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Preface to AcqKnowledge Software Guide 
Welcome 

Welcome to the AcqKnowledge Software Guide. The MP System (MP150 or MP36R) is a complete data 
acquisition system that includes both hardware and software for the acquisition and analysis of life 
science data. The MP System (MP150 or MP36R) is used for data acquisition, analysis, storage, and 
retrieval. 

AcqKnowledge software not only makes data collection easier, but also performs analyses quickly and 
easily that are impossible on a chart recorder. Easily edit data, cut and paste sections of data, perform 
mathematical and statistical transformations, and copy data to other applications (such as a drawing 
program or spreadsheet) for reports and publication. 

The MP System (MP150 or MP36R data acquisition unit) with AcqKnowledge 4 is compatible with 
Windows 7 or Vista OS or Mac OS X 10.4-10.6. 

AcqKnowledge uses the familiar point-and-click interface common to all Windows and Macintosh 
applications. Complex tasks such as digital filtering or fast Fourier transformations are now as easy as 
choosing a menu item or clicking your mouse. 

This manual covers use of AcqKnowledge software with an MP System (MP150 or MP36R) and details 
BIOPAC equipment available for a variety of applications. If a desired application is not addressed, just 
visit the BIOPAC web site at 5www.biopac.com to download one of our many Application Notes, or call 
to request a hard copy or talk to an Applications Specialist. 

 

See also: 

• BIOPAC Installation Guide—packed with the software CD. 

• BIOPAC Hardware Guide.pdf—available under the Help menu and installed to the User Support folder. 
Provides details on MP System (MP150 or MP36R) modules, transducers, electrodes, etc., and setup 
and calibration. 

• BIOPAC Catalogs 

   
MP Research Catalog  MRI catalog  VR & Stimulus Catalog  

 

Supported Platforms  
AcqKnowledge 4.2 is supported on the following:  
 Operating Systems Comment MP Devices 
   Windows 7 or Vista32 — MP150 UDP only 
 Windows 7 or Vista64 32 bit mode only MP36R only 
 Windows XP Functional, limited testing 
 Mac OS X 10.4 PowerPC + x86 
 Mac OS X 10.6 PowerPC + x86   

http://www.biopac.com/Manuals/research_catalog.pdf�
http://www.biopac.com/ProductImages/corporate images/biopac_mri_catalog_web.pdf�
http://www.biopac.com/Manuals/VR_catalog.pdf�
http://www.biopac.com/Manuals/research_catalog.pdf�
http://www.biopac.com/ProductImages/corporate images/biopac_mri_catalog_web.pdf�
http://www.biopac.com/Manuals/VR_catalog.pdf�
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What’s new for AcqKnowledge 4.2 
BONUS! AcqKnowledge 4.2 includes a courtesy copy of our new Analysis package.  

See the Analysis chapter for details. 

 
Note New features for AcqKnowledge 4.0-4.2 apply to the English language version of the software only.  

AcqKnowledge 3.9 software is translated for the following languages:  
 Chinese Simplified, Chinese Traditional, French, Italian, Japanese, and Spanish.  
5Contact BIOPAC to learn more AcqKnowledge 3.9 translations. 

 

The following features have been added since AcqKnowledge 4.1 was released.  

BioNomadix wireless module support 

Rich Journals 

- Expressions in Journal 

- Tables and Excel® functions 

- Docked and independent Journal windows 

MP36R universal built-in amp module support  

- Pulse Sequence Output Control 

- Sound Sequence Output Control 

- Analog Channel scaling units adapt to gain 

- Simplified Hardware Filtering options 

Startup Wizard for launching application  

Check for MP hardware function  

Email graph image as attachment 

Event enhancements 

- Global Event label printing 

- Customizable Event markers 

- Customizable append segment labels 

- Sequential Event labels 

- Sorted Event summary 

- Mark selection from Events 

Measurement enhancements 

- Single point measurements 

- X/Y measurement label display 

- Revised invalid measurement display 

Media playback —automatic segment advancement 

User Interface Tools 

- Most Recently Used options 

- Preset menu separators 

- Keyboard data selection enhancement 

- Zoom out for Spectrum Analyzer 

- Enable tools during acquisition (Preference) 

- Cursor tools sub-menu 

- Mouse scroll-wheel zoom support 

Graph file display enhancements 

- Select channel background 

- Select line plot thickness 

- Data Playback enhancements  

- Start/End axis adjustment 

- Horizontal Axis Hold Relative Position  

- X/Y display crosshairs enhancement 

- Customize default graph window position and size 

- Default analog channel unit display preference 

Grid enhancements 

- Channel independent grid settings 

- Grid presets 

Gaussian Random Number Generator 

Automated Analysis routine enhancements 

- Poincare Plot Hemodynamic Analysis 

- Locate Muscle Activation adjustable windowing 

Advanced Averaging 

Sound Feedback 

Licensed functionality 

- New Remote Monitoring — ‘bedside monitor’ 
display 

o View subject data remotely over a network 

- New B-Alert X-10® Wireless EEG System  

o EEG wireless headset integration  
o Cognitive States Analysis  

- BIOPAC Basic Scripting 

o Script Editor Reset Defaults button 
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Plus—If upgrading an older version of AcqKnowledge, see these additional features. 

AcqKnowledge 4.1 updates

Windows 7 and Mac OS X 10.6 supported 

Licensed functions v4.1.1 

  - Network data transfer  

  - Vibromyography 

  - Scripting 

Analysis Automation Routines 

  - Independent detrending (HRV & PSD) v4.1.1 

  - Slew rate limiter for MRI analysis v4.1.1 

  - HRV algorithm improvements 

  - HRV analysis QRS threshold percentage 

  - ICG Analysis Output Options 

  - Event-related EDA Analysis 

  - Stim-response configuration enhancements 

  - Digital Input to Stim Events 

  - Specialized analysis dialogs 

Module-based analog setup 

MP36R Four-channel D/A unit support 

Measurements 

  - Sum measurement 

  - Measurement presets 

Media Capture Windows (audio and/or video) 

Artifact Rejection functionality 

Timed Reset for Integrate calculation and transformation 

User Interface Enhancements 

  - Analysis dialogs: consolidated parameters in a single dialog 
  - Online averaging progress bar 

  - Transformation history 

  - Canceling Transformations & Transformation Progress Bar 

  - Custom toolbars for transformations and analysis 

  - Toolbar position retention and changes 

  - Event tool enhancements 

  - Typed event label drawing improvements 

  - Choose MP150 Help Button 

  - Button Transparency 

  - Vertical axis scaling buttons 

  - Long channel labels and units 

  - Customizable Chart Track Dividers 

  - Graph window tooltip improvements 

  - Menu item tooltips 

Mac OS Integration 

  - Automator scripting language integration 

  - Spotlight integration

 
AcqKnowledge 4.0 updates 
AcqKnowledge Windows included the following new features since AcqKnowledge 3.9 was released. If upgrading from 
an older version of AcqKnowledge, see the "AcqKnowledge Software Guide" for a more complete list of features. 
  Analysis Packages 

Detect and Classify Heartbeats 

Locate ECG Complex Boundaries 
Chaos Analysis 

Detrended Fluctuation Analysis 
Optimal Embedding Dimension 
Optimal Time Delay 
Plot Attractor 
Correlation Coefficient 

Electrodermal Activity 
Derive Phasic EDA from Tonic 
Event-related EDA Analysis 
Locate SCRs 

Electroencephalography 
Compute Approximate Entropy 
Delta Power Analysis 
Derive Alpha-RMS 
Derive EEG Frequency Bands 

Impedance Cardiography Analysis 
Adaptive template matching 
C point location 
Body Surface Area  
Ideal Body Weight 
ICG Analysis 
VEPT 
PEP Pre-ejection Period 
dZ/dt Derive from Raw Z 
dZ/dt Classifier: B, C, X, Y, and O Points 
dZ/dt Remove Motion Artifacts 

 
Magnetic Resonance Imaging 

Artifact Frequency Removal 
Artifact Projection Removal 
Median Filter Artifact Removal 
Signal Blanking 
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EEG Frequency Analysis 
Remove EOG Artifacts  

Electromyography 
Derive Average Rectified EMG 
Derive Integrated EMG 
Derive Root Mean Square EMG 
EMG Frequency & Power Analysis 
Locate Muscle Activation 

Ensemble Average 
Epoch Analysis 
Hemodynamic Analysis 

Classifiers: ABP; LVP; MAP 
Arterial Blood Pressure 
ECG Interval Extraction 
HRV Poincare Plot 
Left Ventricular Blood Pressure 

Monophasic Action Potential  
Respiratory Sinus Arrhythmia 

 

Slew Rate Limiter 
Neurophysiology 

Amplitude Histograms 
Classify Spikes 
Average Action Potentials 
Dwell Time Histograms 
Generate Spike Trains 
Locate Spike Episodes 
Find Overlapping Spike Episodes 
Set Episode Width and Offset 

Principal Component Denoising 
Remove Trend 
Respiration 

Compliance and Resistance 
Penh Analysis 
Pulmonary Airflow 

Spectral Subtraction 
Stim-Response 

Digital Input to Stim Events 
Stim-Response Analysis 

Waterfall Plot 

Wavelet Denoising 

Multichannel Event Marking System 

Event marking system is now combined with Cycle/Peak Detector, allowing automated measurements around 
specific events and additional event marking based on measurements taken. For example, mark when a dose or 
task occurs and automatically measure and mark the maximum response. 
 
Cycle (Peak) Detector interface 
Advanced Cycle/Peak Detector combines with powerful new Event Marking System. Perform amplitude, time, or 
event-based measurements. New output options for measurements, averaging, events, clustering (K-means), and 
3D surface (cycle data, histogram, FFT, and DWT). 
 
Transformations 
Most recently used files, transformation and analysis 
Adaptive template matching transformation 
Normalized Cross-correlation Template 
Transformation 

Remove projection template 
Delay transformation 
Cubic spline resampling options 
Spectrum analyzer/real-time FFT 

 
Calculation Channels 
Calculation metachannels—daisy-chain calculations, such as Filter and Difference, on one channel 
Dynamic digital filter options 
 

Measurements 
Equation Generator/Expression enhancements—online and post-acquisition 
Interpolated measurements 
New measurement options to optimize event marking system 
 

User Interface – Display and control of data 
3D data visualization 
Text annotations—add zest to publication screen shots or annotate the file beyond marker notes 
Print functions—adjust data range for printing; print waveform data in black; print file to PDF 
Adaptive scaling—vertical scale updates in real time to optimize data display 
Grids—Friendly grid scaling; Flexible grid options Grid Tool 
Balloon Help 
Multiple levels of Undo 
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Jump tool 
Rescale operations 
Selection palette—place cursors at specific time points 
Mouse scrollwheel support 
Keyboard Shortcuts added (accelerator keys) 
Cursor Tools Contextual Menu 
Replay data 
 
Data processing 
Large file support 
Batch acquisitions 
Multithreaded operation 
 
File Formats 
Excel Export (for reports with tabular data) 
Save Selection As moved to File menu and added = Wav, EDF, JPEG; removed = Metafile (*.WMF)  
Open Mac AcqKnowledge 3 Graph 
BSL file import 
EDF file import and export 
Igor Pro Experiment import/export 
WAV file format import/export 
 

The following features were available in AcqKnowledge 3.9 but are not available in AcqKnowledge 4.0-4.1: They are 
again available in AcqKnowledge 4.2. 

Advanced Averaging  
Network Data Transfer  
Preferences option to enable tools during acquisition  
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Using this Manual 

The AcqKnowledge Software Guide is divided into four parts: 

Part A Getting Started 

 Please review Getting Started whether new to computer-based data acquisition systems or an old hand at 
physiological monitoring. Use this section to become acquainted with how the system works and the most 
frequently used features. 

Part B Acquisition Functions 

 Explains data acquisition features and gives a detailed summary of different acquisition parameters. Provides 
an in-depth description of the commands used to determine acquisition rate, acquisition duration, and 
specialized functions such as triggering, averaging, and online calculation of different values. 

Part C Analysis Functions 

 Details information on analysis features; covers the range of post-acquisition analysis functions and 
transformations available with the MP System (MP150 or MP36R). Describes how to edit data, take 
measurements and perform basic file management options (save, print, etc). 

Part D Appendices 

 Answers frequently asked questions, offers hints for working with files, includes information on upgrading 
from previous versions, provides technical information about the MP System (MP150 or MP36R) and other 
information about the AcqKnowledge software. 

 

See also: 

BIOPAC Installation Guide 

This guide was included with the software CD. It contains full instructions for hardware and software 
installation, and how to be up and running with the MP System (MP150 or MP36R) in just a few minutes. 

 

Hardware Guide 

BIOPAC MP Hardware Guide.pdf is available under the Help menu. It gives practical examples of how the 
MP data acquisition unit is used with different components for common types of data acquisition, and 
includes sample results and applications for widely used test procedures. This guide provides instructions for 
connecting external devices to the MP150 or MP36R, electrodes, transducers, amplifiers, etc. 
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User Support System 

 

User Support System files can be found in the following hard drive location; BIOPAC Systems, Inc/AcqKnowledge 
3.x/User Support Systems in the Program Files or Applications folder. 

 

 AcqKnowledge Software Guide.pdf is the software support document 

 

 BIOPAC MP Hardware Guide.pdf is the hardware guide (with specifications) 

  

The User Support files can also be opened directly from the CD. 

 

The files are in PDF format, and can be read by Adobe Acrobat Reader. 

 Adobe Acrobat Reader can be downloaded for free at www.adobe.com under the Adobe Acrobat Reader site. 
 

The Samples folder in the BIOPAC program folder contains sample files and graph template Quick Start files for a 
variety of applications. Quick Start templates establish the channel setup and acquisition parameters required for a 
variety of applications. 

 

 To open sample files, choose File > Open then Browse to the BIOPAC Samples folder. 

 To open a graph template Quick Start file, choose File > Open then Browse to the BIOPAC Samples folder 
(be sure to select/enable the desired file type). 
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Where do I find help? 

The Introductory sections are intended to provide enough information to get up and running with the MP System 
(MP150 or MP36R), and become familiarized with some basic AcqKnowledge functions. There are far more features 
than described in the first few pages, so here is a guide for how to continue using this manual. 

 Help menu 

The online Help menu includes basic information about standard AcqKnowledge functions and links to the 
tutorial, software guide and hardware guide for online searchable Help while running AcqKnowledge, plus 
links to the BIOAPC web site. 

 Application Notes 

The BIOPAC web site at  http://www.biopac.com has more than 50 available Application Notes. Download 
the desired Application Note or call to request a hard copy. 

 Acquiring data 

For more specific information on different types of acquisitions, see Part B—Acquisition Functions. It covers 
basic acquisition parameters in detail, and describes some acquisition features (such as peak detection 
techniques and online Calculation channels) not covered in the Getting Started section. 

 AcqKnowledge 

Information about how to edit, display and transform data can be found in Part C—Analysis Functions. It 
explains how to import and export data, how to save files, and other file management commands. This section 
also explains how to use all of the post-acquisition features of the AcqKnowledge software. 

 Connecting input devices 

To find out how specific modules connect to the MP data acquisition unit, turn to the BIOPAC MP Hardware 
Guide PDF file. This section describes how to connect signal-conditioning modules to the MP data 
acquisition unit and how to connect electrodes and transducers to the modules. 

 Working with large files 

Many users need to perform high speed (i.e., fast sampling rates) or long duration acquisitions. These types of 
acquisitions tend to generate large (several megabytes) data files that can be difficult to load, store, and view. 
The MP System (MP150 or MP36R) can handle such acquisitions—see the Appendices for information on 
how to optimize setup for these types of acquisitions. 

 Troubleshooting 

Includes a list of the most frequently asked questions regarding the MP System (MP150 or MP36R). Check 
this section (Appendix A) for commonly encountered problems and solutions. 

http://www.biopac.com/�
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IMPORTANT SAFETY NOTICE 
BIOPAC Systems, Inc. instrumentation is designed for educational and research-oriented life science investigations. 
BIOPAC Systems, Inc. does not condone the use of its instruments for clinical medical applications. Instruments, 
components, and accessories provided by BIOPAC Systems, Inc. are not intended for the diagnosis, mitigation, 
treatment, cure, or prevention of disease. 

The MP data acquisition unit is an electrically isolated data acquisition system, designed for biophysical 
measurements. 

Exercise extreme caution when applying electrodes and taking bioelectric measurements while using the MP 
System (MP150 or MP36R) with other external equipment that also uses electrodes or transducers that may make 
electrical contact with the Subject. Always assume that currents can flow between any electrodes or electrical 
contact points. 

Extreme caution is also required when performing general stimulation (electrical or otherwise) on a subject. 
Stimulation currents should not be allowed to pass through the heart. Keep stimulation electrodes far from the heart 
and located close together on the same side of the subject’s body. 

It is very important (in case of equipment failure) that significant currents are not allowed to pass through the heart. 
If electrocautery or defibrillation equipment is used, it is recommended that all BIOPAC Systems, Inc. 
instrumentation be disconnected from the Subject. 
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Human Anatomy & Physiology Society Position Statement on Animal Use 

Adopted July 28, 1995 
  It is the position of the Human Anatomy and Physiology Society that dissection and the manipulation of 
animal tissues and organs are essential elements in scientific investigation and introduce students to the excitement 
and challenge of their future careers. 

The Human Anatomy and Physiology Society (HAPS) is a national organization of science educators 
dedicated to the task of providing instruction of the highest quality in human anatomy and physiology. A fundamental 
tenet of science is the ordered process of inquiry requiring careful and thoughtful observation by the investigator. As 
subdivisions of biology, both anatomy and physiology share a long history of careful and detailed examination, 
exploration and critical inquiry into the structure and function of the animal body. Consistent with the origins and 
nature of scientific inquiry, HAPS endorses the use of animals as essential to the laboratory experiences in both 
human anatomy and human physiology. 

Historically, the principal tool of investigation in anatomy has been dissection. A properly directed dissection 
experience goes beyond naming structures and leads the student to conclusions and insights about the nature and 
relatedness of living organisms that are not otherwise possible. To succeed in their future careers, students must 
become thoroughly familiar with anatomical structures, their design features and their relationships to one another. 
Dissection is based on observational and kinesthetic learning that instills a recognition and appreciation for the three-
dimensional structure of the animal body, the interconnections between organs and organ systems, and the 
uniqueness of biological material. While anatomical models, interactive computer programs, and multimedia materials 
may enhance the dissection experience, they should not be considered as equivalent alternatives or substitutes for 
whole animal dissection. 

HAPS supports the use of biological specimens for anatomical study provided their use is in strict compliance 
with federal legislation and the guidelines of the National Institutes of Health and the United States Department of 
Agriculture and that such use fulfills clearly defined educational objectives. 

Physiology experiments involving live animals provide an excellent opportunity to learn the basic elements 
specific to scientific investigation and experimentation. It is here that students pose questions, propose hypotheses, 
develop technical skills, collect data, and analyze results. It is here that they learn to remain focused on the details of 
procedure and technique that may influence the outcome of the experiment and the responses of the animal. When 
faced with unexpected and even erroneous results, students develop and improve their critical thinking and problem 
solving skills. 

Computer simulations and video programs are useful tools that help students acquire a basic understanding 
of physiologic principles. However, due to the inherent variability and unpredictable nature of biological responses, 
such programs fail to fully depict the uniqueness of living organisms and should not be viewed as equivalent 
alternatives or substitutes for live animal experiments. HAPS supports the use of biological specimens in physiology 
experiments provided their use is in strict compliance with federal legislation and the guidelines of the National 
Institutes of Health and the United States Department of Agriculture and that such use fulfills clearly defined 
educational objectives. 

Science educators have in common a respect and reverence for the natural world and therefore have a 
responsibility to share this with their students. They must communicate the importance of a serious approach to the 
study of anatomy and physiology. HAPS contends that science educators should retain responsibility for making 
decisions regarding the educational uses of animals. Furthermore, it opposes any legislation that would erode the 
educator's role in decision making or restrict dissection and animal experimentation in biology. 

Used with permission of:  The Human Anatomy and Physiology Society (HAPS) 
222 South Meramec, Suite 203, St. Louis, MO 63105 
1-800-448-HAPS 
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Part A—Getting Started 
Chapter 1  MP Systems Overview 

Part A - Getting Started covers the basics of data acquisition and analysis with an MP System (MP150 or MP36R). 
All of the material in this section is covered in more detail in subsequent sections (see Using this Manual, page 17 ). 

 
BioHarness™ users should also see the BioHarness User Guide available under 
the Help menu and installed to the User Support folder in the program folder. 

 

Overview 

The MP System (MP150 or MP36R) is a computer-based data acquisition system that performs many of the same 
functions as a chart recorder or other data viewing device, but is superior to such devices in that it transcends the 
physical limits commonly encountered (such as paper width or speed). Data collection generally involves taking 
incoming signals (usually analog) and sending them to the computer, where they are (a) displayed on the screen and 
(b) stored in the computer’s memory (or on the hard disk). These signals can then be stored for future examination, 
much as a word processor stores a document or a statistics program saves a data file. Graphical and numerical 
representations of the data can also be produced for use with other programs. 

Function  MP150  

Aggregate Sample Rate 
Internal MP150 Buffer: 400 kHz 

To Cpt. Memory or Disk: 300 kHz 

Internal Buffer Size: 6 Mbytes 

A/D Converter Signal/Noise Ratio: 86 dB typical 

D/A Resolution: 16 bits 

D/A Output rate: Independent of A/D rate 

Communication to Computer: Ethernet (10 base T, UDP and DLC Type II) 

The MP System (MP150 or MP36R) utilizes the same hardware, excepting the computer interface. The software has 
the same “look and feel” on computers running Windows® or Mac® OS X. 

 The system is referred to as “MPWSW” for Windows® or “MPWS” for Mac. 

Ther MP System (MP150 or MP36R) consists of several major components, including hardware and software. The 
AcqKnowledge software included with the MP system allows full control over editing data, the way it appears on the 
screen, and performs four general functions: 

(a) Control the data acquisition process; 

(b) Perform real-time calculations (such as digital filtering and rate detection); 

(c) Perform post-acquisition transformations (such as FFT’s and math functions); 

(d) Handle file management commands (saving, printing, and the like). 

The heart of the MP System (MP150 or MP36R) is the MP data acquisition unit, which converts incoming 
physiological data into digital signals that can be processed and displayed on a computer interface. The MP150 data 
acquisition unit connects via Ethernet, the MP36R connects via USB. 

The MP150 System also includes a Universal Interface Module (UIM100C) for connecting external devices to the 
MP150 data acquisition unit. Connect chart recorders, pre-amplified signals, and digital signals such as those from 
triggers or event counters/recorders. The UIM100C connects to the front of the MP150 data acquisition unit via two 
cables (Analog and Digital). As a rule, both cables should be connected. The connectors for each of the two cables 
are different, so there is only one way the UIM100C can be connected to the MP150 data acquisition unit. 

A wall transformer is included with the MP System (MP150 or MP36R) to convert AC mains power into DC power 
suitable for system operation and safety. 
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MP36R support 

The MP36R is a four-channel data acquisition unit designed to work with AcqKnowledge 4.1 and above for the 
research market. AcqKnowledge support for the MP36R unit includes:  

 Standard data acquisition and data acquisition features (triggering, multiple channels, variable sampling rate, 
input values)  

 Output control functionality for controlling stimulators, digital channel, and channel redirection to output.  

 Standard analog presets for all SS series transducers 

 Electrode Check support  

 Multiple-MP device support. Similar to multiple MP150 support, each graph may acquire from a maximum 
of one unique MP device.  

 Control channel support for changing digital output lines based on calculation channel analysis  

 

MP36R Notes  The computer sleep mode should be disabled—if the computer goes to sleep while AcqKnowledge 4 
is running, communication with the MP36R may be lost and the application may freeze. To prevent 
this from occurring, modify the computer settings to prevent the computer from going to sleep. 

 If sleep mode is enabled and causes the 
application to freeze, force quit the application 
and ‘power cycle’ the MP unit to re-establish 
communication. 

 During an unresponsive period, the ‘Connect 
Hardware’ dialog may display odd characters 
in place of the MP serial number or the 
computer, upon waking up, may generate 
a“Driver irql not less or equal” error dialog. 

 AcqKnowledge software does not support MP36 
units from the Biopac Student Lab product line (without the “R” designation). 

 Mac OS users: Connect the MP36R directly to the computer, do not connect MP36R via hub or 
keyboard. 

MP System Requirements 

Suggested minimum system requirements are detailed below. Recommendations are included to optimize system 
performance; more memory and a faster system will enhance MP System (MP150 or MP36R) performance. If 
planning to acquire data for more than a few hours and/or are sampling at more than 1,000 samples per second, see 
the 5Disk Space note. 

Windows For AcqKnowledge 4.2 

OS Requires Windows 7 or Vista or Mac OS X 10.4-10.6  see 5Mac on Intel and 5Mac OS  10.4 Tiger Notes 

Port 

MP150 Requires Ethernet (UDP), MP36R requires USB. 

Note To use an MP150 with UDP communication on a network with a non-Windows DHCP server, 
it is necessary to use firmware rev. 1.1.12 or greater in order for the MP150 unit to properly be 
assigned an IP address. This is also true for any DHCP system with non-Windows operating 
systems, such as Unix, Linux, Mac OS X, and other DHCP-aware devices. 

Hard Disk 
Requires 1 GB to store the software and online manuals; additional 1 GByte recommended for data 
storage 

RAM 1 GB recommended 

Processor 
PC: Pentium 4 or higher 
Mac: Intel Core Duo or higher 
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MP150 DLC Limitations 

UDP is the default communication for MP150 units. An administrator password is required in order to access the 
Ethernet network under Mac OS X. Without an administrator password, AcqKnowledge 4.0 can only be used in 
the “No Hardware” mode for data analysis. 
 

Disk Space 

With any program, adequate disk space is necessary for storage of data files. Although BIOPAC saves files in a 
format as compact as possible, some users may generate data files of several dozens of megabytes. To acquire 
data for long periods (more than a few hours) while sampling at relatively fast rates (more than 1,000 samples 
per second), as much disk space as possible should be available. (A removable drive may also be used). See the 
Appendices for hints on working with large files. 
 

Windows XP Compatibility 

AcqKnowledge 4.2 is officially released for Windows 7 and Vista operating systems, but testing was performed 
with Windows XP. If AcqKnowledge® 4.2 is installed on Windows XP, the user should not encounter any 
systemic problems related to the operating system, except for Media and Tooltips. 

 Media functionality is not compatible with the XP operating system and performance will be problematic. 

 Tooltips may not be displayed on XP. 

Sample Data is installed to < drive>:\Documents and Settings\All Users\BIOPAC Systems, Inc\AcqKnowledge 4.1. 
 

Mac Power PC Compatibility 

AcqKnowledge 4.2 is officially released for Macintosh computers with Intel processor, but testing was also 
performed on the Power PC. When AcqKnowledge 4.2 is installed on a Power PC, performance will be sluggish; 
many of the Analysis operations will take several minutes or longer to complete.  
 

Mac on Intel Compatibility  

AcqKnowledge has been updated to a Universal Binary. This allows it to run natively on both PowerPC and 
Intel-based Macintosh computers. AcqKnowledge also integrates directly with operating system features when 
running on Mac on Intel-based computers, such as Automator and Spotlight. 

Some features are not yet available for Mac on Intel-based computers due to the lack of third-party support. 
These features include: 

 MATLAB File Exchange (requires Mac on Intel support from MATLAB and The MathWorks).  

o If MATLAB File Exchange is required, the application can be run in emulation mode by 
checking the “Open with Rosetta” checkbox in the Get Info inspector of the Finder. 

 

Contact BIOPAC Systems for more details on when these features may become available. 

Mac OS X 10.4 “Tiger” — these features are available in AcqKnowledge 4.1 and AcqKnowledge 3.9.1. 

Spotlight Importer for Graph Files 

Spotlight is an effective tool for searching for data. AcqKnowledge includes a Spotlight Importer that allows 
Spotlight to extract and search information from AcqKnowledge graph files including: Graph title; Duration of 
the recorded data in the graph; Text included in the Journal; Labels of data channels in the graph. 

For example, if the names of subjects are recorded in a graph's Journal, Spotlight will be able to locate the graph 
file based upon names extracted from the Journal. If enough information is kept in the channel labels and graph 
journals, graphs can then be located and grouped using the Spotlight search features in ways not possible prior to 
Mac OS X 10.4 and greater. 

The Spotlight importer only supports files generated by Mac AcqKnowledge 3.7.0 or higher. 

 Older Mac AcqKnowledge or any Windows AcqKnowledge files must be resaved to disk using a 
compatible Mac AcqKnowledge file format. 
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Automator Integration and Scripting Support 

Mac OS X 10.4 and greater includes a visual scripting environment called “Automator.” Automator allows for 
drag and drop creation of “Workflows.” Each workflow is a series of steps that is performed in another 
application. Each individual step is called an action. An action encapsulates a simple operation within another 
application, such as opening a text file in TextEdit or applying a filter within Photoshop. 

Over 40 actions have been written to allow AcqKnowledge to be controlled from Automator workflows. Using 
these actions, workflows can be constructed to perform sequences of transformations, automating post-
acquisition analysis, performing experimental protocols, and other repetitive operations. 

Workflows can be constructed using Automator. It is also possible to create, edit, and execute workflows directly 
from within the AcqKnowledge environment using the new “Workflow” menu. The Workflow menu allows the 
creation of workflows specific to an individual user account or to one shared by all AcqKnowledge users. These 
workflows can then be edited in the Automator environment. Each workflow created using Workflow > New 
Workflow will appear at the bottom of the Workflow menu each time AcqKnowledge is launched. By simply 
selecting the name of the workflow from the Workflow menu, AcqKnowledge will execute the workflow.  

Workflows executed from the Workflow menu should begin with either an “Open Graphs” or a “Get Active 
Graphs” action. Workflows intended for use outside of the AcqKnowledge environment (e.g. used as Folder 
Actions) should begin with a “Launch Application” action to start AcqKnowledge followed by an “Open 
Graphs” or a “Get Active Graphs” action.  

AcqKnowledge 3.9.2 and later 

Digital filter options have been changed as follows: 

Cutoff freq: digital filter-FIR, digital filter-IIR, comb band stop, and derivative 

 Sampling rate—Sets the frequency to a fraction of the sampling rate and automatically updates when the 
sample rate is modified. 

 Line frequency—Uses the line frequency at which the data was recorded. 

# of coefficients: digital filter-FIR and derivative 

 Optimize for sample rate and cutoff—Estimate the number of coefficients as four times the sampling rate 
divided by the cutoff frequency of the filter. Optimize does not necessarily produce the best quality 
filter, but takes less time. 

Rescale: To apply textual changes to a channel's units, apply the "Replace Active Channel Units" action. 

Delay 

For more information about Automator and help constructing workflows, see the Apple website at: 
5http://www.apple.com/macosx/features/automator/ 
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Data Acquisition and Analysis with BIOPAC BioHarness™ 

 

 
IMPORTANT NOTE: In AcqKnowledge for BioHarness 

 BioHarness menu replaces the MP150/MP36R menu 

 Analog channels can be turned on/off but not changed 

 Other functionality remains the same 

 
 

BioHarness™ users should see the BioHarness User Guide 
available under the Help menu and installed to the Uer Support 
folder in the program folder. 
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MP System Features 

In conjunction with your computer, the MP System (MP150 or MP36R) is a complete system for acquiring almost 
any form of continuous data, whether digital or analog. The MP System (MP150 or MP36R) can perform a range of 
recording tasks, from high-speed acquisitions to long duration acquisitions. Generally speaking, for physiological 
applications, the MP System (MP150 or MP36R) is limited only by the speed of your computer and the available 
memory or disk space. Features of the MP System (MP150 or MP36R) include: 

Easy to use The MP System (MP150 or MP36R) offers the same convenient and easy-to-use features 
which computer users are accustomed to. Since the MP System (MP150 or MP36R) 
software runs under these Windows and Mac OS environments, you can run other 
applications while you are collecting data. In terms of hardware setup the MP System 
(MP150 or MP36R) uses simple plug-in connectors and standard interface cables.  
You don’t need a degree in electronics to Set Up your system! 

Flexible The MP System (MP150 or MP36R) can be configured for a wide variety of applications, 
from single channel applications to multiple-device measurements (up to 16 analog and 
16 digital, or multiple MP150s). You control the length of acquisition, the rate at which 
data is collected, how data is stored, and more...all with a few clicks of the mouse button. 
Whether you’re measuring alpha waves or collecting zoological data, the MP System 
(MP150 or MP36R) can meet your needs. 

Menu flexibility You can easily customize menu displays to show only the functions you are using, thereby 
reducing the risk of error or confusion in your lab. This function is extremely powerful for 
laboratories working to GLP guidelines. It is also useful for teaching applications where 
instructors can hide unnecessary menu items. See Appendix D—Customizing Menu 
Functionality. 

High Speed Sampling Sample rates up to 400 KHz aggregate 

Arbitrary Sample 
Rates 

Apply different sample rates between channels or operate the STM100C stimulator at a 
different rate than the acquisition sample rate 

View & Control 
Multiple MP150s 

View and control multiple MP150 units over a local area network (LAN). 

Calculation Channel 
Presets 

Customize your recording for specific measurements. 

Template files AcqKnowledge “Quick Start” templates are available for over 40 applications. Just open 
the template file and start the acquisition—appropriate settings are established for the 
selected application. 

Online Calculation Although the MP System (MP150 or MP36R) provides an extensive array of 
measurements and transformations you can apply to collected data, sometimes you need 
to perform computations while data is being collected. The online Calculation functions 
allow you to calculate new channels based on incoming signals. This feature allows you to 
compute BPM, for instance, based on raw ECG data. 

Online filtering Many times, it is preferable to filter data as it is being collected, rather than having to wait 
until after the fact, so now you can apply filters to incoming data and view the results in 
real time. That means online monitoring of data filtered to suit your needs. 

Online measurements The MP System (MP150 or MP36R) can instantly compute over a dozen measurements 
and computations for any given data point(s). These options are available from pull-down 
menus and include mean, peak-to-peak, value, standard deviation, frequency, and BPM. 
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Measurement 
Validation 

You can validate measurements with the ValidateMeasurements.acq sample file 
that was included with the software. The measurement definitions (page 91 19999) 
include measurement formulas and “Sample data file” explanations. 

Preview your data Similar to chart recorders, the MP System (MP150 or MP36R) allows you to 
change both the vertical scale and the horizontal scale. You can change the 
amplitude scale or the time scale to any value you wish, or you can have the MP 
System (MP150 or MP36R) automatically scale them for you. 

Replace (or augment) 
a chart recorder 

Whether you want to replace a chart recorder or simply supplement an existing 
setup, the MP System (MP150 or MP36R) is fully compatible with most major 
recording devices. What’s more, the MP System (MP150 or MP36R) is 
compatible with most popular input devices, so you can continue using the same 
transducers, electrodes and sensors. 

Simplified editing It used to be that once your data was collected, the only way to edit it was with 
scissors and adhesive tape. Now you can delete unimportant sections of your data 
with a keystroke. You can “paste” together sections from different waves, or 
simply edit out noise spikes from individual waves. 

Append mode For some applications, data only needs to be recorded during some portions of a 
long experiment. AcqKnowledge has an “Append” mode that lets you pause the 
acquisition for as long as you wish, and resume the acquisition as many times as 
needed. In this mode, you can start and stop a recording as you would with a chart 
recorder. Appending data saves on storage space and processing time for 
transformations. 

Digital filtering All data contains measurement error and noise. Now you can reduce or eliminate 
that error by using the digital filters and smoothing transformations included in 
the MP System (MP150 or MP36R). You can smooth data across any number of 
samples, or filter out noise from any frequency or bandwidth you wish. 

Digital Output You can control external devices when an input or calculation channel meets 
trigger conditions you specify. Use the Control channels to output a pulse when 
the signal on an analog channel falls above or below a given threshold. 

X/Y plotting You can view and acquire data in the form of an X/Y plot, with one channel on 
the horizontal axis and another on the vertical axis. This allows you to explore 
relationships between different channels and opens up a whole range of 
applications, from chaos plots to respiration analysis to vectorcardiograms. 

Histogram function You can easily examine the variability and the measures of central tendency of 
any waveform data with the histogram function. Set the plotting options to suit or 
let the software determine the “best fit” for graphing your data. 

Math functions In many cases, simply collecting raw data is not enough. AcqKnowledge has an 
array of built-in mathematical functions ranging from simple absolute value to 
computation of integrals, derivatives, and operations involving multiple 
waveforms (such as subtracting one wave from another). You can even chain 
multiple functions together to form complex equations or expressions. 

Annotation AcqKnowledge has a Journal you can use to append comments concerning your 
input data, either online or after the fact. This is especially useful for noting the 
characteristics of an acquisition (what was involved, what manipulations took 
place, and the like) for future reference. 

See also: Text annotation, page 58. 
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Triggering If you need to measure response times or start data collection only after some 
event has occurred, the MP System (MP150 or MP36R) allows you to trigger an 
acquisition in a number of different ways. You can trigger on the level of a signal, 
or with an external synchronizing trigger. 

Event marker  Many times, especially during a long acquisition or in a laboratory setting, it is 
useful to make a note of when specific events occurred so that these events (such 
as when a manipulation occurred) can be recorded and any changes in the data 
can be noted. The marker function allows you to insert symbols in the record and 
add text for each marker. These can be added either while data is being collected 
or after the fact. Marker functionality can be automated for sequential application 
or customized for Function keys. 

File compatibility You can save your data in a number of different formats. For word processor 

programs like Microsoft Word®, use Copy to Clipboard and then paste into the 

document. Use Save as Excel for Microsoft Excel®. You can output your data in 
either text or graphical form, and AcqKnowledge can even read-in raw data from 
a text file. Open (import) or save as (export) MATLAB™ and Igor Pro 
Experiments, or raw (binary) data for low level exchange. 

Pattern recognition Using an advanced pattern search/recognition algorithm, the MP System (MP150 
or MP36R) can automatically find a specific pattern within waveforms. This is 
useful for finding abnormal waveforms (such as irregular ECG waves) within a 
data file. 

Cycle/Peak detection AcqKnowledge has a built-in algorithm to find cycle data, such as positive or 
negative peaks, from any size data file. You can even search for all the 
cycles/peaks with one command and automatically log statistics like time and area 
to the journal. 

Printing The MP System (MP150 or MP36R) provides a range of printing options, and 
allows you to fit your data on one page or many. You can print several graphs per 
page, even if you only have one-channel recordings. Since MP System (MP150 or 
MP36R)s run on Windows or Mac OS, no special printer drivers are required. 

Report generation AcqKnowledge has many features to simplify report generation. Use the Journal 
for notes and quickly copy and paste graph data or measurements to the journal or 
to another program. Cascade event markers to prevent print overlap and select the 
range of data to print and which options to display (measurements, markers, etc.). 
Use the Playback mode to simulate acquisition for presentations. 

User Support Whether you have a question about compatibility with your existing equipment or 
you need to develop a specialized measurement device, BIOPAC’s Applications 
Department can address the problem. 
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Application Features 

Use your MP System (MP150 or MP36R) with AcqKnowledge software for a wide array of applications, such as:  

 
Active Electrodes 
Allergies 
Amplitude Histogram 
Anaerobic Threshold 
Animal studies 
Auditory Evoked Response 

(AER) 
Automate Acquisition Protocols 
Automated Data Analysis 
Automatic Data Reduction 
Autonomic Nervous System 

Studies 
Biomechanics Measurements 
Blood Flow / Blood Pressure 

/Blood Volume 
Body Composition Analysis 
Breath-By-Breath Respiratory 

Gas Analysis 
Cardiac Output 
Cardiology Research 
Cell Transport 
Cerebral Blood Flow 
Chaos Plots 
Common Interface Connections 
Connect to MP System (MP150 

or MP36R)s 
Control Pumps and Valves 
Cross- and Auto-correlation 
Current Clamping 
Defibrillation & Electrocautery 
Dividing EEG into Specific 

Epochs 
ECG Analysis 
ECG Recordings, 12-Lead 
ECG Recordings, 6-Lead 
EEG Spectral Analysis 
Einthoven’s Triangle 
EMG and Force 
EMG Power Spectrum Analysis 
End-tidal CO2 
Episode Counting 
Ergonomics Evaluation 
Event-related Potentials 
Evoked Response 
Exercise Physiology 
External equipment, controlling 
Extra-cellular Spike Recording 
Facial EMG 
FFT & Histograms 
FFT for Frequency Analysis 
Field Potential Measurements 
Fine Wire EMG 
Forced Expiratory Flow & 

Volume 

Gait Analysis 
Gastric Myoelectric Activity 
Gastric Slow Wave Propagation 
Gastrointestinal Motility 

Analysis 
Hardware Flexibility 
Heart Rate Variability 
Heart Sounds 
Histogram Analysis 
Imaging Equipment, Interfacing 
Indirect Blood Pressure 

Recordings 
Integrated (RMS) EMG 
Interface with Existing 

Equipment 
Interface with Third-party 

transducer 
Invasive Electrode 

Measurements 
Ion-selective Micro-electrode 

Interfacing 
Iontophoresis 
Irritants & Inflammation 
Isolated Inputs & Outputs 
Isolated Lung Studies 
Isometric Contraction 
Isotonic Contraction 
Jewett Sequence 
Langendorff Heart Preparations 
Laser Doppler Flowmetry 
Left Cardiac Work 
Long-term Monitoring 
Lung Volume Measurement 
LVP 
Median & Mean Frequency 

Analysis 
Micro-electrode signal 

amplification 
Migrating Myoelectric Complex 
Motor Unit Action Potential 
Movement Analysis 
MRI Applications 
Multi-Channel Sleep Recording 
Nerve Conduction Studies 
Neurology Research 
Noninvasive Cardiac Output 
Noninvasive Electrode 

Measurements 
Nystagmus Investigation 
Oculomotor Research 
Off-line ECG Averaging 
Online Analysis 
Online ECG Analysis 
Orthostatic Testing 
Peripheral Blood Flow 

Peristaltic (Slow Wave) Propagation 
Planted Tissue 
Pressure Volume Loops 
Psychophysiology 
Pulsatile Tissue Studies 
Pulse Rate Measurement 
Pulse Transit Time 
Range of Motion 
Real-time EEG Filtering 
Real-time EEG Filtering 
Recurrent Patterns 
Regional Blood Flow 
Relative BP Measurement 
Remote Monitoring 
Respiration Monitoring 
Respiratory Exchange Ratio 
Rheumatology 
Saccadic Eye Movements 
Sexual Arousal Studies 
Signal Averaging 
Simultaneous Monitoring 
Single Channel Analysis 
Single-fiber EMG 
Software-controlled Stimulator 
Somatosensory Evoked Response 
Spectral Analysis 
Spike Counting 
SpO2 Analysis 
Stand Alone Amplifiers 
Standard Operating Procedures 
Startle Eye Blink Tests 
Startle Response 
Stimulator, software-controlled 
Systemic Vascular Resistance 
Template Analysis 
Tissue Bath Monitoring 
Tissue Conductance Measurement 
Tissue Magnitude & Phase Modeling 
Tissue Resistance & Reactance 
Ussing Chamber Measurements 
Ventricular Late Potentials 
Vestibular Function 
Visual Attention 
Visual Evoked Response 
VO2 Consumption 
Volume/Flow Loop Relationships 
Working Heart Preparations 
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MP System (MP150 or MP36R) Application Notes 

BIOPAC has prepared a wide variety of application notes as a useful source of information concerning certain 
operations and procedures. The notes are static pages that provide detailed technical information about either 
a product or application. A partial list of Application Notes follows. You can view or print application notes 
directly from the Support section of the BIOPAC website 5www.biopac.com. 

APP NOTE Application 

#AH101  Transducer Calibration and Signal Re-Scaling 
#AH102  Biopotential Amplifier Testing w/ CBLCAL 
#AH103  Remote Monitoring System (TEL100C) 
#AS105 Auditory Brainstem Response (ABR) Testing 
#AS105b/c ABR Testing for Jewett Sequence 
#AS108 Data Reduction of Large Files 
#AS109 3-, 6-, and 12-Lead ECG 
#AH110  Amplifier Baseline (Offset) Adjustment 
#AS111 Nerve Conduction Velocity 
#AH114  TSD107A* Pneumotach Transducer 
#AH114b  TSD107B* Pneumotach Transducer 
#AS115 Hemodynamic Measurements—Part I 
#AS116 Hemodynamic Measurements—Part II 
#AS117 Pulse Transit Time and Velocity Calculation 
#AS118 EMG Signal Analysis 
#AS119 EMG Power Spectrum Analysis 
#AS120 X/Y Loop Area Analysis 
#AS121 Waveform Data Reduction 
#AS122 Power Spectrum Analysis 
#AH125  Pulse Oximeter Module Operation 
#AH127  Precision Force Transducers 
#AH128  Active Electrode Specifications and Usage 
#AS129 Heart Rate Variability 
#AH130 Blood Pressure Measurement 
#AS131 Averaging Mode 
#AH132 TSD105A Variable Force Transducer 
#AH135 TSD117 Pneumotach Transducer 
#AH136 BAT100 Instructions 
#AH140 Angular Measurements with Goniometers 
#AH141 Tri-Axial Accelerometer Calibration 
#AS142  AcqKnowledge Rate Detector Algorithm 
#AS143 Importing AcqKnowledge Data Into Excel 
#AH144 Hand Dynamometer Calibration 
#AH145 TSD101B Respiratory Effort Transducer  
#AS148 Automated ECG Analysis 
#AH149 O2100C Module 
#AH150 O2100C Module—Sample application 
#AH151 CO2100C Module 
#AH152 CO2100C Module—Sample Application 
#AH153 Physiological Sounds Microphone 
#AH154 HLT100C High Level Transducer 
#AS158 Analysis of Inspired and Expired Lung Volume 
#AH159 TSD116 Series Hand Switch and Foot Switch 
#AH160 Gas Analysis Module Response Time 
#AS161 Automated Tissue Bath Analysis 
#AH162 Stimulation Features 
#AS168 Analysis of Intraventricular Pressure Wave Data (LVP Analysis) 
#AS169 Speech Motor Control 
#AH170 LDF100A Laser Doppler Flow Module 
#AH175 Using the STMISOC Stimulus Isolator 
#AS177 ECG Analysis using the Offline Averaging Mode 
#AS183 VO2 Measurement 
#AH186 Psychological Assessment using the TSD115 
#AH187 Electrodermal Response (EDR) using the GSR100 or TEL100 
#AH190 Using the MCE100C Micro-electrode Amplifier 
#AS191 Cardiac Output Measurement using the EBI100C and AcqKnowledge 
#AH249 Online Averaging Latency Parameters (ISI, ABR) 
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Chapter 2  AcqKnowledge Overview 
Overview 

 
The MP System (MP150 or MP36R) software is called AcqKnowledge and performs two basic functions: 
acquisition and analysis. The acquisition settings determine the basic nature of the data to be collected, such 
as the amount of time data will be collected for and at what rate data will be collected. All of the acquisition 
parameters can be found under the MP150 menu. The other menu commands pertain to analysis functions 
such as viewing, editing, and transforming data. 

Note:  Some very minor differences exist between the Windows and Mac OS X screen displays and 
keystroke/mouse functionality. These differences are noted throughout this section. 

Menu Functionality See Page 

File New, Open, Open Recent, Open for Playback, Close, Save/Save As, Save selection 
As, Save Journal Text As, Send Email as Attachment, Print, Printer Setup, Quit 

236 

Edit Undo, Cut, Copy, Paste, Clear/Clear All, Remove Last Appended Segment, Insert 
Waveform, Duplicate Waveform, Select All, Remove Waveform, Create Data 
Snapshot, Merge Graphs, Clipboard (Copy Measurement, Copy Wave Data, Copy 
Graph, Copy Acquisition Settings, Copy Data Modification History for All Channels, 
Copy Data Modification History for Graph), Journal (Paste Measurements, Paste 
Wave Data, Paste Acquisition Settings, Paste Modification History for All Channels, 
Paste Modification History for Selected Channel, Show Journal) 

256 

Transform operations that primarily modify the data in the graph 
Recently Used, Digital Filters, Fourier Linear Combiners, Math Functions, Template 
Functions, Integral, Derivative, Integrate, Smoothing, Difference, Resample 
Waveform, Resample Graph, Expression, Delay, Rescale, Waveform Math 

265 

Analysis operations that derive data & measurements from the graph 
Recently Used, Histogram, Autoregressive Modeling, Nonlinear Modeling, Power 
Spectral Density, Autoregressive Time-Frequency Analysis, FFT/IFFT, DWT Discrete 
Wavelets, Principal Component Analysis/Inverse PCA, Independent Component 
Analysis/Inverse, Find Cycle, Find Rate—plus a courtesy copy of the Specialized 
Analysis package with classifiers and automation routines 

296 

Display Tile Waveforms, Autoscale Waveforms, Optimize Ranges, Overlap Waveforms, 
Compare Waveforms, Autoscale Horizontal, Zoom, Reset, Set Wave Position, Wave 
Color, Horizontal Axis, Show, Customize Toolbars, Channel Info, Preferences, Size 
Window, Cursor Style, Create Data View, Organize Data Snapshots, Show All Data 
Snapshots, Load All Data Into Memory 

403 

MP150 Set Up Channels, Set Up Acquisition, Set Up Triggering, Set Up Stimulator, Set Up 
Sound Feedback, Set Up Manual Event Insertion Keys, Set Up Segment Labels, 
Show Input Values, Show Manual Control, Show Gauge, Select MP150, MP150 info, 
Update Firmware, Auto Plot, Scroll, Warn on Overwrite, Organize Channel Presets 

101 
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Menu Functionality See Page 

Playback Replaces the MP150 menu when Playback mode is active (use File > Open for 
Playback and Playback > Quit playback to toggle playback and acquisition modes) 

44 

Window Controls the position of windows on the monitor 429 

Help Provides online support files (PDF format and web links). 429 

Media Capture or Playback media files(.avi, .wmv, or mpg) and synchronize with .acq data 431 
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Launching the AcqKnowledge software 

The first step is to launch the software by double-clicking on the AcqKnowledge icon. You 
may receive a message regarding the hardware. 

 

 

If you receive a hardware prompt when you launch AcqKnowledge, there are two possibilities: You have not 
properly connected everything and/or you have not powered up the MP System (MP150 or MP36R). 

 To use AcqKnowledge without an MP data acquisition unit, press the “No Hardware” button. Click 
Do not ask me again or set Preferences > Other to Always work with no hardware connected. 

 
When AcqKnowledge is first launched, the user must pick an available MP150 unit from the Select MP150 
Serial number dialog. The dialog lists all MP150 units that are powered ON and sitting on the same local area 
network. If using more than one MP150 unit or working across a network, it will be necessary to lock/unlock 
an MP150 to acquire data (see Appendix E on page 1476 for details). The selected MP150 unit will be listed in 
the upper left of the graph display as “Connected to:” if the  Show/Hide Hardware toolbar icon is enabled.  

 
 

Assuming everything is properly connected and there are no conflicts, AcqKnowledge will launch the Startup 
Wizard. (AcqKnowledge 4.2 and higher only) Use this wizard to choose whether to create a new experiment, 
open a saved graph for analysis or access the Help and support files.  
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Startup Wizard under 

‘Create and/or Record a new 
experiment’ (Default) 

Functionality 

Create empty graph Opens new graph window for acquiring data with hardware. Combo box to the right 
selects hardware type. 

Open graph template from disk Brings up ‘Open’ window for browsing to location of saved graph templates. 

Use recent graph template Activates list of recently-opened graph templates for easy selection. 

Sample graph template Activates list of sample graph templates stored in AcqKnowledge program folder for 
easy selection. 

Don’t ask me again If checked, the Startup Wizard will not be presented upon next application launch. 

Quit/OK Cancels or confirms selected operation. 

 Open and analyze graph file  Presents similar options for analysis of existing graphs.  

 Get help    Launch various help and support options. 

NOTE: The Startup Wizard can be disabled in the Preferences, if desired. (Show > Preferences > 
Other) 

A “window” is the term used for the area on your computer’s screen where data is displayed and/or 
manipulated. The graph window on the screen is designed to provide you with a powerful yet easy-to-use 
interface for working with data. 

At this point, you can use this window, create a new window, or open an existing window. 

It’s a good idea to create a new graph window for each acquisition. To create a new graph window after the 
original launch, choose File > New. 
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Setting up channels 

To tell the MP System (MP150 or MP36R) how many channels will be acquired (or collected), select Set Up 
Channels from the MP menu. This will generate the Input Channels Setup dialog. 

 
 The default is to collect one channel of data on channel A1, and to plot and list values for this 

channel. Usually, you will want to check all three boxes for each channel you acquire data on. 

 

Acquire When the Acquire box is checked for a given channel that means data will be collected on that 
channel. 

Plot Determines if data will be plotted in real-time during the acquisition. If the plot box is unchecked, 
data will still be recorded for that channel, but the waveforms can only be plotted after the 
acquisition is over. 

Value Enables you to use the Show Input Values window to display the values for each channel in real 
time, numerically and/or graphically. These values are displayed in a separate window from the 
main graph window.  

Channel This is a dynamic alpha-numeric heading based on the type of channel selected: Analog (or 
continuous), Calculation, or Digital. In the sample above, “A1” indicates Analog channel one. 

 Calculation channels are used for online computations and transformations of other channels. 
These channels are Set Up just as analog and digital channels but also have additional dialoges 
for you to specify what types of transformations and computations you would like to perform. For 
a detailed summary of Calculation channel options, see the Calculation Channel section 
beginning on page X1115 

 In contrast to analog data, Digital channels collect binary data that represent when a measuring 
instrument is “on” or “off.” An example of when this could be useful is for recording whether a 
switch is open or closed, as in reaction time studies or control applications. You can control 
whether digital channels are acquired, plotted, and have values listed the same way you do for 
analog channels. 

Label To the right of each channel number is an editable label for each channel, where you can type in a 
label (up to 38 characters) that identifies what each channel is measuring. 

Preset Calculation channels include Presets as a quick way to get started—choose a preset and the 
software automatically sets the gain, offset, etc. appropriate for the selected application. Choose 
from the list of available presets or create a custom preset; see page 1106 for details. 

Channel The channel sample rate is a function of the acquisition sample rate: all channel sample rate 
Sampling options are equal to or less than the acquisition sample rate (as established via “MP150  
Rate   > Set Up Acquisition”). The options are a specific power of 2 less than the acquisition 
 sample rate. Channel sample rate info is included in the Display > Statistics dialog. Use 
  the pull-down menu to set the channel sample rate. See page 1107 for details. 

 

 
If using AcqKnowledge 4.1 

with BioHarness™, Analog  

channels can be turned  
on/off but not changed. 
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Setting up acquisitions 

 
Once you have set up the channel parameters, the next step is to specify the acquisition settings. Choose Set 
Up Acquisition from the MP150 menu to generate a dialog that specifies the type of acquisition to be 
performed. The basic parameters involve specifying:  

a) How data should be collected and stored 

b) The data collection rate 

c) The acquisition duration (total length) 

Storage Record and Save once to Memory is the default acquisition option. Under this option, the MP System 
(MP150 or MP36R) automatically records data into a single continuous file, and stores the data in 
computer memory (RAM) during the acquisition. 

The third popup menu at the top of the dialog (which defaults to Memory) allows you to specify where 
the data should be stored during the acquisition. You will probably want to choose Memory or Disk 
storage. Computer memory (RAM) is usually faster (but less abundant) than disk space. If your 
system uses any virtual memory, AcqKnowledge will use as much as possible. You may also store 
data directly to the MP150 data acquisition unit, which can store 4 MB; you cannot store data directly 
to the MP36R. 

 The advantage of storing to the MP data acquisition unit is that much faster 
sampling rates may be obtained. 

 The disadvantages of saving data to the MP data acquisition unit are that there is 
limited storage space and that data is not displayed on the screen while it is being 
collected. When the acquisition has stopped, however, the data will be automatically 
displayed on the screen. 

The other option under storage is Averaging, which allows you to take repeated trials of the same 
data. For more information on this feature, see the averaging section on page 154.  

Rate Acquisition Sample Rate is analogous to “mm/sec” on a chart recorder, and refers to how many 
samples the MP System (MP150 or MP36R) should take each second. As the MP System (MP150 or 
MP36R) takes more and more samples per second, the representation of the signal becomes more 
accurate. However, as the sampling rate increases, so does the demand for system resources 
(memory, disk space, etc.). There is a “point of diminishing return” in terms of sampling rate for almost 
all types of analog signals, where sampling above a given threshold adds relatively little information. 

The MP150 sampling rate has a lower bound of 2 samples per hour, and an upper bound of 400 kHz 
aggregate. The MP150 must use a pre-defined rate, it does not accept custom rates. 

Choose the best acquisition sample rate from the pop-up list. 

Note:  Channel sample rates are variable based on the acquisition sample rate. All channel sample 
rate options are equal to or a specific power of 2 less than the acquisition sample rate. 

Duration The final acquisition parameter is Acquisition Length (Total Length), which controls how long an 
acquisition will last. This can be scaled in seconds, minutes, hours, milliseconds or number of 
samples. You can set this value either by entering a number in the acquisition length  box, or by 
moving the scroll box left or right. 
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Starting an acquisition 

Once you have specified which channels will contain data and have defined the channel characteristics, the 
next step is to start the acquisition. If a file window is not already open, choose File > New > Graph window. 

Status 

In the lower bar of the screen, next to the Start button, you should see a circlular status light. The status light 
indicates the communication link between your computer and the MP data acquisition unit. 

 If the MP data acquisition unit is properly connected to the computer and is turned on, the circle will be 
solid and green. 

 If the MP data acquisition unit is not properly connected or not communicating with the computer, under 
Windows® OS the circle will be solid and gray and under Mac OS® X the circle may not appear at all or 
a different symbol, such as double arrows, may be used if the application crashed during acquisition. 

Start 

To start an acquisition, position the cursor over the  button and click the mouse button, or select Ctrl+ 
Spacebar. If there are no input devices (e.g., electrodes or transducers) connected to the MP System (MP150 
or MP36R), it will collect a small value of random signal “noise” with a mean of about 0.0 Volts. 

 For information on how to connect measurement devices to the MP System (MP150 or MP36R), see the 
BIOPAC MP Hardware Guide.pdf. 

 To start an acquisition using a variety of “triggers,” see page 11166. 

 Graphs that open without a Start Button 

o Compressed Graphs 

o Igor Pro Experiment 

o PhysioNet 

o DWT, IDWT 

o PCA, IPCA, 

o ICA, IICA, 

o AR Model separate graph output  

o Nonlinear Modeling separate graph output 

o HRV tachogram output 

o Chaos > Plot Attractor 

o Chaos > Detrended Fluctuation Analysis 

o MatLab Graphs 

o Merge Graphs 

o Original Data Snapshot 

o Raw Data Files 

o Text Files 

o Transform mennu operations: Off-
Line Averaging; Filter Response 

o Analysis menu operations: 
Histogram; FFT (Magnitude and 
Phase); IFFT; Rate (put result in new 
graph option) 
 

 

Once an acquisition has started, the Start button in the acquisition window will change to Stop, and two 
opposing arrows will blink, indicating that data is being collected. Also, the “BUSY” indicator light on the 
front of the MP data acquisition unit will illuminate, showing that data is being collected. 

 

Stopping an Acquisition 

To stop an acquisition at any time, click the  button in the lower right corner of the screen or select 
Ctrl+ Spacebar. 

An acquisition will stop automatically when it has recorded an amount of data equal to that indicated in the 
Total Length box. To save this data file, choose File > Save. 
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Display modes 

The display modes are Chart, Scope, X/Y, Stacked Plot, and Playback. You may change the way data appears 
on the screen at any time, even during an acquisition. To change the display mode, click the corresponding 
icon in the toolbar. 

 Chart mode  

Chart mode is the default display mode. 

Chart mode plots data much as it might appear on a 
chart recorder, with time on the horizontal axis. 

Each channel of data is in its own “track” across the 
screen, with borders between channels. The 
waveforms will not cross boundaries into the tracks 
of adjacent channels. 

If a waveform is plotted off the scale of the channel 
track, choose autoscale waveforms and 
AcqKnowledge will select the “best fit” for 
waveforms to their tracks. 

 

 Scope mode  

Scope mode plots data much as it might appear on an 
oscilloscope, with time on the horizontal axis. 

Scope mode is similar to Chart mode, except that 
there are no borders between different channels. 

 To help emphasize the selected wave in Scope 
mode, select the “Gray non-selected waves” 
Preference (via Display > Preferences). 

Waveforms can overlap. The autoscale waveforms 
command will automatically separate the waveforms 
in the graph window. 

Note: When only one waveform is present, the scope 
and chart modes are identical.  

 X/Y mode  

X/Y mode plots data from two channels against each 
other, with the values from one channel on the 
horizontal axis and the values from another channel 
on the vertical axis. Plotting a channel against itself 
displays a straight line. 

X/Y mode can be useful for chaos investigations and 
respiration studies.  

Note: When viewing data in X/Y mode as it is being 
acquired, plotting only the most recently 
acquired data point can be a useful option. To 
do this, select Display > Show > Dot Plot and 
then Display > Show > Last Dot only. 

Switching to X/Y mode during acquisition can be 
slow. For best performance, switch to X/Y mode 
either before starting the acquisition or after stopping 
the acquisition. 
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 X/Y mode continued 

Plotted channels 

 To change the channel being plotted: Click the Channel label once and hold. 

 
X-axis, click above the waveform; Y-axis, click left of the waveform. 

 To flip the axes: Click the button in the upper left. 

 
 To change the channel label for this plot: Click the Channel label. 

 
Toolbar icons 

The center cluster of toolbar items is specific to X/Y mode. The left two buttons in this group are shortcuts 
for the Autoscale vertical and Autoscale horizontal functions. Adjacent to these buttons are two buttons that 
perform the center vertical and center horizontal functions.  

Tools 

Cursor In X/Y mode, the I-beam tool in the lower right hand corner of the graph window changes into a 
crosshair. When the crosshair is moved into the graph window, the coordinates of the crosshair are displayed 
in the upper left corner of the graph window. The X value refers to the coordinate of the crosshair in terms of 
the horizontal axis, and the Y value describes the location of the cursor in terms of the vertical scale. By 
pressing the mouse, a crosshair is drawn over the closest data point and the measurement toolbar “snaps” to 
that position to show the amplitudes of the actual pair of data samples plotted on the screen. In 
AcqKnowledge 4.2 and higher, the Channel number and label are also displayed next to the measurement 
values.  

 
X/Y plot with ECG on X-axis and BPM on Y-axis 

Autoscale In X/Y mode, the Autoscale waveform function changes to read Autoscale vertical, which 
plots the vertical channel so that it takes up two-thirds of the vertical channel space. This 
function controls the “height” of the data being plotted in the graph window. 

 Similarly, the Autoscale horizontal function plots the waveform so that the waveform is 
plotted in the center two-thirds of the window. This function controls the “width” of the data 
being plotted in the graph window.  
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Autoscale commands adjust the center point and the range of data displayed. To manually 
change the scale, click in either the horizontal or vertical scale area. In this case, the scale at 
the bottom edge of the graph windows (which usually reflects time) is the scale for the X 
variable, and the vertical scale controls the scale for the channel plotted on the Y-axis. 

Center In X/Y mode, since only two channels can be displayed at a time, tile waveforms and 
compare waveform are replaced with Center horizontal and Center vertical. These two Center 
commands change the midpoint of the horizontal and vertical scales (respectively) so that the 
midpoint of the scale is equal to the mean value (average) for that channel. These features are 
useful for centering the display so that it is easier to interpret. 

Ch. # Box  In X/Y mode, the channel numbering boxes are disabled. 

Meas. Menu In X/Y mode, the measurement popup menus are disabled. 

 

 Stacked Plot mode 

Stacked Plot displays multiple time ranges on top of each other and is enabled for acquisitons set to Append 
(except when in X/Y mode). In this mode, all appended segments are stacked in the display, but only one 
segment “slice”is active (“selected”). To view an individual segment, click the Chart mode icon. 

 Click the Stacked Plot mode icon to display the Stacked Plot controls beneath the toolbar: 

 

To change the active slice, click the  Jump Tool or the … icon. 

 
The selected segment is used for all enabled software functions. This means that autoscaling can easily create 
what looks like a mess if the selected segment is not appropriate for scaling the largest segment. In compound 
action potential graphs in Stacked Plot, the last segment slice will most often be the largest, so if you select 
the last segment before autoscaling you will likely get the expected result. The Transform menu is disabled in 
Stacked Plot mode. 

A commonly used data visualization technique for examining the evolution of waveform morphology is the 
2D waterfall plot or “stacked plot.” A stacked plot draws multiple traces for a single waveform on top of each 
other, or “slices.” Each individual slice is a time-shifted plot of the original waveform. The slices toward the 
bottom of the plot occur earlier in time then the slices toward the top. 

Data can be acquired in stacked plot mode, but it is processor intensive. If acquisition setup includes high 
sampling rates or control channels with low latency, acquire in chart or scope mode and switch to stacked plot 
mode after acquisition. 
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The slices can be aligned at any type of events in the graph. This allows for alignment at appended segments 
but also at locations found through other means. For example, an ECG waveform can be aligned at the start of 
the T-wave to examine how the T wave evolves in time. 

Active slice In stacked plot mode, there is a single slice that is called the “active slice.” By default 
it is drawn in black; to change the color, select Stacked Plot Options > Drawing 
Settings. The values on the axes in the graph, grid, displayed events and text 
annotations, selections, and any transformations all apply to the active slice. The 
active slice can be changed using the navigation buttons in the graph toolbar. 

Vertical Separation The vertical separation between consecutive slices is expressed as a percentage of the 
entire visible area. This percentage is kept constant through zooming and scrolling 
operations. 

Stacked Plot Options 

 
Display > Show > Stacked Plot Options 

 
Slicing Event… 

 
Drawing Settings… 

Use Stacked Plot Options to activate slices or visually distinguish the active slice from other slices being 
drawn in Stacked Plot mode. 

Automatic baseline  Adjusts the baseline of each inactive slice to overlap the baseline of the active slice 
prior to the application of any vertical separation. This helps compensate for baseline 
drift in a signal. If it is disabled, no baseline compensation will be applied and the 
stacked plot may exhibit visual vertical segment ordering problems resulting from 
baseline drift (but in this mode can be used as a tool to examine basline drift). 

Gray inactive slices Draws the active slice with a solid pen and draws inactive slices with a dashed gray 
pattern pen. The gray pattern alternates pixels between the chosen waveform color 
and the white background and has the effect of lightening the inactive slices, so you 
may need to zoom in to see the effect. 

Bold active slice Draws the active slice with a thicker pen. In step and line plot modes, plotting 
normally occurs with a one pixel wide pen. Inactive slices will remain one pixel wide 
while the active slice will have the thicker pen as indicated in the edit field. When the 
waveform is in dot plot mode, the pixel width will be added to the waveform's default 
dot size to increase the dot size for the active slice. 

Change active slice… Draws the active slice in a different color than the chosen waveform color. When 
enabled, the same color is used for the active slice of each waveform in the graph. 
The color can be changed by clicking on the colorwell to the right of the checkbox to 
generate a standard color picker to select color. 
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Automatically jump…  You can use the Jump tool (green arrow) to change the active slice.Each time 
the active slice is changed the left edge of the plot area will be changed to match the 
start of the newly activated slice. When disabled, each time the active slice is 
changed the display will be adjusted in such a way that the time interval between 
slice starting positions and the display origin is kept constant.  

Functionality in Stacked Plot mode 

Autoscaling 

When a graph is displayed in stacked plot mode, all autoscaling and related display operations (tile, 
compare, overlap) will examine the visible data of the active slice only. It will not be possible to perform 
autoscaling operations using the data of any inactive slice. 

Autoscale Horizontal 

In stacked plot mode, autoscale horizontal will make the active slice occupy the entire visible area. The 
slicing event corresponding to the beginning of the slice will be placed at the left edge of the screen and 
the next slicing event (or last sample point of the waveform if the active slice is the last slice) will be 
placed at the right edge of the screen. The vertical offset will remain unaffected. 

Data Views 

Different data views may have independent Stacked Plot settings. All settings are independent including 
drawing preferences, slicing events, vertical separation, and active slice settings. Stacked plot settings are 
stored individually for each data view in the graph file and will be restored when the graph file is opened 
from disk. 

Any graph-wide operation that may affect the active slice will update all data views that are configured to 
use stacked plot mode. This includes operations that affect the data (e.g. transformations) or events (e.g. 
waveform editing). 

Graphs Containing No Slices 

It is possible that graphs may not contain any slices whatsoever if no events match the slicing event 
criteria. If a graph in Stacked Plot mode contains no active slices, it will be drawn as if the graph was in 
regular chart mode with the following differences: 

All data is drawn using any active slice settings given in the stacked plot drawing options. 

The “Active slice” index will read “N/A”. 

The previous/next/choose slice graph toolbar buttons and “Display > Show > Stacked Plot Options” menu 
items will be disabled. 

It will be possible to view all data from t = 0 to the final data sample of the graph using the horizontal 
scrollbar. 

All autoscaling operations will function as if chart mode was active. Autoscale horizontal will make all of 
the data of the selected waveform visible on screen. 

If the table of available slices was being displayed prior to the removal/editing of the last matching slicing 
event, the table will be emptied and the “OK” button dimmed. The cancel button will remain active for 
the table window to be dismissed. 

The slicing event, vertical separation, and drawing menu items and toolbar controls will remain active. 
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 Playback Mode (Replay) 

Playback mode will replay a graph file stored on disk in real time to 
simulate acquisition. Analog, digital and calculation channels are 
replayed as stored in the graph file, but in AcqKnowledge 4.2 and higher, 
calculation channels can be reconfigured to reproduce online calculation 
channels that have no offline equivalents. Calculation channels from the 
original graph can be modified, extended, or removed without affecting 
the data stored on disk in the original graph file. 

1. Select File > Open for Playback. 

2. Locate a graph file and then click Open. 

3. A new graph window will be generated. 

 The “Connected to…: hardware menu will indicate that the 
graph will be “acquiring” data from the specified file and the 
Start button will change to a “Replay.” 

4. Press Replay to begin playback. 

 Button alternates with STOP, can’t pause. 

5. Select Playback > Quit Playback Mode to return to acquisition 
status. 

 
Use Playback to experiment with 
different calculation channels 
settings on the same data or to 
recreate an experiment for 
demonstration purposes. 

Playback mode has millisecond timing accuracy and allows for reconfiguration of most acquisition 
parameters. Exceptions include: 

 Length is limited to the amount of data in the file 

 Acquisition Sample Rate is fixed (use Channel Sample Rate to downsample) 

 Number of analog and digital channels is fixed  

 Save last, MP, and Averaging modes are disabled 

 “Append” will replay the same data. 

Do not record data while playing back a data file. If one data file is open in "Playback" mode and is 
'replaying' and a second data file is open in MP150 mode and is acquiring data, clicking back and forth 
between graph windows causes the MP150 menu to flip to the Playback menu (even though 'Connected to' 
shows communication with an MP150 unit). 

See the AcqKnowledge Demo file under the Help menu as a sample of data playback. 
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Data Views 

A “Data View” window is used to provide an alternate view of the same data. You can present data in two or 
more modes for comparison, such as X/Y plots and chart plots. To compare responses in real time, turn off 
Autoplot in one Data View (e.g., Dose 1) and continue Autoplotting in another (e.g., Dose 2).  

To create a new Data View for the active (selected) graph, choose 

 File > New  and select type Data View or 

 Display > Create Data View 

This will generate a new window displaying the active graph’s data, and will name the new window “Data 

View of ‘Filename’” . 

TIP Use the Jump-to tool (see page 158) to correlate data views. 

Data Views share fundamental data characteristics such as channel labels, markers, and sampling rates, but 
can be customized for the following: 

 horizontal scale, precision, and offset 

 vertical scale, precision, and offset 

 measurements, including number of 
rows, precision, visibility, and use of 
interpolation 

 grid settings, including spacing, 
visibility, and locking state 

 selected area 

 autoplotting 

 hidden channels 

 autoscrolling 

 channel button display state 

 wave color 

 marker display state 

 channel order 

 plot mode 

 channel drawing mode (step, line, or dot, 
including dot plot size and type) 

 hardware “connected to” display 

The Data View window can be used like any other graph window. The menus and controls can be used to change 
how the data is presented. An acquisition can be started or stopped in any of the Data Views for a graph, and any 
transformations performed on the data in the Data View will be reflected in the graph and all of the other Data 
Views. Printing a graph from a Data View will use the display settings of that Data View for outputting the graph. 

When a file is saved to disk, the display configuration of any Data Views that are open are saved into the graph 
file. When the graph file is reopened, all of the Data Views and their display settings will be restored. 

 Data Views are saved with the data file only if they are open at the time the original graph is closed and 
saved. 

 Closing a Data View causes this view to be lost; it is not saved with original file. 

 Closing a Data View that was previously saved with a data file will not be saved if the data file is saved 
after closing the Data View. 

 Closing a Data View will not invoke a warning that the Data View will not be saved. 

 Original Data Snapshot is not merged into the newly created data file. 
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Analysis 

For purposes of illustration, you should open an existing file that contains actual data. 
Sample files were installed with the software. Select File > Open and choose a file from the 
list in the dialog. 

If you open the file called demo data.acq, the screen should resemble the following sample 
file display. 

 
Sample File Display 

The sample graph displays six different types of data, and there is a border between the waveforms. 

To the left of each waveform is a vertical strip containing a text string that can be used to help identify each 
waveform. 

The time scale along the bottom denotes when the data was recorded relative to the beginning of the acquisition. 

 Only the last eight seconds of the total data record are visible, although the file contains 
the complete record. 

 The data displayed on the left edge of the graph represent events that occurred about 22 
seconds into the record, and the data displayed at the right edge of the screen represent 
events that occurred about 30 seconds after the acquisition was started. 

The maximum vertical scale range is from +10 to -10 Volts. 

 This reflects the maximum input voltage the MP150 unit can accept and is a greater 
range than you will usually encounter. 

 The display scale can be adjusted to virtually any value range, as demonstrated in the 
graph window above. 

As indicated by the horizontal scale, only a few seconds of data are displayed on the screen. If you choose 
Statistics from the Display menu, you can determine the total length of the record. 

To view data that was collected earlier in the record, you can use the horizontal scroll bar to move to different 
points in the record. The horizontal scroll bar allows you to move around in a data file, just as the scroll bar in a 
word processor allows you to move to different points in a document. 

Alternatively, you can position the cursor in the horizontal scale area (where the numerical values are listed) and 
click the mouse button. This will generate the following dialog (see page 172 for details). 
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The Time scale box allows you to change the amount of data that appears on the screen at any given time. In the 
sample dialog, this is set to 2 seconds per division. The divisions on the screen are indicated by the four vertical 
lines, thus displaying eight seconds at a time (two seconds per division times four divisions). By entering a larger 
value in this box, more of the record will be displayed on the screen at any given time. Conversely, entering a 
smaller value in this box will cause a shorter segment of data to be displayed on the screen.  (Above screenshot is 
from AcqKnowledge 4.2) 

 To display the entire waveform (in terms of duration), a shortcut is to choose Autoscale horizontal from 
the Display menu. The Autoscale horizontal command fits the entire data file into the window, regardless 
of the total length of the acquisition. 

The Initial time offset box lets you “jump” to a different point in the time display. Changing the value in this box 
allows you to display data beginning at a certain point in the record. For instance, if you want to see the data at the 
beginning of this record, you would tell AcqKnowledge to display data with an initial offset of 0 seconds, which 
would result in the following: 

As you can tell from the time 
scale, the first data displayed (at 
the left edge of the screen) was 
collected at the beginning of the 
acquisition. Also, the scroll box 
has moved to the left, indicating 
that the data on the screen 
represents data collected earlier 
in the record. 

If you click in the horizontal 
scale area again, the same dialog 
will appear, and this time the 
value in the start box should have 
changed to reflect the new 
section of data being displayed 
on the screen. 
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AcqKnowledge also allows customization of the vertical 
scaling, or amplitude, of each waveform. Clicking the 
vertical scale area produces a dialog (see page 173 for 
details). 

The vertical scale dialog allows you to change the range 
of amplitude values displayed (scale) and set the value 
that appears in the center of the vertical scale (midpoint).  

You can vary the midpoint and apparent magnitude of 
each waveform by changing the values in each box. By 
changing the value in the scale box, a smaller value has 
the effect of increasing the apparent amplitude. Entering 
a number about half the current value will cause the 
amplitude of the wave to appear to double. 

 Scale—In the sample dialog, the units are set to 2 
Volts per division. As with the horizontal scale, 
there are four divisions on the vertical axis, so 
this setting should show 8 Volts range of data. 

 Midpoint—The box below this controls the midpoint of this range. In this case, the midpoint is set to 2 
Volts, which means that this channel will display the range from - 4 Volts to + 8 Volts. 

As with the time scale, you can have AcqKnowledge automatically come up with the best fit in terms of midpoint 
and units per division. To do this, select the Autoscale waveform command from the Display menu, and the 
amplitude and offset of each wave will be adjusted to fit their sections. 

Any changes you make in terms of rescaling (either horizontal or vertical) will only affect the way data is 
displayed, and will not change the basic characteristics of your data file. 

 

Selecting a waveform 

Although all four waves are displayed at once, you may want to operate on only one channel at a time. To do this, 
you need to select the channel you wish to work with. Selecting a channel allows you to highlight all or part of 
that waveform, and enables you to perform transformations on a given channel. 

In the upper left corner of the graph window there is a series of boxes that represent each channel of data. The 
numbers in the boxes correspond to the channel used to acquire the data (the specifics of setting up channels are 
discussed on page 36). In the sample waveforms shown previously, ECG channels are represented by channels 1 
and 2, with respiration on channel 4 and blood pressure on channel 5. 

To select one of these channels 

 position the  cursor over the channel box  that corresponds to the channel you wish to 
select and click the mouse, or  

 position the  cursor on the waveform of interest and click the mouse. 
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Show/Hide Channel 

To “hide” a waveform, press ALT for Windows or OPTION for Mac and click the channel box. 

To view a hidden waveform, repeat the appropriate key-click combination. 

 

Zoom 

Another way to examine data is to use the “zoom” tool. The zoom tool allows you to select any portion of any 

wave and magnify it as much as possible. To use the zoom tool, click the  icon in the lower right portion of the 

screen. As you move the mouse into the graph area, you will see it change from an arrow  to a crosshair (+). 
Start by positioning the cursor in one corner of the box, holding down the left mouse button, and dragging the 
crosshair horizontally, vertically, or diagonally to form a “box” which encompasses the area you need to zoom in 
on. When you release the mouse button, AcqKnowledge will automatically adjust the horizontal and vertical 
scales. To “unzoom,” choose Zoom back from the Display menu. 

 

Select an area 

Once you have selected a channel, you can “edit” parts of that channel by selecting a section of the waveform. 
The options available to you include cutting, copying, and pasting sections of waveforms. You can also transform 
and analyze entire waveforms or specific sections of waveforms. 

For any of these functions, you will need to select (or highlight) an area to be operated on. If you want to select a 

section of a waveform, position the cursor over the  icon in the lower right hand corner of the screen and click 
the mouse button. Now move the cursor to the first point in the area that you wish to select. As you move the 
cursor into the graph area, you will see it change from an arrow cursor to a standard I-beam editing tool. 

To highlight a section of a waveform, position the  cursor at the left edge of the area you wish to select and 
hold down the mouse button. Now move the mouse to the right until you have selected the desired area. 

To select more than one screen of data, position the  cursor at the left edge of the section to be highlighted, 
then click and hold the mouse button. Use the scroll bars to move to a different point in the record, and when you 
reach the desired endpoint (right edge) of the selected area, hold down the Shift key while you position the cursor 
and click the mouse button. Selecting an area this way will also allow you to “fine tune” the selected area to 
include only a specific range of data. 

Once a channel has been selected and a section of that area highlighted, you can operate on and edit that section of 
the waveform. The editing commands behave much the same way as the editing functions in a word processor. 
You can cut, copy, delete or paste sections of data as defined by the selected area. In most cases (depending on 
available memory) you may undo an edit by choosing Undo from the Edit menu, or by using the shortcuts CTRL 
+ Z for Windows or +Z for Mac. 

Selecting a portion of a waveform also allows you to apply transformations to a particular area, rather than the 
entire area or all waveforms. Selecting an area also allows you to take snap measurements for parameters such as 
delta T, mean, standard deviation, frequency, and so forth. The measurement options are discussed in the next 
section. 

The Selection Palette (Display > Show > Selection Palette) can also be used to select an area. 

Keyboard data selection 

Keystroke combinations can similarly used to select or deselect graph data on a sample-by-sample basis. This 
helps add an enhanced level of precision to the selection operation. See data selection keyboard shorcuts on the 
following page. (AcqKnowledge 4.2 and higher) 

Keyboard Shortcut Description 
Windows: Shift + Ctrl + Left Arrow 
Mac: Shift + Command + Left Arrow 

Subtracts one sample interval from the right edge of the selection. If the selection is 
empty, no action is performed.  

Windows: Shift + Ctrl + Right Arrow 
Mac: Shift + Command + Right Arrow 

Subtracts one sample interval from the left edge of the selection. If the selection is 
empty, no action is performed. 

Shift + Left Arrow Adds one sample interval to the left edge of the selection. 
Shift + Right Arrow Add one sample interval to the right edge of the selection. 
Left Arrow Moves the selection one sample to the left, constructs a zero width selection. 
Right Arrow Moves the selection one sample to the right, constructs a zero width selection. 
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Transform data 

AcqKnowledge includes a library of functions to transform data or perform 
mathematical calculations on waveform data. All of these options can be found under 
the Transform and Analysis menus, and are discussed in detail in the Analysis section 
beginning on page 29613. 

When performing transformations 

 If a section of a waveform is highlighted, the transformation will apply to 
that section. 

 If no area is selected, AcqKnowledge will always select a single data point. 

 If the transformation can only be performed on a selected area (digital 
filtering, for instance) and a single point is selected, the entire waveform 
will be used (and the transform entire wave option will be disabled; close 
out of the dialog and select an area if desired). 

 

Measurements 

Once you have selected a channel to work 
with, you can quickly and easily take 
measurements on each wave. The 
measurements appear in the row of boxes 
across the top of the graph window. You can 
specify the number of measurement boxes to 
show and the display precision in the 
“Preferences” dialog of the Display menu. 
Each measurement consists of three parts: (a) 
the channel selection, (b) the measurement 
function, and (c) the result or actual 
measurement value.  

The pull-down channel selection allows you to calculate a measurement either for the selected channel (SC) or 
from a numbered channel in the record. To switch between the channel options, click in the channel window. The 
pull-down menu shows the channel numbers and labels for all channels in the file. By default, each measurement 
will reflect the contents of the selected channel. 

The pull-down measurement menu allows you to choose between different types of measurements. To choose a 
measurement, click the measurement popup menu and select a measurement from the list. 

 Some measurements (such as Time or Value) look at only a single data point whereas other measurements 
(such as mean and delta T) examine a range of data on the selected channel. 

 Some of the measurements that depend on a selected area (such as delta T) look at differences in the 
horizontal axis measurement whereas other range measurements (such as peak-peak) use the vertical scale 
information in calculating measurements. 

For a complete description of each of the measurement functions, turn to page 1887. 

The final component of a measurement window is the measurement result. 

 When an area is selected (or if the selected area is changed) the measurement result automatically updates 
to reflect the change. 

 

In this example, results for the selected channel (SC) are: 

 Time 17.28 sec 

 delta t 0.00000 sec 

 freq 0.10157 Hz 

 bpm 6.09446 BPM. 
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Events (Markers) 

 

In many instances it is useful to have the software mark an occurrence 
or event during an acquisition so it can be referenced later. For 
instance, you may want to note when a treatment began or when an 
external event occurred so you can examine any possible reaction. 
The software uses “Events”, which are marked in the data to record 
events.  

Event markers can be pre-established and automated. Event icons and labels appear at the top of the graph 
window, and can be edited, displayed, or hidden from view. 

You can automatically insert event markers during an acquisition by pressing the Esc key. This will insert a 
marker at the exact time the key is pressed and will activate the text line entry so you can immediately enter a 
comment to be associated with the marker. 

For a detailed description of markers and marker functions, including options to pre-establish marker labels and 
set function keys for different labels, see Set Up Event Hotkeys (page 207). 

See also: Text Annotation, page 158. 

 

Grids 

  
Grid superimposes a set of horizontal and vertical lines on the graph window. The grid is designed to allow for 
easy measurements, since the grid lines correspond to horizontal and vertical scale divisions. The grid can be 
locked (analysis, printing) or unlocked (visual aid). 

To activate the grid display, choose Display > Show > Grid or click the  toolbar icon. 

 To display minor grid lines, use Ctrl- . 

 To customize grid line and color and optimize the display and print features, choose Display > Show > Grid 
Options. 

For more information about using and printing grids, see page 175. 

Note: The Scale dialogs change when grid lines are locked. See page 172 for details on Horizontal Scale and page 
173 for details on Vertical Scale. 
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Journals 

The Journal is a general-purpose text editor built into AcqKnowledge that works like an “electronic notepad” for 
recording notes and data and saving text and/or numeric values for later review. The Journal can be used at the 
same time data is being acquired. Every graph file has a graph-specific Journal file permanently linked to it. There 
is also an option to generate independent Journals for data view, use with multiple graphs or protocols.  

Graph-specific journal—Journal is saved with graph; 
preferable for retaining notes and analysis within a 
graph file. Display settings are independent. To save 
a graph-specific Journal independent of its graph, 
use File > Save Journal Text As option. 

Independent Journal—Journal is saved into its own 
file, separately from graphs; preferable when 
performing analysis on multiple graphs at the same 
time. Independent journals allow multiple journal 
windows to be open at the same time (each graph 
view can have its own journal associated with it), but 
only one Independent Journal can be used at a time.  

For more information on using Journals, see Journal Details on page 80. 

Saving data 

Once data has been collected, it can be saved as a file and opened later. The data file can be moved, copied, 
duplicated and deleted just like any other computer file. By default, files are saved as AcqKnowledge (.ACQ) 
files, which are a proprietary format designed to store information in a format as compact as possible. Although 
these files can only be opened from within AcqKnowledge, the data in these files can be exported either as a text 
file or as a graphic image. 

Exporting data to a text file allows you to examine the data using other programs, such as a spreadsheet or 
statistical analysis package. Saving data as a graphic (.JPG) enables you to work with the data in graphic format. 

One of the most useful applications of this is the ability to edit and place AcqKnowledge data as it appears on the 
screen. You can use this feature to paste graphs into word processors, drawing programs, and page layout 
programs. To learn more about these options, turn to the Save As section beginning on page 12246. 

Format change warnings 

When a file save function requires a format change for compatibility or alters file content, a prompt will be 
generated to require the user to confirm the option to update format or convert and save.  
 

  
Created with a previous version of AcqKnowledge  Windows PC AcqKnowledge format 
 

  
Saving as a “Graph Template” will erase all data Imported from another file format 
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“Data Snapshot” — Embedded Archive 

“Data Snapshots”are essentially embedded archives of the original acquired data that are stored with the graph file 
so you can easily view them together at a later time to compare results to original waveforms or intermediate 
stages of analysis. 

IMPORTANT Archive functions do not create a new file—they are not backup functions.  
Original data is copied and pasted to the end of the original file.  
You cannot use this feature to recover lost or damaged original data. 

There are two ways to create a snapshot: 

1. Automatic after acquisition: Display > Preferences > Other > Create Data Snapshots after acquisitions 

 
When this is enabled, a date-stamped archive of the data in the graph when acquisition stopped is created. 
In Append mode, the entire graph is archived with each Append, old data as well as the newly acquired 
data.  

This is a memory intensive function; 
each archive that is added to a graph file 
will increase its size on disk by 
approximately 40%. When prompted, 
click OK to proceed.  

2. Manual: Edit > Create Data Snapshot 

  
A snapshot is then taken of the data at that point in time and stored with the graph. Manual archives allow 
you to preserve intermediate stages in a complex analysis for future reference. You will be prompted for a 
comment to describe the archive. This description will be used in the header when you display the archive. 

To view the embedded archive(s) associated with a graph file, choose Display > Show All Data Snapshots. 

This will open a new graph window for each archive associated with the graph. The time portion of the Filename 
for each graph is from the computer clock (saved with semi-colons because you cannot save a file with colons in 
the filename). The “Data Snapshot from…” graph will open with no Start button.  

Manual Archive: description and time 
Original file 
Automatic Archive: time only 

Snapshots will also retain the following in addition to the data: 
 Events - Text annotations  
 Graph-specific journals 
 AcqKnowledge GLP Modification logs (ACK100W-G and ACK100M-G only)  
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Print 

AcqKnowledge allows you to produce high-resolution hard 
copy plots of graphs much as they appear on-screen. 

 To print a file, choose Print from the File menu. This 
will print the contents of the screen on the selected 
printer. 

 To print the entire file, choose Autoscale Horizontal 
from the Display menu first.  

 You must print a journal as a separate command from 
print graph file. 

You may instruct AcqKnowledge to print the contents of a 
file across several pages by entering a value in the Fit to 
box. Entering “4” in this box, for instance, will place the 
length of the page evenly across four pages when printing. 

Print options are available after you click OK in the initial 
File > Print dialog; see page 12254. 
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Chapter 3  User Interface & Context Menu Features 

 

 
 Toolbars 

 Keyboard Shortcuts 

 Mouse Controls 

 Custom toolbars for transformations and analysis 

 Toolbar position retention and changes 

 Event tool enhancements 

 Typed event label drawing improvements 

 Choose MP150 Help Button 

 Button Transparency 

 Customizable Chart Track Dividers 

 Plotting Background Colors 

 Vertical axis scaling buttons 

 Long channel labels and units 

 Graph window tooltip improvements 

 Menu item tooltips 

 Channel Info 

 Transformation history 

 Canceling Transformations 

 Transformation Progress Bar 

 

Toolbars 

Many of the most commonly used features in AcqKnowledge can easily be executed 
with a mouse click. The toolbars contain shortcuts for some of the most frequently used 
AcqKnowledge commands.  

Choose Display > Show or right-click outside the data window and enable Toolbars in 
the context menu. Click an icon to activate it; icons are grayed out when they are not 
applicable. 

Toolbar position—Toolbars for Measurements, Channel number, and Hardware revert 
to the default location when a file is opened (position is not retained). 
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Toolbar (Display controls) 

 
ICON FUNCTION 

 Change display to scope mode. 

 Change display to chart mode (default). 

 
Change display to X/Y mode. 

 Toggle Stacked Plot (overlap segment) mode; see page 41. 

 
Autoscale selected waveform only. 

 
Autoscale waveforms along the horizontal axis. 

 
Center waveforms vertically in the active window. 

 Center waveforms horizontally in the active window (X/Y mode only). 

 
For channels that have range information, set the vertical scale to match the maximum 
allowable input signal for the MP unit 

 Find the peak of a selected area. 

 Find the next peak (after peak has been defined). 

 
Click and hold the mouse to produce a list of graph (.acq) files in the current folder. 

 Show/Hide gridlines in the graph window. 

 
Show/Hide Hardware “Connected to:”  in the graph display; also functions via Display > 
Show > Hardware. 

 Show/Hide measurement pop-up windows. 

 Show/Hide channel selection boxes. 

 Channel selection boxes  appear above the data window and indicate the 
channel(s) being used to record data. 
 To select a channel, depress the corresponding channel number box (CH 1 is selected 

here). 
 To hide a channel, Alt-click (PC) or Option-click (Mac). A slash mark will cover the 

channel box and the channel will be hidden. 

 Show/Hide events (markers) and enable Event toolbar icons:  

 Text Annotation display (see page 158.) 

 Show/Hide graph-specific journal (Mac—Journal must be open for icon to work). 

 GLP—requires  installation of AcqKnowledge GLP (Good Laboratory Practice) 

 
Rewind—deletes the last recorded segment. Alt+Rewind (Windows) or Option+Rewind 
(Mac OS X) deletes all recorded data, similar to the Append “Reset” button. 

 
Open the customize toolbar menu. 

 
Toggle display of the Media Capture viewer. 

 
Toggle display of the Media Playback viewer. 
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Hardware Toolbar 

  
The hardware toolbar displays connected to information and includes quick access to add/change hardware. 
The Hardware toolbar reverts to the default location when a file is opened (position is not retained). 

Also functional through the Toolbar icon   

Cursor Toolbar 

 
The cursor tool icons are in the lower corner of the graph window. These cursor tools are used in many of the 
on-screen functions described below, including editing, measurements, and the amount of data displayed. 

The cursor tools are also accessible via the Display menu (Display > Cursor Style) 

CURSOR TOOLBAR 

 
This is a general-purpose”arrow” cursor tool, used for selecting waveforms, scrolling through 
data, and resizing the chart boundaries between waveforms when in chart mode. All other 
cursors default to this mode when the cursors are moved outside the graph area. Use Alt-
click to step through the channels; each click makes a new channel “active.” The arrow 
cursor can also be activated by the Ctrl+B keystroke. 

In AcqKnowledge 4.2 and higher, holding down the left mouse button with the arrow tool 
positioned over a graph channel will activate a single data point, which displays as a solid 
black vertical line. This is known as “spot measurement” mode. Dragging the mouse will 
then update selected measurement values to the new horizontal locations of the arrow’s 
position in the graph. The mouse button shoud be depressed for approximately 0.5 seconds in 
order for spot measurement mode to become active. Releasing the button restores the arrow 
cursor to its normal status.  

 
This is a standard “I-beam” editing tool. This tool is used to select an area of a waveform (or 
waveforms) to be edited or transformed. To select it, click the middle button in the lower 
right hand corner of the screen. Now move the cursor toward the waveform. You’ll notice 
that the cursor changes from an arrow to an I-beam when it is placed over the graph area. 
Using this tool to edit data is analogous to editing text with a word processor.  

When this cursor appears, you can select an area of data by holding down the mouse button 
and dragging the mouse to either the left or right. You can extend the selected area to include 
data that is not on the screen by positioning the cursor at the left edge of the area to be 
selected and clicking the mouse button. Next, use the scroll bars to scroll through the data 
until the desired data appears on the screen. Hold down the shift key while you position the 
cursor to select the right edge of the area to be selected. Click the mouse button to select the 
area. To extend the selection, hold the Shift key and move the cursor or the arrow keys. The 
I-beam cursor can also be activated by the Ctrl+I keystroke. 

 
This is a standard “zoom” tool. The zoom tool lets you select and magnify any portion of any 

wave. Click the  icon (in the lower right portion of the screen) to use the zoom tool. As 

you move the mouse into the graph area, it will change from an arrow  to a crosshair (+). 
Start by positioning the cursor in one corner of the box, then hold down the (left) mouse 
button and drag the crosshair horizontally, vertically, or diagonally to form a “box” that 
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CURSOR TOOLBAR 

encompasses the area you need to zoom in on. When you release the mouse button, 
AcqKnowledge will automatically adjust the horizontal and vertical scales. To “unzoom,” 
choose Zoom back from the Display menu.  

Hold the “Alt” key to change the zoom mode to zoom out (“– “in the magnifier). The zoom 
tool can also be activated by the Ctrl+G keystroke. 

Grid 
Control 

 

Adjust the grid lines horizontal and vertical. Hold the option key for locked grids to drag to 
the end. 

Event 
Definition 

 

Inserts an event at the mouse click location. See page 213 for Event details. 

 On a plot, the horizontal location matches the ‘x’ coordinate of the click 

 In Chart mode, the event will be placed on the channel track where the click took 
place. 

 In Scope mode, the event will be defined on the active channel. 

 Within the marker bar, clicks define global events. 

When Event Definition is active, the cursor changes to a flag and the cursor includes a 
downward pointing arrow to indicate where the event will be defined. 

The Event Definition tool is disabled in X/Y mode and if events are not visible. 

Event 
Removal 
“Zap” 

 

Deletes event(s) from a graph with the mouse. It allows for quick editing to eliminate 
misclassified events found through visual inspection. 

 If the user clicks on a single event, that event will be removed from the graph.  

 If the user clicks and drags to define a rectangular area (similar to the zoom tool), all 
events between the left and right edges of the area will be removed; the event icon does 
not need to lie vertically within the bounded area in order to be removed. 

When Event Removal is active, the cursor changes to a lightning bolt. 

Jump-to 

 

Data views and advanced analysis output display multiple representations of the same data at 
the same time. Sometimes this association may be abstract or difficult to visualize. The 
Jump-to tool is a green arrow, and is available in all display modes and during acquisitions. 

Use the “Jump-to” tool to correlate data. 

 Click the Jump tool on a data point to “jump”all of the open data views for that graph 
to the same time. 

 Click the Jump tool on a point in an X/Y plot to jump data views in chart or scope 
mode to the point in time corresponding to the point in the X/Y plot. This can be 
useful for correlating PV loops back to other acquired signals. 

 Rate analysis output graphs will jump back to the corresponding point of source data 
at the start of that cycle. 

 Clustering scatterplots will select the appropriate segment of the source graph 
corresponding to the chosen data point. 

 Change the active segment in Stacked Plot mode; once a trace is selected the display 
will adjust to show the new active segment. 

Text 
Annotation 

 

Use Text Annotation to add floating text notes on top of data in a graph; the text notes move 
and scale with the data. During report or figure preparation, it is nice to be able to add 
additional textual information on top of signals to help clarify signals for readers or draw 
their attention to particular areas of visual interest. AcqKnowledge provides a text annotation 
facility to assist in figure preparation. 

Click the A icon and then click in the graph window to generate the Text Annotation 
Contents dialog. Drag the red “handles” from the annotated text to add connector lines to 
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CURSOR TOOLBAR 

connect the text to the data.  

 

Text 
Annotation 

 
continued 

 
 

 

 

 

 
Connector handles 

 
Add a range 

 
Resize a range 

 
Move a connector 

  
Text annotations are short pieces of text that float above channel data and can be used to 
draw visual attention to particular areas of interest in a graph. These text annotations can be 
simple outlined text, can have a connector from the outline boundary to a specific sample 
point on the waveform, or have a range indicator of a specific width. Each text annotation is 
tied to a sample of data in a channel; when the data is moved by coping, pasting, or other 
waveform editing operations, text annotations remain fixed to their corresponding sample 
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CURSOR TOOLBAR 

positions, similar to channel events. 

Although text annotations are tied to horizontal locations like events/markers, they are 
displayed in a relative fashion. The relative pixel distance between the text annotation outline 
boundary and the sample of data remains the same under zoom and autoscaling operations. 

 For example, an annotation that is 20 pixels above a T-Wave peak position will 
continue to be drawn 20 pixels above regardless of zoom. This allows for flexible 
data viewing while maintaining text annotation visibility. 

 

 

Text annotation controls 

Create Insert using the text annotation cursor tool. With the tool active, click in 
the graph to define a new annotation. 

Select Click an annotation once to select it. 

Reposition Drag a selected annotation to reposition it. 

Add Connector Connectors or range indicators can be added to selected annotations by 
using the editing handles on the edges of the selected annotation. 

Edit Connector If the selected annotation has a connector to a data point of the graph, an 
editing handle will appear on the end of the connector. The connector can 
be moved to a different data sample of the graph by dragging the editing 
handle on the end of the connector to the new position in the channel. To 
remove the connector, grab the editing handle on the end of the connector 
and drag the mouse inside the text annotation. 

Range Indicator If the selected annotation has a range indicator, editing handles will 
appear at both ends of the range indicator. To resize the range indicator, 
grab an editing handle and move the mouse. To remove the range 
indicator, grab an editing handle and move the mouse back inside the text 
annotation. 

Autoposition Resizing windows or adding channels may reposition text annotations 
outside of the visible area. Click and hold down the text annotation tool to 
activate the text annotation popup menu. The “Autoposition Hidden 
Annotations” option automatically repositions all annotations so they are 
visible. 

  
Clear all Click and hold down the text annotation 

tool to activate the text annotation 
popup menu. The “Clear all 
annotations” option will clear all 
annotations. This action cannot be 
undone so you will be prompted to 
confirm your selection:  
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Selection palette 

 
Many of the tools within the AcqKnowledge environment are based around the selection. The selected range 
of data in the graph is used as the source for measurements, waveform editing, transformations, and other 
operations. The Selection Palette is a floating dialog that can be used to precisely enter the selection. See page 
413 for Selction Palette guidelines. 

Start/Stop toolbar 

 toggles to  

Channel Number Toolbar 

Toggles the display of channel number and label region. The 
Channel Number toolbar reverts to the default location when a file is 
opened (position is not retained). 

.  

Also functional through the  Toolbar icon. 

Events toolbar 

 
Select a marker to enable the toolbar. Use the arrows to move 
forward or backward through all event marker types. Click the event 
palette icon to generate the event palette. 

Measurements toolbar 

     

Click the down arrow for quick access to measurement preset 
functions. Right-click in the measurement bar for quick access to 
options for copying measurement and using linear interpolation. 
The Measurements toolbar reverts to the default location when a 
file is opened (position is not retained). 

Custom toolbars for transformations and analysis 
AcqKnowledge 4.1 and above allows users to construct new 
toolbars for triggering transformations and analysis. An arbitrary 
number of toolbars may be created and populated with buttons 
that can trigger any menu item in the Transform and Analysis 
menus. The contents of the text-only buttons match the menu 
item title. These toolbars will persist for each user and their 
positions and visibility within the graph window will be retained. 

 Transformation toolbars may be accessed via the 
"Customize Toolbars" button next to the rewind button.  
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Toolbar position retention and changes 
In AcqKnowledge 4.1, toolbars can be 
rearranged within the graph window or 
detached and turned into floating tool 
windows. Any modifications made by the 
user to the position of most toolbars within 
the graph window will be stored as an 
application preference and used for new 
graph windows as they are created and graph 
files that are opened from disk; however, toolbars for Measurements, Channel number, and Hardware will 
revert to the default location when a file is opened (position is not retained). Default toolbar positions have 
changed to move the Start button and cursor tools to the top of the graph window; users preferring the 
ordering in previous versions may manually reposition the toolbars. Toolbar Tooltips may be deactivated 
when toolbars are detached from a graph.  

Axis Controls 

 

If axis controls interfere with scale values,  

  
adjust the opacity slider in Preferences > Graph 

 
to hide the icons until the cursor passes over them 

. 
 

 
A “scaling” button acts as a shortcut for opening the grid and visible range dialog, similar to double-
clicking the axis. If a channel corresponds to an analog channel that has calibration steps, a calibration 
wrench button be displayed and will open the hardware calibration dialogs. This allows visual access 
to commonly used operations for channels. 

 
Module dependent: Generate the scaling or calibration dialogs for the channel input or calucation. 
Analog inputs will open to the scaling dialog and and channels that require calibration will initiate a 
repeat calibration routine.  

 

 

Use Display > Channel Info or use the channel’s contextual menu to display the Channel Information. 

 
Toggle the lock icon at the right edge of the window to change the lock state of the grid for horizontal 
axis or the channel. Uunlocked is open (latch to right); locked is closed. 
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Enable cursor tools during acquisitions 
Enables access to cursor tools while recordings are in progress. (AcqKnowledge 4.2 and higher only, Display 
> Preferences > Graph) 

Button Transparency 

Scaling, calibration, transformation history, and grid lock buttons may be made semi-transparent to allow 
units, axis values, and other information underneath the buttons to remain visible. The Preferences > Graph 
panel includes an “Axis controls” slider to change drawing from fully transparent to fully opaque.  

When the mouse is within the buttons, they will be drawn fully opaque regardless of transparency setting. The 
transparency is shared by the scaling, calibration, transformation history, and grid lock buttons and is the 
same for all open graphs as this is an application-level preference. 

Customizable Chart Track Dividers 

Starting with AcqKnowledge 4.1, users may change the color used to draw the dividers between channels 
tracks The Preferences > Graph panel contains "Chart Track Divider Appearance" options.  

Plotting Background Colors 

Starting with AcqKnowledge 4.2, customizable background colors for individual graph channels are available 
in Preferences > Graph > Plotting Background Colors. 

Spectrum Analyzer Palette 

The Spectrum Analyzier Palette provides a dynamic display of the 
frequency decomposition of data, in real time or post-acquisition.  

See page 1416 for details.   
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Keyboard shortcuts 

Menu Option Windows OS Mac OS X  

Program info Help > About AcqKnowledge AcqKnowledge menu 

Quit Ctrl + Q  Q 

Hide AcqKnowledge minimize (corner box)  H 

File menu   

New  Ctrl + N  N 

Open Ctrl + O  O 

Open for Playback   

Close Ctrl + W  W  
Alt+left-click to close all 

Save Ctrl + S  S 

Save As   

Save Selection As   

Save Journal Text As   

Send E-Mail Attachment   

Page Setup   

Print Ctrl + P  P 

Quit Ctrl + Q  

Edit menu   

Undo (when applicable) Ctrl + Z  Z 

Cut Ctrl + X  X 

Copy Ctrl + C  C 

Paste Ctrl + V  V 

Clear (journal) Delete key none 

Clear All   

Remove Last Appended Segment Use the Rewind toolbar icon  

Insert Waveform   

Duplicate Waveform Ctrl + D  D 

Select All Ctrl + A  A 

Remove Waveform   

Create Data Snapshot   

Merge Graphs   

Clipboard 
 > Copy Measurements 
 >  Copy Wave Data 
 > Copy Graph 
 > Copy Acquisition Settings 
 > Copy Data Modification History for 
All Channels 
 > Copy Data Modification History for 
Selected Channels 

 
Ctrl + K 
Ctrl + L 
 
Ctrl + U 
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Menu Option Windows OS Mac OS X  

Journal 
 > Paste Measurements 
 > Paste Wave Data 
 > Paste Graph 
 > Paste Acqusition Settings 
 > Paste Modification History for All 
Channels 
 > Paste Modification History for 
Selected Channels 
 > Show Journal 

 
Ctrl + M 
Ctrl + / 
Ctrl + J 

 
 M 

Transform Menu   

Recently Used   

Digital Filters   

Fourier Linear Combiners   

Math Functions   

Template Functions   

Integral   

Derivative   

Integrate   

Smoothing   

Difference   

Resample Waveform   

Resample Graph   

Expression   

Delay   

Rescale   

Waveform Math   

Analysis menu   

   

Find Cycle Ctrl-F  F 

Find Next Cycle Ctrl-E  E 

Find All Cycles Ctrl-R  R 

Find Rate none none 

Display menu   

  Tile Waveforms 
  Autoscale Waveforms 
  Overlap Waveforms 
  Compare Waveforms 
  Autoscale Horizontal 

 
Ctrl+Y 
 
 
Ctrl+H 

 

Zoom Back 
Zoom Forward 

Ctrl + - (minus key) 
Ctrl + = (equal key) 

 - 
 + 

Reset Chart Display   
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Menu Option Windows OS Mac OS X  
Reset Grid 
Adjust Grid Spacing 
Set Wave Positions 
Wave Color 
Horizontal Axis 
Show 
Customize Toolbars 
Channel Info 
Preferences 
Size Window 
Cursor Style 
Create Data View 
Organize Data Snapshots 
Show All Data Snapshots 
Load All Data Into Memory 

M150 menu   

Set Up Channels 
Set Up Acquistion 
Set Up Advanced Averaging 
SetUp Triggering 
Set Up Stimulator 
Set Up Sound Feedback 
Set Up Manual Insertion Hotkeys 
Set Up Segment Labels 
Show Input Vales 
Show Manual Control 
Show Gauge 
Select MP150 
MP150 Info 
Update Firmware 
Autoplotting 
Scrolling 
Warn On Overwrite 
Organize Channel Presets 
B-Alert Headset Check Impedance 
B-Alert Headset AMP Baseline 
B-Alert Headset  Brain State Gauges 
Check for Hardware 
Exit Playback Mode 

Ctrl + ] 
Ctrl + [ 
Not supported in AcqKnowledge 
4.0. Supported in 4.1.1 and 4.2 

 
 
 
 
 
 
 
 
Ctrl + T 
 
 
 
 
 
Licensed functionality 
Licensed functionality 
Licensed functionality 

 
 
 
 
 
 
 
 
 
 
 

 T 
 

Start/Stop Acquisition Ctrl + spacebar Ctrl + spacebar 

Delete recorded data  
Delete all recorded data, similar to the 
Append “Reset” button. 

Ctrl+Rewind button Option+Rewind button 

Window menu 
Bring All to Front 
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Menu Option Windows OS Mac OS X  

Help 
Application Notes from Web 
Open AcqKnowledge Manual 
Open MP Hardware Guide 
Open AcqKnowledge Tutorial 
About AcqKnowledge 

  

Cursors 
I-beam 
Arrow (pointer) 
Zoom 
Grid 
Event 
Jump to  
Annotation 

 
Ctrl-I 
Ctrl-B 
Ctrl-G 

 
 I 
 B 
 G 

Horizontal Scroll Location 
 

Home 
 

End
 

Page Up
 

Page Down

In chart, scope, or stacked plot mode (i.e., all but X/Y) 
these keyboard shortcuts can be used to scroll to various 
parts of the graph. 
Jumps to t = 0 (i.e., places first sample of data flush with 
left of graph window) 
Jumps to the end of the currently selected waveform (i.e., 
places last sample of data of the selected waveform flush 
with right of graph window) 
Scrolls backward in time one full screen (i.e., places 
leftmost sample of previous visible area at the right of the 
new visible area). 
Scrolls forward in time one full screen (i.e., places 
rightmost sample of previous visible area at the left of the 
new visible area). 
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Mouse Controls 

Contextual menu items correspond to the AcqKnowledge main menu state. 

Application menu customization has a corresponding effect on contextual menu display. If a contextual menu 
item does not have a corresponding application menu item, the menu customization file identifier will begin 
with “IDM_CM.” 

The following options can be accessed with a right-click for Windows or Control-click for Mac.  

 Mac OS X only: If the mouse is over a portion of the graph that has a context menu available, the 
cursor will change to an arrow with a menu. 

Graph window 

 

Journal window 

 
 
Unicode is the encoding standard used to 
insert control characters from keyboards 
for languages that use 2 byte characters. 

Horizontal Scroll 

 
Vertical Scroll 

 

Display 

 

Measurements 

 

Events 

Mouse Scrollwheel Support 

The scrollwheel operates on whatever window is underneath the mouse; this window does not need to be 
the topmost window. Many third-party mice include scrollwheels, scrolling balls, or trackpads to allow 
for quick access to navigating through a document. Mice may provide two separate controls, one for 
scrolling vertically and one for scrolling horizontally. 

AcqKnowledge supports horizontal and vertical scrolling using the scrollwheels on the mouse. Scrolling is 
supported in graph windows, journal windows, the event list in the event palette, and a number of other 
dialogs and windows that contain scrollable lists. A dynamic zoom operation can easily be performed in an 
AcqKnowledge graph channel by holding down the Ctrl key (PC) or the Option key (Mac). Scroll ‘up’ to 
zoom in and ‘down’ to zoom out. (Zoom operation supported in AcqKnowledge 4.2 and higher) 

 Mac OS X: To increase the scroll speed, hold down the “Option” key while using the scrollwheel. 



Part B — Acquisition Functions: The MP150 menu 69 

AcqKnowledge Software Guide 

Transformation history 

The transformation history functionality in AcqKnowledge 4.1 and higher provides the ability to track 
transformations that are performed on channel data. This gives a visual indicator of whether transformations 
have been applied to a channel and a record of the sequence of transformations and the parameters for the 
transformation. The history for the channel is viewed in the "Channel Info..." dialog. This dialog is 
accessible via the Channel Info option of the context menu or the Display > Channel Info menu item. This 
dialog replaces the "Statistics" dialog used in earlier versions.  

Cancelling Transformations & Transformation Progress Bar 

In AcqKnowledge 4.1 and higher, transformation cancel support has been restored to the software to offer 
Cancel buttons in progress dialogs that indicate the completion status of threaded transformations. 
Progress dialogs have also been enhanced so the textual message includes a graphical progress bar with 
the percentage that is completed. If the progress message does not contain a percentage, an indeterminate 
progress bar will be displayed.  
AcqKnowledge 4.1 and higher extends the analysis package to display dialogs while analysis routines are 
in progress. This progress dialog contains a cancel button which may be used to terminate the analysis 
before it is complete.  
The event tool allows events to be inserted on a graph with the mouse. When performing event editing, 
three new context menu shortcuts have been added to help make the process quicker:  

  
 Assign Current Event Type: Right-click an area with no data to set the type of event that will be 

inserted on the next left-click of the mouse. 

 Event Palette: Toggles event palette displays. 

 Edit event: Right-click a specific event to open the event palette to Selected Event controls for the 
event that was right-clicked. 

Typed event label drawing improvements 

Starting with AcqKnowledge 4.1, the Event system has been enhanced to allow different drawing options 
for channel-specific events when they are drawn in the data plotting area. These drawing options are 
applied to event labels, event amplitude markings, and event time location text. The following drawing 
options may be customized:  
 

 Font (including family, size, italic/bold, and other options)  

 Rotation angle of text baseline  

 Text alignment (left, center, right)  

 

 

Choose MP150 Help Button 

A Help button is available in the "Choose MP150" dialog that appears when the application is attempting 
to locate an MP150, either on initial application installation or on communications errors. The Help 
button opens a "Troubleshooting MP150 Communications.pdf" document from the application's User 
Support System. This troubleshooting guide provides common information from Technical Support for 
decoding the network blink states of the MP150 and other steps to take to troubleshoot why the MP150 
and computer cannot communicate properly. 
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Tooltips 

Channel label and units length and tooltips 
Starting with AcqKnowledge 4.1, character length limitations for channel label and units have been expanded: 
labels may now be up to 1032 characters and units may be up to 511 characters. Tooltips have been added to 
display the full channel units when the vertical axis is moused over. Tool tips do not wrap, so long labels may 
extend beyond the visible viewing area of the computer monitor. 

 

Graph window tooltip improvements 

Several of the toolbar buttons and the Start/Stop button in the graph window are associated with keyboard 
shortcuts that may be used instead of the buttons. Tooltips for these toolbar buttons display the corresponding 
keyboard shortcuts. Toolbar Tooltips may be deactivated when toolbars are detached from a graph. 

 

Menu item tooltips 

Starting with AcqKnowledge 4.1, menu item tooltips will display informational text about how menu items 
may be used. (Similar text was displayed in earlier versions of AcqKnowledge for Windows in the status area 
and in earlier versions of AcqKnowledge for Mac as Balloon Help). Analysis menu tooltips have been 
expanded to provide more detail regarding the types of analysis that are performed by the selected item. 

http://192.168.0.87/wiki/index.php/AcqKnowledge_4.1�
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Chapter 4  Editing and Analysis Features 
Overview 

This section provides a brief overview of some of the most frequently used AcqKnowledge features and 
functions. For more detailed information about specific features, turn to Chapters 9 through 13.  

If you are not currently running AcqKnowledge, double click the AcqKnowledge icon to start it. Choose Open 
from the File menu and select the file called “demo data.acq”. Your screen should look like this: 

 

Edit menu functionality during acquisition 

The following Edit menu functions may move or alter memory and cannot be performed during acquisition: 
Undo, Cut, Clear, Clear All, Paste, Insert Waveform, Duplicate waveform, and Remove Waveform. 
 

Scroll bars 

As you can see, there are four channels of data in this file (Heart Rate, ECG, EEG, Resp, EMG Raw, EMG, 
Integrated EMG). Although this record is 30 seconds long, only a few seconds are displayed on the screen at 
one time. You can move to different locations in the record by moving the scroll box at the bottom of the 
screen. Dragging the box left moves you to earlier points in time, and moving right displays events closer to 
the end of the record. Clicking on the arrows at either end of the horizontal scroll bar allows you to move to 
different points in time at smaller increments. 

A vertical scroll bar is on the right side of the screen, and. If you click the scroll arrow at the top of the box, 
you’ll see that one waveform appears to move down within its “track” on the screen. Moving this scroll box 
changes the amplitude offset of a selected channel. As with the horizontal scroll bar, you may either move the 
box or click the arrows. 



72 AcqKnowledge Software Guide 

Visit the online support center at www.biopac.com 

Scaling 

Horizontal axis 

Click the horizontal scale (above the scroll bar) to generate a dialog where values can be entered for units 
per division and horizontal scale offset.  

 
Time Scale 

The time interval (units per division) between the on-screen grid marks. There are four vertical divisions 
per screen, and the default is 2.00 seconds per division, so eight seconds of data will be displayed on the 
screen display. Entering a larger value will display more of the record, and entering a smaller value will 
display less. 

Initial offset 

 The time corresponding with the first data point displayed. For example, to display the middle 1/3 of the 
data file (assuming the record is 30 seconds long), set the offset to 10 seconds and the seconds per 
division to 2.5 seconds. 

Precision 

Controls number of decimal places following whole units appearing in the horizontal axis. 

Hold Relative Position for Append acquisitions 

This option is available in AcqKnowledge 4.2 and higher, and active only in Append acquisition mode. 
When checked, the display for appended acquisitions will show the same relative position with respect to 
the start of acquisition. This is convenient when doing short-duration; high-speed acquisitions where you 
want to be able to zoom in on the signal of interest and have the relative position (from the start of 
acquisition) stay the same. If the acquisition is started with the horizontal scale such that it falls between 
acquisition segments, this feature is not implemented. 

When Hold relative position is checked; after zooming in on a section of data that has been selected 
(highlighted) and is completely within one appended segment, the scale of the selected area changes with 
each appended segment such that it remains relative to the start of acquisition for that segment and 
updates the measurements. If the selected data area falls within two or more appended segments, this 
feature is not implemented. 

Global Grid Settings 

Opens dialog for applying master grid settings for all channels. For more details, see Grids on page 75. 

Channel Grid Settings 

Opens dialog for selectively applying grid settings to one or more channels. For more details, see Grids 
on page 75. 
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Vertical (Amplitude) axis 

   
Clicking the mouse in the vertical scale area (where the amplitude of each channel is displayed) generates 
the Set Screen Vertical Axis dialog, where values can be entered for units per divison and vertical scale 
offset. 

Scale  

Determines the limits of the viewable vertical axis scale (usually Volts). AcqKnowledge divides each 
channel into four vertical divisions. When data is displayed in chart mode, each “track” is divided 
into four divisions. When data is displayed in scope mode (or if there is only one channel of data) the 
entire screen is divided into four intervals. To increase the apparent amplitude for a given channel, set 
this value to a smaller number; entering a larger number will cause the waveform to appear to have 
less variability. 

Midpoint  

Refers to median displayed value for a particular channel. A checkbox to the left of each of these 
options allows you to apply these scaling options to all channels. By default, the scaling options you 
choose will only apply to the channel indicated in the dialog. If you want to apply these to all 
channels, click all the checkboxes. 

Precision 

Controls number of decimal places following whole units appearing in the vertical axis. Can be 
applied to selected or all channels. 

Apply to all channels 

 Applies settings selected in the various dialog options to all channels. 
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Adaptive Scaling 

Adaptive scaling uses the data to automatically determine the appropriate visible range for the data. 
As the data changes or the baseline shifts, the visible area shifts along with the data to ensure that data 
will always be plotted on the screen. Rather than limiting data visibility to a fixed voltage range, the 
range adjusts for factors such as background noise, electrode movement, EMG interference, 
disconnection, etc. 

Adaptive scaling can be applied to channels individually and can be unique for each Data View. A 
“settings” button is activated when to “Use adaptive scaling” is enabled.  

 
Scaling changes will be applied whenever the domain of the plot area is changed. This includes 
manual changes to the horizontal scale, horizontal scrollbar use, horizontal auto-scrolling when 
dragging out a selected area, auto-scrolling or auto-plotting during acquisition, initial enabling of 
adaptive scaling and auto-scrolling when executing Find Cycle/Peak functions.  

Channel Grid Settings 

Opens dialog for selectively applying grid settings to one or more channels. For more information, 
see Grid Details on page 75. 
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Grid Details 

You can customize the grid behind the waveforms displayed in graph windows in a number of ways. 

 
Grid Lock/Unlock 

Each scale has a small padlock in the lower right 
hand corner that displays the current state of the 
grid lock for that axis and channel. Click the 
padlock to change the lock state. 

  Unlocked grid—the number of grid lines 
and their pixel spacing on screen is kept 
constant through zoom and scaling 
operations 

  Locked grid—the grid lines themselves 
are maintained at constant values through 
zoom operations, e.g. a grid line which is 
located at .753 volts when the grid is 
locked will continue to be located at .753 
volts regardless of changes in scale. 

Grids can be locked and unlocked on individual channels.  

 The lock for the horizontal axis is shared by all channels. 

 The vertical scale can be locked and unlocked independently. 

The lock state of the grid can also be changed through the axis dialogs displayed when the mouse is clicked 
on the axis scale values in the graph window. 

  Click the “Lock units/div” checkboxes. 

 

 

NOTE: All grid screenshots are from AcqKnowledge 4.2. 
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Grid Scaling 

When the grid is locked, the scaling factors controlling how much data is visible on the screen (the distance 
between consecutive major lines of the grid and a fixed location for one of the lines of the grid) are specified 
differently. When the grid is unlocked, these scaling factors do not affect the grid. 

 The Grid Spacing option specifies the scaling factors and whether or not to “Show minor divisions” on the 
grid display. Changing these values only affects the grid display, not how the waveform is scaled. 

   
 Vertical grid: the total range of vertical units displayed per track is specified (Major division) along with 

the first value that should be displayed (First grid line). 

 Horizontal grid: the scaling factors are specified in how many seconds of data should be visible on the 
screen (Major division) and the time offset of the left hand side of the display (First grid line).  

 Settings can be applied to a selected channel or all channels. (Controlled by checking or unchecking 
‘Apply to all channels”). 

Adjust Grid Spacing 

To modify the horizontal and/or vertical grid spacing, choose “Display > Adjust grid spacing.” This will 
generate the aforementioned dialog for modifying the locked axes of the selected waveform. (“Lock vertical 
grid” and “Use channel specific horizontal grid” must be enabled in order for the gridline fields to become 
active). Enter the desired values and click OK. 

 Settings can be applied to a selected channel or all channels. (Controlled by checking or unchecking 
‘Apply to all channels”). 

The following Grid items can also be selected by right clicking with a graph channel and using the contextual 
menu. 

 

 

Grid: Toggles Grid display on and off. 

Adjust grid spacing: Use to change Grid spacing 
for one or all channels (divisions between 
gridlines and position). 

Grid Options: Use to change Grid display for one 
or all channels (Color, width, style, dash length, 
dash spacing, and scale adjustment position). 

Grid Preset: Use to create /save custom Grid 
presets and organize them in a list. (left) 
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Example of channel specific horizontal grid 

 

 

Note in figure on left, the horizontal time scale division is 
one second per division in the graph channel, but two 
seconds per division in the horizontal axis. (Green bar area) 
 
 
 
 
 
 
 

Horizontal Axis Grid Controls 

 

 Global Grid Settings: Brings up dialog specifying grid settings used in the shared Horizontal Axis of 
the graph. 

 Channel Grid Settings: Brings up the ‘Adjust grid spacing dialog’ referred to on previous page. 

Individual channel-specific grid settings take priority over the Global Grid Settings. If no channel-specific 
grid setting exists, the Global settings are applied. 

Grid Tool 

 
The Grid Tool allows divisions of the grid to be specified with the mouse. This tool has four states: 

  Inactive The cursor changes to a circle with a line running through it. The grid 
cannot be adjusted since both the horizontal and vertical axes are unlocked. 

  Horizontal axis locked The cursor changes to a horizontal line. A mouse click and drag will change 
the location of the horizontal lines of the grid. 

   Vertical axis locked The cursor changes to a vertical line. The tool can be used to adjust the 
vertical spacing of the grid. 

  Both axes locked The cursor changes to a crosshair. The rectangle of a full grid division can 
be drawn over the data. Adjust the spacing of locked grid lines underneath 
the waveform. 

If the “Alt” (PC) or “Option” key (Mac) is held down for the Grid Tool in any of the active 
modes, an ellipsis will appear under the cursor. After a mouse click or drag, a Grid Settings 
dialog will be generated. This dialog is functionally similar to the grid dialogs accessible via the 
axis settings dialogs. 
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 Based on lock status, the dialog will allow you to adjust Horizontal, Vertical or combined settings. 

 The values displayed in the dialog correspond to the grid ranges that were just drawn out on the screen 
with the grid tool if a mouse drag occurred. 

 If the mouse was simply clicked, the current grid settings are displayed. 

 This dialog allows the grid drawn out with the grid tool to be made more precise. 

Grid Reset 

To return to the original grid, choose “Display > Reset grid.”  

This will reconstruct the default, unlocked grid of four divisions per screen with solid light gray grid lines. 

Grid Options 

The major and minor grid lines can be further customized with spacing, number of divisions, an different 
colors and dashing styles. These are modified under the dialog generated via Display > Show > Grid options.  

 
Line color Click the color well to generate a color chooser. 

Line width Adjust the corresponding slider. 

Dash style Select a style (solid or broken) from the pop-up menu. 

Dash length Adjust the corresponding slider (for any dash mode that is not a solid line). 

Spacing Adjust the corresponding slider (for any dash mode that is not a solid line). 

# of Divisions Enter a value in the text field to set the maximum number of minor grid lines 
to be displayed in a single major grid division. 

Apply visual settings to all channels 

 When checked, the visual settings for major and minor grid lines are applied to all 
channels. When unchecked, the settings will be applied to the selected channel only. 
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Scale Adjustment 

 Select whether to use Start/End or Range/Midpoint parameters to determine 
horizontal and vertical scale adjustments. Applied only when grids are locked. 

 
10 sec. Horizontal Scale adjustment set to ‘Start/End’ parameters 

 

10 sec. Horizontal Scale set to ‘Middle Point/Range’ parameters 

To undo your selections and return to the original grid, choose “Display > Reset grid.” This will reconstruct 
the default, unlocked grid of four divisions per screen with solid light gray grid lines. 

 

Friendly Grid Scaling 

Too much precision can create numbers that are difficult to quickly interpret, so “friendly” grid scaling 
adjusts the range to the nearest possible whole numbers. For example, it’s easier to comprehend 
4.1000000 than 4.1427385. Unlocked grids always restrict precision to the minimum needed for a given 
magnitude. This produces a “friendly” scale that makes it easier to determine the range between the 
gridlines when data is formatted for display or printing. 

With unlocked horizontal grids, the horizontal scale values printed on a graph may not match the 
horizontal scale values displayed on the application screen. For example, horizontal scale values 

 Displayed in the application: 0.00000   7.50000   15.00000   22.50000 

  Printed:    0.00000   7.50125   15.00250   22.50375 

The precision will only match when using the “Visible area” print option. With selected area or entire 
graph options, the precision will not match when grids are unlocked because friendly grid scaling is 
applied on screen, but is not used during printing where the range is fixed to fill the entire page. 

Note that the Zoom tool and vertical autoscale may produce different results. To accommodate the grid 
precision, the Zoom result may be slightly more than specified in the zoom box. For precise correlation 
from selected area to result, lock the grids (horizontal and vertical). Precision is not restricted for locked 
grids or display ranges manually entered in the axis setting dialogs. 
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Journal Details 

To create a journal, select the  icon from the toolbar or choose File > New > Graph-Specific Journal or 

Independent Journal. To toggle the graph-specific journal display, select the  icon from the toolbar. Or 
after opening a new journal, choose Edit > Journal > Show Journal.  

Once a Journal is open, text and data can be entered. To enter text, just begin typing when the journal is open. 
AcqKnowledge will automatically “wrap” the text to fit the screen width. 

In addition to File and Edit menus, there are Time Stamp, Date Stamp and Auto Time 
functions available in the journal window.   

 Time and Date stamps refer to the computer’s clock to record the time and date, respectively, directly 
into the Journal.  

 Auto Time function records the time at the instant the carriage return is pressed, which is useful for 
tagging commands as data is collected.  

Measurements and data may also be pasted into an open Journal. To paste measurements into an open 
Journal, select an area and choose “Paste measurements” from the Edit > Journal menu. Paste to Journal 
functions only work if a Journal is open and vary for each journal type: 

 Graph-specific journals can only receive measurements and wave data from their associated graph 
view 

 Independent Journals can receive measurements and wave data from any open graph. Results will be 
put into both the graph-specific journal and the independent journal. Use Journal Preferences to auto-
paste to an independent journal if desired. 

Set the Journal Preferences (page 14425) to simultaneously record measurement name and units or control Event 
(marker) paste functionality and detail.  

To paste waveform data into a Journal, select an area and choose “Paste Wave Data” from the Edit > 
Journal menu. Allow several seconds for the text file to be written. The result is a text file of your wave data 
pasted into your active journal.  

TIP: When pasting a graph into a Journal: Pressing the Ctrl key (PC) or the Alt key 
(Mac) will launch a dialog allowing the image to be resized prior to pasting. 

A useful feature of the Journal is that it works in connection with the Cycle/Peak Detector and other 
measurement functions to paste in values from waveform data for further analysis. 

In the example above, the peak-to-peak and delta t measurements were pasted from the open graph window to 
the Journal. See the Journal paste section on page 12263 for more information on how to paste information to 
Journal files. 

Use Save as/Open Journal Template to retain SOP text, or standardize lab/computer details for record 
keeping. 
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Rich Journals 

The AcqKnowledge 4.2 Journal adds powerful rich text editing tools, offering advanced functionality 
common to most word processing programs. The following toolbar options are available within the Journal 
window: 

 Font family 
 Font style: bold, italic, underline 
 Paragraph alignment: left, right, center, justify 
 Font color 

The following items can be pasted or embedded into the Journal text: 

 Images 
 Numbered lists 
 Bulleted lists 
 Tables 

 Numerical statistics or expressions 

Images must reside within a document in order to be pasted into the Journal. Pasting image files directly from 
a location such as the Desktop is not currently supported. 

Journal Toolbar Buttons 

The Journal toolbar controls all formatting functions within the Journal window. Although the settings 
customized in this toolbar are retained within a saved Journal, global default settings for subsequent Journals 
are not overridden. To change the global defaults, the overall Journal Preference settings must be modified. 
(Edit > Journal > Preferences). For more information, see Journal Preferences on page 425. 

 

A full explanation of all Journal toolbar buttons appears on the following page. 
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Journal Toolbar Icon Function Explanation 

 
Clear  Clears text from Journal window 

 
Replace  Replaces Journal text with contents of external text file 

 
Save  Saves selected or full Journal text to an external text file 

 
Print  Prints the Journal text to the default printer 

 
Time stamp Inserts current time into Journal 

 
Date stamp  Inserts current date into Journal 

 
Time AND Date Inserts current time and date into Journal when Enter/Return key is pressed 

Font  Use to select font type and size for Journal session 

 
Text style Use to bold, italicize or underline text 

 
Text alignment Aligns paragraph text to left, center, right or justified position 

 
Font color Selects color of Journal text 

 
Numbering Toggles text numbering on and off 

 
Bulleting  Toggles text bulleting on and off 

 
Increase indent Increases indent in a bulleted or numbered list* 

 
Decrease indent  Decreases indent in a bulleted or numbered list 

 
Table Inserts a table into the Journal 

 
Table row  Adds a row to the table ** 

 
Table column  Adds a column to the table  

 
Delete table row  Removes selected row from the table 

 

Delete table 
column  

Removes selected column from the table 

 
Merge cells  Merges selected cells within the table 

 
Split cells  Splits selected cells within the table 

*Active only when cursor is positioned within a bulleted or numbered list. 

**Additional table tools are active only when a table is present. 
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NOTE: If the AcqKnowledge graph or Journal windows are decreased in size, the Journal toolbar will become truncated 
and some buttons may no longer be in view. Buttons no longer visible on the toolbar can be found in drop-down menus 
indicated by arrows. (See below) 

 

Journal Numerical Table Tools 

The Numerical Table Tools function allows easy insertion of measurements and numerical data into a Journal 
table, which can then be computed and evaluated via basic mathematical operations and expressions. This 
eliminates the need to export data to a spreadsheet application in order to validate statistics gathered during 
the course of an experiment.  

Numerical Tools operations permitted within a Journal table: 

 Insert a single measurement value 
 Insert all measurement values 
 Insert all measurement values with header row 
 Sum, Mean and Standard Deviation statistics for table rows and columns 
 Expression evaluation 

 

Menu Item Function 

Undo Removes previous operation 

Select All Selects all cell contents 

Insert Single Measurement Value Pastes single selected measurement value into cell 

Insert All Measurement Values Pastes all measurement values into cells 

Row Statistics Performs Sum, Mean or Standard Deviation operations on row data 

Column Statistics Performs Sum, Mean or Standard Deviation operations on column data 

Evaluate Expression Performs mathematical operations and functions on cell contents  

Word Wrap Wraps text within visible Journal area. (Does not apply to table cells) 
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Example of Sum, Mean or Standard 

Sum, Mean or Standard Deviation operations can be easily performed on table data. Right clicking within a 
cell opens a contextual menu containing available operations under ‘Row’ or ‘Column’ statistics. Choose an 
operation, and the result will appear in the selected cell. (See sum example below) 

 

Example of Evaluate Expression: 

This feature works very much like Excel®. Simply enter the cell identifiers into an empty cell, then right-click 
and choose ‘Evaluate Expression”. The formula occupying the cell will be computed and be replaced by the 
result. The mathematical operations and functions available for standard Biopac Expression syntaxes may be 
used. (Transform > Expression). Expressions can be created beforehand then copied and pasted into a 
Numerical Tools Table cell. 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
If the expression syntax used is incorrect or invalid, a warning dialog will appear. 

 

 

TIP: To correct a mistake, use the Ctrl+Z (PC) or Command+Z (Mac) 
keystroke to restore the previous cell data. Multiple levels of undo are 
supported. 
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Select a waveform / channel 

Although multiple waveforms can be displayed, only 
one waveform at a time is considered “active.” Most 
software functions only apply to the active waveform, 
which is also referred to as the “selected” channel. 
Selecting a channel allows you to highlight all or part 
of that waveform, and enables you to perform 
transformations on a given channel. 

In the upper left corner of the graph window there is a 
series of numbered boxes that represent each channel of 
data. The numbers in the boxes correspond to the 
channel used to acquire the data (the specifics of setting 
up channels are discussed on page 36). In the sample 
file, ECG channels are represented by channels 1 and 2, 
with respiration on channel 3 and blood pressure on 
channel 4. 

To select a channel, position the  cursor over the channel box that 
corresponds to the desired channel and click the mouse button or position the 

 cursor on the waveform of interest and click the mouse button. 

Note that the selected channel box appears depressed and the channel label to 
the right of the channel boxes changes to correspond to the selected channel. 

Additionally, the channel label in the display (on the left edge of the track) will 
be highlighted for the active channel. 

 

Channel Labels 

Each channel has a label on the left and right edge of the graph window.  

The left label is used to identify the contents of each channel (ECG, 
Respiration, etc.). 

The right label is used to denote the units for each channel’s amplitude scale 
(usually scaled in terms of Volts). 

 

 

When a channel is active, its label is highlighted and also 
appears by the channel boxes. 

To change the label for a given channel 

 during or before acquisition 
(including Append mode) 
revise the MP150 menu >  Set Up Channels label text 

 post-acquisition / analysis only 
click the left label enter the desired text in the dialog 

Label and Units change prompts are separate. Click the left to 
change the label and on the right (wrench icon in vertical scale) 
to change the units. The label can be up to 40 characters. 

 

 
AcqKnowledge 4 Channel label 
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Show/Hide Channel 

 
You can “hide”a waveform display without 
changing the data file. To hide a channel,  

Windows: Alt+click in channel box. 

Mac OS X: Option+click in channel box. 

When a channel is hidden, the channel box will 
have a slash through it. You may view a hidden 
channel by holding down the Alt or Option key 
and clicking in the channel box again. Channels 2 
and 4 are hidden in the following display: 
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Measurements 

A convenient feature in AcqKnowledge is the popup measurement windows. A variety of 
different measurements can be taken, and you can display different measurements from 
the same channel and/or similar measurements from different waveforms. AcqKnowledge 
can display measurements for the selected channel or for any other channel. By default, 
AcqKnowledge displays measurements from the selected channel (as denoted by the 
“SC” in the measurement boxes). 

To select a channel for measurement, position the cursor over the part of the 
measurement window that reads “SC.” Click the mouse button and choose a channel 
number from the pull-down menu. The channel numbers in the pull-down menu 
correspond to the numbers in the channel boxes in the upper left corner of the graph 
window. 

To select a measurement, position the cursor on a measurement box and click the mouse 
button. Choose a measurement from the pull-down menu; see page 91 for measurement 
functions and the minimm samples for each (some of the values are single point 
measurements while others require at least two points to be selected). 

The measurements in the upper half of the menu reflect amplitude measurements, or 
measurements which contain information about the vertical (amplitude) scale. Other 
measurements use information taken from the horizontal axis (usually) and are found on 
the section of the pull-down menu below the dividing line. Some of the measurement 
options change (or are disabled) if units are selected for the horizontal scale. 

  

In some cases, the computations involved in the measurement can produce nonsensical 
results (such as dividing by zero, or calculating a BPM from a single point). In those 
cases, you may get a measurement value like INF or ****. This means that the result was 
undefined at this point.  
Measurement menus are tinted to match the color of the corresponding waveform. 

 

Measurement Display 

    
The number of measurement rows is set in Preferences > Measurements, as well as the precisiona dn units. 
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Measurement Area 

It is important to remember that AcqKnowledge is always selecting either a single point or an area spanning 
multiple sample points. If an area is defined and a single point measurement (such as Time) is selected, the 
measurement will reflect the last selected point. 

 

 Single-point measurements 

When a single point is selected, the cursor will “blink.” The graph on the left shows how the I-beam 
is used to select a single point for measurements. 

 
 

 Selected range measurements 

Drag the I-beam cursor to select an area; the selected area will be highlighted. 
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IMPORTANT! 
The first data point is “plotted” at zero (on the left edge of the graph); the first visible data point is sample 
point 2. The selected areas below demonstrate this concept. 
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Measurement presets 

Measurements are commonly used in conjunction with the cycle detector and other analysis protocols to 
perform data reduction. In complex data analysis using the cycle detector, often multiple different sets of 
measurements may be used to perform multiple extraction passes on the data. The measurement presets 
feature allows users to create multiple predefined measurement configurations and apply them to the graph to 
change between different configurations. All aspects of the measurement configuration are stored, including 
measurement functions, any parameters for the measurement, source channel, and number of measurement 
rows.  

Measurement Validation 

You can validate measurements with the ValidateMeasurements.acq sample file that was included with the 
software. Pay attention to the “Sample data file” section of the measurement definitions that begin on page 
191, and where included, note which sample points to use for validation (i.e., the first four sample points are 
used to validate the Correlate measurement using the ValidateMeasurements.acq file). 

Measurement Info / Parameters 

 Measurements that have parameters have an “i” for 
info button next to the measurement type in the measurement bar. Click the button to generate a dialog to edit 
the parameters. To paste parameters, enable the Journal Preference via Display > Preferences > Journal > 
Measurement paste settings > Include measurement parameters. 

Measurement Interpolation 

On a down-sampled channel, the cursor can fall on a point between physical samples. In such cases, in the 
Line Plot mode only, some measurements will display interpolated values; the value is obtained by linear 
interpolation with respect to the two adjoining samples. 

 To disable measurement interpolation, uncheck the “Use linear interpolation” option in the Display >  
Preferences dialog. 

 If interpolation is disabled for Line Plot, or any time Step Plot or Dot Plot is selected, measurements 
take on the value of the first physical sample immediately to the left of the cursor or edge of the 
selection. 

 When measurements are pasted to the Journal, there is no indication of interpolated measurements. 

 A Calculation measurement can be an interpolated value. When a measurement uses an interpolated 
value, the result box background changes from gray to light purple. 

 The “Delta S” and “Samples” measurements are never interpolated. 

 Measurements will not be interpolated if all measurements are set to “SC” (selected channel); the 
cursor will snap to the left for the measurements.  

 Measurement tooltips will reflect measurement interpolation. 

Exporting measurements 

One of the most important reasons to take measurements is to save them; AcqKnowledge allows you to store 
and export these measurements in different formats. 

 Copying measurements to the journal:  

To copy measurements (exactly as they appear in the measurement windows) and paste them to the 
Journal, select Edit > Journal > Paste measurement. Under the default settings, only the values 
themselves are copied to the journal; you can change the settings to include the measurement name and 
other options under Display > Preferences > Journal 

 Copying measurements to the clipboard:  

To copy measurements (exactly as they appear in the measurement windows) to the clipboard and paste 
them into a word processor or other application, select Edit > Clipboard > Copy measurements. Under 
the default settings, only the values themselves are copied to the clipboard; you can change the settings 
to include the measurement name and other options via Display > Preferences > Journal. 
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Measurement Definitions 

The table below explains the measurement options available and the range required for each. The default 
option is for time to be displayed on the horizontal axis, although it can be set to display frequency or 
arbitrary units (see page 411  for details on how to change the horizontal scaling options). Unless otherwise 
noted, all of the measurements described here relate to those displayed when the horizontal scale reflects time. 
Measurement Area Explanation  
Area Minimum area: 

3 samples 
 
Uses: 
All points of 
selected area 

Area computes the total area among the waveform and the straight line that is 
drawn between the endpoints. 
Area is expressed in terms of (amplitude units multiplied by horizontal units) and 
calculated using the formula: 
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Where: 
n—number of samples; 
i—index (i = 1.n-1); 

1, ii xx  - values of two neighboring points at horizontal axis ( 1x – the first 

point, nx – the last point); 

   1, ii xfxf  - values of two neighboring points of a curve (vertical axis); 

   1, ii xyxy  - values of two neighboring points of a straight line (vertical axis). 

At the endpoints y( 1x )= f( 1x ) and y( nx )= f( nx ). 

1



n

X
xi - horizontal sample interval; 

The value of a straight line can be found by formula: 

  bxmxy ii   

  11 xmxfb  - intercept; 

X

Y
m




 - slope of the straight line; 

   1xfxfY n   - vertical distance of increase at vertical axis; 

1xxX n  - horizontal distance of increase at horizontal axis. 

Sample plot: 

 
The area of the shaded portion is the result. 

Note: The Area measurement is similar to the Integral measurement except that a 
straight line is used (instead of zero) as the baseline for integration. 
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Measurement Area Explanation  

 
Results: This calculation will always return a positive result. 
Units: Volts - sec. 
Sample data file: “ValidateMeasurements.ACQ” 
 Result: 0.4533 Volts - sec. 

BPM 
(Time domain 
only) 

Minimum area: 
2 samples 
 
Uses: 
Endpoints of 
selected area 

BPM (beats per minute) computes the time difference between the first and last 
points and extrapolates BPM by computing the reciprocal of this difference, 
getting the absolute value of it and multiplying by 60 (60 sec). 
The formula for calculation of BPM is: 

60
1

1















xx
BPM

n

 

Where:  

nxx ,1 - values of the horizontal axis at the endpoints of selected area. 

Note: As mentioned, this measurement provides essentially the same information 
as the Delta T and Freq measurement. 
Results: Only a positive value. 
Units: BPM. 

Calculate Minimum area: 
2 sources 
 
Uses: 
Results of 
measurements 
used in 
calculation 

Calculate can be used to perform a calculation using the other measurement 
results. For example, you can divide the mean pressure by the mean flow. 
When Calculate is selected, the channel selection box disappears. 

 
The result box will read “Off” until a calculation is performed, and then it will 
display the result of the calculation. As you change the selected area, the 
calculation will update automatically. 
To perform a calculation, generate the “Waveform Arithmetic” dialog via 
Ctrl-Click or right mouse click the Calculate measurement type box or click the 

“info” button next to the measurement type box . 

  

 
Use the pull-down menus to select Sources and Operand. 
Measurements are listed by their position in the measurement display grid (i.e., 
the top left measurement is Row A: Col 1). Only active, available channels appear 
in the Source menu. 
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Measurement Area Explanation  
Calculation measurement Source operands are updated before a Calculation is 
performed, which means that Calculations can be based on measurements that 
are located after them in the measurement row/column ordering. 
Metachannels—Calculation measurements can include other Calculation 
measurements as their operands. 

 If a cyclic dependency is introduced, the result reads “Error.” 
 When interpolation is being used, a Calculation measurement can also be 

an interpolated value. 
 If either of the operands of a Calculation is interpolated, the result will be 

displayed as an interpolated value (with a light purple background). 
The Operand pull-down menu includes: Addition, Subtraction, Multiplication, 
Division, Exponential. 
The Constant entry box is activated when you select “Source: K, constant” and it 
allows you to define the constant value to be used in the calculation. 
To add units to the calculation result, select the Units entry box and define the 
unit’s abbreviation. 
Click OK to see the calculation result in the calculation measurement box. 

Cap_Dim  Capacity Dimension; fractal dimension estimate. 
(Fractals measure the amount of self-similarity in a data set. AcqKnowledge 
offers three alternate estimates for fractal dimension: Cap_Dim, Corr_Dim, and 
Inf_Dim. The estimates will not agree, based on the heuristic and the 
parameters.) 

Corr_Dim   Correlation Dimension; fractal dimension estimate. Always greater than capacity if 
parameters are the same. (See fractals note at Cap_Dim.) 

Correlate Minimum area: 
2 samples 
 
Uses: 
All points of 
selected area 

Correlate provides the Pearson product moment correlation coefficient, r, over the 
selected area and reflects the extent of a linear relationship between two data 

sets: ix  - values of horizontal axis and  ixf  - values of a curve (vertical axis). 

You can use Correlate to determine whether two ranges of data move together. 
Association  Correlation  
Large values with large values Positive correlation 
Small values with large values Negative correlation 
Unrelated Correlation near zero 

The formula for the correlation coefficient is: 

Correlate = 
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Where: 
n—number of samples;  
i—index (i = 1..n); 

ix — values of points at horizontal axis ( 1x – the first point, nx – the last point); 

 ixf - values of points of a curve ( vertical axis). 

Results: 
Returns a dimensionless index that ranges from -1.0 to 1.0 inclusive. 
Units: None 
Sample data file: “ValidateMeasurements.ACQ” 
 Result: -0.74825(for whole wave) and 0.95917 (for first four 

sample points). 
 

Delta Minimum area: 
2 samples 
 
Uses: 
Endpoints of 
selected area 

Delta returns the difference between the amplitude values at the endpoints of the 
selected area. 

Delta    1xfxf n   

Where: 

 1xf ,  nxf —values of a curve at the endpoints of selected area. 
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Measurement Area Explanation  
Results: 
If the data value at the starting location is greater than the data value at the 
ending location of the cursor, then a negative delta will result. Otherwise, a 
positive delta will result. 
Units: Volts 
Sample data file: “ValidateMeasurements.ACQ” 
 Result: -2 Volts (for whole wave). This result shows the 

absolute value of change of amplitude (2) and the minus 
sign means a decrease of amplitude. 

Delta S  Minimum area: 
1 sample 
 
Uses: 
Endpoints of 
selected area 

Delta S returns the difference in sample points between the end and beginning of 
the selected area. 
Results: This calculation will always return a positive result. 
Units: Samples 
 

Delta T(time) 
Delta F 
(frequency) 
Delta X (arbitrary 
unit) 

Minimum area: 
2 samples 
 
Uses: 
Endpoints of 
selected area 

The Delta T/F/X measurement shows the relative distance in horizontal units 
between the endpoints of the selected area. Only one of these three units will be 
displayed in the pop-up menu at a given time, as determined by the horizontal 
scale settings. 

Measurement Horizontal Axis 
Delta T Time 
Delta F Frequency (FFT) 
Delta X Arbitrary units (Histogram Bins) 

The formula for Delta T/F/X is: 

Delta T 1xx n   

Where: 

nxx ,1 - values of horizontal axis at the endpoints of selected area. 

Results: 
If the data value at the starting location is greater than the data value at the 
ending location of the cursor, then a negative delta will result. Otherwise, a 
positive delta will result. 

For Delta T measurements with the horizontal axis format set to HH:MM:SS. 

 For values less than 60 seconds, you will get a value in decimal 
seconds. 

 For values greater than 60 seconds, you will see an HH:MM:SS 
format value 

(See page 172 for details on how to change the horizontal scaling). 
Units:  

Delta T: Seconds (sec.)  Delta X: “arbitrary unit” 
Delta F: Hz 

Sample data file: “ValidateMeasurements.ACQ” 
 Result: 0.12 sec. (for whole wave). 
 

Evt_amp  Extracts the value of the measurement channel at the times where events are 
defined. The measurment result is unitless. Specify Type, Location, and Extract; 
see page 1217 for details. 
 The amplitude is always taken from the measurement channel, which may be 

different from the channel on which events are defined. 
Evt_amp can be useful for extracting information such as the average T wave 
height within the selected interval.  

Evt_count   Evaluates the number of events within the selected area. The measurement 
result is unitless. Specify Type and Location; see page 1218 for details. 
 

Evt_loc   Extracts information about the times of events. The measurement result uses the 
units of the horizontal axis. Specify Type, Location, and Extract; see page 1218 for 
details. 

Expression  Generates the Expression transformation dialog (page 1133) and offers Source 
“MC” Measurement Channel instead of “SC” Selected Channel to build recursive 
formulas, i.e. result of the expression as it was evaluated x samples ago. Data 
within the selected area is not changed. 
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Measurement Area Explanation  
Freq (time 
domain only) 
 

It is important 
to note… 

This does not 
compute the 
frequency 
spectra of the 
data. 
To perform a 
spectral 
analysis, use 
the FFT 
function (see 
page 13301). 

Minimum area: 
2 samples 
 
Uses: 
Endpoints of 
selected area 

Freq computes the frequency in Hz between the endpoints of the selected area 
by computing the reciprocal of the absolute value of time difference in that area. 
The formula for Freq is: 

Freq 













1

1

xxn

 

Where:  

nxx ,1 - values of horizontal axis at the endpoints of selected area. 

The information provided by this measurement is directly related to the Delta T 
and BPM measurements, and is related to a lesser extent to Delta S 
measurement. That is, if the Delta T interval between two adjacent peaks is 
calculated, the BPM and Freq measurement can be extrapolated.  
If the sampling rate is known, the Delta S can also be derived. 
In the following example, you can see Delta T, Freq and BPM measurements for 
the particular area. The Delta S can also be derived. 

 
Selected area with measurements that describe 

the same interval in different terms. 
Note: It is important to note that this does not compute the frequency spectra of 
the data. To perform a spectra analysis, use the FFT function (described on page 
1301). 
Freq (or frequency) is only available in time domain windows. 
Results: This calculation will always return a positive result. 
Units: Hz 
Sample data file: “ValidateMeasurements.ACQ” 
 Result: 8.33 Hz (for whole wave). 

Inf_Dim   Information Dimension; fractal dimension estimate. (See fractals note at 
Cap_Dim.) 

Integral Minimum area: 
2 samples 
 
Uses: 
All points of 
selected area 

Integral computes the integral value of the data samples between the endpoints 
of the selected area. This is essentially a running summation of the data. 
Integral is expressed in terms of (amplitude units multiplied by horizontal units) 
and calculated using the following formula. 

Integral =     
2

1

1
1

i
n

i
ii

x
xfxf







  

Where: 
n—number of samples; 
i—index (i = 1.n-1); 
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Measurement Area Explanation  

1, ii xx  - values of two neighboring points at horizontal axis ( 1x – the first 

point, nx – the last point); 

   1, ii xfxf  - values of two neighboring points of a curve (vertical axis); 

1



n

X
xi - horizontal sample interval; 

1xxX n  - horizontal distance of increase at horizontal axis. 

The following plot graphically represents the Integral calculation. 

 
The area of the shaded portion is the result. 

Results: The Integral calculation can return a negative value if the selected area 
of the waveform extends below zero. 
Units: Volts—sec. 
Sample data file: “ValidateMeasurements.ACQ” 

Result: 0.300 Volts -sec.(for first 6 sample points) and –
0.155 Volts -sec.(for last 6 sample points—the wave below 
zero). 

Kurtosis   Kurtosis indicates the degree of peakedness in a distribution, e.g. the size of the 
“tails” of the distribution. Distributions that have sharp peaks in their center have 
positive kurtosis; flatter distributions have negative kurtosis. A normal distribution 
has a kurtosis of 0. The following formula is used to extract kurtosis 
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Where from a signal (x) containing n points: 

Lin_reg Minimum area: 
2 samples 
 
Uses: 
All points of 
selected area 

Linear regression is a better method to calculate the slope when you have noisy, 
erratic data. 
 For advanced modeling options, see Nonlinear modeling on page 298. 

Lin_reg computes the non-standard regression coefficient, which describes the 
unit change in f (x) (vertical axis values) per unit change in x (horizontal axis). 
For the selected area, Lin_reg computes the linear regression of the line drawn 
as a best fit for all selected data points using the following formula: 

Lin_reg = 
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Where: 
n—number of samples;  
i—index (i = 1.n); 

ix — values of points at horizontal axis ( 1x – the first point, nx – the last point); 

 ixf - values of points of a curve ( vertical axis). 
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Measurement Area Explanation  
Note: For a single point, Lin_reg computes the linear regression of the line drawn 
between the two samples on either side of the cursor. 
Results: 
If the data value at the starting location is greater than the data value at the 
ending location of the cursor, then a negative delta will result. Otherwise, a 
positive delta will result. 
Units: Volts/sec. 
This value is normally expressed in unit change per second (time rather then 
samples points) since high sampling rates can artificially deflate the value of the 
slope. If the horizontal axis is set to display Frequency or Arbitrary units, the slope 
will be expressed as unit change in corresponding vertical axis values (frequency 
or arbitrary units, respectively). 
Sample data file: “ValidateMeasurements.ACQ” 

Result: 230.00 Volts/sec. (for 1-4 samples) and 
–170.00 Volts/sec. (for samples 4-7). 

Lyapunov   Lyapunov exponent describes the exponential rate of divergence of a system 
when perturbed from its initial conditions. For instance, if the system is started 
from two slightly different locations, this indicates how different their results will be 
with time. Stable experiments have exponents equal to zero. Specify an 
embedding dimension and a time delay; produces a single-valued measure. This 
measure is quite dependent on the amount of data used. 

Max Minimum area: 
1 sample 
 
Uses: 
All points of 
selected area 

Max (maximum) shows the maximum amplitude value of the data samples 
between the endpoints of the selected area. To compare peak heights, select 
each peak—you can easily see the maximum peak values or paste the results to 
the journal. Also, since you can simultaneously obtain measurements for different 
channels, you can easily compare maximum values for different channels. 
Note: For a single point, Max shows the amplitude value in this point. 
Units: Volts 

Max T Minimum area: 
1 sample 
 
Uses: 
All points of 
selected area 

Max T shows the time of the data point that represents the maximum value of the 
data samples between the endpoints of the selected area. 
Note: For a single point, Max T shows the time value in this point. 
Units: Seconds 

Mean Minimum area: 
2 samples 
 
Uses: 
All points of 
selected area 

Mean computes the mean amplitude value of the data samples between the 
endpoints of the selected area, according to the formula: 

Mean =  



n

i
ixf

n 1

1
 

Where:  
n—number of samples; 
i—index (i = 1.n); 

ix — values of points at horizontal axis; ( 1x – the first point, nx – the last point); 

 ixf - values of points of a curve ( vertical axis). 

Units: Volts 
Sample data file: “ValidateMeasurements.ACQ” 

Result: 1.538462 Volts (for whole wave). 
Median Minimum area: 

2 samples 
 
Uses: 
All points of 
selected area 

Median shows the median value from the selected area. 
Note: The median and calculation is processor-intensive and can take a long 
time, so you should only select this measurement option when you are actually 
ready to calculate. Until then, set the measurement to “none.” 
Units: Volts 

Median T Minimum area: 
2 samples 
 
Uses: 
All points of 
selected area 

Median T shows the time of the data point that represents the median value of the 
selected area. 
Note: The median and calculation is processor-intensive and can take a long 
time, so you should only select this measurement option when you are actually 
ready to calculate. Until then, set the measurement to “none.” 
Units: Seconds. 
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Measurement Area Explanation  
Min Minimum area: 

1 sample 
 
Uses: 
All points of 
selected area 

Min (minimum) shows the minimum amplitude value of the data samples between 
the endpoints of the selected area. 
Note: For a single point, Min shows the amplitude value in this point. 
Units: Volts. 

Min T Minimum area: 
1 sample 
 
Uses: 
All points of 
selected area 

Min T shows the time of the data point that represent the minimum value of the 
data samples between the endpoints of the selected area. 
Note: For a single point, Min T shows the time value in this point. 
Units: Seconds. 
 
 

Moment  
 

Uses: 
All points of 
selected area 

Central Moment is a general-purpose statistical computation that can be used to 
compute central variance and other higher-order moments of the data within the 
selected area. Specify the order as an integer (generally). The central moment is 
computed using the following formula: 
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 1  

Where: 
x—signal; 
n—points;  
m—order. 

Mut_inf   Mutual Information determines how much could probabilistically be known about 
an unknown signal given a known variable. Specify a time delay. Produces a 
single valued result. 

NLM   Nonlinear modeling (also called “arbitrary curve fitting“) determines the “best fit” 
model for the selected data of the selected channel. The measurement result 
corresponds to the value of one of the parameters of the best fit. NLM can be 
used to extract Tau (time delay LVP constant) for assessing cardiac condition. 
See page 1298 for nonlinear modeling details. 
 If a Model Expression uses MMT() syntax to reference a measurement and 

that referenced measurement is linearly interpolated, the results of the NLM 
measurement will also be displayed as being linearly interpolated. 

 When combined with the Cycle/Peak Detector (on page 1308), the NLM 
measurement can be useful for extracting cycle-by-cycle best fit models for 
an entire waveform. 

None n/a None does not produce a measurement value. It’s useful if you are copying a 
measurement to the clipboard or journal with a window size such that several 
measurements are shown and you don’t want them all copied. 

P-P Minimum area: 
2 samples 
 
Uses: 
All points of 
selected area 

P-P (peak-to-peak) shows the difference between the maximum amplitude value 
and the minimum amplitude in the selected area. 
Results: The result is always a positive value or zero. 
Units: Volts 
Sample data file: “ValidateMeasurements.ACQ” 

Result: 13 Volts (for whole wave). 
Samples Minimum area: 

1 sample 
 
Uses: 
All points of 
selected area 

Samples shows the exact sample number of the selected waveform at the cursor 
position—the first data point is not displayed, but is plotted at zero. 
See page 189 for examples of selected area Samples. 
Note: When an area is selected, the measurement will indicate the sample 

number at the last position of the cursor.  
Units: Samples. 

Skew  Skew is a statistical measure of the degree of asymmetry in a distribution (away 
from normal Gaussian distribution), e.g. if the distribution is weighted evenly or 
trends toward an edge. 

 A normal distribution has a skew of 0. 
 A distribution with a prominent left tail has a negative skew. 
 A distribution with a prominent right tail has a positive skew  

The following formula is used to extract skew: 
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Measurement Area Explanation  
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Where a signal (x) contains n points: 
Slope Minimum area: 

2 samples 
 
Uses: 
All points of 
selected area 

Slope computes the non-standard regression coefficient, which describes the unit 
change in f (x) (vertical axis values) per unit change in x (horizontal axis). 
For the selected area, Slope computes the slope of the straight line that intersects 
the endpoints of the selected area, using the formula: 

Slope = 
   

1

1

xx

xfxf

n

n




 

Where: 

 1xf ,  nxf —values of a curve at the endpoints of selected area. 

1x , nx - values of horizontal axis at the endpoints of selected area. 

This value is normally expressed in unit change per second (time rather then 
samples points) since high sampling rates can artificially deflate the value of the 
slope. 
Note: Lin_reg (linear regression) is a better method to calculate the slope when 
you have noisy, erratic data. 
For a single point, Slope computes the slope of the line drawn between the two 
samples: the selected sample point and the sample point to its left. 
Results: 
If the data value at the starting location is greater than the data value at the 
ending location of the cursor, a negative delta will result. Otherwise, a positive 
delta will result. 
Units: Volts/sec. (or corresponding to Freq or Arbitrary setting) 
Sample data file: “ValidateMeasurements.ACQ” 

Result: 233.33333 Volts/sec. (for samples 1-4) 
-166.66667 Volts/sec. (for samples 4-7) and 
-16. 66667 Volts/sec. (for whole wave). 

 
Stddev Minimum area: 

2 samples 
 
Uses: 
All points of 
selected area 

Stddev computes the standard deviation value of the data samples between the 
endpoints of the selected area. Variance estimates can be calculated by squaring 
the standard deviation value. 
The formula used to compute standard deviation is: 

Stddev =  
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Where: 
n—number of samples;  
i—index (i = 1.n); 

ix — values of points at horizontal axis ( 1x – the first point, nx – the last point); 

 ixf - values of points of a curve ( vertical axis); 

 




f  
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1
 - the mean amplitude value of the data samples between 

the endpoints of the selected area. 
Results: The result is always a positive value or zero. 
Units: Volts 
Sample data file: “ValidateMeasurements.ACQ” 

Result: 3.09570 Volts (for samples 1-4), 
1.000 Volts (for samples 10-12). 
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Measurement Area Explanation  
Sum Minimum area: 

2 samples 
 
Uses: 
All points of 
selected area 

Sum extracts a mathematical sum of the amplitudes of all of the samples within 
the selected area. This straight sum can be used as a building block for more 
complicated formulas. Examples of its utility include HRV measurements, various 
statistical measurements, and simple criteria for clustering. Sum is available from 
within the measurement popup menus and from analysis scripts that allow for 
extraction of measurements.  

Time Minimum area: 
1 samples 
 
Uses: 
All points of 
selected area 

See the X-axis: T measurement for explanation. 

Value Minimum area: 
1 sample 
 
Uses: 
All points of 
selected area 

Value shows the exact amplitude value of the waveform at the cursor position. 
For the selected area, Value indicates the value at the last position of the cursor, 
corresponding to the direction the cursor was moved (the value will be the left-
most sample point if the cursor was moved from right to left). 
Units: Volts 

X-axis:T/F/X 
(horizontal units) 

Minimum area: 
1 sample 
 
Uses: 
All points of 
selected area 

The X-axis measurement is the exact value of the selected waveform at the 
cursor position, based on the Horizontal Axis setting: 
 Measurement Horizontal Axis Setting Units  

X-axis: T Time Sec. 
X-axis: F Frequency Hz. 
X-axis: X Arbitrary units Arb. units 

For X-axis: T measurements, the time value is relative to the absolute time offset, 
which is the time of the first sample point. 
The X-axis: F measurement applies to frequency domain windows only (such as 
FFT of frequency response plots). The Freq function for time domain windows is 
described on page 195. 
Note: If a range of values is selected; the measurement will indicate the horizontal 
value at the last position of the cursor. 
Results: This calculation will always return a positive result. 
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Part B—Acquisition Functions: The MP menu 

Overview 

The AcqKnowledge software adds acquisition and control capability to the complete MP System (MP150 or 
MP36R). This section describes the commands and procedures used to establish the various acquisition 
parameters for the MP System (MP150 or MP36R), including how to: 

 Set Up channels for data acquisitions 

 Control acquisition parameters such as sampling rate and duration 

 Perform online calculations and digital filters 

 Set acquisitions to begin on command from a mouse click or external trigger 

 Display values numerically and graphically during an acquisition 

 Output waveforms and digital signals during an acquisition 

 Control the on-screen waveform display characteristics 

Some of the basic functions involved in setting up an acquisition were covered in Part A—Getting Started, 
but this section will cover them in more detail, as well as describe some additional features. All the 
commands covered here can be found under the MP150 menu. 
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Acquisitions 

Acquisition is defined as data collection from an external source (such as electrodes connected to an 
amplifier). 

 Before you begin an acquisition, make sure the MP data acquisition unit is turned on and connected 
to your computer. Please refer to the BIOPAC Hardware Guide for more information on 
connections. 

To begin collecting data and display data as it is being collected: 

1. Launch the AcqKnowledge application (you can double click the AcqKnowledge icon). 

2. Choose File > New and select document type “Graph Window” : 

 
 

 
3. Set up the specific channels you want to acquire before starting the acquisition. 

 See the Set Up Channels chapter (page 103 1111) for details. 

4. Set up the acquisition parameters (such as sampling rate, acquisition length, and data storage options. 

 See the Set Up Acquisition chapter (page 148) for details. 

Edit menu functionality during acquisition 

The following Edit menu functions may move or alter memory and cannot be performed during acquisition: 
Undo, Cut, Clear, Clear All, Paste, Insert Waveform, Duplicate waveform, and Remove Waveform. 
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Chapter 5  Set Up Channels 
Set Up Channels—The Basics 

Before you collect data, you need to specify how many channels you will be collecting data on, and at what 
rate data is to be collected. Both of these functions are accomplished through menu items and dialoges. To 
enable collection on a given channel, select Set Up Channels from the MP150 menu. 

AcqKnowledge 4.1 offers two methods of analog channel setup: 

New! Module-based setup View by Channels see page 105 for details 

  
 
If using AcqKnowledge 4.1 with BioHarness™ or AcqKnowledge 4.2 with B-Alert™, Analog 
channels can be turned on/off but not changed. 

 

Module-based analog channel setup  

New! For MP150 units, AcqKnowledge 4.1 introduces a module-oriented analog channel 
setup option. In module mode, setup prompts the user to add modules/transducers and 
establish parameters, plus it detects potential channel conflicts between software 
assignment and the module channel switch setting and scales the signal to the correct 
value and units.  

The new module setup is recommended for easier setup and automatic scaling. In module mode, setup 
prompts the user to add individual modules based upon the module number. For modules with transducers, 
the unique transducers are added. The user is then prompted to input the settings of all of the switches on the 
modules and then perform any calibration steps, if required. Using this information, the module setup 
automatically sets the scaling and initial visual range to match the physical input units from the module or 
transducer. Additionally, module-based setup detects potential channel conflicts between software channel 
assignment and module channel assignment (red switch position).  

 
1. From MP150 > Setup Channels, select the analog tab and click View by Modules...  

 
2. Click Add New Module from the bottom of the dialog. 

  
3. Select a module and click Add. 
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4. If prompted, select a transducer and click Add. 

 
5. Input the settings of the switch on the selected module and click OK. Set 

the choose channel switch to the number set on the amplifier (some 
amplifiers, such as the OXY100C, have a switch on the front of the 
module). 
 Setup detects any potential channel conflicts between software 

assignment and the module’s red channel switch position. 
6. Establish the configuration parameters (gain and filters) and click OK. It 

is important to set the Gain and Filter settings to correspond to the switch 
settings on the amplifier. The software uses this information to scale the 
signal to the correct units. If the Gain is not set to match, the signal will 
be scaled incorrectly. 
 

7. Perform calibration steps, if required. The software will automatically 
scale certain signals, if they only require a zero setting. However, some 
signals require a two-point calibration. In this case, the software will 
generate additional prompts for the scale values.  
 
The following examples show the dialogs for setting up a force 
transducer. 

a. The software prompts the user for pretension amount; enter “0” if 
pretension is not required. 

 
b. Enter a low calibration value or “0” if calibrating between zero and a second weight, when OK is 

clicked, he software will take a voltage reading. 

 
c. Enter a high calibration value and click OK for the software will take a voltage reading. 

 
Note When recording is started, the data may show an offset. This offset is the amount that was 

entered in the pretension dialog. Adjust the tension applied to the transducer to center the 
signal on zero. 

Using this information, the module setup automatically sets the scaling and initial visual range to 
match the physical input units from the module or transducer. 
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View by Channels 

Channel Type 

To specify the channel type—Analog, Digital, or Calculation—click its tab at the top of the dialog. 

 
For each channel you wish to collect data on, there are three options for channel setup: acquire, plot, and 
values. These options appear as boxes on the left side of the Input Channels dialog. 

  

Acquire 

The first option is whether or not you wish to collect data on that channel. The default MP150 setup is not set 
to acquire any channels; the default setup will only collect data on channel 1. To collect data on other 
channels, position the cursor over the Acquire box (on the far left) and click the left mouse button. 

To leave hardware connected to the data acquisition unit, but have the software essentially “ignore” the 
channel, leave the acquire box unchecked. For example, if an input device (such as an ECG100C amplifier) is 
set to channel 7, data from that channel will not be collected unless the Acquire box is checked. 

 

Plot 

The second option is for plotting data. You will need to specify a Plot option for each channel. The Plot 
option determines whether or not data will be plotted on the screen for each channel. Checking this option 
instructs the software to plot data on your computer’s screen. 

When this box is left unchecked, data will still be collected (assuming the Acquire box is checked) but it will 
not be displayed during the acquisition. 

In most cases, you will want to check this option. However, in large-scale acquisitions (i.e., many channels 
and/or high sampling rates) you may want to uncheck this option for some channels to allow for faster display 
rates or to increase the display area for important channels (see Appendix B—Hints for working with large 
files). Alternatively, use a separate data view and enable channels for as desired for optimum viewing. 

The Plot state is applied only on initial acquisition into a graph or template. If data has been previously 
acquired, use the channel buttons in the graph window to change channel visibility. 

 

Values 

The third option enables incoming data values to be displayed either numerically and/or in a “bar chart” 
format in a separate window during an acquisition. Checking this option allows you to open a window (by 
selecting Show Input Values... under the MP150 menu) that displays the numeric value for each input with 
the “Values” option checked. This option is especially useful for tracking slowly changing values such as 
heart rate, respiration rate, or concentrations of chemicals in a substance. For more information on how input 
values are displayed, please turn to page 221. 

 

Channel 

Click in the channel number box (i.e. A1) to make that channel active (“selected”) so its settings can be 
established or edited. 
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Label 

You may attach an editable “label” to each channel. These labels allow you to provide a brief name for each 
channel. To change the label for any channel, position the cursor in the area to the right of the channel 
numbers (A1 through A16) under the label heading and enter a text label. You may key up to 38 characters 
and these labels will appear next to the channel label boxes in the graph window. To edit the label after setup, 
use  the Set Up Channel dialog at any time, or right-click the active channel label in the graph window to 
generate the Assign Channel Label dialog. 

 

Presets 

Calculation Presets are like “templates” for calculation channels. Each Preset stores: 
    a) Calculation channel type 
    b) parameters for that Calculation 
    c) channel-specific scaling 
    d) channel-specific sampling rate 
    e) channel name. 

Calculation Presets establish settings to target application-specific analysis. Presets exist for a broad range of 
analysis functions, including Fourier Linear Combiners and Adaptive Filtering. Start with existing presets for 
a specific species or protocol—for example, human vs. small animal, or stationary vs. exercising 
measurements. 

The Channel Setup dialog contains a “Preset” pop-up menu by each channel that lists the current Preset or, if 
no Preset has been selected for that channel, the Calculation type (Integrate, Difference, etc.). When you 
select a Preset for a particular channel, the channel is configured with the settings associated with that Preset.  

The Setup dialog has a “Presets” pop-up menu that contains all of the Presets for the Calculation type being 
configured. For instance, if a Difference Calculation channel is being configured, all Presets for the 
Difference Calculation will be listed. Just click the Presets head and scroll to select the desired preset.  

             
 Calculation Presets 

When you select a Preset, the Setup dialog is updated with the corresponding information. 

 The Setup dialog reads “none” if the channel configuration doesn’t match any Preset. The menu will 
flip to “none” when the settings for a channel are changed such that they no longer match a Preset.  

 You can create a new Preset from existing Calculation channels. Click “Setup” to display the 
Calculation Setup dialog and click the “New Preset” button. The settings will be applied to the current 
channel, and you will be prompted to enter a name for the new Preset. You cannot duplicate a Preset 
name, which also means that you cannot use the default name of a Calculation channel type 
(Integrate, Difference, etc.). The new Preset will be included in the pop-up menus and saved with the 
file. 

 To reorder channel Presets (by type, use, etc.), choose MP150 > Organize Channel Presets and then 
use the up/down buttons as appropriate (see page 1233). 

 Presets are not applicable to and therefore not selectable on Analog or Digital channels. 
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Channel Sampling Rate  

The Variable Sampling Rate feature allows different channels of data to be down-sampled from the 
acquisition sampling rate; calculation channel must use sampling rate less than or equal to the source channel. 
Choosing lower sampling rates for signals where meaningful data falls below the Nyquist frequency of the 
acquisition sampling rate allows more data to be stored in memory or on disk. 

 Offline operations that involve multiple channels must use the same sampling rate for all Source and 
Destination channels. These operations include waveform editing, Waveform math, Expression 
calculations and Template functions; notable exceptions are “Off-line Averaging” under Find 
Cycle/Peak and “Reset via a Control Channel” under Integrate. 

 When wave data is copied to the clipboard or journal, data values will be inserted at the highest 
sampling rate (channels with a lower sampling rate will snap to the left). 

 To set an arbitrary channel sample rate for analysis, use Transform > Resample (see page 292). 

 There is no restriction on the acquisition length when using Variable Sampling Rates. 

 When Variable Sampling Rates are used in conjunction with the Append mode, and the mode is started 
and stopped manually, it is statistically possible that, prior to the next pass of the Append, extra data 
points may be inserted in various data channels to “line up” the data (see sample on page 1107). These 
extra data points simply replicate the last sample in any affected channel. 

To minimize the impact of the extra data points: 

a) Make sure the lowest sampling rate is on the order of 10 Hz or higher, or 

b) Don’t use Variable Sampling Rates. 
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Set Up Channels—Advanced 
The previous section covered the basic options used in almost all acquisitions. In addition to the features 
described above, a number of other options are available in terms of setting up channels. These advanced 
features are also found under the Set Up Channels menu item. 

Most acquisitions involve collecting analog signals and then displaying them on screen. It is frequently 
useful, however, to collect other types of data (digital data, for instance) or to perform transformations on 
analog data as it is being acquired. Channels containing digital signals and transformed analog signals can be 
collected in addition to the 16 analog channels. 

In the upper right hand corner of the Set Up Channels dialog, you will see the words Analog, Digital, and 
Calc. These refer to (respectively) analog channels, digital channels, and Calculation channels. The general 
features (acquiring, plotting, and the like) are the same for each type of channel, although there are 
considerable differences between the type of data each channel is designed to handle. You may acquire up to 
16 channels each of analog, digital, and Calculation channels. Analog and digital channels may be acquired in 
any combination, and the only requirement for Calculation channels is that you have at least one input 
channel (either analog or digital). 

Analog channels 

Analog channels are the most common type of acquired channel and should be used to acquire any data with 
“continuous” values. Examples of this include nearly all physiological applications where input devices 
(transducers and electrodes) produce a continuous stream of varying data. The range of values for analog 
channels is ±10 Volts. 

AcqKnowledge also allows you to rescale the signal on analog channels to more meaningful numbers. As an 
example, imagine a temperature transducer is connected to an SKT100C amplifier with a gain setting of 
5°/Volt, and output set to channel 1. Ordinarily, the values from the amplifier would be read in as Volts or 
milliVolts. For this acquisition, you need to express the signal from the transducer in terms of degrees 
Fahrenheit. To calibrate the transducer, bring it to two known temperatures. At the first temperature, take a 
voltage reading by selecting Show input values from the MP150 menu (see page 12221 for a description of the 
Show Input Values options). At 90° F, you will get a reading of 0 Volts. The transducer is then brought to a 
temperature of 95° F, and you will get a reading of +1 Volts. 

To scale the incoming signal to degrees F, click the Setup… button in the Input Channels dialog. 

  
Scaling dialog set to rescale Volts to degrees Fahrenheit and Use Mean Value Settings dialog 

The Input Volts and Map (Scale) Value boxes reflect the value of the incoming signal and how it will be 
plotted on the screen, respectively. Thus, an incoming signal of +1 Volts would be plotted as 95° F, whereas a 
signal of 0 Volts would be plotted as 90° F. AcqKnowledge will perform linear extrapolation for signal levels 
falling outside this range (i.e., -2 Volts will be scaled to 80 ° F), as well as perform similar interpolation for 
values between this range. Enter these numbers in the scaling dialog, type in “degrees F” for Units, and click 
OK. 
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As a shortcut for scaling channels, use the Cal 1 and Cal 2 buttons. Click either of these buttons to read in the 
current voltage for the selected channel. In the above example, the transducer could simply be set to a known 
temperature, then Cal 1 could be clicked, and then the temperature could be entered in the Map (Scale) value 
box for Cal 1. 

Next the the transducer could be brought to another known temperature that is considerably higher or lower 
than the first and click Cal 2 and the new known temperature could then be enter in the Map (Scale) value box 
for Cal 2. AcqKnowledge calculates the slope and offset from the two points entered. Each data sample from 
channel 1 will now be scaled according to the slope and offset calculations previously made. When an 
acquisition is performed, the amplitude scale (vertical axis) will reflect the rescaled units. 

It is important to note that Cal 1 and Cal 2 cannot be used when data is being acquired. In 
other words, a channel must be calibrated before it can be acquired. To set the calibration for 
a given channel, connect the input device to the MP data acquisition unit and power up the 
MP System (MP150 or MP36R), and then perform your calibration before starting data 
acquisition. 

The Calibrate all channels at the same time option is used when identical types of transducers or signals are 
being simultaneously recorded on two or more channels. 

If this option is selected, when Cal 1 or Cal 2 is pressed: 

 Map (Scale) Value will be updated for all active channels 

 Input Volts need to be updated for each channel individually. 

The Use mean value option is useful if the input voltage signal is noisy around a mean value. The “Input 
Volts” value returned will be the mean value over the specified number of readings. When this option is 
selected, a Settings… button is activated and generates an “Analog Channel Calibration” prompt for the 
number of readings. 

The data is read the number of times indicated in the prompt and then the readings are averaged. The rate of 
obtaining these readings is indeterminate because the rate depends on the actual hardware unit as well as the 
communication type. 
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Analog channels MP36R 

The MP36R analog channel scaling setup works as shown above, but additionally allows the channel gain to 
be configured directly with a variety of input ranges. Gain settings are accessible via a pop-up menu in the 
Channel setup dialog. (MP36 > Set Up Channels) The Gain setting specifies the extent to which an incoming 
signal is amplified. The Gain is automatically set when a data type is selected from the available Presets. The 
preset Gain settings are only educated guesses and should be used as initial starting values. You may need to 
adjust the gain settings depending on how the amplified signal appears once sample data is collected. 

 

Offset 

To correct the offset of an incoming analog signal, you can add or subtract a constant to the signal prior to 
amplification. Offset can occur if a transducer or electrode has inherent offset. By default, Offset is set to 
zero, and the allowable entry range will vary depending on the Gain and Scaling values. 

To make inputting voltages easier, the analog channel scaling dialog for the MP36R displays the input 
voltages in units that adapt to the gain setting. (x200 is the default) 

The scaling units will adjust dependent upon the gain setting as follows: 

 If the gain is set to < x1000, the Scaling input units will display as millivolts (mV).  
 If the gain is set to > x1000, the Scaling input units will display as microvolts (μV). 

 

  
Channel gain set to < x1000 displays mV input units   

 

Channel gain set to > x1000 displays μV input units 

 

Fixed Hardware Filters MP36R 

The MP36R Unit allows up to three user-configurable, sequential, biquadratic (second order) Infinite Impulse 
Response (IIR) filters. These filters are typically configured by choosing a Preset but can be changed 
manually via the Input Channel Parameters dialog (MP36 > Set Up Channels > Setup button). 
In the “Digital Filters” section, select Filter 1, 2, and/or 3 and then adjust the Type, Freq, and Q. 
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The default setting is no filters applied. 

Adjustable Hardware Filters MP36R 

These filters are implemented using resistors and capacitors in the front end circuitry of the MP36R unit. 
They are set via the “High Pass” section of the Input Channel Parameters dialog (MP UNIT > Set Up 
Channels > Setup”). 

 

High Pass Filter  Appropriate use 

0.05 Hz HP ECG 
Respiration data 

0.5 Hz HP ECG when there is a lot of motion artifact causing a shifting baseline  
EEG 
Pulse plethysmograph 
Most other types of AC Coupled data 

5 Hz HP EMG 
Heart Sounds 
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Additional controls in MP36R Input Channel Parameters 

Button Explanation 
New Channel Preset Allows a custom Preset to be saved under a unique name 
Advanced Opens Advanced dialog. The Advanced dialog may be used to specify additional settings, 

requirements, and dependencies for the preset. See below for complete explanation of all 
Advanced options. 

Scaling Use to configure the value of the incoming signal and how it will be plotted on the screen 

 

MP36R Advanced Preset Settings 

Click the Advanced button to open a dialog containing the following optional preset configuration options. 

  

Acquisition Tab Explanation 

Require minimum sampling rate When enabled, specifies that a minimum sampling rate must be selected 
in order for acquisition to continue. 

  

 Transducer Tab Explanation 

Verify connected 
transducer  

When enabled, the software will check for a specific transducer according to the settings in 
this group box prior to the start of each appended segment 

Title Editable text field used to identify transducer name. 

SSID If checked, indicates which SmartSensor resistor ID should be validated for this channel prior 
to each acquisition.  The ID must be an integer between 1 and 23. 

ISID Device Name If checked, indicates that the internal transducer description should be validated for this 
channel prior to each acquisition.  

Fallback on SSID if ISID 
check fails 

If the ISID device name check is unsuccessful for a connected transducer, fall back and 
check the SmartSensor resistor ID.  
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Range + Grids Tab  Explanation 
Apply initial visual 
range 

The initial vertical axis range of plotted data will be set as indicated at acquisition start of the 
first data segment. 

Top Indicates the maximum vertical visual range in destination channel units.  
Bottom Indicates the minimum vertical visual range in destination channel units.  
Apply locked vertical 
grid 

Locked vertical grid settings are applied for the channel. For more details on grid setups, see 
Grid Details on page 75. 

First grid line Provides the fixed location of the origin of the vertical grid. 
Grid spacing Sets the spacing interval between major vertical grid divisions.  
Apply locked horizontal 
grid 

A channel-specific independent horizontal grid will be applied when the channel is added to a 
graph. 

First grid line Sets the origin location of the horizontal grids. 
Grid spacing Sets spacing between major horizontal grid lines based on the time domain. 
Apply grid appearance Enables options for setting grid color/appearance of major and minor grid lines. 
Major line color Alllows customization of major grid line color. 
Minor line color Alllows customization of minor grid line color. 
Show minor grid Shows/hides minor gridlines 
Vertical precision Indicates number of digits displayed on vertical axis. 
Num minor divisions Sets the number of minor grid divisions for the channel. 
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Calibration Tab Explanation 
Use Calibration Additional calibration procedures will be applied to adjust the channel scaling based on 

values read from a physical transducer. 
Require calibration prior ro 
acquiring data 

When checked, calibration will always be required for this channel prior to acquiring the first 
segment of data. 

Calibration Type Specifies calibration option to be performed on the channel. Two types are available: 
 Single point – records a single input voltage and adds it to the Input Volts value of 

both Cal1 and Cal2 
 Double point – records two independent voltages in a sequence of two dialog 

steps and records the first in the input volts for Cal1 and the second for the input 
volts in Cal2 

 
Prompt Displayed only for “single point” calibration. 

Field for inputting dialog text to be displayed to the user for acquiring the single voltage 
input to apply to the scaling input voltage values. 
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Digital channels 

In contrast to analog channels, digital channels are designed to collect data from a signal source with only two 
values (0 and 1). This type of data can be useful in recording whether a switch is open or closed, and 
ascertaining if a device is on or off. Input values for digital channels have two values, +5 Volts and 0 Volts. 
The MP150 interprets +5 Volts as a digital 1 and interprets 0 Volts as a digital 0. Since digital channels have a 
fixed value, the scaling option is disabled for these channels. The main function of digital channels is to track 
on/off devices such as push-button switches and/or to receive digital signals output by timing devices. 
Similarly, these channels are also used to log signals from devices that output auditory/visual stimulus for 
examination of stimulus response patterns. 

0 volts

+5 volts

Positive edge Negative edge 

(binary "1")

(binary "0") 

 
 

Calculation channels 

Compared to either analog or digital channels, Calculation channels do not collect external data, but transform 
incoming data in some way. These channels do not alter the original data, but create new channels (with 
channel numbers starting at CH40) that contain the modified data. 

You can use Calculation channels to compute a host of new variables by using transformations (including 
BPM, integration calculations, and math functions). The channels are Set Up in much the same way (using 
Acquire/Plot/Values boxes) as analog or digital channels, with the exception of the pull-down menu next to 
the Calc button and the Setup dialog. 

To acquire a Calculation channel, click the Calc button and check the Acquire box for each Calculation 
channel you want to compute (the Plot and Value boxes are optional). By default, all Calculation channels 
have the label “Calculation” and entering more descriptive channel labels might prove useful, especially when 
multiple Calculation channels are being acquired. 

Each of these functions requires some additional parameters to be specified, and these options can be set by 
clicking the Setup button in the Input Channels dialog. For any Calculation channel, you will (minimally) 
need to specify the source channel to be transformed and the nature of the transformation.  

Up to 16 Calculation channels can be acquired, and you may use the output of one Calculation channel as the 
input for another channel, as long as the output channel has a higher channel number than the input channel. 
In other words, it’s possible for Calculation channel 3 to include the result of Calculation channel 1, but not 
the other way around. This allows for complex Calculations to be performed that involve two or more 
Calculation channels such as filtering ECG data then computing BPM. 

Although Calculation channels can be useful in many cases and indispensable in others, each Calculation 
channel acquired will somewhat reduce the maximum possible sampling rate, and add to the amount of 
memory required to store data both during and after an acquisition. Thus, you may want to consider 
performing some of these functions after the fact if high sampling rates are needed for your particular 
application. 

TIP: All of the operations (except Control) that can be performed online can 
also be performed after an acquisition has been completed. These 
options are available under the Transform and Analysis menus.  
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Metachannel  

Calculation metachannels provide a method 
for expanding the 16 available calculation 
channels to allow for more complex online 
analysis. The metachannel calculation 
channel type combines multiple steps into a 
single calculation channel so that a chained 
computation can be performed using a single 
calculation metachannel. 

 AcqKnowledge can display the 
results of up to 16 metachannels, 
allowing for a total of 256 
intermediate subchannel steps. 

 

One metachannel can contain up to 16 subchannels, each of which can be individually configured. 
Subchannels can perform any of the functions of top-level calculation channels. 

Each metachannel has one user-defined output channel. The output subchannel is the only waveform data that 
will be recorded in the graph for that metachannel. All other subchannels associated with that metachannel are 
temporary; they do not display in the graph and require no extra space in the graph file to compute. 

Metachannels alleviate the need to use top-level calculation channels for computing intermediate steps where 
only the final computation is desired. Metachannels also can be used as the basis of presets, allowing multi-
step analyses to be applied with a single preset.  

Computation takes place at the lowest waveform sampling rate of all of the referenced source channels, and 
all subchannels are computed at this rate. 

Metachannels labels display in the graph as C#.# 

To have AcqKnowledge perform a Metachannel calculation in real time: 

1. Choose MP150 > Set Up Channels. 

2. Click the Calculation tab. 

3. Check an Acquire box for the Calculation channel you want to contain the filtered data. You may also 
check the Plot and Values boxes as appropriate for each channel. 

4. Click the Preset pull-down menu and select Metachannel. 

5. Click the Setup button in the Input Channels dialog to generate the Metachannel dialog. 

 

Primary Source 

The primary source for a metachannel can be set to any analog, digital, calculation, or subchannel with a 
lower index (index 0-15, with 15 being lowest). 

 

Set Up Subchannel 

Click this button to display the calculation setup dialog for the 
selected subchannel and then set the calculation parameters 
and the source channel.  

Source channel: Each subchannel can be set to use the primary source channel as its data source or 
another channel (analog, digital, or lower-index calculation channel). When the primary source channel 
for the metachannel is changed, the source channel of each subchannel will implicitly be changed. 
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AcqKnowledge QUICK STARTS  

Quick Start templates (.gtl graph template files) were installed to the Sample folder for PC users. You can use a 
Quick Start file to establish the settings required for a particular application or as a good starting point for 
customized applications. See Open As Graph Template on page 1240 for details.  

Q## Application(s) Feature 
1 EEG 

Sleep Studies 
Real-time EEG Filtering 
Real-time EEG Filtering 

2 EEG Evoked Responses 
3 EEG 

Evoked Response 
Event-related Potentials 
Event-related Potentials 

4 Evoked Response Nerve Conduction Studies 
5 Evoked Response Auditory Evoked response & Jewett Sequence 
6 Evoked Response Visual Evoked Response 
7 Evoked Response Somatosensory Evoked Response 
9 Evoked Response Extra-cellular Spike Recording 
10 Psychophysiology Autonomic Nervous System Studies 
12 Psychophysiology Sexual Arousal Studies 
13 EBI 

Cardiovasc. Hemodynamics 
Exercise Physiology 

Cardiac Output 
Noninvasive Cardiac Output Measurement 
Noninvasive Cardiac Output  

15 EOG Nystagmus Investigation 
16 EOG Saccadic Eye Movements 
17 Plethsymography Indirect Blood Pressure Recordings 
18A Plethsymography Arousal - Female 
18B Plethsymography Arousal - Male 
19 Sleep Studies Multiple-channel Sleep Recording 
20 Sleep Studies 

ECG 
Cardiovasc. Hemodynamics 

Online ECG Analysis 
Online ECG Analysis 
ECG Analysis 

21 Sleep Studies SpO2 Analysis 
22 ECG Einthoven’s Triangle & 6-lead ECG 
23 ECG 12-lead ECG Recordings 
24 ECG Heart Sounds 
25 Cardiovasc. Hemodynamics Online Analysis 
26 Cardiovasc. Hemodynamics Blood Pressure 
27 Cardiovasc. Hemodynamics Blood Flow 
28 Cardiovasc. Hemodynamics LVP 
31 NIBP Psychophysiology 
32 In vitro Pharmacology Tissue Bath Monitoring 
33 In vitro Pharmacology Pulsatile Tissue Studies 
34 In vitro Pharmacology Langendorff & Working Heart Preparations 
35 In vitro Pharmacology 

Pulmonary Function 
Isolated Lung Studies 
Animal Studies 

38 Pulmonary Function Lung Volume Measurement 
39 Exercise Physiology Respiratory Exchange Ratio 
40 EMG Integrated (RMS) EMG 
41 EMG EMG and Force 
42 Biomechanics Gait Analysis 
43 Remote Monitoring Biomechanics Measurements 
44 Biomechanics Range of Motion 
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Chapter 6 Calculation 
Channel Presets 

Calculation Presets establish settings to target 
application-specific analysis. Presets exist for a broad 
range of analysis functions, including Fourier Linear 
Combiners and Adaptive Filtering. Start with existing 
presets for a specific species or protocol—for 
example, human vs. small animal, or stationary vs. 
exercising measurements. 

The Channel Setup dialog contains a “Preset” pop-up 
menu by each channel that lists the current Preset or, if 
no Preset has been selected for that channel, the 
Calculation type (Integrate, Difference, etc.). When 
you select a Preset for a particular channel, the channel 
is configured with the settings associated with that 
Preset.  

The Setup dialog has a “Presets” pop-up menu that 
contains all of the Presets for the Calculation type 
being configured. To enable the Preset pop-up menu, 
set at least one analog channel to “Acquire” 
(calculation channels require a source channel). For 
example, if a Difference Calculation channel is being 
configured, all Presets for the Difference Calculation 
will be listed. Just click the Presets head and scroll to 
select the desired preset.  

When you select a Preset, the Setup dialog is updated 
with the corresponding information. 

 The Setup dialog reads “none” if the channel 
configuration doesn’t match any Preset. The 
menu will flip to “none” when the settings for 
a channel are changed such that they no longer 
match a Preset.  

 You can create a new Preset from existing 
Calculation channels. Click “Setup” to display 
the Calculation Setup dialog and click the 
“New Preset” button. The settings will be 
applied to the current channel, and you will be 
prompted to enter a name for the new Preset. 
You cannot duplicate a Preset name, which 
also means that you cannot use the default 
name of a Calculation channel type (Integrate, 
Difference, etc.). The new Preset will be 
included in the pop-up menus and saved with 
the file. 

 To reorder channel Presets (by type, use, etc.), 
choose MP150 > Organize Channel Presets and then use the up/down buttons as appropriate (see 
page 1233). 

 Presets are not applicable to and therefore not selectable on Analog or Digital channels. 
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Integrate Calculation 

     
The online Integrate Calculation offers three basic options: 

Reset via channel. Perform a real-time integration of input data over a variable number of sample points. 
This option is extremely useful for converting flow signals into volumetric equivalents. The integral of 
flow is volume. For example, when recording airflow with a pneumotach, volume can be precisely 
calculated as the flow varies in a cyclic fashion: 

a)  Real-time conversion of flow signals into volume signals (i.e., Blood flow  Blood volume; Air 
flow  Air volume). 

b)  Any processing involving a need for a cyclic, continuous integral calculated in real time. For 
example: Acceleration  Velocity; Velocity  Distance; Frequency  Number of cycles; 
Power  Energy. 

Average over samples. Perform a moving average (mean) and associated processing (Rectify; Root mean 
square) over the specified number of sample points. This option is useful to process EMG signals to: 

a)  Smooth noisy data 

b)  Display the real-time “integration” (rectified, then sample averaged) of the raw EMG data 

c)  Display the real-time “root mean square” calculation of the raw EMG data. 

d)  Return real-time windowed standard deviation. 

Timed reset. This option is available in AcqKnowledge 4.1 and above in the Integrate calculation channel 
and transformation. This mode computes a straight sum of the source data points and resets this sum after 
a fixed amount of time has elapsed. This periodic integral is used in several types of analysis, such as 
EMG analysis where it can generate an EMG signal or estimate the power in fixed time intervals. The 
time interval at which the integral resets to zero may be specified in seconds or in samples. The timed 
integrate reset functionality may also be used in calculation channel presets and by the Mac 
OS X Integrate automator action.  

To have AcqKnowledge perform an Integrate calculation in real time: 

1. Choose MP150 > Set Up Channels. 

2. Click the Calculation tab. 

3. Check an Acquire box for the Calculation channel you want to contain the filtered data. You may also 
check the Plot and Values boxes as appropriate for each channel. 

4. Click the Preset pull-down menu and select Difference. 

5. Click the Setup button in the Input Channels dialog to generate the Difference dialog. 
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Destination 

Determined by the calculation channel selected when the Scaling button was pressed. 

Source 

The source channel is selected from a popup menu that includes any channels being acquired and any 
enabled Calculation channels. 

 

Reset via channel (Integrate option) 

This feature is used to integrate data over a data-
dependent interval. Either the source channel or a 
different channel can control the integration process. 

Control channel 

Allows user to select any active channel as the integration 
control channel. 

Reset Thresholds 

The threshold is to be set at points surrounding the flow 
level. Typical values are: 

 LOW: a negative value close to 0.00
 HIGH: a positive value close to 0.00 

For airflow to volume conversion, the flow signal will 
vary positively and negatively around zero flow. 

Reset trigger  

The Reset trigger polarity determines on which slope 
(Positive  or Negative ) the integration process will 
begin and end. 

Mean Subtraction 

This option will subtract the mean from the data evaluated during the integration period. If this option is 
selected, the integration will only proceed after all the data in the integration period has been collected. When 
collected, the mean value of all the data is subtracted from each data point in the integration period. In this 
fashion, the integral of the corrected data points will result in the integral returning to exactly zero at the end 
of the integration interval. Although this option will result in “well-behaved” integrations, the integrated data 
will be delayed by a fixed amount of time, as specified by the max cycle period. 

Online Enabling mean subtraction delays the signal by the mean cycle length. It waits for that period of 
time to pass so it can determine a mean value for the initial cycle, and it then tries to re-
compute this mean for each cycle. If the resets are too short or too long, the window expires 
and the processing halts again until a new mean can be recomputed. Online processing may 
reset from threshold crossing in the control channel or window expiration when it loses mean 
tracking. 

Offline Since all the data is available, the mean is computed from the data in the channel and the signal 
is not delayed. Also, since it isn’t doing windowed means, there are no window expiration 
events that are inserted. Offline processing may reset from threshold crossing in the control 
channel. 

Max cycle period 

The Max cycle period should be longer than the maximum time expected from trigger event to trigger event 
in the Control Channel. Typically, the default scale settings for cyclic integrated data will be fine. However, 
the units may need to be changed (i.e., liters/sec to liters) via the Scaling option. 

Output reset events—not available for metachannels 

Add Events markers to show where Reset occurred and distinguish why the channel reached zero. 
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 Threshold crossing on the 
control channel 

For example: Calculation 
channel resetting on positive 
crossings of 0V on CH 1. 

 

 

 Window expiry when mean 
removal is enabled 

For example: No threshold 
crossing within “mean cycle 
width” as specified in calc 
channel setup. Settings of 
calc channel: threshold 
crossings positive, 3V, Mean 
cycle subtraction, 1 second 
period width. First reset is 
due to threshold crossing; 
second reset is due to 
window expiry.  

 Zero value due to “true” zero 
being achieved due to 
mathematical results 

For example: Mathematical 
Source is sine wave, integral 
is cosine. Input (10V) never 
crosses threshold levels. 
Signal reaches zero 
mathematically; no reset 
events appear on output. 
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Average over samples (Integrate operation) 

Online sample averaging can be useful when there 
is a high degree of noise present in the data. At 
least some of this noise can be “averaged out” by 
pooling some number of adjacent data points 
together, taking the average of these points, and 
replacing the original values with the new averaged 
values. This process creates a “window” of moving 
averages that moves across the waveform 
smoothing the data.   

Integration used to smooth noisy data 

Since an average represents the sum of a series of data points divided by the number of data points present, 
you can use the Average over samples calculation to provide the information needed to create a moving 
average. 

Samples 

To specify the number of data points to average across, enter a value in the Samples box. The number you 
select will depend in large part on the sampling rate you select and the type of noise present. All things being 
equal, for slower sampling rates you will probably want to mean average across a smaller number of samples. 
As you increase the sampling rate, you will probably want to integrate across more and more samples. As the 
number of samples specified in the samples box increases, the amount of high frequency information 
contained in the data will decrease. 

Parameters 

Rectify —The Average over samples calculation 
can also be used for producing an envelope of 
modulated data. For instance, EMG waveforms 
frequently contain high frequency information, 
which is often of little interest compared to the low 
frequency information also contained in the data. 
When the Rectify option is checked, 
AcqKnowledge will take the absolute value of the 
input data prior to summing and a plot of the 
waveform’s mean envelope over a specified 
number of samples will be obtained. 

 
Online “Average over samples” feature used as an 

envelope detector 

Typically, this option is only used for processing raw EMG and similar types of applications. The signal for 
Rectify is normalized by a factor of (# samples averaged)/(Channel sampling rate). 

Root mean square—provides the exact root mean square (RMS) of the input data (typically EMG) over the 
specified number of samples.  

Remove baseline—provides the exact standard deviation of the input data (typically EMG) over the specified 
number of samples. When the mean of the input data equals 0-0, the standard deviation and the RMS will be 
equivalent.  

Scaling… button—Since the integration values are going to be on a different scale than the original units, you 
need to change the scale of the integration channel to reflect the new units. When you click the Scaling… 
button, a Change Scaling Parameters dialog will be generated.  

The rescaling involves multiplying the “Input units” values by a factor determined by the sampling rate and 
number of samples mean averaged across. 

Map or Scale value = Input units x 
 averaged mean be  tosamples ofNumber 

 rate Sampling  
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As an example, if data was being acquired at 75 samples per second, and you wanted to integrate across an 
interval of 10 samples, you would set the Integration Setup Scaling parameters so that +10 Volts 
corresponded to a Map (Scale) value of 75 and a Map (Scale) value entry of –75 reflected an Input value of –
10 Volts. 

 

 It is important to note that this rescaling should be performed independent of any rescaling 
performed on analog channels themselves. Even if an analog channel is being rescaled to some other 
units, the input values in the integration scaling should be set to +10 Volts (next to Cal 1) and –10 
Volts (next to Cal 2). 

  
Integrate Calculation and Scaling dialoges for 10 point averaging 

When data is averaged in this way, a portion of the data at the beginning of the record (equivalent to the 
number of samples being integrated) should be ignored, as they will reflect a number of zero values being 
averaged in with the first few samples of data. 

 

Timed Reset (Integrate operation) 

 
Timed Reset is a new option for the Integrate operation in AcqKnowledge 4.1. This operation computes a 
straight sum of the source data points and resets this sum after a fixed amount of time has elapsed. This 
periodic integral is used in several types of analysis, such as EMG analysis where it can generate an iEMG 
signal or estimate the power in fixed time intervals.  

The time interval at which the integral resets to zero may be specified in seconds or in samples.  

Timed reset functionality may also be used in calculation channel presets and by the Mac OS X Integrate 
automator action.  
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Smoothing Calculation 

The Smoothing Calculation functions online in real time and is very 
useful if you are trying to remove noise of varying types from a data 
set.  

1. Choose MP150 > Set Up Channels. 

2. Click the Calculation tab. 

3. Check an Acquire box for the Calculation channel you want 
to contain the filtered data. You may also check the Plot and 
Values boxes as appropriate for each channel.  

4. Click the Preset pull-down menu and select Smoothing. 

5. Click the Setup button in the Input Channels dialog to generate the Smoothing dialog. 

 (Off-line Smoothing is available under Transform > Smoothing.) 

  

Source Source is a pull-down menu of the available channels. 

Smoothing factor enter the number of samples to use as a smoothing factor. 

Smoothing method This calculation channel provides real-time Mean (default) or Median smoothing. 

 Mean value The default is mean value smoothing. Use Mean value smoothing when noise appears in 
a Gaussian distribution around the mean of the signal. 

Use Median value Click in the box to activate Median value smoothing if some data points appear 
completely aberrant and seem to be “wild flyers” in the data set. 

  For a given sequence of wave data, x = {x1, x2,...,xn}, Median value smoothing will sort 
the sequence and extract the median equivalent to the recommended NIST (National 
Institute of Standards and Technology) formula: 

 n is odd: median is the center element of the sorted list of n items. 

 n is even: median is the mean of the center pair of elements of the sorted list of n items.  

 The smoothing calculation channel is the primary method of computing real-time median 
values using the definition of median as given above. The smoothing output at a sample 
position is the median of the window of source channel samples including the current 
sample and the previous samples in the window. 

    The size of the window is 1 at the start of acquisition and increases incrementally until 
the final window size is reached. The median extraction method shifts between even and 
odd definitions as the window size is incremented. 

Scaling Click the Scaling button for access to options that allow you to modify the units or 
linearly scale the output. 
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Difference Calculation 

The Difference calculation returns the difference between two data samples over a specified number of 
intervals and divides the Difference by the time interval spanned by the data values. The Difference 
Calculation is useful for calculating an approximation of the derivative of a data set in real time. 

To have AcqKnowledge perform a Difference calculation in real time: 

1. Choose MP150 > Set Up Channels. 

2. Click the Calculation tab. 

3. Check an Acquire box for the Calculation channel you want to contain the filtered data. You may also 
check the Plot and Values boxes as appropriate for each channel. 

4. Click the Preset pull-down menu and select Difference. 

5. Click the Setup button in the Input Channels dialog to generate the Difference dialog. 

The Difference Calculation dialog allows you to specify the source channel and the number of intervals 
between samples over which the difference is to be taken, and also includes the option of rescaling the 
channel to reflect different units. 

Click the Setup button in the Input Channels dialog to generate the Difference dialog:  

  
Source When the Source channel contains relatively high frequency data, the Difference Calculation 

may result in a very noisy response, so it’s best to use Difference on relatively smooth data. 

Sample rate This line provides the sample rate for the selected channel (may be different than the 
acquisition sample rate). 

Intervals Difference is calculated with respect to the number of intervals between points (rather than 
the number of sample points). For instance, two sample intervals span three sample points: 

POINT<interval > POINT<interval > POINT 

 A 1-interval difference transformation applied to a blood pressure (or similar) waveform will 
result in the widely used “dP/dT” waveform. 

 See page 1291 for a complete description of the online Difference function. 
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Rate Calculation 

  
The Rate Calculation is used to extract information about the interval between a series of peaks in a 
waveform. This interval can be scaled in terms of BPM (the default), frequency (Hz), or time interval between 
peaks. 

 The BPM (or beats-per-minute) Rate function is used as a measure of peaks or events that occur in a 
sixty-second period. 

 The frequency rate function is commonly used to describe the periodicity of data, or the amount of 
time it takes for data to complete a full cycle (from one peak to the next peak). 

 The Interval Rate function returns the raw time interval between each adjacent pair of peaks, which 
is essentially the inter-beat interval (IBI), frequently used in cardiology research. 

These three functions essentially provide the same information in different formats, since a frequency of 2Hz 
is equal to an inter-peak interval of 0.5 seconds, both of which are equivalent to a BPM of 120. Other options 
allow you to record the maximum or minimum value of all peaks (the peak max/min option), or to count the 
aggregate number of peaks (the count peaks option).  

In order to calculate Rate information, you have the option of specifying the threshold manually or having 
AcqKnowledge automatically compute the threshold value (which is the default). This section describes the 
basic parameter settings for typical online Rate Calculations. 

NOTE: Parallel functions can be performed after data has been acquired. A 
detailed description of the Rate Calculation options can be found in the Find 
Rate section on page 13324. 

 

To perform a Rate Calculation in real time: 

1. Choose MP150 > Set Up Channels. 
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2. Click the Calculation tab. 

3. Check an Acquire box for the Calculation channel you want to contain the filtered data. You may also 
check the Plot and Values boxes as appropriate for each channel. 

4. Click the Preset pull-down menu and select Rate. 

5. Click the Setup button in the Input Channels dialog to generate the Rate dialog. 

  

Destination—determined by the Calculation channel that was selected when the “Setup” button was pressed. 

Source—selected from the Source popup menu at the top of the dialog. 

Sample rate—provides the sample rate for the selected channel (may be different than the acquisition sample 
rate). 

Function —The popup menu includes options to scale the rate in terms of Hz, BPM, Interval, Peak Time, 
Count Peaks, Peak Minimum/Maximum, Peak-to-Peak, Mean Value, or Area. 

 For more information on each of these functions, see the Calculation Channels section beginning on 
page 115. 

 Calculate systolic using the peak maximum Function, diastolic using the peak minimum Function, 
and mean blood pressure using the mean value Function. 

 NOTE: All of these Function options are available in the post-acquisition mode through 
the Analysis > Find rate function 

Remove baseline—provides the exact standard deviation of the input data (typically EMG) over the specified 
number of samples. When the mean of the input data equals 0-0, the standard deviation and the RMS will be 
equivalent. 

Auto Threshold detect—The most convenient way to calculate a Rate channel online is to have 
AcqKnowledge automatically compute the threshold value (the “cutoff” value used to discern peaks from the 
baseline). This is done by checking the Auto Threshold detect box. 

Output reset events (not available for metachannels)—When auto threshold detection is being used, the 
minimum and maximum rates of the signal are specified in the Windowing controls. If the input signal falls 
out of this range, the value of the rate function and automatic threshold level will be reset. By enabling 
“Output reset events” a reset event will be placed on the output at the location of these window expirations. 
Rate detector is set to “Peak function, default window of 40 BPM to 180 BPM, auto threshold detect for 
positive peaks. The reset event occurs after the window expiration, approximately a full 40 BPM interval after 
the “peak” transition from 0 to 5 volts in the source signal. 

  
Polarity—For Rate Calculations involving data with positive peaks (such as the R-wave in ECG data), click 
the button next to “Positive” in the Polarity section of the dialog. 

Noise rejection—AcqKnowledge constructs an interval around the threshold level when Noise rejection is 
checked. The size of the interval is equal to the value in the noise rejection text box, which by default is equal 
to 5% of the peak-to-peak range. Check this option to help prevent noise “spikes” from being counted as 
peaks. 
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Peak Interval Window—When “automatic” Rate Calculations are set, specify a minimum rate and a 
maximum rate. These parameters define the range of expected values for the Rate Calculation. By default, 
these are set to 40 BPM on the low end and 180 BPM on the high end. The Windowing units option is only 
activated when the selected function can have variable units (i.e., count peaks, mean value, area). 

The Rate Calculation will use these values to find and track the signal of interest, assuming the input BPM 
range is reasonably well bracketed by these values. Depending on the shape of the input cycle waveform, the 
Rate window settings may be closer or further from the expected rates. 

 For ECG-type data (where the waveform peak is narrow with respect to the waveform period), the 
Rate window values will closely bracket the expected values. 

 For more sinusoidal data, with the waveform energy distributed over the waveform period (as with 
blood pressure or respiration), the Rate window will closely bracket the expected rate on the high-
end, but can be up to twice the actual measured rate at the low-end. 

One of the most frequent applications of the Rate Calculation is to compute BPM online for 
ECG, pulse, or respiration data. For more information on optimizing ECG amplifiers for 
online calculation of heart rate, see the ECG100C section of the MP Hardware Guide. 

Show Threshold—Plots the threshold used by the Rate calculation function. This feature is useful to help the 
rate detector performance on any given data. 

Show Modified—Plots the modified data as processed by the Rate Detector. Typically, the modified data is a 
differential version of the original input data. The data will be modified if the “remove baseline” feature is 
checked in the Rate Detector Setup dialog.
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Math Calculation 

The Math Calculation performs standard arithmetic calculations using two waveforms or one waveform and a 
constant. It is also possible to use other Calculation channels (such as a Rate Calculation channel) as an input 
channel for a Math Calculation channel, as long as the Calculation channel used as a source channel has a 
lower channel number than the Math Calculation channel. 

1. Choose MP150 > Set Up Channels. 

2. Click the Calculation tab. 

3. Check an Acquire box for the Calculation channel you want to contain the filtered data. You may also 
check the Plot and Values boxes as appropriate for each channel. 

4. Click the Preset pull-down menu and select Math. 

5. Click the Setup button in the Input Channels dialog to generate the Math dialog. 

Use the pull-down Source menus to select the source channels (Source 1 and Source 2). 

The Sample rate line provides the sample rate for the channel selected as Source; the channel sample rate may 
be different than the acquisition sample rate. 

Use the pull-down Operand menu to select a function. In the example below, analog channel 1 (Source: A1) is 
added to analog channel 2 (Source: A2). To use this summed waveform as an input for another Math 
Calculation channel. One useful application would be to divide this waveform (C0) by K, where K=2, thus 
producing an arithmetic average of source channels A1 and A2. 

   
The “Constant” entry is activated when “K” is selected as a Source. 

As an alternative to creating an additional Calculation channel for dividing the summed waveform, you can 
use the scaling function to perform the same task. To do this, click Scaling… button and then set the Map 
(Scale) value for the summed waveform equal to +5 and –5 (to correspond to Input Volts values of +10 and –
10 respectively). This will effectively plot the sum of channels A1 and A2 as the arithmetic mean of the two 
waveforms. 

For additional libraries of online Calculation options, consult the sections on Function Calculation 
channels and the online Equation Generator (Expression, page 11133). These types of Calculation 
channels can be used to perform more complex operations on waveforms. Although Calculation 
channels can be “chained” together (so that the output from one serves as the input for another) to 
form more complex calculations, a separate channel must be used for each function. Since only 
sixteen Calculation channels are available, not all calculations can be performed. Additionally, 
chaining more than three or four channels together can require considerable system resources. 

For complex calculations (such as squaring a waveform then adding it to the average of two other 
waveforms) the Equation Generator (Expression) is a more efficient solution. All of the features 
available online in the Math Calculation channels can also be computed after an acquisition using the 
Waveform Math option (see page 12294), which will eliminate the problem of system overload. 
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Function Calculation 

 

 

The Function calculation can be used to perform a variety of 
mathematical functions using two waveforms or a waveform and a 
constant. Function Calculation channels compute new waveforms 
in a manner similar to the math Calculation functions, but provide 
access to higher order functions. Like math Calculation channels, 
function Calculations can be chained together to produce complex 
functions (such as taking the absolute value of a waveform on one 
channel and Calculating the square root of the transformed 
waveform on another channel). These same functions are also 
available under the transform menu in AcqKnowledge for post-hoc 
operations. Many of these functions can also found in the online 
Equation Generator (see Expression on page 133 for details). 

To have AcqKnowledge perform a Function Calculation in real 
time: 

1. Choose MP150 > Set Up Channels. 

2. Click the Calculation tab. 

3. Check an Acquire box for the Calculation channel you 
want to contain the filtered data. You may also check the 
Plot and Values boxes as appropriate for each channel. 

4. Click the Preset pull-down menu and select Filter. 

5. Click the Setup button in the Input Channels dialog to 
generate the Function dialog. 

Other Functions are available in the online Equation Generator 
(see Expression on page 11133). Function Calculations can be 
chained together to produce more complex Calculations, although 
it is more efficient to program complex functions using the 
Equation Generator (Expression). 

The Sample rate line provides the sample rate for the selected 
channel (may be different than the acquisition sample rate). 

Function 
Abs Returns the absolute value of each data point 
Atan Computes the arc tangent of each data point 

Exp Takes the ex power of each data point 
Limit Limits or “clips” data values that fall outside specified boundaries 
Ln Computes the base e logarithm for each data point 
Log Returns the base 10 logarithm of each value 
Noise Creates a channel of random noise with a range of ± 1 Volt 
Sin Calculates the sine (in radians) of each data point 
Sqrt Takes the square root of each data point. 

Threshold Converts above an upper threshold to +1 while converting data below a lower threshold to 0. 

Thresholding Algorithm Assume a domain variable  t  tstart , tstart 1, tstart  2,K  

with tstart being an integer, a real-valued signal y(t) defined for all t, and two real valued levels 
ylow and yhigh satisfying the relation ylow  yhigh . 

Define the Threshold function thresh(t) function such that: 

thresh(tstart ) 
1 y(tstart )  ylow

0 y(tstart )  ylow





    thresh(t) 
0 y(t)  ylow

1 y(t)  yhigh

thresh(t 1) ylow  y(t)  yhigh
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Filter Calculation 

The Filter Calculation channel allows you to perform real time digital filtering on analog, digital, or 
calculation channels. To have AcqKnowledge apply a digital Filter Calculation in real time: 

1. Choose MP150 > Set Up Channels. 

2. Click the Calculation tab. 

3. Check an Acquire box for the Calculation channel you want to contain the filtered data. You may also 
check the Plot and Values boxes as appropriate for each channel. 

4. Click the Preset pull-down menu and select Filter. 

5. Click the Setup button in the Input Channels dialog to generate the Filter dialog. 

                      
Filter Setup & Output Options 

In the dialog above, the signal on analog channel one (A1) is run through a low-pass filter that attenuates data 
above 50 Hz. The “Q” for this filter is 0.707, which is the default. 

One possible application of the online filtering option is in conjunction with the Show Input 
Values option (see page 12221). Raw EEG data, for instance, can be filtered into distinct 
bandwidths (alpha, theta, and so forth) using one source channel and multiple filter 
Calculation channels. The filtered data can then be displayed in a bar chart format during the 
acquisition using the Show Input Values option. 

Source Set the source channel. 

Sample rate provides the sample rate for the selected channel (may be different than the acquisition 
sample rate). 

Type (Output) Lists the filter options: low pass, high pass, band pass, band pass (low + high), band stop, and 
comb band stop. See About Filters in this section for more details on filter types. 

Frequency Fixed value—Type a value in the entry box. 

 Sampling rate—Sets the frequency to a fraction of the sampling rate and automatically 
updates when the sample rate is modified. 

 Line frequency—Uses the line frequency at which the data was recorded. 

Q coefficient The online filters are implemented as IIR (Infinite Impulse Response) filters, which have a 
variable Q coefficient. The Q value entered in the filter setup box determines the frequency 
response patterns of the filter. This value ranges from zero to infinity, and the “optimal” 
(critically damped) value is 0.707 for the Low pass and High pass filters, and 5.000 for the 
Band pass and Band stop filters. If you wish, you may change the Q. A more detailed 
explanation of this parameter, and digital filters in general, can be found in Appendix B. 
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About Filters 

While the technical aspects of digital filtering can be quite complex, the principle behind these types of filters 
is relatively simple. Each of these filters allows you to set a cutoff point (for the low and high pass filters) or a 
range of frequencies (for the band pass and band stop filters). 

 A Low Pass filter allows you to specify a frequency cutoff that will “pass” or retain all frequencies 
below this point, while attenuating data with frequencies above the cutoff point. 

 High Pass filters perform the opposite function, by retaining only data with frequencies above the 
cutoff, and removing data that has a frequency below the specified cutoff. 

 Each type of Band Pass filter is optimized for a slightly different type of task. 

The Band Pass (low + high) filter is designed to allow a variable range of data to pass through the 
filter. For this filter, you need to specify a low frequency cutoff as well as a high frequency cutoff. 
This defines a range or “band” of data that will pass through the filter. Frequencies outside this range 
are attenuated. The Band pass (low + high) is actually a combination of a low pass and a high pass 
filter, which emulate the behavior of a band pass filter. This type of filter is best suited for 
applications where a fairly broad range of data is to be passed through the filter. For example, this 
filter can be applied to EEG data in order to retain only a particular band of data, such as alpha wave 
activity. 

The alternative Band Pass filter requires only a single frequency setting, which specifies the center 
frequency of the band to be passed through the filter. When this type of filter is selected, the “width” 
of the band is determined by the Q setting of the filter (discussed in detail below). Larger values for q 
result in narrower bandwidths, whereas smaller Q values are associated with a wider band of data that 
will be passed through the filter. This filter has a bandwidth equal to Fo/Q, so the bandwidth of this 
filter centered on 50 Hz (with the default Q=5) would be 10 Hz. This type of filter, although 
functionally equivalent to the band pass (low + high) filter, is most effective when passing a single 
frequency or narrow band of data, and to attenuate data around this center frequency. 

 The Band Stop performs the opposite function of a band pass. A Band stop filter defines a range (or 
band) of data and attenuates data within that band. In this case, the Band stop filter is implemented in 
much the same way as the standard Band pass, whereby a center frequency is defined and the Q value 
determines the width of the band of frequencies that will be attenuated. 

 The Comb Band Stop removes interfering harmonics; resonance, aliasing, and other effects may 
generate interference at multiples of a base frequency. It combines all the required filters instead of 
requiring a separate filter for each interfering overharmonic. For setup details, see page 1272. 

Off-line filtering 

Apart from these online filter options, similar filters can be applied after an acquisition is terminated. Many of 
the biopotential amplifiers available from BIOPAC have selectable filters, which allow you to filter certain 
frequencies (including 50 Hz or 60 Hz electrical noise) and possibly reduce the need for online filters. 

Digital filtering can also be performed after an acquisition using the same types of filters. You can choose 
from the different filter types by selecting Digital filters from the Transform menu. The filters available after 
the acquisition use a different algorithm but operate in essentially the same way. 

For more information on digital filters and filters that can be applied after an 
acquisition, turn to the Digital Filtering section on page 266 or Appendix B. 
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Equation Generator (Expression) 

  
The online Equation Generator (Expression calculation channel) is available for performing computations 
more complex than possible in the Math and Function calculations. The Equation Generator (Expression 
calculation) will symbolically evaluate complex equations involving multiple channels and multiple 
operations. AcqKnowledge can perform conditional evaluation, data extraction, logical operations, 
expressions requiring a range of samples or the results of the previous expression, and evaluation of generic 
formulas that can be expressed in a closed, recursive form. 

Unlike the Math and Function calculations—which can only operate on one or two channels at a time—the 
Equation Generator (Expression calculation) can combine data from multiple analog channels, and allows you 
to specify other Calculation channels as input channels for Equation channels. Also, computations performed 
by the Equation Generator (Expression calculation) eliminate the need for “chaining” multiple channels 
together to produce a single output channel. 

While the Equation Generator (Expression calculation) is more powerful than other Calculation channels, 
each Expression calculation requires more system resources than other Calculations. This essentially means 
that acquisitions that utilize Equation calculations are limited to a lower maximum sampling rate than 
acquisitions without online Expression functions. When an expression is evaluated, it is actually evaluated 
multiple times. The expression is computed starting at the first sample acquired, and is then evaluated once 
for each successive acquired sample. 

AcqKnowledge can accept the notations SC, MC, and CHn to reference the sample at the current evaluation 
position or SC(x), MC(x), and CHn(x) for values at locations prior to the present evaluation location using 
an offset expressed in sample intervals. For example, CH1(-1) will give the previous sample of Channel 1. 

The same features that are available in online Calculation channels are also available under the Transform 
menu for evaluation of complex equations after acquisition. Thus, simple Calculations such as summing two 
channels or dividing one channel by another (and so forth) are best performed in either the Math calculation 
channels or the Function calculation channels. 

On the other hand, for complex Calculation channels, such as squaring one channel, multiplying it by the sum 
of two other channels, and dividing the product by the absolute value of another waveform, a single 
Expression calculation channel is more efficient than chaining five Math and Function calculation channels. 

Save to Calculation Channel 

To evaluate an expression and save the result to a Calculation channel in real time: 

1. Choose MP150 > Set Up Channels. 

2. Click the Calculation tab. 

3. Check an Acquire box for the Calculation channel you want to contain the filtered data. You may also 
check the Plot and Values boxes as appropriate for each channel. 

4. Click the Preset pull-down menu and select Expression. 

5. Click the Setup button in the Input Channels dialog. This will produce a dialog, where you can enter 
the expression to be evaluated. 
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The different components of each expression can be entered either by double-clicking buttons from the button 
rows (sources, functions, and operators) in the setup expression dialog, or by typing commands directly into 
the Equation box. The Equation Generator (Expression) uses standard mathematical notation. 

For each expression, you need to specify at least one source, the function(s) to be performed, and any 
operators to be used. Sources are typically analog channels, although you may also select Time from the 
source button row and AcqKnowledge will return the value of the horizontal axis (usually time) for each 
sample point. When the horizontal axis is set to frequency (in the Display > Horizontal axis dialog), the 
“time” item in the source button row will switch to “frequency.” 

When using the online Equation Generator (Expression calculation channel), it is important to keep in mind 
that while different channels, functions, and operators can be referenced, the Calculation cannot reference 
future sample points. That is, data from waveform one can be transformed or combined in some way with 
data from waveform two at the same point in time, although data from one point in time (on any channel) 
cannot be combined with data from another point in time (on any channel). See the section on post-acquisition 
expression commands (beginning on page 293111111) for ways around this limitation. 

Functions The arguments to each function are represented in the Functions table in italics and 
may be replaced by any valid expression. Each argument is separated from its next 
argument by a comma. Expressions can only contain commas within balanced 
parenthesis pairs. An ellipsis (“...”) at the end of a function description indicates that 
any number of arguments may be present provided they are in a comma separated list. 
When a function is added to an Expression, the cursor is placed between the 
parentheses.  

Conditionals Change output based upon a condition test. All of the conditionals treat the value zero 
as false and any non-zero value as true. Expressions can only contain commas within 
balanced parenthesis pairs. 

Offset Notation Offset notations take integer offsets in terms of the number of samples using the 
formation CH#(P) where CH# is the channel number and P is the number of points. For 
example, an offset of -1 will return the data point immediately to the left of the selected 
point and an offset of +1 will return the data point immediately to the right of the 
selected point. 

 To refer to previously acquired data, offsets must be negative. For notational 
convenience, offsets that result in an invalid negative sample position (e.g. no data is 
defined prior to the first sample in the graph) evaluate to zero. Any attempt to access a 
sample beyond the end of the data will result in an error. Any attempt to use a positive 
offset for an online Equation Generator (Expression calculation channel) will result in 
an error. 

CHn(x) Returns the value of channel with index n x samples away from the current 
evaluation position. 

SC(x) Returns the value of the selected channel x samples away from the current 
evaluation position. Only allowed for Transformations and Measurements; 
not allowed for Calculations. 

MC(x) When x is zero or positive, returns the value of the measurement channel x 
samples away from the current evaluation position. When x is negative, 
returns the result of the expression evaluation that occurred x steps previous 
to the current evaluation position. Only allowed for Measurement 
Expressions (see below); not allowed for Calculations or Transformations. 

Recursive notation Since transformations and calculation channels replace the source data of the channel 
with the result of the expression evaluation in sequence, negative offsets are equivalent 
to returning the final result of the expression that was evaluated a certain number of 
steps in the past. The channel where the expression results are stored can be thought of 
as a storage record of the previous evaluation steps. Negative sample offsets, therefore, 
can be used to compute any formula that can be expressed in closed recursive form. For 
example, the recursive definition of the Fibonacci sequence is: 



Part B — Acquisition Functions: The MP150 menu 135 

AcqKnowledge Software Guide 

Fn = Fn-1 + Fn-2 

To evaluate this as an expression transformation, use the expression: 

SC(-1)+SC(-2) 

Note that to actually get the Fibonacci sequence, the selected channel would need to 
have a constant value of one prior to the transformation. 

Expression Measurements are powerful tools for quick manual analysis and also for advanced 
Measurement  automated analysis when combined with the Cycle/Peak detector. Expression 

measurements extend measurements to evaluate simple formulas or complex data 
reduction. Each Expression measurement has an expression associated with it and the 
measurement result is derived from computing the Expression(s) on the selected data. 

 

Measurement expression dialog is 
generated the first time a measurement 
is set to Expression or when the 
measurement “info” button is clicked. 

OK invokes a syntax check. If there is 
an error, the user will be prompted to 
correct the error and the error will be 
selected (highlighted) in the Expression 
edit field. 

Cancel discards any changes to the 
Expression measurement and reverts 
back to the previous Expression. 

Clear erases the current contents of the 
expression edit field. 

 

 

 Measurement Channel 

Expression measurements can reference the “measurement channel” (MC), which 
refers to either the selected channel or a specific channel as set in the measurement 
channel selection box within the graph window. 

Negative sample offsets to MC are interpreted as returning the result of the Expression 
from a prior step. Transformations and calculation channels achieve this as they replace 
the contents of their destination channels sequentially. Measurements, however, do not 
actually replace the data of their source channels. Expression measurements are 
actually executed on a temporary copy of the channel data in memory. This implies that 
negative indicies to the measurement channel are interpreted exactly the same for 
measurements as for transformations and calculation channels even though the 
“transformed” data of the measurement is not visible. Negative sample offsets to MC 
that refer to the sample position prior to the leftmost sample of the selected area will 
always return zero. 

 

Evaluation Rules 

When a new selection is made, the first step in evaluation searches through the 
Expression measurement for any MMT() invocations. Any measurement whose value 
is needed by MMT() is computed at this time prior to the Expression evaluation. This 
behavior is similar to calculation channels and successfully allows measurements to the 
right and bottom of the Expression measurement to be used in the expression. 

The expression is subsequently evaluated from the leftmost sample in the selection to 
the rightmost sample. It is evaluated at the waveform sampling rate of its source 
channel, with one expression evaluation per sample contained within the selected area. 
Interpolation is not used at the boundaries to maintain a consistent sample interval for 
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the expression. After each expression evaluation, the result is cached in memory for 
potential negative MC result references. 

The value of the final expression, the rightmost sample, becomes the result of the 
measurement. 

 

Circularity Detection 

Expression measurements may reference other expression measurements or calculation 
measurements by using the MMT() function in the expression. This raises the 
possibility of circular dependencies being formed by the user if a measurement 
expression either directly or indirectly needs its own value to compute a MMT() 
invocation. Circular dependency checking will be in place at execution time and will 
result in an error. 

To refer an Expression measurement to its own value, use the MC notation. 

Error Reporting 

The Expression measurement result will display the text “Error” if there are syntax 
errors in the Expression measurement, errors computing measurements referenced by 
MMT(), or a circularity. 

Validation Tip To function correctly, AcqKnowledge requires real-valued data. You are encouraged to 
ensure that your expression results are real-valued. To test if a floating point number x 
is a real-valued number, use the expression: 
 
 NOT(OR(ISINF(x), ISNAN(x))) 

Note for variable sample rate processing:  
The Equation Generator (Expression) and Waveform Math functions will constrain operations between waves 
of different rates as follows: 

If an equation is operating on two or more waves of different sample rates, the result of the operation will 
always be output at the lowest sampling rate from the waves (F low). If the destination channel for the result 
has an assigned rate other than (F low), the operation will not be permitted. If the destination channel is set to 
a new channel, the operation will always be permitted. 

In AcqKnowledge 4 and higher, all sources for Expressions and Waveform Math operations must be sampled 
at the same waveform sampling rate. 

VSR data padding—If the channels are of unequal length (as a result of variable sampling rate or waveform 
editing), they will be padded for Append acquisition. Digital and Analog channels are stored as short integers 
by default; a waveform paste into a digital or analog channel, however, will result in its underlying data being 
converted to floating point. This will generate the “Abort/Replace” warning for pastes to Digital or Analog 
channels since the data format has changed since the last acquisition. 

Additionally, if an Analog or Digital channel is used as the source waveform for a Copy, it will also be 
converted to floating point and will result in the “Abort/Replace” warning being generated. 

Since Calculation channels are already floating point, pasting into them or copying from them will not change 
their data format. The channels will be padded with their last value and the append will commence. 

Waveform Cut operations do not change the underlying data format for Analog, Calculation, or Digital 
channels. If only Waveform Cut is used, no data format conversion will occur and channels will be padded 
with their last value and subsequent appends are allowed. 
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Source Description 

ACQLENGTH 

 

Calculation only Acquisition length from 
Set Up Acquisition; keeps Appended 
segments the same whereas “Sample” 
would increase with each segment. 

CH Value of the designated channel (CHn) at 
the current evaluation step. 

Primary Source 
Channel 
metachannels only 

Appears as PSC in the dialog. Refers to 
the data of the primary source channel of 
a metachannel.  

Time Time (in sec) of current evaluation step 

Sample  Sample index of evaluation step; the first 
sample in the graph will always be 
reported as a value of zero. 

MC Measurements only Value of the channel in 
the measurement menu—either the 
explicit channel or “SC”—at the current 
evaluation step. 

Pi  Value of pi (3.141592654…) to double-
precision accuracy. 

SC  

 

Transformation and measurement only Value 
of the selected channel at the current 
evaluation step; can still back-reference 
samples points. 

True  Evaluates to the value 1 (non-zero values 
are interpreted as True) 

False  Evaluates to the value 0 

Segment Timer Used as a source for the onscreen 
Stopwatch gauge view. 

Random Generates random white noise. 

Gaussian 
Random* 

Generates Gaussian white noise for 
startle responses. Returns a random 
value from a Gaussian distribution. 

*Standard Gaussian model; useful for peak fitting.  

param(0)*EXP(-((TIME-param(1))/param(2))^2 

Operator Operation 

+ Addition 

- Subtraction 

* Multiplication 

/ Division 

^ Power 

( Open parentheses 

) Close parentheses  
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FUNCTION  RESULT 

ABS Returns the absolute value of each data point. 

ACOS Computes the arc cosine of each data point in radians. 

AND(x, y, …)  Computes a logical “and” operation for its arguments. Accepts up to eight (8) 
arguments and evaluates to 

1 if all of its arguments are non-zero values. 
 0 if one of its arguments is zero. 

ASIN Calculates the arc sine of each value in radians. 

ATAN Computes the arc tangent of each sample point. 

CEIL(x) Computes the ceiling function (the closest integer larger than the value x). 

COND(T, A, B, C)  Three-way conditional takes four arguments: 
COND(test_expr, neg_test_value, zero_test_value, pos_test_value) 

Evaluates test_expr and if 
< 0, returns neg_test_value 
= 0, returns zero_test_value 

  >  0, returns pos_test_value 

COS Returns the cosine of each data point. 

COSH Computes the hyperbolic cosine of each selected value 

EQUAL(x, y, …)  Performs a Logical equal (numerical comparison) of its arguments. Accepts up to 
eight (8) arguments and evaluates to 

1 if all of its arguments are equal. 
 0 if one of its arguments is not equal to the others. 

EXP Takes the ex power of each data point.. 

FLOOR(x) 
 

Computes the floor function (the closest integer less than the value x). 

IF(T, A, B)  
 

Two-way conditional takes three arguments: 
IF(test_expr, true_value_expr, false_value_expr) 
The conditional evaluates test_expr and if 

non-zero, returns true_value_expr 
0, returns false_value_expr 

ISINF(x)  Filters out infinities and unrepresentable numbers from data; important because 
such values can cause erratic behavior in autoscaling and other operations. Use to 
test whether any expressions have resulted in floating point overflow and have 
generated numbers too large to be represented in the computer. Evaluates to 

1 if x is inf, the floating point representation of infinity. 
0 if x is NaN or a real-valued floating point number. 

ISNAN(x)  
 

“Is not a number” can be used to test whether any expressions have resulted in 
floating point errors such as division by zero. Use to ensure that the output of 
transformations and equations does not produce numbers that AcqKnowledge 
cannot display. Evalutes to 

1 if x is NaN, the invalid floating point number. 
 0 if x is inf or a real-valued floating point number. 

LESS(x, y)  
 

Performs a numerical comparison of its arguments and evaluates to 
1 if x is less than y. 
0 if x is greater than or equal to y. 
 

LOG Computes the natural logarithm of each value 

LOG10 Returns the base 10 logarithm of each value 
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FUNCTION  RESULT 

MMT(row,col)  Transformation and measurement only Evaluates to the result of a measurement 
being displayed in the graph, as specified by row and column. Use to scale by a 
result without having to manually enter the result. Row and Column for a 
measurement start as 0,0 for the top left measurement box; the fourth argument on 
the first row is accessed by MMT(0,3). For this function, the required measurement 
box must be displayed in the graph. Since the values of measurements may change 
during the course of an acquisition, calculation channel expressions cannot use this 
function. 
If a Model Expression (page 1298) uses MMT() syntax to reference a measurement 
and that referenced measurement is linearly interpolated, the results of the NLM 
measurement will also be displayed as being linearly interpolated. 

MOD(x,y) Computes the floating point modulus; returns integer portion of modulus. 
Example: MOD(5,2) evaluates to “1” 

NOT(x) Computes a logical negation of its argument. Evaluates to 
1 if x is zero. 
0 if x is non-zero. 

OR(x, y, …)  
 

Evaluates multiple variables; true if any are true. Computes a logical “or” operation 
for its arguments. Accepts up to eight (8) arguments and evaluates to 

1 if any one of its arguments is non-zero. 
 0 if all of its arguments are zero. 

ROUND(x) Returns an integer closest in value to the argument. For example: 
  round (2.4) = 2    round(2.5) = 3    round(-1.5) = -1    round(-1.6) = -2     

SIN Calculates the sine (in radians) of each data point. 

SINH Computes the hyperbolic sine for each sample point. 

SQR Squares each data point. 

SQRT Takes the square root of each data point. 

TAN Computes the tangent of each sample point. 

TANH Calculates the hyperbolic tangent of each sample point. 

TRUNC(x) Removes the fractional part of the number and returns an integer. For example: 
  TRUNC(2.4)= 2    TRUNC(2.5)= 2    TRUNC(-1.5)= -1    TRUNC(-1.6)= -1 

Note When used with scientific notation, TRUNC(x) applies only to the fractional 
portion after the exponential factor is taken into account: TRUNC(2.93E+4) = 
TRUNC(29300) = “29300”. Since 2.93e+4 (29,300) has no fractional portion, 
the number is returned unchanged. Similarly, TRUNC(2.931245E+4) = 
TRUNC(29312.45) = “29312”. 

XOR(x, y, …)  Logical exclusive OR; true if an odd number is true. Computes a logical “exclusive 
or” for its arguments (e.g. “one or the other, but not both”). Accepts up to eight (8) 
arguments and evaluates to 

1 if an odd number of its arguments are non-zero. 
0 if an even number of its arguments are non-zero or 

if none of its arguments are non-zero. 

 



140 AcqKnowledge Software Guide 

Visit the online support center at www.biopac.com 

Delay Calculation 

  

 
Delay setup dialog and resulting graph showing 20 sample delay 

This option allows you to use a Calculation channel to plot another channel lagged (delayed) by an arbitrary 
interval. To have AcqKnowledge apply a Delay Calculation in real time: 

1. Choose MP150 > Set Up Channels. 

2. Click the Calculation tab. 

3. Check an Acquire box for the Calculation channel you want to contain the filtered data. You may also 
check the Plot and Values boxes as appropriate for each channel. 

4. Click the Preset pull-down menu and select Delay. 

5. Click the Setup button in the Input Channels dialog to generate the Delay dialog. 

 

The delay interval can be specified either in terms of samples or seconds. These types of plots are useful for 
producing non-linear (“chaos”) plots in AcqKnowledge’s X/Y display mode (see page 39 for a description). 

When a delay channel is recorded, there is a segment at the beginning of the Calculation channel (equal to the 
value of the delay) that will read as 0 Volts. This is normal and occurs because the delay channel is waiting to 
“catch up” with the original signal. AcqKnowledge fills this buffer with zeros until the delay channel begins 
to plot actual data. In the example below, the delay channel contains a 0.25-second interval of zeros at the 
beginning of data file.
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Control Calculation 

 
The Control function is used to output a digital pulse when the value for a specified input channel exceeds a 
certain level, falls inside a given range, or falls outside a given range. This feature is unique in that the output 
is on a digital channel (which ranges from I/O 0 through I/O 15) rather than a Calculation channel. Also, 
unlike other Calculation channels, this Control Calculation can only be performed in real time (i.e., while data 
is being acquired) and cannot be performed in post acquisition mode. 

In addition to outputting a signal on a digital channel, the Control Calculation will also plot an analog version 
of the digital signal on the Calculation channel you specify. For instance, in the example below, Calculation 
channel C0 is used to perform a control function using analog channel 1 (A1) as an input and digital channel 0 
(D0) as an output. In addition to outputting a pulse on D0, the setup below will also produce a plot on channel 
40 (the first Calculation channel) that emulates the signal being output on digital channel 0. Since 
Calculations are analog channels, the Calculation channel does not contain a “true” digital signal, but is a 
reasonably good approximation. To retain the physical output generated by a Control channel, the output 
digital channel should be looped back to another digital input channel of the MP150 unit and acquired as well 
as being connected to any external devices. The calculation channel values are not guaranteed to precisely 
match the actual digital output. 

 

To have AcqKnowledge apply a Control Calculation in real time: 

1. Choose MP150 > Set Up Channels. 

2. Click the Calculation tab. 

3. Check an Acquire box for the Calculation channel you want to contain the filtered data. You may also 
check the Plot and Values boxes as appropriate for each channel. 

4. Click the Preset pull-down menu and select Control. 

5. Click the Setup button in the Input Channels dialog to generate the Control dialog. 

 

There are four parameters that need to be specified for each Control channel: 

a) Source channel c) Type of threshold function 

b) Output channel d) Threshold level values  

“Source” refers to the input channel to be used for the Control function. As with other Calculation channels, 
the Control function can use either an analog channel or another (lower) Calculation channel as an input. In 
the previous example, analog channel 1 (A1) is used as the input channel. It is not possible to use a digital 
channel as an input channel for a Control Calculation. 
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The channel selected in the Output Channel section determines which digital channel the pulse will be sent to. 
The digital channels range from 0 to 15 (D0 through D15) and external devices can be connected as described 
in the section on UIM100C connections in the MP System Hardware Guide. In the sample dialog shown, the 
digital pulse is sent over I/O line D0. 

Digital channels have two levels, 0 Volts and +5 Volts. When the signal transits from 0 Volts to 5 Volts, an 
“edge” is created and since the signal is going from low to high, this is referred to as a positive edge. 
Similarly, as the signal transits back from 5 Volts to 0, a negative edge is created. These transitions or edges 
can be used to trigger external devices when an analog signal level meets certain threshold criteria. 

The Threshold Function option sets the criteria for the Control channel. You can specify threshold conditions 
such that the digital I/O line goes to +5 Volts when the conditions are met, or you can program the digital line 
to go to 0 Volts when the threshold conditions are met. Threshold conditions can be set so that either (a) the 
digital line is switched when the value of an analog channel exceeds a specified value or (b) the digital line is 
switched when an analog channel falls within a given range. AcqKnowledge also allows you to create a single 
level threshold or a “wide” threshold. 

Tip  To use test conditions more complicated than simple thresholding, combine the conditional tests of 
Expression calculations with the Control channel to change digital output based on the Expression 
result. 

For example, suppose you want to set a Control channel to switch digital line 5 from low to high whenever 
the signal for Calculation channel one (C0) exceeds 85 BPM. Set the source channel to C0 and the output to 
D5. Select the upper left graph in the control dialog and set L2 and L1 to 85, as shown: 

  
Control dialog and graph showing result of BPM control example 

As you can tell from the preceding graph, there are a number of instances where C0 (heart rate) exceeds 85, 
usually for a short period of time. When it does drop below 85, it appears to return to a value greater than 85 
within a second or two. In instances such as this, it might be useful to “widen” the threshold so that the digital 
line is triggered whenever the input value is greater than 85, but the signal must drop significantly below the 
threshold value before the threshold is reset. 
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As another example, the upper threshold value (L2) is set to 85 and the lower threshold (L1) is set to 83, 
which means that the threshold will not reset until the signal from the source channel drops below 83. In the 
following example, the digital line is switched from low to high (from zero to +5 Volts) when the heart rate 
channel exceeds 85, and stays at +5 Volts for several seconds even though the source channel drops below 85 
(but above 83). The digital line does not switch back to zero until the heart rate channel drops below 83 
(toward the end of the record). Once this occurs, the threshold is reset and the digital line will switch again the 
next time the source channel exceeds 85 BPM. 

  
Control dialog and graph showing control channel with “wide” threshold 

It is also possible to have the digital line switch when the source channel drops below a certain value. In the 
example below, a simple threshold is used to switch the digital line high each time the source channel drops 
below 50 BPM. Since L2 and L1 are set to the same value, this is not a “wide” threshold (as above) and the 
threshold resets each time the source channel goes above 50 BPM. 

  
Control dialog and graph showing control channel detecting source channel levels less than 50 BPM 

These examples are only a few of the possible applications of the control channel using the two threshold 
icons on the left-hand side of the Control Setup dialog. You can construct variations of these (i.e., switching 
the digital line from low to high using a wide threshold whenever the source channel drops below a given 
channel) that are not discussed above. Moreover, each of the options can be construed somewhat differently 
than they have been presented here. For example, the previous example switches the digital line from low to 
high each time the signal on the source channel drops below 50 BPM. Conversely, it also switches from high 
to low each time the source channel value is greater than 50 BPM. This allows you to vary the default setting 
for the digital channels (whether the default is zero or +5 Volts) depending on what types of devices are 
connected. 

(For a description of how to connect various digital devices, see the section on UIM100C connections in the 
MP System) Hardware Guide.) 
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In addition to setting “above and below” type thresholds, you can program the Control channel such that the 
digital line is switched whenever the source channel falls within a given range or outside a specified range. In 
the example that follows, digital line 15 is set to switch from zero to +5 Volts whenever the source channel 
signal falls between the values entered in the L1 and L2 boxes. In this case, I/O is switched to +5 Volts 
whenever the heart rate is greater than 60 BPM but less than 80 BPM.  

  
Control dialog and graph showing control channel switching from 
low to high when source channel is between 60 BPM and 80 BPM 

You can also program the digital line to switch from high to low when the signal on the source channel falls 
within a given range. This is equivalent to setting the digital line to shift from low to high when the source 
channel values fall outside a given range (as shown below). 

  
Control dialog and graph showing control channel switching from 
high to low when source channel is between 60 BPM and 80 BPM 
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Fourier Linear Combiners: FLC, WFLC, CWFLC Calculations 

Fourier Linear Combiners are linear combinations of adaptable sinusoidal functions that are particularly well 
suited to processing cyclic data. Sine and cosine are harmonics that are multiples of a base frequency that are 
summed together, and the order is the fixed number of harmonics used in the model. Step size provides mu, 
the gain factor used to adjust the weights of the harmonics at each processing step. Step sizes must be much 
less than 1 for the system to converge. As step sizes decrease, relaxation time lengthens. The FLC model is 
adjusted based on the source data using least means square (LMS) feedback and the bias compensates for DC 
offset.  

To have AcqKnowledge apply an FLC Calculation in real time: 

1. Choose MP150 > Set Up Channels. 

2. Click the Calculation tab. 

3. Check an Acquire box for the Calculation channel you want to contain the filtered data. You may also 
check the Plot and Values boxes as appropriate for each channel. 

4. Click the Preset pull-down menu and select FLC, WFLC, or CWFLC. 

5. Click the Setup button in the Input Channels dialog to generate the appropriate dialog. 

 See FLC Transform options, including Scaled FLC, on page 1275. 

 

 

Basic FLC  

Simple summation of fixed 
numbers of sines and cosines; 
uses harmonics of a fixed 
frequency and adjusts weighting 
coeffiicients of the mixture. 

Weighted-Frequency FLC 

Base frequency of the harmonics 
is variable; adapts the frequency 
in response to the input signal 
using LMS feedback; the 
frequencies are similarly adjusted 
to the amplitudes. 

Coupled WFLC/FLC 

Runs a WFLC on the signal to 
determine the harmonic frequency 
and then runs the result through an 
FLC using the computed harmonic. 

Operates on a single channel at a 
time. 

Operates on a single channel at a 
time. 

The second FLC can be run on the 
same or a different channel. 

Well suited for extracting data of 
a known frequency band from a 
signal with a stable frequency. 

 Use as an adaptive noise filter 
to remove non-periodic and 
semi-periodic noise 
uncorrelated to the base 
harmonic frequency. 

Well suited for modeling periodic 
signals of an unknown and 
potentially varying frequency 
and/or amplitude. 

 No cycle boundaries or 
frequencies need to be pre-
determined. 

Well suited for real-time extraction of 
information from one signal based 
upon the frequencies contained in 
another signal. 

 Use to remove movement noise 
from ECG. 

 Unique configurations can be 
established with two input signals, 
one for frequency and one for 
amplitude. 
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Adaptive Filtering Calculation 

 
 See the Adaptive Filtering transform on 

page 272. 

Adaptive filtering is a signal processing technique that 
processes two different signals in relation to one another 
and can be used for noise estimation, noise reduction, 
general-purpose filtering, and signal separation. Adaptive 
filtering creates efficient high-quality filters with a 
minimal number of terms, which can be very useful in 
blocking mains interferences or other known periodic 
disturbances. 

 Useful for noise filtering where it is possible to 
acquire a signal that is correlated to the noise (similar 
to the way noise-cancelling headphones detect and 
remove outside noise). Applications include removing 
EMG from ECG or EOG from EEG. 

To have AcqKnowledge apply an Adaptive Filtering Calculation in real time: 

1. Choose MP150 > Set Up Channels. 

2. Click the Calculation tab. 

3. Check an Acquire box for the Calculation channel you want to contain the filtered data. You may also 
check the Plot and Values boxes as appropriate for each channel. 

4. Click the Preset pull-down menu and select Adaptive Filtering. 

5. Click the Setup button in the Input Channels dialog to generate the Adaptive Filtering dialog. 

The weights within an adaptive filter are modified on a step-by-step basis. AcqKnowledge uses the N-tap FIR 
adaptive filter, with coefficients updated using least means squares (gradient) feedback. 

Order Specify a positive integer for the number of terms to be used in the internal FIR filter. 

Step size Provides mu, the rate of adaptation of the coefficients within the FIR filter. 

Source channel The source channel will be replaced by the adaptive filter results. 

Noise channel The noise channel is the signal that is correlated with the noise to be eliminated from 
the Source; it is not modified by adaptive filtering. 

Source and Noise channels must have the same channel sampling rate (under Channel Set Up). 

 

 

Comb Band Stop Filter Calculation 

To have AcqKnowledge apply a Control Calculation in real time: 

1. Choose MP150 > Set Up Channels. 

2. Click the Calculation tab. 

3. Check an Acquire box for the Calculation channel you want to contain the filtered data. You may also 
check the Plot and Values boxes as appropriate for each channel. 

4. Click the Preset pull-down menu and select Comb Band Stop. 

5. Click the Setup button in the Input Channels dialog to generate the Comb Band Stop dialog. 

See page 1131 for details. 

 

Metachannel  

See Metchannel details on page 1116. 
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Rescale Calculation 

 

Rescale applies two-point linear mapping and allows users to change the measurement units (for example, to 
change temperature from Celcius to Farenheit). The text corresponding to the new units can be manually 
entered. 
To have AcqKnowledge apply a Rescale Calculation in real time: 

1. Choose MP150 > Set Up Channels. 

2. Click the Calculation tab. 

3. Check an Acquire box for the Calculation channel you want to contain the filtered data. You may also 
check the Plot and Values boxes as appropriate for each channel. 

4. Click the Preset pull-down menu and select Rescale. 

5. Click the Setup button in the Input Channels dialog to generate the Rescale dialog. 

 

 Use the Rescale transformation (after acquisition) to adjust forgotten calibration of analog channels or 
reverse incorrect calibrations.  

 A "Rescale" Automator action has been added to allow rescaling to be performed in workflows. 

The rescale formula is: 

 
 
Rescale Source Displays the label and number of the selected channel.  
Old Units Displays the values of the current vertical units of the channel 
New Units Allows for manual entry of the new units to be used. The new units will be displayed in 

the vertical units of the channel 
Note  When rescaling only a selected area of the waveform, the manual entry of new 

units is not available unless “Transform entire wave” is checked since it is not 
possible to display different units for different time ranges in the same channel. 
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Chapter 7   Set Up Acquisition 

 
Set Up Acquisition—The Basics 

Once you have selected the channels to be acquired, the next step is to Set Up Acquisition. These options 
control the data collection rate, where data will be stored during an acquisition, and the duration of each 
acquisition. Choose MP150 > Set Up Acquisition to generate the dialog to set these options. 

Storage Mode 

At the top of the dialog are three popup menus that allow you to control a number of aspects for storing the 
data from each acquisition. 

Record/Record last allows you to control whether the software saves all the data or only the most recent 
segment of the data. 

 Record—the MP System (MP150 or MP36R) will store data for the amount of time that is specified in 
the acquisition length box. This is the default and is appropriate for almost all types of acquisitions.  

 Record last—only available when acquisitions are set to 'Save Once' or 'Memory'—the MP System 
(MP150 or MP36R) will acquire data continuously, but will only store the most recent segment of data 
equivalent to the duration in the acquisition length dialog. That is, if the value in the acquisition length 
box is 30 seconds and record last is selected, the MP System (MP150 or MP36R) will acquire data ad 
infinitum, but will only store the most recent 30 seconds of the data.  

Save once/Autosave file/Append allows you to vary how the data is saved to a file. By default, 
AcqKnowledge will save the data to a single continuous file. 

 Save once—AcqKnowledge will begin an acquisition when the mouse is clicked on the start button, and 
will stop either when the acquisition length has been reached or when the stop button is clicked with the 
mouse. 

 Autosave file —allows you to perform several acquisitions one after another, and save the data from 
each acquisition in a separate file. When the Autosave option is selected, a File button will appear to the 
left of the sample rate dialog. Click File to generate a standard Save dialog to enter the root file name 
for the data from each acquisition. After you click Save in this dialog, another dialog is generated with 
options to append an incrementing number, time (system clock), or date (system clock) to the filename: 
Media functionality does not support the Autosave file acquisition mode. 

 
 Append —similar to ‘Save Once’, except that Append allows you stop and restart acquisitions at 

arbitrary intervals. Append mode is unique in that clicking on the Stop button only pauses the 
acquisition, which can then be restarted by clicking on the Start button. 
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In Append mode, each time an 
acquisition is restarted, a marker is 
inserted into the record showing the 
time (hh:mm:ss) at which the MP 
System (MP150 or MP36R) started 
acquiring data. Although you can 
pause for any period of time, the MP 
System (MP150 or MP36R) will only 
acquire data for the amount of time 
indicated in the Acquisition Length 
box. Data can be acquired in Append 
mode while being saved to memory, 
disk, or the MP data acquisition unit 
(but not in Averaging mode). 

  
Sample data Acquired in “Append” mode. 

Markers indicate where Acquisition was paused. 

Appended segments can be stored to disk, memory, or MP150. 

 Append to Disk: In this mode, it is usually best to record all channels at the same rate. If the user 
stops the acquisition, the length will be the same for all channels—so the next segment of appended 
data will neatly link onto the end of the existing record. If channels are sampled at different rates, 
append to disk operation will cause the software to rewrite all data files in the graph and add 
“extra” data to the “uneven” waves. This extra data will be a continuation of the same data point at 
the end of each uneven wave. This operation may take some time to complete for very long data 
files.  

 You can append to existing files—just open them, change the storage mode to “Append to 
Disk” and Start the acquisition. 

 Append to disk requires AcqKnowledge 4 format files. If you open any other file format, you 
will be prompted to translate the file. 

 Append to Memory: In this mode, data is appended to the “uneven” waves in the same manner as 
described for Append to Disk. When channels are sampled at different rates, this mode will respond 
faster than Append to Disk because the data files are already in memory so the software does not 
have to rewrite all the data files in the graph.  

 A Reset button is generated in the Set Up Acquisition dialog when Append is selected. Click 
the Reset button to erase the acquired data file and start a fresh acquisition file (this is 
essentially the same as saying yes to an “Overwrite existing data?” prompt). 

 
 

  The Rewind button on the toolbar will delete the last recorded segment. Ctrl-Rewind (Windows) 
or Option-Rewind (Mac OS X) will delete all recorded segments (similar to the Reset button). 

Append plus external trigger 

An acquisition that takes place over a long period of time with brief events which are few and far between 
can be Set Up in the following manner: the researcher watches for these event, triggers the acquisition to 
start, and then lets the pre-defined acquisition length run out. When another event of interest occurs, the 
researcher triggers the next acquisition. This acquisition will be “appended” onto the end of the first 
acquisition. Memory is the only limit as to how many “appendages” can be added. 

Append plus Variable Sampling Rates 

If the mode is started and stopped manually, it is statistically possible that, prior to the next pass of the 
Append, extra data points may be inserted in various data channels to “line up” the data (see sample on 
page 1107). These extra data points simply replicate the last sample in any affected channel. To minimize the 
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impact of the extra data points, make sure the lowest sampling rate is on the order of 10 Hz or higher, or 
don’t use VSR. 

Disk/Memory/MP/Averaging determines where to store data during an acquisition. Once data has been 
acquired and is stored in a file, it is stored on a hard disk or other similar device. There are a number of 
options for storing data during an acquisition. The best choice as to where data should be stored during an 
acquisition depends in large part on the nature of the acquisition itself, and the type of computer being used. 

 Memory stores data in computer memory (RAM) during an acquisition. After the acquisition is finished 
you will have to select Save As... from the File menu to permanently save this to your computer’s hard 
disk. This usually allows for faster acquisition rates, although most computers have less available RAM 
than disk space. 

 Disk saves data directly to the computer’s hard disk during an acquisition. Disk mode is fast enough (in 
terms of maximum sampling rate) for many applications, especially when only a few channels are being 
acquired. Saving data to Disk also allows for longer acquisitions, since most computers have more hard 
disk space free than free RAM. A final advantage of saving data directly to Disk is that if there is a 
system failure (including power outage), all the data collected up to that point is saved on disk and can be 
recovered, whereas the data is deleted if it is being saved to computer memory.  

IMPORTANT—When saving files to Disk, always be sure to save your files under a different name 
BEFORE you start each acquisition. Otherwise, any previous data in that file will be overwritten.  
In Memory mode, simply save the file after the acquisition. 

 MP stores a small amount of data on the MP data acquisition unit itself. The MP150 is limited only by 
internal memory, with storage estimated at 4 MB and 400 kHz aggregate sampling rate. 

Obviously, data cannot be sampled this fast for a very long period of time if it is to be stored in the MP 
data acquisition unit. Also, as more and more channels are acquired, the duration of acquisition to the MP 
data acquisition unit will shorten. Another drawback of storing data to the MP data acquisition unit is that 
the data is not plotted on the screen as it is being acquired, but will automatically be plotted on the screen 
as soon as the acquisition is terminated. 

 Averaging is used exclusively for acquisitions involving repeated trials; see page 154. 

Acquisition Sample Rate 

The value in the box labeled “Sample rate” indicates how many samples the MP System (MP150 or MP36R) 
should take per channel during each second of data acquisition. The sample rate can be changed by clicking 
on the pull-down menu. To allow for variable sample rates, the rate options are constrained so that channel 
sample rates are equal to or a specific power of 2 less than the acquisition rate. Sample rates can be chosen at 
the selected increments only; custom rates are not accepted. 

Depending on the nature of the data being acquired, the “best” choice in terms of sampling rate will vary. 
Technically speaking, the minimum sampling rate should be at least twice the highest frequency component 
of interest. This means that if the phenomenon you are interested in observing has frequency components 
(which are of interest) of 100 Hz, you should sample at least 200 times per second. Fourier analysis (FFT) can 
be used to determine what frequency components are present in the data (see page 301 for a more detailed 
description of the FFT function). 

TIP: A good rule of thumb is to set the sampling rate to at least three to four times the highest 
frequency component of interest. 

In less technical terms, lower sampling rates can be used for data with slowly changing values (e.g. 
respiration, EDA, GSR), whereas higher sampling rates should be set for data where values change markedly 
in magnitude or direction (e.g. ECG, EEG, evoked response). 

The maximum allowable sampling rate will automatically adjust itself according to the storage mode, how 
many channels are being acquired in the channel setup window and the type of computer being used. You can 
try this by entering a large value (say 99, 999) in the sample rate box. Now click the mouse button or press 
return and AcqKnowledge will automatically return the maximum allowable sample rate given the computer’s 
throughput and the acquisition parameters. 
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If data is being stored to disk or computer memory (RAM) during an acquisition, To set a sample rate that is 
too high. The acquisition will begin normally, but AcqKnowledge will stop the acquisition and display a 
message indicating that the acquisition buffer has overflowed. The data up to this point has been saved, and 
the sample rate must be set to a smaller value if you wish to complete an entire acquisition. 

The sample ECG waveforms below illustrate the effect of different sampling rates on obtaining varying levels 
of fidelity when reproducing the data. 

 Top waveform: data is sampled relatively slowly; difficult to make out the shape of the waveform. 

 Middle waveform: sampled at the faster rate; more samples are taken in the same period of time, which 
results in higher resolution for some components of the waveform. 

 Bottom waveform: sampled at a relatively high rate; increased resolution of the waveform. Waveform 
components that were obscured at slow sampling rates are now well defined, and measurements taken on 
this waveform would be able to better establish the maximum amplitude, time between different ECG 
complexes, etc. 

 

 

Representation of ECG waveform sampled 
with relatively few samples per second 
“True” ECG wave is superimposed over dots 
that indicate sample points. 

 

 Preceding waveform as it would look if 
plotted in AcqKnowledge (with data points 
superimposed). 

 

 

 

 

Representation of same ECG waveform 
sampled at a relatively higher sampling rate. 

 

As shown, under-sampling completely misses the QRS complex of this waveform, although it might detect 
components of the QRS in subsequent beats. Although this is an extreme example of how under-sampling can 
affect digitally processed data, it is important to note that the rate at which data is sampled has important 
implications for the interpretation and analysis of data. 

The disadvantage of acquiring data at high sampling rates is that each sample point takes up memory, whether 
it is RAM , disk space or memory. Moreover, once the file is saved, it will require more disk space than a file 
of similar duration sampled at a slower rate. 
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Note for variable sample rate processing: 

The Equation Generator (Expression)  and Waveform Math functions will constrain operations between waves 
of different rates as follows: 

If an equation is operating on two or more waves of different sample rates, the result of the operation will 
always be output at the lowest sampling rate from the waves (F low). If the destination channel for the result 
has an assigned rate other than (F low), the operation will not be permitted. If the destination channel is set to 
a new channel, the operation will always be permitted. 

VSR data padding—If the channels are of unequal length (as a result of variable sampling rate or waveform 
editing), they will be padded for Append acquisition. Digital and Analog channels are stored as short integers 
by default; a waveform paste into a digital or analog channel, however, will result in its underlying data being 
converted to floating point. This will generate the “Abort/Replace” warning for pastes to Digital or Analog 
channels since the data format has changed since the last acquisition.  

Additionally, if an Analog or Digital channel is used as the source waveform for a Copy, it will also be 
converted to floating point and will result in the “Abort/Replace” warning being generated. 

Since Calculation channels are already floating point, pasting into them or copying from them will not change 
their data format. The channels will be padded with their last value and the append will commence. 

Waveform Cut operations do not change the underlying data format for Analog, Calculation, or Digital 
channels. If only Waveform Cut is used, no data format conversion will occur and channels will be padded 
with their last value and subsequent appends are allowed. 

 

Acquisition length 

To set the duration of an acquisition, enter a number in the acquisition length box. By default, 30 seconds of 
data will be recorded. The popup menu right of the length box allows you to scale the duration of the 
acquisition in terms of milliseconds, seconds, minutes, hours, or samples. Changing this option will not 
change the length of the acquisition, only the units used to describe it. Thus you can describe the same 
acquisition as lasting 30 seconds, or 0.5 minutes, or 30, 000 milliseconds. Scaling the duration of an 
acquisition in terms of samples is essentially the same as the time scaling options, except the length of the 
acquisition will be expressed in the total number of samples to be collected on one channel. 

Regardless of what scale you use to determine the length of acquisition, AcqKnowledge will end an 
acquisition when the value in the total length box is reached. You may also stop the acquisition at any time by 
clicking on the stop button in the lower right hand corner of the graph window. 

The MP150 will automatically limit the maximum recording length to the amount of available memory on the 
target storage device (memory, disk, or MP150). The default is to record one acquisition of the duration 
specified in the acquisition length box. The acquisition length parameter has a somewhat different 
interpretation in the Record Last and Averaging modes. See pages 11148 and 11154 (respectively) for more 
information on these features. 
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Multiple Hardware 

AcqKnowledge can be used with multiple MP150 data acquisition units to 

 control multiple, independent experiments on one computer 

 increase the total number of channels used for a single experiment (e.g., 32-channel EEG) 

To synchronize the Start of multiple units, use the External Trigger function. 

To combine up to 60 channels of data into one file, use the Merge Graphs feature (see page 261X). 

Each graph window can 
support a different MP150 unit. 
To add an MP150 unit for 
acquisition, open a New Graph 
(not a Data View). 

To show/hide the “Connected 
to:” information, toggle the 
Show/Hide Hardware icon in 
the Toolbar. 

 

 

To switch the MP150 unit 
associated with a graph 
window, click the “Connected 
to” box and select an available 
unit or Add new hardware. 

 

 

 

Click the Help… button to 
open a troubleshooting guide 
(PDF) with support tips to try if 
an MP150 is not 
communicating with the 
computer. 
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Averaging 

Overview 

In some instances, the signal of interest does not stand out against the background or ambient noise (the level 
of ambient noise exceeds the signal produced by the object of interest), and the only way to detect the signal 
of interest is to perform repeated trials as part of one acquisition, and average the trials together. Since the 
“noise” associated with the signal is assumed to be random, and the “signal” is assumed to be systematic, the 
noise should approach zero as the individual trials are averaged together.  

 
Signal (top) measured in the presence of noise 
(middle), which results in the bottom waveform 
when measured in standard Acquisition mode 

 
Same signal averaged in the presence of noise 

over 2,000 trials to produce the lower waveform. 

 

Any averaging acquisition consists of three general components: 

(a) the stimulus signal 

(b) the duration of the acquired data, and 

(c) a small amount of processing time (or overhead) that takes place between acquisitions. 

The duration of the stimulus signal and the duration of data to be acquired can be set by the user. The amount 
of overhead required is a function of the acquisition length, the sampling rate, and the number of channels 
being averaged. 

Acquisition length

Stimulus signal

Overhead

Latency
 

Stimulus signal usually some sort of pure tone or pulse; occurs at the beginning of each trial. 

Acquisition length refers to the amount of data to be acquired during each trial. 

Overhead refers to a period of time after data has been acquired that is needed to 
perform the mathematical averaging. 

Latency refers to the total time elapsed between the start of one trial and the start of 
the subsequent trial. 

Important usage notes 

 The maximum length of a single averaging pass is restricted to 2 seconds; if longer averaging 
passes are required, use regular data acquisition and use the Ensemble Average offline analysis option 
to generate averages in post-processing. 

 The preferred hardware setup for on-line averaging mode is direct connection to the MP150 via 
cross-over cable. To improve stability, avoid interruptions during acquisition: 

 Do not access top-level menus (File, Edit, Transform, etc.) or generate popup dialogs (Setup…). 
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 Avoid running other programs—helps ensure that required system resources (processor time, 
memory, and network throughput) remain available. 

 If the MP150 is connected over a network, avoid running applications that consume network traffic 
(Internet Explorer, mail client, media player)—these may interrupt/delay communication to the MP150.  

Averaging Setup 

For Advanced Averaging, see page 157 

To set up Averaging: 

1. Choose MP150 > Set Up Acquisition 
and select “using Averaging” option. 

2. Click the Setup button to generate 
the Averaging options dialog. 

3. Set the Averaging options as detailed 
below. 

4. Click OK to close out of the dialog. 

5. Set the Stimulus (see page 1170). 

6. Use the buttons in the graph window 
to Start, Stop, and save the averaging 
acquisition. 

Online averaging progress bar 

An online averaging progress bar is a toolbar 
that is added to graph windows in 
AcqKnowledge 4.1 when online averaging 
acquisitions are in progress. The toolbar 
displays the number of averaging passes that 
have been completed and the number of 
passes that have been rejected by the MP150 
firmware. This is similar to the text displayed 
in the status area of Windows AcqKnowledge 
3.9.1 and earlier. 

 

 
 

Averaging Options 

Averages  

Select the number of averages to perform from the pull-down menu, to a maximum of 10,000. 

Latency 

The individual components of stimulus signal, acquisition length, and overhead are, in sum, equal to the 
latency of the acquisition. As a rule, you should set the latency to at least three times the acquisition length. In 
some cases—such as when you want to allow a subject to return to a baseline state or condition—you may 
want to set the latency to a value much larger than this. By default, each trial is initiated when the latency 
value is reached (in the sample dialog shown, a new trial is initiated every 100 msec). 

If the latency is set to a value too short to allow for averaging to take place, an Acquisition Warning will be 
generated:  

 

 Adj Latency: automatically adjust the latency 
to the shortest possible value that still allows 
for data to be acquired and processed. 

 Adj Length: reduce the amount of data 
acquired without changing the latency. 

 Abort: return to the graph window without any 
data being collected. 
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Averaging Options continued 

 

External trigger 

To initiate a trial on a signal from an External Trigger, enable this option and select positive or negative edge. 
When this option is checked, a new trial will be acquired each time a trigger circuit is closed. For more 
information on triggers, see page 11166. 

 

Artifact rejection 

Occasionally during an acquisition, extreme levels of artifact will be present for one reason or another. 
Checking artifact rejection allows you to determine what signal levels constitute artifact, and have the MP 
System (MP150 or MP36R) reject these trials. When artifact rejection is enabled, the MP System (MP150 or 
MP36R) will ignore any trials that contain signals exceeding the artifact rejection thresholds, keep track of 
how many trials have been rejected, and add that number of trials to the total number of trials to be acquired. 
This allows you to “re-try” a trial that was rejected due to the presence of artifact. 

To set these parameters, you need to set a high threshold and a low threshold. Both thresholds refer to the 
scale limits (normally ±10 Volts). If the high and low artifact rejection thresholds are set to 80% and 30% 
(respectively), the MP System (MP150 or MP36R) will reject any trial where the signal exceeds +8 Volts or –
3 Volts. 

When the channel scaling feature is used to change the range of Map (Scale) values to something other than 
±10 Volts, the artifact rejection formula for symmetrical limits is: y = ((2·PV)/100)·x – PV 

where y = voltage threshold 
 PV = Peak Value 
 x = percent threshold (whole number) 

If non-symmetrical limits are used, the following equation is used: y = ((V1-V2)/100)·x + V2 
where y = voltage threshold 
 V1 = Higher Peak Value 
 V2 = Lower Peak Value 
 x = percent threshold (whole number) 

Enable Channels 

To add analog channels to the average, check 
additional channels in the Enable list. 

 Channels must be set to “Acquire” under 
MP150 > Set Up Channels to be selectable 
here; otherwise the channel box will be 
grayed out. 

  
 

 
Stimulus Signal 

Although AcqKnowledge does not require a stimulus signal to be output for Averaging trials, most 
applications that use signal averaging make use of a stimulus signal. Digital stimuli (i.e., clicks) or analog 
stimuli (i.e., tones, pulses, and arbitrary waveforms) may be output.  

In almost all cases, the most convenient way to output a stimulus signal is to output a predefined wave on 
analog output channel A0 and/or A1. You can create pulse waveforms, tone waveforms, ramp waveforms, 
and arbitrarily shaped analog waveforms. Use MP150 menu > Stimulator Setup to set all of the stimulus 
output functions (see page 1170). 

When you start Averaging, the Start button turns to Averaging status and the green dot turns to “A” to 
indicate that Averaging is in process. 
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Advanced Averaging—P300 

Advanced averaging can be used to set up P300 protocols. A sample P300 setup is included in the Samples 
folder. 

To set up Advanced Averaging: 

1. Open two or more graph files. 

2. Use Set up Acquisition to set each graph file for Averaging (see page 1154). 

3. Click the Averaging Setup button and set Averaging Options as desired for each graph file. 

 Advanced Averaging will use the defaults if you choose not to set Averaging Options for 
Latency, Artifact Rejection, or Enabled channels.  

4. Use Setup Stimulator to establish the desired stimulus output for each graph file (see page 1170). 

 Set the Output channel to the same channel (A1 or A0) for all graph files. 

 Set the Stimulator Output to During Averaging Pass (recommended). 

5. Save each graph file with an appropriate name. 

6. Choose MP150 > Set Up Advanced Averaging. 

 

This menu option is only enabled if two or more open 
graphs are set to Averaging.  
 

7. Set the Advanced Averaging options: 

 

a. Averages: Select the number of averages from the pull-
down menu (max 10,000). 

b. Graph: Assign a Graph from the pull-down menu of open 
graph files. Up to eight graph files can be used in 
Advanced Averaging. 

c. Trial distribution: Use the slider to assign a percentage for 
each graph; the total will adjust to 100%  

Note The software counts 0 as 1, so the percentage of the 
active graph should be entered as one less than the 
desired output (for 50% enter 49%). 

8. Click the Start button in the Advanced Averaging setup dialog to begin acquisition. 

9. Review the status in the “Completed” bar that is activated when Start is pressed and/or in the status 
display at the bottom of the AcqKnowledge software window. 

  
 

10. Save each graph file. 
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11. Make sure that the Graph names are correct in the Advanced Averaging setup dialog, and then use 
Save or Save As to save the setup as an AVG file. 
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Repeating 

The Repeat mode allows you to acquire data from repeated trials using the same parameters for each trial. 
Checking the Repeat every box at the bottom of the acquisition setup dialog enables a series of dialoges and 
popup menus at the bottom of the dialog. These allow you to control how many times an acquisition will 
repeat as well as the interval between trials. When this is unchecked, the acquisitions will repeat as soon as 
possible (usually instantaneously, but slightly longer if data must be saved to a file between trials). 

  
Interval The entry to the right of the “Repeat every” checkbox tells AcqKnowledge how long to pause 

between the start of one acquisition and the beginning of the next acquisition. This can be scaled 
in terms of seconds, minutes, or hours using the second popup menu. 

 It is important to note that this value measures the interval between the start of two adjacent trials, 
rather than the interval between the end of one trial and the start of the subsequent trial. If the 
repeat interval is set for 15 minutes and the acquisition length is set to 60 seconds, then there will 
be a 14-minute pause between the end of the one trial and the beginning of the next. 

Trials Set how many trials to acquire: 

for perform a finite number of trials; enter the number of trials to acquire 

forever perform an infinite number of trials. Trials will be repeated at the specified interval 
until the acquisition is stopped either by clicking on the stop button in the graph 
window or if there is not enough free memory on the target storage device. 

Regardless of which options are checked, data for each trial is acquired according to the acquisition 
parameters specified in the dialog. In the above example, each trial of data will be sampled at 50 Hz and will 
last 1 minute; the trials will be repeated every 15 minutes for a total of 8 trials. 

By default, each acquisition will delete the data from the previous acquisition. You can change this by 
selecting the Autosave file option from the Save once/Autosave file/Append option at the top of the 
acquisition setup dialog. When the repeating option is checked and Autosave is selected, AcqKnowledge will 
save the data from each trial using the file name and extension indicated by the autosave feature. See page 
148 for a more detailed description of Autosave. 
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Setup Channel Options 

Channel The Channel column contains the alpha-numeric channel numbers. “Analog” (or 
continuous) input channels begin with “CH” and run from CH1-CH4. “Digital” input 
channels begin with “D” and run from D1-D8. “Calculation” channels begin with “C” 
and run from C1-C12. 

Display is limited to four channels of each type. Use the scroll button  to set up 
additional Digital or Calculation channels. 

Acquire When the Acquire Data box is checked for a given channel, data will be collected on 
that channel. 

Plot If Plot on Screen is also checked, data will be plotted on screen in real-time during the 
acquisition. If the plot box is unchecked, data will still be recorded for that channel, but 
the waveform display will be disabled. To display the waveform plot after the acquisition 
is over, show the channel. 

Enable Value 
Display 

Checking the Enable Value Display box means that you can choose to display 
(numerically and/or graphically) the values for each channel in real time. To display the 
values, you must also select Show Input Values (via the MP36 menu). Input values are 
displayed in a separate window from the main graph window. 

 

Default The default is to collect one channel of data on analog channel 1 (CH1), and to plot and 
enable value display for this channel 

TIP Usually, you will want to check all three boxes for each channel you acquire data on 

Label The Label entry for each channel allows you to type in up to 38 characters to identify the 
channel. 

Presets 

 

Clicking on the Presets button will generate a menu of available presets for the channel. 
Presets for common applications configure the hardware gain, filters, etc. 

 For a detailed summary of Analog Input channel, Digital Input channel, and 
Calculation channel options see the Presets section beginning on page 1115. 

View/Change 

 

To View/Change Parameters for a Preset, click the wrench icon. If you change the 
parameters, you have the option of creating a New Channel Preset to make the 
established parameters available to other channels. 

If you make a change to a preset and start recording in the Append mode, you will be prompted as follows. 
Choose Abort, save your data, and then change the presets to aquire as a new data file. 
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Setup Acquisitions 

Once you have set up the channel parameters, the next step is to specify the acquisition settings. You can do 
this by choosing Set Up Acquisition from the MP menu. This generates a dialog that will describe the type of 
acquisition about to be performed. 

There are a number of options here, but the basic parameters involve specifying: where data should be stored 
as it is being acquired, the sample (data collection) rate, and the acquisition length. 

 

Data storage At the top of the Acquisition Setup dialog, you should see a display that reads Record 
and Append using PC Memory. This is the default option for collecting data and tells 
the BIOPAC software to automatically record data into single continuous file, and to 
store the data in computer memory (RAM) during the acquisition. The third pop-up 
menu (which defaults to PC Memory) allows you to specify where the data should be 
stored during the acquisition. You will need to choose PC Memory or Hard Disk 
storage. Computer memory (RAM) is usually faster (but less abundant) than disk 
space. If your system uses any virtual memory, the BIOPAC software will use as 
much as possible. 

Sample rate  This is analogous to “mm/sec” on a chart recorder, and refers to how many samples 
the MP unit should take each second. As the sample rate increases, the representation 
of the signal becomes more accurate — however, so does the demand for system 
resources memory, disk space, etc.). The sampling rate has a lower bound of 1 sample 
per second, and an upper bound of 100,000 samples per second (2 kHz). Choose the 
best sample rate from the pull-down menu generated when you click the Sample Rate 
entry. 

A good rule of thumb is to select a sampling rate at least 
four times the highest frequency of interest for the signal. 

Triggering from an analog channel requires oversampling by a factor of 4, which 
ensures that the trigger signal will not be missed. For example, an initial sampling rate 
of 1,000 samples/second should be increased to 4,000. The trigger can be established 
in the Set up Triggering dialog 

Acquisition Length  This entry controls how long an acquisition will last (duration). This can be scaled in 
seconds, minutes, hours, milliseconds or number of samples, as selected from the pull-
down menu. Set this value by entering a number in the Acquisition Length box or by 
moving the scroll box left (to decrease) or right (to increase). 

Repeat  The Repeat function is an advanced operation and is discussed on page 1159. 
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Starting an acquisition 

After you have setup the channels to contain data and defined the channel parameters, you are ready to start 
the acquisition. If a file window is not already open, choose File > New to generate a graph window. 

In the lower right corner of the screen, next to the  button, you should see a button with a circle 
next to it. The circle indicates the status of the communication link between your computer and the MP data 
acquisition unit (MP150 or MP36R). If the MP unit is properly connected to the computer and is turned on, 
the circle should be solid and green. If the MP unit is not properly connected, a solid gray circle will appear 
(on monochrome displays, the circle will appear solid when the MP unit is connected properly, and unfilled 
when the MP unit is not communicating with the computer). 

You can start the acquisition by positioning the cursor over the  button and clicking the mouse 
button or by selecting “Alt + Spacebar.” If there are no input devices (e.g., electrodes or transducers) 
connected to the MP150/MP36R, it will collect a small value of random signal “noise” with a mean of about 
0.0 Volts. 

 For information on how to connect measurement devices to the MP36R, see the BSL Hardware Guide. 
 You may also start an acquisition using a variety of “triggers,” which are discussed on page 11166. 

Once acquisition starts, the  button in the acquisition window changes to . The 
two opposing arrows to the right of the button indicate that data is being collected. Also, the “Busy” status 
indicator light on the front of the MP150/MP36R will illuminate, showing that data is being collected. 

 

Stopping an Acquisition 

To stop an acquisition at any time, click the  button in the lower right corner of the screen or 
select “Alt + Spacebar.” An acquisition will stop automatically when it has recorded an amount of data equal 
to the Acquisition Length entry. 

 

Rewind 

 The Rewind button on the Toolbar allows you to erase the last recorded data segment and continue to 
Append data to the existing data file. This function will erase the last segment along with the Append Marker 

 for that segment; the application will keep track of Append Marker labels, so that the label always matches 
the segment number. 
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If the “Warn on Overwrite” option is active, a warning dialog will be generated before the segment is deleted.  

 

Saving acquisition data 

To save a data file, pull-down the File menu and choose the Save command. 

 

Electrode Checker 

 
 

The Electrode Checker, in conjunction with the MP36R unit, measures how well electrodes are making 
contact with the surface of the skin. To use this feature: 

1) Attach the electrodes as you normally would. 

2) Connect the electrodes to an electrode lead set (such as the SS2LB). 

3) Instead of connecting the electrodes to one of the four analog inputs, connect the Simple Sensor end 
of the electrode lead to the Electrode Check port on the front of the MP36R acquisition unit. 

4) Click the MP36 menu and scroll down to select Electrode Checker. 

This will generate a small “thermometer-like” display. At the bottom of the display you should see a number 
with k after it. This value describes the impedance of the electrode/skin contact, with lower numbers being 
associated with better conductivity. The better the conductivity, the “cleaner” the signal displayed on the 
screen. If the MP36R is off or no nothing is connected to the “Electrode Checker” on the MP36R unit, the 
Electrode Checker display will say “OFF.” 

   
Poor contact Good contact  Off 

TIP While there are few absolutes as to what constitutes “good” contact, one rule of thumb is that this 
number should be below 10 k, and the lower the better. 

TIP To decrease the impedance of an electrode connection, you may want to “abrade” the surface of the 
skin with an abrasive pad (such as ELPAD). This removes a thin layer of dead skin cells and 
should result in a signal that has relatively little noise. 
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Organize Channel Presets 
The Organize Channel Presets option of the MP36 menu is related to the channel presets in the Set up 
Channels dialog. You can organize the Presets (established or new) to place the most frequently selected at 
the top of the menu or to group related Presets, such as the established ECG Presets with any new channel 
Presets you create. Click a Preset description to select it, and then use the buttons to organize the Presets. The 
up and down arrows will move your selection one space at a time, and the Top and Bottom buttons will jump 
to the start or end of the list.  

  
Organize Channel Presets dialog and resulting Presets menu display 

  
Revised Organize Channel Presets dialog and resulting Presets menu display 

To delete or rename a Preset, select the Preset name from the 
listing and click the Delete or Rename button. Or, click the 
right mouse button to select the Preset from the listing and 
scroll to the desired option.  
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Rename a Preset by typing in a new 
description and clicking OK. 

 

 

Delete a Preset by selecting that option. You cannot delete the 
Default Analog Input preset. When you delete a Preset, you will 
be asked to confirm the request because it is an irreversible 
action.  
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Chapter 8 Set Up Triggering 
During a normal acquisition, the MP System (MP150 or MP36R) will begin collecting data following a 
mouse click the start button. It is also possible to begin acquisition using a trigger. Using a trigger allows you 
to start an acquisition “on cue” from a variety of different trigger sources. All trigger options are set in the Set 
Up Triggering dialog, which can be selected from the MP150 menu. By default, the trigger is Off, and 
acquisitions are started by clicking on the Start button in the graph window. Other options can be selected 
from the popup menu in the Triggering Setup dialog. To begin an acquisition with a trigger, first choose the 
trigger options most appropriate for your application and then click the Start button. After the Start button has 
been pressed, data will be acquired as soon as the trigger is activated. There are two general types of trigger 
sources: digital channels and analog channels. 

 

Digital Triggers 

Digital channels are channels that contain binary 
(either/or) data as typified by a switch being either open or 
closed. This type of data can be acquired from a push-
button switch or other device that produces an on/off 
pulse. For instance, it is sometimes useful to have an 
acquisition begin when a subject presses a button or when 
a signal generator sends out a pulse. These are typical 
digital signals and the trigger devices that emit these 
signals can be connected via the UIM100C. Most stimulus 
generators are equipped to output a digital pulse 
simultaneously with the stimulus signal. 

In a simple trigger design, an external switch is connected 
to the TRIG and GND D input as shown above. Since this 
switch will be either open or closed, the data will be 
digital and have two levels, +5 Volts and 0 Volts. A value 
of +5 Volts is interpreted as a binary 1, and a level of 0 
Volts is interpreted as a binary 0. In the setup above, when 
the switch is closed (i.e., the button is pressed) the signal 
changed from +5 Volts to 0 Volts, creating a transition or 
“edge.” 

If the trigger is set to external, and the edge is set to 
positive, the acquisition will begin as soon as the push-
button is pressed anytime after the start button in the graph 
window is pressed. Once the button is pressed, the 
acquisition will proceed according to the acquisition 
parameters you have set (acquisition length, sampling rate, 
and the like). 

BIOPAC
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Analog Triggers 

Initiate an acquisition when an analog channel reaches a certain level. To enable the analog trigger feature, 
data must be acquired to either memory (RAM) or disk, and a value must be entered in the Delay box 
(although the delay may be set to zero). The channel containing the data to be used as a trigger does not 
require the acquire/plot/values boxes to be checked in the Set Up Channels dialog. Leaving these boxes 
unchecked will allow the incoming data to trigger an acquisition but will not cause the trigger channel to be 
acquired or plotted. 

Select MP150 > Set Up Trigger to generate the Trigger dialog: 

 

  
 

 
Source  Off: Disables Triggering while maintaining the established setup. 

 External: Select for Digital Trigger. 

 CH #: Select for Analog Trigger; must be acquiring to Memory or Disk. Specify the analog 
channel that contains the trigger data and then specify a voltage Level to initiate the trigger. 
Acquisition will begin when the data on the specified channel reaches the specified Level.  

 To trigger an acquisition when an ECG wave on analog channel 1 reaches a certain 
voltage or value, you would set “Source” to CH 1 and then set the Level when the entry 
box is enabled. 

 Triggering from an analog channel requires oversampling by a factor of 4, which ensures 
that the trigger signal will not be missed. The sampling rate can be adjusted in the Set up 
Acquisition dialog. 

o  For example, an initial sampling rate of 1,000 samples/second should be increased 
to 4,000.  
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Level  The Level option is activated when a Source CH is selected. Set a level to initiate the trigger 
(e.g., if the ECG wave peaks at 3 V, set the trigger level just under 3 V). 

Edge  Triggers can have a positive or negative edge, defined as follows: 

Edge Digital Analog 

Pos signal changes from 0 to 1 signal crosses from a baseline to a peak 

Neg signal changes from 1 to 0 signal crosses from a peak to a baseline 

 For ECG data (and other types of data with peaks of relatively short duration) there will 
be only minor differences between the two edges, although the positive and negative 
edges can be widely separated in time for data with slowly changing values (such as GSR 
or skin temperature data). 
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Mode  Once the trigger channel and level have been specified, the final parameter is the delay. Delay 
can be measured in terms of samples, milliseconds, seconds, or minutes, and may be set to zero 
if desired. The delay option instructs the MP System (MP150 or MP36R) to wait a specified 
period after the trigger level is reached before beginning the acquisition. 

Delay When using a trigger, the default setting is for the acquisition to begin immediately after the 
trigger pulse or level occurs. You can change the default by using the Delay option in the 
Trigger Setup dialog. This feature allows an acquisition to begin a specified period after the 
trigger level is reached. If you want to start an acquisition one second after a switch closes, set 
the trigger to external and enter 1.00 in the box next to Delay. The default scale for Delay is 
seconds, meaning that the acquisition will begin a specified number of seconds after the trigger 
has been initiated. The scale of the delay can be changed from seconds to samples, milliseconds, 
or minutes. 

Pretrigger During normal triggered acquisitions, data is collected only after the trigger has been activated 
(or after some delay). For some applications, it is useful to collect data on events that occur just 
prior to the trigger event. As an example, if an acquisition was set to begin when a device (such 
as a tone generator or flash) sends an output pulse, it might also be important to collect 
information on the subject’s state just before the stimulus. 

 Pretrigger functionality is not supported in all acquisition modes (MP150 > Set Up Acquisition): 

Mode Source: EXTERNAL Source: CH  # 

Disk Pretrigger supported Pretrigger supported 

Memory Pretrigger supported Pretrigger supported 

MP150  Pretrigger supported not available 

Averaging not available not available 

 When the Pretrigger function is enabled, start an acquisition by clicking the Start button. When 
the internal memory in the MP data acquisition unit is full, the MP System (MP150 or MP36R) 
will start replacing the oldest data with the newest data (similar to the record last feature). This 
process continues until the trigger event occurs. Following the trigger, the MP System (MP150 
or MP36R) will collect data until the total length is reached. The acquisition now contains data 
from both before and after the trigger. 

 The amount of data collected before the trigger event is determined by the value in the box next 
to the Pretrigger popup menu. As with Delay, scaling can be set in terms of samples, 
milliseconds, seconds, or minutes. The duration of the Pretrigger may also be adjusted using the 
scroll box to the right of the Pretrigger dialog. 

 When Pretrigger is selected, it is important to note… 

 The total length of the acquisition includes the duration of the Pretrigger. If the acquisition 
length is set to 120 seconds and the Pretrigger is set to 20 seconds, only 100 seconds of data 
will be collected after the trigger event occurs. 

 Since the total length of the acquisition includes the duration of the Pretrigger, the duration 
of the Pretrigger may not exceed the length of the acquisition. 
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Chapter 9  Set Up Stimulator 

 

Although data acquisition is the primary function of 
the MP System, you may also output a signal 
through one or two analog channels while data is 
being acquired. This is handled through a window 
similar to the standard AcqKnowledge graph 
window. 

Four types of signals can be output: 

1. Square waveforms—page 177 11111 

2. Tone waveforms—1177 

3. Ramp waveforms—1178 

4. Arbitrary waveforms—179 

Each of these waveform types can be set to repeat 
signal output either Once or Continuously, and 
parameters can be set to either Relative or Absolute 
time scales.  

 

To set the type of waveform to be output, select Setup stimulator from the MP150 menu. This generates a 
window that allows you to control the type of signal output by the MP System. Like the standard graph 
window, this plots time on the horizontal axis and amplitude on the vertical axis.  

You can use this window to create and shape waveforms to be output. Adjust the Stimulator Sample Rate 
(described below) to further control the parameters of the Stimulator Output design. 

For any waveform (or stimulus) to be output, you need to specify the type of stimulus, the “shape” of the 
signal, the output channel to be used, and how many times the stimulus should be output.  

All of these parameters can be set from within the Stimulator Setup dialog. Regardless of the type of 
waveform you select, stimulus signals will normally be output when an acquisition is initiated, either as a 
result of clicking on the start button or a trigger being activated. 

Stimulator Sample Rate 

A very powerful feature intrinsic to the MP150 unit is the ability to set a stimulation signal output rate that is 
different than the acquisition rate, thus permitting considerable flexibility for a variety of physiological 
applications.  

Use the pull-down menu to select a unique sample rate for the stimulator. 

 

  See also: Application Note 5AH162 - Using the Stimulation Features of the MP System.
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Parameters 

Reset Refresh the display; use after the time scale has been adjusted. 

Scaling  Scaling button—Rescale stimulus signals to units other than 
Volts according to the Change Scaling Parameters. 

 This type of rescaling does not change the amplification of the 
signal, it is useful for recalibrating the output signal to more 
meaningful units. In the example shown here, an output signal of 
+10 Volts is rescaled to +128 dB, while an output signal of –10 
Volts is rescaled to reflect 0 dB. 

 

Relative  Set the duration of each segment of the output waveform in Seg # Width. In the sample dialog 
shown below left, a 5000 msec output is created by entering individual segment widths: 500 + 400 
+ 250 +200 + 3650 = 5000 msec 

Absolute    
As an alternative, you can enter an exact Seg # Time for each segment of the output waveform. 
This mode can make it easier to control the overall timeline of the stimulus output because you can 
review the setup as the total time. Enter the precise Time for each segment change. To create the 
same 5000 msec output as used in the Relative example, you would enter Seg # 2 Time as 900 (to 
mimic 500 + 400 in Relative mode) , and end the last segment at 5000 (the Seg # Time reflects the 
time associated with the last sample point of each segment, rather than the duration of the segment 
itself). 

 
 

Output 

A# Analog Output You can output on one or two analog output channels. The output channels are 
listed as A0 and A1 and correspond to Analog Output 0 and Analog Output 1 the UIM100C. 

 For dual stimulation and independent control, connect an output device to A0 and A1.  

 See Analog Output for MP150 Users notes on page 1174. 
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The maximum resolution of a stimulus signal output through an analog channel is 22 µsec; this 
means that the shortest segment in the stimulus signal must be at least 22 long. 

PW Pulse Width AcqKnowledge allows you to output a single digital pulse through digital channel I/O 
15, with a resolution of 1 µsec. Since this is a true digital channel, pulse output has only two levels 
(0 Volts and +5 Volts), which cannot be edited. The segment that can be edited is the pulse width 
(duration), which can be set to any value greater than 1 µsec. 

Repeats 

Set independently for A0 and A1. 

 Turn Output OFF (no stimulus signal output). 

 Output the stimulus signal once. 

 Output the stimulus signal for the duration of the acquisition (forever). 
 When output continuously is selected, a vertical line 

is generated at the end of the first section of the 
waveform in the stimulator window to indicate where 
the first output signal ends and the second begins. 
The line can be dragged left or right like a vertical 
segment in a stimulus waveform to control the 
duration of the waveform as it is continuously output. 

Trigger 

When a trigger option is selected (in the Trigger Setup window), AcqKnowledge allows you to select 
from additional menu items with respect to when the signal is output. By default, the stimulus signal will 
be output when you click the start button. When a trigger is enabled, however, you have the option of 
either outputting the signal when the start button is pressed or when the trigger is initiated. The trigger 
option is added to the stimulator window when a trigger is enabled in the Setup Trigger box (described 
on page 166). 

Manual Stimulator Control 

 Only available when a stimulator is connected and with MP150 units running firmware 1.1.14 
or higher 

When an MP150 unit is being used, the manual stimulator controls at the bottom of the Stimulator Setup 
dialog can be used to start and stop stimulators independently of the acquisition. If changes are made to 
the stimulus wave while a stimulator is running, the stimulator will need to be turned off and then back 
on to apply the changes to the settings. 

The manual stimulator controls can not be used if the MP150 is set to acquire in averaging mode. 

 Acquisition will start the stimulator when the acquisition starts. 

 On/Off button will start the stimulator when the Start button in the Stimulator Setup 
window is engaged. The Start button toggles to a Stop button. 

 If Dual Stimulator settings are active, “Start with” applies to both stimulators. 
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 A “lock” between the two sets of controls can be used to turn both stimulators on or off at 
the same time. This lock is useful for two-channel stimuli delivery, such as stereo sound. 
UNLOCKED 

  
LOCKED—Both channels Start/Stop together 

 
Stimulator Output 

You can set “Stimulator Output” to start before or during an averaging pass. 

 For Averaging details, see page 1154. 

   
Before Averaging Pass During Averaging Pass 
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Analog Output for MP150 Users 
The two MP150 Analog Output channels can independently output static or dynamic values: 

 Static output: Use “Manual Control” (page 1222) to set the output level for each channel in 
the range -10V to +10V. 

 Dynamic output: Use “Stimulator Setup” (page 1170) to define the output level and pattern. 
 
The MP150 will automatically use the “Manual Control” value if: 

 No acquisition is in progress OR 
 Acquisition is in progress but the Stimulator is disabled via the “Setup Stimulator” dialog. 

 
The MP150 will only use the “Stimulator Setup” value if: 

 Acquisition is in progress (or before Averaging pass) AND 
 Stimulator is enabled via the “Stimulator Setup” dialog. 

 
When the stimulator is in use: 

1. Any Stimulator Output starts (from before Time = 0) with the value established for “Manual 
Control”. 

2. If Segment # Width = 0 the stimulator ignores the associated Segment # Level. 
3. If the stimulator is in 1x mode, after the output waveform is sent, the value of the last 

segment is fixed until acquisition stops. 
4. When acquisition stops, the stimulator resets to the “Manual Control” value. 

 
The following dialogs and output illustrations demonstrate how the “Manual Control” value 
influences Analog Output for the Stimulator when an MP150 is used: 
 
Acquisition parameters: 

 
 
 
 
 

Stimulator parameters: 
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Manual Control list box: Stimulator Output pattern (using MP150): 
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Dual Stimulation 

For independent control of two stimuli (such as sound and electrical output), set stimulator functions for 
Output to A0 and A1 for each MP150 unit. Click the tab for each output at the top of the Stimulator Setup 
dialog and complete independent settings. 

 
 

 For additional stimulus paradigms, add MP150 units (see Multiple Hardware, page 1153). 
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Square waves 

 Square waveforms are useful for generating pulse 
waveforms, which can be used as stimuli or to trigger a 
stimulus-generating device (such as a flash device or a tone 
generator). 

To output a square wave, choose the  icon in the 
“Repeats” section. You should see a rectangular wave appear in 
the window. You can control the shape of the wave by 
manipulating the various segments of the wave. A square 
wave has five segments, and AcqKnowledge allows you to set 
the level (amplitude) and width (duration) of each segment. 

In a square wave, each of the editable segments is oriented 
horizontally, with vertical segments connecting the adjacent 
sections of the wave. The first segment of a pulse waveform is 
the segment that appears at the far left of the waveform 
section. By positioning the cursor on this segment of the 
waveform, you can tell from the box at the bottom of the 
screen that the level (vertical offset) of the first segment is 0 
Volts, and the width of the first segment is 500 msec. 

To adjust the level of a segment, either: 

a) enter the desired level in the box that says Seg # Level; or 

b) position the cursor on the first segment of the waveform and drag it up or down using the mouse 
(segment 2 is selected in the preceding dialog, and appears in red). 

To change the duration of a segment, either: 

a) Enter a value in the Seg # Width box at the bottom of the Stimulator Setup dialog; or 

b) Position the cursor on the first vertical segment in the setup dialog, click the mouse button, and drag 
the vertical segment left or right. Moving the first vertical segment left shortens the duration of the 
first segment, whereas moving the first vertical segment right lengthens it. 

Each of the segments in the pulse wave can be “edited” in this way. 

Tone Stimuli 

 Tone waveforms allow you to create pure tone signals of 
any duration, magnitude, and frequency. This option outputs 
a pure sine wave, which is useful for audiological and 
stimulus response testing.  

A tone waveform is comprised of two segments, with only 
the second segment being the actual tone itself. This allows 
you to include a pre-signal delay (by setting the level for 
Segment #1 to 0 Volts and the duration to a desired value). 

To set the duration of the tone, adjust the length of segment 
#2 (by changing the Seg #2 Width value box or by clicking 
and dragging the segments within the window). As shown, 
there is an additional (uneditable) section of the waveform 
after the second section. This segment returns the last value 
from segment two, and continues to output that signal level 
until the acquisition is terminated (if the stimulator is set to 
output once) or until another signal is output (if the MP 
System is set to output continuously).  

There are three additional parameters for Tone waveforms: frequency; magnitude; and tone phase. 

 Tone frequency refers to the frequency of the second segment of the waveform. This can be set to 
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any value, although the most common settings are between 20 Hz and 20,000 Hz. 

 Magnitude refers to the peak-to-peak range of the signal, which can range from ± 0 to ± 10 Volts. 

 Phase of the stimulus signal can be any value equal to or greater than 0 degrees. Phase settings of 
more than 359 degrees will be rescaled to fit the 0°-359° range. In other words, setting the phase 
to 360° or 720° has the same effect as setting the phase to zero degrees. 

 

Ramp Waves 

 Ramp waveforms are useful when you need to construct 
a monotonically increasing or decreasing stimulus signal. 
Ramp waves are comprised of three segments and the 
amplitude and duration can be set for all three sections. 
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Arbitrary Waveform 

 The Arbitrary waveform option allows you to set a 
waveform’s shape and length using standard AcqKnowledge 
editing functions. 

 See Application Note #AH162 for performance 
specifications. 

 The length of an arbitrary waveform is only limited 
by the available memory (if recording in 
Memory/Disk mode; it will be limited to 4096 
samples if recording in MP150 mode). 

Unlike the other types of waveforms, Arbitrary waveforms 
have no segments, so the “shape” of the waveform is 
determined by selecting an existing waveform and the only 
parameters that can be set are Scaling, Repeats, and Trigger. 

There are two methods to create an arbitrary waveform: 

 A. Copy waveform segment 

1. Open a waveform in a standard graph window. 

2. Select the section of the waveform you wish to 
output.  

 
3. Return to the Stimulator Setup dialog—the selected 

area will automatically be pasted into the dialog.  

 

 B. Create waveform 

You can also construct an Arbitrary waveform by copying and pasting predefined stimulus waveforms 
(e.g., square waves or ramp waves) into a standard graph window. This is useful when a pure signal 
needs to be modified by adding noise or modifying waveform parameters such as rise time or decay. It 
also allows you to combine complex sequences of existing stimulus waveforms, such as a pulse followed 
by a tone. 

1. Create a waveform in the Stimulator setup (as described above) of the desired duration and shape. 

2. Choose Edit > Copy. 

3. Switch to an empty graph window. 

4. Choose either Insert waveform or Paste from the Edit menu. 

5. Modify the waveform characteristics as desired. 

6. Choose Edit > Copy. 

7. Switch to the original graph window and paste into the Stimulator Setup window. 

8. Output as an arbitrary waveform. 
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Stimulator Icons 
Waveforms: 

 
Square wave 

 
 

Tone (sine) wave 

 
 

Ramp wave 

 
 

Arbitrary wave 

Parameters: 
 

Reset the display (use after adjusting the time scale) 

 
 

Copy a stimulus waveform from the Stimulator Setup window to the Graph window 

 
 

Scaling (rescale Stimulus signals to different units) 

 
 

Set time base to relative 

 
 

Set time base to absolute 

Output: 
 

Output to Analog Output channel 0 (default) 

 
 

Output to Analog Output channel 1 

 
 

Pulse Width outputs a true digital signal: 0 Volts and +5 Volts 

Repeats: 
 

Toggle the selected Stimulator Output ON and OFF 
For dual stimulator setup, Output is independent for A0 and A1 

 
 

Output stimulus signal once 

 
 

Output stimulus signal for duration of acquisition 

Trigger: 
 

Toggles between “Off” and “Wait for” if MP150 > Set Up Triggering is active 
Off—Output stimulus signal when Start button is pressed 
Wait for—Output stimulus signal when trigger is initiated 

Stimulator 
output: 

 Toggles between “Before” and “During” Averaging Pass if Set Up Acquisition is 
set to Averaging. 

 
 

Before  
 

 
During  
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Chapter 10 Output Control 
Note: Output Contol chapter refers to MP36R hardware only.  
 For MP150 and MP100, see the previous chapter, ‘Set Up Stimulator’. 

The MP UNIT can output pulses or analog voltages via the Analog Out port; this 
port is also used to connect to BIOPAC’s external stimulators. The MP36R has 
an additional I/O Port which is used to output digital (TTL Level) signals. 

Parameters for output signals are set via Output Control. Access to a specific 
Output Control is via the MP36R > Output Control submenu. 

There are seven Output Controls for the MP36R: 

Output Control See… MP36R Functionality 

CH# to Output page 1183 Direct analog CH1-4 to output listen to signals 

Digital Outputs page  185 Control 8 digital outputs 

Pulses page 1186 Use with third-party devices; software can control pulse width 
and repetition. 

Stimulator - BSLSTM page 186 Use with BSL Stimulator 

Low Voltage Stimulator  page 186 MP36R: Use OUT3 adpater for MP36R built-in low voltage 
stimulator. Software can control pulse amplitude, width and 
repetition (-10 to +10 V) 

Pulse Sequence Page 188 Direct analog CH1-4 output. Allows for output of customized 
pulse trains. 

Sound Sequence Page 191 Outputs customized sounds assignable to a user configurable 
pulse train. 

To open an Output Control, select it from the MP UNIT > Output Control submenu. A checkmark appears 
next to the submenu selection and an Output Control panel is displayed, bordered in red in the active data 
window. To close an Output Control, select from the menu again (toggles between display and hide) or right-
click in the open control panel and choose Close. 

Only one Output Control panel may be open at any time. Switching between different data files can change 
the display and operation of the control panel. 

Because some output devices can be used for stimulation on humans and can achieve voltages up to 100 
Volts, built-in software logic makes output control as safe as possible. 
See page 1205 for safety notes regarding human subjects. 
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The following applies to all Output Controls. 

The output will not operate unless its software control panel is open. 

When an Output Control panel is closed, or the AcqKnowledge application is closed, MP36R output goes to 0 
Volts, preventing the output device from sending pulses. 

When an Output Control panel is opened, output is always OFF until activated by a click of the ON/OFF 
switch in the control panel or, if parameters allow, a click of the Start button in the data acquisition window. 
(Exceptions are the Voltage Output Control, which outputs immediately, and the Digital Outputs Control 
when set to the preference “Set each output immediately.”) 

Output preference parameters are local and are saved with the data file or a graph template file. The data or 
template file holds the output parameters as established when the file was saved. (See “Save as Graph 
Template,” page 1240.) Switching between other open graphs can change the display and operation of the 
control panel since the settings in each graph are independent entities. 

CH to Output  

Use both the Output Control panel and its respective Preferences dialog to control the output signal. Output 
Control Preferences  dialogs establish the parameters for output. Preferences dialogs are only available when 
the corresponding Output Control panel is open and active.  

To generate the Preferences dialog, either: 
Open an Output Control panel and then right-click anywhere in it to 
generate a pop-up menu. Choose Preferences to open the dialog (Close 
will close the control panel). 

 or  

Open an Output Control panel 
and then choose File > 
Preferences and select from 
the submenu to open the 
dialog. 

 
If a control panel entry box is grayed or disabled, its values may be established, or limited, by settings in the 
Preferences dialog. If Preferences parameters allow, enter values directly in the Output Control panel. 

   
Key into the entry boxes and then enter the value by pressing the Enter key. 
Use the Tab key or mouse to move to another entry box. 
Click the OK button if in the preference dialog. 
Values entered into a control panel or its Preferences dialog that are outside the specifications of the output 
device, or outside the limits defined by the Preferences dialog, may change automatically to reflect either the 
closest value to that requested that the the hardware can achieve, or the closest increment defined by the limits 
in Preferences. (The system will not check while you type, it checks and may make changes after the value is 
entered.) 
For example, if a Pulse width of 5 ms is entered into the Pulses Output Control panel entry box, but 
Preferences defines a range limit of .5 to 2 ms for Pulse width, the system will automatically change the new 
entry to 2 ms.  
Saving Panel settings: 
Output Control panel settings will be retained until a file is closed or saved. If a file is closed but not saved, 
settings will be lost (defaults established); if a file is saved, panel settings will be saved.
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CH# to Output Output Control 

 

The CH# to Output Output Control redirects an analog input signal to the Analog Out port on the back of the 
MP UNIT. The signal from the assigned channel will continue to be recorded and plotted as it normally 
would. This Output Control is used mainly when attaching headphones to the MP UNIT to listen to signals 
coming in on an analog input channel. One common use is listening to the EMG (muscle) signal, a clinical 
procedure physicians use to actually hear certain problems with muscles. 

To display this control panel: 

Choose MP UNIT > Output Control > CH# to Output to open the control panel. 

MP36R users may use analog input CH1-CH4. Channel 3 is the default setting. If another channel N has been 
designated, the menu will read “CH<N > .” 

Use the control panel ON/OFF Switch to start and stop output. OFF grounds the output so no signal (or 
sound) should be present. 

Preferences 

Set Preferences to designate which channel to redirect to output. 

Open the Preferences dialog (right-click in the control panel or choose File > Preferences > CH# to Output). 

Use the pull-down menu to select the desired channel CH 1-4 to use for the output. 

Click OK to set the output channel and return to the control panel. 

Note Only the Hardware settings (Gain, Offset, Input Coupling) 
from the Input Channel Parameters dialog (MP36R > Set up 
Channels > Wrench) will be applied since output is established 
prior to the processing of Digital Filters.  

See MP36R Input > Output Scaling values on the next page. 
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MP36R Input > Output Scaling 

The MP36R hardware can pipe signals from any channel input to the output using the “CHX to Output” 
control panel in the AcqKnowledge software—due to the difference between the input and output range, there 
will be a change in signal level (scaling). The output range depends on the output pin used as shown in the 
following table. 

Output Pin 
(Analog Out port) 

Pin Description Output Range 
(Volts) 

Pin 1 
Headphones,  
A.C. Coupled 

-2.048 to +2.048 

Pin 2 
Low Voltage Stimulator, 
D.C. Coupled 

-10 to +10  

The input range is gain-dependent.  The table below shows the scaling (multiplying) factors to use for each 
gain setting. 

Output Scale**—accurate to ±10% 
Factor 1 Factor 2 

Gain Input Range 
+- millivolts 

Pin 1 (Headphone out) Pin 2 (Low Voltage 
Stimulator) 

x5 ± 2 V 1.024 5 
x10 ± 1 V 2.048 10 
x20 ± 500 mV 4.095 20 
x50 ± 200 mV 10.238 50 

x100 ± 100 mV 20.475 100 
x200 ± 50 mV 40.950 200 
x500 ± 20 mV 102.375 500 

x1,000 ± 10 mV 204.750 1,000 
x2,000 ± 5 mV 409.500 2,000 
x5,000 ± 2 mV 1023.750 5,000 

x10.000 ± 1 mV 2047.500 10,000 
x20,000 ± 0.5 mV 4095.000 20,000 
x50,000 ± 0.2 mV 10238.000 50,000 

Notes 

* 1: To properly measure the output signal you need at least a 2K Ohm load. 

** 2. Input to Output scaling is accurate to within 10%. 
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Digital Outputs Control 

 

 

The Digital Outputs Control allows control of signal output on each of eight digital lines via the I/O Port 
connector on the back of the MP36R. Use it to control external devices. The digital output uses stardard TTL 
levels which correspond to the control panel setting as follows:  

Control Panel setting   Output Voltage level (Volts) 

0 0 

1 +5 

To display this control panel: 

Choose MP36R > Output Control > Digital Outputs to open the Digital Outputs Control panel 

Click each digital output line to set its digital state to 0 (off) or 1 (on). 

If desired, you may set Preferences for Digital Outputs. 

Open the Preferences dialog (right-click in the control panel 
or choose File > Preferences > Digital Outputs). 

Select from the following two options: 

Set each output immediately (default) allows you to toggle the state of each digital output line between 0 
and 1, and change the state immediately. In this mode, no Set button is available in the control panel. Output 
for each line is set upon clicking its toggle button. 

Set all outputs when Set button is pressed allows you to toggle the state of each digital output line, but the 
states will not physically be changed until the Set button is clicked on the control panel. In this mode, a Set 
button is available in the control panel. When the Set button is clicked, all eight digital lines will update 
simultaneously. 

Click OK to set Preferences and return to the control panel. 
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Pulses Output Control 

Stimulator – BSLSTM Output Control 

Stimulator – Low Voltage Output Control 

Control panel options for Pulses, Stimulator – BSLSTM and Stimulator – Low Voltage  

 

Additional control panel options for Low Voltage Stimulator 

A variety of pulse ouput options are available. Exercise caution when using any of the options with human 
subjects—see the Safety Note on page 1205. 

Pulses Output Control 

Select this Output Control for general pulse output, or when synchronizing to 3rd-party devices. 

Use for reaction time measurements, where a subject listens with headphones for a series of “clicks” (pulses) 
and responds as quickly as possible with a button press. Determine reaction times by calculating the time 
between the start of the pulses and the responses. 

Use with the BIOPAC STP30W Stimulus Presentation System (SuperLab) to measure responses to visual or 
auditory stimuli. To perform sophisticated evoked response averaging tests (e.g. P300), pair triggers with 
different visual or auditory stimuli. 

Use to trigger another device (automatically send a pulse from the MP UNIT when acquisition starts). 

Use to control a 3rd-party stimulator. BIOPAC recommends use of the BIOPAC BSLSTM Stimulator with the 
MP UNIT and BIOPAC software. If using the BSLSTM Stimulator, use the Stimulator - BSLSTM Output 
Control instead of this Pulses Output Control. 

Stimulator – BSLSTM 

Select this Output Control when using the Biopac Student Lab stimulator 
(BSLSTM) 

Use with stimulation electrode HSTM01 for safe stimulation of human 
subjects (0 – 100 Volts), as well as lower voltage (0 - +10 Volt) general-
purpose stimulation, such is used with amphibian muscle or nerve 
preparations. 
 

Set up note Placing the BSLSTMA/B unit too close to MP UNIT hardware can result in data distortion of 
the BSLSTMA/B pulse width signal; distortion is more apparent at higher sampling rates. 

 NEVER set the BSLSTMA/B atop an MP UNIT 
 Position the BSLSTMA/B away from the MP UNIT to reduce the signal distortion 

Low Voltage Stimulator  

Select this Output Control for low-voltage (-10 - +10 Volt), direct drive 
stimulation via MP36RAnalog Out port (with or without OUT3 BNC 
adapter). 
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Use with stimulator electrode HSTM01for safe, stimulation of human subjects (0 – 100 Volts), as well as 
lower voltage (0 - +10 Volt) general-purpose stimulation, such is used with amphibian muscle or nerve 
preparations. 

 Outputs through a BNC connector so it can be used  
with most stimulation cables (such as those that  
terminate in a needle probe). 

To use one of these control panels: 

Choose MP UNIT > Output Control and then select Pulses, Stimulator – BSLSTM, or Low Voltage 
Stimulator. 
Control panel options for Pulses, Stimulator – BSLSTM and Stimulator – Low Voltage  

 

Additional control panel options for Low Voltage Stimulator 

 

 

Right-click in the Output Control panel (or choose File > Preferences and select from the sub-menu) to 
generate the Output Preferences dialog. 

 
Set the Preferences. 
General: ON/OFF, Number of pulses, Marker options — see page 1195 

Advanced: Pulse width, Pulse repetition (rate) — see page 1198 

Level (low voltage only): Pulse level — see page 1202 

Reference Channel (low volatge only): Channel assignment, signal generation — see page 1202 

Once configured, Preferences may be saved using the Save Settings command, activated by pressing the 
button at the bottom of the Preferences dialog (see page 1195). 
Confirm the settings in the control panel. Adjust as desired within the parameters established in Preferences. 
Entry limits: Settings entered into the Preferences dialog may establish, or limit, the values in the Output 
Control panel entry boxes. You may enter pulse settings directly into the control panel only if parameters 
established in Stimulator Preferences allow. If an entry box is grayed or disabled, its value is set or limited by 
Preferences. 
Initiate the pulse sequence as defined in Preferences (see page 1195). 

 ON/OFF Button in Output Control Panel uses the switch in the Control panel. 

 Recording uses the Start /Stop button in the data acquisition window. 

 

To close an Output Control panel: 

Right-click anywhere in the Ouput Control panel to generate a pop-up menu and then choose Close, or select 
it (or another output control) from the MP UNIT > Output Control submenu. 
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Pulse Sequence Output Control 
In AcqKnowledge 4.2 and higher, this Ouput Control allows sequences of pulse configurations and delays to 
be sent to the MP36R unit, making it possible to create more complex stimulus setups. 
 
Enabling the pulse sequence output control option will display the following control panel at the top of the 
graph window: 

 
 
Pulse sequence configuration is performed in the Preferences dialog of this output control panel. (Accessible 
via right-click on panel shown above or from FilePreferences) When a pulse train element is selected in the 
configuration, the controls will become visible in the right hand portion of the preferences dialog. The 
configuration makes use of three basic building blocks: 
 
A sequence consisting of a number of delay and pulse train elements. The final configuration consists of one 
or more sequences that are outputted in order. Normally the entire configuration is outputted. There is a 
special operational mode on ‘Start with Recording’ that will take only the indexed sequence matching the 
current recording segment. 
 
A pulse train element consisting of a fixed number of pulses of identical width output at a 
fixed pulse frequency. 
 
A delay element that allows for the introduction of time during which no pulses will be generated. 
 
Each one of these building blocks also has a “repeat” count associated with it that will perform the action a set 
number of times. (Adjust by selecting the desired ‘Repeat’ and inputting a new value) Individual sequences, 
pulse trains and delays can be added, repeated and reordered as desired. In the right pane of the Preference 
dialog (shown below), fixed or random pulse counts, widths and repetitions can be configured and combined. 
As in other Output Controls, custom settings can be saved and organized in a list view. (See below for 
additional setup dialogs)  
 
For a full explanation of preferences and tabs common to all Output Control panels, see the “Output Control” 
section on page 194.  
 

 
 Preferences available in Pulse Sequence tab 
 



Part B — Acquisition Functions: The MP150 menu 189 

AcqKnowledge Software Guide 

 
Preferences available in Options tab 

 

 
Delay Preferences 
 

About Delay between Pulse Trains: 
The amount of actual Delay between pulse trains will vary from the set value depending upon the pulse 
repetition value that is used. In the example sequence below, a Delay of 100 milliseconds between pulse trains 
has been set up, combined with a pulse repetition rate of 20 milliseconds. Because the pulse repetition rate is 
applied before the Delay occurs, the actual Delay between pulse trains in this case will be 120 milliseconds. If 
it is critical that a Delay reflect an exact value, it is advisable to subtract the selected pulse repetition value 
when setting up the Delay parameters. 
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 Delay between pulse trains 
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Sound Sequence Output Control 
In AcqKnowledge 4.2 and higher, this Output Control offers users the option of configuring and customizing 
sounds to be outputted for aural stimulus experiments. The control panel and Preferences dialogs used for 
Sound Sequence closely resemble that of Pulse Sequence. The built-in sound resource (a default “click”) may 
be used or any other file in *.WAV format can be substituted via the “File”and “Browse” button. The 
“Width” and “Pulse Repetition” values are dependent upon the duration of the sound file selected for output. 
The “Test” button will ouput an audio sample of the selected sound resource. 
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The option all sequences means that each configured sound sequence (regardless of number) will be outputted 
within the same segment. If "Once" is selected in the "Output entire pulse sequence" option, a configured 
sequence will be heard one time only. If "Continuously" is selected, the first Sound Sequence will be repeated 
after the last one has completed, looping the pattern repeatedly until the recording is stopped. 
 
The option each sequence means that each sound sequence will be outputted on a segment-by segment-basis 
only. For example, if one Sound Sequence is configured, it will only be heard during the first recording 
segment, but not during the second recording segment). If two Sound Sequences are set up, the first one will 
be heard during the first segment and the second one during the following segment.. If no additional Sound 
Sequences have been configured, nothing will be heard during the third segments and beyond. (Exception: If 
"Save Once" acquisition mode is used, the Sound Sequence will be repeated when the recording is 
overwritten during subsequent passes). 
 
The following terms are used in the Output Control panels, Preferences, and guidelines for Pulses, Stimulator 
– BSLSTM and Low Voltage Stimulator. 
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Delay before first 
Pulse 

Initial delay from start of acquisition to start of first pulse. 

Number of pulses Number of successive pulses that will be sent out at the specified Pulse Width, 
Repetition and Level. Set for Single (1), Multiple, or Continuous (Cont). 

Pulse Level Amplitude of the pulse, expressed in Volts. 

Note: The output of the BSLSTM is 0 Volts when the pulse is not active. 

Pulse Repetition 

Also called — 
Events per second 
Pulse frequency Pulse 
sequence  
Pulse train 
Repetition rate 
Sample train 

Can be expressed as Period (ms) or Rate (Hz). 

Period: Time between pulses; measured in milliseconds from the start of one pulse to 
the start of the next pulse. 

Rate: Number of pulses that occur in a one-second interval; measured in Hertz. 

Rate relates to Period as: Rate (Hz) = 1000 / Period (ms) 

Pulse Width Time that the pulse is in the non-zero or active state. 
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Output Control Panel Descriptions 

The Output Control panels for Pulses, Stimulator – BSLSTM and Low Voltage Stimulator work in 
conjunction with Preferences to control pulse output. Control panel functions are detailed here: 

OUTPUT CONTROL PANELS 

General Notes Pulse parameters can interact with each other. 
For example, the pulse repetition period cannot be set to a value less than the pulse 

width. 

In order to simplify the interaction, the Pulse width entry overrides other entries as 
required; it is the priority parameter. 
For example, if the pulse width is changed such that it exceeds the pulse repetition 

period, the pulse repetition period will be automatically adjusted to accomidate 
the new pulse width entry.  If, however, the pulse repetition period is changed 
such that it is less than the pulse width, the repetition period will be changed, 
upon attempted entry,  to the closest value that can be achieved without changing 
the pulse width.  

Entries are checked and rounded (not truncated) as necessary to meet limitations of 
the hardware or the Preferences. 
When a file is opened, the output device will not turn ON automatically. A user must 
manually press either the “Record” button or the “Start” button. 
The exceptions are the “Voltage Output” control panel and the “Digital Outputs” 

control panel if “Set each Output immediately” is selected; these settings will 
output values immediately. 

Output control settings are “local,” which means that they are stored at the data file 
level, not the program level. Use the save as graph template (File > Save As) option 
to use existing Preferences in new data files. 
If a file is saved with an Output Control panel visible and then closed, the panel will 
be visible when that file is re-opened. 

Preferences Right-click a control panel to generate the Preferences dialog, and then select a tab 
for the settings you want to adjust. 

 
You can also use the File > Preferences menu option to generate the Preferences 
dialog. 

Output Settings 

 

 

Displays the name of the current Preferences setting. The pull-down menu lists the 
names of all output Preferences saved using the Save Settings button (see page 1195). 
The pull-down menu is not accessible when an output pulse train is in progress. 
If no settings configurations have yet been saved, when the Output Control panel is 
first opened and no parameters are changed, the Output Settings box displays 
“Default.” If any parameters parameters are changed (but not yet saved), it displays 
“Custom.” 
When output settings are saved, the Output Settings box displays the name of the last 
selected setting. Use Organize List to change the display order of the menu, rename, 
or delete items (see page 1195). 
When a saved setting is selected from the pull-down menu, the Output Control panel 
and all Preferences dialog options will be updated. 

For Reference Channel—Low Voltage only: All Output Settings must use the same 
reference channel assignment; other parameters can be unique for each setting. 
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OUTPUT CONTROL PANELS 

 

 

Once configured, Preferences may be saved using the Save Settings button at the 
bottom of the Preferences dialog. Save Settings generates a dialog to name and save 
a defined configuration of Stimulator output settings. Saved configurations are 
accessible via the Output Settings pull-down menu in the Output Control panel. 
When a setting is selected from the menu, all current output parameters are updated 
to reflect the saved settings. 

You can save multiple configurations as long as each has a unique name; the Save 
button will be inactive if the name you enter is not unique.  

Output settings configurations are local presets that are saved with the data file or a 
template file. The data file or template file holds the output parameters as established 
when the file was saved plus any other named configurations of Output Settings. 

 

 
Use the Organize List button at the bottom of the Preferences dialog to order, 
rename or delete saved Preferences settings. The up or down arrows are only 
available if two or more settings have been saved. Select a setting and then click the 
up and down arrows to set the position, or choose rename or delete. If you choose 
“Delete All,” all saved settings will be deleted and the default and Custom options 
will be reactivated. 

 

GENERAL TAB (OUTPUT PREFERENCES) 

General Tab 
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GENERAL TAB (OUTPUT PREFERENCES) 

Number of Pulses 

 

Indicates the number of pulses to be output. When the Output Control panel is 
closed, the pulse output will be immediately stopped. 

Single will establish a single pulse for outputting. All pulse repetition options, entry 
boxes and scroll bars in both the control panel and preferences windows will be 
disabled (grayed). 

Multiple will establish a specific number of pulses for outputting. The selection will 
activate an entry box where you can enter 1-254 pulses. When this option is selected, 
the Pulse Repetition scroll bar is activated in the Output Control panel. 

Continuous will establish a continuous pulse train for outputting. When this option 
is selected, the Pulse Repetition scroll bar is activated in the Output Control panel. 
 
MP30 Only If using High Speed mode ( > 2,000 s/s) and “Initiate pulse sequence 
with Recording” is selected, the stimulator cannot be turned off manually since the 
MP30 will not accept any commands from the computer until the recording has 
stopped. 
 If “Initiate pulse sequence with ON/OFF button in Output control panel” is 
set, the pulse sequence will be stopped prior to acquisition and will have to be 
manually turned back on after the recording. 

Initiate pulse 
sequence with… 

ON/OFF Button 

 
OFF (red) 
 

 
ON (green) 
 

 
AUTOMATIC 
START (yellow) 

 

Controls the start and stop of pulses. Changes to Pulse Width and Repetition Rate 
can be made in the Output Control panel entry boxes during a pulse sequence, and 
during a recording, if all other Preferences parameters allow it. Any change in the 
pulse output will occur immediately. This lets you change the stimulator output “on 
the fly.” 

 

When “Initiate pulse sequence with ON/OFF button” is selected: 

The ON/OFF button controls pulse output independent of the acquisition status. 

OFF is always available. 

The ON/OFF button reflects the current output state, with one exception: if the pulse 
sequence lasts less than 0.5 seconds, the button will remain in the “ON” state for 
at least 0.5 seconds to indicate that the ON state occurred. 

When the Number of Pulses selected is Multiple, ON/OFF acts as a momentary 
switch. Press the ON (green) button to start pulses; 
it will automatically turn OFF (red) at the end of the specified pulse train. 

The switch defaults to OFF. Saving a data file or saving as a Graph Template will 
save all stimulator preferences except the status of the pulse switch, which will 
always be saved in the OFF position. 

Recording 

 
Start button 
 

 
Stop button 

When “Initiate pulse sequence with Recording” is selected: 

If the preference setting “Initiate pulse sequence with: ON/OFF button” is active, the 
control panel changes will take effect immediately. If settings are changed during a 
pulse train, changes do not take effect until the next time the stimulator starts. 
Pulse output turns ON and OFF corresponding to the Start and Stop of the recording. 

In other words, the Pulse output can only occur during a recording. 

When in this mode, and not recording, the ON button will display as yellow, 
indicating that pulse output will automatically begin at the “Start” of the recording. 

Pulse outputting can be turned OFF during a recording, but it cannot be turned back 
ON until the end of the recording. 
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When a Repeat sequence is running, pressing the OFF button will turn OFF the 
output for the entire recording sequence and the button will display as OFF until after 
the last sequence, when the switch will display as yellow ON (automatic start) 
indicating that pulse output will begin again at the “Start” of the next recording 
sequence. You cannot turn pulse outputting back ON during a repeated recording 
sequence. 

When the acquisition stops, all stimulator pulses will cease, regardless of the Output 
Control panel settings. 

The pulse train will stop concurrent with the end of the acquisition, even if the 
specified pulse train is not completed before the acquisition ends. When a new 
acquisition is started, the pulse train will start from the beginning. 

In this mode, no changes can be made in the Output Control panel until the recording 
stops. Changes made after recording stops will take effect when a new recording 
is started. 

When a pulse is sent out, the marker label and indicator arrow will be generated (if 
the marker preference is turned ON and markers are displayed). 

After initial delay After initial delay of … is enabled only when “Initiate pulse sequence with 
Recording” is chosen. Specify a delay interval from the start of recording to the start 
of the first pulse. This is useful for viewing data prior to the stimulus pulse. The 
BIOPAC output device determines the delay range. 

INITIAL PULSE DELAY MP36R or BSLSTM 

 Range 0 - 100 milliseconds 0 or .5 - 100 milliseconds* 

 Resolution 10 microseconds 1.953 microseconds 

*Entries greater than 0 milliseconds must be at least 0.5 milliseconds. 

Pulse Markers 

 

 

An advantage of using the AcqKnowledge software for output signals is that 
information regarding the pulse is automatically recorded along with the data. On 
most chart recorders, information regarding the pulse level (amplitude), pulse rate, 
and pulse width must be noted by hand, a process that can be inefficient, time-
consuming and error-ridden. 
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 The amplitude reflects the output pulse level. 

 Markers can be automatically inserted and labeled for each Reference pulse or 
change in pulse train. The label will contain the Pulse width and Pulse rate (and 
system time stamp if selected). 

 Markers reflect setting changes made during an acquisition.  

 All output pulse information is automatically recorded and archived with the 
saved data. 

Set the marker option by clicking in the box to “Create marker when output is 
changed.” 

Set the time stamp option on the global Marker Preferences tab. 

 

The marker label accurately captures pulse data, but the marker arrow may not 
always line up exactly with the leading edge of the pulse; this typically is not a 
problem because the recording will include the actual stimulus pulse which can be 
used for timing measurements. 

Depending on the acquisition Sample Rate, the leading edge of the pulse in the 
recording may not correspond to the exact time the pulse was sent—it may be off by 
as much as one sample period. If the marker precision is critical for your recording, 
increase the Sample Rate. 

To display markers, use the toolbar icon or Display > Show > Markers. 

The Range switch on the front of the BSLSTM stimulator should be set to 10V or 
100V prior to recording and should not be changed during recording; if using a 
Preset, the corresponding Preset should also be selected prior to recording. The pulse 
level can then be determined by moving the decimal to the right or left depending on 
how the range was switched.  

 

ADVANCED TAB (OUTPUT PREFERENCES) 

Advanced Tab 

 

Pulse Width Indicates the Pulse Width setting, which determines the maximum Pulse Rate 
frequency. You may enter a Pulse Width value, unless limited by Preferences. 

The entry is activated when the value is changed and the Tab or Enter key is pressed; 
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it does not require a stimulator restart to take effect. 

The Pulse width entry overrides other entries as required; it is the priority parameter. 

An entry may be automatically changed if any of the following conditions apply, in 
which case the closest possible value will be selected: 

It falls outside the allowable range. 

It is rounded to .01 millisecond increments (MP36R resolution). 

Width has been limited by the Pulse Width: Limit Entry settings of Preferences. 

Allow any entry Pulse width is limited to the output capabilities of the BIOPAC MP device. This 
option allows any entry within the allowable range specified below: 

PULSE WIDTH RANGE MP36R unit    

Range  .050 – 100 milliseconds  

Resolution 10 microseconds  

Lock entry to This entry locks the width to a single, specified value (within the allowable range). No 
other value can be entered. 

Calibration 
adjustment 

MP30 BSLSTM 
only 

The pulse width from the MP30 output connector is very accurate, but the BSLSTM 
hardware may add 0 to 150 microseconds to the pulse width in its internal circuit. 
This value can vary somewhat from unit to unit but mainly depends on the revision of 
the BSLSTM which is determined from the serial number on the back of the unit. To 
adjust for this, the software can subtract a specified amount of time from each 
requested pulse width. 
To determine a calibration adjustment value which will get one very close (within +- 
5%) of the requested pulse width, refer to the following table: 

Serial No. Calibration adjustment value (microseconds). 
<= 308A 5100  70  
 > = 310A 100 0 (default value) 

If you are using an older model manual control (no LED) BSLSTM stimulator, try 
using 110ms—and then contact BIOPAC for a free product upgrade. 
If pulse width accuracy greater than +- 5% is required, calibrate your specific 
BIOPAC BSLSTM stimulator (requires an oscilloscope) and enter a specific 
adjustment time from 0 to 150 microseconds (entries outside this range will be 
clipped). 
Calibration adjustment—MP30 BSLSTM only 
Connect a BNC to BNC cable from the BSLSTM output connector to an oscilloscope 
input.  
Set the “Calibration adjustment: subtract” to “0.” 

Specify a pulse width of .2 ms. 

Send out a stimulus pulse. 
Measure the actual pulse width out of the BSLSTM stimulator with an oscilloscope.  
The Manual Test button on the back of the BSLSTM cannot be used to make the 

oscilloscope measurement. 

Calculate the time required to make the pulse width exactly .2 ms.   
Enter this time, in microseconds (1 ms = 1000 microseconds), into the “Calibration 
adjustment: subtract” entry box. 

Pulse Repetition Indicates the Pulse Repetition period (Hz or ms). 

The Pulse period must be greater than the Pulse width. See  “TBPMIN” in the 
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Output Preference > Advanced Tab Limits table on the next page. 

The full range of acceptable Pulse Rate values is from .2 to 6,667 Hz (MP36R) or .2 
to 6,827 Hz (MP30). 

The maximum Pulse rate (PRPMAX) depends on the Pulse width setting: 

Pulse width 100 ms  maximum Pulse rate = 9 Hz 

Pulse width .020 ms  maximum Pulse rate = 3333 Hz 

The formula for pulse width vs. pulse repetition is PRPMIN = PW + TBPMIN 

Where: PRPMIN = the MINimum Pulse Repetition Period allowed. 
 PW = Pulse Width setting 
 TBPMIN = MINinum Time (in ms) between successive pulses 
       for the output device (see device specifications) 
If “Limit changes from ___ to ____” is selected in Advanced preferences, then 
PRPMAX will be determined by the formula above or the specified limit, whichever 
is greater. 

An entry may be automatically changed: 

If it falls outside the allowable range. 

To round it to .01 Hz increments (resolution of system). 

To make it at least 0.1 millisecond greater than the Pulse width. 

By the Pulse Repetition Rate: Limit entry Preference. 

By the Pulse Repetition: Adjust entry increments Preference. 

You may manually enter any value for pulse width, but when using the scroll bar or 
arrows, entries will be constrained by the “Adjust entry increments” Preference 
setting. 

Pulse Repetition 
Scroll Bar 

The Pulse Repetition Scroll Bar adjusts rate or period by the increment of change and 
limits established in Preferences. With each click of the scroll bar arrows, the rate will 
be increase by the specified increment. 

When “Initiate pulse sequence with ON/OFF button in Control Panel” is selected, 
changes take effect upon release of the scroll box as long as the stimulator is running. 

The scroll bar is disabled when Number of Pulses is set to “Single” or Pulse 
Repetition is set to Lock Entry to...” 

Display as Pulse repetition can be dispalyed as 

Pulse Rate (expressed in Hz), or 

Pulse Period (inverse of Pulse Rate, expressed in milliseconds). 

Pulse Repetition Rate relates to the Pulse Repetition Period as: 

Pulse Rate (Hz) = 1000 / Pulse Period (milliseconds) 
The “Display as” units selection is also used for: 
Pulse repetition entries in the control panel. 
Scroll bar increments. 
The Pulse Repetition Rate: Limit entry Preference. 
The Pulse Repetition: Lock entry Preference. 
The Pulse Repetition: Adjust entry increments Preference. 

When units are changed from Rate in Hertz (Hz) or Period in milliseconds (ms), the limits 
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of the Pulse Repetition range will be converted by the formula: 

Period increment in ms = Round to nearest whole number [Period Range * (Rate 
increment in Hz /Rate Range in Hz)] 

For example, if the Range was 1Hz to 10 Hz with an adjustment increment of 1Hz, 
the proportional calculation would be Period increment = 900 ms (1Hz / 9 Hz) = 100 
ms 

Allow any entry Pulse width is limited to support the output capabilities of the BIOPAC output device. 
See Output Preference > Advanced Tab Limits table for allowable range. 

Limit entry Establishes minimum and maximum values that can be manually entered or changed 
with the scroll bar. 

Lock entry Locks the Repetition to a single, specified value (within the allowable range). No 
other value can be entered in the control panel. 

Adjust entry Controls the scroll bar or scroll arrow increment; does not apply to manual entry. 

 

 
 
 
Advanced Tab Limits Pulses BSLSTM  

Pulse width     

 Range (ms): .050 – 100 .049  – 100  .050 – 100 .049  – 100 

 Resolution (ms): .010 .001953  .010 .001953 

Pulse Repetition     

 Rate range (Hz): .2  – 16,667 .2 – 10,204 .2 -  2,000  .2 – 2,004  

 Period range (ms) .060 – 5,000 .098  - 5,000  .500 – 5,000 .499 – 5,000  

 TBPMIN Minimum time  

 between Pulses  (ms): 

.010 .049 .450 .450 

 Resolution (ms): .010 .001953 .010 .001953 

Initial Pulse Delay     

 Time range (ms): 0 – 100 0 or .5 - 100  0 – 100 0 or .5 - 100 

 Resolution (ms): .010 .001953 .010 .001953 
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About Level 

 

The Low Voltage Stimulator allows the software to specify the pulse amplitude.  
The amplitude can be set to any value within the limits of the stimulator; the range 
is -10 to +10 Volts. 

Pulse Level 

Low Voltage only 

 

The Level entry box allows the user to 
manually enter any value within the limits 
of the system or within the limits of the 
Preference settings from the Level tab. 
 
The Level entry box will be inactive 
(grayed) if: 
The Level preference “Lock entry to” is 
active. 
If “Initiate pulse sequence with Recording” is active (from the General tab) and a 
pulse sequence is in progress or “wait for trigger” is in progress. 
Use the entry box or the scroll bar to set the Pulse level. When a value is entered 
which is out of range, the value will be rounded to the closest value obtainable 
after the “Enter” or “Tab” key is pressed. 
If “Initiate pulse sequence with ON/OFF button in control panel” is active (from 
the General tab), then values entered during a pulse sequence will take place 
immediately. 
If “Initiate pulse sequence with Recording” is active (from the General tab), any 
entry made between acquisitions will take place on the next “Start” of acquisition. 

Allow any entry The level is limited from -10 to +10 V to support the output capabilities of the 
stimulator. This option allows any entry within that range.  

Limit entry This entry reduces the range (within the -10 to +10 V range limit). 

Lock entry This entry locks the level to a single specified value (between -10 and +10 V). 

Adjust entry This setting affects the scroll bar or scroll arrow increment only; it does not apply 
to manual entry. 

The smallest increment is 5 mV, as limited by the MP36R. The specified 
increment is used to round manual entries to the closest obtainable value. 

REFERENCES TAB (OUTPUT PREFERENCES) 

Reference Channel 

SS58L only 

 

 
This option allows you to “Monitor” the output signal on one of the analog or 
digital input channels without making any physical connections. This is an 
internal, hardware/firmware, feature that recreates the output signal and allows 
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recording in “real time.” The assigned reference channel will override any “real” 
input signal. 
For example, if a transducer is connected to CH 1, and CH1 is chosen as the 
reference channel, then the signal coming from the transducer will not be 
viewable, and will not conflict with the reference signal generated internally. 
The reference signal is not the real signal, but is a very accurate “estimate” of the 
real signal. The pulse timing accuracy will be within 100 microseconds. If an 
analog input channel is used as the reference channel, the pulse level will be 
accurate within 5%. If the SS58L encounters a load that reduces or distorts the 
pulse output, the reference signal will not reflect this amplitude distortion. 
If a digital input channel is used as the reference channel, only a digital 
representation of the pulse will be generated. In other word, regardless of the 
pulse level, when no pulse is occurring, the level will be 0 Volts, and when the 
pulse is occuring, its level will be shown as +5 Volts. 

Channel Assignment Use the pull-down menu to choose which analog or digital input channel will be 
used as the output reference channel. 

When a new reference channel is assigned, a warning will be generated to alert 
you that this setting will overwrite the existing Channel Setup parameters for the 
selected channel. 

 

For example, if you set up CH1 for ECG data and then select CH1 for the 
Reference Channel, your ECG parameters will be replaced. If you then select 
another channel, CH1 will be restablished with the default analog input 
parameters, and you would need to recreate your ECG settings (by using Presets 
or manual entry). 

The reference Channel label should read: “Low Voltage Stimulator - Reference 
Out”. 

When an Analog Input Channel is assigned as the Reference channel, that 
channel, as viewed from the MP UNIT > Set up Channels dialog, will be in a 
“Lock-Out” mode. This means that the Preset pull-down menu icon for that 
channel will be grayed (inactive). The assigned reference channel will be inactive 
for “real” inputs until the Reference Channel Preference is changed to “None” or 
another channel. The wrench button, when pressed for the Reference channel, will 
still allow viewing of the channel parameters, but all entry boxes and pull-down 
menus will be inactive. 

When a “Low Voltage Stimulator” control panel using an assigned Reference 
channel is closed, the channel that was assigned as the reference channel will be 
removed from “Lock-Out” and will automatically change to the default, “CH X 
Input” settings. The reference channel assignment will be saved in the template or 
data file, so that if the “Low Voltage Stimulator” control panel is reopened, the 
reference channel will be automatically re-assigned, without any warning prompt 
given. 

Generate using You can specify how the Reference signal should be shown. 

If using analog input from CH1 - CH4, you may select actual or fixed (max) 
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amplitude and actual pulse or fixed pulse width. Fixed pulse widths are useful 
when the pulse width is much smaller than the sample interval (1/sample rate) 
being used. 

For example, for Frog muscle stimulation, you may choose to use a 1 ms pulse 
width, but a sample rate of 200 samples/sec. to capture the muscle response. At 
this sample rate, the stimulus pulse could not be reliably recorded. By extending 
the displayed pulse width to 100 ms, you will be guaranteed to always record the 
stimulus pulse. 

If using digital input from D1 - D8, select actual or fixed (15ms) pulse width. 
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HUMAN SUBJECT SAFETY 
Before using the stimulator on human subjects, it is very important to limit the energy 
the stimulator outputs. For optimal safety: 
Before powering on the BSLSTM stimulator, set the voltage level to zero by rotating 
the LEVEL knob on the front of the BSLSTM fully counterclockwise. 
Use BIOPAC HSTM Series Probes. You MUST use these probes order to limit the 
energy the stimulator can output. 
Never create an electrical path across the heart. 
Never use on subjects with pacemakers. 
Read this manual and the BSL Hardware Guide to become familiar with Stimulator 
operation. 

Connect the BSLSTM Stimulator to the MP UNIT and power on both units. (For instructions on how to 
connect the BSLSTM to the MP UNIT Acquisition Unit, refer to the BSL Hardware Guide.) 

Connect the Stimulator Trigger cable to the Analog Out port of the back of the MP UNIT. 

Connect the Stimulator Reference Output cable to an Input Channel on the front of the MP UNIT. This 
channel will be set up in Step 3 as the Stimulator Reference Channel. 

The Reference pulse has a fixed Pulse width of 15 milliseconds, so chosen so that the Sample Rate of the 
recording may be as low as 100 samples/second and still capture the Reference pulse. 

Before powering on the BSLSTM stimulator, set the voltage level to zero by rotating the LEVEL knob on the 
front of the BSLSTM counterclockwise all the way to the left. 

Launch AcqKnowledge software to a new data acquisition window. 

Confirm that Markers are activated. 

Markers are activated by default. If not activated for a given recording, choose Display >  Show > Markers. 

Set up the Stimulator Reference Channel. This is the Analog 
Input Channel on the front of the MP UNIT that receives the 
Stimulator Reference Output cable from the back of the 
BSLSTM. 

Choose MP UNIT > Set up Channels. This will generate a Set up 
Channels dialog. 

Select the Acquire, Plot and Enable options for the analog 
channel to be set up as the Stimulator Reference Channel. 

Click Presets and scroll to select “Stimulator (0-10V)” or 
“Stimulator (0-100V)” to match the Range switch setting on front 
of the BSLSTM. 

Click View/Change Parameters. This will generate an Input 
Channel Parameters dialog. 

Read the entire Stimulator section of this manual and familiarize yourself with the unit and its options before 
changing any preset parameters. 

You may set the Gain and other input parameters as desired. 

Click OK to accept the parameters.  

Close the Set up Channels window.  

 

Adjust the voltage output of the stimulator by using the Level control on the front of the BSLSTM. 
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Rotate the Level knob clockwise to increase and counterclockwise to decrease, reading the voltage in the 
BSLSTM’s digital display. 

Stimulator Safety Features 

The stimulator cannot operate unless its Output Control panel is open. 

The Pulse ON/OFF Switch on the Stimulator Output Control panel must be OFF in order to open and 
configure Stimulator Preferences. 

If the Stimulator Output Control panel (or the AcqKnowledge application) is closed in the middle of a pulse 
train while the stimulator is running, the stimulator will shut down and the pulses will stop. 
If another data acquisition window is activated, the stimulator will stop and remain OFF unless restarted using 
the parameters associated with the new data window. The only exception is that if the stimulator is ON and 
the data window corresponding to current stimulator parameters is acquiring data, then the stimulator will 
continue to run until the end of the acquisition. 
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Chapter 11  Set Up Event Hotkeys 
Events (Markers) 

  

 

Event Toolbar Event Insertion Event Control 

Event (Marker) Overview 

For detailed analysis, it can be useful for waveforms to have extra information associated with them. This 
information might include waveform boundaries from ECG analyzers, spike classifications from a spike 
sorter, heartbeat classification from a PhysioBank file, or even detailed user notes. AcqKnowledge 4 uses 
“event” functionality to store and manage this information. 

An event is a piece of information associated with a specific time in a waveform. An event can capture points 
of interest within a file (i.e. subject moved, dose added) or on a particular channel (i.e. T-wave onset). Once 
events are marked in the file, AcqKnowledge can use the event information for analysis, including 
measurement (page 1220) and cycle detection (page 1308). 

 An event has the following pieces of information associated with it: 

o Event type 

o Sample location: the time position in hardware samples where the event is defined. 

o Channel: the channel for which the event is relevant. 

o Some events, such as the time of the start of an appended segment, may be relevant to all of 
the channels of a graph—these are “Global” events. 

o Label: a string of text that can be entered either automatically or by the user to provide more 
information about an event. Labels can be fixed or sequential in AcqKnowledge 4.2 and up. 

 Different event types can be entered automatically or manually. These different event types allow 
events to be filtered and also support analysis routines that key off of these events. 

o Event insertion tool 

o Set Up Manual Event Hotkeys (see page 12210) to manually insert events during acquisitions 

o Copy/paste measurements and Copy/paste wave data operations can insert events at the 
selection boundaries; choose “Mark with events” under Preferences (see page 1209) 

o Cycle Detector Output Events option (see page 1308) 

o Contextual menu in Event region 

 
o Specialized Analysis (see page 331) to automatically insert markers according to complex 

analysis algorithms 
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Event Toolbar 

 
The event toolbar displays global events and provides a quick editing area for event descriptions. The right 
button toggles visibility of the Event Palette for detailed control (see page 1211). The palette will “refresh” 
when events change the event configuration, such as horizontal scrolling, scale changes, changes in the 
selected event via clicking in the graph window, editing of the event label by using the event bar, 
transformations that define new events for the graph, waveform editing operations, and additions of new 
events by clicking the event bar at the top of the graph window. 

 

Event Tooltips 

If events are being displayed within the plotting area and tooltips are enabled, a tooltip will be associated with 
every event in the plotting area. The tooltip includes the event type description, the user-defined label (if 
present), the time location of the event, and the amplitude of the waveform at the event location. While this 
information can be drawn directly on the graph, event tooltips assist in browsing event information when the 
screen becomes too crowded and there is not enough room to display all of the times, amplitudes, and labels. 

Event tooltips are displayed under the event icon. 

 If the event is being plotted directly on the waveform, this will be the point on the waveform 
associated with the event. 

 If there is an indicator and the event icon is at the top of the indicator, the tooltip will be anchored at 
the top of the indicator. 

 If the events are being plotted at the top of each track, the tooltip is anchored at the top of the plotting 
area directly underneath the event icon. 

Event tooltips will not be displayed if tooltips are disabled, if events are only being displayed in the marker 
bar at the top of the screen, if X/Y mode is in use, or if events are not currently visible. 
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Preferences  > Event Summary and Waveform 

Use the “Event Summary” section of the Preferences dialog to set options for pasting summaries of events 
into the journal. (Preferences shown above and losted below are from AcqKnowledge 4.2) 

 Group events 

Sorted by type sorted by event type descriptions first 

Sorted by channel grouped based upon where they are defined (Global events appear first, 
followed by groups for each individual channel). 

 Sort Grouped events 

Sorted by time sorted in order by increasing time 

Sorted by label sorted alphabetically by label 

 Include only events visible on the screen 

Determine if the summary is generated for all of the events that are in a graph, or only for those 
events that are currently visible on the screen. If there are thousands of events in a file, this feature 
allows the list to be pared down to those of interest. 

Event summary options will be saved with the graph if the graph has a graph journal, and can be pasted into 
the journal using “Summary in Journal” Event Palette Actions command (see page 1214). 

Other event preferences are available under Preferences > Waveforms 

 Mark waveform edits with events 

 Mark selection with events in graph—create events at data selection bounds. This includes 
selection events (selection begin and selection end) for global events when measurements or 
waveform data are pasted. When selected, measurement pasting will result in an automatic 
execution of the “Mark Selection” feature manually accessible from the Event Palette. 

 Include time value— include the time value (relative to start = 0) for the paste. 

 Include timestamp—Include time and date stamps for when the paste ocurred; this timestamp will 
match any timestamp pasted into the journal. When selected, any selection events added to the 
graph will have their labels set to match the timestamp. 

 Auto-paste results in independent journal (Preferences > Journal)—Selection events and time 
stamp events can be automatically inserted to an independent Journal. 

Combine these options to retain enough information to reproduce measurement results and correlate 
measurement results with specific areas of the graph; this helps verify the accuracy of measurement results 
made through manually constructed graph selections. 

Any change to these settings will be retained within a saved graph file and will become the default for newly 
constructed graphs. 
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Event Hotkey Setup 

 

Events of different types 
can be inserted during 
acquisition, whether or 
not events are visible in 
the graph. When a hotkey 
is pressed during 
acquisition, an event will 
be inserted into the graph 
at the end of the most 
recently acquired data. 
Each hotkey can have a 
different configuration, 
adjustable through a 
dialog accessible via the 
“MP150 > Set Up Manual 
Event Insertion 
Hotkeys...” menu item.  

Hotkey Assign Escape or F1 through F9. When a different hotkey is chosen, the other controls of the 
dialog change to reflect the configuration of the new hotkey. 

Event type Lists the standard hierarchical menu of available event types; Types are detailed on page 1215. 
Choosing a new type from the pull-down menu will change the type of event inserted when 
the hotkey is pressed during acquisitions. 

Channel Contains a “Global” entry and all of the channels (analog, digital, or calculation) set to 
“Acquire” in Set Up Channels. 

 “Global” will define global events drawn in the event bar above the graph data 

 Choosing a new channel from this menu will cause events to be inserted on the 
appropriate channel of the graph when the hotkey is pressed. 

Label Edit field for label text and toggle optional inclusion of time stamp and/or date stamp. Stamps 
correspond to the time of the system clock when the key was pressed, that is, the time of the 
event insertion in “real clock time.” 

 Fixed - Provides a fixed label from text entered into the label field to the right. This label 
is used every time the assigned hotkey is pressed. (AcqKnowledge 4.2 and higher) 

  Sequential - Labels for events will iterate sequentially through the entries in the table 
index when the assigned hotkey(s) is pressed. The area under ‘Label’ is editable for 
entering text. (AcqKnowledge 4.2 and higher) 

Additional Controls Function 
Add Adds an editable label field to the list.  
Rename Allows renaming of the existing segment label. 
Delete Deletes a selected custom label. 
Delete All Deletes all custom labels. 
Up Incrementally moves a selected label up the list. 
Down Incrementally moves a label down the list. 
Top Moves a selected label to the top of the list. 
Bottom Moves a selected label to the bottom of the list. 
Include time Adds timestamp to labels when checked 
Include date Adds current date to labels when checked 
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The event palette is a floating window that 
provides a quick summary of events for the 
top most graph and can used to examine, 
search, and modify events. Events can be 
extracted in a time range for a specific 
event type and specific channels. 

There is only one visible event palette for 
the entire application. The palette consists 
of four sections: event list, selected event, 
display, and event actions. Each section 
can be shown or hidden by toggling the 
disclosure button next to its title. 

 Event List, see page 1211. 

 Selected event, see page 1212.XX 

 Display, see page 1212. 

 Actions, see page 1214. 

o See the Event Journal 
Summary enhancements. 

Event List 

 

The event list provides an expandable, scrollable, 
hierarchical view of the events in the topmost graph. 
Events are grouped by their channel on the top level. 

The event list has three columns of information: 

 Events: the readable type for each event 

 Location (Time): the time location for each event 

 Label: the user defined description for the event. 

Sort the contents in ascending or descending order on each column by clicking the column header. Events and 
Description will sort in standard alphabetical order, Location will sort based on the numerical sample location 
of each event. 

Select a single event from the event list by clicking on a single event. The event will be selected in the graph 
window and made visible if it is not currently displayed. 

List visible events only toggles the checkbox to switch between the two display modes. 

 When enabled, the event list will display only those events that are being displayed on the plotted 
portions of the graph. As the user navigates through the graph with the scrollbars, horizontal scale, or 
other means of changing the amount of visible data, the event list will continually refresh to contain the 
new set of visible events. 

 When disabled, the event list will display all of the events for the entire graph. This can allow for easier 
navigation through graphs with hundreds of events, such as PhysioBank files. 
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Selected Event 

 

 

 

Event type options are 
detailed on page 1215. 

When a single event is selected, the type, channel (or “General” for global events), user-defined label, and 
location of the event will be filled in and can be edited. The controls can display information about only one 
event at a time; if no event is selected, the controls will be grayed out. 

Event Location 

“Location defines the position where the selected event occurs, relative to the first sample in the file. To 
change the location of an event, change the position entered in the Location box. Precision matches the 
horizontal axis setting. 

Events may also be repositioned using the mouse. Option-click the event icon in the graph and hold down the 
mouse while dragging; the event will be repositioned at the horizontal position where the mouse button is 
released. 

 

Display 

  
 Event display location Event display detail 

Display controls determine the location and detail of events to be drawn in the frontmost graph. 

 Location—Choose one of the five display methods (described on page 1213). 

 Detail—the three checkboxes to establish how much information to include with events. 

 Indicator length—Set the slider to shorten or lengthen the indicator line. This option is only active if 
the display mode is “On waveform, with indicator” or “At top, with indicator.” 

 Font – Align – Selects font style and alignment of Event labels. 

 Angle – Determines the angle in degrees that the Event text can be displayed in the graph. Value can 
be positive or negative. 
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Location & Display Description 

In event bar 

 

Event icons are displayed in the global marker bar located on top of the plot area in the 
graph window. This does not allow for distinguishing what channel a specific event 
belongs to. 

 To select the event, click the icon in the marker bar. 

On waveform 

 

Event icons are displayed above or below the actual sample in the source channel 
corresponding to the location of the event. 

 To select the event, click the event icon on top of the waveform. 

Top of plot 

 

Event icons are displayed at the top of the channel track, either on top of the grid or in 
a channel-specific marker bar. 

 To select the event, click the icon at the top of the channel track. 

On waveform, with 
indicators 

 

Event icons are displayed above the data with a vertical line of configurable length 
running through the data sample of the source channel at the event’s location. 

 To select the event, click the event icon or the indicator line. 

Top of plot, with 
indicators 

 
 

Event icons are displayed at the top of the channel track with a vertical line of 
configurable length running through the data sample of the source channel at the 
event’s location. 

 To select the event, click the event icon or the indicator line. 

Detail When an event is being plotted within a graph, either on the top of a channel or 
floating above the data, the event's location, description, and amplitude of the 
waveform at that location can optionally be displayed along with the event icon. 
Plotting of additional information can be used for graphical annotations on the data 
and for clarifying event location for hardcopy or presentation. 
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Actions 

 

Actions Button Description 

Find It is easy to create many more events then one can easily scroll through and locate 
in a list. Find controls the automatic location of events based on established search 
criteria. 
Click the Find button to generate the Event search criteria dialog, and then 
combine or restrict information to define desired events: event type, specific 
channel location, or label search. 

Click “Find First” to search for the first event in the graph that matches the 
criteria. If found, the event will be selected and made visible in the graph window. 

Find Next Finds the next single event that matches the established search criteria until no 
remaining events match the search criteria. 

Cut Selected Event Active only when an event is selected, removes the selected event from the graph. 

Clear 
Clear all 

Generates a search criteria dialog (identical to the Find dialog) and removes all 
matching events from the graph. 

Summarize in 
Journal 

Displays a dialog with controls that affect which events are included in the 
summary. 

Events can be filtered by visibility on the screen. Creates a textual summary of all 
of the events in the journal. 

 See “Event Preferences” on page 1209 for more information about 
modifications to the traditional marker summary. 

Event Journal Summary Enhancements 

 
Events to be included in the summary can be filtered using the same criteria as 
Find... in the Event Palette. By adding the ability to summarize only events 
matching specific criteria, textual reports of arrhythmias or other infrequently 
occuring events of interest can be generated with ease. 

When “Summarize in Journal” is clicked on the event palette, a dialog will be 
displayed with controls that affect which events are included in the summary. 

If there is no journal for the current graph, you will be prompted to create a 
journal. 
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Mark Selection Defines two new Global events in the graph at the precise time locations of the 
currently selected area (the highlighted wave data section). If there is no selection 
in the graph, this button has no effect. The events that are inserted will have the 
“Selection Begin” and “Selection End” event types. 

Restore from 
Snapshot 

Enables deleted events to be restored from events present in a Data Snapshot.  
This option becomes active only if a Data Snapshot of the main graph is 
displayed. The following prompt will be displayed when Restore from Snapshot is 
selected. 

 

Event Type Options 

Event Types are pre-defined options for assigning event information. The Event Type is for marking purposes 
only and does not imply any analysis has or will occur for the event (unless Specialized Analysis was 
performed, see page 331). 

Once Event Types are defined, some analysis functions can be automated, including measurement (page 1220) 
and cycle detection (page 1308). 

Event classifications: 

 

Event classifications group similar event types together into a logical category. 
Event classifications present event types in a hierarchical fashion and allow other 
event classifications to be contained within them. 

For example, the “Hemodynamic”event classification includes a “Beats” sub-
class with pre-ventricular contraction and escape beat event types. 

Event type Classification 

Global This is the same as ‘untyped’ markers from AcqKnowledge 3.6 or earlier. Unrecognized event 
types will be classified as global events. 

Append Automatically inserted by the program on append operations.  Custom Append labels can be 
created in MP150 > Set Up Segment Labels. (See page 225.) 

Notes Annotation event to add notes on the data. 

User-defined Hotkey insertion for user-specific events; 9 types can be inserted via the keyboard during 
acquisition. 

Pharmacology Basic pharmacological events: baseline, washing, and dosing. 

Waveform Edits Automatically inserted by the program on cut or paste operations in a graph file. The description 
consists of the edit operation performed and a timestamp. 

Insertion of waveform edit events is off by default, but can be turned on for GLP purposes. 

Selections Used to mark boundaries of selected areas. 
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Classification Pre-defined Event Type Options 

Default “Esc” key inserts global event. 

General Waveform onset or end Maximum and minimun 

Change in signal quality or rhythm Reset  

Recovery Append 

Hemodynamic 

 >  Beats 

Normal Nodal premature 

Paced Supraventricular premature 

Fusion of paced and normal Premature ventricular contraction 

Unclassifiable R-on-T premature ventricular contraction 

Left bundle branch block Fusion of ventricular and normal 

Right bundle branch block Atrial escape 

Bundle branch block Nodal escape 

Atrial premature Supraventricular escape 

Aberrated atrial premature Ventricular escape 

Hemodynamic 

 >  Blood Pressure 

Systole End diastolic pressure 

Diastole 

Hemodynamic 
 >  ECG Complexes 

 

QRS onset, peak, and end U-wave peak 

T-wave onset, peak, and end PQ junction 

P-wave onset, peak, and end J-point 

Q-wave peak ST segment change 

S-wave peak T-wave change 

Hemodynamic 

 >  Impedance 

A-point  O-point 

B-point  X-point 

C-point Y-point 

Hemodynamic 

 >  Monophasic AP 

Plateau Upstroke 

Hemodynamic 
 >  Other 

Start of ventricular flutter Pacemaker artifact 

Ventricular flutter wave Isolated QRS-like artifact 

End of ventricular flutter Non-conducted P wave 

Notes Arrow—short, medium, or long Star 

Flag 

Pharmacology Baseline Wash 

Dose 

User-defined User Type 1-9 

Waveform Edits Cut Paste end 

Paste begin  

Selections Selection begin Selection end 
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Event Measurements  

Measurements are a quick way to extract information from a graph. Three measurements extract information 
from events. When combined with the Cycle/Peak Detector (page 1308), they are also powerful data reduction 
tools. These event measurements can provide quick summaries of event information, compute mean intervals 
between event types, and detail other operations. 

 evt_ampl Event Amplitude Measurement (see below) 

 evt_count Event Count Measurement (see page 1218) 

 evt_loc Event Location Measurement (see page 1218) 

 

Event Amplitude Measurement 

 

evt_amp Extracts measurement results where events 
are defined. Note that the amplitude is always taken from 
the measurement channel, which may be different from the 
channel on which the events are defined. Useful for 
extracting information such as the average T wave height 
within the selected interval. The measurement result is 
displayed without units (matching Value and other 
amplitude events). 

Select Event Amplitude or click the measurement info 
button to generate the settings dialog. 

Event Type Determines the type of events that will be processed; Types are detailed on page 1215. 

Location Determines where the processed events need to be defined. The menu options are: 

 Measurement channel only—Only extracts amplitude values for events that are defined on 
the channel specified in the measurement channel pull-down menu. Global events and other 
channel events are not included. 

 Global events only—Only extracts amplitude values for events that are defined as global 
events appearing in the marker bar; changing the measurement channel will not affect the 
measurement result. Channel events are not included. 

 Anywhere—Extracts amplitude values for events defined on any channel and also global 
events; changing the measurement channel will not affect the result 

Extract Determines what processing will be performed on the amplitude values extracted from events 
that match the Type and Location settings. The processing options are: 

 Amplitude at first event only—The value of the measurement channel at the time of the 
first matching event in the selected area. 

 Amplitude at last event only—The value of the measurement channel at the time of the 
final matching event in the selected area. 

 Sum of amplitudes at all events—Computes the sum of the value of the measurement 
channel from each matching event within the selected area. 

 Mean amplitude from all events—Computes the average amplitude value of the 
measurement channel from all of the event locations within the selected area. 

 Minimum amplitude from all events  

 Maximum amplitude from all events  

If there are no matching events of the selected type in the selection, the measurement result will be zero. 
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Event Count Measurement 

 

evt_count Evaluates the number of events within the 
selected area. The measurement result is unitless. 

Select Event Count or click the measurement info button to 
generate the settings dialog. 

Event Type Determines the type of events that will be counted; Types are detailed on page 1215. 

Location Determines where the counted events need to be defined: the pull-down menu options are: 

 Measurement channel only—Only includes events that are defined on the channel 
specified in the measurement channel pull-down menu; global events and other channel 
events are not included. 

 Global events only—Only includes events that are defined as global events appearing in 
the marker bar; channel events are not included. Changing the measurement channel will 
not affect the measurement result. 

 Anywhere—Includes events defined on any channel and also global events. Changing the 
measurement channel will not affect the measurement result. 

If there are no matching events of the selected type in the selection, the measurement result will be zero. 

 

Event Location Measurement 

 

evt_loc Extracts information about the times of events. 
The measurement result will take on the units of the 
horizontal axis; if specific units were set for time or 
frequency via Preferences, those units will be used. 

Select Event Location or click the measurement info button 
to generate the settings dialog. 

Event Type Determines the type of events that will be processed; Types are detailed on page 1215. 

Location Determines where the processed events need to be defined. The menu options are: 

 Measurement channel only—Only extracts the time of events that are defined on the 
channel specified in the measurement channel pull-down menu; global events and other 
channel events are not included. 

 Global events only—Only extracts the time of events that are defined as global events 
appearing in the marker bar; channel events are not included. Changing the measurement 
channel will not affect the measurement result. 

 Anywhere—Extracts the time of events defined on any channel and also global events. 
Changing the measurement channel will not affect the measurement result 

Extract Determines what will be extracted from events that match the Type and Location settings: 

 First event location only—The measurement will equal the time at which the first matching 
event in the selected area is defined. 

 Last event location only—The measurement will equal the time at which the final event 
within the selected area is defined. 

 Sum of all event locations—The times at which all matching events are defined are added 
together to produce the measurement result. This sum of times can be combined with Event 
Count measurements to compute average intervals over the selected area. 

If there are no matching events of the selected type in the selection, the measurement result will be zero. 
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Printing Events 

When a graph is printed and events are displayed onscreen for the graph, event icons will print as they are 
displayed. Event icons will be scaled, depending on the printer's DPI, to be proportional to the vertical scale 
plotted on the screen. If events are located at linearly interpolated positions, event icons will be dimmed on 
the printout (see the Variable Sample Rate section). 

Event display 
setting 

Printed result 

Global events Global events are drawn above and outside of the data plotting rectangle in the 
printout. If the event labels are close together, their alignment will be staggered 
to show separate lines of label text. (AcqKnowledge 4.2 and higher) 

In event bar All events are drawn above the data area of the printout. Only labels may be 
drawn with the events. 

Top of plot or 

Top of plot, with 
indicator 

Channel-specific events are drawn at the top edge of their channel’s track. No 
indicator lines are drawn. Depending on the display settings of the graph, the 
event label, amplitude of waveform at the event location, and Time of the event 
may be printed below the event icon  

On waveform or 

On waveform, with 
indicator 

Channel-specific events are drawn immediately above the position of the 
waveform sample at their location and will appear to be printed immediately 
above the data of the waveform. No indicator lines are drawn. The vertical 
printing position of an event icon will be identical for “On waveform” and “On 
waveform, with indicator” displays. Depending on the display settings of the 
graph, the event label, amplitude of the waveform at the event location, and time 
of the event may be printed above the event icon. 

“Draw vertical divider at event locations” option in the Print Setup dialog. 

 Enabled: draws a dashed vertical line at the precise time location of each event. Vertical divider lines for 
the event type will extend  

Global Through all channels of data 

In event bar Through all channels of data 

Top of plot From the top to the bottom of the relevant channel track 

On waveform From the top to the bottom of the relevant channel track 

 Disabled: prints only the event icon, label, amplitude, and time. No indicator lines will be printed for the 
event display. The vertical divider can be used in place of indicator line drawing. 

 

Event Selection 

Individual events can be selected according to click locations.  

When an event is selected, the event icon will be drawn based on the graphic type: 

 Specific “selected” graphic—the selected graphic is drawn or if none, an inverted global graphic. 

 No associated graphics—the global event graphic will be used. 

 

Events and Graph Selections 

When an event on a waveform plot occurs within a selected area of the graph, the event icon and indicator 
line (if present) will be inverted along with the grid, background, and wavedata. Event types that don't have a 
selected graphic will appear as global events if the events are selected events and they are contained in an I-
beam selection. 
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Events and Waveform Editing 

Waveform editing will adjust event locations for channel-specific events. Waveform editing will never alter 
the time values for Global events (not associated with any specific channel, such as append events). 

Copy  When a portion of a waveform is copied the channel events will also be copied to the clipboard.  

Cut When a portion of a waveform is cut, any channel events within that selected area will be removed 
and channel events to the right of the removed area will be shifted to the left. 

 If waveform editing event insertion is active, a waveform edit event will be inserted at the 
location of the edit operation indicating a “Cut” operation in its description. 

Paste When the waveform is pasted from the clipboard, the channel events will appear at their same 
locations and any channel events to the right of the end of the pasted segment will be shifted by the 
length of the pasted segment. 

 If waveform event insertion is active, a waveform event marker will be inserted at the beginning 
and at the end of the pasted segment. 

Constructing Graph Selections from Events 

Graph selections can be defined from events (in addition to the I-beam tool). Holding down the 
Command/Open-Apple key while double-clicking an event icon in the graph window will place a cursor at 
the event location; this is a zero-width selection, equivalent to single-clicking with the I-beam tool without 
dragging. 

 To create a graph selection from events, hold down the Command key and select an event by clicking on 
the event icon in the graph window or its entry in the event list. 

 To align the boundaries of the graph selection with the time of the previously selected event location and 
the time of the newly selected event, hold the Command key when selecting the new event. 

 To make a graph selection match the time between two events, clickce to select the first event, hold down 
the Command key, click again to select the second event. On this second click, the selected area of the 
graph will change to align with the two events. 

Event Plotting and Variable Sampling Rate 

Event positions are defined in terms of the hardware sampling rate. The Variable Sampling Rate feature can 
generate waveforms with a sampling rate lower than the hardware sampling rate. Through explicit event 
definition, waveform downsampling, or other operations, events on a downsampled channel may not align 
with an actual waveform sample, but rather occur at a hardware sample position in between waveform 
samples. These events will be drawn using linear interpolation when applicable, and only if the waveform is 
being drawn in line plot mode. In step plot and dot plot modes, regular event drawing routines will be used 
with the vertical position and amplitude of the nearest waveform sample to the event’s left. 

When an event is to be drawn on an intermediate position on a waveform, the linearly interpolated value will 
be calculated for the hardware sample location. The interpolated value will be derived from the closest 
waveform sample to the left and to the right. The vertical position on the waveform of the marker and 
indicator line will match the vertical position of the linearly interpolated sample amplitude. This will place it 
immediately above the line connecting the two waveform samples on screen. 

If an event is being drawn using linear interpolation 

 Event icons will be dimmed, regardless of their display position (on waveform or top of the plot). 

 Indicator lines will be drawn on the waveform at a linearly interpolated position and the indicator line will 
be a gray dashed line instead of a solid black line. (Indicator lines are never printed.) 

 Amplitude labels, if included with the event, will correspond to the linearly interpolated amplitude at the 
event location and the linearly interpolated amplitude will be drawn in italicized text. 
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Chapter 12  Other MP menu Commands 
 

BioHarness™ users should see the BioHarness User Guide available under 
the Help menu and installed to the User Support folder in the program folder. 

 

Show Input Values 

             
The Show Input Values option of the MP menu generates an Input Values window, which displays channel 
values in real time, whether an acquisition is in progress or not—which allows you to display values prior to 
or after an acquisition.  

The Input Values display can be set to numeric, horizontal or vertical bar graph format, and it can be resized 
and moved to any position on the screen. To set the display mode, use the “Mode” menu generated via the 
“Options” button.  

Note The Input Values window only displays values for channels that were Set Up with the “Values” box 
checked (see page 12105 for more information). 

Hold Regardless of the display options selected, the display can be “frozen” at any point in time by 
clicking the the Hold button. Clicking this icon will hold the values at their level(s) when the 
icon was pressed. The window will remain frozen until the icon is clicked again. Once the 
values are “unfrozen,” the values will return to the standard real time display mode. 

Options  

 

 

Mode controls the format of the values display. 

 Numeric Values—displays the voltages of the appropriate channels numerically. 

 Bars: Horizontal bars or Vertical bars—the range of values of the bar graphs 
corresponds to the range for that channel in the graph window. To see the bar “bounce” 
less for a particular channel, increase the units per division; to fill more of the window 
space, decrease the units per division in the graph window.  

Font and Size determine text display from fonts installed on your computer 

Precision controls the total number of digits displayed. 

Show controls the amount and type of information displayed regarding each channel. Click in 
the box next to each option to activate it. 

 Channel Numbers will display the channel numbers (A1 for the first analog 
channel, for example). 

 Units will display the units for each channel (as indicated in the main graph 
window). By default, each channel’s display units are scaled in terms of Volts, 
but this can be changed by clicking in the amplitude scale units area in the graph 
window. 

 Labels will display the channel labels (ECG 1, Respiration, etc.) along with the 
input values. This feature is especially useful when values from multiple 
channels are being displayed simultaneously. 

 Min/Max will display the range of values associated with the data. This range 
corresponds to the upper and lower display limits for each channel as it appears 
in the graph window. 

 Values will display number values along with the horizontal or vertical bar chart. 
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Manual Control 

 
STM100 option 

The Manual Control dialog allows you to monitor and/or output pulses through the digital input/output (I/O) 
channels, as well as manually set the magnitude of the signal on either of the analog output channels. The 
digital outputs in Manual Control cannot be used to trigger an online Averaging acquisition. 

Stimulator Usage Note 

Use Manual Control to specify the stimulation output level  

a. If the wide range of waveform output options available in the Stimulator Setup dialog 
cannot match your specifications.  

b. For pre-stimulation and post-stimulation. 

See page 1174 for important Analog Output details 

The 16 digital channels are sectioned off into two blocks, with the first block consisting of I/O channels 0 
through 7, and the second block consists of I/O 8 through 15. 

 All the channels within a given block are programmed together and can be set as either inputs or 
outputs. 

 The two blocks can be set independently. 

o In other words, the lower block can be set to input data while the upper block outputs data. 
You can set channels in the lower block to either read in data or do nothing (as opposed to 
outputting data) while channels in the upper block either output data or do nothing (as 
opposed to reading data). 

To read incoming values for a given block of digital channels, click the Input button below the row of 
channels for which you wish to have input values displayed. This enables a block of digital channels to 
receive incoming data. To read the values for the entire block simultaneously, click the Read button to the left 
of the channel boxes for that block. Since these are digital channels, the values on the individual channel 
boxes will toggle between 0 and 1. 

 When AcqKnowledge is launched, values for digital channels #0-7 always read "0" and  #8-15 always 
read "1" to allow for compatibility with the STM100C module, which utilizes the lower eight digital 
lines for attenuation control. 

When Read Continuously is enabled (below the Input button), the values will be read in real time. When 
unchecked, the displayed values correspond to the values for that block of channels as of the last time the 
Read button was depressed. This mode provides much the same information as the Show Input Values mode. 

To output values for a given channel, the block containing that channel must first be enabled to output data. 
To do this, click the bar below the channel boxes so the button reads “Output.” You can then program the 
individual channels within that block. These channels will toggle between 0 and 1, with a 0 corresponding to 
zero Volts and a 1 corresponding to + 5 Volts. To output a digital 1 on I/O channel 3, the dialog would be 
setup as shown above. 
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The function buttons toggle as follows: 

Input toggles to Output When Input is selected, the checkbox is “Read continuously.” 

Set toggles to Read When Output is selected, the checkbox is “Set immediately.” 

To output a signal on Channel 3, click the Set button to the left of the channel box. If the Set immediately box 
is checked, the signal will be output when the channel button is clicked. 

IMPORTANT 

Potential use conflicts can arise between the parameters set in the Manual Control window 
and those set for digital channels in the Set Up Channels window. 

 

STM100 option  

 
STM100 option  

When the STM100C stimulator module is connected to an MP150 System, the output level can be controlled 
via the STM100 option of the Manual Control dialog. 

Attenuation Attenuate the output signal by a given number of decibels (dB) for controlled stimulus 
applications. To output a signal with no attenuation, simply set the “Stim 100 Attenuation“ to 
0 dB.  

 Manually outputting a value on a digital channel can stop an acquisition if data is being 
collected at very high speeds (greater than 10,000 samples per second aggregate). 

Invert output  Check this box to invert the polarity of the signal output through the STM100C. 

 This function can also be achieved by flipping the polarity switch on the STM100C from 
positive (POS) to negative (NEG). 

 

For more information on the STM100C stimulator output module, see the BIOPAC MP Hardware Guide.pdf. 
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Select MP150 

 

 The pull-down menu lists all MP150 units that 
are powered ON and sitting on the same local 
area network. The software can’t determine the 
lock status until a user attempts to communicate 
directly to a MP150 unit—each MP150 unit 
needs to be tried to determine if it is locked or 
unlocked. 

When “No MP Hardware mode” is selected, the 
menu of available MP150 units is grayed out and 
becomes unselectable. 

Enable “Do not ask me again” to hold your 
selection as the default. 

The fact that MAC (Ethernet) addresses appear in the user’s “Select MP150” dialog does not imply that the 
MP150 unit is, in fact, unlocked and available. If a user attempts to connect to a locked MP150, an error 
message will be generated to advise that the MP150 unit is locked to a different computer. 

AcqKnowledge locks an MP150 as soon as it connects to it, which tells the MP150 to only respond to 
commands from that particular computer and the communication method (serial or Ethernet). The lock has a 
timeout which is reset every time the MP150 unit receives a command from the computer that locked it. To 
locate MP150s in the local network, AcqKnowledge sends a broadcast packet to the local area network that 
asks all the MP150s in the network to respond. All the MP150s—whether locked or unlocked—will respond 
to this prompt. This means that the “Select MP150” menu may allow a user to select an MP150 that is locked. 
In such cases, AcqKnowledge will fail to connect (to a locked MP150 unit, as expected). To resolve this issue, 
unlock or power cycle the MP150 unit. See Locking/Unlocking the MP150 (Appendix E—page 1476) for more 
details. 

 
MP150 Info 

Select MP150 Info from the MP150 menu to generate a dialog with information about the software and 
firmware versions being used by AcqKnowledge: 

 
Manufacturer ROM is the the factory-installed firmware version; check this before you “Reset” the MP150 
unit for a Firmware Rollback (see page 1478). 

 Factory-installed Firmware version 1.1.2 or previous (purchased approximately November 2002 or 
before) may not reset to a level compatible with UDP communication. In such cases, you will need to 
install AcqKnowledge 3.7.2 or previous (non-UDP) and update to UDP in stages; contact BIOPAC for 
additional support. 

Note: For information about AcqKnowledge software, click Help > About AcqKnowledge.  
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Update Firmware 

This menu item is is used to upload MPB firmware files provided to you by a BIOPAC support technician. 
Unless a firmware warning is diplayed at application launch, your MP150 already has the latest firmware 
revision and no further action is necessary. If a firmware warning is displayed, contact BIOPAC technical 
support for more information. 
 

Segment Labels 

Selecting Set Up Segment Labels from the MP menu launches a setup dialog enabling assignment of user-
defined labels to append marker segments. 

 
 
 Add  Adds a segment number to index. Segment text can be edited under ‘Label’. 
 Rename Used to rename an existing segment label. 
 Delete  Deletes a selected segment from Index. 
 Delete All Deletes all segments from Index. 
 Up/Down Incrementally moves a selected segment up or down the Index. 

 Top/Bottom Moves selected segment to top or bottom of Index. 

Enabling checkboxes below the   icons adds time/date stamps to the segment label. 
 
NOTE: Set Up Segment Labels option is available in AcqKnowledge 4.2 and higher only. 
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Sound Feedback 

Set Up Sound Feedback generates a setup enabling acquired data to be redirected to the computer’s default 
audio output device. This feature can be used to monitor waveform data as sound through the computer 
speakers or headphones. (AcqKnowledge 4.2 and higher only) 

 

 
SOUND FEEDBACK 

CONTROLS 
FUNCTIONS 

Sound enabled Turns sound feedback of data on and off. 
Output Sampling Rate Selects from available sampling rates of the default audio device. 
Source Channel Selects the analog, digital or calculation channel from which the audio will be acquired. 
Reset Adaptive Gain Control Resets gain control to adapt to the current level of the signal. Use after sound feedback 

has started to re-adjust the level after accidental spikes or large artifacts. 
Enable low pass filter Applies a low pass filter at the Nyquist frequency (50% of the acquisition sampling rate). 

This IIR filter can help smooth out transition artifacts due to upsampling of data to the 
audio sampling rate. (Enabled by default) 

Median removal controls 
(Window width, 
Recomputate) 

Removes baseline offset from the output signal. 

Window width Sets width of median removal window (in seconds). Must be a positive value. 
Recomputate every Provides the time duration (in seconds) after which the median of the data is regenerated 

from the raw source data. Must be a positive value. 
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Gauge 

 

The Gauge is 
accessed via 

MP150/MP36 > Show 
Gauge. The optional 

“Gauge” display 
shows one channel of 
data in a gauge/dial 

indicator format. 

The Gauge displays 
as a separate 

window, viewed 
simultaneously with 

graph and other 
windows. 

NOTE: The Gauge feature is available in AcqKnowledge 4.2 and higher only. 

The Gauge window: 

 Will display one channel of data: (analog or calculation) 
 Updates and displays simultaneously with the graph window. For analog channels only, the display 

will update when the recording is stopped, but at a slower rate when recording is running. 
 Can update during and in between acquisitions for all MP devices; display may be updated at a rate 

slower than the sample rate and may display a value that represents the average of several samples.  
 The background image (BMP, JPG or TIFF), indicator origin, range, length, thickness and color are 

all user-configurable. An optional range band overlay can also be enabled. 
 Selectable gauge bitmaps include Blood Pressure Cuff, BPM or Stopwatch 
 All window preferences as well as the window visibility, size and position will be saved with the file. 
 Window sizing is “fixed” to the size of the background image, meaning it will have a 1 to 1 

correspondence with the monitor pixels 
 
 

 
Gauge Preferences 

Gauge Preferences are accessed by right-clicking over the gauge and using the 
contextual menu. There are four tabs for setting the various Gauge parameters. 

 

Background is the default tab presented in Gauge Preferences and contains options for setting the 
Background image. 
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Channel  Provides a pop-up menu for assigning any one of the ENABLED analog or calculation 
channels. 

Background Image  Displays the path and file name of the current background image. The default image is 
a blue blood pressure gauge sized at 451 x 451 pixels.  

Browse  Allows alternative background images in different directories to be used in place of the 
default gauges. The Browse location will default to the file path used by the currently 
selected background image. To change the background image, click the “Browse” 
button and locate the desired file. After the background image is specified, the pixel 
Width and Height will be updated. The Width and Height fields are not editable.  

Use Default  Displays a menu of available default background images. (Pressure, Stopwatch and 
BPM). 

Indicator  
The “indicator” or “needle” is a simple line vector drawn from an assigned center point to an endpoint 
calculated according to the “Length” parameter. The indicator always rotates around the origin from low to 
high values in a “clockwise” fashion.  
 

 

Origin  Is the center point of the indicator line referenced from 
the top left of the image not the top left of the window meaning neither the frame of window 
nor the title bar is included. The “X” parameter specifies the horizontal distance in pixels and 
the “Y” parameter the vertical distance. “X” cannot exceed the Width of the background 
image and “Y” cannot exceed the image Height. The default values are: Origin: X: Width/2, 
Y: Height/2. Note that the pixel count starts at “0” so a 225 pixel square image will have 
its center point at 112 pixels. 
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Length  Specifies indicator span in pixels starting from the “Origin”. Default is the smallest of the 
Length or Width dimensions divided by 2. 

Thickness  Specifies the indicator width in pixels, with a selectable range between 1 and 10. The default 
is 1 pixel. 

Color  Specifies color of the indicator “needle” as Black (default) or White. 

When recording is stopped  

If the source channel is a Calculation channel, no gauge updating will occur when the 
recording is stopped. Under this circumstance, the “When recording is stopped” options 
become available. This allows the user to specify whether the indicator should not be 
displayed, should be reset to zero, or should retain the last value. 

Mapping 

For setting up two point mapping: Input to Angle   

  
        

Input  Defines the input values in the scaled units. The units shown in the example are volts, but 
would reflect the units of the source channel (mmHg, psi, etc.). The Input mapping of the 
upper scale value is set to a default of 50 of the source channel unit type. 

Angle  Any angle can be entered, but 0, 360, 720, etc degrees means that the indicator will always be 
pointing straight down.  

When assigning mapping angles: Because the indicator “needle” must rotate clockwise, the 
first value should be the lower angle. The first value also defines the indicator’s starting angle 
but does not to need to be 0 degrees. For example, the Stopwatch Gauge’s starting angle 
should be 180 degrees (pointing straight up). If half-circle gauges are used, the starting angle 
may be 90 degrees.  

Indicator is limited to specific mapping  

If this option is enabled, and the indicator needle reaches its mapped upper limit, it will stop 
rotating and turn red. If this preference is not selected, the needle will not change color if the 
defined mapping limits are exceeded and the needle will just continue in a clockwise 
rotation.  
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Range Band (Default OFF) 
Use the Range Band as an optional feature to highlight a specified area of the Gauge View. 
 

  

 

Start/End  Defines a “pie” shape (defined by Mapping values) sourced from Gauge center and 
superimposed over the background image.   

Color  Clicking on the color bar will bring up the following palette, which allows any color to be 
selected. The default color is green. 

 

Opacity  Used to adjust the transparency of the Range Band. 100% means the background image will 
be fully obscured behind the range band, and 0% means the Range Band itself will not be 
visible. The default setting is 50%.  

Segment Timer “Stopwatch” option  

(Available in AcqKnowledge 4.2 and higher only) 
In addition to the standard Gauge described above, the Segment Timer Gauge option offers an analog 
“Stopwatch” view of an acquisition in progress. As the recording progresses, a circular onscreen stopwatch 
gauge displays the elapsed time with a sweep-second indicator. All customizable parameters shown above for 
the default Gauge view are applicable to the Stopwatch view. A custom mapping for the Stopwatch view can 
be created, or use the pre-configured “Segment Timer Gauge” graph template in the Sample Data folder. 
 
Using the Segment Timer graph template – open the sample template in the following directory:  

Main drive\Program Data\Biopac Systems, Inc\AcqKnowledge 4.2\Sample Data\Segment Timer Gauge.gtl 

Clicking ‘Start’ will show the Stopwatch in progress. The template is setup to record ECG Lead II on CH 1 
and is tied to a new Segment Timer calculation channel. However, no connections are needed to verify the 
segment timer and the template can be customized as desired. To change parameters, choose Preferences from 
right contextual menu with mouse positioned over the gauge window. When the recording is stopped, timer 
indicator will also stop. When the next recording segment begins, the segment timer will reset to 0. (This 
default can be changed in the Gauge Preferences). 
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To configure a new Segment Timer Stopwatch view: 

1. Set up desired acquisition parameters and channels. 

2. MP menu > Set Up Channels > Calculation tab and 
choose the Segment Timer preset. 

3. MP menu > Show Gauge and open Preferences by right-
clicking the contextual menu over the Gauge window. 

4. In the Gauge Preferences, choose “C0 – Segment Timer” 
for the Channel and “Stopwatch”, as shown on right. 

5. Choose the “Mapping” tab, enter the following Input to 
Angle mapping values and click OK: 

 

6. Start the acquisition. Note the Stopwatch view will accurately reflect the time scale of the recording 
in progress. 
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MP36R support 

NEW! MP36R is a four channel data acquisition unit designed to work with AcqKnowledge for the research 
market. AcqKnowledge 4.1 support for the MP36R unit includes:  
 Standard data acquisition and data acquisition features (triggering, multiple channels, variable 

sampling rate, input values)  
 Output control functionality for controlling stimulators, digital channel, and channel redirection to 

output 
 Standard analog presets for all SS series transducers 
 Electrode Check support  
 Multiple-MP device support. Similar to multiple MP150 support, each graph may acquire from a 

maximum of one unique MP device.  
 Control channel support for changing digital output lines based on calculation channel analysis  

 
Note AcqKnowledge software does not support MP36 units from the Biopac Student Lab product line 

(without the “R” suffix for research systems). 
 

Autoplot 

Scroll 

Both Autoplot and Scroll control how data appears on the screen. By default, AcqKnowledge displays the 
most recently collected data first, and if more than one screen of data is to be collected, then the time scale 
will “scroll” so that the newest data is always on the right edge of the screen. 

When Scroll is deselected and Autoplot  is checked, the screen will be cleared when the data reaches the right 
edge of the screen, and plotting continues from the left again. 

When both Scroll and Autoplot are unchecked, the incoming data will be plotted until the screen is full. Once 
the screen is full, data will continue to be collected, but only the first screen is displayed. By default, the MP 
will display the first eight seconds of the data record, but this can be reset manually by changing the 
horizontal scale. To toggle Autoplot ON or OFF in the middle of an acquisition: 

 select Ctrl+T (Winodws) or Command+T (Mac OS X) on the keyboard, or 

 pull down the MP150 menu and choose “Autoplot” ON or OFF 

 

Warn on Overwrite 

Selecting the “Warn on overwrite” option from the MP150 menu will generate a prompt each time you start a 
new acquisition: 

 
If you click “Yes,” then AcqKnowledge will erase your current file and overwrite with a new acquisition. If 
you don’t want to erase the file you’re working in, click “No” and then open up a new file to work in. 

This prompt will appear at the beginning of each acquisition when the MP System is in Repeating/Autosave 
mode, so you will probably want to uncheck the “Warn on Overwrite” under the MP150 menu. 
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Organize Channel Presets  

 
The Organize Channel Presets option controls the channel presets (established or new) in the MP 150 > Set 
Up Channels dialog; you can rename, rearrange or delete Presets. You might use this option to place the most 
frequently selected Presets at the top of the menu or group related Presets, such as established ECG Presets 
and new channel Presets you’ve created. 

Click a Preset description to select it, and then use the buttons to organize the Presets.  

Up and Down buttons move the selection one space at a time. 

Top and Bottom buttons jump to the start or end of the list. 

 Rename a Preset by typing in a new description and clicking OK. 

You can’t use any name currently used by a Preset or any name that matches a Calculation type 
(Integrate, Rate, etc.). 

  
Delete a Preset by selecting that option. You cannot delete the Default Analog Input preset. When you delete 
a Preset, you will be asked to confirm the request because it is an irreversible action.   

 

Add Separator adds a new Separator entry to the Preset list and is useful for dividing different Preset types. 
If a Preset is currently selected in the list, the Separator will be added below it. (See diagram above) If no 
preset is selected, the separator will be added to the end of the list. Separators can be rearranged or deleted in 
the same manner as Presets. (AcqKnowledge 4.2 and higher only) 

 
The default location for Preset files is Computer > Local Disk > ProgramData > BIOPAC Systems, Inc > 
AcqKnowledge 4.2 > Presets. 
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Check for Hardware 

This MP menu option becomes active when the application is launched in “No Hardware” mode. This feature 
enables quick connection to available supported hardware types. (AcqKnowledge 4.2 and higher) 

 

Exit Playback Mode 

This option is enabled when Open File for Playback (see page 144) has been selected. Select to resume 
acquisition functionality (change Playback menu to MP150 menu, Replay button to Start button). 
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Part C—Analysis Functions 
OVERVIEW 

This part describes how to analyze data; in most cases, analysis is performed after the data has been collected. 
This involves creating, managing, and saving files, as well as editing data, performing mathematical 
transformations, and displaying data in various ways. Many of the functions covered here are also discussed in 
Part A—Getting Started. Features that can be computed during an acquisition (primarily transformations and 
calculations) are discussed in Part B—Acquisition Functions. 

For general information about sections of the graph window, and to become familiar with the “look and feel” of 
AcqKnowledge, turn to the Editing and Analysis Features chapter. Descriptions of functions can be found in the 
chapters describing each menu. All of the commands discussed here can be found under the File, Edit, 
Transform, or Display menu items. 

 

Menu See… Type of Commands 

File Page 1236 

General file management commands, including opening, saving, and 
closing files. Export data files. 

Edit Page 1256 Cut, copy, and paste between and within files. Export data files. 

Transform Page 1265 Operations that primarily modify the data in the graph. 

Analysis Page 296 Operations that primarily derive data and measurements from the graph. 

Specialized Analysis Page 331 

A courtesy copy of the new Specialized Analysis package with 
automation and scoring routines.is included under the Analysis menu. 

Display Page 1403 

Control how data appears on the screen either during or after an 
acquisition. 

Media Page 431 Capture and Playback controls to synchronize video/audio with data. 

 

Toolbars 

Many of the most commonly used features in AcqKnowledge can easily be executed with a mouse click. The 
toolbar contains shortcuts for some of the most frequently used AcqKnowledge commands; icons are grayed out 
when they are not applicable. 

Click Display > Show > Tool Bar to view the icons. Click an icon to activate it. 

See page 155 for Toolbar icon definitions. 

 

Shortcuts 

Keyboard shortcuts are detailed on page 1664. 

Mouse shortcuts are detailed on page 68, including contextual menus. 
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 Chapter 13 File Menu Commands 
Overview 

 
Most of the items in the File menu are standard menu items and follow the standard Windows conventions (for 
MPWSW) or Macintosh conventions (for MPWS). By default, all files are created and saved in the 
AcqKnowledge file format, a proprietary format used to store binary data. Data can be read in from either text 
files or AcqKnowledge files, and can be saved in text, graphic, or binary format. As a rule, storing data in the 
AcqKnowledge format saves information in the most compact format possible and takes up less disk space than 
other file formats. In most cases, you will probably be working with graph windows and saving data in the 
AcqKnowledge format. 

AcqKnowledge also supports an online journal that can be used to store waveform data (in numeric format) or 
to make notations and comments in a text file. 

New 

Graph Window 

In almost all cases, you will need to create a new graph window before 
beginning an acquisition so that the data may be displayed on the screen. 
When a new graph window is created, you can modify any of the window 
parameters, including horizontal scale, vertical scale, window size and 
position. In addition, you can also set the acquisition parameters for 
sampling rate, number of channels, and acquisition length. These settings 
take effect once an acquisition begins.  

New > Graph-specific Journal 

Creates a graph-specific journal; see page 152 for details. 
 

New > Independent Journal 

Creates an independent journal; see page 152 for details. 

New > Data View 

Creates a new Data View for the active (frontmost) graph, and names the new window “Data View of 

‘Filename’”. . For Data View details, see page 145. 

New > Batch Acquisition 

Use the Batch Acquisition feature to configure advanced experimental setups and acquire data from a 
sequence of templates. Each template in the Batch may have different acquisition settings, channel 
configurations, and stimulator setups. Use a Batch for long duration experiments with hardware setting 
changes across segments, to automate routines, or to run multiple experiments on the same experimental 
setup in succession. 
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 For example, if an experiment has a preparatory period, a stimulus period, and a response period, three 
graph templates could be batched: 

 A template to acquire for the length of the preparatory period 

 A second template with a stimulator configured for the stimulus period 

 A third template to acquire the response period without stimulation 

All three templates could be added in sequence to a single Batch Acquisition, which would then acquire all 
of the data for all three templates with a single start. 

To create a new batch, choose File > New > Batch Acquisition to generate the Batch dialog. 

The Templates controls at the top allow you to add, 
remove, or re-order the templates. 

 Double click a template in the list to open the 
output graph from the most recent acquisition. 

 Batch acquisition cannot combine acquisitions that 
do not end, so the acquisition storage mode for 
template files cannot be set to “Save last,” 
“Autosave”or “Repeat forever.” 

 

Status 

N/A No status is available for the template, no batch acquisition has been performed. 

In Progress Data is currently being acquired for the template. 

Waiting A batch acquisition is in progress but has not yet reached the step where the template is used. 

Complete Data acquisition for the template has been finished successfully and has been saved to disk at 
the batch output location. 

Error A batch acquisition was aborted manually or due to communication errors. The data for the 
template may not have been saved or may be unreliable. 

Batch Errors 
Misconfigured templates and misconfigured averaging templates may generate the Adjust 
Length/Adjust Latency/Abort Acq warning prior to the start of acquisition. Clicking “Abort” 
will halt the batch acquisition. Misconfigured templates may result in those rare cases where 
data was acquired into a graph template with a different hardware configuration prior to saving 
the template to disk. 

Saving to: 

Use the “Change” button to specify the 
directory where the acquisition output should 
be saved. 

 

Use MP Unit: 

Specify the MP150 unit that should be used for 
the Batch Acquisition. 

This menu lists all of the available hardware units. 
Entire menu dimmed out while batch acquisitions are in 
progress. 

Start/Stop Acquisitions  
Toggles to starts and stop batch acquisitions; dimmed 
when the specified MP150 unit is being used to acquire 
data unless it is a batch acquisition that is in progress. 
Batch acquisitions may be terminated by using either a 
control in the batch user interface or by clicking the 
“Stop” button in the graph window actively acquiring 
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data for the current template of the batch. During the 
execution of an individual template acquisition, errors 
may occur that abnormally terminate that acquisition 
(i.e., communications errors with the MP150 unit, 
errors in calculation channel, disk errors, etc.). When 
the acquisition in progress is terminated due to an error, 
the batch acquisition will be halted as well.  

 If a batch acquisition is aborted early, the 
batch output directory will contain the full 
result graphs for all of the templates that 
were previously completed successfully. It 
will also contain a partial graph file for the 
template that was being used at the time the 
acquisition was aborted. Templates that 
were not used will not have any associated 
graph files. 

Resume  
When a batch acquisition is terminated prematurely, the 
acquisition may be restarted from the first template in 
the sequence or from where it was stopped (e.g. the 
template with the error status). 

Batch Acquisitions can be saved for use at a later time using File > Save Batch 
Acquisition As. Batch Acquisition files retain all of the settings for their 
individual templates and can be used even if the original templates used to 
configure the batch no longer exist or have been moved. Each template is 
acquired and saved into an output graph file that can be opened at a later point in 
time to examine the results.  

To open a Batch Acquisition, use File > Open and select type “Batch 
Acquisition.” 

When a batch acquisition is started, the templates will be executed in the order indicated in the batch to acquire 
data from the specified MP150 unit. Files are autosaved before the next acquisition is started. 

 If the batch acquisition completes successfully, the batch output directory will contain all of the 
graph files that were created during the acquisition. Each output graph is saved into a user-specified 
directory and is titled “Batch n - template name” where n is the order in the acquisition sequence. 



Part B — Acquisition Functions: The MP150 menu 239 

 

Open 

The File > Open command generates the standard file open menu, and allows you to open a variety of different 
file formats from the popup menu at the bottom of the dialog.  

 
Multiple files 

To open multiple files in a single dialog, hold the Shift key down and select multiple files. The Command-
A key combination will “Select All” files in the dialog. AcqKnowledge can only recognize one Journal file 
at a time, so multiple selection is disabled when the file type is set to Journal or Journal Template. 

Graph The default file formats (*.acq) is referred to as “AcqKnowledge” files. The 
AcqKnowledge file format is the standard way of displaying waveforms in 
AcqKnowledge. These files are stored in a compact format that retains information 
about how the data was collected (i.e., for how long and at what rate) and takes 
relatively little time to read in (compared to text files, for instance). AcqKnowledge files 
are editable and can be modified and saved, or exported to other formats using the Save 
as command. Format options for the graph file include 

 Graph—AcqKnowledge 4 

 Windows AcqKnowledge 3 Graph—previous release format 

 Macintosh AcqKnowledge 3—previous release format 

 Biopac Student Lab PRO Graph—import files created using the Biopac 
Student Lab PRO software; to open BSL Lesson files (.ldd), manually add the 
extension “.acq” to the end of the file. 
BSL File Import Notes 

BIOPAC produces two different software lines, the AcqKnowledge software 
for research and the BSL software for higher education. These two 
applications use different file formats, making it difficult to analyze data 
recorded in one with the other.  

AcqKnowledge can directly import data files that were created in Biopac 
Student Lab PRO. This allows data acquired with an MP36, MP35 or MP30 to 
be analyzed using the advanced analysis routines of AcqKnowledge.  

Hardware and calculation channel settings are also imported. This allows for 
the migration of some BSL PRO templates to AcqKnowledge. Only basic 
analog, digital, and calculation channels can be acquired; templates that use 
any of the BSLSTM or other output options are not supported. 

Importing is limited to graph files created with BSL 3.6.6 or higher. It is not 
possible to import files created with earlier versions of BSL. To import from 
earlier BSL versions, those files must first be opened with BSL 3.6.6 or higher 
and re-saved to disk to update the file format. The updated files can then be 
imported directly into AcqKnowledge. 
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When saving files, AcqKnowledge must save using the AcqKnowledge graph 
file format or another available export format. It is not possible to open 
AcqKnowledge graph files with BSL Lessons or BSL PRO. 

Template Graph Template files (*.GTL)  

This powerful feature allows for creation of a template file with predefined experiment 
parameters. Simply click “Start” to run the experiment.  

The Graph Template option allows you to open a copy of a master file so you can 
maintain the master settings. Graph template files open to previously saved setup 
parameters (as established under the MP150 menu) primary graph window size.  

This feature can be especially useful for recreating protocols in the laboratory. You can 
Set Up an experiment and save it as a Graph template, then simply open the Graph 
template file and click the Start button to acquire data under the same settings. 

When a Graph template file is opened: 

a) The graph window will not contain any data. (Since no data is saved in the 
template, arbitrary waveform output setups, which require a source date file, 
will not function in a template.) 

b) The journal window will contain text you entered and saved with the 
template—this is a handy way for you to place instructions or information 
about the experiment for yourself or others. 

AcqKnowledge “Quick Start” (*.gtl graph template) files are available for over 40 
applications. Just open the graph template file to establish appropriate settings for the 
selected application, and then click Start. Quick Start files were installed to the Sample 
Data folder and can be used to establish the settings required for a particular application 
or as a good starting point for customized applications. 

Text .TXT. Text files are a convenient way of transferring information between applications, 
and most spreadsheet and statistics programs are capable of importing or exporting data 
in a text file format. AcqKnowledge assumes that the text file contains numeric data laid 
out in columns and rows, and that there is some delimiter between each column. It also 
assumes that each column represents a distinct variable or channel of data. Normally, 
the values in each row represent the state of each variable at different points in time. 
When a text file is opened, the numeric values will be plotted as waveform data in a 
standard graph window and non-numeric values will be ignored. Each column of data is 
read in as a separate channel. 

Journal *.JCQ—Opens an independent journal; see page 152 for details. 

Open the journal file from the File Menu (File > Open > Journal); right-clicking or 
double-clicking a saved Journal file will open a blank application window. 

Jrnl Temp *.JTL—Opens a journal template; see page 152 for details. 

 Options 

When the Files of type: Text option is select, an Options button is activated. Clicking on 
this button generates another dialog that allows you to control the amount and type of 
data to be read in, as well as the time scale for data display. 

N
O
T
E 
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Read Line 

 To control how much data is read in, enter a value in the read line box at the top of 
the dialog. This tells AcqKnowledge which row contains the first data point in the 
series. By default, this is set to 1, although you may want to set it to another value 
since some applications (usually spreadsheets) generate a “header,” or text 
information at the top of a file. You can also read in a limited amount of data by 
entering a value in the box to the right of the line box. This value indicates the last 
line to be read in as data. By default, text files will be read in starting at line one 
and data will continue being read in until the end of the file is reached. 

 

Interval 

 To control the horizontal scale (usually time) for the text file after it is displayed in 
the graph window, change the Interval between sample points, which can be 
expressed either in terms of time or frequency. For example, if data was collected 
at 50 samples per second, there is an interval between sample points of 0.02 
seconds. AcqKnowledge would then assume that there is a 0.02 second “gap” 
between the data point in row two and the data point in row three (and all 
subsequent pairs of adjacent rows). Likewise, if you have a data file that spans 10 
seconds and has 100 rows of data, the interval between sample points will be 0.01 
seconds. 

 Most files contain time domain data, although some applications generate 
frequency domain data (the results of a spectral analysis, for example). The 
principle here is the same as with time data, that there is some interval between 
different frequencies. If a text file contains 20 sample points covering the range 
between 0 and 60 Hz, then the interval would be set to 3Hz per sample. 

Column Delimiter 

 This setting tells AcqKnowledge what characters indicate a “gap” between two 
columns. This can be set to tab, comma, or space. All text files must have some 
sort of column delimiter, unless there is only one channel of data present. 

 Tab delimited text files —the most common type— have a tab between each 
column for every row of data. These files are most often generated by 
spreadsheets and similar packages. 

 Comma delimited files place a comma between each column of data for each 
row, much the same way as a tab delimited file. Statistics programs such as 
BMDP and SAS frequently create these types of files. 

  Space delimited files are also commonly created by statistics packages, and 
place some number of spaces (usually two) between each column of data for 
every row which contains information. 

 None. If you are not sure which delimiter to use, select auto and AcqKnowledge 
will automatically select a delimiter. 

When either tab or comma is selected, AcqKnowledge will read in a new column 
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each time it sees a delimiter, even if there are no numeric values between 
delimiters. For example, the following text file will read in three channels of data, 
although the channels will be of different lengths. 

0.301424, 0.276737, 0.045015 
0.338723, 0.808811, 0.542627 
0.354271, 0.506313, 0.715995 
0.001325, 0.762115 
946207, 0.894992 
0.926409, 

 Sample text file 

The first channel will contain six data points, the first being 0.301424 and the last value 
being 0.926409. The next channel will contain three data points, starting with 0.276737 
and continuing through 0.506313. The software considers that there is no other data 
values for channel two. The third channel starts with the entry 0.045015 and the last 
data point for this channel is 0.894992. There are only five data points in the last 
channel. 

AVG  Advanced Averaging Experiment—not supported in AcqKnowledge 4.0. 

PhysioNet PhysioBank is a public service of PhysioNet and offers downloadable archives of 
gigabytes of “standard” data for cardiac arrhythmias, gait analysis, and other types of 
physiological signals. AcqKnowledge can use PhysioBank data directly and can be 
integrated with other software tools that understand this interchange format. 

A PhysioBank file is usually comprised of several files, including a header file (usually 
“*.hea”), and all of the files must be located in the same directory for the PhysioBank 
record to open successfully. Open using the header file. 

Opening a PhysioNet file will import data and annotations into a new graph window. If 
“atruth” annotations exist, they will be translated into appropriate events on the 
appropriate channel. All annotation types are retained except LEARN annotations, 
which are treated as UNKNOWN. 

MAT MATLAB® format AcqKnowledge can open files created as a MATLAB work space. 

 Windows™ can open MATLAB v6 compatible MAT files, including MATLAB 7 
if the “v6” flag is specified in MATLAB before saving. 

 Mac™ can open MATLAB v7 compatible MAT files, including V7 format. Only 
ASCII text is supported; Unicode text within MATLAB v7 is not supported. 

 Interoperability with earlier versions of MATLAB is not guaranteed. 

Uses the “MAT-file” binary format to load numerical and textual information. If the 
MAT-file is properly formatted with the following arrays, AcqKnowledge will 
reconstruct the graph with appropriate sampling rate, channel labels, units, and data: 

data units labels isi isi_units start_sample 

 MATLAB files open with no Start button. 

 If the MAT file is missing any of the 
expected variables or contains extra 
variables, only one two-dimensional array 
variable can be imported into a graph. A 
MATLAB Import Options dialog will be 
generated. Choose which variable data is 
stored in, what dimension maps to 
samples, channel indices, and sample rate, 
and then click OK to open the file. 

 If AcqKnowledge can’t recognize the file 
format, an error prompt will be generated 
and a blank graph window will be opened. 
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Raw This low-level data exchange option interprets all data at a single sample rate; variable 
sample rates are not supported. All of the data will be unscaled when opening 
(importing) files. That is, a value of 0 will be imported as a zero voltage. Scaling will 
need to be manually applied to the data. Options to open (import) raw data: 

Data type: 32-bit or 64-bit IEEE floating point format or 8-, 16-, and 32-bit 
integer formatted data 

# of channels: Enter the number of channels stored in the data file as a positive 
integer less than or equal to 60. 

Layout: Packed sequential: All of the data for an individual file is located in 
a single block of the file and multiple channels follow one another. 

 Interleaved: Data is grouped into a single “frame” for each sample 
location with one data element for each channel, so data for a 
particular channel is spread throughout the file (similar to Linear 
PCM audio file format). 

Endian: Little and big endian byte ordering, matching the data formats of x86 
and PowerPC/Sparc, respectively. Set to big for Mac-Power PC 
generated raw files (default), or to little for Mac-Intel generated or 
Windows-generated raw files. 

Set to x/sample: Specify the inter sample interval of data in the file, which will be 
translated into an appropriate sampling rate. The edit field will 
accept an arbitrary floating point number. The units menu contains 
μsec, msec, sec, MHz, kHz, Hz. The edit field will be dynamically 
converted to match the units selection; no conversion will be used 
when switching between frequency and time. 

Batch  

 

Igor Pro Igor Pro Experiments (compatible with Igor Pro 3.1, 4.0, and 5.0). 

The waves contained in an Igor Pro packed experiment can be opened (imported) in 
AcqKnowledge provided that the packed experiment files comply with the following: 
 ≤ 59 waves 
 no text waves 
 no complex waves 

 all waves in Version 2 or Version 5 format (Igor defaults) 
 all waves one-dimensional (vectors) 
 all waves multiples of the same fundamental inter sample interval 

If the wave has an associated wave note, it will be used as the channel label. 

WAV WAV files containing 60 channels or less can be imported. When this format is chosen, 
the list of available files will be filtered such that only files ending in the “.wav” 
extension or having the “WAVE” type are shown. When a WAV file is selected, it will 
be analyzed to determine if it is compatible with the AcqKnowledge application. 
If the file is compatible, a new graph window will be created displaying the data 
contents of the WAV file. 

 Each channel will be numbered “Channel n” where n is an increasing digit. 
These channels will be unitless in amplitude. 

 All of the data will be converted into the 64 bit floating point format for storage 
in memory and in the ACQ formatted files on disk. 

 The horizontal axis of this graph will be set to time and the sampling rate set to 
match the rate as specified in the WAV file headers. 

 This graph will be marked as an imported graph into which data cannot be 



244 AcqKnowledge Software Guide 

Visit the online support center at www.biopac.com 

acquired. 
 This will dim the start button and any appropriate hardware menu entries that 

would be used to access the invalid hardware settings. 
EDF Opens files with .eeg and .edf extensions saved in European Data Format (EDF). Data is 

imported entirely into memory in a newly created graph window titled after the 
filename, similar to other file import routines. All scaling factors will be applied to the 
data as it is imported, and it will be converted to double precision floating point format. 
Since EDF format includes data that is not used by AcqKnowledge, only the following 
items are imported: 

 channel data 
 channel labels 
 units 
 sampling rate (taken from maximum sample rate of all channels) 

All other information stored in the EDF file will be discarded when the file is imported. 
Only 60 channels of data can be imported from an EDF file. Channels will be imported 
starting with the graph file index 1. If there is a 60th channel, it will be placed into the 
channel with index 0. If an EDF file contains more than 60 channels, only the first 60 
channels will be imported and a prompt will advise that not all of the channels could be 
imported. 
 

Open Recent 

The File > Open Recent command generates a list of recently used files. These files can be opened directly from 
the list or with a Ctrl (PC) or Command (Mac) keystroke combination. (File > Open Recent is available in 
AcqKnowledge 4.2 and higher). 

 

The listed files appear in the order they were opened, with the most recently-opened file appearing at the top. 
Default number of files appearing in the list can be modified in the Preferences. (Display > Preferences >Other) 

Open for Playback 

The File > Open for Playback command generates a standard file open dialog; see page 44 for Playback details.  
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Close 

This File menu command will close the active file window and prompt you to save if necessary.  

 
Close without saving 

 Windows—click the  in the upper right corner of the file window 

 Mac OS X—click the  in the upper left corner of the file window 

Click “No” when AcqKnowledge asks you if you want to save the changes. 

Close during acquisition 

 
Close multiple data views 

Set the level of close functionality under Display > Preferences > General. 
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Save 

  
This menu command will save any changes made to a file. If more than one file is open, this command only 
applies to the active window. For untitled files, you will be prompted to name the file you wish the data to be 
saved in. The file will remain open after you have saved it, allowing you to continue working.  

 The Save menu is dynamic and corresponds to the type of file you are trying to save, i.e. Save Graph, 
Save Journal. 

Files should be less than 2 GB, except AcqKnowledge 3.9 “Graph” files on the Mac, which can be larger if not 
compressed. Data files greater than 2GB can be opened, but edit, transformation and analysis operation cannot 
be performed. 

To save data in another format (such as a text file), use File > Save As. 
 

Save As 

Choosing File > Save As produces a standard dialog that allows you to 
save data in a variety of different formats and to any location. As with all 
save last dialoges, you can use this to save a file to a different file name or 
directory than the default settings. 
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Graph AcqKnowledge format 

The default file format for the File > Save as command is to save files as an 
AcqKnowledge 4.0 file, which is designed to be as compact as possible. These files can 
only be opened by AcqKnowledge 4.0, but data can be exported to other formats once 
it has been read in. 

 To save in the previous relase format, choose Windows AcqKnowledge 3 
Graph. When a file is saved in AcqKnowledge 3 format, the following 
calculation channel types will revert to Integrate: Band Stop Comb Filter, 
Adaptive Filter, FLC, WFLC, CWFLC, Rescale and Metachannels. 

File Compatibility  

Windows AcqKnowledge cannot save as Macintosh AcqKnowledge files. 

Macintosh AcqKnowledge 3.9 and above can save as “Graph (Windows)” files, but it 
saves in Windows AcqKnowledge 3.7.1 format. In this earlier format, all data is 
retained, but new Windows AcqKnowledge features (like dual stimulation, data 
views, embedded archives, etc.) are lost along with any settings specific to Macintosh 
AcqKnowledge (like events, adaptive scaling settings, etc.). 

 Macintosh AcqKnowledge 3.9 and above can save PC-compatible Graph (*.acq) 
and Graph Template (*.gtl) files. Variable sampling rate information and 
hardware settings are retained, and Journals can be read from and written to PC 
files. Choose the format “Graph (Windows)” to create PC-compatible files. 

The Mac version does not save PC GLP files or compressed PC files.  

Files must end on a multiple of the lowest channel sampling rate to be fully PC 
compatible. 

GTL Graph Template 

This feature can be especially useful for recreating protocols in the laboratory. You 
can Set Up an experiment and save it as a Graph template, then simply open the Graph 
template file and click the Start button to acquire data under the same settings.  

TIP: Check the existing Quick Start template files listed on page 1240 before 
creating or saving a new template. With over 40 templates provided, you 
may find one to establish the settings required for your particular 
application or to use as a good starting point for customized applications. 

The Save As Graph template option saves the setup parameters established under the 
MP150 menu and retains the size of the primary graph window. In general, the 
minimum file size for graph templates is 700 K-800 K; file size may increase as setup 
options are enabled. 

When a file is saved as a Graph Template: 

a) No graph data will be saved. 

 Since no data is saved in the template, arbitrary waveform output 
setups, which require a source date file, will not function in a 
template. 

 You must select Save / Save as and select “File of type .ACQ” to 
save the graph data. 

b) Journal text will be preserved. Any text you entered will be saved to the 
Journal window and stored with the template—this is a handy way for 
you to place instructions or information about the experiment for yourself 
or others. 

When this feature is used with the menu.dsc customization feature it is easy to comply 
with GLP standards and save your protocol as an SOP. When you change the menu.dsc 
file for a graph template file, save the “menu.dsc” file with the exact same name but 
save it to the new lesson folder you have created. For full GLP features, contact 
BIOPAC about the Lab Assistant GLP System. 

N
O
T
E 
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TXT Text  

Saves graph data in text format. When Save As Text is selected, an Options button is 
generated. Clicking on this button generates a Save Options dialog that allows you to 
control how much data is saved and the format it is saved in.  

 

 

Header 

When the first box is checked, a “header” is included at the top of the text file that 
contains information about the sampling rate, number of channels, date created, and 
other information relating to the data. This information is frequently useful, but some 
programs will attempt to read in the header information as data, which could result in 
nonsensical results. You may wish to include the header as it can always be edited 
out later using a text editor or the journal. 

Selected Section 

Checking the second box instructs AcqKnowledge to save only the selected section 
of the file. This is useful for saving a brief segment of a long file. When this option is 
checked, the highlighted area of data will be saved from all channels. When only one 
data point is selected, the entire file will be saved. If you want to save only a portion 
of the selected channel, you can either remove other channels or copy the data 
through the clipboard. See page 262 for more information on how to copy data 
through the clipboard. 

Horizontal Scale 

The third checkbox allows you to include the horizontal scale (usually time) values 
in the text file, along with the data to be saved. This allows you to produce time 
series plots in other applications, as well as correlating events to time indexes in 
graphing and statistical packages. Since a separate row is generated for each sample 
point, To exceed the limitations of programs if data is collected at a fast sampling 
rate (many spreadsheet programs are limited to about 16,000 rows). You may wish to 
consult the section on resampling data after an acquisition is completed (page 292 X). 

Column Delimiter 

When data is saved as a text file, each channel of data is saved as a separate column, 
with the number values for each data point saved in rows. Use the pop-up menu to 
select the delimiter to separate the columns of data in the text file. By default, a tab is 
placed between each column for every row of data; this format is called a tab-
delimited text file and almost all applications will read in tab-delimited text files. 
However, you may also save data in a comma-delimited format or a space-delimited 
format. 

Line endings 

Use to create text files that are compatible with Classic Mac OS applications 
(Mac), Unix-compatible applications (Unix), or PC-compatible applications 
(DOS). 

PhysioNet This format requires that the WFDB library is on your computer. PhysioBank is a public 
service of PhysioNet and offers downloadable archives of gigabytes of “standard” data 
for cardiac arrhythmias, gait analysis, and other types of physiological signals. 
AcqKnowledge can use PhysioBank data directly and can be integrated with other 
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software tools that understand this interchange format. 

Saving a file in PhysioNet (WFDB) format will export the entire contents of the graph 
to a PhysioBank record. The record will consist of multiple files, all in the location 
specified for export. There will be a header file (*.hea) and a single data file for each 
channel of the graph (starting with “d” and ending with the base name of the header 
file). The files must not be separated for a successful move or copy. 

Export Limitations 

Precision Some precision may be lost due to differences in binary representation 
between AcqKnowledge and PhysioBank formats. 

Events Events will not be exported to the PhysioNet format. 

Channels Only 32 channels of data can be exported from a graph (the max allowed 
in a PhysioBank file). 

Rate If you are exporting a graph that uses variable sampling rates, all of the 
channels in the exported file will be downsampled to the lowest waveform 
sampling rate of the source graph. 

*.MAT 
MATLAB 

MATLAB® format. Uses the “MAT-file” binary format to save numerical and textual 
information as Filename.mat. 

 Windows™ and Mac™ create MATLAB Version 6 files, which are compatible 
with both MATLAB Version 6 and MATLAB Version 7. 

 Interoperability with earlier versions of MATLAB is not guaranteed. 

The following variables will be in the workspace when the file is opened in MatLab. 
data Contains the data of the graph in floating point format, for all of the 

channels of the array. The first dimension of this array is the amount of data 
in each channel, the second dimension increments with each channel. 
Therefore, each column contains a full channel of data that can be accessed 
in MATLAB via data (1:length, [channel number]). 

units This string array contains the textual representation of the units of the 
samples stored in data, with one element per channel of data. 

labels This string array contains the labels of each of the channels, with one 
element per channel. 

isi This floating point array of one element gives the number of units of a 
single inter sample interval of the data. 

isi_units This single string array provides a units string for a single unit of isi. Time 
data will always be “ms,” frequency data will always be “kHz,” and other 
values will be represented by an Arbitrary horizontal axis type in an ACQ 
graph. 

start_sample Contains the time offset of the index 0 sample of data in isi units. This will 
be 0 for many graphs, but if only a selected area of a graph was exported 
into the MAT file, the start_sample will contain the offset from the original 
data corresponding to the start of the data array in the MAT file. 

Raw Options to save (export) data for low-level data exchange are: 

Data type: 32-bit or 64-bit IEEE floating point 

Layout: Packed sequential: All of the data for an individual file is located in a 
single block of the file and multiple channels follow one another. 

 Interleaved: Data is grouped into a single “frame” for each sample 
location with one data element for each channel, so data for a particular 
channel is spread throughout the file (similar to Linear PCM audio file 
format). 

Endian: Little and big endian byte ordering match x86 and PowerPC/Sparc data 
formats, respectively. To exchange with Windows applications or Mac-
Intel, set to little endian; to exchange with standard Mac applications, set 
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to big endian. 

 

Raw Data Export Limitations 

Formats Raw export only allows data to be saved in 32-bit and 64-bit IEEE floating 
point format. 

Rates All files will be interpreted at a single sample rate; variable sample rates 
are not supported. If a graph with variable sampling rates is exported, 
channel data for downloaded channels will be padded to match the highest 
waveform sampling rate. 

Length If channels have unequal lengths, the overall file length will match the 
longest channel. Shorter channels will be padded at the end using their 
final sample value so that all channels contained in exported files will be 
equal in length. 

Scaling When integer-valued analog channels are exported from AcqKnowledge to 
raw files, all relevant scaling and offset will be applied—the data in the file 
will appear the same as if the channel had been internally converted to 
floating point format before export. 

 If the value of a channel is outside the maximum/minimum value that a 
chosen export data type can represent, the value will be clipped 
accordingly. (AcqKnowledge uses a 64-bit data type, so this should only be 
a problem if exporting to 32-bit floating point values.) 

Igor Pro Igor Pro Experiment format. 
An AcqKnowledge graph will be saved (exported) to a single packed experiment file, 
with each channel saved into a separate Igor wave that preserves the channel label, 
waveform sampling rate, and unit information. Vertical units will be stored as data units, 
and horizontal units will be stored dimension units; extended units are supported. The 
scaling of each wave will be adjusted to match the waveform sampling rate. All data 
will be stored in 64-bit floating point format in a one-dimensional wave. The waves will 
be named incrementally from “wave0” and the channel label will be stored in the wave 
note field. Files will have the type/creator pair “IgsU/IGRO” and a “.pxp” extension will 
be added to the file name for compatibility with Igor Pro for Windows™. 

WAV This option saves the graph data into a WAV audio file for exchange with other 
applications. The “.wav” extension extension will automatically be added if the save as 
filename does not end with it. 
The “Selected area only” checkbox will be active for WAV export. When checked, only 
the highlighted area will be exported to the WAV file. The final sample of this range is 
not included in the export, mirroring the other file export routines of AcqKnowledge. 
All exported WAV files use the 64 bit floating point format. This format preserves full 
operational precision. Most audio applications should be able to support floating point 
WAV files. Exported data will not be normalized when it is exported. Any 
normalization to audio ranges should be performed prior to exporting the data. 
WAV files are normally either one or two channels (e.g. mono or stereo). 
AcqKnowledge graph files, however, usually contain more than two channels. Although 
they can contain more than two channels, most audio applications may not be able to 
recognize these multiple channel files. 

 If a graph file contains only one or two channels of data, a WAV file will 
automatically be created without further interaction. 

o Graphs with a single channel will result in mono WAV files. 
o Graphs with two channels will result in stereo WAV files. 

 If a graph contains more than two channels, the user will be presented with the 
following choice: 
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o all channels—create a multiple-channel WAV file with one channel per 

channel of data in the graph. While this WAV file may be easily opened 
by some applications, it may not be fully compatible with audio 
applications and other applications expecting two channels or less. 

o selected channel only—create a single channel mono WAV file using 
only the data of the selected channel. This will be the selected channel 
in chart mode, the active channel in scope mode, or the vertical channel 
in X/Y mode. This single channel export may be useful for exporting 
audio channels that are recorded along with physiological data, such as 
heart sounds, audio stimuli, and the like. 

After a WAV file is exported, the WAV file will not be reopened; the open graph will 
be left unmodified. To view the exported file, import the WAV file. 

EDF Saves file in European Data Format (EDF). The saved file will automatically have an 
.edf extension added onto it if the user did not include it. Users will be able to save 
either the entire graph or only a selected portion of data. 

AcqKnowledge does not retain sufficient information to accurately complete an EDF 
header. When exporting, the following default values will be used: 

EDF Header Element Default 

subject ID Empty* 

recording ID Empty* 

recording date Set to the modification date of the graph file on disk. 
If no graph file is on disk, the current date is used. 

recording time Set to the modification time of the graph file on disk. 
If no graph file is on disk, the current time is used. 

transducer description Empty* 

filter description Empty* 
 * Empty: indicates that the field will be left blank 

All other fields will be filled with corresponding information from the graph, including 
channel titles, sampling rates, channel units, and scaling factors. Variable sampling rate 
information will be preserved as it can be expressed in the EDF format. 

EDF is used by many applications and online recording databases to store information, 
particularly EEG recordings. EDF is an open file format originally developed for sleep 
studies. It stores continuous time recordings of data in a binary format. Since its original 
proposal, EDF has been adopted by a number of open source and commercial tools as a 
supported data file format. Usage has also expanded beyond sleep studies into other 
types of recording.  

JPG AcqKnowledge also supports formats for saving graphical information. Most drawing, 
page layout, and word processing programs can read .JPG files. This is particularly 
useful for writing reports. A. JPG file can be opened in any standard drawing program 
and can then be embellished or used to highlight any particular phenomena of interest.  
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When data is saved as a graphic, only the data currently on the screen is saved. So, if 
you have a data file that spans eight hours but only two minutes is displayed on the 
screen, only two minutes of data will be converted to a graphic file. Since 
AcqKnowledge uses information about the computer screen in creating the graphic file, 
the default resolution of the file will be the same as the window. Most word processors 
and graphics packages allow for some way to resize and scale graphics. 

Compressed Saves a compressed AcqKnowledge formatted file. The degree of compression varies 
based on data characteristics, but will generally achieve about 60% compression. 
Saving small files (less than 200K) may have little effect. Using a sample file as an 
example: 

 
Compressed graphs no longer allow data acquisition and will open with no Start 
button. 

Resave the compressed file in standard format to enable a Start button. 

A warning prompt will be 
generated when you try to 
compress a graph in which 
data can be acquired (Start 
button active): 

Excel 
Spread-

sheet 

Excel Spreadsheet Export—Graph data can be saved directly to an Excel spreadsheet by 
using the Excel Spreadsheet format in File > Save As. Each channel will be placed into 
its own column of the spreadsheet. Only 65K sample points can be exported at a time, 
however, so long or high sample rate data acquisitions may not be able to be saved in a 
single spreadsheet. 

 Also available for File > Save Journal Text As, Find All Cycles journal, and 
Specialized Analysis tools. 

Note  The Excel spreadsheet option requires Excel or a compatible spreadsheet 
application that can read Excel files (OOo, Symphony, etc.). If Analysis results 
are exported to an Excel spreadsheet, and a compatible application is not 
available, results will open as a text document the data and nonsense characters.  

Save Selection As 

To save only the data that has been selected with the I-beam tool, choose File > 
Save Selection As; this option saves the selected area to another file and does 
not affect the current file that you are working in. Specify file name and file 
type and then click Save. 
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Save Journal Text As 

 
Choosing File > Save Journal generates a save dialog to save the journal text as a separate file. Specify file 
name and file type and then click Save. 

Journal 
  

Text (*.TXT) format—Saves an independent journal; see page 152 for details. 

Jrnl Temp .JTL format—Saves a journal template; see page 152 for details. 

Excel 
Spread-

sheet 

Excel Spreadsheet File (*.XLS)—Journal text can be exported directly into an Excel 
spreadsheet by using the File > Save Journal Text As with the Excel Spreadsheet format. Each 
line of text in the journal will be saved as a single row with tabs separating columns. A 
selected portion of a journal can also be written to a spreadsheet. This export allows for textual 
data reduction results to be easily exported into a spreadsheet to allow for further analysis. 

 Also available for File > Save As, Find All Cycles journal, and, for Specialized 
Analysis tools. 

Note  The Excel spreadsheet option requires Excel or a compatible spreadsheet application 
that can read Excel files (OOo, Symphony, etc.). If Analysis results are exported to an 
Excel spreadsheet, and a compatible application is not available, results will open as a 
text document the data and nonsense characters.   

 

File Format prompts 

When a file open or save function requires a format change for compatibility or alters file content, a prompt will 
be generated to require the user to confirm the option to update format or convert and save.  
 

  
Created with a previous version of AcqKnowledge  Windows PC AcqKnowledge format 
 

  
Saving as a “Graph Template” will erase all data Imported from another file format 
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Send Email Attachment 

Use this feature to create an email attachment containing an image of the active AcqKnowledge graph, along 
with the journal contents. (AcqKnowledge 4.2 and higher only). 

When using this feature: 

o The default email program will launch, along with a ‘compose new email’ window. 

o An Open Document (*.odt) text file containing an image of the currently opened graph and associated 
journal text will be copied to the attachment field. The formatting and images present in the journal 
should be preserved. 

o Further details can be typed into the body of the email prior to sending. 

In order to open the attachment, the email recipient must have a word processing application compatible with 
*.odt file format, such as OpenOffice, NeoOffice or Microsoft Word™. 

Page setup 

Choosing File > Page Setup produces a standard printer setup dialog that allows you to setup any available 
printers. All the options in this dialog function as described in your system manual. There is also an options 
button that allows you to make several printing adjustments with respect to fonts, image orientation, and 
graphics presentation. 

Range of Data options 

 
Select “MP150…” for Print range options 

 

Event Divider 

Toggle “Draw vertical divider at event locations” to enable/disable this option. See Printing Events on page 12219 
for details. 

Based on the range selection, the software will make appropriate adjustments before printing. For visible area, 
friendly grid scaling will be applied, and onscreen and printed precision will match, even if horizontal grids are 
unlocked. For selected area and entire area, onscreen and printed precision will not match when grids are 
unlocked because friendly grid scaling is applied on screen, but is not used during printing where the range is 
fixed to fill the entire page. 

The automatic software adjustments before printing will set the horizontal scale as if it had been used to display 
the relevant data on the screen. When printing is completed, the scale and offset parameters of the graph will be 
restored to the previous settings. 

 

Print 

The File > Print menu that AcqKnowledge uses is similar to the standard computer print dialog; however, there 
are additional options available 
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The Print menu is dynamic and corresponds to the type of file 
you are trying to print, i.e. Print Graph, Print Journal. 

Windows OS: Click print for more options. 

Mac OS X: Select “MP150…” in the print dialog: 

 
 

 

 Print Options 

 Plots per page—Control how many plots appear per page when the file is printed. Printing more than 
one plot per page has the effect of “snaking” graphs on a page much the same way text appears in a 
newspaper. For example, if this option was selected so that two plots were printed per page, 
AcqKnowledge would divide the amount of data to be printed on that page into two graphs—one graph 
printing at the top of the page, the second graph printing at the bottom of the page. This option allows 
you to print records on considerably fewer pages than standard printouts, and is most effective when 
only a few channels of data are being printed. 

 Fit to pages—Print the contents of a window across multiple pages. When a record is printed over 
multiple pages, the amount of data on the screen (the amount of data to be printed) is divided by the 
number of pages entered in the dialog. The graph on the screen is then printed across the number of 
pages specified in the Total pages box at the bottom of the File > Print dialog. These two options apply 
only to graph windows, and do not apply to Journals. 

 Draw vertical dividers at event positions 

 Print waveform data in black 

 Range Options—determine the range of data that will be included in the printout  

 Visible portion only synchronizes the range of data in the printout to match the range of data that is 
visible on the screen. 

 Selected portion only prints only the data that is selected in the graph. This option is disabled if there is 
no selection in the graph. When working with Journals, it is easy to generate large amounts of text 
content in the window. Only a portion of this information may actually be of interest and this feature 
allows for only portions of the text to be printed. If there is no selected text, the entire journal or 
modification log will be printed regardless of this setting. 

 Entire graph prints all of the data contained in the graph from zero to the maximum length channel. 

 Print to PDF file—generate a PDF file. 

 

Quit  

Select Quit from the File menu to exit AcqKnowledge software; you will be prompted to save any open 
graph files that have been modified since they were last saved. 

Mac OS X only—Use Quit under the AcqKnowledge menu (page 1429) to exit the software. 
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Chapter 14 Edit menu commands 
Overview 

  

  

One of the most useful features in AcqKnowledge is the ability to edit and work with data by cutting sections 
and copying sections from one window to another. In this sense, the MP System (MP150 or MP36R) allows you 
to work with data much as a word processor lets you work with text. When working with data, you will usually 
want to select a section of data to work with. To select a section of data, use the editing tool to highlight an area. 
The selection tool is used for a variety of purposes including cutting and pasting waveform data, making 
measurements and determining which portion of a waveform to save as text values. To select the tool, click its 
icon in the lower right hand corner. You will notice that the cursor changes into the familiar “I-beam” cursor 
when you move it within the graph area. Click the mouse and drag to select a portion of the waveform. 

IMPORTANT 

When multiple waveforms are present, the highlighted area appears to include all of the waveforms, 
but most modifications and transformations apply only to the selected channel. 

Once you have selected a section of a waveform, you can perform such as editing, transformations, saving data 
to the journal, saving as text, and using the measurement functions on the selected area. The cursor always 
selects at least one sample point; when there is no defined area, a single sample point will be selected, and the 
cursor will blink. You can highlight a larger area by positioning the cursor over the first point you are interested 
in, holding down the mouse button, and dragging the cursor either left or right to highlight an area. This is 
similar to highlighting a series of letters or words in a word processor. You can modify the selected area by 
placing the cursor anywhere on the graph, then holding down the shift key and clicking the mouse. This feature 
is useful for fine-tuning the selected area. To fine tune, first coarsely select an area. By zooming in (with the 
zoom tool) on either edge, you can then use the shift key to precisely align the edges of the selected area. 

AcqKnowledge also allows you to select an area that spans multiple screens. To do this, first select an area that 
contains the leading edge of the portion of the graph that you are interested in. Next, use the horizontal scroll 
bar to scroll to the end of the area that you are interested in. Then place the mouse near the area of interest and 
click the button while holding down the shift key. While still depressing the mouse button, move the cursor to 
the exact position desired.  

By using the selection tool to select areas of the waveform, the Cut, Copy, Paste and Clear functions are 
designed to work in much the same manner as a word processor. These functions operate only on areas selected 
by the selection tool. 
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Edit menu functionality during acquisition 

The following Edit menu functions may move or alter memory and cannot be performed during acquisition: 
Undo, Cut, Clear, Clear All, Paste, Insert Waveform, Duplicate waveform, and Remove Waveform. 

 

Undo / Can’t undo 

The Undo command allows you to restore data that was unintentionally deleted or modified. Undo applies to 
editing commands and transformations (such as digital filtering and mathematical operations). 

There are some important exceptions to the Undo command. 

First, neither Edit > Clear all nor Edit > Remove waveform can be undone. It is a good idea to make backup 
files before performing any editing, especially when using these commands. 

Second, changes in the display options (i.e., changing the horizontal scale or changing the color of a waveform) 
cannot be undone, since they are easier to manipulate and less drastic than cutting data out of a waveform. If 
you modify the screen scale (or other display parameters) you will still be able to undo your latest data 
modification, which is much more difficult to recover than a screen parameter change. 

TIP: If you accidentally remove a waveform or choose Clear All, one way to recover 
the data is to close the file without saving the changes. The data file can now be 
reopened, as it was when it was last saved; any changes made since it was last 
saved will be lost. 

Perform multiple levels of undo on a per graph basis; Journal undo remains unchanged at one step. Complex 
data analysis in AcqKnowledge is rarely performed with a single transformation; multiple transformations are 
frequently cascaded together to produce a result. AcqKnowledge will “stack” the transformations and the user 
will be able to undo one step at a time until this stack is exhausted. 

 Undo may move or alter memory and cannot be performed during acquisition.  

 Undo operations may occupy large amounts of memory, particularly for transformations that affect 
entire waveforms or multiple markers. Users without large amounts of RAM or working with large data 
sets may require the available computer memory for performing transformations. To accommodate 
these users, the maximum size of the undo stack can be limited using the Levels of undo Preference 
(Display > Preferences). 

 
 Specialized Analysis (page 13331) scripts are complex and undo may not function for all steps. 



258 AcqKnowledge Software Guide 

Visit the online support center at www.biopac.com 

Cut 

When Cut is selected from the Edit menu, the highlighted portion of the active window (Graph, Journal, entry 
prompt or dialog) is removed and copied to a clipboard, where it is available for pasting into other windows. 

Cut may move or alter memory and cannot be performed during acquisition. 

 When a selected area is removed from a waveform, the data will shift left to “fill in” the deleted area. So, 
if ten sample points are deleted, all data after the selected area will be shifted over ten sample points. 
Since this alters the relationship of events to the time base, you might want to consider alternatives to 
cutting sections of data—such as using smoothing, digital filtering, or the connect endpoints functions to 
transform the section of data. 

Area selected using the 
editing tool  

 

 

 

 

 

 

Same data with selected 
area Cut out  

 

Note that the data 
after the selected 
area has shifted 
forward in time. 

 

 

Copy 

Choosing Edit > Copy will copy the selected area of the active window (Graph, Journal, entry prompt or dialog) 
to the clipboard without modifying the text/waveform on the screen. 

 Once the area has been copied, it can be inserted in another window using the Edit > Paste command or, 
for waveforms, the Edit > Insert waveform command. 

 To copy a waveform to another channel in the same graph window, choose the Edit > Duplicate 
waveform command. 

Paste 

The Edit > Paste command will take the contents of the clipboard and paste it into the currently selected area of 
the active window (Graph, Journal, entry prompt or dialog). 

 If no area is selected, the data is pasted at the beginning of the waveform in a Graph window or the end of 
the text a Journal window 

 

Note  Copy/Paste operations require AcqKnowledge to allocate additional memory and then load the data into 
memory; when these operations are executed on large data files, the application may crash. 
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Clear 

The Edit > Clear command works much the same way as the Cut command, with the key difference being that 
data is not copied to the clipboard. This function deletes the selected area from the selected channel only. If the 
entire waveform is selected (as with the Edit > Select all command), the clear command will delete all the 
waveform data and leave an empty channel. 

Clear may move or alter memory and cannot be performed during acquisition. 

 As with the cut command, the clear function operates on only one channel, and when a portion of the 
waveform is deleted, the remaining data will shift left. If multiple channels of data are present, one 
channel will be “shorter” than the others. 

 To remove a selected area of data from multiple channels, use the Edit > Clear all command. 

 

Clear all 

Choosing Edit > Clear all will delete the selected area from all channels. This is similar to the clear function in 
that data is removed and is not copied to the clipboard. The Clear all command, however, removes a section of 
data from all waveforms, whereas the clear command applies only to the selected channel. 

Clear All may move or alter memory and cannot be performed during acquisition. 

 When Edit > Select all is chosen prior to performing the Clear all function, all waveform data for all 
channels will be deleted. 

 The Edit > Undo command does not work for Clear all. 

 

Select All 

When Select all is chosen from the Edit menu, the entire selected channel becomes highlighted. For almost all 
commands, when a waveform is selected using Select all, subsequent operations apply to the selected channel 
only. 

 The exception is when Edit > Clear all is chosen after Edit > Select all. When this occurs, all data from 
all waveforms will be deleted. 

 

Insert waveform 

The Edit > Insert waveform command is useful for copying a waveform (or a section of a waveform) from one 
window to another. To do this, first select the area to be copied using the cursor and the Edit > Copy command. 
Next open the graph window you wish to insert the waveform into. To insert the waveform into the same graph 
it was copied from, although the Edit > Duplicate waveform is a much more straightforward way to do this. 

Once you have selected the graph you wish to insert the waveform into, choose Insert waveform from the Edit 
menu. A new (empty) channel will then be created and the data will be copied into the empty channel. The new 
channel will always take on the lowest channel number available (including zero). 

Insert waveform may move or alter memory and cannot be performed during acquisition. 

 This command cannot be undone directly, although selecting the inserted channel and choosing Remove 
waveform from the Edit menu effectively undoes this operation. 
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Duplicate waveform 

Choosing Edit > Duplicate waveform will create a new channel in a graph window and copy an entire 
waveform (or a selected area) to the new channel. When a portion of the waveform is selected, only the 
highlighted area will be duplicated. 

Duplicate waveform may move or alter memory and cannot be performed during acquisition. 

 To duplicate the entire waveform, choose Edit > Select all and then select Duplicate from the Edit menu 
or click the right mouse button and select Duplicate from the pull-down menu.  

 

Remove waveform 

Deletes the entire selected waveform, regardless of what other options are selected.Remove waveform may 
move or alter memory and cannot be performed during acquisition. 

 The Edit > Undo command does not work for Remove waveform. 

 

Remove last appended segment 

Removes the last appended segment. Equivalent to the  Rewind toolbar icon. 

 
 Edit > Undo does not work for Remove last appended segment. 

 

Create Data Snapshot 

The Snapshot options store “snapshots” of the original acquired data at specific stages along with the full graph 
file. Use snapshots for analysis or reporting to compare results to original waveforms or intermediate stages of 
analysis. This is essentially an embedded archive; it is not a backup tool. 

IMPORTANT: Archive functions do not create a new file—they are not backup functions. 
Original data is copied and pasted to the end of the original file.  
You cannot use this feature to recover lost or damaged graph files. 

See page 53 1555 for Snapshot details. 
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Merge Graphs 

Combine multiple graph files into a single file for performing cross-file analysis and storage. Use merge with 
the multiple-hardware capabilities to produce single graph files containing multiple streams of data from an 
individual subject.  

Use Merge Graphs to combine up to 60 channels from multiple graph files acquired with the same acquisition 
rate into one merged graph file.  

 

Note  Merge Graphs requires AcqKnowledge to allocate additional memory and then load the data into 
memory; when this operation is executed on large data files, the application may crash—on Windows 
OS, the resulting file size of a merge should be less than 2GB; data files greater than 2GB can be 
opened, but edit, transformation and analysis operation cannot be performed. 

 

1. Select Edit > Merge Graphs to generate the Merge Graphs dialog. 

2. Click Add Graph to generate the Choose Graph dialog. 

3. Choose a file to add to the merge. 

 “Add” the “Matching graph” listed (this pull-down menu includes all open files with the same 
acquisition rate) 

 “Add File…” to browse and select a file that is not already open 

4. Adjust the selection for individual channels if desired. 

 Click the “+” to list individual channels in the graph file. 

 Toggle the checkbox to add or remove the associated channel/graph file. 

 You cannot delete a file name from the list, but you can remove it from the merge. 

5. Repeat as desired for multiple files. 

6. Click Merge and wait (you can check the status in the Total Channels bar). 

7. Save the merged file. 
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Clipboard 

  
All of the clipboard commands involve copying data from AcqKnowledge to the standard Windows clipboard, 
where the contents of the clipboard are made available for other applications. Transferring data through the 
clipboard allows you to copy data from AcqKnowledge to other applications even after you have closed the 
graph window and/or quit AcqKnowledge. 

Data can be copied to the clipboard in two formats: 

Text/Alphanumeric Copy Measurement and Copy Wave Data save information to 
the clipboard in text/numeric format. 

Graphic format Copy Graph transfers the image in the window to the clipboard. 

 Copy Measurements 

Copies the contents of all visible measurement popup menus, along with the values associated with 
these windows. By default, three windows are displayed (on most monitors); you can change this by 
increasing or decreasing the width of the window. Once the measurements have been copied, they can 
be pasted into any application that allows paste functions, including word processors, drawing 
packages, and page layout programs. A sample of measurements pasted from AcqKnowledge into a 
word processor follows: 

BPM = 85.714 BPM delta T = 0.700 sec p-p = 0.8170 Volts 

 Copy Wave Data 

Copies the data (in numeric form) for all channels from the AcqKnowledge graph into the clipboard. 
When an area is selected, only the data in the highlighted area will be copied to the clipboard. As with 
the copy measurement command, once the data is stored in the clipboard, it can be pasted into virtually 
any application. 

When multiple channels of data are copied to the clipboard, the data is stored in columns and rows, with 
data from each channel stored in a separate column. For a four-channel record, four columns of data 
will be copied to the clipboard. As with a text file, AcqKnowledge will insert a delimiter between each 
column of data. The default delimiter is a tab; you can change the delimiter to either a space or tab in 
the options dialog in the File > Save as dialog. See page 240 Xfor more detailed instructions on how to 
set the column delimiter. Transferring data through the clipboard performs essentially the same function 
as saving data as a text file (using the File > Save As command), with the obvious exception that 
transferring data through the clipboard does not save data to disk. 

Note  Using Copy Wave Data on larger files may crash the application due to the excessive number of 
text lines generated (the problem is not the data size). For instance, one large file sample was 
300,002 lines—a 3 MB text file. 

 Copy graph 

Copies the graph window as it appears on the screen to the clipboard, where it is stored in graphic 
format. You can then place the graphic into a number of different types of documents, including word 
processors, drawing programs, and page layout programs. The JPEG graphich format are common to 
almost all applications, and images saved in these formats can be edited in most graphics packages and 
many word processors. 

Using the copy graph function is similar to saving a graph window as a JPEG  (using the File > Save As 
command), except that using the file save command writes a file to disk, whereas transferring data 
through the clipboard does not save a file. 
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 Copy Acquisition Settings 

Creates a textual summary of the current acquisition settings and sends it to the clipboard, where it can 
be pasted into the journal via Edit > Journal > Paste Acquisition settings, or pasted to another program. 

The summary includes sampling rates, channel configuration, calculation channel settings, triggering 
options, averaging options, and if any stimulator is active. This is useful for retaining records for 
acquisition parameters (and for technical support, if necessary). Use this feature to keep a textual record 
or printout of the configuration of your MP150 unit along with your data. 

 Copy Data Modification History… 

Copies the transformation history to the clipboard for all channels or the selected channel. Modification 
history includes the transformation name, channel (analog, calculation, or digital), date & time, and 
relevant transformation parameters, including starting and ending sample position. 

Use Edit > Paste to move it from the clipboard to an active Journal window or other word processing 
application. 

 
 

Journal 

  
The Edit > Journal sub-menu options are similar to those found in the Edit > Clipboard menu. The key 
difference is that data (whether measurements or raw data) is pasted directly into the journal rather than copied 
to the clipboard. 

 Paste Measurements 

Choosing Paste Measurements from the Edit > Journal menu will cause all visible measurement 
windows to be pasted into the journal. Each time this is selected, the measurements and values are 
pasted into the journal using the precision specified in the Display > Preferences dialog. You can also 
change the total number of measurements displayed by adding more rows of measurements. Use the 
Preferences menu (see page 420) to change the number of measurement rows or the measurement 
precision displayed on the screen. 

Paste Measurement shortcuts: 

 Keyboard: Ctrl + M 

 Mouse: Right-click in the Journal and choose “Paste Measurement” 
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 Paste Wave Data 

Converts the selected area of the waveform to numeric format and paste it into the journal in standard 
text file format. As with the copy wave data command (in the Edit > Clipboard submenu) this will paste 
the selected area from all channels, not just the selected channel, and will place a delimiter between the 
columns when two or more channels are being pasted to the journal. By default, tab characters are used 
to separate columns; you can change to comma or space delimiters in the File > Save As > Options 
dialog. See the Save As section on page 12246 for more information on how to change the column 
delimiter. 

Note  Using Paste Wave Data on larger files may crash the application due to the excessive number of 
text lines generated (the problem is not the data size). For instance, one large file sample was 
300,002 lines—a 3 MB text file. 

 Paste Acquisition Settings 

Pastes the acquisition settings to the journal as they were copied via Edit > Clipboard > Copy 
Acquisition settings. 

 Paste Modification History… 

Use after Copy Data Modification History… to paste the transformation history from the clipboard for 
all channels or for the selected channel to an active Journal window or other word processing 
application. Modification history includes the transformation name, channel (analog, calc, or digital), 
date & time, and relevant transformation parameters, including starting and ending sample position. 

 
 Show Journal 

Toggle to display/hide the Journal window. 
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Chapter 15 Transform menu commands 
Overview 

  
The Transform menu contains operations that primarily modify the data in the graph. 
AcqKnowledge provides a number of options for post-acquisition analysis and transformations. These 
transformations allow you to perform a range of operations on your data, from digital filtering and Fourier 
analysis to math functions. All of these options can be found under the Transform menu, and are disabled while 
an acquisition is in progress. Unless otherwise noted, all of the transformations described here apply to the 
selected channel only. Some options (such as the expression and math functions) allow you to specify a channel 
(or channels) to be transformed.  

It is important to remember that AcqKnowledge is always selecting at least one point, and the cursor will flash 
whenever only one point is selected. Some of the transformation functions (e.g., math function, waveform math) 
can operate on a single sample point, and will transform a single sample point when only one is selected.  

There are two ways to apply a transformation to an entire waveform. 

a) For transformations that generate a dialog, check 
the “transform entire waveform” box (usually 
located toward the bottom of each dialog). This 
will transform the entire waveform, regardless of 
whether a single point, area, or the entire 
waveform is selected. 

b) For transformations that do not generate a dialog, use the Edit > Select all command prior to selecting the 
transformation. This will transform the entire waveform for all of the transformation functions. 

 Edit > Select All is not necessary when only a single point is selected prior to selecting the 
transformation because AcqKnowledge will automatically apply the transformation to the entire 
waveform since it is not possible to perform these transformations on a single point. 

 

Note  Transformations require AcqKnowledge to allocate additional memory and then load the data into 
memory; when transformations are executed on large data files, the application may crash. 
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Recently Used Transformations 

The Transform > Recently Used submenu allows quick access to a user’s most recently used transformations 
and analysis commands. The Recently Used submenu also appears at the top of the Transform submenu 
available from the context menus of waveforms.  

The submenu lists a default of five of the most recently used transformations, with the most recently executed at 
the top of the menu. To adjust the number of recent transformations displayed, select Display > Preferences. 

 
The recently used transformation listing is saved and restored across subsequent launches of AcqKnowledge. It 
also is application wide: Executing a transformation in any graph will add that transformation onto the recently 
used list. The recently used list is independent for each user account.  

 
The recently used tranformations can also be launched by the keystroke combinations appearing in the menu. 
(AcqKnowledge 4.2 and higher) 

Digital Filters 

 
FIR filters are linear phase filters, which mean that there is no phase distortion between the original signal and 
filtered waveforms. 

IIR filters are not phase linear filters, but are much more efficient than FIR filters in processing data. The IIR 
filters are useful for approximating the results of standard biquadric filters of the form: 

(as2 + bs + c) / (xs2 + ys + z) 

These types of filters are commonly implemented in electronic analog circuitry. IIR filters are also used for 
online filtering (discussed on page 131X). 

 See Appendix B for more information about the differences between these types of filters. 

Adaptive filtering is a signal processing technique that processes two different signals in relation to one another; 
see page 272 for details. 

To understand how digital filters work, it is important to understand the nature of analog signals and their 
frequency components. All analog signals are comprised of signals of various frequencies. A commonly used 
analogy is that of the color spectra. Just as white light is made up of a variety of colors that have different 
wavelengths (frequencies), physiological signals are comprised of specific signals with unique frequency 
signatures. 

For example, an electroencephalogram (EEG) recording is comprised of several different types of signals, each 
of which has a different frequency signature. Alpha waves (one of the most studied EEG signals) have a 
frequency range of about 8 Hz to 13 Hz. This means that alpha waves go through a complete cycle (from peak 
to peak or trough to trough) anywhere from eight to 13 times a second. 



Part B — Acquisition Functions: The MP150 menu 267 

 

There are, of course, signals that have other frequency signatures in EEG data. Most types of physiological data 
have a number of different frequency signatures present in the overall signal. In addition, frequency components 
besides the signal(s) of interest are often present. In the U.S., it is not uncommon for 60 Hz electrical noise to be 
acquired along with physiological signals (in other countries, AC interference is present at either 60 Hz or 50 
Hz). 

Use digital filtering to retain only the frequency components of interest and remove other data (whether it is 
“noise” or merely physiological signals outside the range of interest). 

It is important to note that the way in which data is filtered depends in large part on the sampling rate at which 
the original data was acquired. For instance, if data was collected at 50 samples per second (50 Hz), it is not 
possible to filter out 60 Hz signals. 

In fact, data must be sampled at a rate equal to at least twice the frequency of the signal to be removed. So, if 
data is to be collected and the information between 80 Hz and 120 Hz is to be removed, the data must be 
sampled at 120 Hz*2, or 240 samples per second (or faster). Also, each channel of data is filtered separately, so 
removing one type of data from one channel will not affect any other channels. 

Digital filters can be divided into four general classes: 

low pass     band pass     high pass     band stop 

Descriptions of these four classes of filters follow, with visual examples of how these filters work. In each of 
the four examples, a single channel of data containing frequency components in three ranges (low frequency, 
mid-range, and high frequency) is acquired. 

 Low frequency data, by definition, has slowly changing values, much like respiration patterns or core 
temperature variations. 

 High frequency data, compared to low frequency data, is noticeably more “spiked,” much like an EMG 
signal. As you can tell, the high frequency wave repeats itself about five times in the time it takes the 
low frequency wave to repeat once. 

 Mid-range data falls somewhere in between these two extremes. 

In the examples that follow, one possible way that these data could have been collected is if respiration were 
measured, but the measurement was contaminated with high-frequency muscle movement and mid-frequency 
signal coming from AC interference. The data is then passed through a filter, where some of the frequency 
components are removed. 

Low pass filtering 

In the example below, a low pass filter attenuates the data above a given threshold, allowing only lower 
frequency data to “pass” through the filter. 

Low
Pass
Filter

Incoming data Filtered data

Low
frequency
data

Mid
frequency
data

High
frequency
data

Low
Cutoff

 
High pass filtering 

In the example below, a high pass filter removes the low and middle range data, but allows the high frequency 
data to pass through the filter. 
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Whereas the low pass and high pass filters retain data either above or below a given threshold, the next two 
types of filters work with a range, or band, of data. 

Band pass filter 

The band pass filter, allows only the data within the specified range to pass through the filter. A band pass filter 
is useful when you want to retain only specific waves from an EEG record. For instance, to retain alpha waves, 
you can set the filter to only pass data between 8 Hz and 13 Hz. 
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Band stop filter 

The band stop filter allows data to pass above and below the specified range. This type of filter is typically 
applied to remove extraneous 60 Hz or 50 Hz noise from a data record.  
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FIR Filters 

 
Digital filter dialog  

When you select an FIR filter type, the corresponding Digital Filter dialog will pop up, allowing you to specify 
a number of different filtering options. 

1. Window. The Window popup menu allows you to choose from a 
variety of filtering algorithms. The filter default is set to a “Blackman” 
type. These different Windows (described in detail in Appendix D) 
allow you to “fine tune” the filter response. 

2. Cutoff Frequency (Hz) (or threshold). Enter a fixed value or set to a 
fraction of the sampling rate or to line frequency. 

Sampling rate—frequency is set to a fraction of the sampling rate and 
automatically updates when the sample rate is modified. 

Line frequency—frequency is set to the line frequency at which the 
data was recorded. 

Fixed at —Fixed value guidelines are as follows: 

 Low Pass Filter—data with frequency components below the 
cutoff will pass through the filter, whereas frequency components 
above the threshold will be removed. For low pass filters, the 
default cutoff frequency is the waveform sampling rate divided by 
eight and can be set to any value between 0.000001Hz and 0.5 
times the sampling rate. 

 High Pass Filter—data with frequency components above the 
cutoff will pass through the filter, whereas frequency components 
below the threshold will be removed. For high pass filters, the 
default threshold is the waveform sampling rate divided by four 
and can be set to any value between 0.000001Hz and 0.5 times the 
sampling rate. 

 Band-type Filters—a low threshold and a high threshold must be specified to define the band of data 
(the frequency range) that is either passed or stopped, depending on whether it is a Band Pass or Band 
Stop filter. In either case, the default for the low threshold is the waveform sampling rate divided by 
eight and the default for the high threshold is the waveform sampling rate divided by four. The 
threshold settings can take on any value from 0.000001Hz and 0.5 times the sampling rate, but the two 
thresholds cannot be set to the same value and the high threshold must be greater than the low 
threshold. 

3. Number of Coefficients. Enter a fixed value or enable the optimize option. 

 Fixed at—This determines how well the filter will match the desired cutoff frequency (or range). The 
minimum number of coefficients is 3 and the maximum must be less than the total number of sample 
points in the selected area. The software will truncate the maximum number of coefficients to the 
highest odd number less than the total. 

 Optimize for sample rate and cutoff—the number of coefficients is set as four times the sampling rate 
divided by the cutoff frequency of the filter. Optimize does not necessarily produce the best quality 
filter, but it takes less time. 

The recommended number of coefficients is  

4 x (waveform sampling rate/lowest frequency cutoff for the filter) 
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For every filter except the band pass, the lowest frequency cutoff is equal to the specified cutoff frequency 
for the filter; for the band pass filter, the lowest frequency cutoff is the low frequency cutoff setting. Filters 
that use a small number of coefficients tend to be less accurate than filters that use a large number of 
coefficients. Larger coefficients increase filter accuracy, but also increase the processing time required to 
filter the data.  

To see how changing the number of coefficients affects the way data is filtered, it can be useful to examine 
the filter response patterns. In the example below, data was collected at 500 Hz and the band stop filter was 
designed to remove 60 Hz noise using a low cutoff of 55Hz and a high cutoff of 65Hz. The same data was 
band stop filtered using 39 coefficients (upper waveform) and then 250 coefficients (lower waveform). 

 
Along the horizontal axis, the units are scaled in terms of frequency, with lower frequencies at the left of the 
screen. The values along the vertical axis are scaled in terms of dB/V and indicate the extent to which 
various frequencies have been attenuated. 

In both filter response waveforms, there is a downward-pointing spike that is centered on 60 Hz. The 
baseline of the filter response corresponds to a value of approximately 0 on the vertical axis, indicating that 
the signals significantly above or below 60 Hz were not attenuated to any measurable extent. As you can 
tell, however, the filter does not “chop” the data at either 55Hz or 65Hz, but gradually attenuates the data as 
it approaches 60 Hz. 

For example, the upper waveform in the filter response plot represents data that was filtered using a value of 
39 coefficients. The slope is relatively shallow when compared to the lower waveform, which represents a 
filter response performed with 250 coefficients. Although the filter that used 250 coefficients took slightly 
longer to transform the data, the filter response pattern indicates that the data around 60 Hz is attenuated to 
a greater degree. Also, the 250-coefficient filter started to attenuate data considerably closer to the 55 Hz 
and 65 Hz cutoffs, whereas the default filter began to attenuate data below 55 Hz and above 65 Hz. 

TIP: A good rule of thumb is to use a number of coefficients greater than or equal 
to two times the sampling rate divided by the lowest cutoff frequency 
specified. For example, if running a low pass filter at 1 Hz on data sampled at 
100 Hz, choose at least (2 x 100/1) or 200 coefficients in the filter. Additional 
coefficients will improve the response. 

4. Show Filter Response. When checked, this option generates a plot of the 
filter response in a new window, labeled “Frequency Response” (see 
example above).  

 Units: Select linear units or dBV. 

5. Don’t modify waveform. This option is useful in conjunction with the “Show Filter Response” option. 
When both boxes are checked, AcqKnowledge will produce a plot showing the filter response, but will not 
modify the waveform. This allows you to repeatedly specify different filter options (without modifying the 
waveform) until the desired frequency response is achieved. 

6. Filter entire wave. If this option is checked, AcqKnowledge will filter the entire wave and replace the 
original. If you want to keep the original, duplicate it prior to filtering. 
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IIR Filters 

To access the IIR filter dialog, click the Transform menu, scroll to select Digital Filters, drag right to IIR and 
drag right again for the filter options. For all filter types, the software will limit the frequency setting so it 
cannot exceed one-half the channel sampling rate. For real-time filter options, see page 1131. 

  
Low Pass and High pass Pass data that falls below or above the specified standard. The Low Pass default is 

waveform sample rate/8; the High pass default is waveform sample rate/4. 

Band Pass (low + high) Pass a variable range of data. Specify a low frequency cutoff and a high frequency 
cutoff to define the range or “band” of data that will pass through the filter; 
frequencies outside this range are attenuated. For the Band Pass Low + High filter, 
the low default is waveform sample rate/8 and the high default is waveform sample 
rate/4. 

 This filter is best suited for applications where a fairly broad range of data is to 
be passed through the filter. For example, apply to EEG data to retain only 
alpha wave activity. 

Band Pass (single freq) Requires only a single frequency setting, which specifies the center frequency of 
the band to be passed through the filter. The “width” of the band is determined by 
the Q setting of the filter (discussed in detail below). Larger Q values result in 
narrower bandwidths, whereas smaller Q values are associated with a wider band 
of data that will be passed through the filter. This filter has a bandwidth equal to 
Fo/Q, so the bandwidth of this filter centered on 50 Hz (with the default Q=5) 
would be 10 Hz. Although functionally equivalent to the Band Pass (low + high) 
filter, this filter is most effective when passing a single frequency or narrow band 
of data, and to attenuate data around this center frequency. The Band Pass (single 
frequency) default is waveform sample rate/8. 

Band Stop (single freq) Defines a range (or band) of data and attenuates data within that band (the opposite 
function of a band pass). This filter is implemented in much the same way as the 
standard Band Pass, whereby a center frequency is defined and the Q value 
determines the width of the band of frequencies that will be attenuated. The Band 
Stop (single frequency) default is waveform sample rate/8. 

Q coefficient The online filters are implemented as IIR (Infinite Impulse Response) filters, which 
have a variable Q coefficient. The Q value entered in the filter setup box 
determines, in part, the frequency response of the filter. This value ranges from 
zero to infinity, and the “optimal” (critically damped) value is 0.707 for the Low 
Pass, High pass and Band Pass filters. A Q of .707 for any of these filters will 
result in a second order Butterworth response. The Q is set to a default of 5.000 for 
the single frequency Band Pass and Band stop filters. For more details about the Q 
setting, see the Appendix. 

Sampling rate Sets the Frequency to a fraction of the sampling rate and automatically updates when the 
sample rate is modified. 

Line frequency Sets the Frequency to the line frequency at which the data was recorded. 
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Adaptive Filtering 

  

 
 See the Adaptive Filtering Calculation 

Channel on page 146. 

Adaptive filtering is a signal processing technique that 
processes two different signals in relation to one another 
and can be used for noise estimation, noise reduction, 
general-purpose filtering, and signal separation. Adaptive 
filtering creates efficient high-quality filters with a minimal 
number of terms, which can be very useful in blocking 
mains interferences or other known periodic disturbances. 

 Useful for noise filtering where it is possible to acquire 
a signal that is correlated to the noise (similar to the 
way noise-cancelling headphones detect and remove 
outside noise). Applications include removing EMG 
from ECG or EOG from EEG. 

The weights within an adaptive filter are modified on a step-by-step basis. AcqKnowledge uses the N-tap FIR 
adaptive filter, with coefficients updated using least means squares (gradient) feedback. 

Source signal 

The source channel will be replaced by the adaptive filter results. 

Noise signal 

The noise channel is the signal that is correlated with the noise to be eliminated from the Source; it is 
not modified by adaptive filtering. 

Source and Noise channels must have the same sampling rate. 

Order 

Specify a positive integer for the number of terms to be used in the internal FIR filter. 

Step size 

Provides mu, the rate of adaptation of the coefficients within the FIR filter. 

 

Comb Band Stop Filter  

Comb Band Stop filters out a fundamental frequency and its overharmonics (integer multiples of the base). 
Resonance, aliasing, and other effects may generate interference at multiples of a base frequency. The Comb 
Band Stop filter combines all the required filters instead of requiring a separate filter for each interfering 
overharmonicX.  

    
 Transformation Dialog Calculation Channel Dialog 

Resonance, aliasing, and other effects may generate interference at multiples of a base frequency. The Comb 
Band Stop filter combines all the required filters instead of requiring a separate filter for each interfering 
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overharmonic. Comb Band Stop filters remove a fundamental frequency and its overharmonics (e.g., integer 
multiples of the base frequency) from a signal, and are useful for removing noise. AcqKnowledge approximates 
a Comb Band Stop filter by cascading a series of IIR Band Stop filters, and is limited to removing frequencies 
and overharmonics. The number of filters used can be fixed at a particular number (e.g., limiting the number of 
harmonics to filter out) or configured to automatically remove all possible harmonics for any given sampling 
rate. 

 Mac OS — Use the "Comb Band Stop Filter" Automator action to integrate Comb Band Stop 
filters into Workflows. 

For a given base frequency  and quality factor Q, the comb filter approximation will be given by the set of 
following formulas: 

  xFFFFy k   32  

where F  represents a standard two-tap IIR band stop filter for the frequency  with coefficients 
computed using the quality factor Q. 

The number of overharmonics of the base frequency to be removed is given by the integer value k. The 
maximum allowable number of overharmonics may be automatically determined given the sampling 
frequency f s: 
















2max

f
k s  

This limits the maximum overharmonic frequency to be less than the Nyquist of the sampling 
frequency. 

After the first comb filter is performed, the most recently used settings for the comb filter will be displayed, 
(except for “Transform entire wave,” which will be reset each time the dialog is opened). 

Textual export will include the source channel, base frequency, quality factor, and number of harmonics. 



274 AcqKnowledge Software Guide 

Visit the online support center at www.biopac.com 

 
Comb Band Stop Filter Dialog 

number of samples Width of the selection. 

@ samples/sec Waveform sampling rate of the source channel. 

 The channel sampling rate of the calculation channel can not exceed the channel sampling 
rate of the source channel. Downsampling will be applied to the source channel prior to 
comb filter processing, if required, and all Nyquist frequency restrictions will be determined 
from the calculation channel sampling rate. 

Frequency Fixed—The comb filter will remove this base frequency and integer multiples of this frequency. 

 Must be positive and less than the Nyquist frequency (half the sampling rate). 

Sampling rate—Sets the frequency to a fraction of the sampling rate and automatically updates 
when the sample rate is modified. 

Line frequency—Uses the line frequency at which the data was recorded. 

Q Quality factor used when computing the coefficients of the IIR notch filters. 

 Must be positive. 

all up to Nyquist Removes all integer multiples of the base frequency. This will include all multiples of the base 
frequency that are less than the Nyquist frequency. 

Harmonics Removes the base frequency and integer multiples of the base frequency up to and including the 
multiple contained in the edit field 

 Must be an integer greater than 0 and must not exceed k max  

 The final multiple must be less than theNyquist frequency. If it is not, the input will need to 
be corrected before the comb filter can be applied. 

OK If the settings are valid, executes the comb filter transformation. Verification of certain calculation 
channel parameters does not occur until the start of acquisition as sampling rates may be changed 
after calculation channels are configured. 

Prior to the start of acquisition, the following will be checked: 

 source channel to ensure it is still being acquired. 

 base frequency of the comb filter to ensure it is less than the Nyquist frequency of the 
channel sampling rate. 

 if the user has manually specified that a fixed number of overharmonics should be used, the 
number of overharmonics to ensure the highest used overharmonic does not exceed the 
Nyquist frequency of the channel sampling rate. 

If any of the parameters are invalid, a prompt will be displayed indicating which settings are 
incorrect and must be fixed for the acquisition to be started. 

Cancel Quits without modifying any data. 

Source All enabled analog, digital, and lower-index calculation channels. 

Label When the calculation type of a channel is changed to comb filter, the title of the channel will be 
replaced with the default label “Cn –Filter” where n is the index of the calculation channel. 

 Must be 40 characters or less. 

Preset Displays the title of any Calculation Preset currently applied to the calculation channel. 
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Fourier Linear Combiners 
Transform > Fourier Linear Combiners: 

  
 

 See FLC Calculation Channel 
options on page 1145. 

 See FLC references on page 1276. 

Fourier Linear Combiners are linear combinations of 
adaptable sinusoidal functions that are particularly well 
suited to processing cyclic data. Sine and cosine harmonics 
of a base frequency are summed together and the order is 
the fixed number of harmonics used in the model. Step size 
provides mu, the gain factor used to adjust the weights of 
the harmonics at each processing step. Step sizes must be 
much less than 1 for the system to converge. As step sizes 
decrease, relaxation time lengthens. The FLC model is 
adjusted based on the source data using least means square 
(LMS) feedback and the bias compensates for DC offset. 

 

Basic FLC  

Simple summation of fixed numbers of sines and cosines; uses 
harmonics of a fixed frequency and adjusts weighting coefficients 
of the mixture. 

Operates on a single channel at a time.  

Well suited for extracting data of a known frequency band from a 
signal with a stable frequency. 

 Use as an adaptive noise filter to remove non-periodic and 
semi-periodic noise uncorrelated to the base harmonic 
frequency. 

 

Scaled FLC 

Fundamental harmonic frequency can vary on a cycle-to-cycle 
basis. The frequency remains fixed within a single cycle and must 
be known before processing.  

Scales the harmonics used in each cycle based on cycle 
boundary events (defined through the Cycle Detector, ECG 
Analysis, or manually). Events from one signal can be used to 
drive analysis of another signal.  

Well suited for signals with detectable boundaries, such as ECG. 

 Use to extract information that is tightly coupled to other 
cyclic signals, such as extracting ICG based upon 
Knowledge of the RR cycles of the ECG. 

 

Weighted-Frequency FLC 

Base frequency of the harmonics is variable; adapts the 
frequency in response to the input signal using LMS feedback; 
the frequencies are similarly adjusted to the amplitudes. 

Operates on a single channel at a time.  

Well suited for modeling periodic signals of an unknown and 
potentially varying frequency and/or amplitude.  

 No cycle boundaries or frequencies need to be pre-
determined.  
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Coupled WFLC/FLC 
Runs a WFLC on the signal to determine the harmonic frequency and 
then runs the result through an FLC using the computed harmonic. 
The second FLC can be run on the same or a different channel. 

The transformation will occur in the channel  designated as “ Output.” 

Well suited for real-time extraction of information from one signal 
based upon the frequencies contained in another signal. 

 Use to remove movement noise from ECG. 
 Unique configurations can be established with two input signals, 

one for frequency and one for amplitude. 
 

FLC References 
The basic Fourier linear combiner (FLC) is described by Vaz and Thakor. 

 Christopher A. Vaz, and Nitish V. Thakor, “Adaptive Fourier Estimation of Time-Varying Evoked Potentials,” 
IEEE Trans. Biomed. Eng., VolBME-36, pp. 448-455. 

The weighted-frequency Fourier linear combiner (WFLC) and the coupled weighted-frequency Fourier linear combiner 
(CWFLC) are described by Riviere, Rader, and Thakor.  

 Cameron N. Riviere, R. Scott Rader, and Nitish V. Thakor, “Adaptive Canceling of Physiological Tremor for 
Improved Precision in Microsurgery,” IEEE Trans. Biomed. Eng., Vol BME-45, pp. 839-846. 

The scaled Fourier Linear Combiner (SFLC) is described by Barros, Yoshizawa, and Yasuda. 

 Allan Kardec Barros, Makoto Yoshizawa, and Yoshifumi Yasuda, “Filtering Noncorrelated Noise in 
Impedance Cardiography,” IEEE Trans. Biomed. Eng., Vol BME-42, pp. 324-327. 
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Math Functions 

AcqKnowledge allows you to perform a wide range of mathematical and 
computational transformations after an acquisition has been completed. Unless 
otherwise noted, each of these functions applies only to the selected area of the 
selected channel. If no area is selected (i.e., a single data point is selected), the 
cursor will blink and AcqKnowledge will transform the entire wave. If a math 
function attempts to divide by zero, a zero will be returned. 

For complex transformations involving multiple functions, you may want to use 
the Expression/ Equation Generator (see page 293 for details). 

The following table describes the commands available in the Transform > Math functions menu: 

Transform > Math Explanation of Command 

Abs (Absolute Value)  Computes the absolute value of the data. All negative data values are made 
positive, with no change in magnitude. This function can be used to rectify data. 

Atan (Arc Tangent) Returns the arc tangent of each data point in radians. This rescales the data such 
that the range is from -/2 to /2. 

Connect endpoints 
(Connect the endpoints) 

Draws a line from the first selected sample point to the last selected sample point 
and interpolates the values on this line to replace the original data. The connect 
endpoints function is very useful for removing artifacts in the data or in generating 
waveforms. 

In the example below, the “noise spike” in the data is an undesired measurement 
artifact that should be removed. You could cut the section of data, but then all 
subsequent data points would shift left. In order to preserve the time series of the 
data, you could use the connect endpoints command to draw a straight line 
(although not necessarily flat) that connects the two extreme sample points of the 
selected area. 

 

 
Area selected before (top) and after (bottom) connect endpoints function 

 

Exp (Exponential) Computes the function ex, where x is the waveform data and e is 2.718281828. 
This is the base of the natural logarithms. 

Limit (Limit data values) “Clips” data outside the range specified by the set of thresholds in the limit dialog. 
This function will prompt you for an upper and lower limit. Any data values outside 
these limits will be clipped at the closer limit. Although both a high and low 
threshold must be entered, To limit only one extreme (high or low) while leaving 
the other extreme unaffected. For instance, if you wanted to limit data so that all 
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Transform > Math Explanation of Command 

negative values were set to zero but the positive values were left unchanged, you 
would set the low threshold to zero and the high threshold to 99 (or some other 
large positive value that exceeds the maximum value for that channel). 

Ln (Natural Logarithm) Computes the natural logarithm of the selected section. The inverse of this function 
is the exponential function, Exp. 

Log (Base 10 Logarithm) Computes the base 10 logarithm of the selected section. 

In order to perform the inverse of this function, which would be 10x, use the 
Waveform Math power operator with the constant k=10 as the first operand and 
the waveform data as the second operand. 

Noise Converts the selected section into random data values between –1.0 and +1.0. 
This is mainly useful for creating stimulus signals and other waveforms. 

Sin (Sine) Calculates the sine of the selected section. The data is assumed to be in radians. 

Sqrt (Square Root) Takes the square root () of each data point in the selected section. 

Threshold (Threshold 
data values). 

Transforms all data points above the threshold to +1 units, and converts all values 
below the lower threshold to 0 units. Once the data crosses a threshold it will 
continue to be set to +1 for the upper cutoff and 0 for the lower cutoff, until it 
crosses the opposite threshold. The most common application of this function is to 
serve as a simple peak detector, the results of which can be used in rate or phase 
calculations. 

Threshold Algorithm 

Assume a domain variable  t  tstart , tstart 1, tstart  2,K  with tstart being an 

integer, a real-valued signal y(t) defined for all t, and two real valued levels ylow and 
ymax satisfying the relation ylow  yhigh . 

Define the threshold function thresh(t) function such that: 

 thresh(tstart ) 
1 y(tstart )  ylow

0 y(tstart )  ylow





 

 thresh(t) 
0 y(t)  ylow

1 y(t)  yhigh

thresh(t 1) ylow  y(t)  yhigh
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Template Functions 

  
The Template Functions are useful for comparing waveforms. Technically, the template functions provide 
correlation, convolution and mean square error transformations of a template waveform against another 
waveform. To activate the full template menu, select an area and then select set template. 

NOTE: To determine a level of comparison between two waveforms, use the 
Correlation function. 

All the template functions perform a mathematical operation of the template waveform on the waveform to be 
compared, move one sample forward, and repeat the multiplication until the end of the longer waveform is 
reached.  

 

Set Template 

Use the following ECG waveform as an example. An abnormality exists in the record. After detecting an 
abnormality, you should find out if there are other (similar) abnormalities in the record. To do that, you need to 
select the pattern you’d like to search for, and then compare that pattern to other data sets in the file. 

Selecting a section of a wave to be used as a template: 

1) Highlight the section to be used as a pattern. 

  
2) Click the Transform menu and choose Set template from the Template functions submenu. This copies 

the selected portion into a buffer for subsequent template functions 

3) Select the waveform and position the cursor at the beginning of the data. 

4) Choose Correlation from the Template functions submenu. The center waveform in the graph below 
shows the result of the correlation. 

Note the higher amplitude peaks where the template data more closely matches the waveform. The lower 
waveform illustrates the mean square error function, which is similar to the correlation function. 

This indicates that there are two abnormal beats in the record. The first one appears at about 3 seconds and 
is the one used as a template; the second one appears at about 11 seconds. 
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Result of correlation and mean square error functions 

5) Use the zoom tool to inspect the abnormalities more closely. 

 

Remove mean 

A drifting baseline can be a problem in comparing waveforms. If you perform a Template function and the 
template or the waveform has a slowly moving baseline, you can increase the effectiveness of the comparison 
by choosing Remove mean from the submenu of the Template function. The remove mean option causes the 
mean amplitude value of the template and the compared section of the waveform to be subtracted from each 
other before the sections are compared. This way, a large baseline offset will have very little effect on the 
comparison. This option is toggled every time it is selected and is enabled when a check mark is present. 

For example, the following graph shows the original waveform at the top, the correlated waveform with mean 
removal in the middle, and the same correlation without mean removal at the bottom. Note how the mean 
removal effectively compensates for the drifting baseline in the original waveform. 

 
Correlation with and without mean removal 



Part B — Acquisition Functions: The MP150 menu 281 

 

Template algorithms 

The template functions are: correlation, convolution, mean square error, inverse mean square error, normalize 
cross correlation and adaptive template matching. 

a) Correlation is a simple multiplication and sum operation (as shown in the preceding example). The template 
is first positioned at the cursor position in the waveform to be correlated. Each point in the template 
waveform is multiplied by the corresponding point in the data waveform (the waveform to be correlated) 
and summed to produce the resulting data point. The template is then moved one data sample forward and 
the operation is repeated to produce the next resulting data point. The resulting data points replace the 
waveform to be correlated. 

The correlation function algorithm can be expressed by the following formula, where foutput(n) is the 

resulting data point, ftemplate(k) is the template waveform data points, and K is the number of data points 

in the template: 


K

1 =k 

waveformtemplateoutput (n)f * (k)f = (n)f  

 

b) Convolution is identical to the correlation function except that the template waveform is reversed during the 
operation. This function is not generally useful by itself, but can be used as a building block for more 
sophisticated transformations. The convolution function algorithm can be expressed by the following 
formula, where foutput(n) is the resulting data point, ftemplate(k) is the template waveform data points, and 

N is the number of data points in the template: 

f (n) =  f (-k) *  f (n + k)output template waveform

k = -N/2

N/2 - 1

  

 
c) Mean square error positions the template at the cursor position in the waveform to be compared. Each point 

in the template waveform is subtracted from the corresponding point in the waveform to be compared. The 
result is squared and summed to produce the resulting data point. The template is then moved one data 
sample forward and the operation is repeated to produce the next resulting data point. The resulting data 
points replace the waveform. 

The mean square error function tends to amplify the error (or difference) between the template and the 
waveform, which makes it useful when you are looking for an extremely close match rather than a general 
comparison. When a match is found, the mean square error algorithm returns a value close to zero. 

The mean square error function algorithm can be expressed by the following formula, where foutput(n) is 

the resulting data point, ftemplate(k) is the template waveform data points, and K is the number of data 

points in the template: 

f (n) =  [f (k) -  f (n)]output template waveform

k = 1

K


2

 

 

d) Inverse Mean square error simply inverts the result of the mean square error algorithm. Accordingly, when 
this algorithm finds a match between the template and the data, the algorithm returns the inverse of a value 
close to zero and, typically, a large positive spike will occur at the point of the match. 

 

e) Remove Projection Template removes the projection of a reference signal from another part of a signal 
(whereas the other template functions revolve around the comparison of a portion of a signal against a 
reference signal). 
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Remove Projection treats the template in memory as a vector. The projection of the selected area onto the 
template is computed as a vector dot product. This projection is then removed from the source data. After a 
remove projection transformation, the remaining data consists of the part of the signal that is the most 
unrelated to the template. 

Remove Projection can be useful for emphasizing signal differences. For example, it may be useful for 
exploring differences in an arrhythmia in comparison to a normal reference beat. It may also be useful as a 
denoising building block by removing the projection of a signal against idealized noise in the template. 

The number of samples in the template should match the number of samples in the selected area of source 
data. 

 Dot product is undefined for vectors of mismatched dimensions. 

 If the template is longer than the selected source data, the template will be shortened (for that single 
transformation; it will be restored afterward) so its length matches the selection width. 

 If the selection is longer than the template, any data occurring after the end of the template will not 
be transformed. 

To create a Remove Projection template: 
1. Highlight the portion of data to be used as the reference signal. 
2. Transform > Template > Set Template. 
3. Highlight the portion of the data to be analyzed. 
4. Transform > Template > Remove Projection. 
 

f) Normalized cross-correlation is useful when searching for variations in the signal. Regular cross-correlation 
(Transform > Template > Correlation) can exhibit large amplitude spikes when the energy of a signal varies 
greatly or amplitudes change suddenly, causing jumps that are not necessarily indicative of a match with the 
template. Normalized cross-correlation is a statistical method that can help resolve these issues by applying 
normalization to both the template and signal being searched. This reduces the effect of amplitude variation 
in the result, making normalized cross-correlation useful for template matching purposes. 

This transformation computes the windowed normalized cross-correlation, and results in a value between -1 
to 1, which indicates the linear fit of the data set. Normalized cross correlation is defined as: 
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where x = template 
y = signal 
L = length 

= mean value of the signal f 
At the end of the transformation, the source data will be replaced with the sliding NCC values. Data outside 
the selected area will be left unmodified. If the selected area is zero width when the transformation is to be 
executed, the entire waveform will be transformed. 

If selection is shorter than the template, the missing data at the right end of the selected area will be filled 
with zero padding until it matches the length of the template. This padding occurs in memory and will not 
affect the source data in the graph. The same zero padding is used when computing NCC at the end of every 
selected area when the template is running off the end of the data. This zero padding should trend the NCC 
to zero at the right edge of the transformed area, in most cases. 
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Adaptive Template Matching 

Many different types of physiological analysis involve 
locating repetitive features within a signal. These may 
occur at regular intervals or may occur sporadically. 
Sometimes the features of interest may be intermingled 
with other results, such as occassional heartbeat 
arrhythmias occurring in a long-term ECG recording. 
Template matching is one frequently used approach for 
locating areas of waveforms that exhibit certain 
characteristics. An example feature is specified as the 
input template and then, using cross correlation or related 
methods, the areas of an arbitrary wave that most strongly 
match the example can be located. 

Adaptive Template Matching allows the template to vary 
during execution to incorporate changes to the 
morphology of signal features. The adaptation consists of 
a moving average of a number of the most recent 
matching features. A template match will be defined as a 
peak in the windowed normalized cross correlation of the 
adapting template with the signal.  

Normalized cross correlation helps to eliminate artifact due to baseline shift and changes in overall power 
and amplitude. This heuristic is sensitive to waveform morphology instead of amplitude. 

Template width 

The number of samples in the template that will be used as the initial template for the transformation, as 
set using Transform > Template Functions > Set Template. 

Note One template is shared globally by all graphs and data views in AcqKnowledge. 

Average template window size 

Input positive integers only. Provides the number of previous matches to be used for constructing the 
average template estimate. 

Correlation threshold 

Floating point input in the range -1 to 1. Provides the threshold used for peak detection on the 
normalized cross correlation signal. Corresponds to r in the algorithm description. 

Normalize matching data before updating average template 

Toggle check box. When enabled, the reference set normalization algorithm option is used. This 
performs mean subtraction and unit magnitude normalization to every member of the reference set prior 
to constructing the average template. This option can help to compensate for unintentional weighting of 
the windowed average template towards larger amplitude data. 

Reject matches closer than 

When checked, the minimum match interval algorithm option is used. This rejects matches that are too 
close together and can compensate for degeneration of the algorithm into continual matching due to 
signal self similarity. The edit field contains the minimum width that must separate valid matches. The 
width must always be a positive number. The popup menu specifies the units of the separation interval. 
Its contents are dependent on the horizontal axis type: 

Time (seconds & HH:MM:SS) Frequency Arbitrary 
samples samples samples 
milliseconds Hz arbitrary units 
seconds 
minutes 
hours 



284 AcqKnowledge Software Guide 

Visit the online support center at www.biopac.com 

Output 

Show normalized cross correlation values provides access to the sequence of correlation values that is 
examined by the heuristic for potential matches. Viewing the normalized cross correlation signal can 
provide feedback that is useful for proper threshold selection and for detecting whether the heuristic has 
fallen into one of its degenerate cases (e.g. NCC signal hovering around the threshold for extended 
periods of time). When checked, a new channel will be added into the graph containing the normalized 
cross-correlation values computed by the algorithm.The channel will be labeled “NCC Values.” 

Generate synchronization waveform allows for the generation of spike trains. The value of the wave in 
the graph will be zero by default. At each sample position where a match with the average template is 
triggered, the wave value will be set to one. A single sample position set to 1 indicates a single valid 
match. This synchronization wave can be used in conjunction with the cycle detector to perform further 
data reduction, input to the rate detector for computing match frequencies, and other analysis. 

Define events at match locations output allows placement of an event on the waveform being analyzed 
at the location of each valid match. The event output can allow adaptive template matching to be used 
to construct classifiers that provide event locations for further data reduction with the cycle detector.  

 Type—Used to choose the type of event that will be defined at match locations. Displays the 
standard hierarchical menu list of event types. 

 Label—Label to be given to events defined at match locations. 

Transform entire wave 

When checked, the entire waveform will be analyzed. When unchecked, only the selected area will be 
transformed. 
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Integral 

Integral is essentially a running summation of the 
data. Each point of the integral is equal to the sum 
of all the points up to that point in time, exclusive 
of the endpoints, which are weighted by half. The 
exact formula is below, where f( ) is the data values 
and Ts is the horizontal sampling interval: 

f (n) =  f (k) f (n -1) +  f (n)] / 2]* Tsoutput input

k = 1

n -1

input input  [[   

The units will be (amplitude units • horizontal units). The integral function can be used to compute the area 
under the curve in a continuous fashion. For instance, if you had data acquired by an accelerometer, the integral 
of the data would be the velocity, and the integral of the velocity would be the distance. As with all 
transformations, this function can be applied to either a selected area or to the entire waveform. 

Derivative 

   
Derivative calculates the derivative of the selected area of a waveform. Since high frequency components return 
nonsensical results in a derivative, a low pass filtering function is included in the Derivative function (see page 
267 Xfor more information on low pass filters). Derivative is based on an FIR filter implementation. 

The Filter Response for a Derivative transformation will be displayed as a linear graph, not in (log). The 
Derivative FIR filter frequency response will appear as a linearly increasing magnitude up to the point of the 
specified cutoff frequency, at which point, the filter magnitude will drop off sharply. 

 
Derivative can provide a more meaningful result than Difference (which often has a higher than required 
frequency response, thus processing potentially undesirable data). However, if your data is already “well 
behaved” (i.e., low pass filtered or contains little or no high frequency information), you can use Difference 
with a 2-sample interval to quickly generate results very similar to Derivative. 
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Cutoff Frequency The value entered in the cutoff frequency box should be roughly equivalent to the highest 
frequency component of interest present in the time series data. The default cutoff 
frequency is 0.125 times the waveform sampling rate. 

 Sampling rate—Sets the frequency to a fraction of the sampling rate and automatically 
updates when the sample rate is modified. 

 Line frequency—Uses the line frequency at which the data was recorded.  

 # of Coefficients Fixed—The default number of coefficients is (4 x waveform sampling rate)/Cutoff 
Frequency. As the number of coefficients (Q) increases, the Derivative becomes more 
accurate. Fixed can produce better filters but may take longer to execute. 

 Optimize for sample rate and cutoff—Estimate the number of coefficients as four times 
the sampling rate divided by the cutoff frequency of the filter. Optimize does not 
necessarily produce the best quality filter, but takes less time. 

 

Units Select linear units or dbV. 
 

 

TIP: A good rule of thumb is to use a number of coefficients greater than or equal to 
two times the sampling rate divided by the lowest cutoff frequency specified. For 
example, if running a low pass filter at 1Hz on data sampled at 100 Hz, choose at 
least (2 x 100/1) or 200 coefficients in the filter. Additional coefficients will 
improve the response. 
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Integrate 

The Integrate transformation operates 
the same as the Integrate calculation—
see page 1119, except it does not have a 
Max Cycle option, which is not relevant 
post-acquisition, and Reset via channel 
with mean subtraction enabled functions 
differently online and offline. 

 

Root mean square is implemented as:  
Sqrt(sum(x^2)/(n)) 

Reset 

Online Mean subtraction causes the online version to be delayed by the mean cycle length. It waits for 
that period of time to pass so it can determine a mean value for the initial cycle, and it then 
tries to re-compute this mean for each cycle. If the resets are too short or too long, the window 
expires and the processing halts again until a new mean can be recomputed. Online processing 
may reset from threshold crossing in the control channel or window expiration when it loses 
mean tracking. 

Offline  Since all the data is available, the mean is computed from the data in the channel and doesn't 
delay the signal. Also, since it isn’t doing windowed means, there are no window expiration 
events that are inserted. Offline processing may reset from threshold crossing in the control 
channel. 

Output Reset 

 

Enable the 
checkbox 
option to 
create an 
Event at each 
signal reset. 
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The Integrate formula is the same in the calculation (online, real-time) mode and the transformation (off-line, 
post-processing) mode; it varies only based on the parameters selected. 

Notes 

 For the first points, value of index “i” will be less than or equal to zero; it means that for 
summation you have only values beginning with  1xf . 

o For the first point for summation you have:  1xf ,  0xf ,  1xf . 

 1xf and  0xf  - don’t  exist, so you have only  1xf . 

o For the second point for summation you have:  0xf ,  1xf ,  2xf . 

 0xf  - doesn’t exist, so you have only  1xf +  2xf . 

 The Integrate formula is implemented as a Standard Deviation formula (see 
mathworld.wolffram.com > Wolfram Research > equation 5 at 
5http://mathworld.wolfram.com/StandardDeviation.html). 

 The Root Mean Square formula is identical to the Standard Deviation formula, but without mean 
removal; this is the n-1 definition. 

o For an explanation of n-1 verus n in the formula, see notes as a 5pdf or 
5http://www.uic.edu/classes/mba/mba503/971/503nts3.htm. 

o For a window size n, to convert from the n-1 definition to the n definition, use
n

n )1(   

 The formulas to calculate RMS are optimal for data with a 
zero mean (typical for biopotential data). For data with a non-
zero mean, scaling can be applied. Click  the “Scaling” button 
in the Integrate dialog (or click the channel’s vertical scale to 
generate the Vertical Scale dialog and then click the “Scaling” 
button), and then enter the following parameters: 

Input value    Map (Scale) value 
 10 7.07107 
 -10 -7.07107 

 

 
  

 

1. Via samples, no extra parameters selected 

    xxfxF
j

sji
ij  



*
1

 

Where: 
i - index for source values (***the real range is 1..j); 
j - index for destination values (1..n); 
n - number of samples; 

ix , jx - values of points at horizontal axis; 

 ixf - values of points of a curve; 

 jxF - integrated values of points of a curve; 

s – number of samples to average across; 

1
1





n

xx
x n  - horizontal sample interval; 

1, xxn  - values at horizontal axis at the endpoints of selected area. 
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Integrate formulas, continued…  See Notes on page 1288 

  2. Via samples, rectify 

      xxfABSxF
j

sji
ij  



*
1

 
Where:           
i - index for source values (***the real range is 1..j); 
j - index for destination values (1..n); 
n - number of samples; 

ix , jx - values of points at horizontal axis; 

 ixf - values of points of a curve; 

 jxF - integrated values of points of a curve; 

s - number of samples to average across; 

1
1





n

xx
x n  - horizontal sample interval; 

1, xxn  - values at horizontal axis at the endpoints of selected 

area.  
3. Via Samples, root mean square (RMS) 

  
  

1
1

2







s

xf

xF

j

sji
i

j  

Where: 
i - index for source values (***the real range is 1..j); 
j - index for destination values (1..n); 
n - number of samples; 

ix , jx - values of points at horizontal axis; 

 ixf - values of points of a curve; 

 jxF - integrated values of points of a curve; 

s - number of samples to average across.  
4. Via samples, root mean square, remove baseline 
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xf
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xF

j

sji

j

sjm
m

i
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Where: 
i and m- indexes for source values (***the real range is 1..j); 
j - index for destination values (1..n); 
n - number of samples; 

ix , jx - values of points at horizontal axis; 

 ixf - values of points of a curve; 

 jxF - integrate values of points of a curve; 

s - number of samples to average across. 
k - coefficient: for the first few points that have index j < s  k=j, 

for the other points with j > =s    k=s 
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Smoothing 

 
The smoothing function is a transformation that computes the moving average of a series of data points and 
replaces each value with the mean value of the moving average “window.” This has the same effect as a crude 
low pass filter, with the advantage being that smoothing is typically faster than digital filtering. 

Samples AcqKnowledge allows you to set the width of the moving average window (the number of 
sample points used to compute the mean) to any value larger than three. By default, this is set 
to three samples, meaning that AcqKnowledge will compute the average of three adjacent 
samples and replace the value of each sample with the mean before moving on to the next 
sample. For data acquired at relatively high sampling rates, you will probably want to set the 
smoothing factor to a higher value, since smoothing three sample points when data is 
collected at 1000 Hz will only average across three milliseconds of data, and will typically do 
little to filter out noise. To set the size of the window, enter a value in the Transform > 
Smoothing dialog. 

 This function is most effective on data with slowly changing values (e.g., respiration, heart 
rate, GSR) when there is noise apparent in the data record. 

Mean value Mean value smoothing is the default and should be uses when noise appears in a Gaussian 
distribution around the mean of the signal. The Mean value smoothing formula is shown 
below, where “m” is the number of points in the window and “n” is the sample number: 

m/(k)f   = (n) f
1)/2]-[m+nk

(m/2)-n=k

inputoutput 


 

Median value Use Median value smoothing if some data points appear completely aberrant and seem to be 
“wild flyers” in the data set.  

  The Median value smoothing formula is shown below, where “m” is the number of points in 
the window and “n” is the sample number: 

[m/2]) n [m/2];-(n median   = (n) f output   

Scaling  Generates the Scaling Parameters dialog. 
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Difference  

 
The Difference function measures the difference (in amplitude) of two sample points separated by an arbitrary 
number of intervals. The difference is then divided by the total interval between the first selected sample and 
the last selected sample. 

When you select the difference transformation, a difference interval dialog will be generated and you can enter 
the number of intervals between samples (default of 1). 

For data with no high frequency components, a 1-interval difference transformation approximates a 
differentiator. 

Since it is not implemented as a convolution, Difference is much faster than the derivative function. 

The formula for the difference transformation is shown below, where “m” is the number of intervals difference, 
[ ] rounds the integer down, “n” is the sample number, and Ts is the horizontal sampling interval: 

foutput(n) = finput(n + [m/2])—finput(n—[(m+1)/2]) 

 (Ts * m) 

Example for boundary values when 
m = 3:

foutput(0) = (finput(1)—finput(0)) / (Ts * m) 

foutput(1) = (finput(2)—finput(0)) / (Ts * m) 

foutput(2) = (finput(3)—finput(0)) / (Ts * m) 
 

If you enter an odd number
(K = odd):

foutput(K) = (finput(K+1)—finput(K –2)) / (Ts * m) 
 

If you enter an even number
(K = even):

foutput(K) = (finput(K+2)—finput(K –2)) / (Ts * m) 

 

 

Note:  The online (real-time) Difference calculation is calculated differently because projected values are not 
available. The online Difference formula is: 

foutput(n) = finput(n –m)—finput(n) / (Ts * m) 
 Using the default difference setting of 1 interval will produce a “P/T” waveform when the 

transformation is applied to a blood pressure or similar waveform.  
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Resample  

   

TIP  A good rule of thumb is to sample from two to ten times the highest frequency component of interest. 

Variable sampling rate and the flexible acquisition speeds of MP150 units can create data sets that are at 
different sampling rates. For some types of data analysis, the data must be resampled to a common sampling 
rate. AcqKnowledge has resampling facilities with Transform > Resample Graph; Transform > Resample 
Waveform, and Pasting between graph windows of different sample rates when the “Interpolate pastings 
between graphs” Preference is enabled (via Display > Preferences, page 424). 

AcqKnowledge provides three interpolation methods for resampling data. Any changes made to the interpolated 
pastings between windows Preference and the interpolation method used in the Preferences dialog will be 
retained across launches of the software. 

Padding—Padding will use the closest original value of the waveform to the left of the new sample 
position for the value, constructing a padded square save as the data is resampled. Padding is desirable 
when it is imperative no new data or data approximations get introduced into an analysis. 

Linear—Linear interpolation is the default; previous software versions generated any missing data via 
linear interpolation. This method uses the sample points of the old waveform as the endpoints of a line. 
Missing data points are approximated from points lying on this linear segment. 

Cubic spline—Cubic spline interpolation will construct a spline for the entire data set and use the values of 
this spline as the new waveform values. A natural fit spline is used that keeps zero second derivative at the 
endpoints of the fit. Cubic splines are useful when the analysis requires data with a smooth derivative. 

Resample Graph 

Apply an arbitrary, user-defined sample rate to all graphs in the file. 

 The highest rate you can enter is the Acquisition Sample Rate. 

 This option will adjust as necessary to maintain the established channel rate/acquisition rate proportion. 

 You can create channel-specific rates by changing the channel sample rate after Resampling. 

Resample Waveform 

Resamples the active channel to a different rate. Resampling data maintains the same time scale but changes 
the number of samples per second. You can also use Resample to increase the number of sample points per 
interval (usually samples per second). When this is done, AcqKnowledge will interpolate between sample 
points to adjust to the new rate. This will add data points, although not necessarily more information. 

 Resampling to a a lower sampling rate will “compress” a data file and information will be lost. 

 For instance, a 4-channel data file sampled at 250 samples per second for 15 minutes takes up about 
1.8 MB of disk space. If these channels are resampled to 100 samples per second, the size of the file 
on disk is about 720 KB, a considerable reduction 

 The highest rate a channel can be resampled to is the file acquisition rate (MP150 menu > Set Up 
Acquisition). 

 If data is resampled to a lower rate and then resampled again at a higher rate, the waveform will 
maintain the resolution of the lower sampling rate, only with more data points. 

The alpha component of an EEG signal has a frequency signature of 8-13Hz, so (assuming you have isolated 
the alpha component using a band pass filter) you would probably want to sample the data (in this case, isolated 
alpha waves) at a rate of at least 26Hz and probably no more than 130 Hz.
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Equation Generator (Expression) 

    
The post-acquisition Equation Generator (Expression trasnformation) is available for performing computations 
more complex than available with the Math and Function calculations. The post-acquisition version of the 
Equation Generator (Expression transformation) includes all the same features as the online version described 
on page 133. The Equation Generator (Expression transformation) will symbolically evaluate complex 
equations involving multiple channels and multiple operations. Unlike the Math and Function calculations, 
which can only operate on one or two channels at a time, the Equation Generator (Expression transformation) 
can combine data from multiple analog channels, or specify other calculation channels as input channels. Also, 
computations performed by the Equation Generator (Expression transformation) eliminate the need for 
“chaining” multiple channels together to produce a single output channel.  

To have AcqKnowledge solve an equation/expression and save the result to a new channel, choose Transform > 
Expression (Equation Generator). A dialog will be generated. For each equation/expression, specify a source 
channel (or channels), the function(s) to be performed, any operators to be used, and a destination for the result. 
The different components of each equation/expression can be entered either by double-clicking items from the 
pop-up menus (sources, functions, and operators) in the setup dialog, or by typing commands directly into the 
box using standard mathematical notation. 

You can divide a complex equation into several steps and perform each part of the equation with a separate 
channel. With up to 60 channels, almost any calculation can be performed. 

The Equation Generator (Expression transformation) can reference past and future points. 

 

Delay 

The Delay transformation allows the addition of time delays in postprocessing (similar to the Delay calculation 
channel that can be used to add time delays to signals). The time delay can be added by introducing zero-valued 
samples at the start of the area to be delayed. The length of the waveform will remain the same; an amount of 
data at the end of the wave prior to the delay will be lost, with the length equal to the delay. The delay can be 
applied by using the Transform > Delay menu item. 

 
When inputting the delay amount, the units can be changed between seconds and samples. 

 Delay by samples is applied according to the acquisition sampling rate, not the channel sampling rate. 
Delay specifies the units of acquisition and graph sampling rate for samples. For Delay calculation 
channels, the units of “samples” need to be kept constant under changes to the channel sampling rate as 
there is no opportunity to adjust them. As a result, acquisition sampling rate is used to determine 
“samples” for calculation channels. This same logic is applied to the transformation. 

The Automator action allows Delay to be used in Automator workflows. See page 125. 

See the tables starting on page 85 
for descriptions of sources, 
operators and functions for the 
Equation Generator/Expression 
dialog. 
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Rescale 

The Rescale transformation operates the same as the Rescale calculation—see page 1147. 

 

Waveform math 

 

 
The Waveform math transformation allows arithmetic manipulation of waveforms. Waveforms can be added 
together, subtracted, multiplied, divided or raised to a power. These operations can be performed using either 
two waveforms or one waveform and an arbitrarily defined constant. You can operate on the entire waveform 
by choosing Edit > Select all, or operate on portions of the waveform that have been selected using the cursor 
tool. If there is no selected area, only one sample point (the one selected by the cursor) will be transformed.  

When you select Transform > Waveform Math, the Waveform Arithmetic dialog will be generated. 

All of the main components of a waveform math calculation can be selected from pop-up menus in the 
Waveform Arithmetic dialog. 

Source  The channels to be used in the transformation are referred to as source channels (Source 1 and 
Source 2), and can be combined using any of the operators in the pop-up menu. Source 
channels allow you to select any of the existing channels in the current window, or a constant 
(defined by K). 

Constant The “Constant =” entry box is activated when a Source is set to “K, Constant.” 

Operand  The pop-up menu allows selection of addition, subtraction, multiplication, division or power 
functions.  

Destination  You can save the results to an active channel, or create a new channel to store the results. 
Choose an existing channel from the pop-up menu or select the “New” option, which will 
create a new channel (using the next available channel). 

Result sample  When using variable sample rate processing, the Equation Generator (Expression 
transformation) and Waveform 
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rate Math functions will constrain operations between waves of different rates as follows: 

 If an equation is operating on two or more waves of different sample rates, the result of 
the operation will always be output at the lowest sampling rate from the waves (F low). 

 If the destination channel for the result has an assigned rate other than (F low), the 
operation will not be permitted. 

 If the destination channel is set to a new channel, the operation will always be 
permitted. 

Scaling… Generates the scaling parameters dialog. 

Waveform math can be used many ways. As one example, two waveforms can be added together. The 
following screen shows a sine wave in channel 14 and a triangle wave in channel 16. 

 
To add these two waves, select Transform > Waveform Math and set source 1 to channel 14, the operator to 
addition “+”, source 2 to channel 16, and destination to New as shown here: 

 
Click OK to perform the transformation. The following screen shows the sum of CH14 and CH16 on a new 
channel. 

 
 

NOTE:  If you select two waveforms of unequal length as sources, the length of the resulting 
waveform will be equal to that of the shortest one. Likewise, if one of the source 
waveforms extends only into a portion of the selected area, the resultant waveform 
will only be as long as the shortest source portion. If waveform math is performed on 
a selected area and output to an existing waveform that does not extend into the 
selected area, the resultant waveform is appended to the destination waveform. 
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Chapter 16 Analysis Menu Commands 
Overview 

The Analysis menu contains operations that derive data and measurements from the graph—plus a courtesy 
copy of the Specialized Analysis package with classifiers and automation routines. 

 

Histogram 

  
The Histogram function produces a histogram plot of the selected area. When a histogram is created, the sample 
points are sorted into “bins” along the horizontal axis that contain ranges of amplitude values. These bins divide 
the range of amplitude values into equal intervals (by default, ten bins) and the individual sample points are 
sorted into the appropriate bin based on their amplitude value. 

For instance, if a waveform had a range from 65 BPM to 85 BPM, the lowest bin would contain all data points 
with a value from 65 BPM to 67 BPM. The second lowest bin would hold all data points between 67 BPM and 
69 BPM, and so on, until the tenth bin was created. AcqKnowledge then counts the number of “hits” (the 
number of data points) in each bin and plots this number on the vertical axis. 

Analysis > Histogram Options: 

bins Determines how many bins the data will be divided into; the default is ten bins.  

Autorange  Fits all the data selected into a bin; the bin sizes are determined by the extent of the data and the 
desired number of lines. Automatically sets the center of the lowest bin equal to the minimum 
value of the waveform (or the selected area, if a section is highlighted), and centers the highest 
bin on the maximum value of the waveform (or selected area, if any).  

 Disable to fix the bin sizes and enter values for Highest Bin and Lowest Bin.   

When you click OK, a histogram plot will be generated in a new window. By default, AcqKnowledge displays 
the frequency of occurrence for each bin on the vertical axis. To calculate the cumulative frequency, select the 
entire histogram waveform and choose Integrate from the Transform menu. 

Since the histogram function sorts sample points into a relatively small number of categories, the histogram 
window is likely to display a large number of “hits” in each bin, especially if data was collected at a relatively 
fast sampling rate. If this is the case, you may want to resample the data at a lower rate (using the Transform > 
Resample function). The caveat to this is that resampling the data may cause a bias, unless the data was filtered 
to remove all frequency components that are more than 0.5 the resampling rate. 

 



Part B — Acquisition Functions: The MP150 menu 297 

 

Autoregressive Modeling 

About autoregressive modeling 
Autoregressive Modeling is a linear mathematical modeling algorithm that represents a signal as a 
weighted sum of its previous values combined with a noise factor. Autoregressive models are adept at 
capturing frequency behavior of an input signal and may be useful in generating high-resolution FFTs 
from undersampled data. 

AR models are well suited to operation on discrete series of data and are particularly useful for 
expressing frequency information of a signal. Consecutive models can be used to perform advanced 
time series analysis, compression, denoising, arrhythmia detection, and waveform classification. AR 
models are commonly used on physiological data in advanced spectral analysis, and increasingly for 
classification of heart rhythms and gastric waves or visual detection of arrhythmias. 

AR models can be used to extrapolate spectral features from waveforms at low sample rates. 

 Generate high-resolution FFTs without fast acquisition sample rates (quite useful for 
electrogastrogram analysis). 

 An FFT from a 3,000-point AR Model provides the same result as a 42,000-point FFT. 

 Examine spaces of AR parameters for feature extraction. 

Since the underlying model is linear, AR modeling is not appropriate for representing signals that are 
inherently chaotic. 

 
AR Time-Frequency Analysis is on page 1300. 

Autoregressive modeling estimates the parameters of a 
fixed-order autoregressive model, representing a 
model output value as a linear sum of previous input 
values. AR modeling may replace the source data with 
the model of equivalent length. The output length is 
equal to the source data, unless specified. 

Output can also paste model parameters as tabular text to a journal. If “Don’t modify waveform” and “Show 
model in separate graph” are both enabled, a new graph window will be generated to display the specified 
number of samples resulting from the best-fit autoregressive model. 
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Nonlinear Modeling 

About nonlinear modeling 
Modeling is used in physiological data to assess how well data conforms to a theoretical model. This is 
used to express a sampled signal in a continuous form and to perform data reduction. The nonlinear 
modeling features in AcqKnowledge support more advanced physiological analysis than is possible with 
the linear regression measurement, which is a rudimentary single order linear model. 

Nonlinear modeling is the process of finding the best fit of a mathematical function to an arbitrary data 
set. Fitting the function—or model—to the data consists of choosing a set of function parameters that 
minimize error between the actual data points and the values generated from the model function. 
Nonlinear modeling functions can be arbitrarily complex. When the model is close to the shape of the 
data, the fits between different data sets may be good indicators of subtle variations in the data. 

Most general-purpose methods of performing modeling are iterative and require an estimator for the 
function. A commonly used estimator is the least means squares (LMS) estimator. Nonlinear models can 
be estimated from data by combining LMS estimators with multidimensional function minimization 
algorithms. 

Applications in hemodynamics 

Many pressure and ECG signals exhibit regular morphologies. Fitting data to models that share these 
characteristics helps emphasize subtle differences in waveforms though variations in their model 
parameters. Nonlinear modeling is one of the most accepted methods for computing indexes for the 
relaxation period of left ventricular pressure. Cardiac researchers have used the time constant “tau” in 
various studies on cardiac function and abnormalities. Tau is determined by one of the parameters to 
an exponential model of the trailing end of the pressure signal. Studies have indicated that tau can be 
a good indicator of cardiac dysfunction, but reliable methods for its calculation have proven difficult 
and the effort is ongoing. The generic modeling abilities in AcqKnowledge allow researchers to 
analyze data using the tau constant and potentially develop robust algorithms for its calculation. 

 
See the NLM measurement on page 198 

Nonlinear modeling (also called “arbitrary curve fitting“) 
determines the “best fit” of an arbitray function to source 
data; the function is called a model. 

AcqKnowledge uses a Nelder-Mead simplex search with 
a Euclidean distance function. A model must match 
underlying trends in the data to produce meaningful 
results. Also, to properly interpret the value of the best fit 
coefficients and any further derived results, users must 
consider the limitations of the simplex search method, 
which include: estimation only; not guaranteed to 
terminate; not guaranteed to find the exact solution; may 
get stuck in local minima. 

Nonlinear modeling generates a new display and replaces source data with a model of equal (unless specified) 
length and also pastes model parameters as text to a journal. The sampling rate and axis units match the source 
graph. 

Max iterations 

Indicates the number of iterations after which the simplex search will be terminated if no convergence has 
been achieved. 

Tolerance 

Provides the tolerance used for termination of the algorithm. If the estimator decreases in two consecutive 
steps by less than this tolerance, the simplex search will halt. 
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Model origin placement 

Controls where the zero point of the model is placed. Selection-relative placement is useful when comparing 
different sections of the same channel of data by looking for variations in their best fit model parameters. If 
channel data is used as part of the Model Expression the location from where the channel data is extracted 
will not be translated; regardless of the model origin setting, the channel data will be used from the selected 
area only. 

Model Expressions 

Models are defined through basic expressions, called Model Expressions. See the function tables starting on 
page 1137 for details on Sources, Functions, and Operators. 

Preset 

The following presets for the most common types of models are included. Users can extend presets or create 
custom models if these presets are too general to achieve exact fits with simplex search. Presets are stored at 
Computer > Local Disk > ProgramData > BIOPAC Systems, Inc > AcqKnowledge 4.0 > Presets. 

Preset Description Equation 

Cubic 3rd order polynomial. param(3)*(TIME^3)+param(2)*(TIME^2)+param(1)*TIME+param(0) 

Gaussian Standard Gaussian model; useful 
for peak fitting. 

param(0)*EXP(-((TIME-param(1))/param(2))^2 

Linear Basic linear fit of the data. param(1)*TIME+param(0) 

Logarithmic Logarithmic growth and decay; 
useful for initial rapid growth/decay 
followed by gradual 
decline/increase. 

param(0)*LOG(TIME-param(1))+param(2) 

Logistic Logistic LVP relaxation model; 
TL given by a(1). 

param(0)/(1+EXP(-TIME/param(1)))+param(2) 

Monoexponential Exponential LVP relaxation model;
Te given by a(1). 

param(0)*EXP(-TIME/param(1))+param(2) 

Power Series Useful for a wide variety of data, 
e.g. reactant analysis. 

param(0)+param(1)*(TIME^param(2)) 

Quadratic 2nd order polynomial. param(2)*(TIME^2)+param(1)*TIME+param(0) 

Weibull 
Distribution 

Commonly used in reliability 
analysis. 

param(0)*param(1)*TIME^(param(1)-1)*EXP(-param(0) 
*TIME^param(1)) 

Sources 

All channels except the channel being modeled can be used as Sources; if the channel of data being modeled 
is inadvertently set as a Source, a syntax error prompt will be generated. 

Parameters 

Parameters are represented by param(n) where n is an integer index starting from zero. For example, in the 
linear model param(0)*x+param(1), param(0) can be interpreted as the “a” in “ax+b and param(1) can be 
interpreted as the “b” in “ax+b”. 

Output to Journal displays the result of the modeling as text in the journal. 

Show model in separate graph generates a separate graph to display the best fit model. 

Length specifies the length of the separate model graph in samples. 

Don’t modify waveform suppresses replacement of the selected source data. 

 If the model fitting does not complete successfully, the original data will be preserved regardless of 
the state of this selection. 

Transform entire wave 

Fits the entire data of the selected waveform to the model, with model origin at start of graph. 
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Power Spectral Density 

The Power Spectral Density (PSD) function extracts the 
power present at different frequencies within a signal and is 
useful for EMG analysis. The PSD transformation 
approximates the same result as squaring the linear FFT 
magnitude. PSD is not available when the horizontal units 
of the source graph are set to Frequency. 

AcqKnowledge uses the Welsh approximation algorithm to 
average signal time-sliced portions of the signal and reduce 
noise effect, and generates a two dimensional graph 
displaying the wattage of a particular frequency component 
in a signal. Windowing options are Hanning, Hamming, or 
Blackman. The graph is plotted as horizontal frequency vs. 
vertical (units)^2/Hz, where units are the vertical axis units 
of the source data.  

Use linear detrending for each window—when enabled, linear regression detrending is applied for each 
individual segment prior to the FFT computation; when disabled, windowing only is applied.  

Detrend each segment independently—becomes available when “Use linear detrending” is enabled. When 
this option is enabled, detrending is applied independently for each segment; when disabled, detrending from 
the previous segment will be incorporated into the next segment. 

 

AR Time-Frequency Analysis 

 

The AR Time-Frequency transformation can be used to 
examine changes in the spectral density of a signal using 
enhanced frequency resolution from derived AR models. 
Examining frequency changes over time can be a useful tool 
for arrhythmia detection and rough classification of 
waveforms. 

Autoregressive spectrum time-frequency analysis divides a 
waveform into equal-length time segments, calculates an AR 
model (see page 1299) for each individual time segment, and 
then computes a power spectrum from the model. (To perform 
raw data time-frequency analysis, use the Cycle/Peak detector 
with the FFT 3D output option.)  

 

Time interval—Enter a positive floating point value to specify the segment width; the source signal is split into 
fixed length segments of this width and a frequency spectrum is generated for each segment from a model of its 
data. 

Model order—Enter a positive integer to specify the order of the AR model that is constructed on an interval 
by interval basis. 

Frequency resolution—Enter a positive integer to indicate the number of points contained in the FFT of an 
individual time segment; it will be rounded to the closest power of 2 when analysis is performed. 

Amplitude scaling—“Normalize amplitudes” scales amplitudes such that the maximum peak-peak distance is 
equal across time intervals. 

Show 3D Output—Constructs a 3D surface plot of the time-frequency analysis with amplitude vs. frequency 
vs. time. 

Paste results to journal—Inserts a series of tab-delimited tables representing the frequency distributions on a 
cycle-by-cycle basis into the Journal. 
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FFT Fast Fourier Transformation 

 
The FFT algorithm requires that the length of your data be an exact power of 
two (i.e., 256 points, 512 points, 1024 points, and so on). 

The Fast Fourier Transformation (FFT) is an algorithm that produces a description of time series data in terms 
of its frequency components. This is related to the frequency spectrum. The FFT displays the magnitude and 
phase of the time series data selected and displays only the DC and positive frequency components; the FFT 
does not display negative frequency components. To reconstruct a signal from additive sines or cosines, you 
need to include both the positive and negative frequency components. Since it’s not physically possible to 
generate a negative frequency signal, you need to double the amplitude of the corresponding positive frequency 
component. 

The output from an FFT appears in a graph window with magnitude (vertical axis) plotted against various 
frequencies (horizontal axis). A large component for a given frequency appears as a positive (upward-pointing) 
peak. The range of frequencies plotted is from 0 Hz to 1/2 the sampling frequency. Thus, if data was collected 
at 200 samples per seconds, AcqKnowledge will plot the frequency components from 0 Hz to 100 Hz. 

Fourier analysis can yield important information about the frequency components in a data set, and can be 
useful in making determinations regarding appropriate data cleaning techniques (e.g., digital filtering). The FFT 
algorithm assumes that data is an infinitely repeating periodic signal with the end points wrapping around. Thus, 
to the extent that the amplitude of the first point differs from the last point, the resulting frequency spectrum is 
likely to be distorted as result of this start point to end point discontinuity. This can be overcome by 
“windowing” the data during the transformation. For more information on the windowing feature, see the 
window section that follows. 

The FFT transformation cannot be performed in real time (i.e., during an acquisition). To emulate an online 
spectral analysis, use online filters and the Input Values window. See page 221 for more information about real-
time frequency information. 

 

Pad If a section of data is selected that is not a power of two, AcqKnowledge will always “pad” data 
up to the next power of two, filling in the remaining data point with either 

Pad with zeros: a zero 

Pad with endpoint: the last data point in the selected area 

In other words, if 511 data points are selected, AcqKnowledge will use a modified version of 
the waveform as input. The modified waveform will have 512 points, and the last point in the 
modified wave will be either a zero or equal to the 511th point of the original data. 
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Show Mod. To view the modified waveform being used as input for the FFT, check the Show modified 
input box. Whenever possible, it is best to use an input waveform (select an area) that is an 
exact power of two. The waveform is modified by applying the windowing and padding 
options. Window functions diminish the discontinuities that occur at either end of the wave. 

 
Window The FFT algorithm treats the data as an infinitely repeating signal with a period equal to the 

length of the waveform. Therefore, if the endpoint values are unequal, you will get a frequency 
spectrum with larger than expected high frequency components due to the discontinuity. 
Windowing these data minimizes this phenomenon. For example, to apply a window 
transformation to a sine wave whose endpoints do not match up, check the box next to Window 
and choose a type of window from the pop-up menu. Each of the windows has slightly different 
characteristics, although in practice each provides similar results within measurement error.  

 As shown below, the frequency spectra of the windowed and non-windowed data differ 
significantly when the endpoints are unequal. When data are not windowed, the very low and 
very high frequencies are not attenuated to the same extent as when windowed. 
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Remove  Sometimes, data contains a positive or negative trend that can cause extraneous  
Trend  frequency components to “leak” into the frequency spectrum. In this case, you could select 

remove trend when you perform the FFT, which will draw a line through the endpoints, and 
then subtract the trend from the waveform.  

For example, the 
following sine wave 
has an upward trend 
through the data 
(positive trend 
component). The lower 
graph shows FFTs of 
the skewed sine wave 
data with and without 
the trend removed. 

Note that the spectrum 
of the data without the 
trend removal has 
gradually decreasing 
frequency components, 
while the data with the 
trend removed has far 
fewer frequency 
components except for 
the single spike due to 
the sine wave. 

 

without trend removal

trend removed

 

Remove Mean  Remove mean calculates the mean of all the points in the selected area and then subtracts it 
from the waveform. This is generally useful for windowing a waveform that has a large DC 
offset. 

 As an example, you might start with a sine wave with a 10-volt DC offset (with a little noise 
added to broaden the spectrum), and perform spectral analysis with and without mean removal: 

 
 Note the large spectral components at the beginning of the top plot, without mean removal. 

This is due to the offset of the original data. The bottom plot is with mean removal. 
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 Since the offset of the waveform is often an artifact of the way it was generated, the remove 
mean option provides a more accurate indication of the true spectral components. This is 
especially true for applications where low frequency components are of interest. If your data 
has a large DC offset and you plan on windowing the data, you will generally get a more 
meaningful spectrum if you remove the mean prior to windowing (which is the same order the 
FFT uses). 

Linear By default, the FFT output is described in terms of frequency along the horizontal axis and 
dBV on the vertical axis. The Bell scale (from which dB are derived) is logarithmic, and in 
some cases it may be useful to have the output scaled in linear units. To do this, click the button 
next to linear and check OK. The other options in the dialog work as they normally do when the 
dB scaling option is selected. The relationship between log and linear units is: dBVout = 20 log 
VIN. 

Phase The standard FFT produces a plot with frequency on the horizontal axis and either dB/V or 
linear units (usually Volts) on the vertical axis. In some cases, it may be useful to obtain phase 
plots of the waveform (as opposed to the default magnitude plots). Phase plots display 
frequency along the horizontal axis, and the phase of the waveform (scaled in degrees) on the 
vertical axis. This option functions exclusive of the magnitude option—you can check either 
independently, or if you check both, two plots will be produced (a magnitude plot and a phase 
plot). 

 

Inverse FFT 

 

The Transform > IFFT menu option is generated after an FFT is 
performed. An Inverse FFT (Transform > IFFT) converts spectral 
values back to a time series waveform to reverse the FFT 
transformation. Any modifications to the original data (such as 
windowing or padding) will be shown in the resulting time series 
data. 

To obtain a meaningful IFFT result you must have a graph window 
open with at least one magnitude channel and at least one phase 
channel. With the window open, choose IFFT from the Transform 
menu to generate the Inverse FFT dialog. 

To accurately recreate the time series waveform  

1. Select the source channels for the inverse FFT in the Magnitude and Phase pull-down menus. 

2. Select whether to express Magnitude in linear units or dB logarithmic units (decibels). To determine 
this setting, check the vertical axis units of the magnitude channel; this should correspond to the 
Magnitude scaling choice that was used when performing the forward FFT. 

 The Phase waveform must be in degrees. 

3. Click OK to perform the IFFT. 

 The result is generated in a new time domain window, labeled “IFFT of Spectral…”
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To perform an FFT, you might start with an electroencephalogram (EEG) signal acquired when the 
subject alternated between eyes open and eyes closed. Typical results suggest that higher levels of alpha 
activity (activity with frequency components between 8Hz and 13Hz) are to be expected when a subject’s 
eyes are closed. 

1. The raw data, prior to FFT, is shown here: 

 Eyes
open

Eyes

Eyes
open

closed

 

2. Select Transform > FFT from the menu. 

The FFT Parameters dialog will be 
generated; in this example, the Window 
function chosen is Kaiser Bessel: 

 

13107

3. Click OK. 

A frequency domain window (a graph 
window which places frequency along the 
horizontal axis rather than time) will be 
created and displayed, showing the spectrum 
of the input data. 

The window is named “Spectral of (the 
original window name)” and ends with the 
channel number, as shown here: 

The resulting magnitude value for each 
component is equal to the peak value of the 
sine wave contributing to that component. 
The entire pattern of frequency components 
is known as the frequency spectrum of the 
data. The somewhat erratic appearance of the 
spectrum is usually due to small-scale 
variations in the original waveform. 

4. Optional—This “noise” can be removed by 
applying a smoothing transformation to the 
FFT output. In the graph shown, there is a 
pronounced frequency component centered 
on 8Hz, which corresponds to the alpha wave 
frequency band (8Hz—13Hz). The frequency 
spectrum (0-20 Hz shown) used 20-point 
smoothing. 
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DWT Discrete Wavelet Transformation  

 

About Wavelet Transformation 
Wavelet transforms are similar to Fourier transforms. Instead of 
projecting a signal in a space of sines and cosines, wavelet transforms 
project a signal into a space comprised of orthogonal functions called 
wavelets. Discontinuities are more obvious in wavelet transforms than in 
sines and cosine analysis, making wavelet transforms a better choice 
for decomposing a signal to its fundamental form. Wavelet transforms 
can be used for noise reduction and filtering, extracting features from 
signals that are not apparent in time or frequency domains, and 
predicting signal qualities from a small number of data points. 

Discrete wavelet transforms break a source signal into high-frequency and low-frequency components. Use for 
ECG and EEG analysis. DWT creates a new graph with wavelet coefficients on the horizontal axis and the 
amplitude for each coefficient on the vertical axis, pastes acquisition settings to the graph-specific journal, and 
places an event at each boundary between the high- and low-frequency components produced at each iteration. 

 Wavelet type Specify Biorthogonal 4.4, Symlet 4, Coiflet 6, or Daubechies 8. 

 Number of iterations Specify the number of transforms to execute iteratively. 

Inverse DWT 

Operational on the result of a DWT. Projects data from wavelet 
space to time space. For correct recomposition of the source 
data, the wavelet type specified for the IDWT must match the 
wavelet type used for the DWT. Amplitudes of the wavelet 
coefficients may be changed, but an IDWT will fail if the 
horizontal units, events at DWT iteration level boundaries, or 
file length have been modified. 

 

Principal Component Analysis 

 

About Principal Component Analysis 
Principal Component Analysis decomposes source signals into a 
new signal space (constructs an orthogonal set of vectors). PCA is 
useful as a feature extraction and data reduction tool.  

Changes in the values of the mixing matrix may be indicative of 
changes in underlying signal morphologies that other methods 
cannot easily detect.  

For example, PCA is useful for EEG analysis; where it can reduce 
32 channels to the fundamental elements of signals.  

AcqKnowledge uses a mean-adjusted covariance matrix method to generate a new PCA graph with each 
component in a separate channel. The coordinates of the new space are the eigenvalues extracted from the 
matrix defined by the source data and are called “Principal components.” The extracted eigenvectors are the 
“mixing matrix.” Sine and cosine are orthogonal signals. The principal components are numbered in order of 
decreasing eigenvalues, which implies that the first principal component contains the majority of the variation 
of the source signals. Results are also pasted in to the journal, including the eigenvalue magnitudes and the 
eigenvector matrix. To determine the percentage contribution of each component, review the eigenvalue 
magnitudes. Select two or more channels—all of the selected channels must have the same sampling rate. 

Inverse PCA 

Available only for graphs produced by PCA. Reconstructs the source signals based on the components and 
mixing matrix of the PCA graph. The graph is reconstructed in a new window, with a list of the components 
used pasted to the journal. 

 For noise reduction, use only the strongest principal components to reconstruct the source signals. 
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Independent Component Analysis 

 

About Independent Component Analysis  
Independent Component Analysis is useful for signal separation, 
denoising, and advanced EEG analysis to remove noise signals or 
locate approximate regions of active processing centers in the brain. 
ICA is a form of statistical blind separation that attempts to separate 
mixed (overlapped) signals based on the assumption that they are 
statistically independent. 

 For example, if two microphones in a room record one person 
reciting Shakespeare and another person playing the banjo, the 
recordings will capture both the speaker and the banjo. After 
performing ICA on the two recordings, one result will have only 
the speaker and the other will have only the banjo. 

AcqKnowledge uses the FastICA algorithm to generate a new ICA graph with each component in a separate 
channel. 

Select two or more channels—all of the selected channels must have the same sampling rate. 

Specify tolerance and number of iterations. 

ICA limitations to consider for application and interpretation: 

1. The number of mixed sources must be equal to the number of independent components (as in the 
example where two microphones captured two sound types). 

2. Sources must be statistically independent; highly-correlated signals cannot be effectively separated. 

3. Sources must have non-Gaussian probability distribution. It is not possible to separate out components 
like white noise through ICA. 

4. Signal mixing must be a constant, linear process. Any type of non-linear signal propagation cannot be 
expressed in linear combinations of sources, the underlying assumption of ICA. 

5. The component sources must be stationary (that is, point sources). 

 

Inverse ICA 

Available only for graphs produced by ICA. Reconstructs mixed signals based on the components and 
mixing matrix of the ICA graph. The statistical nature of the algorithm implies that it cannot perfectly 
reconstruct original source data—it estimates the most probable set of source signals. The graph is 
reconstructed in a new window, with a list of the components used pasted to the journal. 



308 AcqKnowledge Software Guide 

Visit the online support center at www.biopac.com 

Find Cycle (Peak Detector)  

 
Overview 

The advanced Cycle/Peak Detector combines with the powerful new Event Marking System. Use it to perform 
amplitude, time, or event-based measurements. New output options for measurements, averaging, events, 
clustering (K-means), and 3D surface (cycle data, histogram, FFT, and DWT). 

The Find Cycle detector uses three tabbed settings panels to define and automate cycle/peak detection: 

Cycles/Peaks Selection Output 

Cycle detector settings are graph-independent, which means that find cycle/peak operations can be performed 
in multiple graphs without needing to re-enter graph-specific settings for each run. By using multiple data 
views, different find cycle/peak operation can be performed on the same set of data without losing settings 
between “Find Next Cycle/Peak” operations. 

When the Cycle/Peak Detector is first opened for a graph, the dialog will be filled with the values from the last 
successfully executed find Cycle/Peak operation. Subsequently, changes to the settings will be applied only to 
that graph. 

TIP If you're running the cycle/peak detector multiple times and need to put the cursor back at the 
beginning of the waveform for the next pass, use the keyboard shortcuts Home, End, Page Up, and 
Page Down to quickly change cursor location (see page 64). 
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Cycles/Peaks tab 

  
Peaks Events 

 
Fixed Interval 

A cycle is defined as the interval between two events of user-specified types. The Cycles/Peaks tab offers three 
general methods for establishing cycle parameters: 

 Peaks: Data driven maximum and minimum 

 Events 

 User-defined fixed time intervals 

When the cycle location mode is switched on the “Cycles/Peaks” 
tab, the edge selection offsets will be checked. If they are non-
zero, a prompt will generated to warn that that the edge 
adjustment offsets may not apply for the new cycle location 
mode. The user can reset the offsets to zero (default) or retain 
the (non-zero) settings used in the previous cycle location mode. 
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Peaks 

Peak direction See the Peak definitions.  

Level Important usage note—Level is not set automatically when the Cycle/Peak detector is 
generated. (Automatic Level is used in previous versions of AcqKnowledge for Mac and 
current version for Windows.) 

Use selected... To optimize the threshold detection level for the selected area of data in the graph, click the 
“Use selected maximum/minimum” button underneath the level. If you change the source 
channel or peak direction, you can also use this button to re-compute the recommended level 
based upon your new settings” 

Threshold Fixed—Keeps the threshold voltage level constant. 

 Tracking The Tracking threshold mode modifies the threshold after it finds a peak, depending upon the 
value of the new peak, and will compensate for a slowly drifting baseline. 

Hints regarding the use of Tracking Threshold Options 

 If data has a very consistent cyclical nature, either Tracking Option will work. 

 If data has spurious positive or negative peak values present, the Means Reference 
Tracking Option is probably a better choice. 

 If data has an erratic baseline, but consistently sized, positive and negative peaks, the 
Peaks Reference Tracking Option is probably a better choice. 

Tracking using mean value and % of peak value—Adjusts the threshold voltage level after 
each peak based on the average of the last cycle’s data and the specified percentage of the 
current peak voltage. The Means reference option will cause the software to determine the 
Mean Value of all the data, from peak to peak. This Mean Value establishes a variable 
reference upon which the tracking threshold operates. The software will determine the new 
threshold (NT) as follows: 

For Positive Peaks 

NT = Mean Value + (Positive Peak Value - Mean Value) x (% factor) 

For Negative Peaks 

   NT = Mean Value - (Mean Value - Negative Peak Value) x (% factor) 

 Tracking using % of peak value—Adjusts the threshold voltage level dynamically based on 
the specified percentage of the value of the most currently found peak. The Peaks reference 
option will cause the software to determine the Positive Peak Value and Negative Peak Value 
of all the data, from peak to peak. The Positive and Negative Peak Values establish a variable 
reference upon which the tracking threshold operates. The software will determine the new 
threshold (NT) as follows: 

For Positive Peaks 

NT = Neg. Peak Value + (Pos. Peak Value—Neg. Peak Value) x (% factor) 

For Negative Peaks 

NT = Pos. Peak Value - (Pos. Peak Value—Neg. Peak Value) x (% factor) 
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Events 

Event-based cycle location can extract information from events or define events based upon the output of the 
peak detector. A cycle is defined as the interval between two events of user-specified types. 

Start / End Define the event; any of the predefined event types can be explicitly matched. 

Match pairs “Match pairs of events only” is active when the Start event criteria are identical to 
the End event criteria. Toggle the checkbox to set this option. For a cycle to be 
located, a pair of two distinct events that match the criteria must be present. The 
event occurring earlier in time matches the left edge, later in time matches the 
right edge. This is the default search mode; this is the only search mode when the 
criteria are different. 

When unchecked, a single event can be used as the Start event and the End event 
of a cycle, which will produce a zero width cycle. This is useful for adjusting a 
selection relative to an event, such as locating the first second prior to each event 
of a specific type. This single-event matching option makes it possible to hit time 
periods for each event since each cycle consumes two events. 

Located on Specify the channel when the event must be defined, either its actual channel or 
“Global” for markers not associated with any channel. Select “Anywhere” to 
search for events of specific types across channels. 

With Labels 
optional 

Toggle the “With labels containing text” checkbox to set this option. 

When checked, the matching event’s label must contain the text in the edit box to 
the right of the checkbox. 

 The text search is not case sensitive. The search must be non-empty for cycles 
to be located properly. 

When unchecked, the matching event can have any label, including none. 

The Cycle detector uses the following algorithm to search for cycles in the graph: 

1. From the starting point, find the first event matching the criteria of the Start event. This will be defined 
as the left event. If no event matches the Start criteria, no more cycles are in the file. 

2. If the Start event criteria match the Ending event criteria and zero width cycles are allowed (e.g. “Match 
pairs of events only” is unchecked), define the right event as identical to the left event and go to step 5. 

3. From the location of the left event, find the closest event matching the criteria of the End event. This 
will be defined as the right event. If no event matches the End criteria, no more cycles are present in the 
graph. 

4. Within the time region between the left and right events, search for any events that match the Start 
criteria. If such an event occurs, redefine the left event to be this matching event and repeat the step. If 
no event is located, then the closest pair of events has been located. 
 This step is useful for working with data that has missing portions of the sequence, as can come out 

of some classifiers. For example, if two event types A and B are used as the endpoints, a sequence 
of three events AAB will match the last two events as the cycle. This is logical in the case of 
physiological data where, if B should occur periodically in the signal, AA is an indicator of an 
abnormality or missed classification. 

5. Set the selected area to the time interval whose endpoints are the left and right events. 
6. Perform selection adjustment and output as indicated by the settings on the “Selection” and “Output” 

tabs. 
7. If “Find All Cycles” is being performed, return to step 1 and use the ending event location as the new 

starting point to find any remaining cycles in the graph. 

Fixed Interval 

See the interval definitions. 
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Selection tab 

Use the Selection tab to adjust the range of data that will be analyzed to generate any output. By default, the 
data range is set to be the entire cycle as located by the settings on the Cycle/Peak tab, but it can be adjusted to 
analyze only specific portions of the cycle. 

The controls on the Selection tab vary based on the settings on the Cycle/Peak tab 

Peak When the Cycles/Peaks location method is “Peaks,” you can adjust the Selection based on the 
times of the peaks in the data or the times of the threshold crossings prior to the peaks. 

  
To perform analysis on the entire data within each cycle, the selection should be from the 
“previous peak” to the “current peak.” To examine fixed-width time windows located at each 
peak, use the “current peak” to “current peak” settings and adjust the two time offsets 
accordingly. Note that your settings must place the left edge earlier in time than the right edge 
for the peak detection to succeed properly. 

Event When the Cycles/Peaks location method is 
“Events,” you can adjust the Selection based 
on the locations of the events that define the 
boundaries of a cycle. 

For a specific cycle, the starting event will be 
the event at the left boundary of the cycle and 
the ending event will be the event at the right 
boundary of the cycle. The starting event will 
never be located after the ending event in time. 

To analyze data over each entire cycle, use the “starting event” to “ending event” setting. To 
examine fixed-width time windows occurring within each cycle, set the left edge and the right 
edge to the same event (e.g. “starting event” to “starting event” for time windows at the 
beginning of each cycle) and adjust the offsets accordingly. Note that your settings must place 
the left edge earlier in time than the right edge for the peak detection to succeed properly. 

Fixed When the Cycles/Peaks location method is “Fixed 
time intervals,” you can adjust the Selection based 
on the endpoints of the time interval. 

To analyze the data over each entire interval, use 
the “previous interval” to “current interval” 
setting. 

To examine fixed-width time windows within 
each interval or only a sub-portion of each 
interval, use the “current interval” to “current 
interval” setting and adjust the time offsets 
accordingly. Note that your settings must place the left edge earlier in time than the right edge 
for the peak detection to succeed properly. 
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Output tab 

 

The Cycle/Peak Detector includes four Output 
options, which can be independently enabled: 
Measurements, Averaging, 3D Surface, and Events. 
The selected output, if any, is listed at the top of the 
Output tab as Enabled output. 

 

Output Measurements 

Toggle each checkbox to enable/disable the option: 

 Paste measurements for each cycle to the 
Journal 

 Plot measurement results; display measurement 
values as channels in graph. 

 

Output: Averaging—Offline 

Use Averaging Output” to perform offline ensemble 
averaging of source data or ensemble averaging of 
event locations. Specify the channel where the 
cycles/peaks are to be located in the “Cycles/Peaks” 
tab and specify the channel whose data should be 
ensemble averaged in the “Average” controls on the 
“Output” tab. 

Toggle the “Average channel events checkbox near 
the bottom of the tab to turn event averaging on and 
off. 

Offline averaging can produce average locations of 
events within the defined cycle along with the average 
data. When a cycle is found, any events in that cycle 
will be noted. Events that are on the channel of data 
being averaged will be examined for inclusion in the 
average.  

Index For each individual cycle, each event will be given an index starting at 0 and increasing to one less 
than the number of occurrences of that event type within the cycle. The time offset for each event 
from the start of its cycle will be averaged along with the offset for events with the same index from 
all other cycles. When the graph of the averaged data is produced, these average time offsets from 
the start of the cycle will be used to define new events for the averaged data. If the events and 
averaging interval were correlated with the data, the average event offset will produce a reasonable 
representation of the appropriate event locations for the averaged cycle. 

 Average events reflect the accuracy of classifiers and the consistency of data used to locate each 
cycle. 

Label Each event is labeled with the number of cycles contained in the event. Differences in the event 
sequence can cause spurious events to be inserted. The label helps in manual inspection for events 
that were only in one or two cycles. 

Rejection Toggle the “Events must be in…” checkbox to turn rejection on and off, and specify a percentage 
for the relative number of cycles an event must appear in to be considered valid. 
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Remove… When mean removal is enabled, the mean value of the data within each cycle is subtracted prior to 
including it in the overall signal average. This mean removal option is useful for: 

o Extracting signals that are “riding” on top of other signals with high DC offset (e.g., MRI 
artifact on top of skin temperature) 

o Compensating for baseline drift where there are not enough cycles present in the data for 
the baseline variation to completely cancel itself out. 

Output 3D Surface 

    

3D Engine menus and prompts 

  
Save as TIFF Choose File > Save as TIFF 
when 3D output is enabled. 

 

 

Toggle the “Generate a surface” checkbox at the top of the 3D tab to turn Surface Output on and off. 

1) Choose a channel to generate a 3D surface from. 

2) Confirm or establish the cycle period of interest on the channel. 

 Use the Cycles/Peaks tab and the Selection tab to adjust the threshold and cursor positions for the 
cycle period for 3D output. 

3) Choose a cross-section output format for the cycle data: cycle data, histogram, FFT, or DWT. 

 For histogram, FFT, or DWT, click “Configure Transformation” to change the settings. 

4) Select surface and background colors. 

5) Set axis options. 

6) Click OK. 

Use the cursor to rotate the 3D image; the magnitude of display response increases as you leave the center of the 
screen (keep cursor close to center for slow response/display control). 

  

3D Output Example Compare ECG cycles in 3D Output. The following example shows how to 
AcqKnowledge will generate a 3D image using each cross section of ECG. 

a)  Cycles/Peaks tab: set the threshold level to identify each R-wave. 
b)  Selection tab: set the cursors to 

Current Peak 
Left edge -.5 seconds 
Right edge .5 seconds 
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c)  On the Output tab 
Enable 3D Output 
Specify the channel to generate a surface from. 
Choose “cycle data” for the cross-section format. 

d)  Click Find All Cycles. 

Output Events 

  

Toggle the “Output events” checkbox at the top of the 
Events tab to turn Event Output on and off. 

The Cycle/Peak Detector Output mode can define events at 
specific locations; a maximum of two events per cycle can 
be inserted with Event Output. After the Peak Detector has 
located a cycle and adjusted the selection, the data within 
that cycle can be analyzed and used to create new events in 
the graph (data-driven or time specific). 

Event definition 

   
Insertion method & 
channel selection 

Brief definitions follow, see the Event Location table on page 13317 for details: 
At edge place the event directly at the specified edge (left or right). See Edge 
Adjustment on page 1316. 
Percent change looks for a crossing based on a percentage of the value of the 
signal at the corresponding edge and places the event when a signal increases or 
decreases in value from the edge. 
% peak to peak looks for a point where the signal's value has changed by a 
percentage of the maximum peak-to-peak amplitude distance over the selected 
area and places the event when a signal increases or decreases in value from the 
edge 
Minimum place events at the minimum of a specific channel's data within the 
selection. 
Maximum place events at the minimum of a specific channel's data within the 
selection 
The channel whose data should be examined is specified in the pull-down menu 
directly to the right of the insertion method pull-down menu: 

Output type For each insertion method, the “Output type” pull-down menu adjusts the event 
type of the inserted event. 

Output channel Sets the channel where the event is inserted, either “Global” for defining global 
events or specific channels. 
 None—disables any insertion for that event and all of the other controls 

will be hidden except the insertion method pull-down menu. 
 Left edge / Right edge—a pull-down menu is displayed to be used to 

change between the different offset methods 
 Minimum / Maximum  

Output label Use this edit field to type in specific label text. Each event that is inserted will 
have its label set to this text. By default, it is empty (inserted events will not be 
labeled). 
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Edge Adjustment When an “at edge” location method is used, options will be generated to fine-
tune event placement relative to that (right or left) edge of the selection. 

Offset Underneath the insertion method pull-down menu, a set of controls will be 
added that allow the user to specify the percentage, choose whether they want 
to search for an increase or decrease, and choose the channel whose signal 
should be examined. 

 
When the offset method is “Threshold crossing,” the event will be placed when 
the signal on a channel crosses a threshold.  
There are a number of possible ways to configure the threshold crossing: 
 Fixed—The edit field may contain a specific voltage level for the threshold. 

In this configuration, an event will be placed if the value of the channel 
specified in the next pull-down menu crosses this fixed voltage value. 

 + value—The edit field may specify an offset from the value of the channel 
at an edge. The threshold voltage level is the value of the chosen source 
channel plus the offset from the edit field. To specify a threshold lower then 
the value of the channel at the edge, a negative sign can be placed before 
the offset. 

Direction of 
 crossing 

The direction of the crossing can be specified. 
 + (positive crossing)—the signal must approach the threshold from below 

and cross to above the threshold before an event is inserted. 
 - (negative crossing)—the signal must approach the threshold from above 

and cross to below the threshold before an event is inserted. 
 ± (mixed threshold)—an event will be inserted at the first positive or 

negative crossing that is encountered. 
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Event Location Table 

Insertion Method Location Process 
Edge, at edge Place an event at the left or right boundary of the selected area, as specified. 
Edge +/- percent offset Given a particular channel, place an event at the specified time within the 

selection when the signal increases or decreases by a specific percentage. 
Left edge + Place at the time closest to the left boundary of the 

selection. The percentage is calculated from the value of 
the signal at the left boundary of the selected area. 

Right edge - Place at the time closest to the right boundary of the 
selection. The distance between the event and the right 
edge of the selection will have an amplitude difference 
equal to the indicated percentage of the right edge’s 
value. 

If the signal does not increase or decrease by that percentage within the 
selection, no event will be inserted. 

Edge +/- percent peak to 
peak offset 

Given a particular channel, place an event at the specified time within the 
selection when the signal increases or decreases by a specific percentage of 
the peak to peak delta of the selected area. 

Left edge + Place at the time closest to the left boundary of the 
selection. The percentage is calculated from the result of 
subtracting the minimum value of the signal over the 
selected interval from its maximum. 

Right edge - Place at the time closest to the right boundary. The 
distance between the event and the right edge of the 
selection will have an amplitude difference equal to the 
indicated percentage of the minimum value of the signal 
over the selected interval subtracted from its maximum. 

If the signal does not increase or decrease by that percentage within the 
selection, no event will be inserted. 

Edge +/- threshold 
crossing 

Starting at the specified boundary of the selection, determine a threshold 
value. This threshold voltage may be: 

 fixed voltage level 
 value of signal at the specified edge + offset 
 mean value in selected area + offset 

Left edge + Search for the first location where the signal on a 
particular channel crosses the threshold. 

Right edge - Examining data from right to left, search for the rightmost 
location where the signal on a particular channel crosses 
the threshold. 

If the direction of the threshold crossing matches the user specified direction, 
then an event is inserted. If it does not, then the next threshold crossing is 
located and the process repeats. If the threshold is never crossed within the 
selected area in the user-specified direction, no event is inserted. 

Minimum The event will be placed at the time location corresponding to a specific 
channel’s minimum value within the selected area. 

Maximum The event will be placed at the time location corresponding to a specific 
channel’s maximum value within the selected area. 
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Output: Clustering 

Clustering is the process of taking a set of data points and partitioning them into a fixed number of groups 
called clusters. Each cluster represents data points that may share some type of commonality. This can be used 
to assign each data point to a class of similar points. Clustering can be used for hemodynamic analysis and is 
one of the basic analysis tools used for spike analysis in neurophysiology. 

Algorithm Overview 

K-means clustering is an iterative algorithm that begins with a data set of real-valued points in an n-
dimensional space. Given this data set, one then specifies how many clusters are present. The k-means 
clustering algorithm attempts to find the location at the center of each of these clusters. Essentially, this 
algorithm partitions the data set into k groups such that the sum of the differences between the centers of 
each group and its members is minimized. 

A basic algorithm description is: 

A. Given a total of k clusters, choose k potential cluster centers. 

B. Assign each member of the data set to a cluster according to the closest potential cluster center 
using a Euclidean distance function (sum-of-squares). 

C. Adjust the location of the potential center for each cluster to a more optimal value. The most basic 
method is to assign the new center as to match the mean value of all of the members of the set 
(referred to as expectation maximization). 

D. Determine if the set of clusters and centers is satisfactory. If not, go to step 2 and repeat the 
clustering process. 

There are many different variations on what constitutes satisfactory ending conditions. The most ideal 
stopping criteria are when the cluster assignments do not change any longer with successive iterations. If 
there is no change in the centers, the solution perfectly minimizes the Euclidean distance sum for each 
cluster, unique up to variations in ordering of the dimensions. In practice, determining the perfect clustering 
of a data set is computationally intensive and may require an indefinite amount of time. Approximations of 
perfect clustering are quicker to compute and usually produce sufficiently accurate results. 

A useful termination condition for constructing approximate solutions is to place a tolerance on how much 
the centers are moved in successive steps. If the total distance between the centers at subsequent steps of the 
algorithm is less then a specific tolerance, the centers can be assumed to approximate the ideal solution. 
Another potential termination condition is to limit the maximum number of steps that are executed. This 
condition does not necessarily produce a usable approximation, but it does provide a way to halt execution. 
This is required because there is no way to determine if the algorithm can terminate successfully for a given 
data set. 

Feature clustering is a very common data reduction method in use by clustering based spike sorting 
software. A waveform segment is reduced to a single data point by extracting numerical quantities known 
as features. Each feature is a single real-valued number extracted from the data. Examples of features are: 
maximum amplitude in waveform segment, minimum, time to maximum, time to minimum, peak to peak 
distance, sum of all values, maximum slope of peak, and so on. 

A commonly used feature clustering analysis starts with two features. The features are then calculated for 
each waveform segment and presented on a scatter plot, allowing the user to visually determine how many 
clusters may be present. A k-means clustering analysis is then run on these two dimensional data points to 
determine the center of the clusters in feature space. With the center known, each waveform segment is then 
assigned to a cluster depending on the values of its features. 
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Clustering Settings 

  
Number of clusters 

After features have been extracted from the data, the data points constructed from the feature will be split 
up into a number of groups. The number of clustering groups must be provided. Clustering will always 
partition the data into this number of clusters. The output of a clustering analysis should be verified visually 
and numerically to determine if the number of clusters matches the data. 

Locate Centers 

Clustering has a good potential to form the basis for classifiers to score physiological data. The clustering 
implementation will allow for automatic learning of cluster center positions through expectation 
maximization or for manually specified cluster center positions. 

Manually 

The manual method allows the centers of each cluster to be manually typed in and edited. Instead of 
running a full k-means algorithm to locate centers, the k-means algorithm will simply run through the data 
set and assign each element to the closest cluster center and apply any outlier detection. 

This simplistic clustering will allow centers as computed from a previous run to be used in subsequent 
clustering. Using manually specified centers is necessary to provide consistency when clustering data that 
may occur in different experiments or different graph files. The use of manual centers allows for the 
clustering implementation to be used as a classifier to compare new data sets to clusters as determined from 
either ideal or previously scored data sets. 

By Learning 

The learning method will use the full k-means clustering algorithm as described above. This consists of 
choosing candidate centers, computing mean distances, adjusting the candidate center positions, and 
repeating until termination conditions are met. 

The data set used to compute the center positions can either be the full data set or a subset of the data. 
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Training Set Definition 

The training set is the set of data that is used during the iterative portion of the clustering algorithm that 
learns the potential center of each cluster. Training sets are only used for learned centers. There are three 
ways to specify a training set for use in clustering: 

 Use all of the source data when searching for the centers.Allow the training set to be a specific 
percentage of the total source data set with members of the training set chosen at random. 

 Manually identify the training set with events located in the data. 

Partial clustering refers to running the k-means clustering algorithm on only a subset of the source data, 
referred to as a training set. The clustering algorithm outputs the centers of the clusters as determined from 
the training set, and other data points that are not members of the training set are subsequently added to the 
cluster whose center is closest to them. This approach assumes that the training set is a good approximation 
of the characteristics of each cluster in the entire data set. 

There are a number of reasons to perform partial clustering. One is computational efficiency. K-means 
clustering can be a time intensive procedure, as each iteration of the algorithm must recompute all of the 
distances to reclassify the entire data set. By performing partial clustering, it is possible to reduce the 
complexity of the k-means clustering step by limiting the amount of source data that needs to be processed 
in each step. This may be acceptable in situations where perfect partitions are not required. 

Another use of partial clustering is to construct a classifier. A classifier is some method for assigning a 
particular data point to a specific class. To construct a classifier using k-means clustering a k-means 
algorithm is run on a training set that has known desirable data properties for splitting data into a number of 
classes. Once the centers of this training set are known, they can be used to perform another clustering 
analysis on a set of unknown data and determine how well that data exhibits the properties of the training 
set. 

Remove Outliers 

One of the deficiencies of k-means clustering is that it is a total partition of the data set. Basic clustering 
assumes the original data set is ideal and that each cycle belongs to one of the clusters. Rejection of 
spurious data points is useful in real-world applications, particularly with physiological signals where noise 
and artifacts are to be expected. 

The clustering analysis allows for optional removal of outliers, or spurious data points. When enabled, each 
cluster is assigned a boundary. After each data point has been assigned to the cluster, the standard deviation 
of the distance of each point from the center of the cluster is computed. When outlier rejection is enabled, 
any data point that is farther away from the center than a specific number of standard deviations will be 
removed from the cluster. Enabling outlier removal retains only the points in a cluster that have the 
strongest association with each other. 
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Clustering Criteria 

 

AcqKnowledge can perform feature clustering. For a particular 
segment of a waveform, features are extracted based upon 
user-specified criteria. 

Segment Width Peak to Peak 
Value (left edge) Time peak to Peak Delta 
Max Sum 
Min Median 
Time to Max Mean 
Time to Min Measurement Result 

Multiple segments are located using the Find Cycle/Peak 
functionality. After the criteria have been computed for each 
segment, clustering is then performed on these criteria. This 
allows segments to be partitioned based upon their features. 
For example, “Segment Width” criteria can be used to 
partition ECG cycles into two clusters of shorter segments and 
longer segments. 

The criteria Segment Widths are reported in milliseconds for time-domain graphs, as are the other time-based 
criteria (Time to Max; Time to Min; and Time Peak-to-Peak Delta). If the measurements are fixed to units of 
milliseconds (Display > Preference), then K-Mean Criteria results will match measurement magnitude results. 
Clustering is defined with a hard left to right directionality for all measurements. Therefore, Delta T will have 
opposite signs than the same measurement pasted with Find Peak. 

Clustering Output 

The output of a clustering analysis can be presented in multiple 
ways, including events, waveforms in the graph, textual tables, and 
visual scatterplots. These outputs allow for visual examination of 
the clustering results for anomalies and also provide a foundation 
for further data reduction using other AcqKnowledge tools. By 
examining waveform data in a reduced feature space, it may be 
possible to construct clustering configurations that allow for 
separation of neuron action potentials into different classes, 
detection of heart arrhythmias, and other classification tasks. To 
generate 3D criteria scatterplots, select at least three criteria. 
Includes the option to change the 3D scatterplot background color 
and export results to an Excel spreadsheet. 
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Find Next Cycle 

 When you select Find next cycle from the Analysis menu (or select the toolbar icon), both cursors will 
move one peak to the right while staying above the threshold.  

 

Find All Cycles  

When you select Find All Cycles from the Analysis menu, the software will find all cycles/peaks through the 
end of the file. If your data file is very large, it may take some time to find all the cycles since AcqKnowledge 
loads data from disk while it scans for the cycles. 

 
If the “Paste measurement to Journal” preference is set, measurement values will be pasted into the Journal each 
time a cycle is found, as shown above. Each column corresponds to a measurement value (in this case, Value 
and BPM). 

 

Cursor functions 

The process uses the default cursor settings to select the area between two adjacent cycles. In this mode, one 
cursor tracks the current cycle location while the other cursor marks the location of the previous cycle (these 
“cursors” are internal to the software and do not appear in the graph window). 

A cursor can be based on: 

(a) a currently selected cycle 

(b) a peak found immediately prior to the currently selected cycle 

(c) the current cycle threshold 

(d) the threshold used for the previously selected cycle. 

To select areas other than the inter-cycle interval, enter an offset for these cursors. 

 

Excel Spreadsheet Export—The cycle detector has also been enhanced to allow for the direct creation of 
spreadsheets. The cycle-to-cycle values of the measurements can be inserted directly into an Excel spreadsheet 
file. Each measurement is placed into an individual column and each cycle corresponds to a single row. To 
generate the spreadsheet a “Find All Cycles” operation is required.  

 Also available for File > Save As, File > Save Journal Text As, and Specialized Analysis tools. 
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The following example details how to detect the positive spike in the QRS complex—a typical use of 
the Find Cycle (peak detection) function. 

Analysis > Find Cycle, Find next cycle, Find all cycles Icons:  Find Cycle    Find Next Cycle 

 

1. Select the area around a typical peak.  

 
2. Select Find Cycle. 

3. Enable “Use selected maximum” on the Cycles/Peaks tab to automatically set an appropriate threshold 
value based on the amplitude of the cycle detector. 

4. Click the Output tab and choose the desired option(s), such as paste measurement controls to update the 
journal with the measurement values from the new peak. 

5. Click a Find button. 

 Find first cycle – the cursor will blink at the first cycle point 

 To manully move through the file, click Find next 

 Or, select an area and choose Find all 

 Or, place the cursor in the data and Find all will detect cycles from that point forward. 

 Find all cycles will ocate all cycles from the current cursor location to the end of the file. 

 

To use an offset 

Use the Selection controls to set a time window around the selected cycle; previous peak controls the left 
cursor, Current peak has options to control the left and right cursors.  

1. Use steps 1-4 above. 

2. Click the Selection tab. 

3. Set the desired cursor values. 

 For example, to set the time window 0.5 seconds prior to the previous peak. 

 
To control the left and right cursors, slect currnet peak and enter the appropriate time window to define an 
interval around the cycle. 
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Find Rate 
The Rate Detector is critical to AcqKnowledge’s ability to extract 
information from physiological data that has a degree of 
periodicity. Physiological data that can be investigated using the 
AcqKnowledge Rate Detector includes: 

 ECG (e.g. Heart Rate or Inter-Beat-Interval recording) 

 Blood Pressure (e.g. Systolic, Diastolic, Mean, dP/dt Max, 
dP/dt Min) 

 Respiration (Respiration Rate measurement) 

 EMG (Zero Crossing or Mean Frequency analysis) 

 

The Find Rate function allows you to compute rate calculations 
(including BPM) for data that has already been collected. Although 
this function uses the same algorithm as the online rate detector 
(which uses a Calculation channel), it can be advantageous to 
perform rate calculations after the data has been acquired. One 

benefit is that off-line rate computations do not require that a separate channel (i.e., a Calculation channel) be 
acquired. Since the number of acquired channels is reduced, other data can be collected and/or data can be 
sampled at a higher rate. 

Rate detector settings are graph-independent, which means that find rate operations can be performed in 
multiple graphs without needing to re-enter graph-specific settings for each run. By using multiple data views, 
different find rate operations can be performed on the same set of data without losing settings between “Find 
Rate” operations. When the Rate Detector is first opened for a graph, the dialog will be filled with the values 
from the last successfully executed Find Rate operation. Subsequently, changes to the settings will be applied 
only to that graph. 

Modes of Operation 

The Rate Detector incorporates a significant amount of flexibility to optimize performance when extracting data 
from periodic physiological waveforms. There are three basic modes of operation for the Rate Detector: 

1) Fixed threshold detect mode 
2) Auto threshold detect mode (enables Noise rejection) 
3) Remove baseline and Auto threshold detect mode 

The Rate Detector will eliminate certain options when selecting different modes of operation. 

 The Remove baseline function always uses the Auto threshold detect mode. 
 Any cyclic measurement relating to amplitude (e.g. Peak-Peak, Maximum, Minimum, Area, Mean) 

automatically turns off the Remove baseline function. 
 If the measurement pertains directly to time (e.g. Hz, BPM, Interval, Peak Time, Count Peaks) the 

Remove baseline and Auto threshold detect modes are both operational. 

Generally, it’s best to use the simplest Rate Detector mode that is suitable for your application. If the simplest 
mode doesn’t work, add layers of sophistication, one at a time. For example: 

 If the Fixed threshold mode can’t or will not work, use the Auto threshold detect mode. 
 If the Auto threshold detect mode is similarly unavailable, adjust the Noise rejection or add the 

Remove baseline option (if possible). 
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1) Fixed threshold detect mode: 

Fixed threshold detect mode is the simplest mode of operation for the Rate 
Detector. As shown here, the Threshold Level has been set to 0.00 Volts. If 
the waveform crosses 0 Volts, the Detector will begin to look for Positive or 
Negative peaks (based on the Peak detect setting). 

Not available in Fixed mode: 

 Noise rejection 

 Windowing options 

 Output reset events  

 

2) Auto threshold detect mode:  

Auto threshold detect mode is a more advanced and flexible mode of operation 
for the Rate Detector. In this case, the Rate Detector will create a variable 
threshold defined as: 

 Positive peak search 
  0.75 • (Old Peak Maximum - Old Peak Minimum) 

 Negative peak search 
  0.25 • (Old Peak Maximum - Old Peak Minimum) 

Furthermore, the Rate Detector will construct a moving file of data points 
defined by 1.5 times the number of samples that can be placed in the largest 
rate window size (defined by the Window settings). If the Rate Detector loses 

sync (no trigger event inside the window), the threshold is changed to the mean value of the moving file of 
data points. This operation permits successful recovery in the event 
of spurious waveform data values. 

The Noise rejection setting creates Hysteresis around the variable threshold. The Hysteresis level is defined 
as: 

Hysteresis = Noise rejection (%) • (Old Peak Maximum - Old Peak Minimum) 

3) Remove baseline and Auto threshold detect mode: 

Remove baseline and Auto threshold detect mode is an advanced and flexible 
mode of operation for the Rate Detector. Primarily, the Rate Detector 
performs an automatic (and hidden) moving difference function on the 
waveform data. The difference function is performed over a variable number 
of samples defined by: 

# of points over which difference is performed = 
  0.025 • Sampling Rate 

This difference waveform is then passed through the variable threshold: 
 

Positive peak search = Negative 
peak search = 

  0.75 • (Old Peak Maximum - Old Peak Minimum)   0.25 • (Old Peak Max - Old Peak Min) 

Furthermore, the Rate Detector will construct a moving file of data points defined by 1.5 times the number of 
samples that can be placed in the largest rate window size (defined by the Window settings). If the Rate 
Detector loses sync (no trigger event inside the window), the threshold is changed to the mean value of the 
moving file of data points. This operation permits successful recovery in the event of spurious waveform data 
values. 
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FIND RATE OPERATIONAL SUGGESTIONS 

Option Waveform Characteristics 

Fixed threshold option  waveform data has clearly defined positive or negative 
peaks (like respiratory or air flow data), which are 
consistently higher (in magnitude) than the rest of the 
waveform. 

 waveform data has clearly defined zero-crossings (like 
EMG), and you wish to determine the rate of these 
crossings 

Auto threshold detect option  waveform data has a moving baseline, but the peaks are 
otherwise larger in magnitude than other parts of the 
waveform (blood pressure). 

You may need to adjust the Noise rejection (Hysteresis) to 
optimize performance. 

Remove baseline and 
Auto threshold detect options 

 waveform data has high narrow peaks (like most ECG 
leads), which may or may not be larger in magnitude than 
other (slow moving) parts of the waveform. 

You may need to adjust the Noise rejection (Hysteresis) to 
optimize performance. 
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Find Rate Dialog Settings 

  
Function 

The Rate Detector Function menu lists a variety of calculations, which are discussed below. 

Rate (Hz), Rate (BPM), Interval (sec) 

The most commonly used function is the Rate (BPM) option, which calculates a rate in terms of beats 
per minute or BPM. Rate calculations can also be performed that return a rate value scaled in terms of 
frequency (Hz) or time interval (sec). When rate is reflected in terms of a time interval, the time 
difference (delta T) between the two peaks is returned. This is sometimes referred to as the inter-beat 
interval (IBI). The frequency calculation returns the rate in Hertz (Hz), which is computed by dividing 
1 by delta T. These measurements are perfectly correlated with the BPM calculation, since BPM is 
equal to 60 times the frequency calculation, or 60 divided by delta T. 

Peak time 

Returns the time (in seconds) at which the peak occurred. Like the other Rate functions (e.g., BPM and 
Hz), the value of the last peak time will be plotted until a subsequent peak is detected. The resulting 
plot will resemble a monotonically increasing “staircase” plot. 

Count peaks 

Produces a plot of the number of peaks (on the vertical axis) vs. time on the horizontal axis. When used 
with the delta measurements (in the measurement windows), this is a convenient way to calculate how 
many peaks occur within a selected area. 

Peak maximum/minimum 

Tracks the maximum value of the peak (the ECG R-wave). This correlates to the systolic pressure in 
blood pressure readings. To search for minimum peak values, select negative from the Peak detect 
section of the dialog.  

Peak-to-peak 

Looks at the vertical difference between the maximum and minimum values of the waveform on a 
cyclical basis—useful when you want to determine the amplitude of your pulsatile signal. 

Mean value 

Computes the mean of a pulsatile signal on a cycle-by-cycle basis between two peaks; produces a 
staircase plot. 

Area 

Computes the area of the signal between two peaks, on a cycle-by-cycle basis.  
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Peak Detect 

By default, the Peak Detector searches for Positive peaks (upward pointing, such as the R-wave of an ECG 
signal) to calculate the rate of a waveform. In some instances, however, you may have to base the rate 
calculation on negative peaks (downward pointing). To do this, select Negative peak. 

Remove baseline 

The Remove baseline option applies the optimal high pass filter based on the other settings. This option is 
useful when signals have a slowly fluctuating baseline. 

Auto Threshold Detect 

When the Auto threshold detect box is selected in the Find Rate dialog, AcqKnowledge automatically 
computes the threshold value using an algorithm that accentuates peaks and uses information about the 
previous peak to estimate when and where the next peak is likely to occur. This threshold detector is typically 
more accurate than a simple absolute value rate calculation function, and is able to compute a rate from data 
with a drifting baseline and when noise is present in the signal. (For a detailed description of how the 
calculation is performed, contact BIOPAC Systems, Inc. for the complete Application Note.) 

 When Auto threshold detect is enabled, the Noise rejection and Window options are enabled. 

Threshold level 

This option (activated when “Auto threshold detect” is not selected) lets 
you enter a threshold level to be used for a simple absolute value rate 
calculation function. 

 The Auto threshold detect option is typically more accurate. 

Noise Rejection 

Noise rejection (activated when “Auto threshold detect” is enabled) 
constructs an interval around the threshold level. The size of the interval 
is equal to the value in the “Noise rejection” text box. Checking this 
option helps prevent noise “spikes” from being counted as peaks. 

 The default is equal to 5% of the peak-to-peak range. 
 

Output reset events 

This option is activated when “Auto threshold detect” is enabled and controls the 
definition of reset event insertion into the graph. 

If no thresholds are found within the user-specified window width, the automatically detected threshold level 
will “reset” and tracking will start anew; the output of the rate detector function may also drop to zero. When 
“Output reset events” is enabled, a reset event will be added to the channel whenever the threshold is reset 
due to window expiration 

 This helps distinguish zero-valued output due to 
window resetting and true zero-value output. 

In the sample shown, the signal drops to zero during a 
period of analysis (e.g., due to lead clip falling off). 
Reset events indicate automatic threshold tracking was 
lost in this interval and the points where the search for 
a new level begins. 
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Window (Peak Interval) 

Window is used to specify an upper and lower limit 
for the Rate calculation. Window is activated when 
“Auto threshold detect” is enabled; the Windowing 
Units pull-down menu is only activated when the 
selected Function can have variable units. 

Setting the upper and lower bounds for the “window” 
tells AcqKnowledge when to start looking for a peak. 

 

AcqKnowledge will try to locate a peak that matches the 
automatic threshold criteria within the specified window. 
If no peak is found, the area outside the envelope will be 
searched and the criteria (in terms of peak value) will be 
relaxed until the next peak is found. 

For instance, once the first peak is found, AcqKnowledge 
will look for the next peak in an interval that corresponds 
to the range set by the upper and lower bounds of the 
window. The interval associated with the upper band of 
180 BPM is 0.33 seconds (60 seconds ÷ 180 BPM), and 
the interval for the lower band is 1.5 seconds (1 minute ÷ 
40 BPM). If a second peak is not found between .33 
seconds and 1.5 seconds after the first peak, then 
AcqKnowledge will look in the area after 1.5 seconds for 
a “smaller” peak (i.e., one of lesser amplitude). 

For those rate functions that require a window interval in 
seconds, you will probably want to enter numbers like .33 
seconds and 1.5 seconds (which correspond to the BPM 
defaults of 40 and 180). These numbers will be suitable 
for detecting the heart rate of an average subject. 

 

A simple peak detector uses what is called a threshold-crossing algorithm, whereby each time the amplitude 
(vertical scale) value exceeds a given value, the peak detector “remembers” that point and begins searching 
for the next event where the channel crosses the threshold. The interval between the two occurrences is then 
computed and usually rescaled in terms of BPM or Hz. This is how the AcqKnowledge rate Calculation 
functions when all options are unchecked. 

In the sample waveform shown here, the threshold was set to 390 mV to detect the peaks of the waveform and 
provide an accurate rate calculation. Since it only recognizes signals greater than 390 mV as a peak, this 390-
mV threshold is referred to as an “absolute threshold.” Most waveforms are not so well behaved, however, 
and artifact can be introduced as a result of movement, electrical interference, and so forth. Combined with 
actual variability in the signal of interest, this can result in “noise” being included with the signal, as well as 
baseline “drift“ which can render absolute threshold algorithms useless. 

Put Result in New Graph 

When this option is checked, the results from the find rate calculation are plotted in a new graph window with 
data displayed in X/Y format, with time on the horizontal axis. By default, this option is unchecked and the 
resulting transformation is placed in the lowest available channel of the current graph. 

NOTE: When put into a new waveform or used as a calculation channel, the output rate function uses 
padding to generate a signal at a continuous sampling rate. The extracted value is used for padding until the 
next cycle is detected. This padding can cause unsuitable weighting for statistical analysis. For accurate 
statistical analysis with only one value for each cycle, use the offline rate detector "show output in new 
window" to produce a "value" waveform with one output point for each cycle. This output is suitable for 
export to Excel or other software for statistical analysis. 

Defaults:  Min 40 BPM 
Max 180 BPM 
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Find Rate of Entire Wave 

When this option is checked, the rate (or other function from the Find rate command) will be calculated for 
the entire wave (other than the selected area, if any). 

Don’t Find 

Saves dialog settings so you can close out of the dialog and select an area. When you reopen the dialog, the 
settings will be established as before you closed out, and you can click the OK button to perform the Find 
Rate function. This is useful for setting parameters using an area of a waveform and then repositioning the 
cursor at another point in the record. 

Specialized Analysis 
The Specialized Analysis package includes tools to automate analysis to save hours (or days!) of processing 
time and standardize interpretation of results. 

A courtesy copy of the Specialized Analysis package is installed under the Analysis menu with 
AcqKnowledge™ 4. 

See the next chapter for full details.  
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Chapter 17 Specialized Analysis 

 

The Specialized Analysis package includes comprehensive 
analysis tools to automate analysis to save hours (or days!) of 
processing time and standardize interpretation of results. 

 AcqKnowledge™ 4 includes a courtesy copy of the 
Specialized Analysis Package under the Analysis menu.  

Specialized Analysis provides extensive post-acquisition analysis 
options similar to modules from Mindware Technologies, 
PONEMAH Physiology Platform, EMKA Technologies, SA and 
other advanced analysis applications. If you need still more 
analysis options, save the data as MatLab, Igor Pro, PhysioNet, 
raw, or text format—or compress the file to reduce file size by 
about 60%. 

Analyze data collected on MP Systems with Windows OS or Mac 
OS X.  

 

See the Analysis menu on page 296 for other operations that 
derive data and measurements from the graph: 

Histogram 
Autoregressive Modeling 
Nonlinear Modeling 
Power Spectral Density 
AR Time-Freq Analysis 
FFT  
DWT  
Principal Component Analysis  
Independent Component Analysis  
Find Cycle  
Find Next Cycle  
Find All Cycles  
Find Rate 

The Specialized Analysis package includes the following Analysis Packages and Classifiers: 

Analysis package—bundle of transformations created to assist with analysis in a specific area of research.  

Classifier—special-purpose transformation that defines events at well-known points of interest on standard 
waveforms, such as the ECG wave boundary classifier and the QRS beat detector and arrhythmia detector. 
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Detect and Classify Heartbeats 
Locate ECG Complex Boundaries 
Heart Rate Variability 
Gastric Wave Analysis 
Gastric Wave Coupling 
Chaos Analysis 

Detrended Fluctuation Analysis 
Optimal Embedding Dimension 
Optimal Time Delay 
Plot Attractor 

Correlation Coefficient 
Electrodermal Activity 

Derive Phasic EDA from Tonic 
Event-related EDA Analysis 
Locate SCRs 
Preferences: Output Display Format; Phasic EDA 

Construction Method: Smoothing Baseline Removal or 
High Pass Filter 

Electroencephalography 
Compute Approximate Entropy 
Delta Power Analysis 
Derive Alpha-RMS 
Derive EEG Frequency Bands 
EEG Frequency Analysis 
Remove EOG Artifacts  
Preferences: Output Display Format 

Electromyography 
Derive Average Rectified EMG 
Derive Integrated EMG 
Derive Root Mean Square EMG 
EMG Frequency & Power Analysis 
Locate Muscle Activation 
Preferences: Output Display Format 

Ensemble Average 
Epoch Analysis 
Hemodynamic Analysis 

Classifiers: ABP; LVP; MAP  
Arterial Blood Pressure  
ECG Interval Extraction 
HRV Poincare Plot  
Left Ventricular Blood Pressure  

Monophasic Action Potential 
Respiratory Sinus Arrhythmia 
Preferences: Output Display Format; LVEDP Location 

Method; dP/dt pk-pk %; MAP Plateau Location Method; 
dP/dt MAP pk-pk % 

Impedance Cardiography Analysis 
Body Surface Area Ideal Body Weight 
ICG Analysis VEPT 
PEP Pre-ejection Period 
dZ/dt Derive from Raw Z 
dZ/dt Classifier: B, C, X, Y, and O Points 
dZ/dt Remove Motion Artifacts 
Preferences: Output Display Format; C-, B-, and X-Point 

Location; Stroke Volume Calculation Method; Body 
Measurement Units; Body Surface Area Method; Ideal 
Weight Estimation Method; dZ/dt Max Method 

Magnetic Resonance Imaging 
Artifact Frequency Removal Signal Blanking 
Artifact Projection Removal Slew Rate LImiter 
Median Filter Artifact Removal 

Neurophysiology 
Amplitude Histograms Classify Spikes 
Average Action Potentials Dwell Time 
Histograms 
Generate Spike Trains Locate Spike 
Episodes 
Find Overlapping Spike Episodes 
Set Episode Width and Offset 
Preferences: Detect Spike; Default Episode Width; Default 

Episode Offset; Default # of Spike Classes 
Principal Component Denoising 
Remove Trend 
Respiration 
 Compliance and Resistance 
 Penh Analysis 
 Pulmonary Airflow 
Spectral Subtraction 
Stim-Response 

Digital Input to Stim Events Stim-Response 
Analysis 

Waterfall Plot  
Wavelet Denoising 

 

AcqKnowlege File Portability WindowsMac OS 10.3 or higher 

Use Specialized Analysis to analyze AcqKnowledge data files collected on MP Systems running on Windows/PC or 
Mac OS X. Open/save the following file formats: 

Opening files for Specialized Analysis 

The default file formats (Graph and .ACQ) are referred to as 
“AcqKnowledge” files. The AcqKnowledge file format is the standard 
way of displaying waveforms in AcqKnowledge. These files are stored in 
a compact format that retains information about how the data was 
collected (i.e., for how long and at what rate) and takes relatively little 
time to read in (compared to text files, for instance). AcqKnowledge files 
are editable and can be modified and saved, or exported to other formats 
using the Save as command.  

 
File Compatibility 
 Mac AcqKnowledge 3.9and above can open and create PC-

compatible Graph (*.acq) and Graph Template (*.gtl) files. Variable sampling rate information and hardware 
settings are retained, and Journals can be read from and written to PC files. Files must end on a multiple of the 
lowest channel sampling rate to be fully PC compatible. 
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Saving files after Specialized Analysis 

 
Saving Files AcqKnowledge 4.1 

The default file format for the File>Save as command is to save files as an 
AcqKnowledge file. Selecting Graph (MPWS) or .ACQ (MPWSW) from 
the popup menu in the Save As dialog will save a file as an AcqKnowledge 
file, which is designed to be as compact as possible. These files can only 
be opened by AcqKnowledge, but data can be exported to other formats. 

File > Save Selection As allows you to save only a portion of your file. 
When this option is enabled, only the data that has been selected with the 
I-beam tool will be saved. This option saves the selected area to another 
file and does not affect the current file that you are working in. 

File Compatibility  

Windows AcqKnowledge 3.9 and above files can be opened with MacAcqKnowledge 3.9 and above, but some 
advanced features may not transfer. 
Mac AcqKnowledge 3.9 and above can save as “Graph (Windows)” files, but it saves in Windows 
AcqKnowledge 3.7.1 format. In this earlier format, all data is retained, but newer AcqKnowledge features (like 
dual stimulation, data views, embedded archives, etc.) are lost along with any settings specific to Mac 
AcqKnowledge (like events, adaptive scaling settings, etc.). 
 Mac AcqKnowledge 3.9 and above can save PC-compatible Graph (*.acq) and Graph Template (*.gtl) 

files. Variable sampling rate information and hardware settings are retained, and Journals can be read from 
and written to PC files. Choose the format “Graph (Windows)” to create PC-compatible files. 

The Mac version does not save PC GLP files or compressed PC files.  
Files must end on a multiple of the lowest channel sampling rate to be fully PC compatible. 

Excel Spreadsheet Export—The Specialized Analysis tools have been updated to automatically export their results to 
an Excel spreadsheet if desired. The spreadsheet contents mirror the tabular Journal text output. All the spreadsheets 
are saved as temporary files, so they need to be re-saved in order to be saved permanently. 

 Also available for File > Save As, File > Save Journal Text As, and Find All Cycles journal. 

Note Specialized Analysis scripts are complex and undo may not function for all steps. 

 Some of the specialized algorithms are very complex and processor intensive, so they may take a long (even 
very long) time to return a result. 
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Detect and Classify Heartbeats 

 
This robust QRS detector is tuned for human ECG Lead II signals. It attempts to locate QRS complexes and 
places an event near the center of each QRS complex to identify the type of heartbeat event: 

 Normal The beat was recognizable as a valid heartbeat falling in a human heartbeat rate. 

 PVC The beat was shorter than the beats around it and may be a pre-ventricular contraction. These events can 
be found in the “Hemodynamic > Beats” submenu of the event type listing. 

 Unknown The beat wasn’t recognizable as a valid heartbeat. This may occur on the first beat prior to the QRS 
detector locking onto the signal. It may also occur if tracking is lost due to changes in signal quality. 

The Cycle/Peak detector may be used with these events to perform further cardiac analysis. 

 

Locate ECG Complex Boundaries 

 
Locate ECG Complex Boundaries performs ECG waveform boundary detection for human ECG Lead II signals; 
ECG signals must be sampled at 5 kHz or below to be analyzed with this classifier. It will attempt to locate the 
boundaries of the QRS, T, and P wave and will define events for each individual complex. It will attempt to insert 
the following events; all of these complex boundaries can be found in the “Hemodynamic > ECG Complexes” 
submenu of the Event Type listing. 

Wave Type Event Placement & Description 
QRS Onset 

Peak 
End 

Before the beginning of the Q wave 
At the top of the R wave 
After the end of the S wave 

T-wave Onset 
Peak 

At the onset of T 
At the peak of the T wave 
Note: This may not be a positive peak if the T-wave is inverted. If the T-wave seems 

to be bi-phasic, two T-wave events will be inserted and the event description 
will indicate that the T-wave is bi-phasic. 

 End At the end of T 
P-wave Onset 

Peak 
At the onset of P 
At the top of the P wave 

Note: This may not be the absolute maximum, but rather the likely center of P. 
 End At the end of P 

The Cycle/Peak detector may be used with these events to perform further cardiac analysis. 
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Heart Rate Variability 

New parameter settings for the HRV algorithm function better on shorter ECG signals 
and correspond more closely with other implementations. 

  

  

Heart rate variability is the examination of physiological rythms that exist in the beat-to-beat interval of a cardiac 
signal. Heart rate variability assists in performing frequency domain analysis of human ECG Lead II data to extract 
standard HRV measures. The HRV algorithm in AcqKnowledge 3.9 and above conforms to the frequency domain 
algorithm guidelines as published by the European Heart Journal. HRV processing in AcqKnowledge consists of three 
stages: 

1. The RR intervals are extracted for the ECG signal. 
 A modified Pan-Tompkins QRS detector is used. 

2. The RR intervals are re-sampled to a continuous sampling rate in order to extract frequency information. 
 Cubic-spline interpolation is used to generate this continuous time-domain representation of the RR 

intervals. 
3. The frequency information is extracted from the RR intervals and analyzed to produce standard ratios. Power 

sums are reported in units of sec2. 
 A Welch periodogram is used to generate the Power Spectral Density (equivalent to Transform > Power 

Spectral Density). 
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The initial implementation of the HRV algorithm was primarily for use with long duration recordings. HRV algorithm 
improvements allow for further customizations to the algorithm:  
 Windowing type for FFTs used to construct the PSD may be changed between Hamming, Hanning, and 

Blackman  
 Overall window length for segmenting source data for individual FFTs to include in PSD average may be 

modified  
 Length of the individual FFTs in the average can be manually specified  
 Scaling has been changed for PSDs, which are now scaled relative to the sampling frequency  
 Summary of power in individual frequency bands has been changed  
 Instead of a straight sum, an average power value is now reported  
 Power at endpoints is halved (e.g. divided by 2)  
 Sympathetic/Vagal ratios may optionally include the very low frequency band in the total power estimate  
 The modifications to the HRV algorithms that affect its power spectrum estimation have also been applied to 

the PSD transformation.  

After selecting Analysis > Heart Rate Variability, choose the appropriate tab(s) and establish settings.  

Preset controls, Transform entire wave checkbox, and OK/Cancel buttons apply across all of the tabs.  

Preset—The preset menu can be used to save a variety of HRV settings, including: beat detection parameters, 
spline resampling frequency, and frequency band ranges. Choose a preset from the popup menu to apply its 
settings. To construct a new preset with the currently displayed settings, choose Add New Preset. A default preset 
for adult human subjects is supplied. 

________________________________________________________________________________________ 
 
IMPORTANT—Recording good data is essential for performing HRV analysis. The protocol for data acquisition, 
filtering, artifact detection and correction in Application Note 233 results in great improvements in HRV analysis.  

“Results reveal that even a single heart period artifact, occurring within a 2-min recording epoch, can lead to 
errors of estimate heart period variability that are considerably larger than typical effect sizes in 
psychophysiological studies.” —Berntson & Stowell, 199 

 See Application Note 233 Heart Rate Variability—Preparing Data for Analysis Using AcqKnowledge 
(online at 5www.biopac.com) 

The note explains how to optimize ECG R-R interval data for Heart Rate Variability studies by using a template 
matching approach. It also explains how to identify erroneous R-R interval values caused by signal artifact and shows 
methods for correcting the errors by using the tools in the AcqKnowledge software. The note explains how to:  

A. Record good ECG data 
B. Prepare data for the tachogram  

1. Filter the ECG data 
2. Transform the data using Template Correlation function  

C. Create a tachogram  
D. Identify problems with the tachogram data  
E. Correct tachogram data  

________________________________________________________________________________________
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RR intervals 

Select a method to locate R waves: QRS Detector or Events. 

QRS detector 

 
The heart rate variability implementation has a built-in QRS detector. The detector does not run on raw source 
data; it uses a modified Pan-Tompkins algorithm to normalize the ECG data to 1, whereby the peak amplitude of 
the highest R-wave represents 1. Use the tachogram output to examine the output of the QRS detector. 

 R wave threshold—Starting with AcqKnowledge 4.1, the detection threshold must be specified in terms of 
percentage of maximum R peak level; this helps to clarify the units in which this threshold is expressed. The 
default threshold level of .5 should place the threshold in the middle of the R-wave, which should function on 
a wide range of data sets. If the R-wave amplitude varies a lot, it might be necessary to adjust the threshold 
level. 

o R wave threshold is expressed in normalized units, which are in the range (-1, 1): positive for 
positive R wave peaks. The maximum voltage in the signal maps to 1.0 and the minimum voltage 
in the signal maps to -1.0. 

Pan J and Tompkins WJ. A Real-Time QRS Detection Algorithm. IEEE Transactions on 
Biomedical Engineering 32(3):230-236, 1985.  

Events 

 

R-wave peaks will be located using events already in the graph of the channel of data to be analyzed. This 
assumes a single event is placed at each R-wave peak and that all of the R-peak events are of the same event type. 
When using events, the buit-in QRS detector is not used; the exact positioning between the events on the channel 
is used to extract the RR intervals.  

By using events, it is possible to use other QRS detectors within AcqKnowledge for performing HRV analysis. It 
is also possible to apply spectral HRV-style analysis to data in other domains as long as intervals can be reduced 
to events. 

Spline resampling frequency 

For highest accuracy, set to no less than twice the topmost frequency of the very high frequency band. 
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Frequency Bands 

 

Enter the start and end of each specified frequency band to adjust the boundaries of the frequency analysis. They 
are preset to the frequency ranges recommended by the European Heart Journal. Output of derived parameters is 
presented in a dialog and may also be pasted as text to the Journal. 

 Very high frequency band, usually used in rat studies, is disabled if the spline resampling frequency is less 
than the upper bound of the very high frequency range. 

 

PSD Options 

 

PSD Options establish parameters for the power spectral density transformation used to compute the spectrum 
from the interpolated tachogram; the options contained in this tab mirror the controls of the Analyis > Power 
Spectral Density transformation. 

The use of linear detrending in each individual segment of source data prior to the windowed periodogram 
analysis can be enabled or disabled. When disabled, the algorithm may be tuned to correspond to 
implementations that do not apply linear trending, such as MATLAB, which uses windowing only. The same 
PSD options are available via Analysis > Power Spectral Density so users can regenerate the spectrum from 
either the raw or interpolated tachogram output as necessary. 

After the user modifies the parameters for the PSD transformation, those parameters will become the new 
default values each time the dialog is displayed. When the application is relaunched, the default settings will 
be used (user changes are not persistent). 
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Window Used to change the window that is applied to each segment of the source data prior to 
computing the PSD to be included in the average. Includes the following options: 

Hamming Hanning Blackman 

Window size The specified number of samples must be a power of two. Note that the window function is 
applied to the entire window width of the data; using a subset of the windowed data will not 
include the final portion of the windowed data. 

 If the FFT size is less than the window size, only a subset of the windowed sample data 
will be used.  

Automatic If selected, the window size is selected automatically depending on the size of the 
source data. For a data length of n samples, choosing this radio button will use the 
window size: 

L =
n

4.5  

Manual If selected, the window size will be input manually by the user in the associated 
edit field. The window size must be greater than three and must be less than the 
length of the data selection. Users will be warned on invalid window sizes when 
attempting to click OK. 

Overlap length After each individual FFT, the window of source samples is shifted over by a certain amount to 
compute the next FFT, so there is an overlap of source samples in successive windows of 
source for the next FFT in the average. 

Automatic If selected, the number of samples to overlap successive windows will be 
computed automatically. Given a window length L computed according to the 
window width choices, choosing this radio button will use an overlap number of 
samples:  

L
2  

Manual lf selected, the number of samples to overlap successive windows of source data. 
Overlapping reduces windowing artifacts The overlap length must be positive and 
must be less than the window size. Users will be warned on invalid overlap lengths 
when attempting to click OK 

FFT width Automatic If selected, the number of points to use for each individual FFT will be computed 
automatically. Given a window length L computing according to the window width 
choices, the number of points in the FFT will be set to: 

 

 The number of points in the FFT is set to 256 if the window width is less than 
256. Otherwise the length is set to the next power of two higher than the 
window width. 

Manual  If selected, the number of points in the FFT will be specified manually in the edit 
box to the right of the radio. The number of points in the FFT will be required to 
be a positive power of two. It is recommended that the FFT length be set larger 
than the window size. If longer than the window size, zero point padding is used. 
Users will be warned on invalid FFT number of points when attempting to click 
OK. If the user inputs a number of points for the FFT that is shorter than the 
window width, a confirmation dialog will be displayed to the user warning that the 
windowing is shorter than the requested FFT width and asked if they want to 
continue. 
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Use linear 
detrending for 
each window 

When enabled, linear regression detrending is applied for each individual segment prior to the 
FFT computation. When disabled, windowing only is applied. 

Detrend each 
segment 
independently 

This option is only available when “Use linear detrending” is enabled. When this option is 
enabled, detrending is applied independently for each segment; when disabled, detrending 
from the previous segment will be incorporated into the next segment. 

Transform 
entire wave 

When enabled, the entire waveform is delayed. When unchecked, only the selected area is 
delayed. 

 If there is no selection in the graph, the checkbox is enabled and dimmed. 

 As the selection changes in the graph with the selection palette, the state of this checkbox 
is updated. 

Output 

 

Create standard result presentation graphs or assess 
performance of the HRV algorithm. Output options 
allow access to intermediate computation data for 
algorithm validation and/or measurements.  

 

RR Interval table 

 If the combined output formula is selected, the analysis output will contain an additional line of text:  “VLF 
Ratio” with the corresponding percentage. 

Spectrum 

Displays the power spectrum density (PSD) estimation from which the PSD summations and 
sympathetic/vagal ratios are computed. 

Raw tachogram 

Plots the raw R-R intervals found by the QRS detector. Perform statistical HRV measures on the R-R 
intervals without exporting the textual R-R table to excel. 

Interpolated tachogram 

Plots the resampled R-R intervals after cubic spline interpolation is applied and extracts the PSD from 
this data. 
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Gastric Wave Analysis 

 

 

 

 Gastric Wave Analysis uses autoregressive time-frequency analysis to determine the classifications of gastric 
waves present in an EGG signal. The single wave analysis determines the percentage of gastric waves that fall 
within the frequency bands corresponding to normal, bradygastric, and tachygastric waves. The analysis also 
indicates the percentage of waves that fall outside of these boundaries and are arrhythmias. The frequency bands 
are expressed in units of “contractions per minute” and may be adjusted by the user. Presets for commonly used 
subject and wave types are predefined; you may extend these presets with your own. 

 

Gastric Wave Coupling 

   
Gastric Wave Coupling takes two EGG signals and uses autoregressive techniques to classify the contractions in 
those signals according to user-configurable frequency bands (similar to single channel Gastric Wave Analysis). 
In addition to providing classification information for the two signals, Gastric Wave Coupling provides a 
measure of the percentage of coupling between the two signals—this measure that can be used to determine the 
amount of slow-wave propagation across the stomach. 
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Chaos Analysis 

 
The “Chaos” analysis package assists the user in exploring the chaotic nature of data, including measurement 
selection and visualization of time domain attractors in the data. 

 

Detrended Fluctuation Analysis  

  
Modified root mean square analysis, useful for evaluating self-similarity in a long-term, non-stationary data 
series. Source data is mean-adjusted and then integrated; it is then split up into n segments of equal length, and in 
each segment, via linear regression, the best fit least squares line is computed. For a particular value of n and a 
number of samples N, the characteristic fluctuation of the piecewise linear fit yn. is defined as: 

F n
1
N k 1

N

y k yn k 2  

F(n) is evaluated over a user-specified range for the number of divisions. n will equal the total length divided by 
the number of divisions. A log-log plot of the interval width n in samples versus the corresponding value of F(n) 
will be created. If a linear relationship appears to exist in this graph, then the source signal displays some form of 
self-similarity. The slope of the line in this graph is related to the scaling exponent. 

 For more information on Detrended Fluctuation Analysis, see http://www.physionet.org/physiotools/dfa/ 

 

Optimal Embedding Dimension  

            

Indicates the number of times the dimensionality of the data is increased by adding additional copies of the data. 
Many of the fractal measurements take an embedding dimension parameter. Increasing the dimensionality of the 
data may improve the quality of the results. In general, embedding dimensions should always be less than 8. 

After the most relevant time delay for the data has been selected, Optimal Embedding Dimension assists in 
choosing the embedding dimension that appears to give the most accurate results. The embedding dimension is 
chosen to be the earliest dimension in the search range where the fractal correlation dimension measure reaches a 
local maximum. This indicates the lowest dimension where the data has the potential to exhibit the most self-
similarity. 

 Since real data may not be fractal in nature, there may be no local maximum for the embedding dimension. In 
this case, it is not possible to determine the optimal dimension. 
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Optimal Time Delay  

   
Assists in picking a time delay that is most relevant for the data. It runs through and locates the earliest time delay 
in the specified interval range where the mutual information measurement reaches a local minimum. Optimizing 
the time delay in this fashion picks the shortest delay where the signal exhibits the most independence with 
respect to its time-delayed version. 

The fractal dimension and other chaos-related measurements operate on a single channel of data. In the process of 
extracting these measures, a signal is compared with a time-delayed version of itself to examine the patterns in 
dynamics of the data. These measures take a fixed time delay setting. The Optimal Time Delay transformation can 
be used to choose the best value for the parameter. 

 

Plot Attractor  

 
Assists in constructing X/Y plots for the attractors of time 
delayed data. By visually examining the shape of the attractor 
at a given time delay, To develop an intuitive sense for the 
underlying nature of the data and the dynamics of the system. 

Plot Attractor functions on the active channel of the graph. It 
prompts the user for a time delay and then constructs a new 
graph window with an X/Y plot of the attractor of the original 
signal against the time delayed version of the signal. It does 
not perform any additional computation aside from assisting 
in the setup and configuration of the attractor plot. 

 

 

Correlation Coefficient 

   
The correlation coefficient is a statistical measure related to the degree of variance or covariance between two data 
series. Given two data series x and y of length n, the correlation coefficient r is given by the formula: 

 (see 5http://mathworld.wolfram.com/CorrelationCoefficient.html) 
The square of the correlation coefficient can be used to determine the proportion of variance in common between the 
two signals. As the square gets closer to 1, the signals are a better statistical match for each other. 
To derive the correlation coefficient, two channels of data are compared against each other. 

 the channels must have the same length 
 the channels must have the same waveform sampling rate 
 all of the data of the entire graph for the two channels will be used to compute the correlation coefficient. 
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Electrodermal Activity 

 
 

Overview 

The Electrodermal Activity analysis routines are separated into three menu options that transform the tonic EDA 
signal to create a phasic waveform, locate and score skin conductance responses, or perform a detailed event-related 
EDA analysis by combining marker information from the Stim-Response: Digital Input to Stim Events routine (see 
page 397) to the event-related EDA Analysis routine. The Event-related routine will automatically derive the phasic 
waveform and locate SCRs. 

The routines employ a scoring system that marks the waveform and the point of stimulus delivery. It’s easy to 
manually adjust the automated scoring by relocating the event onset/peak/end before rerunning the analysis. The 
event-related analysis provides a variety of measures from the SCR data, including classification of specific and non-
specific responses. The results are pasted into the journal file or Excel for further analysis. 

Preferences must be established for each routine and can be adjusted at any time via the Preferences option (page 351). 
The time to complete the analysis routine will vary based on the number of SCR reposnes and the sample rate of the 
data. 
 
Definitions 

The prompts and results of the Electrodermal Activity analysis package use the following terminology and units: 

µmho—the unit abbreviation for micromhos, used in channel labels and analysis results; micromho is equivalent 
to microsiemens. 

EDA (Electrodermal Activity)—the general area of skin conductance signals. Sometimes referred to by the older 
term “galvanic skin response.” 

Tonic EDA—continuous data acquired from an EDA electrode that includes all baseline offset. Sometimes 
referred to as “skin conductance level.” Averaging the tonic EDA over a specific period of time results in the 
average skin conductance level over an interval. Tonic EDA is recorded using BIOPAC equipment with the high 
pass filtering set to off (DC mode). 

Phasic EDA—a continuous signal indicative of localized changes in the tonic EDA signal. Sometimes referred to 
as “continuous skin conductance response.” Phasic EDA can be thought of as AC coupled tonic EDA. The EDA 
analysis package offers multiple ways of constructing phasic EDA including smoothing and high pass filtering. 
The EDA analysis package performs the majority of its analysis on tonic EDA signals, so if phasic EDA is being 
recorded directly it is recommended that a second channel be used to record tonic EDA. 

Skin Conductance Response (SCR)—an individual localized change in the tonic EDA signal. An SCR may occur 
in response to a stimulus or may occur spontaneously. In general, there are multiple SCRs present in a tonic EDA 
signal and they can be detected as deflections from the localized baseline. 

Reference 

The Electrodermal Activity analysis package was developed to support the parameters established in: 

M. E. Dawson, A. M. Schell, and D. L. Filion. The electrodermal system. In J. T. Cacioppo, L. G. Tassinary, and 
G.B. Bernston, editors, Handbook of Psychophysiology: second edition, pages 200–223. Cambridge Press, 
Cambridge, 2000. 
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Derive Phasic EDA from Tonic 

Given a tonic EDA signal, this transformation uses baseline smoothing or high pass filtering (the method 
currently set in Preferences) to construct a new Phasic EDA channel in the graph containing the estimate of the 
phasic EDA. This routine is automatically included in both the locate SCR and Event-related EDA routines. 

 

Event-related EDA Analysis 

   
The Event-related EDA Analysis transformation routine assists in the extraction of EDA measures that are linked 
to specific stimuli. The stimulus event marks must be included in the file BEFORE using this analysis.  

This analysis routine requires four elements: 

1. Tonic and Phasic waveforms. 

Tonic EDA Channel: A Tonic EDA signal must be present in the graph.  

Phasic EDA: 

Construct new: Given a tonic EDA signal, a phasic EDA will be automatically constructed using 
baseline smoothing or high pass filtering (the method currently set in Preferences).  

Use Channel: If the graph contains a phasic waveform, select the appropriate channel. 

2. Stimulus delivery events.  

Digital markers with a common event type must be located BEFORE using this analysis.  

The Event-related EDA Analysis requires that an event be defined in the graph at the location of the 
delivery of each stimulus. This event may be defined using the Event Tool, hotkey insertion during 
acquisition, or any other method of defining events. All of the stimulus delivery locations to be 
extracted must have the same event type (e.g. “Flag”). To analyze multiple different event types, the 
transformation script must be executed multiple times. 

 If you are using E-Prime, SuperLab, or some other stimulus delivery system and have the digital 
events captured in the AcqKnowledge file, we recommend that you use the Stim-Response: 
Digital Input to Stim Events routine (see page 397). This routine will automatically classify and 
label the digital markers for use by the Event-related EDA analysis. 

Stimulus event type: If using the Digital Input to Stim Events, select Stim/Response > Stimulus 
Delivery. Stimulus delivery events are located by event type or by specific channel of the graph. 

 
Sample EDA Analysis Output 

All SCR events are marked on the tonic waveform as 
follows:  
 ( open paren. The point at which the phasic signal 

crosses the SCR threshold level 
established in EDA Preferences; see 
page 291 

 blue waterdrop blue marks the peak response of a 
nonspecific, event-related SCR  

red waterdrop marks a specific SCR “SRR” with a 
flag numbered with the stimulus event 
type 

  ) close paren. The point at which the phasic signal 
crosses the zero threshold level 
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Stimulus event location: Specify the location as anywhere, global only, or on a specified channel. 
See the Events section for details. 

3. Skin conductance responses. 

If the tonic EDA signal does not already have SCR events defined on it, SCR events will be 
automatically constructed on the channel using the Locate SCRs transformation routine. 

4. Specified time window between the stimulus event and the skin conductance response. 

The transformation takes a maximum allowable separation window between the stimulus event and 
SCR response. Each stimulus delivery event is paired with the closest SCR event. SCRs that 
correspond to a stimulus delivery are known as specific SCRs (abbreviated “SRR”). SCRs generally 
occur within a certain timeframe after stimuli. The time window allows responses too close to stimuli 
to be rejected and classified as non-specific. 

Minimum separation: specify in relation to the stimulus event (includes time unit options). 

Maximum separation: specify in relation to the stimulus event (includes time unit options). 

Given a response time window [resmin, resmax], for each stimulus delivery event at a time t, SCR onset 
events that are not presently matched as SRRs will be searched for in the window [t+ resmin, t+ 
resmax]. The SCR onset event within this window closest in time to [t+ resmin] will be paired with the 
stimulus event and considered a SRR.  
 

SRR are marked as a red waterdrop icon with a flag numbered with the corresponding 
stimulus event type when “Output events for specific SCRs” is enabled.  

 

Each SRR will be matched to only one stimulus delivery event. If the closest SCR to a stimulus is 
farther away than this time interval, it is not assumed to be a response to the stimulus. It may be a 
response to a later stimulus or it may be a non-specific SCR that occurred spontaneously. 

 

Output Events for Specific SCR 

Enable this option to mark specific 
skin conductance events as a red 
waterdrop icon with a flag numbered 
with the corresponding stimulus 
event type. 

 

 

 

 

 

Event-related EDA Analysis Output Options 

Enhancements provide more options for multiple stimulus event types and unmatched events, including:  

 Labels and additional measures are available in the specific stimulus and SCR analysis table  
 Text and Excel tables may be optionally sorted either by time or grouped by stimulus label  
 A new table has been added listing stimulus events that were not paired with an SCR  
 The SRR/NS.SSR Rate analysis, which counts frequencies of SCRs in specific time periods, may 

now be driven by time periods defined using pairs of events or a selection in the graph  
 A table has been added listing amplitude/frequency percentage statistics for all matched and 

unmatched stimuli events (e.g. total stimulus count, percentage of stimuli that were pared with an 
SCR, etc.)  

 Additional optional Specific-SCR events may be defined on the tonic EDA waveform at the 
positions of specific SCRs with labels matching the stimulus to which they were responses. This 
allows for further peak-detector based runs to perform additional data reduction.  
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Amplitude Summary Output Options 

For each specific SCR that is paired with a stimulus delivery event, the following measures are extracted in 
table format and can be sorted by Time or by Event label. If text output is enabled in EDA Preferences, the 
average value of SCL, Latency, SCR Amplitude, and SCR Rise Time will be included as the final row of the 
table. 

Name Abbrev. Description Units 

Stimulus 
Delivery Time 

Stim Time The time within the recording where the stimulus delivery event 
was located. 

seconds

Skin 
Conductance 
Level 

SCL Amplitude of the tonic EDA signal at the time when the stimulus 
was delivered. 

µmho 

Response 
Latency 

Latency Time separating the stimulus delivery from the onset time of the 
corresponding SCR. 

This latency will always be less than the maximum allowable 
latency specified as a parameter for the analysis. 

seconds

SCR 
Amplitude 

SCR 
Amplitude 

Height of the corresponding SCR as determined by the change in 
the tonic EDA amplitude from the time of SCR onset to the 
maximum tonic EDA amplitude achieved during the SCR: 

[EDA(tmax) – EDA(tonset)] 

µmho 

SCR Rise 
Time 

SCR Rise 
Time 

Time taken for the tonic EDA to reach its maximum value within 
the SCR:  

 [tmax - tonset] 

seconds

 

SSCR/NSSCR Summary Count Options 

In addition to the above measures extracted for each specific SCR, the analysis performs rate extractions for 
specific and non-specific SCRs. By examining how the rate of SCR occurrences changes, long-term 
experimental trends can be investigated. This analysis is placed into a second set of waveforms (or a second 
table for text and Excel output). 

Fixed width: fixed width window is specified as the “SCR count interval width” when performing the analysis. 
The entire recording is split up into fixed-width epochs of this granularity with the first epoch aligned at the 
start of the recording. For each fixed-width epoch, the following are extracted: 

Name Abbrev. Description Units 

Epoch Start 
Time 

Start Time Time location in the recording of the start of the epoch being 
examined. 

seconds

Specific SCR 
Rate 

SRR Frequency of the occurrences of specific SCRs within the epoch. 
Specific SCRs are those SCRs that were successfully matched to 
a corresponding stimulus delivery event. 

Hz 

Non-specific 
SCR Rate 

NS.SRR Frequency of the occurrences of non-specific SCRs within the 
epoch. These are SCRs that occur spontaneously and are not 
paired with any known stimulus. 

Hz 

Between event pairs: Select an event type from the pull-down menu. The software will locate the event 
markers at the beginning and end of the region of interest and perform the analysis between the two points This 
option is useful if the recording is broken into defined periods—such as baseline, event, and response—using 
the event hotkeys.. 

Manually selected area: Highlight the area where NSSCR/SSCR rates 
should be computed and then click “Do EDA Analysis” in the graph window. 
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Amplitude/Frequency Percent Summary 
The “Stimulus Matching Summary” table for Textual and Spreadsheet output provides overall summaries for 
each unique event label. The table has one line for each unique event label. 

Assume we have a set S of all events of an identical label, with an indexed event defined by si. 

This will be split into two subsets: Smatched consisting of all of the specific stimulus events that have an 
associated SCR with them, and Sns consisting of the non-specific stimulus events that do not have an associated 
SCR with them. Given these sets, the following definition holds: 

 
For an individual event, define the SCR Amplitude function:  

 
The following are the definitions of measures that will be included in the table: 

Name Description Units
Amplitude Average value of the SCR amplitude of all of the specific SCR events. Defined by 

the following formula: 

 

µmho 

Magnitude Weighted average of the SCR amplitude of all of the specific SCR events over 
the entire set of specific and non-specific events. Defined by the following 
formula: 

  

µmho

Matched Total count of specific SCRs. Defined by the following formula: 

 

 

Non-
matched 

Total count of non-specific SCRs. Defined by the following formula: 

 

 

Total Total count of events. Defined by the following formula: 

 

 

Frequency 
(%) 

Percentage of stimulus events that were paired with an SCR. Defined by the 
following formula: 

 

 

Label Textual label of the events that are included in S. One row per unique event label 
will be included in the table. All events with empty labels will be consolidated into 
a single row of the table. All stimulus label types are case sensitive, similar to the 
sorting options in the other output tables. 
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Locate SCRs 

  
The Locate SCRs routine will identify skin conductance response and score the waveform. This analysis is useful 
for analyzing spontaneously occurring skin conductance responses. The routine is automatically included in the 
Event-related EDA routine. All SCR events are marked on the tonic waveform as follows:  

 ( open paren. The point at which the phasic signal crosses the SCR threshold level established in EDA 
Preferences; see page 351 

 blue waterdrop The peak response point of a nonspecific, event-related SCR  

  ) close paren. The point at which the phasic signal crosses the zero threshold level 

This transformation requires a tonic EDA signal. If a phasic EDA has already been constructed for this tonic 
EDA, it may be used; otherwise, the transformation will create a phasic EDA automatically according to the 
settings in the Preferences. 

Given a tonic EDA, the Locate SCRs transformation defines an event for each skin conductive response in the 
tonic EDA. SCR location is a two stage process. First, all potential SCR occurrences are located on the signal. 
Second, all potential SCR occurrences that are not large enough are rejected. 

Potential SCR occurrences are detected by performing thresholding positive peak detection on the phasic EDA 
signal (using H and P as set via Preferences): 

1. Given a detection threshold H (expressed in µmho), search for a positive threshold crossing in the 
phasic EDA signal. This position is recorded as the start of the potential SCR. 

2. Continue examining the phasic EDA until the first negative threshold crossing of 0 µmho occurs. This 
position is recorded as the end of the potential SCR. 

3. Return to step 1 to continue searching for more potential SCRs. 

After all of the potential SCRs have been located, the set of valid SCRs is constructed as follows: 

1. Determine the overall maximum amplitude of the phasic EDA signal within all potential SCRs. 
2. Given a percentage P, construct a threshold level T of P percent of the overall maximum phasic EDA 

signal value located in step 1. 
3. Examine each potential SCR. Find the maximum phasic EDA. If m < t, discard the potential SCR. 

Mark the potential SCR as a valid SCR. 

If the tonic EDA channel chosen for analysis already has SCR events defined on it, the SCR events will be 
replaced with the newly detected SCR events. No existing SCR events will be erased without a confirmation. 

Once SCR events have been defined, they can be used in conjunction with the Cycle Detector for performing 
further data reduction. The “event count” measurement can be used to estimate SCR frequency during individual 
time ranges of the experiment. 

Events on Tonic EDA 

After valid SCRs are located using the algorithm above, events are inserted into the graph that can allow for 
further data analysis around the SCR positions. Three events are defined on the tonic EDA waveform for each 
individual valid SCR: 

1. “General > Waveform onset” event at the SCR onset time. This is the point where the threshold H was 
crossed in the phasic EDA. 

2. “EDA > Skin conductance response” event at the time where the tonic EDA reaches its maximum value 
within the SCR (max in time range). 

3. “General > Waveform end” event at the ending SCR time. This is the point where the zero threshold was 
crossed in the phasic EDA. 

Events for SCRs will always occur as described above, in the order shown. 
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EDA Measurements 

To perform Event-related EDA analysis, choose Analysis > Electrodermal Activity > Event-related EDA Analysis.  

To take measurements from the skin conductance response analysis, set measurements for event count, event location 
and/or event frequency. Set the source channel as the Tonic EDA channel and select the location (measurement 
channel only, global events only, anywhere) and measurement parameters as desired. This method is useful for 
spontaneously occurring skin conductance response analyses. Take measurements over a manually selected area or 
use Find Cycle analysis to take automatically measurements over a user-defined time interval. 
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EDA Preferences… 

 
The following EDA Preferences can be configured and will be applied to all options in the analysis package: 

 Display results as text, graph channels, or Excel 

 Construct Phasic EDA using High pass Filtering or Smoothing Baseline Removal 

o High pass Filtering—High pass filtering constructs phasic EDA by applying a digital IIR high pass filter 
(f = 0.05 Hz, Q = 0.707) to the tonic EDA signal. This high pass filter essentially AC couples the tonic 
EDA signal similar to using the high pass hardware filter available on the GSR100C module. When using 
high pass filtering, the first few seconds of the phasic EDA may not be centered on zero and will appear 
to contain invalid data and a valid response may be excluded; this artifact is related to the long time 
constant of this filter and is expected. 

   
0.05 Hz High Pass Filter     Smoothing Baseline Removal 

o Smoothing Baseline Removal—Smoothing baseline removal constructs phasic EDA by subtracting an 
estimate of the baseline conductance from the tonic EDA. Set the baseline estimation  

 Baseline estimation: The estimate of the baseline is generated using median value smoothing. This is more 
computationally intensive than high pass filtering but does not illustrate artifact at the start of the signal. 
Increasing the window will increase sensitivity and return more responses. 

   
Baseline window set to 4 seconds Baseline window set to 8 seconds 

 SCR detection parameters: threshold detection level H and percentage P, see page 349. 

o The default values are H = 0.02 µmho, P = 10, where H is detection threshold and P is percentage 
o Setting H to 0 and P to 10% will approximate the SCR detection algorithm referenced in  

K. H. Kim, S. W. Bang and S. R. Kim, “Emotion recognition system using short-term monitoring of 
physiological signals,” Medical & Biological Engineering & Computing, vol. 42, pp. 419-427, 2004. 

o Setting P to 0% will retain all potential SCRs (none will be rejected in the second phase). 
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Electroencephalography 

 
Compute Approximate Entropy 

  
Approximate entropy is a statistical measure that attempts to quantify the predictability of a data sequence. A 
perfectly predictable data series (such as a pure sine wave) has approximate entropy of zero. Several studies are 
beginning to examine approximate entropy of EEG data and its relationship to external factors such as drugs and 
sleep states. 

The Compute Approximate Entropy script divides an EEG signal into fixed-width epochs and computes the 
approximate entropy for each epoch. Derivation of the approximate entropy is a computationally intensive process 
and may take several minutes or hours to complete. To obtain only the sub-ranges of the EEG data, copy and 
paste the ranges into new graph windows to restrict the approximate entropy computations to that data range; the 
analysis is performed for all of the data in the graph window regardless of the selected area. 

Delta Power Analysis 

  
Delta power is the total power of the EEG signal that occurs within the delta frequency band as configured in the 
Preferences. Delta power has been examined in a number of various EEG studies as an indicator of 
sleep/wakefulness and other conditions. By examining changes in the delta power, it may be possible to correlate 
delta power with effects of external factors. 

The Delta Power Analysis script divides an EEG channel into fixed-width epochs. For each epoch, the power 
spectral density is computed and the total power within the delta frequency band is derived from the PSD. This 
delta power value is then placed into the graph or into the journal as specified by the output preferences. 
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Delta power can be measured from either a filtered or unfiltered EEG channel. To compute delta power for 
individual frequency bands, they must be derived prior to running the Delta Power Analysis script. 

Derive Alpha RMS 

 
The Derive Alpha RMS script constructs a standard alpha RMS waveform from an alpha EEG signal. Alpha RMS 
is the windowed root mean square value of the signal using a window width of 0.25 seconds. 

Derive EEG Frequency Bands 

 
The Derive EEG Frequency Bands script applies filtering to an unfiltered EEG lead signal to generate the 
following five standard EEG bands: Alpha, Beta, Theta, Delta, and Gamma. 

The frequencies used for each band are taken from the analysis package preferences. Filtering is performed using 
IIR lowpass+high pass combination filters. 



354 AcqKnowledge Software Guide 

Visit the online support center at www.biopac.com 

EEG Frequency Analysis 

   
EEG may be characterized in terms of frequency and the power within specific frequency bands. The EEG 
Frequency Analysis script performs various feature extractions from EEG signals using FFT and other techniques 
to examine the power within the EEG signals. This analysis may be performed for multiple EEG leads 
simultaneously, allowing for either analysis of multiple leads or analysis of multiple EEG alpha, beta, theta, or 
delta bands from a single raw lead. 

The EEG Frequency Analysis script divides the EEG signals into fixed-width time epochs. For each individual 
time epoch, AcqKnowledge’s Power Spectral Density function is used to estimate the power spectrum of that 
epoch using a Welch periodogram estimation method. From this PSD the following measures are extracted for 
each epoch: 

Name Abbrev. Description Units 

Mean Power MeanP The average power of the power spectrum within the epoch. 
(Units Note: V will be replaced with the voltage units in which 
the EEG was recorded) 

V 2

Hz  

Median 
Frequency 

MedianF Frequency at which 50% of the total power within the epoch 
is reached. 

Hz 

Mean 
Frequency 

MeanF Frequency at which the average power within the epoch is 
reached. 

Hz 

Spectral Edge Spectral 
Edge 

Frequency below which a user-specified percentage of the 
total power within the epoch is reached. This percentage can 
be set using “Preferences” and defaults to 90%. 

Hz 

Peak 
Frequency 

PeakF Frequency at which the maximum power occurs during the 
epoch. 

Hz 
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Remove EOG Artifacts  

   
Some EEG recordings involve subjects performing various visual tasks such as reading or watching video. Under 
these conditions, EEG may be susceptible to interference from the much stronger EOG signal arising from eye 
motion, particularly if EEG is recorded from near the front of the skull. Remove EOG Artifacts helps remove 
EOG interference from the EEG signals, recovering the EEG data for use in further analysis. 

EOG removal is performed using a blind signal separation technique known as Independent Component Analysis. 
ICA is used to split up statistically independent signals that have been mixed together during recording. Since 
EOG is independent of EEG, ICA can be used to remove it.  

In order to use Remove EOG Artifacts, a distinct EOG signal must be acquired in addition to the EEG signals. 
The EOG signal is required to identify the components correlated to eye motion. 

EOG artifact removal functions better when it is performed on multiple EEG leads simultaneously. Better results 
may be obtained by including EEG leads that do not exhibit EOG interference since the increased number of leads 
allows for more fine-grained signal separation. Good results can be seen with as few as two EEG leads and one 
EOG lead. While this technique can be performed with a single EEG lead, the results will not be as dramatic. 

Note ICA is a non-deterministic technique, so it may not be possible to automatically separate the signals for 
every EOG/EEG data set. For ICA to be successful, it may be necessary to fine-tune the parameters of the 
ICA search procedure to match the data, use a different electrode configuration, or use fewer or more 
leads. 
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Preferences… 

 
Adjust the EOG ICA Tolerance level and the EOG ICA maximum number of iterations by accessing Transform > 
Specialized Analysis > Electroencephalography > Preferences. EOG ICA Tolerance is used as the termination 
condition of ICA signal separation. The EOG ICA maximum number of iterations is another termination 
condition of ICA signal separation and represents the maximum point at which the search is aborted. For more 
information on these settings, see the documentation for the Independent Component Analysis transformation. 

Because ICA is a statistical technique, any filtered data produced with Remove EOG Artifacts should be carefully 
verified against other information to ensure that the approximations produced via ICA represent information that 
is truly correlated to the expected ECG. 

The spectral edge percentage indicates the cutoff percentage of the total power at which spectral edges will be 
placed. The default value is 90%. 

The frequency bands of alpha, beta, delta, and theta may be modified to match different analysis protocols. The 
default frequency ranges are:  

 Alpha—8 Hz-13 Hz 

 Beta—13 Hz-30 Hz 

 Delta—0.5 Hz-4 Hz 

 Theta—4 Hz-8 Hz 

 Gamma—36 Hz-44 Hz 
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Electromyography 

 
Derive Average Rectified EMG 

  
Average rectified value (ARV) is defined as a time windowed mean of the absolute value of the signal. ARV is 
one of the various processing methods used to construct derived signals from raw EMG data that can be useful for 
further analysis. 

To perform ARV, a time window must be specified for the sliding mean. The default time window setting is 30 
milliseconds, but this value can be adjusted depending on the desired amount of smoothing effects. It is advisable 
to closely examine results for time windows larger than 30 milliseconds as it is possible for delay to be introduced 
into the result. 

The ARV is computed using the Integrate transformation with a Rectified Average over Samples configuration. 

Derive Integrated EMG 

  
Integrated EMG (iEMG) is defined as the area under the curve of the rectified EMG signal, that is, the 
mathematical integral of the absolute value of the raw EMG signal. When the absolute value of the signal is taken, 
noise will make the mathematical integral have a constant increase. Integrated EMG splits up the signal into 
fixed-width timeslices and resets the integral at the start of each timeslice. To derive iEMG, the width of this 
timeslice must be specified. Similar to ARV, timeslices longer than 30 milliseconds may introduce delay into the 
result. 

The integrated rectified EMG signal will appear like a “sawtooth” style wave. In addition to the true iEMG, this 
script will output a second waveform whose value is the maximum value of the iEMG signal in each timeslice. 
This Maximum iEMG is easier to interpret visually and approximates the envelope of the iEMG signal. 

Derive Root Mean Square EMG 
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Root Mean Square EMG (RMS EMG) is defined as the time windowed RMS value of the raw EMG. RMS is one 
of a number of methods used to produce waveforms that are more easily analyzable than the noisy raw EMG. 

To construct the windowed RMS signal, a time window must be specified for the sliding mean. The default time 
window setting is 30 milliseconds, but this value can be adjusted depending on the desired amount of smoothing 
effects in the RMS EMG. It is advisable to closely examine results for time windows larger than 30 milliseconds 
as it is possible for delay to be introduced into the result. 

RMS EMG is computed using the Integrate transformation in a Root Mean Square Average over Samples 
configuration. 

EMG Frequency & Power Analysis 

Several frequency domain techniques may be used for data reduction of EMG signals. The EMG Frequency & 
Power Analysis script extracts several measures derived from the power spectrum of an EMG signal. The EMG 
signal is split up into a fixed number of time periods; within each window, the power spectrum is computed using 
the Power Spectral Density transformation. For each time period, the following measures are extracted: 

Name Abbrev. Description Units 

Median 
Frequency 

MedianF Frequency at which 50% of the total power within the epoch 
is reached. 

Hz 

Mean 
Frequency 

MeanF Frequency at which the average power within the epoch is 
reached. 

Hz 

Peak 
Frequency 

PeakF Frequency at which the maximum power occurs during the 
epoch. 

Hz 

Mean Power MeanP The average power of the power spectrum within the epoch. 
(Units Note: V will be replaced with the voltage units in 
which the EMG was recorded) 

V 2

Hz  

Total Power TotalP The sum of the power at all frequencies of the power 
spectrum within the epoch. 
(Units Note: V will be replaced with the voltage units in 
which the EMG was recorded) 

V 2

Hz  

Locate Muscle Activation 

 
When performing gait analysis, exercise physiology, or other research, identification of periods where the muscle 
is active can allow for correlation of external factors to muscle activity. Locate Muscle Activation attempts to 
identify various periods of muscle activity using statistical methods. The transformation requires a raw, unfiltered 
surface EMG channel. It takes a window width of w seconds, by default 0.25 seconds.  It is important that the first 
w seconds of the EMG signal be “background noise”, that is, that the muscle being examined is relaxed for the 
first quarter second. This quarter-second period is used to estimate baseline parameters that affect the entire 
process. 
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Note The LMA analysis expects EMG to be an AC-coupled signal centered around zero without baseline offset. 
If the signal is centered below zero, then no muscle activations are located. The Remove Mean function 
from the Analysis menu can be used to center the signal around zero for most waveforms. 

This transformation implements a variation of the Hodges and Bui detection algorithm as described in: 

P. W. Hodges and B. H. Bui, “A comparison of computer-based methods for determination of onset of muscle 
contraction using electromyography,” Electroenceph. Clin. Neurophysiol., vol. 101, pp. 511-519, 1996. 

The variation implemented is a threshold-based algorithm roughly consisting of the following steps: 

1. Determine mean value  and resting standard deviation  of the first w seconds of the signal. 

2. Construct a filtered ARV EMG signal, z. The window width w is used when constructing the ARV signal. 

3. Extract the variance of the signal with respect to the noise with the formula 

 
4. Using a threshold h, determine when the signal g lies below and above the threshold. Portions of time 

above the threshold are periods of muscle activity. 

5. Discard any transitions across the threshold if they are shorter in duration than a user-specified time, t. 

There are two methods of specifying the threshold h. An adaptive method examines the signal g and chooses the 
threshold to be the median of g over the entire waveform. Alternatively, the threshold can be specified manually. 
Using a manual threshold can be useful in adjusting the detection to better match specific EMG data. A suggested 
threshold is 2.5. By lowering the threshold, a larger quantity of data will be considered as muscle activity. By 
raising the threshold, a larger quantity of data will be considered to be noise. 

The transition discard time t is specified in seconds. The default value of t is 0.1 seconds. If muscle activity is 
being inaccurately identified as inactivity for short periods within active times, try increasing the value of t. Do 
not set t to be greater than the smaller of either the shortest duration of a single muscle contraction or the shortest 
rest interval between consecutive muscle contractions. 

There are two outputs from the Locate Muscle Activation script.  

 A new waveform, Muscle Active, will be added to the graph. The value of this wave will be zero when 
the muscle is at rest and one when the muscle is active. This wave can be used to quickly visually 
examine the record for periods of activity.  

 Events are also generated on the raw EMG waveform. A Waveform Onset event is placed at each 
transition from inactive to active, and a corresponding Waveform End event is placed at each active-to-
inactive transition. You can use these events in conjunction with the Cycle Detector to perform further 
data reduction based on muscle activity. 

The detection of muscle activation onset and end from surface electrode EMG is an imprecise process. The output 
of this location should be visually examined for misidentification of activation periods that are too short, too long, 
overlapping, or missed. 

Preferences… 

The Preferences allow the type of output to be chosen for displaying results: text, graph channels, or Excel. 
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Ensemble Average 

  
Ensemble Average assists in performing offline averaging. Offline averaging produces an average waveform from 
a number of cycles, also known as an ensemble average. Averages of multiple channels can be extracted 
simultaneously and be consolidated into a single graph window showing the results. 

This option provides two methods for locating individual members of the ensemble. 

 Peaks: Data-driven peak detection with positive or negative peaks in the data. This method automatically 
derives appropriate threshold levels from a user-selected peak and is useful for constructing averages keyed 
to periodic signals with strong spikes, such as ECG. 

 Events: Place members of the ensemble surrounding events in the waveform. Events must be previously 
defined by the user, either manually or through another automated process. This method is useful for 
constructing averages keyed to any types of events in a graph. 
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Epoch Analysis  

  
Extracts basic measures from fixed-width time segments of data. A fixed-width time segment of data is known as 
an epoch. The location of these fixed-width intervals can either be keyed off of locations of events in the graph or 
tied to regular time intervals (e.g. occurring at a constant frequency). All of the standard AcqKnowledge 
measurements can be extracted on an epoch-by-epoch basis with the exception of calculation measurements. 

Epoch-by-epoch measurement results can be viewed either as channels of 
data in the graph, a textual summary, or on an Excel spreadsheet; textual 
summaries include a final row with an overall average of each extracted 
measurement.  

Times output by Epoch Analysis are always expressed in seconds; all other 
units correspond to the current preferred measurement unit settings 
accessible under Display > Preferences. 
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Hemodynamic Analysis 

Hemodynamics is the study of blood and circulation related data. This analysis package concerns itself with 
interpretation of ECG, blood pressure, and monophasic action potential data; ECG signals must be sampled at 5 
kHz or below to be analyzed with this package. 

IMPORTANT: These routines are designed specifically for human subjects and may not function well, or at all, 
on animal subjects, particularly small animals. 

The Hemodynamic analysis package consists of:  

a)  ABP Classifier 

b)  Arterial Blood Pressure 

c)  ECG Interval Extraction 

d)  HRV Poincare Plot 

e)  Left Ventricular Blood Pressure 

f)  LVP Classifier 

g)  MAP Classifier 

h)  Monophasic Action Potential 

i)  Respiratory Sinus Arrhythmia 

j)  Preferences 

The time units reported by all of these transformations are in seconds unless otherwise noted. 

 

ABP Classifier  

   

 
Places systolic and diastolic events at appropriate locations on a continuous arterial blood pressure signal 
recording using either invasive means or a continuous noninvasive pressure monitoring system. The ABP 
classifier functions directly on the pressure data and may fail for signals that exhibit strong noise characteristics or 
large baseline drifts. Pre-filtering the signal may improve classification accuracy. 



363 BIOPAC Systems, Inc. 

www.biopac.com      |                     info@biopac.com |     805-685-0066 

Arterial Blood Pressure  

  
Extracts various cycle-by-cycle measures from arterial blood pressure (ABP) and ECG signals. It can function on 
an individual ABP signal or, when used in conjunction with an ECG Lead II signal, extract additional Q relative 
measurements. 

 If the ECG and ABP signals have not been classified when this analysis is performed, events for diastolic, 
systolic, and ECG boundaries will be inserted as necessary. 

 If systolic, diastolic, and Q events are already present on the signals, however, they will be used. 

On a cycle-by-cycle basis, the arterial blood pressure analysis transformation extracts the following measures: 

Name Abbrev. Description 

Diastolic - Minimum pressure occurring during the cycle 

Ejection time ET Time interval between the diastolic pressure and the minimum of dP/dt 

Heart rate HR Heart rate in BPM as extracted from the diastolic-to-diastolic time interval for a 
given cycle 

Maximum dP/dt dP/dt max Maximum amount of the change in the pressure during the cycle 

Mean blood 
pressure 

MBP Mean blood pressure: 

Pdiastolic 
Psystolic  Pdiastolic

3
 

Minimum dP/dt dP/dt min Minimum amount of change in the pressure during the cycle 

 

QA Interval QA Time interval between ECG Q wave and the diastolic pressure 

Recovery 
interval 

%REC Time required for the pressure signal to decrease by a user specified percentage of 
the pulse height 

Systolic - Maximum pressure occurring during the cycle 

Time to peak 
pressure 

TTPK Time interval between the diastolic and the systolic pressures 

When textual output is used, the average of all of these measures will be output as the last row of the table. 
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ECG Interval Extraction  

 
 

Extracts cycle-by-cycle time and voltage measurements for various points and intervals between waveforms in the 
cycle on ECG Lead II signals. This interval extraction is based off of the waveform boundary locations with 
additional logic for defining explicit Q and S wave events. QRS peak events as output for boundary location are 
used as the R peak location. 

 If the ECG signal was not classified before running the interval extraction analysis, it will be classified 
automatically. 

This analysis extracts the following cycle-by-cycle measures: 

Name Abbrev. Description 

Corrected QT 
interval 

QTC QT time interval divided by the square root of the RR interval 

Heart rate HR RR time interval expressed in BPM 

P height P-H Amplitude at the peak of the P wave in a cycle 

PRQ interval PRQ Time between the onset of the P wave to the Q wave 

QRS width QRS Time between onset of the QRS complex and the end of the QRS complex. Equivalent 
to the time between onset of Q and end of S 

QT interval QT Time between the beginning of the Q wave and the end of the T wave 

R height R-H Amplitude of the R wave in a cycle 

RR interval RR-I Time between consecutive R peaks in the waveform 

ST interval ST Time between the S wave to the end of the T wave 

At the end of the text table output, the average of all of the cycles will be displayed. Additionally, both text and 
Excel output will indicate the number of cycles that did not have all three of the QRS, P, and T waves defined. 
These are cycles where the classifier missed a boundary and are listed as “Bad cycles,” which may happen due to 
noise or other artifacts in the signal. 

HRV Poincare Plot 
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Poincare plots are constructed from ECG Lead II data. A Poincare plot is an XY plot with RR intervals in seconds 
on one axis and on the other axis the sequence delayed by one beat (RR vs. RR+1).  This plot may be used to 
visually inspect for patterns in the sequence similar to an attractor plot. The RR intervals are measured in seconds.  
This generates a new graph window in XY mode, no textual output is generated. (AcqKnowledge 4.2 and higher) 
 

Left Ventricular Blood Pressure 

 
Extracts various cycle-by-cycle cardiac measures of left ventricular blood pressure data, optionally in conjunction 
with an ECG Lead II signal. Examines the LVP signal, ECG, and derivative of the LVP signal. 

 If the LVP and ECG signals have not been classified before this analysis is executed, they will be classified 
automatically. 

 Derivatives of the LVP signal can be pre-existing or can be constructed automatically. 

 If an ECG signal is not included, only pressure related measures will be extracted. 

The analysis outputs the following information on a cycle-by-cycle basis and the textual output cites the average 
of all of these cycle-by-cycle measurements: 

Name Abbrev. Description 

Contractility 
index 

CI maximum value of dP/dt during the cycle divided by the pressure at that time 
location 

Developed 
pressure 

DP Amplitude interval between end diastolic pressure and systolic pressure 

dP/dt Max - Maximum change in pressure over the cycle 

dP/dt Min - Minimum change in pressure over the cycle 

End diastolic 
pressure 

LVEDP End diastolic pressure for the cycle. This is not necessarily the minimum pressure 
during the entire cycle. 

LVEDP is located on the LVP signal using the method set in the preferences. 

Minimum 
pressure 

MIN Absolute minimum pressure occurring during the entire cycle. This is not 
necessarily equivalent to the end diastolic pressure 

QA Interval QA Time interval between the Q wave of the ECG and the end diastolic pressure 

Rate - heart rate in BPM as extracted from the time interval between consecutive end 
diastolic pressure locations 

Recovery time %REC Time it takes for dP/dt to increase from the minimum dP/dt location to a user 
specified percentage of that minimum value 

Systolic pressure SYS Maximum pressure occurring during the entire cycle 

Tau - Monoexponential time relaxation constant tau computed on a cycle by cycle basis. 

See “Computation of Tau” on page 1366 for specifics. 

Tension time 
index 

TTI Integral of the pressure between end diastolic and the time of minimum dP/dt 
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Computation of Tau 

There are many different methodologies used to extract the time constant from LVP data. The time constant is 
extracted from a best fit parameter of a model to the trailing edge of LVP data on a cycle by cycle basis. This 
analysis uses a monoexponential model of zero asymptote for computing tau. The relaxation period is defined as 
the range of data between the time of minimum dP/dt in the cycle to the point where the LVP pressure signal 
drops below the previous LVEDP level. Within this range, the following model is fitted to the data using the 
simplex search method: 


t

eP0  

where P0  is the value of the LVP signal at the time of dP/dt minimum and t is the time coordinate shifted such 
that t is 0 at the time of dP/dt minimum. The best fit value from this model is used as the value of the relaxation 
time constant. 
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LVP Classifier  

Operates on left ventricular blood pressure (LVP) data to define events at the systolic pressure and the left 
ventricular end diastolic pressure for each cycle. 

 
The location of these points is performed using filtered derivatives of the original LVP signal. Pre-filtering the 
signal (lowpass of 50 Hz or less) or smoothing the signal before running the classifier may improve accuracy. 

The LVP classifier locates LVEDP (left-ventricular end diastolic pressure) by examining the derivative of the 
pressure signal based upon the location method specified in Preferences: 

 Adaptive threshold of 0 plus a percentage of the peak to peak change in pressure. The percentage is user-
specified; the default is 1%. If the LVP signals do not have “flat” valleys, this percentage may need to be 
increased to fine-tune positioning of LVEDP. 

 First zero crossings before contraction. 
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Monophasic Action Potential  

  
Performs classification of MAP data acquired from a human or animal subject and extracts various cycle by cycle 
intervals. Locates upstroke, maximum, 100% recovery, and user-specified recovery points on the action potential.  

 Classification is performed using the action potential with its smoothed derivative; pre-filtering noise with 
low pass filters may improve classification. 

 If upstroke, maximum, and plateau events are already defined on the MAP signal, the classifier is not invoked 
and only recovery events are defined. 

Plateau position 

To better handle animal subjects and different potential morphologies, there are two methods for locating the 
plateau position in monophasic action potential data; use Preferences to set the method. Each method defines 
recovery percentage time locations depending on the signal between its maximum and the beginning of the 
plateau. The plateau is located by examining the derivative of the MAP immediately following its maximum 
value after an upstroke.  

 The first method uses an adaptive threshold of zero plus a percentage of the peak to peak change in the 
derivative between the maximum and the first zero crossing after the maximum. If the signal remains above 
the upstroke voltage in this interval, a quick algorithm is used to locate 100% recovery and user-specified 
percentage levels. The default percentage is 0.1%, which will place the plateau position very close to the 
second zero crossing. This slight window around zero helps place plateau start events better for MAP data 
that has plateaus that continue increasing after their starting position. 

 Searches for the second zero crossing after the maximum. If the signal drops below the voltage level of the 
upstroke in this interval, a different (slower) algorithm is used to ensure the recovery percentage is relative to 
the upstroke voltage and not the minimum occurring between the maximum and plateau. 

The analysis outputs the following information on a cycle-by-cycle basis and the textual output cites the average 
of all of the cycle-by-cycle values: 

Name Abbrev Description 
100% recovery 
period 

100% 
REC 

Time interval from the upstroke for the signal to recover back to the upstroke voltage 
level 

dV/dt maximum dV Max Maximum change in voltage over the cycle 
dV/dt minimum dV Min Minimum change in voltage over the cycle 
End diastolic 
voltage 

EDV The value of the signal at the beginning of the upstroke 

Max voltage MAX The maximum value of the signal over a single cycle 
Minimum 
voltage 

MIN The minimum value of the signal over a single cycle. This may be less than the 
upstroke voltage depending on the morphology of the action potential 

Plateau voltage PLAT The value of the signal at the start of the plateau after the completion of the upstroke 
Rate - This is the heart rate in BPM as extracted from the time interval between consecutive 

upstrokes 
Stroke amplitude AMP Voltage interval between the plateau and the upstroke voltage 

User recovery 
period 

%REC Time interval from the upstroke for the signal to recover a specific percentage of the 
interval between the upstroke and the maximum voltage between the upstroke and the 
plateau 
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MAP Classifier  

The classifier portion of Monophasic Action Potential only – defines upstroke, plateau, and percentage recovery 
events on MAP signals without performing the additional MAP data extraction. 

 
The start of the plateau is located using either the second zero crossing of the derivative or a percentage of the 
cyclic peak-to-peak distance of the derivative. The plateau location method can be configured in Preferences. 

 

Respiratory Sinus Arrhythmia 

IMPORTANT—Respiration analysis assumes a bidirectional airflow signal that records both 
inhale and exhale. Unidirectional respiration signals cannot be analyzed at this time. 

Respiratory Sinus Arrhythmia is used to explore the connection between respiration and changes to heart rate. 
Variations in the heart rate can be directly correlated with vagal tone. The RSA index can be used to investigate 
changes in this connection during recording. 

This RSA index is computed using the peak-valley method as outlined in: 

Grossman, P., van Beek, J., & Wientjes, C. (1990). A comparison of three quantification methods for 
estimation of respiratory sinus arrhythmia. Psychophysiology, 27, 702-714. 

This method uses both a recorded ECG Lead II signal and a respiration signal. By using respiration information, 
this analysis method can provide breath-to-breath analysis that does not require parameter tweaking for individual 
subjects. 

While designed for use with the RSP100C/TSD201 respiration module and transducer combination, it should be 
possible to use other estimates of respiration. The respiration signal is used to locate periods of inhalation and 
exhalation. Inhalation begins at valleys in the signal while expiration at peaks. Any respiration estimate that 
exhibits this morphology should be sufficient. 

The RSA index outputted by this analysis is linearly scaled as per the recommendations in Grossman et. al. For 
comparison to other methods or studies using logarithmic scaling, Transform > Math Functions > Ln 
transformation can be used after analysis to convert results to logarithmic scaling. 
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RSA results are triggered from the respiration cycle. The RSA analysis outputs the following measures: 

Cycle Index of the respiration cycle in the analysis. 

Time Location of the start of the respiration cycle on the time axis. 

Min Rate Minimum heart rate occurring during the inspiration window of the respiration cycle, expressed 
in milliseconds (IBI). 

 If a respiration cycle is invalid, this measure will be set to 0. 

Max rate Maximum heart rate occurring during the expiration window of the respiration cycle, expressed 
in milliseconds (IBI). 

 If a respiration cycle is invalid, this measure will be set to 0. 

RSA RSA index for the respiratory cycle, expressed in milliseconds. This is the max rate minus the 
min rate. This is output in linear scaling. Conversion to logarithmic scaling must be performed 
manually, if desired. 

 If a respiration cycle is invalid, this measure will be set to 0. 

Preferences 

 
Display results as 

Several of these transformations produce large amounts of cycle-by-cycle derived measures. Results can be 
displayed as a tab delimited table in the journal, as waveforms in the graph, as an Excel spreadsheet or various 
combinations. Results are displayed as text-only by default. 

 

 LVEDP location method – see page 1367 

 adaptive threshold of 0 plus a % of pk-pk change in pressure 

 first zero crossings before contraction on the dP/dt signal 

 MAP Plateau location method – see page 1368 

 adaptive threshold of 0 plus a % of pk-pk change in the derivative between the max and the first 0 
crossing after the max 

 second zero crossing after the maximum 
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Impedance Cardiography Analysis 

The Impedance Cardiography analysis package assists in the analysis of cardiac output and other hemodynamic 
parameters using noninvasive bioimpedance monitoring techniques; signals must be sampled at 5 kHz or below to 
be analyzed with this package. It offers a variety of approaches for estimation of cardiac measures. 

 
Body Surface Area  

Determines the body surface area estimation in square meters for a subject of a given height and weight, using the 
formula set in Preferences. It can be used to calculate body surface area independent of any of the other analysis 
routines, which may be useful for validation purposes or other derived calculations. 

Body Surface Area equation 

Use the Preferences option to select an algorithm for estimating body surface area of a subject and deriving stroke 
volumes from impedance data. 

Method Formula 

Boyd BSA  0.0003207Height(cm)0.3 Weight(g)0.72850.0188 log(Weight(g ))
 

DuBois and DuBois BSA  0.20247Height(m)0.725 Weight(kg)0.425
 

Gehan and George BSA  0.0235Height(cm)0.42246 Weight(kg)0.51456
 

Haycock BSA  0.024265Height(cm)0.3964 Weight(kg)0.5378
 

Mosteller BSA 
Height(cm) Weight(kg)

3600
 

 

dZ/dt Derive from Raw Z  

This is a convenience utility for working with impedances recorded using the BIOPAC EBI100C amplifier or the 
raw impedance output of the BIOPAC NICO100C module. When computing derivatives from raw impedance 
signals from an EBI100C, this will apply appropriate filtering for a thoracic impedance signal and properly invert 
the derivative to match traditional dZ/dt presentation. 

dZ/dt Classifier  

Places events at common inflection points on a dZ/dt waveform to derive other measures. 
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The classifier will attempt to locate the following points on the ICG signal: 

 B point – opening of aortic valve (set location in Preferences) 

 C point – Maximum left ventricle flow (set location in Preferences) 

 X point – Closing of aortic valve (set location in Preferences) 

 Y point – Closing of pulmonal valve 

 O point – Widest opening of mitrial valve 

The algorithm for locating these points on the ICG signal examines local minima and maxima in the dZ/dt signal 
as well as values of its second derivative. Filtering is applied to the second derivative signal to improve accuracy. 

 Pre-filtering the dZ/dt signal may improve accuracy slightly. 

In a particular cardiac cycle, if there is not enough definitive change in the ICG signal to locate a particular point, 
the point will be omitted. This may most commonly occur with the Y point since its inflection between X and O is 
subtle and may be lost. 

The location routine, as with impedance cardiography measurements in general, is sensitive to motion artifacts. It 
is intended to function on signals acquired from subjects at or near perfect rest. Swings in the dZ/dt signal may 
cause the classifier to fail. It is recommended that motion artifacts be removed before running the dZ/dt classifier 
or any other ICG analysis tools that may invoke the classifier on an ICG signal. If artifacts are present within the 
signal, the template matching cycle location method will exhibit better behavior than the fixed threshold method. 
The choice between these two methods can be made with the Preferences option of the analysis package. 

B-point Location—Use Preferences to set the dZ/dt B-point location method. 

There is no standard method generally accepted for programmatically locating B-points on an ICG waveform. 
The appropriate choice of B-point location method may depend on the data or on subjective preference. On 
average, all three methods will produce similar results for clean data. ICG Preferences has three options for B-
point location: 

 Second derivative classification – Given a C peak, it searches within a 150ms to 100ms time window 
before the C peak for the maximum of the second derivative of impedance ( Z ). The B point is placed 

at this maximum. 

 Third derivative classification – Given a C peak, it searches for the maximum value of the third derivative 
of impedance ( Z ) within 300ms before the C peak. The B point is placed at this maximum. 

 Cycle-by-cycle ‘Isoelectric’ crossings – Given a cycle defined by two C peaks, the mean of the dZ/dt 
signal is computed over the cycle. The B point is then placed at the closest time to the right C peak that is 
still underneath this baseline zero level. 

C-point Location—Use Preferences to set the dZ/dt C-point location method. 

In several of the ICG analysis scripts, the B, C, X, Y, and O points will need to be located on the dZ/dt 
waveform. The starting point of this process is locating individual cycles on the dZ/dt waveform to define the 
C points. Use Preferences to set the cycle location method: 

 Template Matching – the user is expected to select a representative cycle of the dZ/dt waveform. The 
entire cycle should be selected (e.g. visually to approximate a C-C interval, a X-X interval, etc.). The 
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entire dZ/dt signal is then correlated with that representative cycle, and individual cycles are picked out 
from locations of maximum correlation. 

 Fixed Thresholding – the user is prompted to select one of the C peaks of the dZ/dt waveform. The 
voltage level of this peak is then used to compute an Ohms/sec thresholding level. Peak detection is 
then run on the dZ/dt waveform using that voltage level as the threshold. 

Since ICG is subject to many artifacts such as respiration components and motion artifacts, the default 
method used is template matching. For extremely clean ICG signals, however, fixed thresholding can 
be used effectively as well and will provide a quicker analysis. 

 Adaptive template matching – the user is prompted to select a representative cycle of the dZ/dt 
waveform. This is used as a basis for an adaptive match to locate cycles. Adaptive template matching 
will adapt to changes in the dZ/dt waveform as conditions change within the experiment. Two 
parameters may be set. The window size is the number of ICG cycles to use for estimating the next 
template. Smaller values will track changes more quickly; larger values will reduce interference from 
artifact. The correlation threshold is the value above which a match is found. It refers to the normalized 
cross correlation of dZ/dt with the template and should be between 0 and 1. Values closer to 1 will 
require precise matches and skip artifacts. Values closer to 0 will use looser match constraints and may 
be required if the ICG is changing rapidly.  

X-point Location 

There are two methods that may be used to locate the X point of the ICG waveform at the closing of the aortic 
valve. The choice of appropriate X point location method is dependent on the electrode configuration that is 
used to acquire the ICG signals. In certain electrode configurations, the dZ/dt minimum may actually occur 
closer to the A-wave complex than to X, making the first (and default) option of searching for the first turning 
point a more reliable solution. You may want to acquire a phonocardiogram in conjunction with ICG to help 
determine which method will be more accurate at locating X. 

 Search for the first turning point in the dZ/dt signal that occurs after the C point location and place X at 
the first positive zero crossing in the second derivative of impedance (d2Z/dt2).This is the default X point 
location method. 
 Locate the X point at the minimum value of dZ/dt over each cardiac cycle. 
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ICG Analysis  

 

The ICG Analysis routines include 20 derived impedance and hemodynamic measures that correspond to various 
values that are generated by other industry-standard impedance cardiography analysis tools. Many users tend to be 
interested only in a subset of the various measures produced by the analysis (e.g. only heart rate and cardiac output); 
the extra measures can “clutter” the output and frustrate users who have to delete them manually. 

The ICG Analysis output options feature adds a new step to the ICG Analysis where the user may toggle the output of 
individual measures on and off. This allows users to suppress generation of all output for a measure including the 
graph channels, column in the Excel spreadsheet, and column in the text output.  

ICG Analysis performs a full impedance cardiography analysis on data, extracting intervals and derived cardiac 
measures. The minimal set of signals required to run this analysis is an ECG Lead II signal and either a raw 
impedance signal or a dZ/dt signal. 

 If a raw impedance signal is present from an EBI100C or NICO100C and no derivative has been constructed, 
the analysis will automatically construct the appropriate derivative and perform classification. 
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 If both a raw impedance and a dZ/dt signal are present, the baseline impedance will be derived on a cycle-by-
cycle basis to improve the accuracy of the analysis. 

 If no raw impedance signal was acquired, a default fixed baseline impedance can be used. 

 If a NICO100C amplifier is used, it is recommended that both the raw impedance and dZ/dt signals be 
acquired to improve analysis accuracy. 

 To automatically apply motion filtering to the dZ/dt signal, use Preferences to enable Motion Filtering (see 
page 1379). 

In addition to the minimal set of signals, it is also possible to use arterial blood pressure, central venous pressure, 
and pulmonary arterial pressure signals to improve the quality of the algorithm results. If any of these signals are 
not present, default fixed estimated values can be substituted for the mean pressures instead of deriving pressures 
on a cycle-by-cycle basis. 

ICG Analysis may potentially perform classification of both the dZ/dt and the ECG Lead II signals. The various 
notes for understanding the limitations of these classifiers apply and should be understood to properly interpret 
failures in the analysis. 

ICG Analysis will produce the following information on a cycle-by-cycle basis: 

At the end of the textual table an average of all of the cycle-by-cycle values will be appended. 

 

Name Abbv. Description Units Formula 

Acceleration index ACI Maximum blood acceleration 1 / sec^2 d2Z
dt 2

max

TFI
 

Cardiac index CI Normalized cardiac output m^2 / min CO

BSA
 

Cardiac output CO Volume of blood pumped each 
minute 

l / min SV HR 

Heart rate HR Heart rate in BPM as computed 
from the RR interval. 

BPM 60

RRi

 

Left cardiac work LCW Work exerted by the left ventricle 
each minute 

kg m MAP  PAP CO0.0144 

Left cardiac work index LCWI Normalized left cardiac work kg m / m^2 MAP  PAP CI  0.0144 

Left ventricular ejection 
time 

LVET Time interval between B and X. 

Time interval between aortic valve 
open and close. 

sec Not applicable 

Mean blood pressure MBP Mean blood pressure as measured 
on the arterial blood pressure 
signal, or fixed estimate if no ABP 
signal is present. 

mmHg 
Pdiastolic 

Psystolic  Pdiastolic

3
 

Mean central venous 
pressure 

CVP Mean central venous pressure over 
cycle, or default value if no CVP 
signal is present. 

mmHg Not applicable 

Mean pulmonary arterial 
pressure 

PAP Mean value of the pulmonary 
arterial pressure of a cycle, or 
default value if no PAP signal is 
present. 

mmHg Not applicable 
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Name Abbv. Description Units Formula 

Pre-ejection period PEP Time interval between the Q wave 
of the ECG and the B point of the 
ICG. 

Time interval between systole and 
aortic valve open. 

sec Not applicable 

RR interval RR-i Time interval between R peaks in 
the waveform. 

 

sec Not applicable 

Stroke index SI Normalized stroke volume (ml / beat)/ m^2 SV

BSA
 

Stroke volume SV Volume of blood pumped by left 
ventricle in a single beat 

ml / beat Set equation in Preferences: 

Kubicek—Estimates SV from the 
derivative of the impedance signal 
and blood resistivity: 

SV    L2

Z0
2 

dZ

dt max

 LVET  

Note  may be either the absolute 
maximum or the BC delta in 
amplitude, as set in Preferences. 

 Sramek—Estimates SV from the 
derivative of the impedance signal and 
the estimated volume of electrically 
participating fluid (VEPT): 

SV 
VEPT

Z0


dZ

dt max

 LVET

o In the ICG analysis routines, 
VEPT is estimated using a 
truncated cone model. 

VEPT 
0.17H 3

4.25
 

     Sramek-Bernstein—Estimates SV 
from the volume of electrically 
participating tissue scaled according to 
body habitus. The SV equation is: 

LVET
dt

dZ

Z

VEPT
SV 

max0

)(  

where 

 
25.4

17.0
)(

3H

weight

weight
VEPT

ideal

actual   

Ideal body weight is computed using the 
method set in the Preferences. To best 
match the original Sramek-Bernstein 
equation, use the Met Life Tables ideal 
body weight method. 

Systemic vascular 
resistance 

SVR Afterload; arterial flow resistance dynes sec / 
cm^5 80 

MAP CVP

CO
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Name Abbv. Description Units Formula 

Systemic vascular 
resistance index 

SVRI Normalized afterload dynes sec m^2 / 
cm^5 80 

MAP CVP

CI
 

Systolic time ratio STR Ratio between electrical and 
mechanical systole 

none PEP

LVET
 

Thoracic fluid content TFC Electrical conductivity of the chest 
cavity 

1 / Ohms 1

TFI
 

Thoracic fluid index TFI Mean value of the raw impedance 
over the cycle, or fixed baseline 
value if no raw impedance signal is 
present. 

Ohms Not applicable 

Velocity index VI Maximum velocity of blood flow 
in the aorta. 

1 / sec dZ

dt max

TFI
 

Note  may be either 
the absolute maximum 
or the BC delta in 
amplitude, as set in 
Preferences. 

Ideal Body Weight  

Body Weight is derived from a person’s height, gender, and (for the Met Life method) frame size. It describes the 
ideal weight based upon various estimates. Ideal body weight is subject to much interpretation, so a number of 
methods are provided. Ideal Body Weight results are always expressed in kilograms. 

Use Preferences to set the Ideal Body Weight computation method; the selected method is also used for ICG 
Analysis. 

Method Formula 

Devine Men 50 kg + 2.3 kg per inch over 5 feet 
Women 45.5 kg + 2.3 kg per inch over 5 feet 

Metropolitan Life 
Tables 

The weight is taken from the standard Metropolitan Life tables, which are based on gender, 
height, and frame size. The Metropolitan Life tables specify weight ranges; the ideal body 
weight is computed as the average of the endpoints of each weight range. Ideal weights are 
based on height with shoes on and are only defined for heights between 
Men 5' 2''and 6' 4'' 
Women 4' 10''and 6' 0'' 

Miller Men 56.2 kg + 1.41 kg per inch over 5 feet 
Women 53.1 kg + 1.36 kg per inch over 5 feet 

Robinson Men 52 kg + 1.9 kg per inch over 5 feet 
Women 49 kg + 1.7 kg per inch over 5 feet 

 

PEP Pre-ejection Period  

The pre-ejection period is the time interval between the electromechanical systole and the onset of ejection of 
blood from the left ventricle of the heart. This can be derived from standard ECG data and ICG data as the 
interval between the Q point on the ECG and the B point on the ICG. The Pre-ejection Period analysis tool helps 
extract PEP measurements from ECG Lead II and ICG data. PEP can also be computed using the full ICG 
Analysis tool on page 1374. 

To use Pre-ejection Period analysis, both an ECG Lead II and an ICG (dZ/dt) signal must be present. If either of 
these signals requires classification, the analysis will run the appropriate classifier to define the relevant events on 
the signals. To automatically apply motion filtering to dZ/dt, use Preferences to enable Motion Filtering (see page 
1379). 

PEP analysis will output the following information on a cycle-by-cycle basis and the final line of the textual 
output will be the average of all of the cycle measurements. All time unit output is in seconds unless otherwise 
noted. 
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Name Abbrev. Description 

Heart rate BPM The heart rate for the cycle as indicated in BPM. Derived from the RR interval. 

Pre-ejection 
period 

PEP Time interval between the Q wave of the ECG and the B point on the ICG for the cardiac cycle. 

If the PEP cannot be computed for a particular cycle, it will have the value “----” in the textual output 
or 0 in the graphical output. 

RR interval RR-i Time interval between R peaks of a single cycle of cardiac data. 

dZ/dt Remove Motion Artifacts  

   
Applies SFLC motion artifact removal to a dZ/dt signal. Uses cycle information from an ECG signal to construct 
a sinusoidal model of the ICG signal containing only components that are correlated to the heart rate. 

 

IMPORTANT 

Motion artifact removal will affect the amplitudes of the dZ/dt signal, so results derived from a motion filtered 
dZ/dt signal should be additionally verified for accuracy. 

This tool performs the same type of filtering as the ICG Analysis and Pre-ejection Period tools when the Motion 
Filtering preference is enabled. 

VEPT  

 
Uses the truncated cone method to compute the volume of electrically participating tissue (VEPT) in cubic 
centimeters of a subject. You will be prompted to enter the height of the subject in the units set under Preferences. 
It can be used to calculate VEPT independent of any of the other analysis routines, which may be useful for 
validation purposes or other derived calculations. 
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Preferences 

Display results as 

 Textual tables in the journal 

 Channels of data inserted into the graph. 

C-point location –see page 1372 

B-point location – see page 1372 

X-point location – see page 1373 

Stroke volume equation – see page 1376 

 Kubicek, or Sramek, or Sramek-Bernstein 
 

dZ/dt Max method – Baseline drift in ICG signals 
can introduce drift artifacts into stroke volume, 
cardiac output, and other measures that are sensitive 
to changes in dZ/dt max. The Preferences offer two 
settings. “Max dZ/dt in cardiac cycle” will extract the 
maximum amplitude of dZ/dt as the max value. This 
is the traditional way of measuring dZ/dt max. A 
second estimate option, “change in voltage from B to 
C” will take the amplitude delta between B and C as 
the estimate of dZ/dt max. This will produce different 
stroke volume results, but is useful for removing 
motion artifact and improving consistency. 

Body Measurement Units system for inputting  

 English system: body height in feet and 
inches, distance between measuring electrodes 
in inches, and body weight in pounds 

 Metric system: body height in meters and 
centimeters, distance between measuring 
electrodes in centimeters, and body weight in 
kilograms. 

Body Surface Area equation – see page 1371 

 Boyd; DuBois and DuBois; Gehan and 
George; Haycock; or Mosteller 

Ideal Body Weight method– see page 1377 

Motion Artifact Removal 

The Pre-ejection Period and ICG Analysis transformations have the ability to optionally apply motion 
filtering automatically to the dZ/dt signal. Motion filtering is performed using an SFLC keyed to the R waves 
of an ECG signal. The SFLC filtering approach is similar to performing cycle-by-cycle averaging of the dZ/dt 
signal. This motion filtering approach may cause errors to be introduced in derived calculations, so any results 
with motion filtering turned on should be validated additionally. 

Filter Magnitude Level – relaxed, aggressive, and custom. 

 “Relaxed” uses a SFLC step size of .001. This allows the filter to adapt moderately quickly to changes in 
the dZ/dt signal. 

 “Aggressive” uses a SFLC setting of .0001. The filter will adapt less quickly to changes in the ICG signal, 
allowing better filtering out of motion artifacts at the expense of a lessened response to changes in 
underlying ICG morphology. 

 “Custom” allows for an arbitrary SFLC step size. The step size must be greater then zero and much less 
than 1 for the filter to converge. 
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Magnetic Resonance Imaging 

 
Magnetic resonance imaging, or MRI, is often used to study the brain and other organs in the body. As access 
increases to MRI machines, researchers are beginning to combine MRI with traditional physiological signal recording. 
The strong magnetic fields used by MRI equipment can cause profound artifacts in physiological recordings, which 
can make the analysis of physiological recordings acquired in an MRI difficult. Some artifacts are external 
interference while other artifacts can be caused by currents being induced in electrode leads or even in the body itself. 

Artifact Location and Trigger Signals 

Most of the MRI analysis options require information to identify the positions of various artifacts. Event positions 
can be used or a “trigger signal” waveform in the graph can be used to identify periods when the MRI is active. 
Some MRI machines have a TTL output that is synchronized with periods where the MRI is on. 

 Whenever possible, this trigger signal should be acquired with the MP unit along with the physiological 
data. 

Trigger detection off of an MRI trigger signal waveform is performed using fixed level thresholding on the 
waveform data. The threshold level is set to be the minimum value of the entire trigger signal plus 1/10th of the 
peak-to-peak distance of the trigger signal. The threshold is kept data dependent to allow for artificial trigger 
signals to be derived from data if the MRI unit does not provide its own. The trigger signal may be acquired on 
either an analog or digital channel. 

Event driven artifact location can be useful when trigger signals are not available from the MRI or are not 
recorded. A cycle detector analysis can be used to place events at the onset of each artifact, or these events may be 
placed manually. Event based detection is also useful for applying the procedures for artifacts that are not directly 
related to the MRI trigger signal, such as for removing the cardiac interference from EEG data caused by the 
magnetic field of the MRI machine. 

 

Artifact Frequency Removal 

MRI > Artifact Frequency Removal 
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Two large sources of interference in MRI recordings are the current induced by the MRI magnetic field and the 
RF pulses used for triggering molecule alignment. While the overlap of this interference may be difficult to 
separate in the time domain, the MRI interference may have a distinctive signature in the frequency domain. 

Artifact Frequency Removal is a frequency domain adaptation of the ensemble projection removal of the Artifact 
Projection Removal transformation. It attempts to cancel out MRI artifact by removing the frequencies most 
strongly associated with the MRI signal. 

For each channel of data to be denoised, either the MRI trigger signal or event positions are used to locate periods 
of MRI activity for constructing an ensemble average. The FFT of this ensemble average is computed, and the 
magnitude of the average FFT is set as the reference. Cyclic mean removal is applied to each period of artifact to 
compensate for baseline drift or signals with expected DC offset. A second pass is then made through the data. 
For each individual artifact, the FFT of that artifact is computed and the projection of that FFT onto the average 
FFT is removed. After projection removal, negative Fourier components are discarded and a time-domain signal 
is reconstructed using the inverse Fourier transform. This reconstructed, filtered signal is used to replace the MRI 
artifact in the original data. 

Application of projection removal in the frequency domain has similar limitations to applying it in the time 
domain, that is, it assumes that the MRI interference is stationary (which is not necessarily the case). Variations in 
the MRI interference may cause this method to fail. 

IMPORTANT Artifact Frequency Removal requires an MRI triggering signal or artifact onset events to locate 
artifact positions. 
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Artifact Projection Removal 

  
Artifact Projection Removal attempts to remove the noise components from the artifacts within a signal. An 
ensemble average is made for each period of MRI artifact in a channel. Cyclic mean removal is applied to each 
period of artifact to compensate for baseline drift or signals with expected DC offset. As the artifacts are averaged 
together, the actual interference with the physiological signal caused by the MRI should become the dominant 
feature if a sufficient number of artifacts are present. A second pass is made through the artifacts to remove this 
average MRI artifact from each individual period. 

The average artifact is removed using the Remove Projection transformation. This performs a vector projection of 
the signal onto the averaged artifact estimation and subtracts this projection. This is an improvement over straight 
subtraction of the average artifact as vector projection can compensate for changes to amplitude that may occur 
over time. 

Artifact projection removal cannot compensate for MRI interference that varies in frequency due to changes in 
orientation of electrode leads within the MRI or other factors that may alter the MRI artifact. 

Artifact projection removal is an adaptation of a denoising technique described in: 

M. Samonas, M. Petrou and A. Ioannides, “Identification and Elimination of Cardiac Contribution in Single-
Trial Magnetoencephalographic Signals,” IEEE Trans. Biomed. Eng., vol. 44, no. 5, pp. 386-393, 1997. 

IMPORTANT Artifact Projection Removal requires an MRI triggering signal or artifact onset events to locate 
artifact positions. 
 

Median Filter Artifact Removal 

 
Median Filter Artifact Removal provides a basic artifact removal suitable for slow moving signals such as 
respiration, GSR, or temperature. It performs a windowed median transformation on the source channel with a 
window width of 1/10th of the acquisition sampling rate. 

This median filtering approach is explained in the BIOPAC MRI application note AH223. 

Median Filter Artifact Removal does not require an MRI triggering signal. 
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Signal Blanking 

  
MRI artifact can grossly distort low level physiological signals, and this distortion can be several orders of 
magnitude larger than the signal of interest. A common practice for analyzing the physiological data is to discard 
the MRI artifacts and only examine the portions of the signal in between the MRI artifacts. One approach for this 
is outlined in BIOPAC MRI application note AH223. 

Signal Blanking provides an alternate approach for discarding MRI artifacts from the signal. Using the MRI 
triggering signal or artifact event locations, this analysis option will locate the periods of MRI activity and 
“blank” the physiological signal during this period. 

Two types of “blanking” can be performed: 

 Set value to zero – The waveform is set to zero during each artifact. 

 For integrated measures, zeroing the signal may be preferable as it will have no effect on the running 
sum. 

 Connect endpoints – For each artifact, a selection is made and the values within the interval are replaced with 
a line connecting the signal value before the MRI artifact to the signal value at the end of the interval. 

 For statistical measures or DC coupled signals, connect endpoint (linear interpolation within the 
interval) may be preferable to avoid causing the output to trend towards zero. 

IMPORTANT Signal Blanking requires an MRI triggering signal or artifact onset events to locate artifact 
positions. 

 

Slew Rate Limiter 

The Slew Rate Limiter restricts the maximum allowed 
change in amplitude across sample intervals, which is 
useful for certain types of denoising. The ability to 
restrict the maximum rate of change is useful for certain 
types of signal separation where a signal with a high 
expected rate of change is mixed with a low rate of 
change signal. The slew rate limiter removes noise of 
a specific type, without impacting source data, 
whereas a linear filter is not suitable for removing 
MRI artifact because it simply integrates the noise. 
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Neurophysiology 

The Neurophysiology analysis package assists in the analysis of spikes within extracellular microelectrode recordings, 
such as those recorded using an MCE100C module. All of these analysis options require a continuous recorded single 
channel of microelectrode data. 

 A spike is a deviation from the baseline caused by a neuron action potential. Frequently extracellular spikes will 
resemble exponentials. The point of maximum value of the spike will be used to locate neuron firing. 

 A spike episode consists of a fixed time window around a spike that aims to capture the underlying neuron 
firing time. The episode consists both of the rise time (the time taken to reach maximum) and the relaxation 
period around the spike. 

 

Amplitude Histograms 

 

  
 

IMPORTANT To run this analysis option, the signal must first be transformed by the Locate Spike Episodes 
option or the Classify Spikes option. 

Amplitude histograms show the population density of the maximum amplitude of neuron firing events. They may be 
used to interpret changes in neuron firing due to drug response or as rough indicators of the approximate number of 
classes of action potentials in a signal. Amplitude histograms can be generated on classified or unclassified signals. 

 On classified signals, an overall amplitude histogram will be created for all of the spikes in addition to a single 
amplitude histogram per class (reflecting only the episodes of that class. 

 On unclassified signals, a single amplitude histogram will be created from the maximum voltage within all of 
the spike episodes. 

Average Action Potentials 

 
IMPORTANT To run this analysis option, the signal must first be transformed by the Locate Spike Episodes 

option or the Classify Spikes option. 

After a classification has been completed for a spike signal, to assign spike episodes to different groups, users 
may wish to view the average shape of the waveforms of each class. Examining the shape of the different classes 
provides visual feedback as to the efficiency of the clustering, can allow for identification of certain classes as 
noise or artifacts, and helps to determine if the identified classes are indeed unique. Average Action Potentials can 
be generated on classified or unclassified signals. 
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 On classified signals, the resulting ensemble averages will have multiple channels. 

o The first channel will be the overall average of all of the spike episodes. 

o The remaining channels show the average of the members of each individual spike class. 

 On unclassified signals, a graph will be produced with a single channel showing the average of all of the spike 
episodes. 

Classify Spikes 

  

This analysis option will automatically classify action potentials in microelectrode data and divide them into 
different spike classes. 

A single-feature k-means clustering classifier is used, and the entire data set is used for the clustering portion of 
the algorithm. The determining feature is the Sum criteria— that is, the sum of all of the data points within the 
waveform segment; this was one of the first features used in early action potential classifiers. 

If the Locate Spike Episodes option has not been used to find spikes before this option was selected, the Locate 
Spike Episodes option will be automatically performed prior to the clustering. 

The analysis routine will ask for a number of spike classes and then use k-means clustering to group each spike 
episode into a class. The clustering may not produce meaningful classes, so results should be examined for 
accuracy. 

This style of classifier is for rudimentary spike analysis. For more advanced classification techniques, use the 
clustering algorithm in the peak detector. 

Dwell Time Histograms 

   
 

IMPORTANT To run this analysis option, the signal must first be transformed by the Locate Spike Episodes 
option or the Classify Spikes option. 

A dwell time histogram shows the population density of the duration of a neuron firing event. Dwell times can be 
approximated for an action potential by measuring the absolute value of the time interval between their maximum 
and minimum voltage levels reached during the firing of the neuron. After the minimum value in the firing 
recording has occurred, the neuron will be returning to its resting state, so the time difference is a good 
approximation for the firing duration. The dwell time histogram plots this time difference versus number of action 
potentials that have similar time differences. Examining varieties in dwell times can help to illustrate drug 
responses or to perform rudimentary classification of action potentials. 

Dwell times will be defined as the time difference between the positions of the maximum signal value and 
minimum signal value within a spike episode. Since dwell time histograms can be used for classification 
purposes, they can be run on classified or unclassified microelectrode signals. 

 On classified signals, an overall dwell time histogram will be constructed for all of the spikes in addition to a 

IMPORTANT If cluster events from a previous spike 
classification are already defined on the 
recorded waveform, this option will erase 
them and replace them with the new 
classification of the potentials. 
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single histogram per class, showing times of only the spikes in that class. 

 On unclassified signals, a single dwell time histogram will be created for all of the spikes. When run on a 
classified signal. 

Find Overlapping Spike Episodes 

IMPORTANT To run this analysis option, the signal must first be transformed by the Locate Spike Episodes 
option or the Classify Spikes option. 

In many extracellular recordings, it is frequent for there to be more than one neuron firing in response to the same 
stimulus. This can result in overlapping spike episodes when both neurons fire in close succession. Some types of 
analysis and spike classification are not able to produce meaningful results if too many overlapping episodes 
occur. “Find Overlapping Spike Episodes” can be used to locate overlapping episodes. After the spikes have been 
located in a signal, this option can be used to iterate only to those that are overlapping.  

“Next Overlap” and “Cancel” buttons are available in the toolbar of the graph window to allow for iteration 
through the episodes. 

Note This option is “view only.” Overlapping episodes are not affected by the analysis and will need to be 
manually removed manually to delete them from the file. 

Generate Spike Trains 

 
IMPORTANT To run this analysis option, the signal must first be transformed by the Locate Spike Episodes 

option or the Classify Spikes option. 

Spike trains are good visual indicators of when action potentials are firing and are good synchronization waves for 
further analysis and data reduction. A spike train is a channel in a graph whose value is 0 when there is no spike 
and 1 when there is a spike. 

Spike train generation will operate only on signals whose action potentials have already been classified.  

A single spike train will be generated as a channel in the graph for each class of action potential in the signal. 

If text output is enabled, the spike trains will be pasted as tables in the journal with one table per spike class. 

If spreadsheet output is enabled, the tables will be placed side by side so index 1 of the tables lines up for each 
action potential. 

Locate Spike Episodes 

Neurophysiology > Locate Spike Episodes  

 
This option provides the basic spike detection for a microelectrode signal. Spike detection is performed using the 
following steps: 

1. Obtain mean value of the entire signal. 

2. Obtain standard deviation of the entire signal. 
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3. Detect spikes where the signal rises above a fixed threshold determined by adding a multiple of the standard 
deviation to the mean. 

4. Position the episode around the threshold crossings according to the width and offset entered previously. 

A “Spike Episode Begin” event will be placed at the start of each spike episode and will be located offset 
milliseconds away from the threshold crossing. A “Spike Episode End” event will be placed at the end of each 
episode. 

If text output is enabled, a table of the start time of each episode will be placed in the graph’s journal. 

If spreadsheet output is enabled, a new spreadsheet will be created with the start time of each episode. 

Spike episodes may also be located manually by using the Cycle Detector to define “spike episode begin” and 
“spike episode end” events in the graph. 

Set Episode Width and Offset 

   
The first time spike detection is performed on a graph, the episode width and offset need to be entered. This width 
and offset is remembered and is used for all future spike detections in the graph performed by “Locate Spike 
Episodes” and other transformations. The width and offset that are entered are retained even if the file is saved 
and reopened. 

Use this option to view or change the current width and offset. 

Preferences 

 
 

Preference Description Default 
Setting 

Output type Determines whether analysis results will be displayed as graph channels, 
textual tables in the journal, or Excel spreadsheets. Not all of the output 
types are applicable for each Neurophysiology analysis option. 

Text output to 
journal only. 
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Preference Description Default 
Setting 

Spike Location 
Method 

Choose how spikes are searched for in the signal.  

Mean + Stddev—uses fixed level peak detection with a level that is 
computed from the mean value plus a configurable number of standard 
deviations of the data.  

Amplitude/Half-width Discriminator—allows for basic isolation of spike 
shapes that have peak voltages within a configurable range and spike half-
widths within a configurable range; uses the amplitude of the spike as 
well as the width of the spike to determine what constitutes a valid 
spike event. 

Half-width For a given spike, the discriminator searches from the 
maximum value of the spike to both the left and right of 
the maximum for the sample positions where the value 
has dropped below 50% of the maximum. The time 
interval between these sample positions is defined as 
the estimate of the half width. The acquisition sampling 
rate can be increased to improve accuracy of the spike 
half width estimates as neuron firing events involve high 
frequency components. 

 
Each time the discriminator is run, the user must input the amplitude 
low and high values as well as the minimum and maximum spike 
width. The discriminator searches for spikes in a signal x as follows: 
 

1. Performs regular peak detection on x using a fixed threshold 
alow. This locates the local maxima occurring after each 
threshold crossing of the low amplitude area. This results in a 
sequence p of potential spike locations. 

 
2. For each potential spike location p, computes the half-width 

time interval. 

 

 where  t50r is the first time > p such that  

   t50l  is the first time < p such that   

3. Accepts the spike for each potential spike location p as a valid 
spike s if, where a is amplitude and t is time window: 

 

 

 
4. For each valid spike location s, positions the spike episode 
 
   start output at s+offset 
  end output at s+offset+width 
 

The spike discriminator generates output only for spikes that fall 
within the bounds of the amplitude and offset windows. If a spike 
candidate falls outside the windows, no output is generated. 

Mean + 
Stddev 
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Preference Description Default 
Setting 

Spike Detection 
Level 

Spikes are located in the signal by looking for locations where the signal 
deviates from its baseline by a certain number of standard deviations. This 
multiplier is set in this preference. 

4 standard 
deviations 

Default Episode 
Width 

The first time that any of the spike detection is run on a graph, the time 
width of each fixed width episode must be specified. This preference 
provides the default value that is seeded in the dialog. 

The episode width for an individual graph does not need to match this 
default. 

10 
milliseconds

Default Episode 
Offset 

Each fixed width episode is located around one of the spikes in the signal. 
The offset allows for the episode to begin before (or after) the spike 
threshold crossing so the leading edge of the spike can be captured. 

Negative numbers indicate episodes are to start before the spike threshold 
crossing, positive numbers indicate episodes that start after. 

-2 
milliseconds

Default Number of 
Spike Classes 

The Classify Spikes script requires the user to input the number of classes 
into which the spikes will be partitioned. This preference allows the default 
number to be modified. 

The number of classes that wind up being used does not need to match this 
default. 2 

 

Principal Component Denoising 

  
Removes noise from certain types of signals. For principal component denoising to be effective, more than two 
signals should be used as sources and all source channels must have identical waveform sampling rates. PCA 
denoising is most effective on signals that are known to contain a high degree of similarity, such as multiple ECG 
leads or multiple EEG leads. PCA denoising should not be used on signals of different types or units as all of the 
principal components may be needed to fully capture the differences in the signals. 

 To determine if PCA denoising will be effective on a particular set of data or to compute a appropriate 
variance percentage for denoising, examine the principal components directly with “Transform > Principal 
Component Analysis” before selecting this option. 

Given a set of signals, a principal component analysis is performed. The strengths of the components are then 
analyzed, and the original signals are reconstructed from a subset of the principal components that capture a 
certain percentage of the total variance of the signals. This essentially eliminates one or more of the higher-order 
principal components. For certain types of signals, these principal components are the ones that model the noise 
inherent in the signals. 

1. Check the “Denoise” column for the channels to be denoised. 

2. Enter the overall percentage of the variance. 

3. After the percentage is entered, the denoising process will begin. 
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Remove Mean 

Available in AcqKnowledge 4.1 and above—Remove Mean allows for mean subtraction to be performed for the 
selected area (or entire wave if no data is selected). It will result in the mean value being the new zero value for 
the waveform. 
 

Remove Trend 

    

Available in AcqKnowledge 4.1 (and 4.0 Windows or 3.9 Mac)—Remove Trend helps to remove baseline drift or 
other linear trends from data. This tool makes it easier to apply trend removal to only specific segments of a 
waveform. Given a selected segment of data, or an entire waveform, it computes the trend between the two 
endpoints (similar to the Slope measurement) and then removes this trend from the selected area such that the 
endpoints of the selection lie at the same voltage. 

Linear Regression 

Use linear regression to estimate the trend to be removed from the waveform. 

Slope between endpoints 

 Left keeps the starting point of the selection fixed at the same voltage. The software adjusts the data from 
left to right such that the right endpoint is aligned with the initial starting voltage. 

 Right keeps the ending point of the selection fixed at the same voltage. The software adjusts the data 
from right to left such that the left endpoint is aligned with the initial ending voltage. 

Respiration 

 
IMPORTANT—Respiration analysis assumes a bidirectional airflow signal that records both inhale and 
exhale. Unidirectional respiration signals cannot be analyzed at this time. 

The respiration analysis package helps to analyze respiration- and airflow-related data. Other tools exist for 
respiration related analysis including AcqKnowledge transformations and the Respiratory Sinus Arrhythmia 
analysis in the Hemodynamics analysis package. 

Compliance and Resistance 

Compliance and Resistance analysis can be used to extract pulmonary resistance and pulmonary compliance in 
addition to basic airflow measures. This analysis requires an airflow signal and a pressure signal. The analysis 
will extract all of the measures of the Pulmonary Airflow analysis for the airflow signal. It also will locate apnea 
periods after exhalation using the same user-configurable threshold method as the Pulmonary Airflow analysis. 
IMPORTANT— The flow signal must be recorded correctly for Compliance and Resistance analysis to 
work. Compliance and Resistance analysis assumes positive flow indicates inhalation and negative flow indicates 
exhalation (the flow conventions of the recommended connections for a BIOPAC TSD107 pneumotach or a 
TSD117 airflow transducer). 

 If the flow signal was recorded with exhalation positive instead of inhalation positive,  
multiply the flow signal by -1 to invert the signal. 
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Pulmonary resistance is computed using the isovolumetric method. On both sides of the tidal volume peak for a 
breath, the position where the volume reaches a user-specified percentage of the tidal volume is located. The 
pulmonary resistance is defined as the difference in pressure divided by the difference in flow at these two 
isovolumetric positions. Due to the discrete nature of sampled data, these points may not be exactly equal in 
volume. To improve the accuracy of the isovolumetric method, increase the sampling rate used to acquire data. 

Dynamic pulmonary compliance is extracted on a breath-by-breath basis by dividing the tidal volume by the 
change in pressure between the exhale start and inhale start locations of the breath. 

Individual breaths are defined as the period between consecutive Inhale Start events. Airflow units are assumed to 
be the standard liters/sec and pressure units mmHg. For each breath period, the analysis will define the following 
events: 

 Inhale Start event on flow signal at start of inhale 

 Exhale Start event on flow signal at start of exhale 

 Apnea Start event on flow signal at beginning of apnea period (if present) 

 Recovery events on volume signal at isovolumetric positions to left and right of tidal volume peak 

If Inhale Start and Exhale Start events are already present on the flow signal at the start of analysis, those events 
will be used to define the breath periods. Apnea Start and Recovery events will always be regenerated by the 
analysis. 

The analysis will extract the following measures from the data: 

 

Name Abbrev. Description Units 

Cycle  Index of the breath in the data, beginning at 1.  

Time  Starting time of the inhale of the breath. seconds 

Peak Inspiratory 
Flow 

PIF Maximum absolute flow occurring during the inhale portion of 
the breath. 

liters/sec 

Peak Expiratory 
Flow 

PEF Maximum absolute flow occurring during the exhale portion of 
the breath. 

liters/sec 

Tidal volume TV Total volume of air inhaled during the breath. liters 

Minute volume MV Volume of air that would be inspired during a minute given the 
tidal volume and breathing rate of this breath. 

TV * BPM 

liters/ 
minute 

Breaths per minute BPM Breathing rate. 

60
TT  

BPM 
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Name Abbrev. Description Units 

Inspiration time IT Time interval between the start of inhale and the start of exhale. seconds 

Exhalation time ET Time interval between the start of exhale and either: 

● start of apnea (if apnea present) 

● start of subsequent breath (if no apnea present) 

seconds 

Total breath time TT Time interval between the start of inhale and the start of inhale 
of the following breath. This is the sum of the inhalation time, 
exhalation time, and apnea time. 

seconds 

Apnea time AT Time after end of exhalation where the airflow signal remained 
within the apnea threshold defined at the start of the analysis. 

seconds 

Pulmonary 
resistance 

RES Change in pressure divided by change in flow at the isometric 
volume locations: 

 

mmHg/ 
(liters/ 
sec) 

Pulmonary 
compliance 

Cdyn Tidal volume divided by the change in pressure between exhale 
and inhale locations in the breath: 

 

liters/ 
mmHg 

 

If text output is being generated, an additional row will be added containing the average values of the measures. 
Time and count are not output as waveforms in the graph since they can be found in the horizontal axis. 

 

Penh Analysis 

Penh Analysis script assumes standard recording methodology for a full body plethysmograph. Positive flow is 
treated as exhalation and negative flow is treated as inhalation. 

Penh Analysis extracts measures from data recorded in a full body plethysmograph. It operates on a single 
channel of data recorded from an airflow transducer connected to the plethysmograph. The analysis takes a single 
parameter: the Rt percentage. This percentage is used to locate the plateau, or “pause,” in the airflow signal. The 
pause begins at the time when the Rt percentage of the exhalation volume has been reached. The Rt percentage 
may be adjusted by the user and is set to a default of 65%. This analysis will place Inhale Start and Exhale Start 
events on the airflow signal. If these events are already present when the analysis starts, the user-defined inhale 
and exhale events will be used. This allows for the analysis to be repeated after manual inspection and correction 
of inhale and exhale locations and allows for different methods to be used to define the breathing boundaries. 

Penh analysis will place Recovery events on the airflow channel at the time positions where the corresponding 
percentage of the volume has been exhaled. The percentage used for the analysis is displayed in the label of the 
Recovery events. 
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For each exhalation period, the Penh Analysis will extract the following: 

 

Name Abbrev. Description Units 

Cycle  Index of the exhalation cycle in the data, beginning 
at 1. 

 

Time  Starting time of the exhale for the cycle. 

This is the location of the Exhale Start event. 

Seconds 

Peak inspiratory 
flow 

PIF Maximum absolute airflow occurring in the 
inspiration cycle immediately preceding the 
exhalation cycle. 

This measure is recorded as an interval, so its value 
is always positive. 

Airflow 
channel units 

Peak expiratory 
flow 

PEF Maximum airflow during the exhalation cycle being 
examined. 

Airflow 
channel units 

Exhalation time Te Total time elapsed between the start of the 
exhalation cycle and the end. 

This is the time interval between the Exhale Start 
and following Inhale Start events. 

Seconds 

Relaxation time 
interval 

Rt Time required for the subject to exhale the specified 
percentage of the total exhaled air. 

This is the time interval between the Exhale Start 
and the subsequent Recovery event. 

Seconds 

Pause  Numerical factor describing the characteristics of 
the plateau at the end of the expiration cycle. 
Computed using the formula: 

Te
Rt
− 1  

 

Enhanced pause Penh Pause scaled to be relative to the strength of the 
inhale and exhale.  This helps take breathing 
variability into account.  Computed using the 
following formula: 

 

 

 

The Penh analysis excludes the following exhale cycles from the analysis: 

 Exhale cycles that do not have a preceding inhale (may occur for partial cycles at the start of the data 
recording). 

 Exhale cycles that do not have a corresponding recovery time (often occurs during apnea). 

In addition, during periods of apnea, the analysis may produce invalid results, such as zero width recovery times. 
These results may be excluded from the analysis by either using waveform editing to remove apnea periods, 
discarding all events during apnea periods and rerunning the analysis, or deleting the corresponding rows from the 
Excel output. 
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Pulmonary Airflow  

 
The Pulmonary Airflow analysis follows the flow conventions of the recommended BIOPAC connections for a 
TSD107 pneumotach or a TSD117 airflow transducer. Positive flow is assumed to indicate inhalation; negative 
flow is assumed to indicate exhalation. 

The Pulmonary Airflow analysis extracts basic parameters from a calibrated airflow signal, such as would be 
recorded using a pneumotach or airflow transducer. In addition to inspiration and expiration, Pulmonary Airflow 
also can be used to examine apnea. Apnea is defined in this analysis as pauses in breathing that occur after an 
exhalation. 

When performing the analysis, an airflow signal  is chosen. An apnea threshold  fa is also entered. Inhalation is 

defined to begin at the point where . Exhalation is defined to begin at the point where . Apnea is 
defined to be the period between exhalation and inhalation where the flow lies within the apnea threshold: 

. At least two consecutive samples must occur within the apnea threshold for a period of apnea to be 
defined. This allows for valid transitions from exhalation to inhalation to occur even if one of the samples in the 
transition happens to fall within the apnea threshold due to sampling. 

The Pulmonary Airflow analysis will generate a tidal volume waveform if it is not present in the graph. It also 
will add Inspire Start and Expire Start events on the airflow signal if they are not present. New Apnea Start events 
will be defined each time the analysis is performed. 

Individual breaths are defined as the period between consecutive Inhale Start events. Airflow units are assumed to 
be the standard liters/sec.  

For each breath period, the analysis will extract the following: 

 

Name Abbrev
. 

Description Units 

Cycle  Index of the breath in the data, beginning at 1.  

Time  Starting time of the inhale of the breath. seconds 

Peak Inspiratory Flow PIF Maximum absolute flow occurring during the 
inhale portion of the breath. 

liters / sec 

Peak Expiratory Flow PEF Maximum absolute flow occurring during the 
exhale portion of the breath. 

liters / sec 

Tidal volume TV Total volume of air inhaled during the breath. liters 

Minute volume MV Volume of air that would be inspired during a 
minute given the tidal volume and breathing rate 
of this breath. 

TV �BPM  

liters / minute 

Breaths per minute BPM Breathing rate for the breath. 

60
TT  

BPM 
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Name Abbrev
. 

Description Units 

Inspiration time IT Time interval between the start of inhale and the 
start of exhale in the breath. 

seconds 

Exhalation time ET Time interval between the start of exhale and 
either: 

● start of apnea (if apnea present) 

● start of subsequent breath (if no apnea 
present) 

seconds 

Total breath time TT Time interval between the start of inhale and the 
start of inhale of the following breath. This is 
the sum of the inhalation time, exhalation time, 
and apnea time. 

seconds 

Apnea time AT Time after end of exhalation where the airflow 
signal remained within the apnea threshold 
defined at the start of the analysis. 

seconds 

If text output is being generated, an additional row will be added containing the average values of the measures. 
Time and count are not output as waveforms in the graph as they can be found from the horizontal axis. 

Preferences 

  
 

Spectral Subtraction 

Spectral subtraction is a denoising technique that operates on data projected into the frequency domain. It is 
frequently used in speech analysis denoising applications. Spectral subtraction examines a reference noise signal and 
performs a Fourier transform to get the noise frequency distribution. To denoise a signal, the Fourier transform of the 
signal is performed. The noise estimate frequency distribution is then subtracted from the source signal. The resulting 
processed spectrum with the noise frequencies removed is then reconstructed into a time domain signal using the 
inverse Fourier transform. 

Spectral subtraction performs noise removal on the entire channel in a single Fourier transformation, which allows for 
denoising where the noise is stationary; there is no provision for sliding window spectral subtraction at this time. 

The spectral subtraction is performed using a formula with two adjustable parameters. Given a frequency spectrum 
Fnoise and a mixed signal Fmix, the denoised frequency spectrum is computed using the following formula: 
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where 

Alpha is the “scaling factor” and can be used to adjust the strength of the noise estimate. 
Gamma () is the “power factor” and can be used to vary how the noise is removed. 

 = 1 allows for pure subtraction 

 = 2 allows for Euclidean distance formulas 

and so on 

Fdenoise that is less than zero is discarded and replaced by zero to maintain a valid set of Fourier coefficients for the 
reconstruction. 

When spectral subtraction is being used in practice, the noise signal may not always match the length of the signals to 
be denoised. To define the subtraction formula, the spectrum of the noise must have the same number of points as the 
spectrum to be denoised. If there is a length mismatch, the noise spectrum is resampled automatically to match the 
length of the spectrum to be denoised. Cubic spline interpolation is used during the resampling to provide a better 
estimate of the overall noise spectrum. 
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Stim-Response 

 
The Stim-Response analysis package can aid in analysis of stimulus-response studies. It allows for measurements to 
be extracted in tabular format for multiple stimulus classes. Stim-response configuration enhancements in 
AcqKnowledge 4.1 add the following functionality:  

 Measurement configuration is preserved across launches of the application  
 Measurement presets may be accessed directly from the specialized analysis routine 
 Additional checking for invalid channels and measurement expressions that cannot be applied to the source data  
The Event-related EDA Analysis routine uses the stimulus events to categorize specific and non specific responses. 
Responses are matched to the appropriate stimulus events using a user defined time window. See the Electrodermal 
Activity EDA Event-related analysis section for further information. 

Note: Excel spreadsheet generation is supported in AcqKnowledge 4.0 Windows 
 or AcqKnowledge 3.9.1 Mac and higher. 

 

Digital Input to Stim Events 

Digital Input to stim events identifies and labels stimulus events corresponding to any combination of digital inputs. A 
lightbulb icon is placed in the global event marker bar, the event is labeled with the stimulus event type, and the 
mouse-over tag includes the event time. All event information is accessible and exportable from the Event Palette. 

 
The Digital input to stim events function works with TTL trigger information coming from applications such as E-
Prime®, SuperLab®, DirectRT®, MediaLab®, Inquisit®, and Presentation. It converts TTL data acquired on the 
digital channels of an MP device into stimulus events. The system also works with analog and calculation channel 
signals coming from switch transducers. Unlike TTL signals, a voltage threshold level is used to determine the 
transition from low to high. 
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 This analysis option converts TTL or switch data acquired on an MP 
device into stimulus events. Stimulus delivery events are defined in the 
graph for each low to high transition of the digital data, the indications of 
stimulus delivery. The digital channels are interpreted as a binary number. 
Each stimulus event placed into the graph has the corresponding number 
included with its label. This allows further analysis to distinguish between 
different types of stimulus events by using the Cycle Detector’s label 
matching capability. 

   

  
Digital line decoding can be two byte (using all 16 digital lines) or single byte (on either the low eight or high eight 
digital lines). Big endian bit and byte ordering are used, with digital line 0 representing the least significant bit. 

When the stimulus labels are constructed, all numbers are zero-prefixed. All stimulus events will have the same 
number of base-10 digits with leading zeros, regardless of magnitude. This provides each stimulus event type with a 
unique label that can be used with the Cycle Detector (which uses substring matching). 

Some systems that trigger digital lines such as parallel ports 
may not be able to do so instantaneously; they may require a 
time window before the transition from one state to another is 
fully complete. A “transition latency” time window can be 
given to the analysis, specified in microseconds, milliseconds, 
seconds, minutes, hours, or samples. If non zero, any transitions 
that are separated by less than this latency are treated as a single 
transition and only one stimulus event is inserted. The decoded 
value used for the transition is the maximum value observed during the transition latency window. In the following 
example graph, the three digital TTL inputs correspond to one event., as marked by the red icon in the global marker 
bar. A transition latency of .5 seconds will consider all three as part of the same event since the transitions occur 
within .5 seconds of each other.  

 

“Specific channels only” dialog 
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Stim-Response Analysis 

Stim-Response Analysis allows for extraction of measurements within fixed width intervals occurring at Stimulus 
Delivery events. Stimulus events must be present to perform this analysis. The Stimulus Delivery events may be 
defined either manually, with the Cycle Detector, or using the Digital Input to Stim Events analysis option. The 
information that can be extracted includes the majority of the measurements available from the graph window 
measurement toolbar, matching the Epoch Analysis options. 

Unlike Epoch Analysis, the Stim-Response Analysis splits the analysis based upon the event labels. Stimulus Delivery 
events with different labels are interpreted as different stimulus types. Analysis results for each individual stimulus 
type are summarized in separate tables. Each independent text table has its own average of the measurements over that 
stimulus type. 

Additional options are available for positioning the fixed width interval where measurements should be made: 

 At each stimulus event – The measurement interval is aligned so the start of the measurement matches the time of 
the Stimulus Delivery event. 

 At fixed interval offset before or after stimulus – The measurement interval begins a fixed amount of time either 
before (for pre-stim studies) or after the time of the Stimulus Delivery event. This allows measurements to be 
made at a time relative to each stimulus onset and may be useful for measurements focusing on a specific time 
range (e.g. P300). 

 At matching response event – This option assumes that a second set of Response events have been defined for 
each stimulus either manually or using the Cycle Detector. Each Stimulus Delivery event is paired with the 
closest Response event occurring after it. The fixed width measurement interval is aligned so the start of the 
measurement window is the time of this matching Response event. 

 To use the “at matching response event” window positioning option, Response events must be defined in the 
graph. Response events are in the “Stimulus/Response” event submenu. These events are not defined 
automatically. 

 Response events can be inserted manually into the graph using the Event tool. 

 Response events can be inserted using the event output of a data-driven Cycle Detector analysis. 

Note If EDA/SCR signals are being analyzed in response to stimulus delivery, also examine the “Event-related EDA 
Analysis” transformation located under Analysis > Electrodermal Activity. 



400 AcqKnowledge Software Guide 

Visit the online support center at www.biopac.com 

Waterfall Plot 

  

 
Assists in configuring the Peak Detector for 3D surface generation. These surfaces showing cycle-by-cycle data of 
the graph are commonly known as waterfall plots. Cycles are located in the graph using the same sequence of 
steps as the Ensemble Average transformation script. Instead of generating the averaged graph, however, a 
number of 3D surfaces are generated. One surface is generated for each channel that is selected by the user. 

Wavelet Denoising 

 

Sample output  
Wavelet Denoising applied to heart 
sounds data may help clarify S1 and 
S2, as shown: 

 
Wavelet Denoising uses the forward and reverse wavelet transformations to project source data into the wavelet 
domain, modify the wavelet coefficients (called “shrinking” the coefficients), and then reconstruct the data from 
the modified coefficients. Wavelet Denoising allows for noise to be removed from a signal while minimizing 
effects on portions of the signal that strongly adhere to a wavelet’s shape. 

To perform wavelet denoising: 

1. Choose the wavelet type to use for the denoising (Biorthogonal 4.4, Symlet 4, Coiflet 6, or Daubechies 8). 
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Certain signals may work best with different wavelet types. 

2. Enter the number of iterations to use in the wavelet decomposition. 

Different numbers of iterations will have different effects on the results. 

3. Choose which type of thresholding should be used to shrink the wavelet coefficients. 

 Hard thresholding replaces coefficients below the threshold with zero while leaving all other coefficients 
unmodified. 

 Soft thresholding zeroes out coefficients below the threshold and subtracts the threshold for coefficients that 
are above it. 

Soft thresholding may be useful for reducing edge effects, but hard thresholding will affect amplitudes less. 

4. Choose the threshold level to use for shrinkage. 

 Fixed threshold for all levels. If you choose a fixed threshold, an additional window will appear into which 
you can type your threshold. 

 Adaptive threshold level based on the number of coefficients in the DWT iteration (a VIS shrink 
procedure). 

 

ECG Analysis Algorithm References 

AcqKnowledge 3.9 software implements the open source ecgpuwave ECG boundary location software and the open 
source OSEA QRS detector and beat classification library for ECG analysis. 
Automated ECG Waveform Boundary Location 
 ecgpuwave ECG boundary location software 

AcqKnowledge 3.9 software incorporates the ecgpuwave ECG boundary location software. Ecgpuwave is an 
implementation of a waveform boundary detection algorithm primarily developed by Pablo Laguna at the 
University of Zaragoza in Spain. This algorithm incorporates a variant of the Tompkins QRS detector, but 
contains additional rules that allow it to automatically extract the following characteristics of an ECG signal 
on a cycle by cycle basis: onset of P, P peak, end of P, onset of QRS, peak of QRS, end of QRS, onset of T, 
peak of T, and end of T. 

The algorithm is tuned to human ECGs through comparison with manual classification. Particularly, it seems 
to be within the standard deviation of human examiners for the onset and end of T waves, a particularly 
difficult feature to extract from an ECG complex. It also has the ability to take multiple ECG leads into 
account to reduce errors and misclassifications and appears to function for one to twelve lead ECGs. The 
algorithm is well documented in a number of papers. This algorithm development was sponsored by several 
government agencies including CICYT in Spain and the NIH. 

The ecgpuwave tool is distributed from the PhysioNet NIH servers ( 5http://www.physionet.org). This is a tool 
written in Fortran that will read WFDB formatted files. It will then output a series of annotations in WFDB 
format indicating the locations of the various ECG complexes within each cycle. It also depends on another 
tool, sortann (available from PhysioNet), to perform post-processing. This software reads and writes 
PhysioBank formatted files. This tool is only available on OS X. 
AcqKnowledge can automate the process of running ecgpuwave on source data and import its output back 
into AcqKnowledge. To run ecgpuwave on an ECG signal from within AcqKnowledge, first make the ECG 
channel the active channel and then choose Transform > Specialized Analysis > Locate ECG Complex 
Boundaries. AcqKnowledge will execute ecgpuwave on that signal and read in its waveform boundary 
location output, placing events on the channel. You will only be able to see this output if you have events 
shown. 
Alternatively, you can save your file to PhysioBank format, run ecgpuwave manually from a Terminal, save 
the annotations to “atruth” and then reopen that PhysioBank file to see the ecgpuwave results; this is the same 
process that AcqKnowledge performs. 

Source code for ecgpuwave detector is released under a GPL license and can be found on the AcqKnowledge 
CD. 
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OSEA QRS Detector 

 OSEA QRS detector and beat classification library 

AcqKnowledge 3.9 software incorporates the open source OSEA QRS detector and beat classification library. 

The OSEA library is a set of routines provided by EP Limited (5http://www.eplimited.com). This C++ based 
software library provides robust QRS complex detection and rudimentary beat classification. This library is 
well documented and tested. The QRS detector uses a standard Tompkins-based filtering and derivative 
detection algorithm and has been in development for about 15 years; the beat classifier has been developed for 
about a year or two. This algorithm development is sponsored by the NIH. 

This algorithm is fairly robust against arrhythmias, baseline drifts, discontinuities, and other artifacts in the 
ECG signal. It achieves a 90% success rate on identifying QRS complexes on sample arrhythmia databases. 
The algorithm is tuned to human ECGs. 

The QRS detector is optimized for 200 Hz sampled data. If the sampling rate is lower or higher, data will be 
internally resampled to 200 Hz before processing. The sampling rate difference may result in slightly different 
placement of beat events for different sampling rates. 

QRS detection can be performed by selecting the desired channel of ECG data and choosing Transform > 
Specialized Analysis > Detect and classify beats. AcqKnowledge will execute the OSEA beat detector on the 
source data and output a sequence of events on that channel of ECG data. You will only be able to see this 
output if you have events shown. 

Source code for the QRS detector is released under an LGPL license and can be found on the AcqKnowledge 
CD. 

 
Open Source Licensing 

The ecgpuwave and OSEA algorithms are available as open source, which means that their source code is 
publicly available. The source code can only be used, however, under conditions of their licenses. 

 ecgpuwave is under the GPL license 

 OSEA is under the LGPL license 

For the full text of both licenses, visit the Free Software Foundation (5http://www.fsf.org). 
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Chapter 18 Display menu commands 
Overview 

The Display menu includes a number of features that control how the waveforms appear on the screen and how much 
data is displayed at a time. 

  

  
Display menu and Show sub-menu 

Although these options change the appearance of the data, they do not change the data itself. In other words, changing 
the color of a waveform or showing only a portion of the data on the screen will not alter the data stored in the file. 

See the following shortcut options for Display menu commands: 

 Toolbar shortcuts, page 155 

 Context-sensitive shortcuts—page 68 
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Tile Waveforms 

Tiling is an operation performed on all waveforms to visually separate them on the screen. Tile Waveforms adjusts 
the vertical offset to center waveforms in the display; if there are multiple waveforms displayed in chart mode, the 
waveforms will be centered in their “tracks.” Tiling does not adjust the scale of the waveforms; it only affects the 
midpoints of the visible portion of the waveform. Tiling does not affect the vertical scale factor previously set for each 
channel (whereas Autoscale may affect the vertical scale factor as well as the offset). 

In Scope mode, tiling staggers the midpoint of the channels to visually separate them on the screen while maintaining 
their scales. In Scope mode, waveforms are spaced evenly along the vertical axis of the screen, and each waveform is 
centered vertically in its division. 

Choosing Tile Waveforms will center the waveform in the display by adjusting the vertical offset of the selected 
waveform. If there are multiple waveforms displayed in chart mode, the waveforms will be centered in their “tracks.” 
To apply tiling only to the selected waveform, hold down the CTRL key on Windows or the Option key on Mac OS X 
before selecting Tile Waveforms. In scope mode, waveforms are spaced evenly along the vertical axis of the screen, 
and each waveform is centered vertically in its division. Tiling does not affect the vertical scale factor previously set 
for each channel (whereas Autoscale may affect the vertical scale factor). 

When grids are locked, tiling will retain the appropriate heights and percentages. 

When grids are unlocked, the scale may be slightly larger in order to optimize the tick marks displayed on the vertical 
axis. 

  
Before Chart mode tiling After Chart mode Tiling 

  
Before Scope mode tiling After scope mode Tiling (red lines for illustration only)  

Note that the waveforms are centered relative to the horizontal divisions of the plotting area; the range and midpoint 
of the second waveform (blue square wave) are indicated in the figure above. 
 

Autoscale Waveforms 

The primary use of Autoscale is to make all of the data of 
the channel within the current time range visible on the 
screen. 

When Autoscale Waveforms is selected, AcqKnowledge 
determines what the “best fit” is for each displayed 
waveform. The percentages and midpoints are identical 
whether grids are locked or unlocked. 
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The software adjusts the vertical offset so that each channel is centered in the window (or within the channel track in 
chart mode) and adjusts the units per division on the vertical axis so that the waveform fills approximately two-thirds 
of the available area. In chart mode, the waveforms are autoscaled to fit their sections. In scope mode, the screen is 
evenly divided into horizontal “bands” and each waveform is scaled to fit the division without overlapping. 

 The autoscaling algorithm for Chart mode and X/Y mode is: 

1. Find maximum value of the channel in the time area, max. 

2. Find minimum value of the channel in the time area, min. 

3. If grids are locked, adjust scale such that max-min occupies 75% of the channel's track in Chart mode, or 75% 
of the entire plotting area X/Y mode. 

4. Adjust the midpoint so (max-min)/2 is at the vertical center of the channel's track in Chart mode, or vertical 
center of the entire plotting area in Scope and X/Y modes. 

  
Before autoscaling LVP channel After autoscaling LVP (red lines for illustration only) 

 The autoscaling algorithm for Scope mode is: 

1. Divide the plot height into m equal sections of height h each. 

2. Assign each visible channel to one of these plot sections. 

3. If grids are locked, Scale the waveform such that the range between the max and min values will occupy 75% 
of h. 

4. Place the midpoint between the max and min at the center of the waveform's section. 

In scope mode, the screen is evenly divided into horizontal “bands” and each waveform is scaled to fit the 
division without overlapping. 

Note: Autoscaling a single channel in Scope mode results in that channel occupying 1 / 
(num_visible_channels) of the overall waveform plotting area. It will be autoscaled into the topmost division 
of the screen. 

  
Before autoscaling in Scope mode After autoscaling in Scope (red lines for illustration only) 
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Overlap Waveforms 

Overlapping waveforms places all of the waveforms at the same scale and midpoint so that the plotting location of a 
specific voltage on screen is at the same spot for every channel. Overlapping is useful for examining closely 
associated waveforms, such as the calculated diastolic, systolic and mean calculation channels “overlapped” with the 
raw blood pressure waveform from a continuous blood pressure signal. 

In scope mode, when Overlap Waveforms is selected, the waveforms are “overlapped” into one screen. All of the 
currently displayed waveforms are arranged in the graph window with the same vertical scale and offset so all the 
displayed waveforms will fit on the graph; their magnitude reflects their size relative to the other waveforms. The 
overall chosen scale for all the displayed waveforms will be a function of the pk-pk value of the combined waves 

  
Before Overlapping in Scope mode After Overlapping in Scope (red lines for illustration only) 

 

Compare Waveforms 

Compare Waveforms displays all of the channels with the same amplitude scale. Compare Waveforms automatically 
sets the vertical scale to be the same for all channels and adjusts each channel offset so that all displayed waves are 
centered in the display. The scale for all the displayed channels is determined by the channel with the largest pk-pk 
range in the display interval. Compare Waveforms is useful for gauging the relative amplitudes of a number of 
channels by placing them all on the same amplitude scale and discounting the effect of waveform offset (or baseline). 

 In Chart mode, Compare Waveforms functions on each channel in its track. 

  
 In Scope mode, the channel scaling is similar but disperses the channels through the plot area similar to 

tiling. For a graph with m channels being plotted: 
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Autoscale Horizontal 

The Autoscale Horizontal command is a convenient way to display the entire data file (in terms of duration) on the 
screen. When this is selected, the display will be adjusted so that the duration of the entire waveform fits in the graph 
window. For long waveforms, this can take some time to redraw.  

You cannot undo the Autoscale Horizontal function with Edit > Undo, but you can use the Display > Zoom back 
command to revert to the previous display settings. 

 

Zoom Back / Forward 

Zoom functions can affect the horizontal scale, the vertical scale, or both. Zoom restoration is functional for the Zoom 
tool, Autoscaling, and the Tile, Overlap, and Compare Waveform options. Zoom scales are stored until another zoom 
function is performed. For instance, you cannot Zoom back and then use the Zoom tool and expect Zoom back to take 
you back two scale levels. 

 Zoom Back will restore settings one level at a time; you can repeat this selection to restore the original 
zoom scales. Essentially, Zoom back acts as an “undo” command for the zoom forward command and any 
other function that changes the amount of data displayed (either in terms of time or amplitude) 

 Zoom Forward will redo a zoom function after it has been undone; you can repeat this selection to restore 
the latest zoom scales. 

Zoom functions will work without limitation, until another Zoom is performed. 

 

Reset Chart Display 

The Reset Chart Display option will redistribute the chart displays evenly after you have changed the boundaries so 
that each channel’s vertical size is the same. This function, which only works in Chart Mode, can be useful if you 
need to expand a display region for analysis and then return to the original display. 

  
Before Reset Chart Display …and after 
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Reset Grid 

To return to the original grid, choose “Display > Reset Grid.” This will reconstruct the default, unlocked grid of four 
divisions per screen with solid light gray grid lines. 

 

Adjust Grid Spacing 

To modify the horizontal and/or vertical grid spacing, choose “Display > Adjust Grid Spacing.” This will generate a 
dialog for you to modify the locked axes of the selected waveform. See page 76 X for details. 

 

Set Wave Positions...  

By default, channels are arranged on the screen based on their channel numbers, with the lower number channels 
being displayed at the top of the screen. You can change the ordering so that waveforms are placed in an arbitrary 
order. 

 In chart mode this will result in vertical ordering of the individual waveforms. 

 In scope mode this will result in vertical ordering of the individual waveforms after a tiling or autoscaling 
operation. 

In addition, in the waveform positioning function, you can set any waveform to ignore the autoscaling and tiling 
functions. This can be important if you have some waveforms which you don’t want autoscaled with others. 

The waveform positioning function is selected through the Set Wave Position in the Display menu. The following 
dialog will then appear, with a scrolling list of all stored channels:  

 
If you have more channels than displayed, you can scroll through the list by clicking on the vertical scroll bar at the 
right. The list will scroll if you move past the top or bottom when clicking and dragging the waveform positions. 

The “Tile” checkbox to the left of each channel enables tiling and autoscaling for each channel when checked. Click 
the checkbox to toggle the enable.  

The on-screen position of the waveforms is the same as the ordering shown in the above dialog (from top to bottom). 
You can reposition the waveforms by reordering the channel labels as they appear in this dialog. To change the order 
of any waveform, select the channel label (e.g., CH1, ECG) and then click the Move Down or Move Up button. 
Repeat this operation until the waveforms are ordered the way you want. 

 Click OK to apply your selected order to the display screen. 

 Click Cancel to revert all waveform positions to those set before the dialog was opened. 
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Wave Color 

Select Wave Color and then set the desired color to discriminate between waveforms. In scope mode, the vertical 
scale, channel text, channel units and measurement popup menus take on the same color as the selected waveform. 
When adding new waveforms, AcqKnowledge assigns waveform colors in the following order: black, red, blue, green, 
cyan, and magenta. 

You can assign new colors to waveforms by choosing the menu selection Display > Wave Color 

  
Or, you can click the right mouse button to bring up a menu, select Color, and then select the desired waveform color 
from the color palette menu. Depending on the type of graphics adapter on your computer, you may or may not be 
able to choose “Other” to display a palette of color options. 
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Active Slice Color 

 
To change the Active Slice Color in Stacked Plot mode (see page 141), use Display > Show > Active Slice and then 
select Drawing options. 
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Horizontal Axis 

Horizontal Axis generates the Horizontal Scaling dialog. Set the axis in 
terms of time, frequency, or arbitrary units, and set the horizontal sample 
interval (the amount of time between two sample points) and the first 
sample (sample offset).  

Time domain scaling has two options to store and display data: 
 (ss.sss) —absolute seconds; the time scale for an event occurring 30 

seconds into the record would be 30.00 seconds 

 (HH:MM:SS) —hours:minutes:seconds; the time scale for the same event would be 00:00:30. 

You can set Time Unit precision via Display > Show > Selection palette; press Enter (return) to accept changes. 

  
Setting the horizontal Frequency allows output from a spectrum analyzer or plots data from a Fourier analysis or 
other data with a frequency base (rather than a time base). As with the time options, this feature is typically used for 
importing text files from other applications. For instance, if you were importing a text file with 1,000 sample points 
that covered a frequency range from 0 Hz to 100 Hz, you would want to set the interval to 1000 Hz/100 samples, or 
0.1 Hz per sample in the box to the left of the interval text box. Similarly, if the frequency range was 20 Hz to 100 Hz, 
you could set the offset to 20 Hz. You can attach arbitrary base units to the data (rather than a time or frequency base). 
This might be useful for data collected from a gas chromatograph. When the horizontal axis corresponds to 
wavelength, and the data consists of 100 samples covering a range from 1 to 10 Angstroms, the interval should be 0.1 
units per sample. 

Arbitrary units are generally useful for changing the time base (or other horizontal scale) of data that has been 
imported into AcqKnowledge as a text file. For instance, if you want to analyze data imported from a text file that 
contains 30 seconds of data that was collected at 100 samples per second (100 Hz), the first step would be to open the 
file (following the directions on page 239). 

When arbitrary units are selected, two additional text boxes appear at the bottom of the dialog. The upper Units text 
box is used to provide a name for the horizontal scale units (in this case, Angstroms), and the lower Units text box is 
used to provide an abbreviated label for the horizontal units (i.e., Ang). 

By default, AcqKnowledge assumes that the data was collected at 50 Hz, and would therefore plot the data so that a 
60 second record was displayed that appeared to be collected at 50 samples per second. To change this to reflect the 
rate at which data was actually collected, you would change the sample interval box in the horizontal scaling dialog. 
When data are displayed on a 50 Hz time base, the sample interval will read 0.0200000 seconds per sample. This 
means that there is a 0.02-second “gap” between sample points in the record. To display data at 100 samples per 
second, change the interval to 0.01 seconds per sample. 

To determine the sample interval for other sampling intervals, divide 1 by the rate at which data was sampled (in 
terms of samples per second). Thus, a sampling rate of 0.5 Hz would translate into a sample interval of 2.00 seconds 
between samples, and data collected at 100,000 Hz (100 kHz) would have an interval between sample points of 
0.00001000 seconds. 

TIP:  To confirm that AcqKnowledge is storing data in the same time base it was collected in, 
choose Statistics from the Display menu. This will generate a dialog that describes (among 
other things) the sampling rate AcqKnowledge uses in analyzing the data. Once data has 
been saved as an AcqKnowledge file, time base information is automatically saved along 
with the data. 
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Show 

Selecting Show from the Display menu generates a submenu that allows you to control a number of data display 
options and what additional information is displayed in the graph window. To enable an option, select it from the 
submenu; a bullet (•) or checkmark appears next to the menu item when it is enabled. The three display modes and the 
two plotting modes are mutually exclusive, but the remaining items can be enabled independently.   

Show Option Shortcut Explanation 

Channel 
numbers   

When the Channel numbers option is selected, the channel boxes appear just above 
and below the graph area. 

 Channel boxes with Channel 1 selected 
These boxes are useful for selecting channels and “hiding” channels by positioning 
the cursor over the channel box, holding the ALT key on the Windows or the 
Option key on the Mac, and clicking the mouse button. 

Annotations  Toggle show/hide of text annottaions.  

Chart 
  

Activates the Chart display mode (see page 139). 

Dot plot  Dot Plot allows you to view data in a “dot” format. The software will create user-
defined, discrete points that map out the selected waveform. This is often useful for 
demonstrating the concept of discrete digital sampling by dividing the waveform up 
into data points or “dots.” 

Dot size  

 

Dot size is enabled after Dot Plot is selected. 
Dot size specifies how large each dot will be. Each dot 
is measured by the number of monitor pixels it 
occupies. 

Events 
 

Enables Event display. See page 208 for Events. 

Grid 
  

Superimposes a Grid on the graph window (see page 151). To change grid precision, 
use the axis scaling dialog of the horizontal or vertical axis.  

Grid Options  Activates the Grid Options dialog (see page 78 X) 

Hardware 
 

Show/Hide Hardware “Connected to:” dialog in the graph display; includes network 
access. 

Journal 
   

Activates the Journal (see page 1552). 

Last dot only  Plots only the most recently acquired data point. This is most useful when viewing 
data as it is being collected and when this data is displayed in X/Y mode. 

Line plot Right-click 
menu 

Connects each sample point with a line to create the waveform. Waveforms that are 
displayed in line plot mode match a true analog plot (as closely as possible). This is 
the default display mode for most waveforms, except histogram plots, which are 
displayed in Step Plot mode (see 12296). You can change line options by clicking the 
right mouse button, which will generate a menu displaying several commonly used 
features. 
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Show Option Shortcut Explanation 

Line thickness   

 

Line thickness is enabled when Line or Step plot are 
enabled. Use to specify the plot thickness in pixels. 
(AcqKnowledge 4.2 and higher) 

 
Sine wave set to thickenss of 5 pixels 

Markers 
 

Displays the marker/event region at the top of the graph window, along with any 
markers/events associated with the data being displayed and the marker/event tools. 
See page 213 for Event details. 

Measurements 
 

Displays the measurement popup menus and windows above the graph window (see 
pages 150 and 187).  

Scope 
 

Activates the scope display mode (see page 139). 

Selection 
Palette 

 

 

Many of the tools within the AcqKnowledge environment are based around the 
selection. The selected range of data in the graph is used as the source for 
measurements, waveform editing, transformations, and other operations. The 
Selection Palette is a floating dialog that can be used to precisely enter the selection. 

 The Selection Palette can be used to adjust the selection at times when it is 
not possible to use the selection tool in the graph window, such as when 
transformation dialogs are being displayed for the graph. 

 The selection palette offers a way to change the selected area without 
having to cancel the transformation setup and lose any parameters typed in 
the dialog. 

To display the Selection Palette, choose Display > Show > Selection Palette. This 
small floating dialog contains two edit fields that display the location of the left and 
right edges of the selection using the measurement units currently displayed in the 
horizontal axis. As the selection is changed, the new selection boundaries are 
shown. 

The Selection Palette also can be used to manually type in the edges of the 
selection. Double-clicke of the edges and type in the new horizontal position of the 
edge of the selection. Press “Return” to adjust the selection to that time location and 
update measurements and the visible display on the screen. 

When a graph is displayed in X/Y mode, the Selection Palette can be used to adjust 
the range of data that is plotted on the screen. Limiting the time range can be useful 
for generating X/Y plots for different intervals of the graph that can then be 
compared with each other, such as examining PV loops from different time periods 
of a recorded signal. 

Click the small arrow in the top right of the selection palette for the following 
additional options: 



414 AcqKnowledge Software Guide 

Visit the online support center at www.biopac.com 

Show Option Shortcut Explanation 

 
 Paste edges in Journal—This option pastes a line of text into the Journal 

that includes the left and right edge measurements of the selection. 
 Time units—Use this submenu to change the time units used in the 

selection palette. The following time units are available: Match units on 
axis; Hours; Minutes; Seconds, Milliseconds, and Microseconds. The Time 
units submenu will be dimmed unless the graph displays time/arbitrary 
measures). 

 Frequency units— Use this submenu to change the frequency units used in 
the selection palette. The following frequency units are available: Match 
horizontal axis, Kilohertz, Hertz, and Millihertz. The frequency submenu 
will be dimmed unless the graph displays frequency-based measures.  

Note Changing time/frequency units in the selection palette can be helpful during 
zoom operations when the units displayed in the horizontal axis may not be 
the most convenient for inputting new selection boundaries.  

Spectrum 
Analyzer 
Palette 

 Provides a dynamic display of the frequency decomposition of data, in real time or 
post-acquisition. See page 1416 for details. 

Stacked Plot 
Options 

 Displays options that can help visually distinguish the active slice from other slices 
being drawn in Stacked Plot mode. See page 142 for details. 

 
Step plot  Displays waveforms in a “step” plot, meaning that the lines connecting sample 

points are drawn either vertically or horizontally. Step plot is most useful for 
displaying histograms and similar plots, but since it displays data much as it appears 
to a digital processor (like the MP), it can also be useful for examining the effects of 
various sampling rates.  

NOTE: Step plot is mutually exclusive of line plot. 

Toolbar  Displays the toolbar (shortcut) icons across the top of the display (see page 155). 

X/Y 
 

Activates the X/Y display mode (see page 139). 
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Customize Toolbars 

 

Use this feature to create custom toolbars for easy access to post-processing Analysis and Transform actions. Toolbars 
are dockable and custom toolbar placeholders can be named independently of toolbar actions.  

 Actions – Menu list of available Analysis and Transform functions 

 Toolbars – List view of custom toolbar placeholders 

Current Toolbar Actions – List view of available actions from Analysis and Transform menu 

Button Function Explanation 

 
Add toolbar button Adds placeholder for new toolbar. (More than one toolbar action can 

be grouped under one placeholder). 

 
Remove toolbar button Removes placeholder for toolbar. 

 Rename toolbar button Allows existing custom toolbar name to be edited. 

 
Up arrow Moves a toolbar action up the list. 

 
Left arrow Removes a toolbar action from the list. 

 
Right arrow Adds a toolbar action to the list. 

 
Down arrow Moves a toolbar action down the list. 

 
Clear button Removes all toolbars from Toolbars and Current Toolbar actions list. 

 
OK button Enforces addition or removal of toolbars from list or application 

toolbar region. 

 
Apply button Applies changes without closing Customize Toolbar window. 

 
Cancel button Dismisses any toolbar changes without applying. 
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Spectrum Analyzer Palette 

 

 

Spectrum Analyzer breaks time domain signals into their respective frequency components to provide a dynamic 
display of the frequency decomposition of data, in real time or post-acquisition. Spectra can be generated in real time 
based on the most recently acquired data or post-acquisition based on the selected area of a saved data file. 

 Spectrum analyzers can be useful for locating and correcting noise sources in a system as well as other 
frequency domain analysis. 

 The spectrum analyzer displays the FFT of a portion of data of a single channel; FFT is preferable over Power 
Spectral Density as the averaged periodogram approach used by PSD is effective only over larger portions of 
data. 

 Other off-line spectral analysis tools include the FFT and Power Spectral Density transformations. 

The spectrum analyzer applies to all graph windows displaying data in the time domain. Viewing the underlying time 
domain data at the same time as the spectral information also provides useful visual feedback with regards to signal 
quality. The palette allows for continuous availability of the spectrum analyzer across multiple graphs and for 
positioning alongside original data. The channel is always indicated by the popup menu within the spectrum analyzer 
itself. The graph whose data is analyzed will always be the topmost graph; this is the graph whose window is highest 
in the Z ordering. 

Mode: 

 Real-time Analyzes the most recently acquired data in a graph. The analyzer generates full FFT output so, in 
linear units, it is the regular FFT multiplied by two. The analyzer extracts the spectrum based on a 
sliding window of samples at the tail end of the signal and periodically refreshes the spectrum plot 
during acquisition. The analyzer uses a fixed width window size. The first spectrum will be generated 
after the number of samples needed to fill the initial window has been acquired. If no data is being 
acquired, the analyzer will not display any frequency information and will appear to be off. 

 Selection Analyzes the highlighted section of the active channel of a saved graph (post-acquisition). 
Measurements derived from data on the selected area are useful tools for quickly comparing different 
portions of data. Choose a specific channel to analyze or “SC” to use the current active channel. 
Window size does not need to be specified for this mode; the closest power of two above the number 
of samples in the selected area will be used and padding will be applied in the method specified. 

Palette popup  (upper right) Displays the spectrum analyzer palette popup menu for 
performing other operations on the spectrum including extracting the 
spectrum to a new graph window and copying spectrum data to the 
clipboard or journal. Options are dimmed if there is no spectrum 
available. 

New … New Graph with Spectrum constructs a new graph window 
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with the contents of the spectrum. This allows for more detailed examination of the 
spectrum than is possible with the tools in the spectrum analyzer palette. 

Paste… Paste Spectrum to Journal makes a textual representation using the current Journal 
preferences and copies the text into the graph journal of the graph whose data is being 
analyzed. This will prompt to create a journal if none exists.  

Copy… Copy Spectrum to Clipboard makes a textual representation using the current Journal 
preferences and copies the text to the Clipboard. 

Settings… Displays the spectrum analyzer settings dialog. Equivalent to using the Settings button at 
the bottom of the palette; see Settings below for details. 

Channel Indicates which channel of the hardware setup or graph is being analyzed. The “Channel” popup 
menu contents vary with the analyzer mode: 

 Real-time Channel popup menu lists active channels whose “Acquire” checkboxes are checked in MP150 > Set 
Up Channels. The channels will be listed as “{A,D,C}{0-16}, chan_title” where chan_title is 
replaced with the manually entered title in the channel setup window. 

 Selected The channel popup menu matches the channel menu of measurements in the topmost graph window. 
The menu starts with “SC, Selected Channel” which, when chosen, uses the data of the active channel 
of the graph. The remainder of the menu lists the channel numbers and labels of the channels within 
the topmost graph. 

Plot display Plot of the spectrum of the corresponding data. 

 Vertical axis units match the source channel (displays either “dbV” or linear) 

 Horizontal axis displays frequency and is always displayed in “Hz.”  

 If there is a valid data selection that can be used to compute a spectrum, the spectrum will be 
displayed in this area. If there is no valid data selection, no axes will be displayed and the plot will be 
replaced with the text “Not Available”. The following conditions cause spectra to be unavailable: 

 graphs that contain no data (either no channels or only empty channels) 

 graph is being displayed in XY mode 

 graph uses either frequency or arbitrary units for its horizontal axis 

When operating in selected area mode, the following additional conditions also cause spectra to be 
unavailable: 

 selection contains no data on the active waveform 

 selection is a single-point selection (not enough data to compute FFT) 

When operating in real-time mode, the following additional conditions also cause spectra to be 
unavailable: 

 no data acquisition is in progress 

Auto Vert Click to autoscale the spectrum to fit all amplitudes within the visible spectrum plotting area. 

Auto Horiz Click to autoscale the spectrum to fit all frequencies within the visible spectrum plotting area. 

Settings 
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 Plot color Colorwell that changes the color used to draw the spectrum in the palette. Click to display a standard 
color picker. 

Window Width specifies the window size used when performing analyses in real-time mode. The spectrum 
will always reflect the frequency characteristics of the most recently acquired data of the graph, using 
this window size as the number of sample points to use. This popup will list various powers of two as 
well as a “Custom...” entry. If a custom width is entered that is not a power of two, padding will be 
applied during real-time operation according to the FFT Options. 

  
 FFT Options 

 Padding—used whenever the number of input points is not an exact power of two. Data can be 
padded either with zero or with the amplitude of the last data point. 

 Remove mean—Subtracts the mean value of the data is prior to frequency analysis. This helps 
remove the zero frequency component caused by DC offset. 

 Remove trend—Connects the endpoints of the data with a line and removes this linear trend from the 
data prior to frequency analysis. This can help compensate for drifting baselines. 

 Units—control whether the data is displayed using a logarithmic scale or a linear scale. 

 Window—enables the standard AcqKnowledge windowing options, to adjust the data to remove 
effects resulting from the discontinuities of data at the two edges. 

Value Click the crosshair icon  to display the frequency and amplitude values of the spectrum when 
moved within the spectrum display. The mouse cursor will change to a crosshair when inside the 
spectrum plot. The frequency and amplitude values corresponding to the mouse position are displayed 
above the spectral plot. Hold the mouse button down to display the amplitude of the spectrum at the 
horizontal mouse position, along with a crosshair cursor highlighting the exact location shown on the 
spectrum. If the active spectrum is compressed (that is, if multiple samples exist for a particular 
horizontal position), the value extracted will be the maximum value displayed at that pixel position. 

Zoom Click the magnifying glass  to perform zoom operations. Click and drag the mouse cursor (which 
will change to a magnifying glass) in the plot display to select the area to zoom in on. Alternately, 
click either of the axes of the spectrum palette to display a dialog used to enter display ranges 
manually. Enter the start and end points of the desired range for each axis. There are no grids in the 
spectrum analyzer palette, so the axis scaling dialogs of graphs are not applicable. Note: adaptive 
scaling will be disabled for the spectrum display when either the zoom tool or the axis endpoint entry 
dialogs are used. 

TIP: To zoom out, hold the Alt key (PC) or Option key (Mac) while clicking mouse 
over zoomed area. 
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Channel Information... 

The Display > Channel Information command generates an information dialog for the selected channel. 

 
Line Freq Files created with AcqKnowledge 4 include the line frequency (50 Hz or 60 Hz); files created in earlier 

versions will list “Unknown.” 

Channel This box displays the channel number, channel label (if any). 

Interval Indicates the acquisition sampling rate. The sampling rate specified reflects the sampling interval 
AcqKnowledge uses to store the data, which is not necessarily the same rate at which it was collected. The 
sampling rate can be modified by using the resample function (described on page 292122222), by changing the 
interval horizontal scale (see page 411 X), or by pasting data collected at one sample rate into a graph 
containing data sampled at a different rate. 

Length Indicates the overall length of the channel in samples per second and time. Generally, the waveform 
length information is the same for all channels, although this is not always the case. To shorten 
waveforms by editing out sections of the waveform (using Edit > Cut and/or Edit > Clear functions). 

Min Provides the minimum value for the waveform data. 

Max Provides the maximum value for the waveform data. 

Mean Provides the mean value for the waveform data. 

The fields below the statistical information contain transformation histories, time/date stamps, parameters, and values 
for selected channels. 

Paste Selected Channel to Journal Pastes transformation modification history for selected channel to Journal. 

Paste All Channels to Journal  Pastes transformation modification history for all channels to Journal. 
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Preferences... 

To generate the Preferences dialog, select Display > Preferences on Windows or AcqKnowledge > Preferences on 
Mac. Use Preferences to control measurement options, how waveforms are displayed, and other AcqKnowledge 
features. Select an option in the list on the left of the Preferences dialog and then set the respective preferences 
displayed on the right. 

See page… 
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426 Not supported in AcqKnoweldge 4.0-4.1 
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Measurements Preferences 

 Measurement rows—determines how many measurement rows should be displayed at the top of the graph 
window. 

o Use Display > Show > Measurements to hide the measurements; see page 14412 for details. 

 Precision—controls the accuracy of digits displayed right of the decimal (1-8) for all visible measurement 
results. For instance, with precision set to 3, one measurement window might show 125.187 while another reads 
0.475. 

 Use linear interpolation—toggle to enable/disable measurement interpolation. 

 Time/Frequency units—sets the measurement unit to use for time and frequency pop-up measurements. This 
locks the units for the measurement result display (i.e., if seconds is selected, a result of 70 seconds will display 
as “70 seconds” rather than “1.16667 minutes”). 
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o Best match—Scales units to best match the interval for time and frequency based on the total file. For 
example, won’t set a 3 hour file to display in msec. 

 Include for Journal/Clipboard options 

 measurement name (i.e., BPM, Delta T, Freq, etc.) with the values. 

 measurement units (i.e., volts, mmHg, and so forth) after the numeric values. 

 Note The first two options cause additional text to be pasted into the journal, 
which can drastically reduce the amount of numeric data that can be pasted into the 
journal due to limitations on the maximum journal size. See page 152 for more 
information on working with Journal files. 

 measurement parameters used to compute the measurement function result, such as the location and 
operator used for Calculate measurements. 

 channel numbers at the top of each column of data. 

 timestamp—Automatically insert the time of day and the date when pasting measurements or wave 
data. This timestamp can be correlated with selection events to reconstruct the selected area.—useful 
for GLP auditing. 

 Use a separate line for each measurement in the journal/clipboard 

 Mark selection with events in graph—Automatically insert a pair of Global Selection Begin and Selection 
End events at the selection boundaries when pasting measurements or wave data. These events will be 
timestamped with the time of day and the date when the paste occurred. This timestamp can be matched to the 
result of “Include timestamp” to recreate selected areas for reconstructing measurement results or re-executing 
wave data exporting—useful for GLP auditing. 

 Journal Table Export Options – Sets the options for how multiple measurement rows are displayed in a 
Journal table. 

o Put all values in a single table row – Extends multiple measurement rows horizontally into one table 
row. 

o Use one table row for each measurement row – Divides the measurements into multiple table rows in 
the same manner shown in the measurement toolbar. 

Waveforms Preferences 

In the center of the dialog are two options that control how waveforms are displayed on the screen. 

 Gray non-selected waves—When enabled, the active wave will be drawn in a solid color and any non-selected 
waveforms will be drawn using lighter, dotted lines (or with lighter colored dots if dot plot is in use). This can 
help emphasize the selected waveform when viewing data in Scope mode. 

 Draft mode for compressed waves—allows for some (“compressed”) waveforms to be plotted in “draft” 
mode, which results in faster plotting time, although the display is not exact. A waveform is considered 
compressed when more than three sample points are plotted per pixel on the screen. For example, on a VGA 
display that is 640 pixels wide, a compressed waveform would be any type of waveform displaying more than 
2000 samples (approximately) on the screen at any one time. Using the default horizontal scale (which plots 
eight seconds of data on the screen), any data sampled at more than 250 samples per second would be 
considered “compressed.” 

 Scaling—These two options handle the way data appears on the screen after it has been transformed (e.g., 
filtered or mathematically operated on). Neither option affects how data appears on the horizontal axis, although 
both options change how data is presented along the amplitude (vertical) axis. 

o Autoscale after transformations will automatically rescale all waveforms after a transformation to 
provide the “best fit” along the amplitude axis. 

o Tile after transformations tiles all visible waveforms after any transformation, and is mutually 
exclusive of the autoscale command. When waveforms are “tiled” they appear to be stacked on top of 
each other. 

 Mark waveform edits with events—Insert an event at points where waveform edit commands have been 
applied. 
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 Include time value—copies the horizontal scale values along with the waveform data when data is copied to 
the clipboard. This means that when you paste data from the AcqKnowledge screen into a spreadsheet or similar 
application, horizontal scale information is retained. 

 Include timestamp—Automatically insert the time of day and the date when pasting measurements or wave 
data. This timestamp can be correlated with selection events to reconstruct the selected area.—useful for GLP 
auditing. 

 Mark selection with events in graph—Automatically inserts a pair of Global Selection Begin and Selection 
End events at the selection boundaries when pasting measurements or wave data. These events will be 
timestamped with the time of day and the date when the paste occurred. This timestamp can be matched to the 
result of “Include timestamp” to recreate selected areas for reconstructing measurement results or re-executing 
wave data exporting—useful for GLP auditing. 

Event Summary Preferences 

For the event summary that can be pasted to the journal, choose a method to group the events (i.e., type or channel), to 
sort the events (by time or label) and indicate whether to include all events or include only visible events in the 
summary. Beginning in AcqKnowledge 4.2, there is an option to include a header row at the top of the summary. 

Access Event (Marker) preferences under MP150 menu > Set Up Events; see page 209 for details. 

Graph Preferences 

 Interpolate pastings instructs AcqKnowledge to interpolate/extrapolate time base information when working 
with data sampled at two different rates. AcqKnowledge will interpolate data to fit the sample rate of the 
destination window. When doing this, you should copy data to a higher resolution window. Although To copy 
data in the other direction (from high resolution to low resolution), it is not recommended since some resolution 
will be lost in the process. 

o For example, if you have one 30-second waveform sampled at 50 samples per second, and another 
30-second waveform sampled at 2,000 samples per second, you can copy the contents of one window 
into another using the insert waveform command, and AcqKnowledge will interpolate one waveform 
so that both appear to be 30 seconds long. In this example, data would be copied from the 50 Hz (low 
resolution) window to the 2,000 Hz (high resolution) window. 

 Maximum levels of undo—Set the maximum number of undo operations. Unlimited may be memory-
intensive, depending on the detail of each operation. 

 Enable cursor tools during acquisition – Allows access to cursor tools while recording is in progress. 

 Axis controls – Controls visibility of set screen vertical axis controls. 

 Chart Track Divider Appearance – Starting with AcqKnowledge 4.1, users may change the color used to 
draw the dividers between channels tracks The Preferences > Graph panel contains "Chart Track Divider 
Appearance" options.  

 Default uses operating system specific dividers, which are 
lighter in color (as in AcqKnowledge 4.0). 

 Custom activates a colorwell, allowing a solid color to be 
specified for all dividers. The preference setting and color are 
shared by all open graphs and data views, as this is an 
application-level preference. 

 Plotting Background Colors – Starting with 
AcqKnowledge 4.2, customizable background colors for 
individual graph channels are available.  

 Normal activates a colorwell for choosing background color of the non-selected channels.  
 Selected channel activates a colorwell for choosing background color of the selected channel. 

 When closing… determines the degree of closing and what prompts, if any, for multiple data views. 
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 Recently Used—set the number of recently used Transform and Analysis options to list in the Transform > 

Recently used sub-menu; provides quick access to common options. Recently used items can also be launched 
using keystroke the combinations appearing in this menu. 

Journal Preferences 

 
The Journal Preferences dialog has options that control the format of data when it is pasted into the journal or 
clipboard. 

 Change font type and size to any font installed on your computer.  

 Wrap Journal text—Wraps text to window size. 

 Tabs: Specify the tab interval to make columns more readable when you have a high precision setting. 

Auto-paste results—Toggle the checkbox to enable/disable the option to paste results to independent journals. 
Display Style— Choose whether Journal window is fixed, dockable on edges of graph, or independently floating. 

Hardware Preferences 

 Always work with No MP hardware connected sets the default communication for no connection so the 
connection error is not displayed each time the software is launched. 

 Ethernet communications protocol is UDP by default; DLC is not supported in AcqKnowledge 4. If you cannot 
establish MP150 unit communication using UDP protocol, check the MP150 unit firmware (see page 1478) and 
then contact BIOPAC for technical support. 

 Line frequency is specified during software installation and can be changed here. Every time data is recorded, the 
line frequency setting is saved along with the data. If no line frequency data was saved, the line frequency setting 
for the installed/active version of AcqKnowledge will be used. 

 Default analog channel display units – Use to set default channel units to volts or millivolts. 

 Volts – displays in Volt units, visible range +/-10V (MP150 default) 

 mV – displays in Millivolt units, visible range +/- 50 mV (MP36 default) 

Performance Preferences  

 Use all available memory instructs AcqKnowledge to attempt to use all the available memory for loading data. 
Otherwise, a variable sized buffer is used to load portions of large data files. This option works best if there is 
enough free memory to load the entire data file. 

 CPU allocation sets the priority for CPU (system resource) allocation. For a data focus, move right, for a 
function focus, move left. 
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 If you are experiencing Buffer Overloads, move toward Better data transfer for high speed acquisition. 
 To allow autoscale during acquisitions or jumping between MPs, resizing displays, or working in other 

programs, move toward More responsive. 

 
Networking Preferences  

Network data transfer and Remote Monitoring are not supported in AcqKnowledge 4.0-4.1. 

Enable networking to allow applications running on other computers attached to the same network to gain access to 
data from AcqKnowledge as it is being acquired. Data is sent to other applications over a network using TCP 
(recommended) or UDP connection during acquisitions. All types of channels may be exported, including analog, 
digital, and calculation channels. AcqKnowledge will continue to function normally while data transfer is in progress, 
displaying the new data in the graph window and performing any autoscrolling.  

Respond to auto-discovery—Toggle the checkbox to enable/disable response during network data transfer. 

The network data transfer feature is not intended for strict real-time delivery. It also does not provide direct control 
over the MP150 unit. Perform all hardware configurations manually using the AcqKnowledge interface.  

Enable Remote Monitoring to allow acquisitions on the computer to be viewed remotely over a network through a 
client/browser interface. Acquisitons can be started and stopped remotely and graph data viewed while recording is in 
progress. This is handy if the AcqKnowledge computer recording the experiment is in one area and the researcher 
monitoring the experiment is in another. 

For applications that require low latencies, high-data throughput, or direct hardware configuration and control, use 
BIOPAC Hardware API.  
 

Other Preferences 

 Show menu tooltips enables display of tooltips describing menu item functions. Tooltips appear when menu 
items are moused over. 

 Create Data Snapshots after acquisitions toggles the snapshot (embedded archive) feature, which stores 
snapshots of original acquired data along with the graph file for easy comparison of results to original 
waveforms or to intermediate stages of analysis; see page 53 for details. 

IMPORTANT: Archive functions do not create a new file—they are not backup functions.  
Original data is copied and pasted to the end of the original file.  
You cannot use this feature to recover lost or damaged original data. 

When this Preference is enabled, a date-stamped archive of the data in the graph will be created each time the 
acquisition is stopped. In Append mode, the entire graph is backed up with each Append, old data as well as the 
newly acquired data. 

This is a memory intensive function; each snapshot that is added to a graph file will increase its size on disk by 
approximately 40%. You will be prompted about memory; click OK to proceed.  

 
 Reset toolbars—Resets toolbar configuration to default setting. 

 Create configuration file— Create default menu configuration file to customize menu display. See page 1474 
for customization details. 

 Maximum number of files in File > Open Recent—Sets the number of files that will appear in the ‘File > 
Open Recent’ list. 
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 When application is launched:—Chooses between display of Startup Wizard or a new empty graph following 
application launch. 

Scroll options 

The Scroll option help you move through large data files. Right-click below 
the horizontal scroll bar to generate the contextual menu with scroll options. 

 
Contextual menu 

Size window... 

The Size Window function allows the setting of exact dimensions 
for the interior size of the graph window. Use this to create 
consistently sized windows for pasting into documents. The two 
text box fields are used to enter interior screen width and height, 
both of which are scaled in terms of pixels. Standard computer 
displays have 72 pixels per inch (28.3 pixels/cm), so a graph 
window that is 360 pixels wide by 216 pixels high would be 
12.7cm tall and 7.6cm wide.  
 

Each operating system may add additional dimensions as necessary to put in window adornments depending on the 
appearance configuration preference of the user (e.g. extra space for title bar of the window, any additional space put 
around the edges of the window frame, etc.). 

When the Reset chart boundaries box is checked, the boundaries between the waveforms will be reset so that each 
channel “track” is the same size.  

When Use as default for new windows is checked, the user-modified dimensions are applied as the default graph 
window size. 

Cursor Style 

 
This option allows the active cursor tool to be adjusted via the Display menu. (AcqKnowledge 4.2 and higher) 

Create Data View 

 
Creates a new Data View for the active (frontmost) graph and names the new window “Data View of ‘Filename’” For 
Data View details, see page 145. 
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Organize Data Snaphots 

Arrange data snapshots (as created via Edit > Create Data Snapshot). 

 

 
 

Show All Data Snaphots 
 

1 
 

2 
 

3 

 1 Manual Archive: description and time 
 2 Original file 

3 Auto-Archive: time only  

To view the embedded snapshot(s)/archive(s) associated with a graph file, choose Display > Show Original Data/All 
Data Snapshots. This will open a new graph window for each archive/snapshot associated with the graph. The time 
portion of the Filename for each graph is from the computer clock (saved with semi-colons because you cannot save a 
file with colons in the filename). The “Snapshot from…” graph will open with no Start button. 

Each embedded archive is essentially a “snapshot” of the original acquired data that is stored with the graph file so 
you can view the archive at a later time to compare results to original waveforms or intermediate stages of analysis. 
Append markers are not preserved in the snapshot/embedded archive file. For details on creating snapshots/embedded 
archives, see page 53. 

 

Load All Data Into Memory 

Use with large files to improve plotting performance, measurement response, etc. Memory can hold up to two 
gigabytes of data. 
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Chapter 19 Program & OS Menus 
AcqKnowledge menu 

 

Mac OS X only—System generated menu. Use for About, Quit, and 
Preferences. 

 

 

Window menu 

The Window menu is a standard OS function. See your Windows or 
Macintosh OS Guide for details. 

 

Bring All to Front 

If other programs are running, this command will bring all AcqKnowledge 
windows to the front (on top of all other application windows); this 
command does not change the windows size or position. 

 

 

Help menu 

 

 
 

Use the User Support System pdf files for online help with the software. 

When About AcqKnowledge is selected from the Help menu, a screen is 
generated that provides information about the AcqKnowledge software 
being used and your system parameters, which can be useful if you need to 
call BIOPAC for any reason. 

 Mac OS X only—About AcqKnowledge is under the AcqKnowledge 
menu. 

Note: For information about the MP150 data acquisition unit and firmware, 
click MP150 menu >MP150 Info. 

Tooltips—Tooltips is an online assistance feature to help novice users learn 
how to use AcqKnowledge. Text is generated to describe the software 
functionality of the item under the mouse. Unavailable items/controls will 
indicate why they are unavailable. 

 Mac: To toggle Tooltips when you pass the cursor over an item, select 
Help > Show Tooltips. 

Tooltips are not available for context sensitive (Ctrl-click) menus due to 
operating system limitations. 
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Click the System Info button for more detailed information. 

 
The Copy to clipboard button makes it easy to paste system info into an 
email for Technical Support. 
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Chapter 20 Media Menu 

     

Available in AcqKnowledge 4.1 and above for Windows—Media functionality allows users to capture and playback 
video and/or audio with a USB web cam or firewire DV device and synchronize it with physiological information 
from an MP device. The key functionality is a strong link between the video and data cursor when graphs are being 
used in post-acquisition mode; changing the selection in the graph window will automatically jump the video to the 
time corresponding to the cursor position. The reverse tie is also in place where erasing the video will move the data 
cursor to the corresponding data point in the graph. 

For synchronized playback of media player with AcqKnowledge cursor in data view, BIOPAC recommends that the 
users sample the MP150 at least as fast as the video frame rate 30Hz. In this case, any measurement errors are limited 
to the basic frame rate error window (1/30 sec). For exact match of Video and Data samples, BIOPAC recommends 
frame rate 25 fps and acquisition rate 25 samples/second (or its derivatives). 

Set Up  Establish Sources, Output and Media parameters. Set device type for audio and or/video. 
Use refresh after connecting a new device to make it a selectable option. Browse using 
standard file open/save functionality to specify media files. If desired, set a Delay between 
file segments. 

Show Capture Viewer Use for video signal directly from a video camera; this option is disabled (grayed) in the 
record mode when both the Capture video and Capture audio options in the Media Setup 
dialog are off. 

 
Show Playback Viewer Use to play back media from the disk (stored media files); this option is disabled (grayed) if 

there is no media assigned to the file. 

 

Show Capture Preview  This Media Toolbar icon toggles the preview window display state (show/hide); this option 
is disabled (grayed) in the record mode when both the Capture video and Capture audio 
options in the Media Setup dialog are off. 
 

Video Playback and Capture preview include a right-mouse contextual menu item “Grab bitmap” which, when 
selected, generates a Save As dialog to save the current displayed frame as a *.bmp image. 

 

Media Notes 

 ::  Media capture performance is improved under Windows 7 or Vista OS. If the selected webcam drops frames 
because of poor performance/low quality, the degree of synchronization will be compromised. Testing 
indicated the Microsoft Lifecam NX-3000 gave reliable performance with no dropped frames. 

 :: Several AcqKnowledge files can point (link) to the one media file.  

 ::  AcqKnowledge files can link to media files created by other programs. If the media file is shorter or longer 
than the AcqKnowledge files, just align the two files at the start. 

 ::  AcqKnowledge files alignment precision with the media file is user-controlled through the use of a delay 
function that allows a forward or backward time shift. 

 ::  AcqKnowledge files store the location (path) of the media file. This path is editable, so the AcqKnowledge 
file can link to other media files too. 

 :: Media functionality does not support the Autosave file acquisition mode. 
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Synchronization Tip 

To optimize synchronized playback of the media and the physiological record, use the OUT103 LED and a digital 
channel to determine the delay between the media and the data. The LED must be in view of the video camera and the 
LED channel must be recorded.  

1) Setup LED Output:  

a. Connect CBL102 to an analog input channel and CBL106. 

b. Connect the other end of CBL106 to a Digital I/O channel and GND D on the rear of the UIM100C; 
additional interface required for the MP36R.  

c. Piggyback the OUT103 with the CBL106 on the rear of the UIM100C.  

d. Use MP150 > Set Up Channels to acquire and plot the Digital I/O channel the LED is connected to. 

e. Set MP150 > Show Manual Control to Output and enable the Set immediately option.  

  

2) Start the acquisition in AcqKnowledge. 

3) Click “0” on the appropriate channel in the Manual Control dialog. 

4) Once the LED has illuminated and you can see the square wave in the file, you can hide the channel. 

5) After the recording is complete, use the I-beam selection tool to measure the offset between the LED 
illumination and the leading edge of the digital impulse. Use a Delta T measurement to determine the delay 
information; Delay may be positive or negative based on camera performance. Delay should be entered in the 
Linked Media row for each segment—see page 433. 
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Media > Set Up 
 
Source  

Use this dialog to select media source and select audio and video to record.  Click Refresh to update the list if a 
video or audio device is connected after the dialog was opened. When video/audio for capture is selected, an 
output file must also be slected.  Input file name and click OK; this will close the Media Setup dialog and 
automatically open the media window if the Capture option is ON.   
All video camera, audio (microphone) input parameters can be setup by user with the UI provided by camera 
manufacturer.  

   
Output 

Video/audio capture requires a media file specified with full name with disk location.  *.avi or *.wmv file formats 
are supported. Users can save AcqKnowledge data and media streams onto separate hard drives. 

Linked Media  

IMPORTANT An AcqKnowledge data file must be opened before linking to a media clip.  

  
If media was captured with the data file, the Linked Media dialog will display a row for each appended 
segment in the AcqKnowledge data file and will list the file location of the corresponding media for each segment. 
The samples above show four AcqKnowledge data segments and four linked media Files. 

Click anywhere in the row (or choose the Edit button) to set a delay to synchronize the media file with the 
physiological data. Delay range: Min= 1 millisecond, Max = segment duration. 

 See Synchronization Tip on page 432. 

If media was not captured with the data file, click the appropriate row and click “Link” to browse to the 
desired media file from that segment. 

Delay—Eash segment can have a distinct delay. Click in the Delay 
cell or click Edit to generate the dialog for Delay entry. 

“+” Delay places start of video file after graph start 

“-” Delay places start of video file before graph start 

The best possible synchronization can’t be better than the the video frame rate (usually1/30 of a second).  
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Media > Capture 

Use Set Up to assign a Source and Output to enable the Capture menu option. There are no Preview window 
controls and the size reflects default video camera resolution. 

Playback Preview 
As the media file is manually scrolled or automatically played, the AcqKnowledge cursor keeps moving to reflect 
the corresponding location in the AcqKnowledge graph. If the AcqKnowledge cursor is moved, the media file is 
automatically scrolled to keep time sync with the data file.   
In AcqKnowledge 4.2 and above: Media files linked to appended data segments are loaded in sequential order. 
After playback of the first media segment, the cursor will automatically advance to a still-frame view marking the 
beginning of the next segment. The Play button must be pressed in order to play back subsequent segments.  

Audio Mute button and level slider 

Video Digital indicator (time in milliseconds or frame number for the segment clip) and Horizontal slider 
(progress bar) to navigate the media file. The start point can be set from either the media clip or the data 
file. For precise selection, hold the shift key and use the forward or backward arrow keys on the media 
player or the keyboard to move single video frame (mostly 1/30 seconds) or data point.   

 Use the scroll bar to navigate to different frames.  Synchronization should be maintained with data in the graph 
window.  This should result in a single sample selection cursor shown at the time closest to the displayed video 
frame.   

The media window displays the text “No media assigned” in Playback Preview when the media window is visible 
but there is no video/audio file assignment for given data segment.  

During the capture or playback of audio only, the media window will be displayed with a static 
musical note image as shown at right. 

The Playback viewer uses standard media player controls. 

 
Go to previous segment / go to beginning of 
segment 

 
Step backward a frame/sample 

 
Fast backward / reverse rewind 

  
Play/ pause 

 
Fast forward 

 
Step forward a frame/sample 

 
Go to following segment 

 
Mute sound 
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Media Playback Example 

1. Launch AcqKnowledge 4.1 
2. Open a saved acquisition file.  

 

 
3. Select Media > Show Playback Viewer. 
4. Here you can play with contents: 
 Select I-beam cursor on graph and push 

“Play” button on the player.  
 Change selection with I-beam on graph 

and see the video. 
 

 
IF media is not assigned, locate the video clip 
for the appropriate segment: 

a.)  Select Media > Set Up 
b.)  Select the “Linked Media” tab  
c.)  Select Segment 1 and click “Edit. 
d.)  Click “Link” and select a saved media 

file. 
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Chapter 21 Licensed Functionality: Network Data Transfer 
Network Data Transfer (NDT) functionality is available through an optional license available 
with AcqKnowledge 4.1.1 or above.The license must be authorized to access NDT 
functionality. To add an NDT license to an existing MP System, please contact BIOPAC. 

Network Data Transfer (NDT) is a real-time data transfer system that allows access to the data 
being acquired into a graph by AcqKnowledge for use in an external application; the 
AcqKnowledge process and the custom application may run on the same computer.  
Make TCP or UDP connections to external applications and stream binary data during acquisitions. 

The NDT license  

 allows Network Data Transfer functionality  

 links the Network Data Transfer Reference under Help 

 includes network data transfer Preferences 

 

Most of the settings for the network data transfer functionality are set by clients through control connections. Several 
settings for the AcqKnowledge server may be set directly in the AcqKnowledge preferences. Versions of 
AcqKnowledge that include network data transfer functionality have an additional "Network" group of settings 
underneath their Preferences. These Preferences are accessed from the Display menu ( Windows 7/Vista) or from the 
AcqKnowledge menu (Mac OS X): 
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NDT is a basic method for allowing third party applications to tap into the data stream being generated by both the 
MP unit and AcqKnowledge during data acquisitions. NDT provides  

 networking facilities that allow for integration into a distributed application environment 

 basic control facilities to allow external applications to query and control the AcqKnowledge application state. 

The NDT system is split into two separate types of connections: data connections and the control connection.  

A. Data connections deliver data from AcqKnowledge to external applications during acquisitions.  

B. Control connections are made from external applications to AcqKnowledge to query application state and 
adjust data connections. 

The server refers to the AcqKnowledge process and the computer on which it is running. The client refers to the 
custom application that is to receive data from AcqKnowledge and the computer on which it is running.  

All connections should be made using standard network protocols, either TCP or UDP. Single system image 
architectures should make connections using the loopback interface. It is assumed that network implementations have 
appropriate IP networks in place with routing between machines that can be identified either by IP address or by 
hostname. Firewalls must be properly configured to allow network communications between the client and server. 
Appropriate network configuration is the user’s responsibility. 

 

Data Connections 

Data connections are used to deliver data from the AcqKnowledge server to the client application. Data connections 
stream both data acquired from an MP unit and computed data from AcqKnowledge calculation channels. Data 
connections are available in a variety of formats and can be configured to meet the needs of the client application and 
bandwidth requirements. 

Data connections are created only at the start of acquisitions. It is not possible to “attach” to data acquisitions that are 
already in progress. 

XML-RPC calls for retrieving data are also described in this section. These connections are not persistent and not 
established from server to client, but rather a request made from client to server. The recommended mode of operation 
is regular TCP or UDP operation. 

 

Variable Sampling Rates 

AcqKnowledge uses variable sampling rates that allow different channels of data to be acquired at different sample 
rates. This allows fast moving signals (such as EMG) to be acquired at high sampling rates while simultaneously 
recording slow moving signals (such as respiration) at lower sampling rates. The primary use of variable sampling 
rate is to optimize storage requirements by minimizing space spent retaining slow moving data. 

In addition to the storage optimizations, variable sampling rates are also used to optimize data connections. Channels 
that are sampled at lower rates require less network bandwidth to transfer from client to server. If channels of data 
cannot be disabled and overall bandwidth is limited, variable sampling rate can be used to lower the bandwidth 
required to move data between the server and the client. 

The use of variable sampling rates requires the client to be aware of downsampled channels and handle data 
accordingly. Variable sampling rate may also affect the interpretation of the incoming data connection stream, as 
indicated below. 

Transfer Types 

Clients may choose between two different transfer types:  

 single connection uses one data connection between the server and the client to deliver all data 

 multiple connection uses multiple data connections delivering data simultaneously 
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Single Connection 

The single connection transfer type uses a solitary connection between the server and the client to deliver data. When 
multiple channels of data are being delivered, all data is sent over the single connection in an interleaved format. The 
interleaved format mingles the data of all channels in order. For example, an interleaved representation of two 
samples from three channels of data would be: C1 C2 C3 C1 C2 C3. This is equivalent to two sample frames where a 
frame contains the data at a particular sample location for all of the channels, in this case “C1 C2 C3”. Frames are 
delivered sequentially over the data connection. 

The single connection transfer type allows for all data to be processed from a single location and uses only one 
network connection resource. Single connection transfer has drawbacks including the need for the client to demux the 
data stream as well as account for variable sampling rates. 

Variable Sample Rate Considerations 

When variable sampling rate is being used, the single connection transfer type has the characteristic where not 
all frames have the same size. If a frame occurs at a sample position where a channel is not being sampled, 
that channel will not be included in the frame. 

All downsampling within the AcqKnowledge variable sampling rate environment occurs at integer divisions 
of the base sampling rate. Only frames with indexes (zero-based) that are evenly divisible by the 
downsampling divider will contain data for that channel. 

It is the responsibility of the client to compute and retain the frame index and to properly check 
channel dividers against the frame index to determine which channels are represented in that 
frame. 

Frame 0 always contains a data point from every channel. 

For example, consider a three channel acquisition. Channels 1 and 3 have a downsampling divider of 1, that 
is, they are being acquired at full speed. Channel 2 has a downsampling divider of 2, that is, channel 2 is 
being acquired at half speed. The first five frames of data in the single connnection transfer type will appear 
as follows: 

C1 C2 C3 | C1 C3 | C1 C2 C3 | C1 C3 | C1 C2 C3 

Note how frames 1 and 3 are shorter as they occur at positions where channel two is not defined. 

If variable sampling rate is being used, clients are required to perform proper frame indexing in order to 
demux the interleaved data stream. If clients cannot handle variable sampling rate correctly and are using the 
single stream transfer type, clients should check all of the downsampling dividers using the control 
connection to AcqKnowledge and warn the user if the configuration cannot be supported with that client. 

Multiple Connection 

The multiple connection transfer type uses a single connection from server to client for each channel of data that is 
being delivered. Using multiple connections offers the benefit of avoiding the client having the need to demux all of 
the data from each sample. If the client is operating in a high-load environment, the elimination of the demuxing may 
be useful in reducing processor overhead. It also allows client code to be simpler if variable sampling rate is being 
used. 

The primary disadvantages of using the multiple connection transfer type are the usage of more network ports and the 
client assuming responsibility for synchronization of data across multiple channels. The data immediately available on 
one network connection may not be guaranteed to be the identical sample index of data being received for another 
channel. The client must keep track of sample index on an individual channel basis to properly synchronize data 
across multiple channels. 

Variable Sampling Rate Considerations 

Using variable sampling rate in a multiple connection transfer type is significantly easier. Each individual 
channel's connection delivers data at that channel's sampling rate. On a given connection, all samples have an 
identical length. 
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Clients still must be aware of variable sampling rates. The sampling rate of information on a downsampled 
channel connection is different than the sampling rate of information on an upsampled channel connection. If 
the client is performing any time domain measurements or other computations involving the sample interval, 
the difference in inter-sample-interval must still be taken into account. 

XML-RPC 

The XML-RPC transfer type allows clients to explicitly request data from the server. Instead of data being 
automatically pushed to clients, the client must post an XML-RPC function call to the server. This allows the 
client to query the server for the most recently acquired data sample value for a particular channel. Clients 
that do not require continual data streams or interact with only slow moving data may wish to use this method 
communication method. This method returns values only; no information about sample indexes or lengths is 
returned. 

XML-RPC has significant overhead for both client and server, so this transport method cannot handle more 
than a few requests per second. If faster response time is required, the client should implement either the 
single connection or multiple connection streaming methods. 

XML-RPC is not a true data connection as it does not involve the server constructing a streaming connection 
to the client. 

 

Transport Protocol 

Data connections offer a choice of using either TCP or UDP as the transport protocol for delivering data to the client. 
Choice of protocol depends on application requirements. When a client is receiving data, it is assumed that all data 
connections are using the same transport protocol. 

TCP/IP 

TCP is the preferred transport protocol. As TCP guarantees reliable, ordered delivery, all data is simply transferred 
from the server to the client without any additional information. Data is streamed continuously as it becomes 
available. TCP is recommended for all clients that require a guarantee of receiving all information. It is also 
recommended for any configuration using up to two computers. The port number used for data connections is 
specified by the client using the control connection prior to the start of acquisition. Once a client passes along port 
information, the client should begin listening for connections on that port. 

When using TCP data connections, the start of acquisition is signaled to clients by the establishment of a connection 
on an appropriate port to the client. The end of an acquisition is signaled by the termination of the connection. 

UDP 

UDP is a connectionless protocol that does not guarantee either delivery or properly ordered reception of packets by 
clients. Data connection is allowed to be switched to UDP delivery mode. The primary benefit of using UDP 
datagrams is that a single data stream can be multicast to a number of computers. Multicasting is not offered 
implicitly by the AcqKnowledge data connection protocol but can be achieved implicitly by requesting a data 
connection be bound to a broadcast address. 

UDP delivery used fixed size datagrams. The default size is 512 bytes. Clients can modify this size to any fixed 
number of bytes prior to the start of acquisitions. The UDP packet size is stored in the template and is different for 
each graph. UDP clients that require a specific packet size should set that packet size prior to the start of each 
acquisition. 
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Each datagram will contain the following: 

Field Data Type Offset Description 

Starting sample 
index 

unsigned long 
(four bytes, 
network order) 

0 byte This indicates the starting sample position of the first sample of data 
contained in the packet. This number is always monotonically 
increasing and can be used to reassemble datagrams that are received 
out of order. 

This field is always stored in network order. Usage of htonl()/ntohl() 
should convert from network order into host endian. 

Length of data 
section in bytes 

unsigned long 

(four bytes, 
network order) 

4 bytes Total number of bytes in the data section. Data is sent by 
AcqKnowledge as it is available, so not all data packets will contain 
the same amount of data. 

This field is always stored in network order. Usage of htonl()/ntohl() 
should convert from network order into host endian. 

Data section (type and 
endian specified 
by client) 

8 bytes Data section containing the binary data that was acquired. The data is 
converted into the appropriate data as configured by the client. 

All of the data delivery is performed as data is available from the MP unit. The actual size of the data section in 
packets that get delivered to the client is dependent on the speed of data acquisition and other activity on the host 
computer. If variable sampling rates are being used, frames will not be split up. All of the data for the final frame is 
contained in the UDP packet. If a frame will not fit in the amount of space in a packet, it is sent in the next packet. 

There are no provisions for clients to request retransmissions of packets from the server. Clients should be aware that 
data may not be delivered when using UDP and should be prepared to examine sample indexes at the beginning of 
each packet and handle missing data accordingly (padding, warning user, etc.). 

The port on which datagrams is delivered is specified by the client prior to the beginning of acquisition on the control 
connection. Once the client specifies its port, it should begin listening for datagrams delivered to that port. The start of 
acquisition is signaled by the first datagram that is sent to that port. The sample index of the first datagram 
corresponds to the first hardware sample of data acquired by AcqKnowledge. If the graph is initially empty, the index 
is zero. 

Unlike TCP connections which get explicitly disconnected at the end of acquisitions, there is no direct messaging for 
UDP delivery indicating the end of acquisitions. Datagrams will not be sent to the client after the end of acquisition. 
Clients requiring explicit termination notification should either use TCP or implement a timeout mechanism combined 
with an XML-RPC getAcquisitionInProgress call on the control connection to locate the end of acquisitions. 

XML-RPC 

The XML-RPC “get most recent data sample” call will use standard XML-RPC connection semantics involving the 
client making an HTTP POST request to the server and interpreting the response as appropriate. Handling of XML-
RPC can be performed by a library in the client's appropriate implementation language. 

 

Real-time Delivery Guarantees 

No delivery time guarantees exist for any data connection. Data is delivered to the client as it becomes available. The 
overall latency of the system from physical sample time to data delivery is dependent on  a number of factors 
including network load, AcqKnowledge overhead (which is variable due to calculation channel processing time, user 
interface activity, thread scheduling, and other operations), system load, and other factors. The actual sampled data 
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itself is guaranteed to be accurate; the sample time of a signal acquired into the MP unit is always accurate. It is only 
the time between the physical time corresponding to a sample and its delivery to the client application that is variable. 

Clients that require strict real time guarantees or more predictable latencies should investigate using the hardware API 
on their local machine. 

 

Data Formats 

It is assumed that the data transfer feature is used in a mixed host environment, potentially with clients running in 
environments that have restricted data types. The sampled information delivered by a data connection is allowed to be 
controlled to appear in a variety of different formats for the client: 

 64 bit floating point – This format will always be available for all channels and may be delivered in either big 
endian byte order or little endian byte order. This is equivalent to a C style double data type. 

 32 bit floating point – This format will always be available for all channels and may be delivered in either big 
endian byte order or little endian byte order. This data type is not native to AcqKnowledge, so the precision of 
received data may differ from data as recorded by AcqKnowledge. This is equivalent to a C style float data 
type. 

 Signed 16 bit integer – This format is available only for analog data channels. It may be delivered in either big 
endian byte order or little endian byte order. This is equivalent to a C style short data type. Clients receiving 
data in 16 bit integer format should use the control connection to determine appropriate floating point scaling 
factors that need to be applied to the data to convert into actual units. 

Data formats should be specified by the client prior to the start of acquisition. If left unspecified, the default data 
format depends on channel type: 

Channel Type Default Data Type 

Analog 16 bit signed integer, little endian 

Digital 16 bit signed integer, little endian 

Calculation 64 bit floating point, little endian 

XML-RPC get most recent sample requests will always return the double type of XML-RPC (in ASCII notation). 

 

Default Data Connection Settings 

If the client does not modify any data connection settings, the following is used: 

 Single connection transfer type 

 TCP/IP transport protocol 

 Port 15020 for single connection 

 For multiple connections, each channel type (16 channels per type) is set as follows: analog channels [15020-
15035], digital channels [15040-15055], calculation channels [15060-15075]. 

 Default data formats for each channel type as indicated in the “Data Formats” section 

Note that no channels are enabled for delivery by default. Both data connection delivery and get most recent sample 
tracking are disabled. Clients will still need to enable channels in order to receive data. 
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Locating AcqKnowledge Servers 

It is possible that clients and servers may be located on networks with dynamic IP addresses or other features that 
make establishing the connection between machines difficult. In this case, a simple UDP broadcast mechanism can be 
used to locate known servers. 

AcqKnowledge will listen for incoming UDP packets on port 15012. If the UDP packet contains the sequence of 
ASCII characters “AcqP Client” and only that sequence, it will send a broadcast packet containing “AcqP Server 
Port:” followed by the port number on which the server is listening for control connections. The port number is 
expressed in base 10 ASCII notation. 

It is possible to configure AcqKnowledge to not acknowledge discovery requests for security purposes. 

 

Control Connections 

Clients connect to an AcqKnowledge server using control connections. A control connection allows the client process 
to control how data is going to be delivered to it, query settings, modify settings, and perform other basic operations 
without requiring graphical interaction with the AcqKnowledge environment. 

On the start of an acquisition, all data connections are established to the client that most recently established a control 
connection unless the client has modified the destination by using the  changeDataConnectionHostname command. 

It is possible to configure AcqKnowledge to not respond to any control connections for security purposes. 

The majority of all control connections use XML-RPC. The XML-RPC specification can be located at 
http://www.xmlrpc.com/spec. XML-RPC consists of an HTTP POST request being assembled by the client along 
with data content expressed in the XML-RPC notation. The remote procedure call will then return with an appropriate 
response to the caller. By design, XML-RPC is client and platform agnostic. 

XML-RPC implementations exist for a number of languages. If there is no implementation in the client's language, 
hardcoded requests can be embedded or a small helper application or shared library can assist in providing the control 
connection interface. 

The URI that should be used when connecting to the server is the recommended “/RPC2” for XML-RPC. For 
example, a URL for localhost control connections would be “http://localhost/RPC2”. 

 

TCP Port 

Only one control connection may be opened by a client to a server at a time. The server will listen on port 15010 by 
default. As this port may conflict with other network services or may need to be modified for firewall accessibility, 
AcqKnowledge will allow the server port to be modified by the user in the Display > Preferences panel. Clients should 
be aware that control connection port numbers are not fixed and should either allow users to change the port number 
from the client or use the dynamic discovery mechanism for locating AcqKnowledge servers. 

 

http://www.xmlrpc.com/spec�
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Control Procedure Calls 

Control procedure calls are remote procedure calls with a set method name and response. All method names and 
strings are case sensitive. The available control calls are roughly split up into querying acquisition parameters, 
configuring data delivery, and limited calls for modifying acquisition parameters and affecting application state. 

Channel Index Parameter Structures 

Some procedure calls take a channel index structure as a parameter. This is an XML-RPC structure that consists of 
the channel type and index. The channel type is a string member named “type” that is one of the following strings: 
analog, digital, calc. The channel index is an integer member named “index” and contains a zero-based index 
indicating the channel. For example, the following channel index parameter structure can be used to refer to calc 
channel 2 (recall, in AcqKnowledge calc channels are indexed from zero): 

<struct> 
 <member> 
  <name>type</name> 
  <value><string>calc</string></value> 
 </member> 
 <member> 
  <name>index</name> 
  <value><int>2</int></value> 
 </member> 
</struct> 

 

Querying Acquisition Parameters 

The calls for querying acquisition parameters are intended to allow clients to request information required for them to 
fill out appropriate parameters and to verify that previous control requests have been properly applied. The following 
control calls are recognized: 

getMPUnitType 

Method name: acq.getMPUnitType 
Parameters: None 
Return value: int 

 Retrieves the type of MP unit to which the server is connected. This may be zero (indicating no unit is 
connected, e.g. “No Hardware” mode), 150 (for MP150), or 36 (for MP36R). 

 The client can use this value to decide between appropriate templates to download or other channel settings. 

getEnabledChannels 

Method name: acq.getEnabledChannels 
Parameters: string 
Return value: array populated with int 

 Retrieves the channels that are available for acquisition and data delivery over a data connection to the client. 
The type of channels that are to be returned are specified in the string parameter. The string parameter may be one of 
the following: analog, digital, calc. The type must be lowercase. “analog” returns information about analog channels, 
“digital” digital channels, “calc” calculation channels. 

 The enabled channels are returned as an array of channel indexes, zero-based. These are the indexes that can 
be validly used in calls for configuring data connection parameters. 

getChannelScaling 

Method name: acq.getChannelScaling 
Parameters: channel index parameter structure 
Return value: struct containing scaling 
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 For channels that can be delivered in short integer format, the channel scaling provides the scale factor and 
offset used to convert the short into physical units using the formula: sample*scale+offset. The scaling is returned as a 
structure containing two double-valued members: “scale” contains the multiplication factor, “offset” contains the 
offset factor. 

 Channels that cannot be delivered as short integers cannot be scaled. If this method is called with an invalid 
type of channel, a fault response is returned. 

getSamplingRate 

Method name: acq.getSamplingRate 
Parameters: None 
Return value: double 

 Returns the current sampling rate expressed in Hz. This is the rate at which data is sampled for a channel 
whose downsampling divider is 1. 

getDownsamplingDivider 

Method name: acq.getDownsamplingDivider 
Parameters: channel index parameter structure 
Return value: int 

 Retrieves the downsampling divider for a particular channel. A channel is sampled at the base sampling rate 
divided by this factor. This factor is also used to determine which frames contain samples for this channel. 

 

Data Connection Configuration Commands 

While it is possible to configure data connection parameters using AcqKnowledge, frequently clients may need to 
alter data connection configurations based upon dynamic information regarding the machine on which they are 
running (e.g. port collisions with other services, unexpected endian changes, etc.). The following commands may be 
used to configure how data is delivered to the application. 

getDataConnectionMethod 

Method name: acq.getDataConnectionMethod 
Parameters: none 
Return value: string 

 Returns the method currently being used for data connections between the server and client. The string value 
is either: single, multiple. “single” corresponds to a single data connection being made between the server and the 
client with all data interleaved over that connection. “multiple” corresponds to opening an individual connection to 
the client for each channel. 

changeDataConnectionMethod 

Method name: acq.changeDataConnectionMethod 
Parameters: string 
Return value: 0 on success, or fault code 

 Changes the method used to deliver data to the client. The parameter is a string that is one of the following: 
single, multiple. “single” opens up a single data connection and sends data in an interleaved fashion. “multiple” opens 
up an individual data connection for each channel. 

getDataConnectionHostname 

Method name: acq.getDataConnectionHostname 
Parameters: none 
Return value: string 
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 Returns the currently set hostname for data connections. When data connections are established on the start of 
acquisition, the IP address associated with this hostname is sent the data. Hostnames must properly resolve in order 
for data connections to be made; DNS configuration is outside of the scope of the network data transfer feature. 

 If this hostname is empty, data connections is made to the most recently connected client application. This is 
the default setting. 

 Hostnames are unique on a graph by graph basis and are saved in templates and graph files. Clients 
redirecting data to another machine should check and set the data connection hostname as appropriate prior to the start 
of acquisition. 

changeDataConnectionHostname 

Method name: acq.changeDataConnectionHostname 
Parameters: string 
Return value: 0 on success, fault on error 

 Changes the destination machine for data connections, the recipient of the network delivered data. If the 
parameter is an empty string, data connections will automatically be made to the most recently connected client. The 
empty setting is the default. 

 If non-numeric hostnames are specified as parameters, they must be resolvable. If a hostname cannot be 
resolved, a fault is returned. Proper DNS configuration of the server is beyond the scope of the network data transfer 
feature. 

getTransportType 

Method name: acq.getTransportType 
Parameters: None 
Return value: string 

 Retrieves the transport type that is being used to deliver data from the server to the client. The transport type 
is a string that is one of the following: tcp, udp. Note that the XML-RPC data delivery method may be used in 
addition to this transport type if channels are enabled. 

changeTransportType 

Method name: acq.changeTransportType 
Parameters: string 
Return value: 0 if successful, else fault code 

 Change the transport type that is used to deliver data from the server to the client. The transport type is a 
string that has one of the following values: tcp, udp. XML-RPC last value data delivery may be used in addition to 
this type provided channels are enabled properly. 

getUDPPacketSize 

Method name: acq.getUDPPacketSize 
Parameters: None 
Return value: int 

 Returns the current size in bytes of UDP packets that is delivered to clients. Datagrams are always this fixed 
byte length although each individual datagram may contain varying amounts of data. 

setUDPPacketSize 

Method name: acq.setUDPPacketSize 
Parameters: int 
Return value: 0 on success, fault on error 

 Changes the size in bytes of UDP packets that are delivered to clients. Each individual datagram will always 
be this fixed length although the amount of data sent in specific packets may vary. 
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getUDPBroadcastEnabled 

Method name: acq.getUDPBroadcastEnabled 
Parameters: None 
Return value: boolean 

 Determine if UDP packets are sent only to the client or are broadcast to the broadcast IP of the network. 
Broadcasting is supported only when the transport type is UDP. 

changeUDPBroadcastEnabled 

Method name: acq.changeUDPBroadcastEnabled 
Parameters: boolean 
Return value: 0 if successful, fault code on error 

 Modify whether UDP packets are sent only to the client or are broadcast to the broadcast IP of the network. 
Broadcasting is supported only when the transport type is UDP. 

getSingleConnectionModePort 

Method name: acq.getSingleConnectionModePort 
Parameters: None 
Return value: integer 

 Returns the port number on which the server will connect to the client to deliver data. This port is used only 
when the connection mode is set to “single” which interleaves all data over a single connection. 

changeSingleConnectionModePort 

Method name: acq.changeSingleConnectionModePort 
Parameters: integer 
Return value: 0 on success, else fault code 

 Modifies the port on which the server connects to the client to deliver data. This port is used only when the 
connection mode is set to “single” which interleaves all data over a single connection. 

getDataDeliveryEnabled 

Method name: acq.getDataDeliveryEnabled 
Parameters: channel index parameter structure 
Return value: boolean 

 Query whether a channel is enabled for data delivery. Channels must be enabled for data delivery in order for 
their data to be delivered to the client. Not all channels that are being acquired are required to be delivered to data 
delivery. 

changeDataDeliveryEnabled 

Method name: acq.changeDataDeliveryEnabled 
Parameters: channel index parameter structure, boolean 
Return value: 0 for success, else fault code 

 Change whether or not data delivery is enabled for a particular channel. Data delivery can only be changed 
prior to the start of an acquisition. Changes to data delivery enabling are only applied on the next start of acquisition. 

getMostRecentSampleValueDeliveryEnabled 

Method name: acq.getMostRecentSampleDeliveryValueEnabled 
Parameters: channel index parameter structure 
Return value: boolean 

 Query whether a channel is enabled for most recent data sample requests. If a client wishes to use the XML-
RPC calls to fetch the most recent value of data acquired of a channel, the channel must be enabled for this 
functionality prior to the start of acquisition. 
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changeMostRecentSampleValueDeliveryEnabled 

Method name: acq.changeMostRecentSampleDeliveryValueEnabled 
Parameters: channel index parameter structure, boolean 
Return value: 0 for success, else falut code 

 Change whether or not a channel is enabled for most recent data sample requests. When a channel is enabled, 
XML-RPC calls can be used during an acquisition to return the most recent sample of data acquired (or computed) for 
the channel. Any changes to the enabled state of a channel is applied on the start of the next acquisition. If a client 
wishes to use XML-RPC calls to read the value of a channel, that channel must be enabled prior to the start of the 
acquisition. 

getDataConnectionPort 

Method name: acq.getDataConnectionPort 
Parameters: channel index parameter structure 
Return value: int 

 Retrieves the port on which the the server will deliver the data for the channel specified in the parameters to 
the client. Per-channel data connections are only used if the data connection method is set to “Multiple”. 

changeDataConnectionPort 

Method name: acq.changeDataConnectionPort 
Parameters: channel index parameter structure, integer 
Return value: 0 for success, else fault code 

 Changes the port on which the individual connection is made by the server to the client to deliver the data for 
the channel specified in the parameters. This style of connection is used only if the data connection method is set to 
“Multiple”. 

getDataType 

Method name: acq.getDataType 
Parameters: channel index parameter structure 
Return value: structure 

 Returns the data type that is being used in the binary data streams for the channel's data. The return value is a 
structure with a type and endian member. The type member, named “type”, is a string and contains one of the 
following values: short, double, float. These strings correspond to their matching C-style data types. The endian 
member, named “endian”, is a string and contains one of the following values: little, big. “little” corresponds to little 
endian byte order, big endian bit order. “big” corresponds to big endian byte order, big endian bit order. 

changeDataType 

Method name: acq.changeDataType 
Parameters: channel index parameter structure, type structure 
Return value: 0 on success, or fault code 

 Changes the data type that is used for binary data streams of the channel's data. The type structure is a struct 
containing two members. The “type” member is one of the following strings: double, float, short. Each string 
corresponds to the matching C-style data type. The “endian” member is one of the following strings: little, big. Each 
corresponds to the matching byte endian. Bit order within a byte will always be big-endian. 

 Not all channels may be able to support all data types. If the channel cannot be transmitted in the requested 
data type, a fault code is returned. 

setDataConnectionTimeoutSec 

Method Name: acq.setDataConnectionTimeoutSec 
Parameters: integer of new timeout in seconds 
Return value: 0 on success, or fault code 



448 AcqKnowledge Software Guide 

Visit the online support center at www.biopac.com 

 Changes the timeout in seconds after which the data connections is closed when acquisitions complete. 
Clients may need to set this keep-alive timeout in order to receive the trailing data at the end of acquisitions. The 
default value is “0” seconds which terminates all data delivery connections immediately when the final sample of data 
is acquired. 

 

Reading Data During Acquisition 

Normally data is delivered to clients during acquisitions using data connections. Data connections are either TCP or 
UDP connections established from the server to the client over which the server streams the incoming data. In some 
languages and environments however, it may not be possible to handle continuous data streams. The following XML-
RPC commands are offered to assist these types of clients. Due to the large overhead of processing connections and 
XML-RPC requests, this data transfer type is not recommended and TCP/UDP should be used wherever possible. 

getMostRecentSampleValue 

Method name: acq.getMostRecentSampleValue 
Parameters: channel index structure 
Return value: double, or fault code 

 This procedure allows clients to read the most recent data value of a specific channel during acquisitions. In 
order for this call to be successful, a data acquisition must be in progress and the channel must be enabled for most 
recent sample value data delivery. Issue a changeMostRecentSampleValueDeliveryEnabled call prior to acquisition to 
allow this procedure to be used. 

getMostRecentSampleValueArray 

Method name: acq.getMostRecentSampleValueArray 
Parameters: none 
Return value: array of structures with channel info and values, or fault code 

 This procedure allows clients to retrieve the most recent data values of all channels during acquisitions in a 
single call. If clients are interested in the values of multiple channels, using this method is more efficient than 
performing consecutive getMostRecentSampleValue calls (which require an individual POST request per call). 

 Only channels that are enabled for most recent sample value data delivery is returned. Issue a 
changeMostRecentSampleValueDeliveryEnabled call for each desired channel prior to acquisition in order for this to 
return the value for a channel. 

 The return value is an array of structures, one per channel. Each structure contains two members. The 
“channel” member will contain a channel index structure with members set to appropriate type and index information 
for the channel. The “value” member is a double that contains the most recent sample value of the channel specified in 
the “channel” member. 

 This procedure cannot be called unless there is an acquisition in progress and there is at least one channel 
enabled for most recent sample value delivery. 

 

Other Control Connection Commands 

Control connections will also allow for the following additional commands to be used by clients: 

loadTemplate 

Method name: acq.loadTemplate 
Parameters: base64 encoded binary AcqKnoweldge graph template 
Return value: 0 on success, or fault code 

 Attempts to open the passed template within the AcqKnowledge environment. The parameter is a base 64 
encoded AcqKnowledge “gtl” graph template file. Only templates in PC AcqKnowledge 3.7.1 or Mac AcqKnowledge 
graph templates are allowed to be used with this command. The parameter must include the entire contents of the 
template file. 
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 The parameter in the XML-RPC call should be a base64 parameter with the raw binary contents of a graph 
template file. When this parameter is decoded, it should correctly provide the contents of a template file on disk. 

 This function will return 0 on success, otherwise a fault code if the template could not be loaded. Once a 
template is loaded, the hardware settings contained within that template is used for subsequent data acquisitions. 
Templates for ACQ 3.9.2 and higher will retain any data connection settings that have been specified by clients. After 
loading a template, clients should re-send any configuration information for ports and data connection methods if they 
do not match the new settings from the template. 

 If the template data is corrupted or is incompatible with AcqKnowledge, user interaction may be required on 
the server computer to dismiss any error messages when attempting to load the template. If user interaction is required 
on errors, this call may not return until the user interaction has completed. Clients who are using XML-RPC bindings 
that offer timeout services may wish to use them with this function. 

getAcquisitionInProgress 

Method name: acq.getAcquisitionInProgress 
Parameters: none 
Return value: boolean 

 Query whether data acquisition is currently in progress or not. A value of true is returned if data acquisition is 
occurring in any open AcqKnowledge graph window. 

toggleAcquisition 

Method name: acq.toggleAcquisition 
Parameters: none 
Return value: 0 on success, else fault code 

 Toggles data acquisition in the frontmost graph. If data acquisition is in progress, it is halted. If none is in 
progress, data acquisition is started in the graph. 

 Note that this function invocation may block if physical user interaction is required to start the acquisition in 
the graph, such as dismissing an overwrite warning, warnings on incompatibilities between different MP unit types, 
specifying a save location for acquisition to disk, etc. If the implementation of the XML-RPC binding used by the 
client supports timeout capabilities, it is highly recommended to enable timeouts for this function. 

setOutputChannel 

Method name: acq.setOutputChannel 
Parameters: channel index structure, float output value 
Return value: 0 on success, else fault code 

 Changes the voltage on the specified output channel of the MP device. For analog outputs, the value should 
be in the range (-10, 10) for the voltage level. For digital outputs, a value of 0 will turn the specified line off, a non-
zero value will turn it on. The latency of when the output line is changed is variable and non-guaranteed. Additionally, 
the output channel may be modified by other areas of the software including control channels, manual user 
intervention, configured stimulators, etc. 

The valid output channels are dependent on the type of MP device that is connected.  

 MP150 units allow analog 0, 1 and all digital output channels 

 MP36R units allow no analogs and digital 0-8. 
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Chapter 22 Licensed Functionality: Vibromyography 
VMG functionality is available through an optional license available with AcqKnowledge 4.1.1  
or above. The VMG license must be authorized to access VMG functionality. To add a VMG 
license to an existing MP System, please contact BIOPAC. 

The vibromyography transducer (TSD250) uses an accelerometer to measure surface vibration 
during activity which is directly correlated to muscle activity; this allows for muscle force and 
balance to be assessed without using surface electrodes or needle probes. The VMG license allows access to software 
processing algorithms that are incorporated into AcqKnowledge to perform data reduction for analysis of data 
collected from a VMG system.  

The VMG license: 

 adds “Vibromyography” Calculation channel Preset with required scaling and calibration  

 adds “Vibromyography Filter” option under the Analysis menu 

 includes QuickStart Q45 Vibromyography (.gtl format)—the journal of the file introduces VMG and the 
hardware settings use Module Setup to add a “VMG Transducer” to analog channel 1 and analog channel 2 of 
an HLT100C module. Two calculation channels are set to the “Vibromyography” preset using analog channel 
1 and analog channel 2 as the respective source channels. 

A side-effect of the VMG analysis is that the sampling rate of the channel is lowered by a factor of 32. In the 
AcqKnowledge software, all data in an individual waveform must share a single sampling rate divider; it is not 
possible to mix sampling rates within a channel. As such, the analysis must be performed on the entire data signal. 
Traditionally, if there is only a single point selected (0 width selection), the entire data channel is transformed. If there 
is a selected area, the application will check if it encompasses the entire waveform. If the entire waveform is selected, 
the entire waveform will be transformed. If only a portion of the channel is selected, the following warning will be 
displayed: 

 

When OK is clicked, analysis will be performed on the entire waveform. The selected area will be maintained but the 
waveform regions outside the selected area will still be transformed. This matches the “Transform entire wave” 
checkbox operation of other transformations. Cancel exits without modifying the data. 

Sampling Rate Restrictions 

The Vibromyography Filter is designed to process data acquired at 2 kHz sampling rate only. If the correct 
sampling rate is not used (via MP menu > Set Up Acquisition), results may be unpredicatable. 

Transducer Setup  

The TSD250 VMG transducer is a MEMS accelerometer transducer used for recording vibromyography signals 
from major muscle groups. 

 MP150: Activating the VMG license adds the “VMG Transducer” option to the MP150 module setup; it 
is an HLT100C high level transducer. 

 MP36R Support—the MP36R system may be useful for VMG analysis as four channels allows for 
comparison of muscle balance between two muscle groups. No custom preset is included for VMG 
transducers and any filters, offsets, and calibration/scaling will need to be configured manually—contact 
BIOPAC for support. 
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Post-analysis Selection Adjustment 

After the analysis completes, the waveform sampling rate of the selected waveform will be reduced by a factor of 
32. As this reduction occurs, the selected area or zero-width cursor location will be adjusted to snap to the nearest 
samples of data in the processed VMG channel. 

Data Modification History Name 

This operation will be displayed in data modification logs (Display > Channel Info) as “VMG Analysis.” 
It will not have any parameters. 

VMG Calculation Channel Preset 

The Vibromyography calculation channel preset uses the VMG channel as its source channel. The calculation 
channel preset automatically applies a downsampling divider of 32 based on the acquisition sampling rate.  

 A hardware calculation channel preset can only have a fixed divider of the acquisition sampling rate. This 
calculation channel preset requires the source channel to be acquired at the acquisition sampling rate. If a 
user changes the channel sampling rate of the source channel, the calculation channel will not be updated 
and must be manually adjusted—the user will be required to set the calculation channel to the channel 
sampling rate of the source channel divided by thirtytwo. 

At the end of an acquisition, the Vibromyography preset automatically performs the following steps: 

1. Check if VMG Analysis is available. If VMG analysis is not available, display a warning dialog that the 
VMG license needs to activated (or purchased from BIOPAC). 

2. Check if acquisition is running in append mode and, if so, check that the destination channel waveform 
sampling rate divider will apply the correct reduction factor of 32 compared to the selected/source 
channel divider. If there is a mismatch, a warning prompt is generated advising users that additional 
segments will no longer be able to be acquired into the graph and asking them to confirm that VMG 
processing should proceed. 

3. Perform Vibromyography Analysis filtering; this reduces sampling rate by 32. 

4. Adjust selection to highlight only the most recently acquired data segment. If not in append mode, all data 
will be selected. 

5. Copy the processed data to the clipboard. 

6. Select the destination calculation channel. 

7. Paste processed data from clipboard over the zero valued data for the appended segment (or entire 
channel if not in append mode). 

8. Remove the duplicated channel created in step 3 to allow further data segments to be acquired. 
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VMG Sample Data Files 

Two sample data files illustrating basic VMG data and analysis results are included: 
 VMG right leg VL dynamic isometric.acq 

 
 

 VMG Squat Data.acq 

 
. 
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Chapter 23 Licensed Functionality: Scripting 
Scripting functionality is available through an optional license available with 
AcqKnowledge 4.1.1 or above. The Scripting license must be authorized to access Script 
functionality for executing, authoring, and debugging BIOPAC Basic scripts. To add a 
Scripting license to an existing MP System, please contact BIOPAC. 

Scripting is available for Windows Vista and Mac OS X 10.5 or above and also requires 
Qt SDK 4.5.0 or higher for rich dialog development. 

BIOPAC Basic Scripting is a scripting language development option for AcqKnowledge 4.1 that allows for 
viewing of runtime variables, creating new script files and editing existing script files, triggering of individual script 
functions for testing and single step functionalities. Only users that have licensed the BIOPAC Basic feature may run 
user-generated scripts; if the feature is not available only digitally signed BIOPAC scripts may be executed. 

The Scripting license  

 enables the Script menu 

 adds the Calculation channel Preset “Run Macro” 

 links the BIOPAC Basic Reference under Help 

 adds Preferences for Scripting 
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The “Run Macro” Preset enables automatic post-processsing at the end of acquisition. 

Single Step Execution mode halts execution after each individual line of a macro, which allows for stepping through 
macros line by line for debugging and development purposes.  

The Variables Explorer window shows the contents of the scripting language variables. 

 
Note 

 Inserting an extra End in the middle of the macro creates a second macro upon saving. The second macro 
starts immediately after the inserted End. 

 Calculation channels for Run Macro created in the licensed version will be converted to Integrate if opened 
in a copy of AcqKnowledge that does not have a Scripting license. 
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Chapter 24 Licensed Functionality: Remote Monitoring 
Remote Monitoring functionality is available through an optional license available with 
AcqKnowledge 4.2 or above.The license must be authorized to access Remote Monitoring 
functionality. To add a license to an existing MP System, please contact BIOPAC. 

 

  

AcqKnowledge MP devices are generally tethered to specific computers where data acquisition is performed. In some 
laboratories, this computer may not be in the same location as the researcher performing the experiment. In MRI 
situations, for example, the data acquisition computer may be in the MRI control room but the researcher may be in a 
separate area. AcqKnowledge Remote Monitoring offers researchers the capability of checking on critical parameters 
from an alternate location. 

Remote Monitoring is a client/server application capable of locating and connecting to computers running 
AcqKnowledge on the same network. It consists of a simple browser interface, from which acquisitions can be started, 
stopped and remote data viewed during and post-acquisition.  

About Remote Monitoring 

 Remote Monitoring is licensed functionality and must be activated by BIOPAC. 

 Remote Monitoring is for viewing of data only. Transformation and specialized analysis of graph data is not 
supported within the Remote Monitoring interface. 

The Remote Monitoring web interface consists of three primary pages:  

 A list of open graph windows 

 Configuration settings for an individual graph 

 The data monitoring page. 

Remote Monitoring in AcqKnowledge Networking Preferences 

Remote Monitoring is enabled by default in 
AcqKnowledge Networking Preferences (Display > 
Preferences > Networking > Remote Monitoring). The 
Enable remote monitoring checkbox option activates 
the local machine on the network, making it visible to 
other local network machines also running 
AcqKnowledge Remote Monitoring.  

The Webserver TCP port is the numerical port on which AcqKnowledge listens for remote requests. (This port is set 
to 8080 by default.) The Remote monitor URL is a clickable link that opens Remote Monitoring in the local 
machine’s default web browser. This view will display acquisitions running on the local machine only. (This is 
actually an easy way to become familiar with Remote Monitoring). To view acquisitions running on machines in other 
network locations, the stand-alone Remote Monitoring Client application must be used. For further details, see the 
Remote Monitoring Client section on the following page. 

NOTE If a Remote Monitoring preference or port setting is changed, the new preference will not be applied until the 
subsequent AcqKnowledge application launch. 

New! Remote Monitor 

Simplified user interface to view subject data on 
another computer or mobile device – ‘bedside 
monitor’ display.  

Track the welfare of the subject with alarms to 
warn when signals fall out of range. The system 
will work on any device that has access to the 
same IP based network as the MP150. 
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Remote Monitoring Client 

The Remote Monitoring Client is a stand-alone application residing in the AcqKnowledge program folder. This 
application facilitates the remote connection to other computers running AcqKnowledge acquisitions on the local 
network. AcqKnowledge does not need to be running on the local machine in order to use the Remote Monitoring 
Client to observe remote acquisitions in progress. To launch the Client, browse to the following directory: 

Main Drive:\Program Files\BIOPAC Systems, Inc\AcqKnowledge 4.2\RemoteMonitorClient.exe 

 
Double-click on the RemoteMonitorClient.exe to launch the application. After launching, the first presented item is 
the Remote Monitoring Server list. This is a list of other AcqKnowledge computers on the network that have 
Remote Monitoring enabled. 

  
Quit  Exits Remote Monitoring Client 

Refresh List Updates list of available AcqKnowledge Remote Monitor computers on network 

Connect Connects to the computer selected in list 

The above-right figure shows a right-click contextual menu available within the Remote Monitoring Server List, 
which allows an alternate means of connecting to a selected computer. The Properties option displays the 
AcqKnowledge application status, along with network and hardware information about the selected computer. 

Remote Monitoring Client Browser 

Selecting a computer from the list launches the Remote Monitor Client browser interface. The navigation buttons 
operate in the same manner as most Internet browser controls. See the following page for details on the Remote Client 
browser buttons. 
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Icon Button Function Explanation 

 Back Moves browser back one page 

 Forward Advances browser ahead one page 

 Refresh Reloads the current page 

 Stop Stops loading of current page 

 

Address bar Displays I.P. address of currently-connected computer 

 Zoom in Master control for enlarging size of browser content 

 Zoom out Master control for decreasing size of browser content 

 

File, Edit, Help menus File contains Page Setup and Print controls for Remote 
Monitoring chart displays. Quit exits the Remote Monitor. 

Edit contains a Copy option. (Copy function not supported 
in Windows version) 

Help displays “About” information for the current version of 
Remote Monitoring Client* 

NOTE for Windows only: 

In order for the Remote Monitor Client to properly display the server list of additional AcqKnowledge 
computers on the network, Bonjour Service for AcqKnowledge must be installed. (The option of installing 
Bonjour Service is presented during the licensed AcqKnowledge 4.2 application installation). If Bonjour is not 
installed, the following dialog will be presented upon launch of the Remote Monitoring Client: 

 
The I.P. address of the desired computer can be entered into the http-address field. If the address is valid, 
clicking OK will connect the Remote Monitoring Client to this computer. An acceptable entry should include 
the server IP address and UDP port number. (Example; http://192.168.1.76:8080) 

Open Graphs Page 

When the Remote Monitoring Client browser is launched, a scrollable list of all graph windows currently open on the 
selected remote machine is presented. Only one graph may be selected at a time. 

 
Refresh this page Reloads the page and refreshes the list of available graphs. 
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Show Monitor  Advances the browser view to the selected file’s setup page. 

Configuration Settings Page 

After selecting a graph and clicking Show Monitor, the following Monitor Setup page is displayed. This page 
contains configurable options for data display and other viewable parameters in the Remote Monitor graph. Note that 
all available options are set individually per channel. 

 

 

Control Description 

Return to Graph List Returns browser to list of currently-open graphs. Serves the same function as the 
browser’s ‘back’ button. 

Show Monitor Saves the selected setup and advances the view to the data monitoring page. (‘Show 
Monitor’ button at bottom of screen duplicates this link’s function) 

Auto-refresh interval Chooses the interval at which the monitored data is being refreshed over the network. 
The increments range from 1-sec. to 5 minutes. 

Use audible alarms When enabled, an alarm will sound if the Remote Monitoring graph data display 
exceeds its maximum or minimum visible ranges. The audio sound is a one-second beep 
followed by one second of silence. This audio playback is supported only on HTML5 
compliant browsers.  

Label Displays assigned label of the AcqKnowledge data channel 

Show Trend Displays a graphical plot of the currently monitored data. 

Show Most Recent Value If checked, the most recent value of the channel data is displayed in a large font. If 
unchecked, textual display of this value is omitted. 

Show Min/Max Displays minimum and maximum value of currently monitored data. 

Alarm Enabled If the channel value exceeds the current trend display range, the alarm changes the color 
of the textual display to red and optionally plays audio. 

Precision Sets number of decimal places following channel display values. 
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Data Monitoring Page 

After the desired channel setup parameters are selected, choosing ‘Show Monitor’ will advance the view to the data 
monitoring page. 

 
If an AcqKnowledge acquisition is already in progress and data being plotted, the screen will appear similarly to 
above, with the graph plot tracing at intervals determined by the Monitor setup auto-refresh rate. If the acquisition has 
not been started prior to launching Remote Monitoring; the Start button will be displayed in this screen. (Remote 
acquisitions can be easily started or stopped from within this data monitoring page). 

Control Description 

Return to Graph List Displays scrollable list of all currently-open graphs. 

“-“ and “+” Controls for decreasing and increasing size of the input values display font. 

Reset Resets size of input values font display to default setting. 

Show Monitor 
Settings 

Returns to the “Monitor Setup” page for adjusting refresh rate, display options, and other 
monitoring parameters. 

Start/Stop  Toggles between starting/stopping acquisition in Remote Monitoring graph. 

Refresh Now Updates data and controls on Monitoring page. 

Stop Alarms Halts any audio alarms that may be playing. Active only if Audio Alarm option is enabled. 

Plot Controls visual display of Min, Max and Mean values display of current graph 

Change Range Allows adjustment of visible ranges of the chart, similar to the vertical and horizontal scale 
dialogs found in the AcqKnowledge application. This is useful for viewing data that may 
otherwise appear out of range of the default scaling. Change Range only affects the data 
display in the Remote Monitoring window, not in the actual AcqKnowledge graph data. (See 
below for Change Range example and further details). 

 

Default Visible range. (Note BPM data from this graph is ‘out of range’ in the above chart) 
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Visible range is modified via ‘Change Range’ to include entire data set. Horizontal time scale and vertical divisions 

were also modified. 

Controls in Visible Range (Change Range) dialog 

Control Description 

Return to Monitor page Clickable link for paging back to the Monitoring screen. 

Show seconds of data Determines visible horizontal time scale in chart display. 

Number of horizontal divisions Sets the number of horizontal divisions in chart. 

Horizontal axis precision Sets number of decimal places following horizontal time values.

Vertical lower endpoint Determines low end of vertical graph scale. 

Vertical upper endpoint Determines high end of vertical graph scale. 

Number of divisions  Sets the number of vertical divisions in chart. 

NOTE: Remote Monitoring plots are only updated in the data monitoring window while an acquisition is in 
progress. Once a Remote Monitoring acquisition is stopped, the graph will remain visible only as long as 
the browser page is displayed. After navigating away from the page, the plot will not be retained or 
reconstructed. To save a Remote Monitoring plot for future reference, printing a hard copy or printing to a 
PDF file is recommended. 

*For Remote Monitoring technical support, contact BIOPAC Systems, Inc at (805) 685-0066 or support@biopac.com 
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Chapter 25 Licensed Functionality: B-Alert 
B-Alert functionality is available through optional licenses* available with AcqKnowledge 4.2 
or above (B-Alert wireless headset hardware is also necessary).  
 * B-Alert Headset integration: must be authorized to access basic B-Alert functionality. 

 * Cognitive States Analysis: must be authorized to access this enhanced functionality. 

To add licenses please contact BIOPAC. 

The B-Alert Hardware Data Acquisiton license adds: 

 Basic wireless recording of up to nine channels of raw or decontaminated EEG data 

The Cognitive States Analysis Software license adds: 

 Functionality described above, plus the ability to create individual baseline recordings for each subject 

 Additional analysis software and specialized calculation channels 

 
Data Acquisition and Analysis with B-Alert™ 

 

B-Alert™ X10 is a Bluetooth wireless system and sensor headset integrated with AcqKnowledge software to record up 
to 9 channels of monopolar EEG, plus one optional channel of ECG data. B-Alert data can be acquired simultaneously 
with BIOPAC MP150 Hardware, if additional graphs are used.  

IMPORTANT NOTE: In AcqKnowledge for B-Alert: 

 B-Alert is licensed functionality and must be activated by BIOPAC 

 Analog channels can be toggled on/off but not modified 

 Digital channels are not supported 

 B-Alert-specific calculation channels are available when the optional Cognitive States 
Analysis software license is applied (AcqKnowledge calculation channels C8 and higher can 
be used if configured manually) 

 Data acquired with B-Alert is outputted in standard BIOPAC *.acq format 

 

B-Alert™ users should refer to the B-Alert X10 User Manual for complete hardware setup instructions. 

 For step-by-step direction, request B-Alert X10 User Training Videos from support@biopac.com. 

mailto:support@biopac.com�
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AcqKnowledge software is used to view, record and analyze data acquired with the B-Alert unit. 
To launch software with B-Alert hardware: 

1. Connect the B-Alert USB dongle and turn the X10 headset unit’s power switch ON. 
2. Choose B-Alert device from the AcqKnowledge Startup Wizard Hardware menu. 
3. Use the B-Alert menu options for acquisition and channel settings.  

 

 
 
When AcqKnowledge launches in B-Alert mode, the MP menu will be replaced by the B-Alert menu and the B-Alert 
device ID will appear in the AcqKnowledge graph “Connect to” menu. 

 

If the B-Alert device cannot be located or is disconnected, the following dialog will appear: 

 

Click ‘Retry’ in the B-Alert Headset Warning dialog to initiate a refresh of the hardware connection.  

 
With the optional Cognitive States 

Analysis License activated, an 
additional B-Alert shortcut icon will 

appear on the Desktop. For 
complete details about B-Alert 

Cognitive States software, see the 
B-Alert Software Manual. 
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Click ‘Cancel’ in the B-Alert Headset Warning dialog to launch the AcqKnowledge software in analysis mode, 
identified in the “Connect to” menu as “B-Alert Check the Connection.” (This operates similarly to MP150/36R “no 
hardware” mode, for which data can be analyzed and transformed but not recorded). 

 

Acquisition Setup 
Standard recording modes found in MP150/MP36R hardware (with the exception of Averaging) are supported in B-
Alert but the acquisition sample rate is limited to 256 samples per second. Dependent upon licensing level, there are 
two additional checkbox options in the B-Alert acquisition setup dialog: 

 Record EEG artifacts as events: When checked, recorded EEG artifacts are translated into visible 
events (eye blinks, EMG interference, etc.). When unchecked, artifacts are discarded and only data is 
acquired. 

 Use B-Alert Definition File: When checked, enables use of a subject’s baseline Definition File. This 
option is only available if the Cognitive States Analysis license is applied. See page 465 for a detailed 
explanation of Definition File setup in AcqKnowledge. 

Channel Setup 
Nine analog input channels of monopolar EEG data are enabled by default in B-Alert, along with one optional ECG 
(EKG) channel. Channels are configurable as desired. In the standard B-Alert setup, calculation channels C8 – C15 
remain available for additional online transformation/filtering of data (for C0-C7, see page 465). Digital channels are 
not supported in B-Alert hardware. 

 

Under the standard B-Alert license, the Input channel setup contains options for recording raw or decontaminated 
EEG data. These parameters are set individually per channel. It is possible to record raw data on one channel and 
decontaminated data on another. 

 Record raw data: records unfiltered data. Any further filtering must be applied through calculation 
channels or transformations. (Default setting) 

 Record decontaminated data: filtered data will be recorded for the channel. This setting applies 
algorithms to minimize artifact resulting from eye blinking or other small involuntary movements. 

The optional B-Alert Cognitive States Analysis license offers additional functionality, such as creation of a baseline 
“Definition” file (based upon a subject’s responses to some simple cognitive tests), and access to pre-configured 
calculation channel setups. 
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B-Alert-specific Hardware Menu Options   

 

B-Alert Headset Check Impedance  

This item is found in the B-Alert menu, (which 
replaces the MP menu in B-Alert hardware 
configuration) and is used to initiate an impedance 
check to verify the headset’s electrode contact 
quality. Results and resistance values are 
displayed in the dialog when the check is complete. 
If any of the channels fail the impedance check (as 
shown on Channel Fz on the right), verify that 
electrodes are firmly attached and making good 
contact, and then rerun the check. 

 

B-Alert Headset Amp Baseline  
Requires Cognitive States Analysis license activation 

Use to set up an “Alertness Memory Profile” (AMP) 
Baseline recording of a subject’s EEG definition 
file. 
Subject: Field for 4-digit identifier unique to subject 
being recorded. 

Group: Field for single-digit identifier used to 
distinguish a group number. 

Iteration: Field for single digit identifier identifying 
the session, if additional Baseline sessions are 
recorded for a subject. 

APR Setting: Choose the type and length of the 
baseline recording. Recording lengths of 15, 30 
and 45 minutes are supported. Refer to the B-Alert 
Software Manual for further details. 

After setting up the required fields, click OK to 
launch the baseline recording user interface, similar 
to the example at right.  A series of step-by-step 
instructions will follow. 

For more details about the baseline recording user 
interface and additional software controls, refer to 
the AMP Baseline section of the B-Alert Software 
Manual. 

B-Alert Show Brain State Gauges  
Requires Cognitive States Analysis license activation 

Displays real-time views of B-Alert headset data as 
it is being acquired. Information includes Meter 
Gauges gauges (Top Left) with Engagement, 
Workload and Drowsiness (along with Heart Rate). 
Time Series (Bottom) Heat maps (Top Right) 
display EEG power spectral densities (PSD) in both 
spatial and temporal maps for the traditional Hz 
bands (Beta, Alpha, Theta, Sigma).  
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Assign Definition File  
Requires Cognitive States Analysis license activation 
 

 

The Definition File is created when the 
subject undergoes an initial baseline 
EEG recording while responding to 
some simple onscreen tests. (Definition 
File setup is configured in the B-Alert 
Headset Amp Baseline dialog referred to 
on the previous page). The file is saved 
to a directory containing the subject’s B-
Alert profile folder. Once created, a 
subject’s Definition File will always be 
referenced for subsequent recordings 
and analysis. 

 

 

 

 

Cognitive Analysis Calculation Channels 
Pre-configured calculation channels C0 – C7 become available when a subject’s B-Alert Definition File is active. 
These signals are mapped from the Definition File and extract cognitive workload, high/low engagement, distraction 
and drowsiness data. The channel setups and presets are not editable but can be enabled or disabled as desired. 

 

For specific information on additional B-Alert GUI software controls, see the B-Alert Software Manual.
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Data Output 

The following data is collected during a B-Alert experiment and merged into a standard AcqKnowledge *.acq file: 

Real-Time Output file name Description 

Data file 

.edf European data format containing nine raw and nine decontaminated 
EEG channels, raw ECG channel, plus derived heart rate, head 
movement value and head movement level  

_Impedance.csv Lists the values obtained for each channel each time impedance was 
measured  

Automatically Generated during Acquisition – for all EEG Channels 

_Ref_Raw.csv Absolute PSD from 1 to 40 Hz, relative PSD from 1 to 40 Hz, and EEG 
bands labeled by channel (no edge-effect window) 

_Ref_Class.csv Absolute PSD from 1 to 40 Hz, relative PSD from 1 to 40 Hz, and EEG 
bands labeled by channel (with Kaiser window) 

Automatically Generated during Acquisition – Derived Signals 

_HR_beat.csv Presentation of heart rate based on beat-to-beat interval 
_HR_epoch.csv Beat-to-beat heart rate interpolated to sec-by sec value 

Optionally Generated with B-alert Cognitive State Classifications 

_Classification.csv Probabilities for sleep, distraction, low and high engagement, cognitive 
state from DFA with greatest probability, probability of high workload 
based on forward and backward digit span (FBDS), backward digit span 
(BDS), and average of FBDS and BDS 

_Diff_Raw.csv Absolute PSD from 1 to 40 Hz, relative PSD from 1 to 40 Hz, and EEG 
bands for differential channels: FzPO,CzPO,FzC3,C3C4, and F3Cz (no 
edge-effect window) 

_Diff_Class.csv Absolute PSD from 1 to 40 Hz, relative PSD from 1 to 40 Hz, and EEG 
bands for 5 differential channels FzPOz, CzPO, FzC3, C3C4, F3Cz (with 
Kaiser window) 

_Zscore_class.csv Updates and applies mean and standard deviation with each new 
second to provide z-scores for B-Alert cognitive states (sleep onset, 
distraction, low and high engagement, three workload measures) 

_Zscore_psd.csv Updates and applies mean and standard deviation with each new 
second to provide z-scores for PSD for all channels requested in 
initialization process 

 



APPENDICES  467 

 

Part D—APPENDICES 
  

Appendix A - Frequently Asked Questions 

Q: I have a large data file and it seems to take a long time to redraw the screen. Is there anything I can do to 
speed it up? 

A:    Yes. You can choose from several remedies for this. 

(1) The simplest solution is to check the Draft mode for compressed waves and Use all available 
memory boxes in the Preferences dialog (shown below). Checking these two boxes will cause 
AcqKnowledge to plot data faster (at the expense of some precision) and use as much available 
memory as possible. 

  
(2) You can reduce the time interval per division, which causes less data to be displayed on the 

screen at one time, and should reduce plot time. 

(3) If the data still takes too much time to redraw and you have a color monitor, try reducing the 
number of colors displayed. 

(4) If you have a high-resolution video card (one capable of displaying many thousands of colors), 
you may want to reduce the resolution to speed up plotting time. 

(5) Load all data into memory; see page 1428 for details. 

Q: Can I use other software with the MP System (MP150 or MP36R)? Can I use AcqKnowledge to control 
other data Acquisition hardware? 

A: No. The MP System (MP150 or MP36R) was designed to work with the AcqKnowledge software. 
However, the software can read in previously acquired text files generated by AcqKnowledge or any 
other software. 

Q: I have a device that outputs an RS-232/RS-422 signal. Can I connect this to the digital I/O lines? 

A: No. These types of digital output devices have their own communication protocols and are more 
complex than the digital pulses that the MP System (MP150 or MP36R) can accept as inputs. 
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Q: I imported a text file and the time scale is wrong. What happened? 

A: When a text file is imported, AcqKnowledge assumes (by default) that the data was sampled at 100 
Hz or 100 samples per second. This is arbitrary, and there are two ways to adjust this. Both methods 
involve Calculating the interval between sample points. To calculate the sampling interval, you need 
to know the rate at which the data was originally sampled. The sampling interval is calculated by 
dividing one by the sampling rate. You can adjust the sampling interval to the appropriate value via 
the File > Open dialog before the data is read in, or if the data is already present, change the time 
scale in the Display > Horizontal scale dialog. 

For instance, if 20 minutes of data was originally collected at 2Hz and is read into AcqKnowledge as 
a text file, the software will interpret this as data collected at 100 samples per second. To set the time 
scale to accurately reflect the data, change the sampling interval from 0.01 to 0.5 seconds per sample. 

To change this setting before data is read in, click the Options button in the File > Open dialog and 
change the value in the Sampling Interval dialog. To change the time scale after data has been read in, 
adjust the units per division in the Display > Horizontal axis dialog. If the data are time-domain data, 
you can adjust the seconds/sample interval at the bottom of the dialog. This value defines the interval 
between sample points, and can be changed to fit the rate at which the data was originally acquired. 

Q:  I have the fastest computer available. Why can’t I acquire data to the computer any faster than 11,000 Hz 
on one channel? 

A: The bottleneck occurs in two places: 

1. The first occurs when data is transferred between the MP150 data acquisition unit and the 
computer. While the MP System (MP150 or MP36R) can acquire data as fast as 70,000 Hz when 
data are stored directly to the MP150 data acquisition unit memory, the maximum rate drops 
considerably when data is acquired to the computer memory, and even more so when data is 
acquired directly to disk. 

2. The second bottleneck occurs within the computer itself, and has to do with the time it takes to 
transfer and process incoming data. Faster computers can perform these tasks more quickly, 
which is why the maximum possible sampling rate for a Pentium (storing to memory) is faster 
than a 386SX. With a large number of channels, the aggregate sampling rate can climb to a 
theoretical maximum of 16,000 samples per second. 

To resolve the sampling limitation, use an MP System (MP150 or MP36R). 

Q: I just filtered a waveform and now my data file is huge. Why is that? 

A: When AcqKnowledge performs any type of transformation on a waveform (e.g. digital filtering, 
waveform math), it converts the entire waveform from integer format (two bytes per sample) to 
floating-point format (eight bytes per sample). Since each sample point in the waveform now takes up 
four times as much space, the file should be approximately four times as large. AcqKnowledge still 
saves the file as compactly as possible, and since some of the information stored describes the time 
base, the file size will not increase by exactly a factor of four. 
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Q: My MP data acquisition unit seems to be connected, but I can’t acquire data. What should I do? 

A: This can be caused by one of several conditions: 

(a) Check to make sure that the MP data acquisition unit is ON and, if so, that all the connections to 
the MP data acquisition unit were made properly. When the MP data acquisition unit is powered 
up, a light on the front panel of the MP data acquisition unit will illuminate. If the power light 
will not illuminate, check to make sure the proper power supply is connected. The power supply 
that comes with the MP data acquisition unit is rated at 12 VDC @ 1 Amp, and using other power 
supplies may result in damage to the MP data acquisition unit. 

(b) If the proper power supply is connected but the power light still does not illuminate, disconnect 
the power supply and check the fuse in the back of the MP data acquisition unit. The fuse is a 
standard 2.0 Amp fast blow fuse, and can be changed by unscrewing the fuse cap and replacing 
the fuse. 

(c) If the power light does illuminate, the next step is to see if the busy light (next to the power light 
on the front panel of the MP data acquisition unit) illuminates when the MP data acquisition unit 
is powered up. When the MP data acquisition unit is powered up, the busy light should illuminate 
for three or four seconds and then extinguish. 

NOTE: The busy light is normally off (except at startup), but it will remain on while 
data is being acquired and will illuminate for the duration of each trial when data is 
being acquired in averaging mode. If the busy light does not illuminate when the 
system is powered up or does not turn off after a few seconds, contact BIOPAC at 
one of the locations listed in Appendix A. 

Q: I Set Up the channels but I only seem to be acquiring noise. What’s wrong? 

A: A number of phenomena can cause this. Check to make sure that the settings in the Set Up Channels 
dialog correspond to the channel switch settings on the amplifier modules and/or direct analog 
connections to the UIM100C. When a direct analog input is set to the same channel as an amplifier, 
the resulting data will appear quite noisy or erratic. You should also check to see that no two 
amplifiers are set to the same channel. 

Another possible cause is that the gain settings on the amplifiers are too low and should be increased. 
You may also want to select Autoscale waveforms from the Display menu. This will automatically 
adjust the waveforms to provide the “best fit” in terms of scaling the data to fit in the available 
window space. 

It is also possible that the electrodes/transducers themselves are the source of the noise. Proper 
electrode adhesion techniques involve abrading the skin and securing the electrode in place to reduce 
movement artifact. 

Q: What is the storage and operation accuracy of AcqKnowledge? 

AcqKnowledge performs all internal calculations to the accuracy defined by the IEEE format for 
double precision flointing point numbers and stores the results of those calculations in double 
precision floating point format. This format assigns 8 bytes to all numbers involved in calculations or 
resulting from calculations. The 8 bytes (64 bits) are assigned as 52 bits to mantissa, 1 bit to sign, and 
11 bits to exponent. The effective decimal accuracy for calculation operation or storage will be 
defined as [2 to the 52] power or approximately 4.5 E15. Accordingly, the effective decimal accuracy 
will be between 15 and 16 digits. 
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Appendix B - Filter characteristics 
Filter types 

AcqKnowledge employs two types of digital filters:  

(a) Finite Impulse Response (FIR) perform post-acquisition filtering 

(b) Infinite Impulse Response (IIR) perform filtering calculations online (during an acquisition) or post-
processing (after an acquisition)  

Although the similarities between the two types of filters outweigh the differences, some important 
distinctions remain. 

1. First, IIR filters are typically more efficient than FIR filters, which means that IIR filters can filter 
data faster than FIR filters, which is why IIR filters are used for online Calculations. 

2. Second, IIR filters tend to be less accurate than FIR filters. Specifically, IIR filters tend to cause 
phase distortion or “ringing.” When the phase of a waveform is distorted, some data points on a 
waveform are shifted (either forward or backward in time) more than others. This can result in the 
intervals between events (such as the Q-R interval or the inter-beat interval in an ECG waveform) 
being slightly lengthened or shortened compared to the original signal. In practice, however, the 
effect of this distortion is usually minimal since the frequencies which are most distorted are also 
attenuated the most. By contrast, FIR filters are phase linear, which means that the interval between 
any two sample points in the filtered waveform will be exactly equal to the distance between the 
corresponding sample points in the original waveform. 

3. Third, IIR filters have a variable Q setting that defines the filter response pattern, but FIR filters do 
not have a Q component. The optimal Q of an IIR filter is 0.707, with lower values resulting in a 
flatter response and higher values resulting in a more peaked response. The default Q for all IIR 
filters is 0.707 (except for Band pass filters where Q defaults to 5), which is appropriate for nearly all 
filter applications. 

In the examples on the following page, the filter responses of several different types of filters are compared. 
All of the filters are 50 HZ low pass filters operating on the same data. 

The first graph shows how the number of filter coefficients in FIR filters (Q) affects the filter’s frequency 
response. Note that as the number of coefficients (Q) increases, the filter becomes more accurate. A good rule 
of thumb is to set Q ≥ 2(fs/ fc), where fs = sampling rate and fc = cutoff frequency. 

 
 FIR filter performance as a function of number of coefficients (Q) 
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The next graph shows how the pole or zero locations of the filter, as related to filter “peaking” (specified by 
Q), affect the frequency response of the filter. The “Q” in this case is not to be confused with the Q from the 
FIR filter. Note how increasing “Q” in the IIR filter case affects filter “peaking.” 

 
FIR filter performance as a function of changes in pole or zero locations 

Coincidentally, the FIR (Q = 10) and IIR (Q = 0.707) filters have very similar responses in this case. 

Technically, the coefficient setting for FIR filters determines the number of multiplies performed by the 
filtering algorithm. In practical terms, it determines how “steep” the frequency response of the filter is. Filters 
with a large number of coefficients have a steep roll-off, whereas the frequency response of filters with a 
smaller number of coefficients is not as steep. 

 

Window Functions 

Window functions are used for two purposes in AcqKnowledge. Windows are applied to the impulse response 
in the (FIR) digital filtering functions, and can optionally be applied as part of the FFT function. In either 
case, a window refers to a computation that spans a fixed number of adjacent data points.  

Typically, window functions are used to eliminate discontinuities that may result at the edges of the fixed 
span of points of the digital filter function (FIR filters) or the data points of the FFT. 

Digital filtering. When a window is used in digital filtering, the impulse response of the filter (rather than the 
data itself) is modified. When the impulse response smoothly approaches zero at both the beginning and end 
of the data, this works relatively well. When the impulse response is not so well behaved, edge effect occurs. 
Edge effects can be minimized by windowing, or forcing the edges of the impulse response to smoothly 
approach zero. The exact process depends on the window selected (see below). 

Another way to minimize edge effect with an FIR filter is to increase the number of coefficients used to 
transform the data. 

FFT. The FFT function also windows data, although the nature of the windowing function is somewhat 
different in the sense that the window operates on the data. One of the assumptions of the FFT is that the input 
data is an infinitely repeating signal with the endpoint wrapping around. In practice, the endpoints are almost 
never exactly equal. You can check this by choosing the Delta measurement item from the measurement 
popup menus, which returns the amplitude difference between the first selected point and the last. To the 
extent that the endpoints differ, the FFT output will produce high frequency components as an artifact of the 
transformation. 

 AcqKnowledge displays only the positive coefficients of an FFT. In this FFT presentation, there is an 
implicit negative frequency component for each positive frequency component, so if you are looking 
at amplitude levels in a linear FFT you need to multiply by two (negative frequency can only be 
created with positive frequencies in the real world). 

By windowing the data, the effects of this phenomenon are greatly diminished. When data are windowed, a 
window is moved across the data, much as the smoothing function moves across the data. Whereas the 
smoothing function simply takes the average of a specified number of points, each type of window weights 
the data somewhat differently. 

The Window pull down menu offers the following options: 
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Bartlett implements triangular windowing and Rectangle does not window the data. The “shape” of the other 

windows is defined by the following formula, where n = 
0

N 1
n


 and A, B, C and D are constants: 
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The table below details the different parameter values for each type of window. 

 Parameter Values 

Type of Window A B C D 

Bartlett n/a n/a n/a n/a 

Blackman 0.42000 0.50000 0.08000 0.00000 

Blackman -61 0.44959 0.49364 0.05677 0.00000 

Blackman -67 0.42323 0.49755 0.07922 0.00000 

Blackman -74 0.40217 0.49703 0.09392 0.00183 

Blackman -92 0.35875 0.48809 0.14128 0.01168 

Hanning 0.50000 0.50000 0.00000 0.00000 

Hamming 0.54000 0.46000 0.00000 0.00000 

Kaiser-Bessel 0.40243 0.49804 0.09831 0.00183 

Rectangle 
Windows/PC only 

n/a n/a n/a n/a 



Part D — Appendices 473 

www.biopac.com      |                     info@biopac.com |     805-685-0066

Appendix C - Hints for Working with Large Files 
It is not uncommon for users to generate large data files (on the order of several megabytes) through some 
combination of (a) high-speed acquisitions, (b) long acquisitions, and (c) multi-channel acquisitions. Users 
frequently encounter system limitations (such as storage space limitations) and find the files are difficult and 
slow in loading to memory. 

The software that comes with your MP System (MP150 or MP36R) stores the data in as compact a format as 
possible. Each sample takes up roughly two bytes of storage space. When a waveform (or a section of a 
waveform) is transformed (i.e., filtered or integrated) each data point takes up roughly eight bytes of storage 
space. As a result, file size can change drastically after transforming one or more waves. 

Note AcqKnowledge data files greater than 2GB can be opened, but edit, transformation and analysis 
operation cannot be performed. 

The following tips can help you get the most out of your MP System (MP150 or MP36R) when working with 
large data files. 

 Use virtual memory 

 Since AcqKnowledge runs under Windows XP or Mac System 7.0 or better, most computers are 
able to take advantage of the virtual memory feature. While this is slower than conventional memory, 
it will at least make it possible to load some files that might otherwise be impossible to load. 

 Remove waveforms 

 Since each waveform adds to the total size of the file, try removing (or copying to another file) some 
of the waveforms from a multi-channel file. This is especially true if you would like to perform 
transformations of some sort on at least one of the waves. 

 Sample slowly 

 Theoretical and methodological concerns will, to a large extent, dictate sampling rate. However, if 
you can reduce the sampling rate, choose to do so. Or, use Transform > Resample (page 292) to 
resample data after collecting it. 

 Set preferences 

 Check the “Use all available memory” and the “Draft mode for compressed waves” options under the 
Preferences menu item. This should decrease the time it takes to redraw waveforms and allow the 
software to access all available memory for storage. 

 Store to disk 

 Although slightly slower than storing to RAM, acquiring data directly to disk allows you to recover 
data in the event of a power loss to the MP System (MP150 or MP36R). Furthermore, much larger 
data files can typically be stored directly to disk than to memory. 

 Use the Append mode 

 The Append mode allows you to pause the acquisition for arbitrary periods. This can be helpful when 
recording only a few key events that will occur randomly over a long period of time, since it will 
reduce unnecessary data.  

 Compress Files 

 Use the File > Save As > Compressed option to store or transfer data 

 

Note  Copy/Paste, Merge Graphs, and Transformations require AcqKnowledge to allocate additional 
memory and then load the data into memory; when these operations are executed on large data files, 
the application may crash. 
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Appendix D - Customizing Menu Functionality 
AcqKnowledge now includes a powerful customization feature lets you choose the program features to display as 
menu options. If you have a specific procedure, you can limit the menu options to list only those functions you 
need, thereby reducing the chance for confusion or error in your lab. For instance, you might choose to remove 
the “Setup Triggering” and “Setup Stimulator” options from the MP150 menu, as shown below: 

   
Default MP150 menu     Customized MP150 menu 

Follow the simple procedure below to customize menu display for your own needs. 

1. Launch AcqKnowledge. 

2.  a) Choose Display > Preferences. 

a)  Click “Create default menu configuration file.”  

b)  Click “Yes” when prompted about editing the file. 
 

 Alternately, you can pull down the “Files of type” menu, select “All files” and then select 
the “menu.dsc” file from the default location and click Open. 
 

The “menu.dsc” file will open in the Journal window, as shown below. 

 For a complete list of the options included in the “menu.dsc” file, see the end of this section. 

 
3. Find the menu and item you want to change (scroll through list as necessary) and type “OFF” to disable the 

menu display. For example, you might change the File > New option to OFF, as shown below. 

 Note that ON/OFF is case-sensitive and you must type in ALL CAPS. 

 Deleting a file listing instead of typing OFF will not remove the feature; it will default to ON unless you 
type OFF. 

 

 To reactivate a menu item that you have turned OFF, just repeat the above procedure and type 
“ON” for the menu item you desire. 

4. Activate the Journal Save As dialog. 
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File > Save Journal as… 

5. Save the file in the exact same location by typing “menu.dsc” in the “File name” entry box and clicking Save. 
Leave “Save as type” set to Text (*.TXT).  

 

6. You should be prompted that the file already exists. Click Yes to replace the existing file. 

 

7. Quit the AcqKnowledge program. You do not have to save any graph or journal changes—the “menu.dsc” file 
has already been saved. Click No if prompted. 

 
8. Restart AcqKnowledge. 

9. Check your menu listing. 

 

Note: Application menu customization has a corresponding effect on contextual menu display. If a contextual 
menu item does not have a corresponding application menu item, the menu customization file identifier 
will begin with “IDM_CM.” 
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Appendix E—Locking/Unlocking the MP150 

for Network Operations 
The MP150 is primarily designed to work in Local Area Networks (LAN). In a LAN, each MP150 unit may be 
accessed from any workstation (PC or Mac) running an Ethernet version of AcqKnowledge software. 
Theoretically, two or more workstations (WS) could be connected to one MP150 at the same time, but the MP150 
cannot perform independent acquisitions simultaneously, so in such cases one or all connected WS would receive 
corrupted/invalid data and/or crash. 

To prevent this, AcqKnowledge uses new “lock/unlock” technology that establishes communication between an 
MP150 and one —and only one— dedicated WS in the Network. 

 

AcqKnowledge locks an MP150 as soon as it connects to it, which tells the MP150 to only respond to commands 
from that particular computer and the communication method (serial or ethernet). The lock has a timeout which is 
reset every time the MP150 unit receives a command from the computer that locked it. To locate MP150s in the 
local network, AcqKnowledge sends a broadcast packet to the local area network that asks all the MP150s in the 
network to respond. All the MP150s—whether locked or unlocked—will respond to this prompt. This means that 
the “Select MP150” menu may allow a user to select an MP150 that is locked. In such cases, AcqKnowledge will 
fail to connect (to a locked MP150 unit), as expected. To resolve this issue, unlock or power cycle the MP150 
unit. 

 

Locked  An MP150 becomes “locked” in operation to a WS (and unusable to other users) if 

 a) An MP150 unit is selected from “Select 
MP150.” The dialog lists all MP150 units 
that are powered ON and sitting on the 
same local area network. Unfortunately, 
this dialog cannot provide the 
locked/unlocked status of each MP150 in 
the LAN. You may refer to the BUSY and 
ACTIVITY lights on the MP150 to 
determine the status—if you cannot 
connect to an MP150 but its lights 
indicate data traffic or acquisition, the 
MP150 you are trying to connect to is 
connected to another WS. 

 b) When AcqKnowledge is launched. 
AcqKnowledge will “remember” and try to 
connect the last MP150 used by a WS; if the 
last used MP150 is not available, the user 
must pick an available MP150 unit from the 
“Select MP150” dialog. 

 c) With the advent of any new 
communications or the start of any type of 
acquisition to the MP150 unit. When a WS 
communicates with an “unlocked” MP150 
unit, AcqKnowledge sends a “lock” 
command. 

When an MP150 is locked, its serial number is listed in the Select MP150 dialog but any attempt to 
select a locked MP150 will generate a Hardware Not Found prompt (shown above).  
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Unlocked An MP150 automatically “unlocks” and becomes available to other users  

a) When the user exits AcqKnowledge. 

b)  The user selectes another MP150 in the Select MP150 dialog. 

c)  The user selects the “No Hardware” option in the Select MP150 dialog. 

Other, less common conditions that may unlock the MP150 include 

d)  The MP150 is powered OFF and then ON. 

e)  The MP150 does not receive commands/data from the WS or AcqKnowledge for about 5 minutes. 
This time-out can occur when 

 An AcqKnowledge dialog (About, Calculation setup, etc.) is open for a long time. 

 AcqKnowledge or the WS crashes for any reason. 

 You turn the connected WS off without exiting AcqKnowledge. 

If the MP150 becomes unlocked due to a time-out, two scenarios are possible: 

1) The MP150 is locked—If another user has locked the MP150 you had been using, you will see 
the No Hardware Prompt. Check the MP150 lights to determine its status. 

2) The MP150 is unlocked—Your WS will “lock” the MP150 as soon as you initiate communication 
or acquisition; until then, the MP150 remains unlocked and available to others. 

 

No 
Hard-
ware 

When a user selects the “No Hardware” option, the menu of available MP150 units is grayed 
out and becomes unselectable. If a user attempts to connect to a locked MP150, an error 
message will be generated to advise that the MP150 unit is locked to a different computer. 

 

 

Cannot 
lock 

 

 If you receive this “cannot lock” prompt, check that no other user on the network is using the 
MP150, power-cycle the MP150, check the current firmware version (About MP150), and, if 
necessary, update the firmware using MP150Tools (see next Appendix). 
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Appendix F—Firmware Upgrade  
MP150 firmware is upgraded automatically. Unless a firmware warning is diplayed at application launch, your 
MP150 already has the latest firmware revision and no further action is necessary. If a firmware warning is 
displayed, contact BIOPAC technical support for more information. 
 

Firmware Rollback Switch 

   IMPORTANT! 
Use the Firmware Rollback Switch only if the MP150 fails to operate 
after a Firmware Upgrade. 

 In all other cases, just turn the MP150 power OFF and then ON and check 
the results of the Start up/Self-Test. 

The Firmware Rollback Switch is located on the bottom of the MP150 unit and is recessed to prevent accidental 
activation. 

Activation of the Firmware Rollback Switch will cause the MP150 unit to operate under the factory-installed 
firmware version. If no upgrades have been performed (the MP150 has only the factory-loaded firmware), the 
Firmware Rollback Switch will have no effect. 

Procedure: 

1. Turn the MP150 unit ON. 

2. Use About MP150 in the AcqKnowledge software to determine the factory-installed firmware version: 

IMPORTANT! 

Factory-installed Firmware version 1.1.2 or 
previous (purchased approximately November 
2002 or before) may not reset to a level 
compatible with UDP communication. In such 
cases, you will need to install a DLC-compliant 
version of AcqKnowledge and update to UDP in 
stages; contact BIOPAC for additional support if 
necessary 
Mac OS X: Labeled “Manufacturer’s ROM” and 
“Current ROM” 

3. Turn the MP150 unit OFF. 

4. Turn the MP150 unit upside down and use a small-tipped device (an unfolded paperclip 
will do) to depress and hold the switch down. 

5. Continue to hold the switch down, and turn the MP150 unit ON. 

 One green and one yellow LED light will begin to blink simultaneously 5 times. 

 While the lights are blinking simultaneously, you may cancel the Rollback by 
releasing the Firmware Rollback Switch. If Rollback is cancelled, the MP150 
will try to load the latest firmware upgraded version. 

 Then the MP150 will perform a normal Startup/Self-Test with the factory-loaded firmware. 

6. When the simultaneous blinking stops, release the switch. 

 The MP150 is now restored to the previous version of firmware. 

 You can check the firmware version via the MP150 > About MP150 menu item in AcqKnowledge. 
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BPM, Rate function, 126 

BSL File Import, 239 

C 
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center vertical, 41 
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Plot Attractor, 343 

Chart mode, 412 
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Color, 409 
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down sampling, 292 
Save As option, 252 
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Connected to…, 56 
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Calculation channel, 141 
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Convolution, 281 
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Epoch Analysis, 361 
Equation Generator, 132–44, 293 
Erase Appended Segment(s), 56 
Ethernet protocol, 425 
European Data Format (EDF) 

Open, 244 
Save, 251 

Event (Marker) 
Graph Selection, defining via, 220 
Graph Selection, display impact, 219 
Hotkey Setup, 210 
Location, 212 
Measurements, 217 
Overview, 207 
Palette, 211 
Preferences, 209 
Printing, 219 
Selection, 219 
Toolbar, 208 
Tooltips, 208 
Variable Sampling Rate and, 220 
Waveform editing, 220 

Event definition cursor, 58 
Event marker, 29 
Events, R wave location, 337 
ex power of a data point, 138 
Excel Spreadsheet Export, 252, 333 
Exp Exponential, 277 
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Exporting data, 52, 240 
Expression, 293 
Expression evaluator, 132–44 
External trigger, 156 

F 
FAQ, 467 
Fast Fourier transformations. See FFT 
FFT, 301–5, 471 
File Compatibility for Specialized Analysis, 332 
File format prompts), 253 
File menu commands, 236 
File size, 468, 473 
Filter 

Calculation, 131 
characteristics, 470 
response, 270 

Find, 324 
Find Cycle/Peak, Mac OS X, 308 

Finite impulse response filters. See FIR filter 
FIR filters, 266, 269, 470 
Firmware Rollback Switch, 478 
Font, journal, 425 
Formula 

Area, 91 
BPM, 92 
Correlation, 93 
Delta, 93 
Delta T/F/X, 94 
Freq (Frequency), 95 
Integral, 95 
Lin_reg (Linear regression), 96 
Mean, 97 
Slope, 99 
Stddev (Standard deviation), 99 
Threshold, 130 

Fourier 
FFT Fast Fourier transformation, 301 

Fourier Linear Combiners 
Calculation Channels, 145 
Transformations, 275 

Frequency 
frequency spectrum, 305 
Horizontal scale, 411 
measurement (Freq), 95 
rate calculation (Hz), 327 

Frequency Bands, HRV analysis, 338 
Frequently asked questions, 467 
Friendly Grid Scaling, 79 
Function 

Calculation, 130, 133 
Equation (Expression) commands, 138 

G 
Gain setting, 110 
Gastric Wave Analysis, 341 

Gastric Wave Coupling, 341 
Gauge, 227 
Getting Started, 22 

GLP audit 
include timestamp, 423, 424 
mark selection with Events, 423, 424 

GLP guidelines, customizing menus for, 27 
Graph template files (gtl) 

Open, 240 
Quick Start Files, 117, 240 
Save As, 247 

graph window, 35 
Graph window, 35 
Gray non-selected waves, 423 
Grid 

Adjust spacing, 408 
GridReset, 408 

H 
Hard Disk, acquisition option, 161 
Hardware. See note on page 10 
Heart Rate Variability, 31, 335 
Help menu, 429 
Hemodynamic Analysis, 362 

ABP Classifier, 362 
Arterial Blood Pressure, 363 
ECG Interval Extraction, 364 
LVP Classifier, 367 
MAP Classifier, 369 
Measurements App Note, 31 
Monophasic Action Potential, 368 

High pass filter, 267 
Histogram, 296 
Hold button, SIV, 221 
Hold relative position 

Horizontal Scale, 72 
Horizontal 

Axis, 28 
scale, 46 
Scale, 46 
Scroll bar, 72 

Human Subjects, Safety, 205 
Hyperbolic 

Cosine, 138 
Sine, 139 
Tangent, 139 

I 
I/O channels, Manual Control, 222 
I-beam tool 

selection cursor, 57 
IBI Inter-beat Interval, 126, 327 
IFFT. See inverse FFT 
Igor Pro Experiment 

Open (import), 243 
Save As (export), 250 

IIR filters, 266, 271, 470 
Impedance Cardiography Analysis, 371 

Body Surface Area, 371 
Derive dZ/dt from raw Z, 371 
dZ/dt Classifier, 371 
dZ/dt remove motion artifacts, 378 



482 AcqKnowledge Software Guide 

Visit the online support center at www.biopac.com 

ICG Analysis, 374 
Ideal Body Weight, 377 
Pre-ejection Period, 377 
Preferences, 379 
VEPT, 378 

Independent Component Analysis, 307 
INF (measurement value), 87 
Infinite impulse response filters. See IIR filters 
Initial offset, 72 
Input Values Setup (SIV), 221 
Insert 

Markers, 51 
Waveform, 259 

Installation. See note on page 10 
Integral 

measurement, 95 
Transformation function, 285 

Integrate 
formulas, 288 

Integrate Calculation (online), 119 
inter sample interval, 243, 249 
Interpolate pastings, 424 
Interpolation method, resampling, 292 
Intraventricular Pressure Wave analysis, 31 
Inverse mean square error, 281 

J 
Jewett Sequence, ABR testing for, 31 
Journal, 52 

Copy Measurements, 90 
Paste options, 263 
Preferences, 425 
Show Journal, Mac OS X, 264 

Jump-to tool (correlates data views), 58 

K 
K (Constant), Calculate measurement option, 92 

L 
Latency, 154 
Left Ventricular Pressure 

LVP Classifier, 367 
Limit data, Calculation channel Function, 130 
Limit math command, 277 
Lin_reg (linear regression measurement), 96 
line plot, 412 
Linear (FFT option), 304 
Linear interpolation, 292 
Ln natural logarithm, 278 
Locate SCRs, 349 
Locked MP150, 476 
Log, 138, 278 
Low pass filter, 267, 285 
Lung Volume analysis, 31 
LVP Analysis, 31 

M 
Mac on Intel, 24 
Macintosh® system requirements, 23 
Magnetic resonance imaging 

Specialized Analysis, 380 
Manual Control (digital I/O), 222 
Manual stimulator controls, 172 
Markers, 51 

Time Stamp, 197 
Math 

Calculation, 128–29 
Functions (Transformation), 277 
Waveform Math, 294 

MATLAB 
Open (import), 242 
Save As (export), 249 

Max measurements, 97 
Mean 

Mean square error, 281 
Measurement, 97 
Removal, 280, 303 

Mean subtraction, Integrate option, 120 
Measurement, 50, 87 

Cycles/Peaks Output, 313 
Preferences, 422 
Preferences for Journal, 425 
Presets, 90 
Table of Explanations, 91 

Media menu (capture or playback), 431 
Median measurements, 97 
Memory 

Load all data into, 428 
Storage option, 37, 150 
Use all available memory, 425 

Menu configuration file, 426 
Menu display, customizing, 426, 474 
Merge Graphs, 261 
Min (minimum) measurement, 98 
Modeling 

Linear 
Autoregressive transform, 297 
Lin_reg measurement, 96 

Nonlinear, 298 
NLM measurement, 98 

Modeling, Autoregressive, 297 
Monophasic Action Potential, 368 

MAP Classifier, 369 
Moving average, 290 
MP, data storage option, 150 
MP150 

Locked/Unlocked, 476 
MP150 Serial Number, 224 
Multiple hardware, 153 

MP150 Info (menu option), 224 
MP150 System 

Features, 27 
Overview, 22 

MP150 System Requirements, 23 
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N 
Natural logarithm, Ln, 278 
Network Data Transfer (NDT), 436 
Neurophysiology 

Specialized Analysis, 384 
New 

Data View, 236 
No hardware mode, 224 
Noise, 469 

Calculation channel Function, 130 
Math command, 278 
Rejection (auto threshold detect, 328 

None (measurement option), 98 
Nonlinear modeling, 298 

NLM measurement, 98 
Normalized cross correlation, 282 

O 
Off-line Averaging, Cycle/Peak Detector (MAC), 

313 
Online filtering, 131 
Open (file command), 239 
Open for Playback, 244 
Options button, Open Text file, 240 
Options, Input Values, 221 
Organize Channel Presets, 164, 233 
Organize List, Preferences, 195 
Output continuously. Stim. Setup, 172 
Output Control, 181 

CH# to Output, 183 
Digital Outputs, 185 
Preferences, 182 
Pulses, 186 
Stimulator – OUT3 adapter, 186 
Stimulator—BSLSTM, 186 

Output tab, Cycles/Peaks detect, 313 
Overlap 

Overlap Waveforms, 406 

P 
P300 measurements, 157 
Pad with…, 301 
Padding (resampling interpolation), 292 
Paste, 258 

Acquisition settings, 264 
Measurement, 263 
Wave data, 264 

Pause mode (Append to disk), 149 
PC-compatible files, 247 
Peak 

Detect (Find Rate option), 328 
Find Cycle (Peak Detector), Mac OS X, 308 
Minimum, 327 

Peak-to-Peak (P-P measurement), 98 
PEP Pre-ejection Period, 377 
Phase, 304 

Distortion, 470 
Phasic EDA options, 351 

PhysioNet 
Save As (export), 248 

PICT files, 262 
Playback mode, 44 
Plot 

Plot on Screen, Setup Channels option, 160 
Plotting data, 36, 105, 232 
Poincare plots, 365 
Power Spectral Density, 300 
Power supply, 469 
P-P (peak-to-peak measurement), 98 
Preferences 

Display Preferences, 420 
Journal preferences, 425 
Menu configuration file, 426 
Output Control, 182 
Undo max, 424 

Presets, 106 
Organize Channel Presets, 164, 233 

Pretrigger, 169 
Principal Component Analysis, 306 
Principal Component Denoising, 389 
Print, 29, 54, 254–55 
PSD Options, HRV analysis, 338 
Pulse Sequence Output Control, 188 
pulse stimuli, 177 
Pulses Output Control, 186 

Q 
Q coefficient, filter setting, 131, 271, 470 
QRS Detector, HRV analysis, 337 
Questions, frequently asked, 467 

R 
RAM, acquisition storage, 161 
Ramp waves, 178 
Rate 

calculation, 125–28, 295 
detector algorithm, 31 

Raw data 
Open (import), 243 
Save As (export), 249 

Record 
Start acquisition, 162 

Record/Record last, 148 
Recursive formulas, 134 
Remove 

last appended segment, 260 
mean, 280, 303 
trend, 303 
waveform, 259, 260, 473 

Remove Projection, 281 
Remove Projection Template, 281 
Remove Trend, Specialized Analysis, 390 
Repeat mode, 159, 232 
Repositioning Events (Marker), 212 
Resample, 292 
Resampling Interpolation, 292 
Reset 



484 AcqKnowledge Software Guide 

Visit the online support center at www.biopac.com 

Append acquisition button, 149 
reset chart boundaries, size window, 427 
Reset Chart Display, 407 
reset thresholds, Integrate setup, 120 
reset trigger, Integrate setup, 120 

Reset Grid, 408 
Resource allocation, 425 
Respiratory Sinus Arrhythmia, Specialized Analysis, 

369 
Rewind, 56 
RS-232/RS-422 signal, 467 

S 
Safety Notice, 20 
Sample 

measurement, 98 
Rate, 150–52, 468, 473 
Rate, Acquisition rate, 37 
Rate, Channel, 36, 37, 107 
Rate, Stimulation signal output, 170 

Sample Rate, 161 
Save, 52 

Save (File command), 246 
Save as (File command), 246, 253 
Save as TIFF, 3D output, 314 
Save once (Acquisition setup), 148 

Save Settings, Preferences, 187, 195 
Scaling, 108–9 
Scaling, Friendly Grid Scaling, 79 
Scope mode, 39 
Scroll, 46, 71 

Menu option, 232 
Segment Labels, 225 
Select 

All, 259 
Area, 49, 256 
Area for measurement, 88 
Channel, 48, 85 
Cursor tool, 57 
Waveform, 48, 85 

Selection Palette, 413 
Selection tab, Cycles/Peaks detect, 312 
Serial number, MP150, 224 
Set template, 279 
Set Up 

Acquisition, 37 
Channels, 36, 103, 108 
Stimulator, 170 
Triggering, 166 

Set wave positions, 408 
Setup Acquisition, 161 
Shortcuts 

Keyboard, 64 
Toolbars, 55 

Show 
All Data Snapshots, 53 
Display menu options, 412 
Hardware icon, 56 
Input values, 105 

Input Values, 221 
Input Values Setup options, 221 
Modified input, 302 

Signal averaging. See Averaging mode 
Sine, 139, 278 
Size window, 427 
Slew Rate Limiter, 383 
Slope (measurement), 99 
Smoothing 

online calculation, 124 
transformation function, 290 

Smoothing Baseline Removal, 351 
Snapshot data after acquisition, Preference, 53 
Sound Feedback, 226 
Sound Sequence Output Control, 191 
Specialized Analysis Package, 330, 331 

File Compatibility, 332 
Specifications. See MP Hardware Guide 
Spectral analysis. See FFT 
Spectral subtraction, 395 
Spectrum Analyzer Palette, 416 
Spotlight Importer (Mac OS feature), 24 
Square 

Square, 139 
Square Root, 139, 278 
Waves, 177 

Standard deviation measurement, 99 
Start acquisition, 38 
Starting an acquisition, 162 
Statistics (Waveform Statistics dialog), 419 
Status indicator, 38 
Status indicator, software, 162 
Stddev (standard deviation) measurement, 99 
Step plot, 414 
Stimulation. Dual, 176 
Stimulator 

Stimulator Reference Channel, 205 
Stimulator - BSLSTM, 186 
Stimulator Manual Control, 223 
Stimulator setup, 170 
Stimulator, manual controls, 172 
Stimulus signal, 154, 156, 170 
STM100C Manual Control, 223 
Stopping an acquisition, 162 
Sum measurement, 100 

T 
Tab interval, Journal, 425 
Tangent, 139 
Tau (time constant), 298 
Template functions, 279 
Text Annotation, 58 
Text files, 52, 241–42 
Three-D Output, Cycles/Peaks detect, 314 
Threshold 

Math command, 278 
TIFF, Save 3D output as, 314 
Tile waveforms 

Tile after transformations, 423 
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Tile Waveforms, 404 
Time 

Expression source, 134 
measurement, 100 
Set Horizontal Time scale, 411 
Time scale after importing, 468 

Timestamp, journal preference, 423, 424 
Tone stimuli, 177–78 
Toolbars, 55 
Transform, 50 

Math commands, 277 
Menu commands, 265 
Remove Projection, 281 
Specialized Analysis Package, 330, 331 

transition latency, 398 
Triggering, 166 
Troubleshooting, 467 

U 
UDP, Ethernet protocol, 425 
Undo, 257 
User Support System, 18 

V 
Value (measurement), 100 
Values checkbox, 36, 105 

Show input values, 221 
Variable Sampling Rate, 37, 107, 170 

data processing notes, 136 
Event plotting and, 220 

VEPT, 378 
Vertical axis, 28, 109 
Vertical scale, 48, 73 
Viewing data, 46 

Virtual memory, 473 
VO2 measurement, 31 

W 
Warning 

Before overwrite data, 232 
Hardware not found, 34 

Waterfall Plot, 400 
WAV files, 243 
Waveform 

Arithmetic dialog, 92 
Color, 409 
Math transformation, 294–95 
Selection, 48, 85 
Statistics dialog, 419 

Wavelet Denoising, 400 
Window 

Find Rate option, 329 
Functions (filter, FFT), 471 
Menu, 429 

Windows® system requirements, 23 
Working in AcqKnowledge, 32 

X 
X/Y mode, 39, 40 

X/Y loop area analysis, 31 
X-axis T/F/X (measurement), 100 

Z 
Zap, event cursor, 58 
Zoom 

Cursor tool, 49, 57 
Zoom previous, 407 
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COPYRIGHT 

Information in this document is subject to change without notice and does not represent a commitment on the part of 
BIOPAC Systems, Inc. This manual and the software described in it are copyrighted with all rights reserved. Under 
the copyright laws, this manual or the software may not be copied, in whole or part, without written consent of 
BIOPAC Systems, Inc., except in the normal use of the software or to make a backup copy. 

The same proprietary and copyright notices must be affixed to any permitted copies as were affixed to the original. 
This exception does not allow copies to be made for others, whether or not sold, but all of the material purchased 
(with all backup copies) may be sold, given, or loaned to another person. Under the law, copying includes translating 
into another language or format. This software is intended for use on only one machine at a time. 

 

Open source software for Specialized Analysis: 

 PCRE 

Regular expression support is provided by the PCRE library package, which is open source software, written by 
Philip Hazel, and copyright by the University of Cambridge, England. 
ftp://ftp.csx.cam.ac.uk/pub/software/programming/pcre/ 

 The Apache Software License, Version 1.1 

Copyright (c) 1999-2001 The Apache Software Foundation. All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the 
following conditions are met: 

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer. 

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution. 

3. The end-user documentation included with the redistribution, if any, must include the following 
acknowledgment: "This product includes software developed by the Apache Software Foundation 
(http://www.apache.org/)." Alternately, this acknowledgment may appear in the software itself, if and 
wherever such third-party acknowledgments normally appear. 

4. The names "Xerces" and "Apache Software Foundation" must not be used to endorse or promote 
products derived from this software without prior written permission. For written permission, please 
contact apache@apache.org. 

5. Products derived from this software may not be called "Apache", nor may "Apache" appear in their 
name, without prior written permission of the Apache Software Foundation. 

THIS SOFTWARE IS PROVIDED ''AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE 
FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, 
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT 
OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

=================================================== 

This software consists of voluntary contributions made by many individuals on behalf of the Apache Software 
Foundation and was originally based on software copyright (c) 1999, International Business Machines, Inc., 
http://www.ibm.com. For more information on the Apache Software Foundation, please see 
<http://www.apache.org/>. 
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WARRANTY 

BIOPAC Systems, Inc. warrants its hardware products against defects in materials and workmanship for a period of 
12 months from the date of purchase. If BIOPAC Systems, Inc. receives notice of such defects during the warranty 
period, BIOPAC Systems, Inc. will at its option, either repair or replace the hardware products that prove to be 
defective. This warranty applies only if your BIOPAC Systems, Inc. product fails to function properly under normal use 
and within the manufacturer’s specifications. This warranty does not apply if, in the sole opinion of BIOPAC Systems, 
Inc., your BIOPAC Systems, Inc. product has been damaged by accident, misuse, neglect, improper packing, 
shipping, modification or servicing, by other than BIOPAC Systems, Inc. 

Any returns should be supported by a Return Mail Authorization (RMA) number issued by BIOPAC Systems, Inc. 
BIOPAC Systems, Inc. reserves the right to refuse to accept delivery of any shipment containing any shipping carton 
which does not have the RMA number(s) displayed on the outside. The Buyer shall prepay transportation charges to 
the BIOPAC Systems, Inc. designated site. 

BIOPAC Systems, Inc. makes no warranty or representation, either expressed or implied, with respect to this 
software, its quality, performance, merchantability, or fitness for a particular purpose. As a result, this software is sold 
“As is”, and you, the purchaser, are assuming the entire risk as to its quality and performance. 

In no event will BIOPAC Systems, Inc. be liable for direct, indirect, special, incidental, or consequential damages 
resulting from any defect in the software or its documentation, even if advised of the possibility of such damages, or 
for damage of any equipment connected to a BIOPAC Systems, Inc. product. 

 

TRADEMARKS 

AcqKnowledge is a registered trademark of BIOPAC Systems, Inc. 

Windows is a registered trademark of Microsoft Corporation in the United States and other countries. 

Mac and MacBook are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. 
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